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1 What’s New in This Release
What’s New in Applications Administration Guide, Version 7.7, Rev. B
Table 1 lists changes in this version of the documentation to support Release 7.7 of the software.

Table 1. What’s New in Applications Administration Guide, Version 7.7, Rev. B

Topic Description

Improvements to the documentation

Using Keyboard Accelerators The topic about using keyboard accelerators has been deleted 
from the book because keyboard accelerators are obsolete in 
the Release 7.7 of the software.

“Enabling AOM Case Insensitivity” 
on page 69

Case sensitivity can be set on the Application Object Manager 
and server component levels.

About LOV Caching on Screen 
Home Page

See “Clearing the Cache” on 
page 79.

LOV caching behaves slightly differently on screen home 
pages than on other views. 

To clear the cache (from the Server 
Manager command-line interface)

See “Clearing the Cache” on 
page 79.

The procedure for clearing the cache from the Server 
Manager command-line interface has been deleted from the 
book because it obsolete in the Release 7.7 of the software.

“Configuring Audit Trail in Siebel 
Tools” on page 91

In workflow processes, the Audit Trail function does not work 
unless the Start Method of the Audit Trail Engine Business 
Service is included as a first step. 

“Creating iHelp Item Records” on 
page 102

In order to open iHelp, users need access to the Task 
Assistant Player View.

“About Message Broadcasting” on 
page 113

Message Broadcasting is only available for employee 
applications.

“Creating Inbox Types” on page 139 Corrected an error in the action type example, 
UINBOX_STATUS_TYPE. 

“Setting Up Inbox Actions” on 
page 142

Listed the arguments that are always passed with actions.

“Changing Controls in the Calendar 
Detail View” on page 281

The names of the applets invoked by the three buttons (Add 
Employee, Add Contact, Add Resource) in the Calendar Detail 
view are listed in this topic. The names of these specialized 
applets are not found in Siebel Tools. 
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What’s New in This Release ■ 
What’s New in Applications Administration Guide, Version 7.7, Rev. A
Table 2 lists changes in version 7.7 Rev. A of the documentation to support Release 7.7 of the 
software.

“Showing or Hiding Side Applets on 
the Life Sciences Calendar” on 
page 281

User property for hiding the side applet on Siebel Life 
Sciences calendar.

“Creating State Models and State 
Transitions” on page 286

MLOV (multilingual lists of values) fields are supported with 
state models. 

Table 2. What’s New in Applications Administration Guide, Version 7.7, Rev. A

Topic Description

New features described

Configuring the Calendar

See “About Configuring the 
Calendar” on page 274.

New user properties for configuring these calendar features:

■ Calendar activity description

■ ToolTip text

■ Start and end times for calendar activity display

■ Calendar drilldown

■ Drag-and-drop onto the calendar applet

Simplified List Management

See Chapter 29, “Global Target List 
Management.”

Create and apply targeted lists of accounts, contacts, 
employees, positions, and prospects. The feature is only 
available in Siebel Industry Applications (SIA) such as Siebel 
Financial Services and Siebel Life Sciences.

Improvements to the documentation

Content Center

See Chapter 13, “Content Center” 
and Chapter 14, “Content Asset 
Management.”

The Content Center chapter has been updated and divided 
into two smaller chapters.

State Models

See Chapter 21, “State Models.”

This chapter has been reorganized and corrected.

Siebel Correspondence

See Chapter 23, “Correspondence.”

This chapter has been reorganized and corrected.

Table 1. What’s New in Applications Administration Guide, Version 7.7, Rev. B

Topic Description
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What’s New in This Release ■
What’s New in Applications Administration Guide, Version 7.7
Table 3 lists changes described in version 7.7 of the documentation to support Release 7.7 of the 
software.

Siebel eDocument functionality

See Chapter 26, “Fulfillment 
Centers” and Chapter 27, “Batch 
Printing.”

These chapters have been broken out from the 
Correspondence chapter.

System Preferences

See Appendix A, “System 
Preferences.”

More system preferences are documented, including those for 
SIA (Siebel Industry Applications).

Alerts Online Alerts Online are documented as part of setting up the Siebel 
HelpDesk in the Siebel Employee Relationship Management 
Administration Guide.

Table 3. New Product Features in Applications Administration Guide, Version 7.7

Topic Description

Quick Fill 

See “Administering Quick Fill 
Templates” on page 74.

Templates for filling in records.

Screen Home Pages

See “Setting Up Default View Links 
for Screen Home Pages” on 
page 75.

View links on screen home pages can be set up by the 
administrator.

Audit Trail

See “Specifying Parent–Child 
Associations for Audit” on page 94.

Parent–child associations made in MVG (multi-value group) 
fields and parent–child applets can be audited.

iHelp

See Chapter 7, “Creating and 
Administering iHelp.”

Real-time step-by-step instruction that helps users complete 
tasks within the application.

Message Broadcasting

See Chapter 8, “Message 
Broadcasting.”

Messages can be cached in the Object Manager.

Table 2. What’s New in Applications Administration Guide, Version 7.7, Rev. A

Topic Description
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What’s New in This Release ■ 
Inbox

See Chapter 10, “Administering and 
Using Inbox” and Chapter 11, 
“Configuring the Inbox.”

A single screen consolidating all approval and notification 
items assigned to a user.

Content Asset Management

See Chapter 14, “Content Asset 
Management.”

Various enhancements to Content Asset Management 
including:

Allowing hierarchies (nesting) for content sets

Ability to preview all versions

Advanced options for adding content assets to the Content 
Center repository

Microsite Management

See Chapter 15, “Microsite 
Management.”

Enhancements to Microsite Management:

Redesigned Page Designer, including the new Menu tool

Enhanced Page Administration

Template administration

One-click publishing 

Symbolic URL links

Page caching set through CFG file (not the mmlayout.txt file)

Usage Collection

See Chapter 16, “Usage Collection.”

Collect usage statistics about site traffic. Log files list who is 
accessing which pages and views and when.

Table 3. New Product Features in Applications Administration Guide, Version 7.7

Topic Description
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2 Getting Started
This chapter includes the following topics:

■ “Getting Started Prerequisites” on page 27

■ “Starting the Application for the First Time” on page 28

■ “Entering License Keys” on page 29

■ “Selecting a Data Source” on page 33

■ “About Seed Data” on page 33

■ “Summary of Applications Administration Tasks” on page 34

Getting Started Prerequisites
Once the Siebel system is successfully installed, you need to enter license keys so that you and your 
organization can access the Siebel products that your organization has purchased. After the license 
keys have been entered, you are ready to set up your Siebel applications.

Before you can begin to use your Siebel applications, the software listed in Table 4 must be correctly 
installed.

Once these Siebel servers and applications are successfully installed, you can proceed to enter 
license keys for specific Siebel applications.

Table 4. Required Software

Software For Information, See

Siebel Gateway Name Server Siebel Installation Guide for the operating system you are 
using

Siebel Server

Siebel Database Server

Siebel Tools or Siebel Dedicated Web 
Client

Siebel eBusiness Applications Application-specific administration guide and this guide
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Starting the Application for the First 
Time
In order to begin setting up your Siebel application, you must log in with administrative 
responsibilities. The Siebel database server installation script creates a Siebel administrator account 
that you can use to perform administrative tasks. The default user ID and password are SADMIN and 
SADMIN (case-sensitive). Your database administrator may also have created a user ID and 
password that allows you to access the Siebel Server and perform the required setup. To set up 
entities in the Group Administration view, you must be connected to the Siebel Server; you do not 
have full administrative capabilities for this view if you are connected to the local database or working 
in a mobile Web client. 

NOTE: The responsibility for the SADMIN ID that comes with Siebel applications cannot be modified. 
However, you can copy this responsibility and modify the copy. For more information, see Security 
Guide for Siebel eBusiness Applications.

You can start Siebel applications from the Siebel Dedicated Web Client or from the Siebel Web Client. 
Instructions for both are described below.

TIP: If you have not yet entered any license keys, you must enter the first license key from the 
Siebel Dedicated Web Client or from Siebel Tools. For more information, see “Entering License Keys” 
on page 29.

To start a Siebel application from the Siebel Dedicated Web Client for the first time

1 From the Start menu, choose Programs and then choose your Siebel application.

2 Enter SADMIN in the User ID and Password fields.

3 In the Connect to field, choose the server database from the drop-down list and click OK.

For information about the other databases available in the Connect to drop-down list, see 
“Selecting a Data Source” on page 33.

4 If a message tells you that there is no valid license key, click OK.

5 In the License Key dialog box, enter the Siebel eBusiness base application license key and click 
OK. 

For more information about license keys, see “Entering License Keys” on page 29. If you need to 
enter additional license keys, see “Entering an Additional License Key” on page 31.

To start a Siebel application from the Siebel Web Client for the first time

1 Open your Web browser.

2 Go to the URL for your Siebel Web Client.

The login screen appears.
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3 Enter SADMIN in the User ID and Password fields and click OK.

NOTE: If a message tells you that you have not been licensed for this feature, you must enter a valid 
license key, using either Siebel Tools or the Siebel Dedicated Web Client, before you can access the 
application. For more information, see “Entering License Keys” on page 29. 

Entering License Keys
The Siebel license key is generated so that your organization's users can access the Siebel products 
that your organization has purchased. The license key is a series of numbers (up to 54 digits). Your 
organization’s specific license key is included in the Welcome Package. You must enter this license 
key before you begin to use the Siebel product, products, or optional modules that your organization 
has purchased. Because the license key resides in the database and not on the client machine, 
everyone who accesses the Siebel database uses the same license key. 

Your license key activates the screens and views associated with the applications and modules that 
your organization has purchased. If you have been assigned multiple license keys, their effect is 
cumulative, as you enter them.

Customers upgrading from earlier versions of Siebel software may notice differences between the 
Siebel product and the products listed in the Welcome Package. These generally reflects changes in 
naming and bundling of Siebel products. For example, a functionality that was previously sold 
separately might now be bundled into a single product, or included in a base application, or simply 
have been renamed. It is recommended that you run the application itself to verify that all of the 
functionality that you expected is there.

Customers using Siebel products which are upgrades from earlier versions may notice differences 
between the views in the previous product and the views in the upgraded product. Reasons for this 
may include the following:

■ The view you are looking for is not available from the application that you have launched.

■ You logged in as a user who does not have responsibilities for the view. In order to evaluate all 
of the views available in the product, log in as a Siebel administrator. 

■ The method of accessing the functionality may have changed, or the functionality may have been 
replaced by more comprehensive features that work differently. Consult the Siebel Bookshelf for 
information on functionality changes in the latest release.

■ The location or name of the screen or view may have changed. You can review the Site Map or 
consult the Siebel Bookshelf for information on current view locations.

However, if you do not see views that you expected, or if you see views that you did not expect, and 
feel that it impacts the functionality you have purchased, contact Siebel Technical Support as soon 
as possible. If your license key has expired, contact Siebel Technical Support.
Applications Administration Guide Version 7.7, Rev. B ■ 29



Getting Started ■ Entering License Keys
Entering the First License Key
Before you enter the first license key, the following software must be correctly installed: Gateway 
Name Server, Siebel Server, Siebel Database Server, Siebel eBusiness Applications, and one of the 
following: Siebel Dedicated Web Client or Siebel Tools. After the first Siebel Dedicated Web Client or 
Siebel Tools installation, the first user to connect to the Siebel database is required to enter a license 
key in order to use the product. 

To enter the first license key

1 Start either Siebel Dedicated Web Client or Siebel Tools. 

NOTE: You have the choice of entering the first license key in either Siebel Dedicated Web Client 
or Siebel Tools. You can enter any Siebel license key in either Siebel Dedicated Web Client or 
Siebel Tools. 

2 Log in as the system administrator and connect to the server database. 

Use SADMIN as the login name and SADMIN as the password, and choose Server in the Connect 
to drop-down list. 

NOTE: If you are the first to log in to Siebel Dedicated Web Client after a new Siebel installation, 
you get the error message “There is no valid license key in the database.” If you are the first to 
log in to Siebel Tools after a new Siebel installation, you get the error message “No valid license 
keys were found in the database.” 

3 If you are logged in to Siebel Dedicated Web Client, click OK. If you are logged in to Siebel Tools, 
click Add Key. 

4 In the License Key dialog box, enter the Siebel eBusiness base application license key or the 
Siebel Tools license key, and then click OK.

CAUTION: Enter only a Siebel eBusiness base application license key or the Siebel Tools license 
key. If you enter an optional-module license key without having a Siebel eBusiness base 
application license key already entered, an error message appears. The error occurs because the 
Home Page view is required to start Siebel eBusiness base applications, and Home Page views 
are not included in optional module license keys.

5 Close Siebel Dedicated Web Client or Siebel Tools, whichever you started in Step 1 on page 30.

6 Restart the Siebel Server System Service. (For more information, see Siebel System 
Administration Guide.) 

7 Start the Siebel application associated with the license key that you entered. 

For example, if your license key is for Siebel Sales, start Siebel Sales; if your license key is for 
Siebel Tools, start Siebel Tools. 

NOTE: After entering the initial license key, if you discover that you made an error when entering 
the license key, you can correct the license key in the Key Value field in the Application Administration 
screen, License Key view. 
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Entering an Additional License Key
After entering the initial key, you can add or delete license keys through Siebel eBusiness 
Applications as long as your Siebel user responsibility includes the Siebel License Key view. You can 
do this immediately if your purchase included more than one license key, or you can add license keys 
as your organization purchases more Siebel applications or optional modules. 

To enter an additional license key using a Siebel application

1 Start the Siebel application—for example, Siebel Call Center. You can use Siebel Web Client or 
Siebel Dedicated Web Client.

2 Log in as the system administrator and connect to the server database. 

Use SADMIN as the login name and SADMIN as the password, and choose Server in the Connect 
to drop-down list. If the system administrator’s password has been changed, use the current 
password.

3 Navigate to the Administration - Application screen > License Keys view.

4 Add the new license key:

a In the License Keys list, create a new record. 

b In the new record, enter one license key in the Key Value field. 

c Repeat Step a and Step b for each license key to be entered.

5 Close the application.

6 Restart the Siebel Server System Service. (For more information, see Siebel System 
Administration Guide.) 

Start any Siebel application or module associated with a license key you have entered.

If you have any problems installing your license keys, contact Siebel Technical Support.

To enter an additional license key using Siebel Tools

1 Start Siebel Tools.

NOTE: To enter additional license keys in Siebel Tools, you must have first entered the Siebel 
Tools license key. 

2 Log in as the system administrator and connect to the server database. 

Use SADMIN as the login name and SADMIN as the password, and choose Server in the Connect 
to drop-down list. If the system administrator’s password has been changed, use the current 
password.

3 Choose Help > Technical Support from the menu bar.

4 In the Technical Support Information dialog box, click License Key.

5 Add a license key:

a In the License Keys dialog box, click Add Key. 

b In the new record, type in one license key and then click OK.
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c Repeat Steps a and b for each license key to be entered.

6 Close Siebel Tools.

7 Restart the Siebel Server System Service. (For more information, see Siebel System 
Administration Guide.) 

Start any Siebel application or module associated with a license key you have entered.

License Key Fields
Table 5 describes the files in the license key record.

Hiding Access to License Keys
There are two ways that you can hide access to license keys: hiding the License Keys administrative 
view within Siebel applications and hiding the License Key button within Siebel Tools.

■ Within Siebel Applications. You may want to hide the License Keys view in the Application 
Administration screen, in order to discourage unauthorized users from attempting to change 
license keys. To hide the License Keys view, remove it from the responsibility associated with the 
users who should not have access to it. Responsibilities control the views to which users have 
access. For more information about creating and modifying responsibilities, see Security Guide 
for Siebel eBusiness Applications. 

■ Within Siebel Tools. You may want to disable the License Key button, found in the Technical 
Support Information dialog box (available from the Siebel Tools Help menu), in order to 
discourage unauthorized users from attempting to change license keys. You can disable the 
License Key button by selecting the Siebel Administrator responsibility and deleting the Edit 
License Key view.

Table 5. Fields in the License Key Record

Field Description

Key Value The license key from your Welcome Package. Create a new record for each license 
key.

Status Automatically entered based on the license key.

OK means the license key has not expired.

Expired means the license key has expired. 

MaxUsers Automatically entered based on the license key.

The maximum number of concurrent users allowed in your license agreement 
with Siebel Systems.

Expires Automatically entered based on the license key.

The expiration date for the license key in your license agreement with Siebel 
Systems.
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Selecting a Data Source
When you start a Siebel application from the Siebel Dedicated Web Client, you specify the data 
source to which you want to connect.

The following databases are potentially available to administrators and end users:

■ Local. Resides on your local computer. Can be synchronized with the corporate database. 
Typically stored on a laptop computer and used by mobile users who are not connected to a 
server when working. 

■ Server. This is your enterprise server database.

■ Sample. A database of sample data, stored on your workstation. Using this database, you can 
experiment with a Siebel application without risk of damaging actual organizational data.

You should always perform system administration tasks against the server database. Although you 
can perform these tasks against your local database and synchronize, doing so has the potential to 
cause errors, including data conflicts. In addition, performance problems can result from a large local 
database, and from routing large numbers of transactions.

About the Sample Database
Siebel eBusiness Applications include a sample database to use in demonstrating, evaluating, or 
experimenting with the Siebel client and Siebel Tools. (For more information, see Siebel Installation 
Guide for the operating system you are using.)

The sample database includes a number of demo user accounts (SADMIN is one of these). Each of 
these has a predefined responsibility that reflects the demo user’s position within the sample 
organization. If you log in to the sample database as a demo user, you can access certain views 
within Siebel eBusiness Applications based on the demo user’s responsibility.

You do not need to install server components to run the Siebel sample database. However, you 
cannot access the Administration - Server Management screen if the server component is not 
running. The sample database cannot be copied to the server data sources.

To log on as a demo user, double-click the icon for the listed application in the Siebel client program 
group. Applications listed as “Demo” automatically log the indicated user into the sample database. 
For the other applications, enter the user ID and password in the logon dialog box and choose 
Connect to: Sample. For more information about the sample database, including a list of demo users, 
see Release Notes on Siebel SupportWeb.

The sample database that ships with the Siebel system has a built-in license key that includes access 
to all views and modules for a period of a year from the initial ship date of the product.

About Seed Data
The enterprise database of your default Siebel application contains some built-in seed data, such as 
organization, division, position, responsibility, and employee records. You can use this seed data for 
training or testing, or as templates for the real data that you enter. For more information on seed 
data, including descriptions of seed data records, see Security Guide for Siebel eBusiness 
Applications.
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Summary of Applications Administration 
Tasks
Table 6 summarizes the additional application administration tasks necessary to set up various Siebel 
eBusiness applications and optional modules.

Table 6. Application Administration Tasks

If You Want to You (May) Need to Perform For More Information, See

Use any base 
application (for 
example, Siebel 
Sales or Siebel Call 
Center)

Initial Setup tasks. Chapter 3, “Initial Setup”

Ongoing administration tasks. Chapter 4, “Ongoing 
Application Administration 
Tasks”

Control access to 
views or data

Establish a strategy for controlling access 
to views and data:

■ Establish the business environment 
(such as organizations, divisions, 
territories)

■ Add employees

■ Assign responsibilities to employees

Security Guide for Siebel 
eBusiness Applications

Launch a global 
deployment

Locale and language administration tasks. “Setting Up Locales” on 
page 41

“Setting Up Languages” on 
page 67

Global Deployment Guide

Manage global 
accounts

Account administration tasks: Set up 
global account hierarchies.

Chapter 36, “Global Accounts”

Use Application 
Services Interfaces 
(ASIs) for accounts, 
contacts, or 
households

Set up Web services and activate 
workflows for the ASIs.

Chapter 32, “Integration Using 
ASIs”

Create catalogs for 
data, including 
products

Create catalogs for products, literature, 
solutions and auctions.

Siebel eSales Administration 
Guide
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Use Correspondence, 
Presentations, and 
Proposals 
functionality

Set up the Siebel Document Server, and 
create templates.

Chapter 22, “Document 
Server”

Chapter 23, “Correspondence”

Chapter 24, “Presentations”

Chapter 25, “Proposals”

Manage content with 
Content Center

Set up a staging environment, set up 
content objects and workflows, and set up 
content types.

Chapter 13, “Content Center”

Manage a microsite Microsite administration tasks. Chapter 15, “Microsite 
Management”

Use the calendar to 
set up resources, 
such as conference 
rooms, equipment, 
and projectors

Calendar administration tasks. Chapter 20, “Calendar”

Use Assignment 
Manager to 
automatically assign 
tasks to appropriate 
users

Create skills and other criteria. Siebel Assignment Manager 
Administration Guide

Use Siebel Marketing Marketing administration tasks. Siebel Marketing Installation 
and Administration Guide

Manage lists of 
prospects, contacts, 
accounts, positions, 
and employees

List Management tasks. Siebel Marketing User Guide 
and Chapter 29, “Global Target 
List Management”

Use Competency 
Management System

Skills and competencies administration 
tasks

NOTE: These are different skills than 
those used by Assignment Manager.

Siebel Employee Relationship 
Management Administration 
Guide

Use Time Sheets and 
Expense Reports

Time Sheet and Expense Report setup 
tasks, such as creating work types.

Siebel Professional Services 
Automation Guide

Manage Service 
schedules, Service 
Assets, Warranties

Service administration tasks. Siebel Field Service Guide

Table 6. Application Administration Tasks

If You Want to You (May) Need to Perform For More Information, See
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Manage quotas and 
employee or partner 
incentive 
compensation 

Incentive compensation administration 
tasks.

Siebel Incentive 
Compensation Administration 
Guide

Manage orders and 
the order process

Order administration tasks. Siebel Order Management 
Guide

Table 6. Application Administration Tasks

If You Want to You (May) Need to Perform For More Information, See
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3 Initial Setup
This chapter is about initial setup tasks. It includes the following topics:

■ “About Initial Setup” on page 37

■ “Summary of Initial Setup Tasks” on page 38

■ “Adding Views to the Application” on page 39

■ “Completing Employee Setup” on page 39

■ “Assigning Skills” on page 41

■ “Setting Up Locales” on page 41

■ “Setting Up Satmetrix Survey Reports” on page 45

About Initial Setup
Once your Siebel products are successfully installed, you need to perform a number of tasks to set 
up and administer the application.

Initial setup tasks are those which must be completed in order for your Siebel applications to work 
correctly, and then may be done infrequently, for instance, as your company grows.

Ongoing tasks are done on an occasional or ongoing basis, and are described in Chapter 4, “Ongoing 
Application Administration Tasks.”
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Summary of Initial Setup Tasks
Table 7 summarizes the initial setup tasks and the order in which you should perform them.

Table 7. Required Tasks During Setup

Task Comments

Add any custom views. Custom views are created in Siebel Tools and must be 
added to your Siebel application. Custom views should be 
added to the Views view before you define responsibilities. 
For information about adding views, see “Adding Views to 
the Application” on page 39.

Determine access control strategy and 
define business environment 
structure.

Siebel applications can be set up to support many 
strategies for your company to control access to views and 
data. These strategies include methods such as defining 
your business environment structure (organizations, 
internal and external divisions, and so on), defining 
employee positions, and creating access groups so that 
specific groups of people have access to specific views and 
data.

These decisions should be made early in the deployment 
process, so that the strategy can be implemented during 
the initial setup.

For more information about controlling access to views 
and data, and the procedures for implementing access 
control, see Security Guide for Siebel eBusiness 
Applications.

Enter employee records into system 
(database and application) and 
determine employee access to views 
and data.

Enter employee records after you have defined your 
business environment structure. You need to assign at 
least one responsibility to each employee, and you may 
also assign organizations, positions, or other access 
control parameters.

For more information about entering or deactivating 
employee records, see Security Guide for Siebel eBusiness 
Applications.

Complete employee setup. For information about associating additional information 
to an employee record, see “Completing Employee Setup” 
on page 39.

Set up locales. Locale Codes and parameters are necessary for a global 
deployment. For more information, see “Setting Up 
Locales” on page 41.
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Adding Views to the Application
Developers create new views through Siebel Tools. In order for the views to become available for 
administrators to work with, you must add them to the Views screen in the application before you 
define your business environment.

Example: You want to add an Opportunities view in the Reference screen. In Siebel Tools, you create 
the view and name it Reference Opportunities. (For details on creating views, see Configuring Siebel 
eBusiness Applications.) In your Siebel application, you follow the steps below and add the Reference 
Opportunities view in the View Administration view. After it has been added in both places, the view 
can be made accessible to the appropriate users. For details about controlling visibility to views, see 
Security Guide for Siebel eBusiness Applications.

To add customized views to the Siebel application

1 Navigate to the Administration - Application screen > Views view.

2 In the Views list, create a new record and complete the necessary fields.

You generally do not need to modify or delete views that are already listed. You would only need to 
modify a view if its name was changed in Siebel Tools. A view would need to be deleted only if it no 
longer existed in the data model schema, or if you did not want anyone to have access to it. Instead 
of deleting views, administrators should remove the views from responsibilities and keep them in the 
database.

NOTE: Only visibility-level views can be configured to appear in the Site Map.

Completing Employee Setup
After completing the employee setup procedures described in the Security Guide for Siebel eBusiness 
Applications, which are required to allow employee access to the Siebel application, views and data, 
you complete employee setup by providing additional information. This can include the following:

■ Assignment Rules. Allows you to see and administer the assignment rules for an employee. For 
more information on assignment rules, see Siebel Assignment Manager Administration Guide.

NOTE: You must be logged on to a server database to use the Employee Assignment Rules view.

■ Availability. Used for Siebel Professional Services Automation. Lists the projects for which an 
employee is on staff, or for which an employee has been requested. For more information, see 
Siebel Professional Services Automation Guide.

NOTE: Employees can also change their availability in the Availability view on the User 
Preferences screen.

■ Exception Hours. Specifies what days and hours an employee is not available.

■ Utilization. Displays a chart with the monthly and quarterly utilization of the currently selected 
employee. Managers use this chart for monitoring professional services projects and employees. 
For more information about professional services, see Siebel Professional Services Automation 
Guide.
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■ Tools. Defines the tools that field service engineers carry with them or have access to. It allows 
a call center person to check whether the engineers have the correct tools for the jobs they are 
assigned to.

■ Job Information. Specifies the job profile, salary, compensation ratio, pay currency, and 
location of employee.

■ Calendar administration. Defines the calendar properties and access for an employee. For 
more information about Calendar administration, see Chapter 20, “Calendar.”

■ Assignment Skills. Defines an employee’s skills and skill items, along with their level of 
expertise. Skills can be used as assignment criteria in Siebel Assignment Manager. For more 
information about how the Siebel application uses skills, see Siebel Assignment Manager 
Administration Guide.

Skills can also be used in the Professional Service Automation product for managing resources. 
For information about these types of skills, see Siebel Professional Services Automation Guide.

■ Employee Query. Allows queries to identify employees with particular skills and expertise.

■ Service Details. Provides details about the shift start and end locations, hourly costs, overtime 
availability and other details for a service employee.

■ Competency. Provides a list of areas in which the employee has some demonstrated level of 
knowledge or accomplishment.

■ Education. Provides details of an employee’s education history.

■ Past Work Experience. Provides details of an employee’s work history.

■ Honor/Award. Provides list of honors and awards earned by an employee.

■ Membership. Provides details of an employee’s memberships in various organizations.

■ Certification. Provides details of an employee’s certification.

To complete the employee setup

1 Navigate to the Administration - User screen > Employees view.

2 In the Employees list, drill down on the employee for whom you want to add additional 
information.

3 Click the More Info view tab.
Applications Administration Guide Version 7.7, Rev. B40 ■



Initial Setup ■ Assigning Skills
4 In the form, complete any necessary fields. 

Some of the fields are described in the following table.

 

5 Click any other appropriate view tab.

6 Create a new record, if needed. 

7 Enter the appropriate information.

Assigning Skills 
At the levels of organizations, positions, and employees, you can add skills. Skills are used for 
assigning employees to certain projects, service requests, and so on. Skills added to an organization 
apply to all employees assigned to that organization. Skills assigned to a position apply only to the 
employee assigned to that position. You create skills with Siebel Tools.

Employees can track and update their own skill profiles in the User Preferences Profile view.

For more information about how your Siebel application uses skills, see Siebel Assignment Manager 
Administration Guide.

Setting Up Locales
A locale is a set of rules guiding how common data is displayed to the user or received from the user. 
These rules are used to format data from a database before displaying the resulting information in 
output fields on the user interface. Siebel applications support language and geographical 
conventions for the display language of picklists, and formatting of data such as dates, time, 
numbers, and currency based on locale settings.

The Locale information is stored in the Locale Table (S_LOCALE). The data in this table is maintained 
by the administrator using the Locale Administration view.

The locale with which the Component Object Manager processes are initialized is determined by the 
value of the parameter Locale Code. Although this is set during installation, it may be changed to 
the locale code of any locale that is preconfigured with the Siebel application or added by the 
administrator. The Locale Code parameter can be set at the Enterprise, Server, or Component level.

A number of locales and their parameters come prebuilt with the standard Siebel application. You 
can also create and revise locales in the Locale Administration view.

Field Description

Configuration Specifies which Siebel product or group of software components to 
associate with the currently selected employee. For more information, see 
Siebel Anywhere Administration Guide.

Available Until May be used to indicate the active period of an employee. Used in 
conjunction with the Availability, Overtime Availability, and Next Available 
fields.
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After a locale and its parameters are defined, you can create translations for locale names that 
display in the locale pick applet, rather than the three letter acronym locale code. For example, 
instead of showing ENU as locale name, the administrator provides English–United States as a 
translation for English speakers and Inglese–Stati Uniti d’America for Italian speakers. Only 
translated locale names are exposed to end-users on locale pick applets.

NOTE: Whereas the Siebel Web Clients use the locale settings specified in the Locale Administration 
view, the Siebel Mobile Web Client and the Siebel Dedicated Web Client use the locale settings 
defined in the client operating system’s regional settings.

Setting up a Server Object Manager includes assigning a locale to the Object Manager. Because the 
locale directs how locale sensitive information, such as date, time, and numbers are different from 
country to country, customers must complete an Object Manager for each country in which they have 
users in order to provide the users with correct looking data. (This does not apply to Siebel Dedicated 
Web Clients, because dedicated clients use the regional settings of the dedicated client machine.)

To create a locale

1 Navigate to the Administration - Data screen > Locale view.

2 In the Locale list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Description

Date Separator Designates the symbol used to separate the components of the 
date. This symbol replaces the forward slash (/) in the date format.

International Dialing 
Code

Designates the country codes to display in phone numbers, 
suppressing the country code for phone numbers that are in the 
user’s locale. For example, if the phone numbers for two accounts 
are the following:

■ +33 1-23 42 34 56, for an account based in France (+33 is the 
country code for France)

■ +1 6502955000, for an account based in the U.S. (+1 is the 
country code for the U.S.)

To a user based in the U.S. (locale ENU) the International Dialing 
Code value is “USA and Canada (1)”, and the above phone numbers 
displays as:

■ +33 1-23 42 34 56

■ (650) 295-5000
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List Separator Designates the symbol used to separate consecutive numbers in a 
list.

For example:

■ In the U.S., consecutive numbers are separated by a comma: 
1.23,3.57,4.01

■ In France, consecutive numbers are separated by a semi-
colon: 1,23;3,57;4,01

Locale Code Siebel applications use the three letter acronym (TLA) code 
conventions of Microsoft for locale name. In most cases, the TLA is 
created by taking the two-letter language abbreviation from the 
ISO Standard 639 and adding a third letter as appropriate to form 
a unique identifier.

For information on Microsoft codes, see your Microsoft 
documentation.

Locale Name The naming convention is generally Language Name–Territory, for 
example, English–United States, English–United Kingdom, or 
French–France.

Long Date Format Specifies the appropriate long date format, using spaces, commas, 
or periods as separators. Long date formats contain day and month 
names.

For example: dddd, MMMM dd, yyyy
as in Friday, June 21, 2004

A forward slash (/) in the format acts as a placeholder for the Date 
Separator symbol.

NOTE: Long dates are only supported for the calendar, the Gantt 
chart, salutation text on the home page, and balloon text in some 
charts.

Negative Currency 
Format

Specifies the location of the negative sign (-) with respect to the 
currency symbols and digits (100).

For example:

■ For U.S. format, ($32.45), select (s100)

■ For British format, -£32.40, select -s100

Number Decimal 
Separator

Specifies the symbol used to indicate the decimal place.

For example:

■ French format: 1 234,34 (comma as decimal symbol)

■ U.S. format: 1,234.34 (period as decimal symbol)

Field Description
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Number Fractional Digits Designates the number of digits after the decimal separator. For 
example, the number 12.340 has a number fractional of 3.

This applies to data fields of type DTYPE_NUMBER.

Number Grouping 
Separator

Designates the symbol used to group numbers.

For example:

■ French format: 1 234 (space as number grouping separator)

■ German format: 1.234 (period as number grouping separator)

■ U.S. format: 1,234 (comma as number grouping separator)

Number Leading Zero Designates whether to display a leading zero in numbers less than 
one. For example, .7 or 0.7.

Positive Currency Format Specifies the location of the currency symbols with respect to the 
digits (100).

For example: for U.S. format, $32.45, select s100.

Short Date Format Specifies the appropriate shortened date format.

For example:

■ International format: yymmdd

■ U.S. format: mm/dd/yy

■ German format: dd.mm.yy

The forward slash in the string mm/dd/yy is actually a placeholder. 
It is replaced with the symbol specified in the Date Separator field. 
For example, if the Date Separator value is a dash, -, then April 10, 
2002 displays as 04-10-2002.

NOTE: If you enter a month number greater than 12, it defaults to 
12. If you enter a day number greater than the number of days in 
the month, it defaults to the last day of the month. For example, if 
you enter 42/99/03 (U.S. format), the date defaults to 12/31/03.

Time AM Designator Specifies the symbol for designating time between 00:00 and 
12:00.

For example: AM, a.m., am

Time Leading Zero Designates whether to display a leading zero in time fields. For 
example:

12 hour clock with leading zero: 01:03 AM, 01:03 PM

12 hour clock without leading zero: 1:03 AM, 1:03 PM

24 hour clock with leading zero: 01:03, 13:03

24 hour clock without leading zero: 1:03, 13:03

Field Description
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To create a translation for a locale name

1 Navigate to the Administration - Data screen > Locale view.

2 Select the appropriate record.

3 Click the Locale Name Translation view tab.

4 On the Locale Name Translation list, create a new record and complete the necessary fields.

Some fields are described in the following table.

To edit the current locale

1 Edit the locale record. (See “To create a locale” on page 42.)

2 To have the edits take effect, restart the application’s Object Manager. 

(For information about shutting down and starting Siebel Server components such as an Object 
Manager, see the Siebel System Administration Guide.)

Setting Up Satmetrix Survey Reports
NOTE: This section only applies to those who have purchased Siebel Satmetrix Surveys or who have 
purchased surveys directly from Satmetrix Systems.

In order to view Satmetrix survey reports through your Siebel application, you need to:

Time PM Designator Specifies the symbol for designating time between 12:00 and 
24:00.

For example: PM, p.m., or pm

Time Separator Specifies the symbol used to separate the hours from the minutes.

UI Directionality Designates the direction of the text displayed.

Field Description

Language Designates the language code of the translation of the locale name. For 
examples of language codes, see Global Deployment Guide.

Translated 
Name

The exact translation of the locale name to appear in the picklist for users with 
the designated language code. For example, for the locale English–United 
States:

■ With ENU language code, the locale name is English–United States.

■ With ITA language code, the locale name is Inglese–Stati Uniti d’America.

Description Translated description of this locale.

Field Description
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■ Add the Account Satmetrix Survey View view to the appropriate user responsibilities. For 
information about how to add views to responsibilities, see Security Guide for Siebel eBusiness 
Applications.

■ Enter the secret key string provided by Satmetrix Systems into the Satmetrix Key Value system 
preference. For information about how to change system preferences, see “Setting System 
Preferences” on page 50.

■ Extend the List of Values for WI_ARG_TYPE as described in “To extend the List of Values for 
WI_ARG_TYPE” on page 46.

■ Set up the symbolic URL for access to the Satmetrix reports server, as described in “To set up the 
symbolic URL for access to Satmetrix Reports” on page 46.

To extend the List of Values for WI_ARG_TYPE

1 Navigate to Administration - Data > List of Values.

2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

For more information about creating List of Values records, see Chapter 5, “Working with Lists of 
Values.”

To set up the symbolic URL for access to Satmetrix Reports

1 Navigate to the Administration - Integration screen > WI Symbolic URL List view.

2 From the Show drop-down list, select Symbolic URL Application.

3 In the Symbolic URL list, select SatmetrixSurvey.

4 Make sure the URL is the URL for the reports server provided by Satmetrix Systems. 

Field Value

Type WI_ARG_TYPE

Display Value Satmetrix

Language-Independent Code Satmetrix

Active Yes

Translate Yes

Replication Level All
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5 In the Symbolic URL Arguments list, complete the fields, using the following table as a guide.

Name
Required 
Argument

Argument 
Type Argument Value

Append 
as 
Argument Sequence

EncodeUrl Yes Command FALSE Yes 1

version Yes Constant Obtain from Satmetrix Yes 2

windowsize Yes Command WebControl width=1000 
height=500 border=1

Yes 3

type Yes Constant acct Yes 4

acctid Yes Field Id Yes 5

acctname Yes Field Name Yes 6

contactid Yes Constant * Yes 7

contactname Yes Constant * Yes 8

user Yes Profile 
Attribute

Login Name Yes 9

domain Yes Constant Obtain from Satmetrix Yes 10

model Yes Constant Obtain from Satmetrix Yes 11

created Yes Field Timestamp Yes 12

token No Satmetrix Satmetrix Surveys, 
CalculateToken

Yes 13
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4 Ongoing Application 
Administration Tasks
This chapter assumes that you have successfully installed your Siebel product and have completed 
the tasks in Chapter 3, “Initial Setup.”

The tasks described in this chapter set up defaults that are used throughout your Siebel application. 
For some implementations, the default settings provided through the seed data meet a company’s 
needs without customization. In other cases, administrators find it useful to make adjustments to 
these defaults. 

This chapter includes the following topics:

■ “Setting System Preferences” on page 50

■ “Setting Up Predefined Queries” on page 50

■ “Setting Up Currencies” on page 52

■ “Setting Up Currency Conversion” on page 53

■ “Setting Up Expense Types” on page 56

■ “Setting Up Payment Terms” on page 57

■ “Setting Up Periods” on page 58

■ “Specifying Telephone Formats” on page 58

■ “Setting Up Pager Companies” on page 63

■ “About Date Formats” on page 63

■ “Setting Up ZIP Codes” on page 64

■ “Administering Global Time Zone Support” on page 64

■ “Setting Up Email, Fax, and Mail Accounts (Contact Us)” on page 66

■ “Setting Up Industries” on page 66

■ “Setting Up Languages” on page 67

■ “About Case Sensitivity” on page 67

■ “Enabling Application-Wide Case Insensitivity” on page 68

■ “Enabling AOM Case Insensitivity” on page 69

■ “Enabling Field-Specific Case Insensitivity” on page 70

■ “Adding Web Browser Capabilities” on page 71

■ “Adding Additional Web Browsers” on page 72

■ “Administering Quick Fill Templates” on page 74

■ “Setting Up Default View Links for Screen Home Pages” on page 75
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Setting System Preferences
System preferences control how Siebel applications operate in your environment. You need to review 
default settings and modify these as appropriate for your environment.

For a list of the system preferences in Siebel applications, see Appendix A, “System Preferences.”

To set system preferences

1 Navigate to Administration - Application screen > System Preferences view.

2 Check that the default System Preference Values are correct in your environment, or change 
values for system preferences as needed.

Some system preferences may not take effect until the affected components are restarted. (For 
information about shutting down and starting Siebel Server components such as an Object 
Manager, see the Siebel System Administration Guide.) 

Setting Up Predefined Queries

About Setting Up Predefined Queries
Predefined queries (PDQ) automate queries that a user can perform online. Rather than creating a 
query, entering criteria, and running the query, the user selects a PDQ from the Queries drop-down 
list. 

Predefined queries can be private (available only to the person who created them) or they can be 
public (available to all the users of the application).

There are two ways to set up predefined queries:

■ Create and execute a query in the usual way, and then save the query.

■ Create or modify a predefined query in the Predefined Query screen.

Things to Remember
When setting up queries, remember:

■ The Administrator can define a PDQ using both displayed and nondisplayed fields.

■ You can reference only fields from the current applet’s business component in your query.

■ On occasion, using the wildcard * to find all entries in a field may cause a performance problem. 
If it does, use IS NOT NULL instead. For more information about query operators, see 
Fundamentals.

Predefined queries are defined on a business object. All screens based on the same business 
object display all the predefined queries created for that business object.

■ Querying on fields of data type DTYPE_NOTE is not supported on some database platforms. 
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Procedures

To create a predefined query by saving a query

1 Navigate to the screen where you want to run the query.

2 Create and execute a query.

3 From the application-level menu, choose Query > Save Query As.

4 In the Save Query As dialog box, enter a name for the query. 

The query is added to your list of predefined queries. This query is private, and only you can view 
it.

5 If you want to make the query public:

a Navigate to the Administration - Application screen > Predefined Queries view. 

b In the Predefined Queries list, deselect the Private field in the record for the query you just 
created.

To set up a predefined query in the Predefined Query view

1 Navigate to the Administration - Application screen > Predefined Queries view. 

2 In the Predefined Queries list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name This is the name that appears in the predefined query drop-down list.

Object The object upon which the query is performed. 

Private Marked if the query is available only to the person who created it. 

When you unmark a query to make it public, the other users must first exit the 
application and reenter before they can see the newly public query.

Query The SQL code for the query. 

When you create a query for a field that is a multi-value group, you can use the 
EXISTS operator to query nonprimary child records.

For more information about the syntax, see about operators, expressions, and 
conditions in Siebel Developer’s Reference.

Cache 
Result

If this is Y, the query returns all rows up to the value of the 
DSMaxFetchArraySize parameter set for the data source.

For information about setting DSMaxFetchArraySize, see about modifying 
Named Subsystems in the Siebel System Administration Guide.

NOTE: Setting DSMaxFetchArraySize to -1 and Cache Result to Y may cause 
memory problems for queries returning many rows.
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Setting Up Currencies
You specify the currencies your company uses by: 

■ Making Currencies Active. If the application includes the currency definitions you need, you 
make these currencies active. 

■ Defining Currencies. If you need additional currencies whose definitions the application does 
not include, you must also define these currencies. 

NOTE: If you use multiple currencies, you must also set up exchange rates before you import data 
that contains foreign currencies and before you use any of the Siebel currency features. 

Making Currencies Active
The application includes more than 30 currency definitions. If your currency is one of these, you need 
only mark it as active. 

To make currencies active

1 Navigate to Administration - Data screen > Currencies view.

2 For any currency that you want to make active, click the Active column in the Currencies list. 

3 (Optional) Enter the Start Date and End Date in the form to specify the date when this currency 
becomes active and the date when it is no longer active.

Defining Currencies
If your company uses any currencies that the application does not include, you must define them 
and mark them as active. 

If you modify the definition of currencies, you must clear the cache or log out and back in to the 
application before the modification becomes visible. For more information about clearing the cache, 
see “Clearing the Cache” on page 79. 

You cannot delete a currency once you have defined it. If you no longer use it, you can mark it as 
inactive.

To define a currency

1 Navigate to Administration - Data screen > Currencies view.

2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Code A three-letter code for the currency.

Name The name of the currency.
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Setting Up Currency Conversion
This section discusses how to set up exchange rates and includes related background information. It 
includes the following topics:

■ Setting Up Exchange Rates. You must set up exchange rates used to convert currencies. 

■ Understanding the Euro and Triangulation. If a currency is part of the European Monetary 
Union, you convert it to other currencies through the Euro. 

■ Currency Conversion Functionality. The currency conversion rates that you set up are used 
by a number of features of Siebel applications. 

Setting Up Exchange Rates
After you have set up your currencies, but before you use any currency features or import data with 
foreign currencies, you must set up exchange rates that are used to convert currencies.

Issuing Country The country that issues the currency.

Symbol The symbol for the currency, such as $.

Scale The number of places after the decimal used for displaying currency in the 
interface. For example, U.S. Dollars has a scale of 2 to accommodate the 
cents, so an amount would be displayed as $10.50. If the scale were 1, 
this same amount would be displayed as $10.5. 

Smallest 
Denomination

The smallest unit of currency available. For instance, the smallest unit of 
currency for the U.S. Dollar is one cent, or .01 dollars. If there were no 
cents, the scale would still be 2, but the smallest denomination would be 
$0.05.

EMU Triangulation Check to indicate that this currency must be converted to other checked 
currencies using the EMU Triangulation method. 

Active Indicates whether or not the currency can be chosen by the end user.

Start Date The date when the currency becomes active.

End Date The date when the currency is no longer active. 

Extended Scale The number of places after the decimal used for storing currency data in 
the database. If the values in the Extended Scale and Scale fields are 
different, results of currency calculations, for instance conversions or 
discounts, may be different than expected. This is because the currency 
values that are stored in the database are used for these calculations, 
rather than the displayed values.

Field Comments
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If you fail to set up an exchange rate, currency is converted on a 1:1 basis. This means that the 
amount stays the same but the currency symbol changes.

NOTE: To calculate exchanges between currencies, you must set up an exchange rate twice—one for 
each currency. For instance, if you want to calculate exchange rates between U.S. dollars and 
Japanese yen, you must set up an exchange rate for yen to dollars, and set up another rate for dollars 
to yen.

To set up exchange rates

1 Navigate to Administration - Data screen > Currencies view.

2 In the Currencies list, select the currency for which you want to establish exchange rates.

3 Click the Exchange Rates view tab.

4 In the Exchange Rates list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

5 Repeat this process to add additional exchange rates.

You must restart the Siebel client or use the clear cache command before any changes to exchange 
rates can be seen in your Siebel application. For more information about clearing the cache, see 
“Clearing the Cache” on page 79.

Field Comments

Type Currently, Daily is the only type used. 

To Currency The currency to which you are converting the currency selected in the 
currencies list.

Exchange Rate The conversion rate. 

Exchange Date The date of this conversion rate. When converting currencies, Siebel 
applications use the exchange rate whose date is closest to, but not past, 
the date of the transaction. Depending on the accuracy that you need and 
on how much currency values are fluctuating, you may want to enter a new 
exchange rate every week, month, quarter, or year. 

Siebel applications use the Exchange Date only to convert currencies in 
transactions in which money has been or will be received. For example, 
Quote Item Price has an Exchange Date field, because it represents money 
that your company will receive, and your sales representatives should enter 
the date when the money will be received. 
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The Euro and Triangulation
NOTE: As of January 2002, the Euro Triangulation method for converting between currencies 
belonging to EMU members is not needed for present and future currency exchanges. However, the 
method is still available in Siebel applications, as are the old currencies, so that historical data can 
be maintained accurately. The following description applies only to historical data needing conversion 
prior to the 2002 switch to the Euro for the EMU member countries.

If a country is a member of the European Monetary Union (EMU), you should convert its currency to 
other currencies through the Euro. This is called triangulation, and it is used whenever either 
currency being converted has EMU Triangulation checked. 

For example, if you are converting from USD to DEM and DEM has EMU Triangulation checked, you 
must set up the conversion rates between US dollars and the Euro and between the Euro and US 
dollars. You do not have to check the EMU Triangulation field for USD. The DEM is converted to EUR 
according to the fixed exchange rate set by the European Monetary Union, and then the amount in 
EUR is converted to USD according the exchange rate you set up.

The EMU Triangulation field is already checked for the following European Monetary Union member 
nations: Germany (DEM), Belgium (BEF), Spain (ESP), France (FRF), Ireland (IEP), Italy (ITL), 
Netherlands (NLG), Austria (ATS), Portugal (PTE), Finland (FIM), and Luxembourg (LUF). However, 
you can check or clear this field. For instance, if the United Kingdom or Sweden joins the EMU, then 
you can check the field for that currency.

To calculate triangulation conversion, the conversion rate is always expressed to six significant 
figures. Conversions from one national currency unit into another are made by: 

1 Converting the monetary amount from the national currency unit into the Euro. 

2 Rounding the result to not less than three decimal places. 

3 Converting the result to the target national currency. 

4 Rounding the result to the lowest subunit of the target national currency, such as pfennig for the 
German mark or centime for the French franc.

NOTE: The EMU Triangulation field should be checked only for currencies that are subdivisions of the 
Euro. 

Currency Conversion Functionality
Currency conversions currently occur in your Siebel application in various features. Some examples 
follow:

■ Price lists. When you change the currency code of a price list, it prompts you for an exchange 
date and converts the prices of all of the price list items.

■ Quotes. When you change the currency code of a quote, it will convert the discount amounts 
and discount prices. 

■ Forecasting. When you update forecast information from the opportunity, it will do a currency 
conversion from the opportunity currency to the forecast currency if the currencies are different. 
When you roll up the forecast lines, it will do a conversion from the forecast line currency to the 
rollup forecast currency if the currencies are different.
Applications Administration Guide Version 7.7, Rev. B ■ 55



Ongoing Application Administration Tasks ■ Setting Up Expense Types
■ Projects. When you create expenses in a currency different from the project’s currency and 
submit the expenses to the project, the expense amount will be converted from the expense 
currency to the project currency in the Project Time Expenses Summary and Project Time 
Expenses Adjustments views.

■ Rate lists. When you change the currency code of a rate list, it will prompt you for an exchange 
date and convert the prices of all of the price list items. 

■ Expense reports. When you prepare expense reports, you can perform currency conversion 
between the expense currency and your default currency. 

■ Reports. The following reports support currency conversion:

■ Opportunity Pipeline Report by Rep. Opportunity revenues created in different currencies 
will be converted in the Total and Subtotal fields to the user’s default currency.

■ Euro Expense Report. If expenses have been created in an EMU currency, all expenses will 
be displayed in dual currencies.

■ Project Limit Summary Report. 

■ Forecasting Reports. 

■ Current Quotes Report. 

■ Charts. The following charts support currency conversion:

■ Opportunity Current Opportunity Analysis. Opportunity revenue will be converted to the 
user’s default currency if both the opportunity currency and the revenue currency are 
different from the user’s default currency.

■ Forecast Analysis. 

Setting Up Expense Types
When employees create expense reports, they choose an expense type for each line item in the 
report. For example, when employees travel on business, they might have to enter line items with 
expense types Food, Airfare, Car Rental, Hotel, and so on. 

When you set up expense types, you specify what expense types are available to employees in the 
drop-down list that they use to choose expense types. You also specify how these expense types are 
to be categorized and summarized in expense reports. 

You can also create establishments that are associated with these expense types. For example, if the 
expense type is Airfare, you might associate establishments with it such as Air Canada and British 
Airways. For more information about associating expense types with establishments, see Siebel 
Professional Services Automation Guide.

NOTE: Before you can add expense types and establishments, you must add them in the List of 
Values Administration screen so that they can be displayed in the drop-down list. Create expense 
types under EXP_ITEM_TYPE, and create establishments under EXP_ITEM_ESTAB. For more details 
about List of Values administration, see Chapter 5, “Working with Lists of Values.” 
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To set up expense types

1 Navigate to the Expense Reports screen > Expense Types view.

2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Setting Up Payment Terms
Payment terms are the different terms that you offer to your customers, such as Net 30 days and 
Net 60 days. You set up payment terms so that they are available in your Siebel application, for 
example in the Quotes screen.

To set up a payment term

1 Navigate to the Administration - Data screen > Orders > Payment Terms view.

2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Expense Type Enter the expense type that the employee will choose in the Expense Type 
drop-down list of expense report line items, such as Airfare. 

Report 
Category

Enter a category for this expense type. This category will be used in 
summary reports, such as Air/Rail Fare.

Summary Enter a larger summary category for this expense type, such as Travel Cost. 
This summary category will be used in summary reports.

Field Comments

Payment Term Enter a name for the payment term, such as Net 30. 

Net Days If the payment term requires payment in a specific number of days after the 
order date, enter the number of days. Optional

Description Enter a description of the payment term. Optional. 

Discount If there is a discount for early payment, enter the amount of the discount. 
Optional. 

Discount Days If there is a discount for early payment, enter the number of days within 
which a customer must pay to qualify for the discount. Optional. 

Due If there is a specific due date for payment, enter the due date. Optional. 

Integration ID Users should not modify this system field. It is a cross-reference that links 
the Siebel application to corresponding payment term information in the 
back-office application. 
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Setting Up Periods
Periods are time periods that are used in your business, such as Q1 2002 or Jan. 2001. Periods are 
used extensively in the Siebel application, such as in forecasting, time sheets, incentive 
compensation, and expense reports. 

Be sure to set up periods far enough into the future that forecasting will work. For example, the 
default forecast is for seven months ahead. Therefore, if you keep this default, you must create 
periods defined for at least seven months from the current date for forecasting to work correctly. 

After setting up a period, you can associate Period Units with it. Period Units allow you to define one 
time unit in terms of another. For example, day periods can be associated with week periods for use 
in Timesheets. When a new timesheet is created, based on a week period, each day in that week is 
also added to the timesheet. This functionality requires the day periods to be associated as Period 
Units with the week period.

To set up periods

1 Navigate to the Administration - Data screen > Periods view.

2 In the Period Definition list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

To associate period units with a period

1 Navigate to the Administration - Data screen > Periods view, and select the appropriate period.

2 In the Period Units list, create a new record.

3 In the Period Units dialog box, select all the period units to associate with this period, and then 
click OK.

Specifying Telephone Formats
Default telephone formats are specified in the List of Values view. You can only have one default 
telephone number format per country code. The default format is applied when you enter only 
numbers, without slashes, dashes, or other formatting symbols. 

Field Comments

Period Enter a name for the period, such as Q1 2001. 

Closed Select this to indicate that the period has already closed.

Start Enter the start date for the period. 

End Enter the end date for the period. 

Type Select the type of period, such as month, quarter, or year.

Description Enter a description of the period.
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Before users enter telephone numbers:

■ Set the default country. See “Setting Up Locales” on page 41. The default phone format is 
determined by the locale setting. 

■ Define formats for countries outside the default country. See “Specifying Non-North American 
Telephone Formats” on page 59.

If a user enters a telephone number from a country for which the format has not yet been specified, 
the telephone number may be formatted incorrectly.

NOTE: If you define any new telephone formats, coordinate with communications administrators 
who specify CTI functionality and define dialing filters. For more information, see Siebel 
Communications Server Administration Guide. 

North American Telephone Formats
The default format for North American telephone numbers is (000) 000-0000. The telephone 
formatting logic for North American telephone numbers works as follows:

■ If the user enters 10 digits in a telephone number field, it is formatted as (123) 123-1234.

■ If the user enters more than 10 digits, the first 10 digits are formatted as (123) 123-1234, and 
the rest of the digits are used as the extension number. The user can enter up to 40 digits.

■ If the user enters fewer than 10 digits, an error message appears.

■ If the user begins the telephone number with a leading zero, an error message appears.

This telephone formatting logic is followed even when the default country is not in North America.

Specifying Non-North American Telephone Formats
If your users need to enter telephone numbers for countries outside North America, you must specify 
telephone number formats for those countries.

To specify non-North American telephone formats

1 Navigate to the Administration - Data screen > List of Values view.

2 Query the Type field for the entry PHONE_FORMAT to see existing telephone formats.
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3 Create a new record and complete the necessary fields.

Some fields are described in the following table.

4 Stop and restart the Siebel Server.

International Telephone Formats
To enter an international telephone number (a telephone number for a country other than the current 
default country) in a telephone field, the user must specify the country by preceding the telephone 
number with a plus sign (+) followed by the country code (for example, +44). If the user does not 
enter a country code, the default country code is assumed.

After the user indicates the country by entering the plus sign and country code, the telephone 
formatting logic for international telephone numbers works as follows (assuming that there is a List 
of Values telephone format entry for the indicated country):

■ If the user enters exactly the same number of digits in a telephone number field as there are in 
the telephone format for the indicated country, the entry is formatted as specified.

■ If the user enters more than the number of digits in the telephone format for the indicated 
country, the first digits are formatted as specified and the rest of the digits are used as an 
extension number.

Field Comments

Display Value

Language-
Independent Code

Enter the format string.

Use the number zero (0) to represent required digits, the character # 
to represent optional digits, and other formatting characters to 
represent how the telephone number should appear. Do not include any 
alphanumeric characters other than 0.

For example, to format an Australian phone number, which includes a 
two-digit area code and a six- or eight-digit number, use (00) 000# 
000#.

You do not need to include characters to represent the country code in 
the format. When a user enters a number, the country code is 
automatically shown if the default country is different from the country 
code.

If a phone number has more digits than the format, the extra digits are 
used as the extension. For example, if the format is 000-00-0000 and 
the phone number entered is 12345678912, the number is displayed 
as 123-45-6789x12.

Order Enter the country code of the new format. When adding new codes, 
make sure that no country code is a prefix of any other. For example, 
because India’s country code is 91, you should not add a country code 
of 9 or of 910 (or any other number beginning with 91). 

Type Enter PHONE_FORMAT or choose it in the drop-down list.
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■ If the user enters fewer than the number of digits in the telephone format for indicated country, 
the entry is accepted without an error message. (This is to accommodate telephone numbers of 
different lengths.)

If there is no List of Values telephone format entry for the indicated country, the number remains 
formatted the way that you enter it. No error message is returned.

Unformatted Telephone Numbers
When you change or add a telephone number format, the existing telephone numbers are not 
updated automatically.

CAUTION: When entering telephone numbers, users can enter letters in place of digits, but 
computer telephony integration (CTI) features, such as outbound dialing, do not work for these 
numbers. Queries for such numbers must include the letters, not the numeric equivalents. Siebel 
eBusiness Applications do not detect or warn users if they enter Q or Z (letters that do not appear 
on all telephones).

Examples
Table 8 shows how telephone numbers would appear under various circumstances. In this example, 
the default country is the United States and the default format is the North American format, (000) 
000-0000. Another format has been entered for country code 91: 00-000-0000.

The telephone format has no effect on sort order.

When performing a query on a telephone number, do not include any format characters such as (,), 
-, ., x, or spaces.

You can query for only country 61 by typing +61* but you cannot query for only North American 
telephone numbers this way, because +1* returns all telephone numbers. To query for North 
American telephone numbers, use not like +* instead.

Table 8. Telephone Number Format Examples

User Enters Number Is Formatted As

1234567890 (123) 456-7890

1234567890123 (123) 456-7890 x123

123456 Error message: “Invalid data has been entered.”

+91123456789 +9112-345-6789

+9112345678910 +9112-345-6789 x10

+9112345 +9112345

+2512345 +2512345

?0+9112345678 ?0+9112345678 (you see the ‘?’ and the ‘0’)

?0HelloWorld ?0HelloWorld (you see the ‘?’ and the ‘0’)
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Table 9 gives examples of how to query telephone numbers.

When the user performs a query using a telephone number, the country code of the default country 
automatically prefixes the query (unless the default country is in North America, in which case no 
prefix is added). For example, if the default country is Germany, and the user types “0181” in the 
telephone field of a query, the German country code (+49) is added to the query (that is, 
+49*0181*). 

To find a number for a country other than the default country, the user must specify the country code 
in the query. To avoid limiting the query to one country, the user must refine the query and remove 
the country code portion of the query specification.

To see a demonstration of this behavior, look at the Contacts screen. Every number for a country 
other than the default contains a “+n” at the beginning, while every number for the default country 
code appears as local (no +). Numbers that have the “+n” require explicit queries (country code plus 
number) while local numbers are returned normally.

Importing Information with EIM
Siebel Enterprise Integration Manager (EIM) manages the exchange of data between Siebel database 
tables and other corporate databases. When you use EIM to import information that includes 
international telephone numbers, the numbers are handled as described in the previous sections.

For more information about EIM, see Siebel Enterprise Integration Manager Administration Guide.

Table 9. Querying Telephone Numbers

Desired Query Result Query Criteria

(123) 456-7890 1234567890

+61(123) 45.67.89 x0 +611234567890 (if 61 is defined as a country 
code)

Country code 61 telephone numbers +61*

All telephone numbers +1*

415 area code numbers (North America only) 415*

Null telephone numbers is null

415 area code or null (North America only) 415* or is null

(800) SKY-PAGE 800SKY*
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Maximum Length for International Telephone Numbers
Refer to Table 10 to calculate the safe maximum length for international telephone numbers: 

In the formulae in Table 10: 

■ C is the length of the country code

■ N is the length of the city code and the subscriber number, including any formatting, such as 
spaces or hyphens

■ E is the length of the extension number

Figure 1 shows an example.

Setting Up Pager Companies
Pager companies can be set up so they are available from the File > Send > Page menu.

To set up a pager company

1 Navigate to the Administration - Communications screen > Pager Companies view.

2 In the Pager Companies list, create a new record and complete the necessary fields. 

NOTE: The pager companies you use to send pages must support Telocator Alphanumeric Protocol 
(TAP), which is an industry standard for sending alphanumeric pages.

About Date Formats
For the Siebel Web Client the display format for date and time is determined by the locale settings 
of the application server. For more information, see “Setting Up Locales” on page 41.

For the Siebel Dedicated Web Client and the Siebel Mobile Web Client, the date format is determined 
by the specification in the client computer’s operating system. 

Table 10. Maximum Length for International Telephone Numbers

Is there a PHONE_FORMAT 
LOV for the country code?

Then, the safe maximum length for 
international telephone number is

Yes C + 2N + E + 2 ≤ 40

No 2C + 2N + E + 2 ≤ 40

Figure 1. Example International Number
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When a user creates a query using a date field, the user must use the appropriate date format.

Setting Up ZIP Codes
ZIP Codes are used to look up address attributes (City, State, and so on). They are also used to look 
up nine-digit postal codes based on the street address. Siebel eBusiness Applications ship with a 
table of United States Postal Service ZIP Codes, and the table is available for customer use. 

To add a ZIP Code

1 Navigate to Administration - Data screen > ZIP Code Administration view.

2 In the ZIP Geocodes list, create a new record and complete the necessary fields.

Administering Global Time Zone Support
The time zones records that are shipped with Siebel applications as seed data include the 74 world 
time zones. These are the same time zones used by Microsoft in its operating systems. Use the Time 
Zone administration view to:

■ Edit the text descriptions of time zones and their abbreviations 

■ Manage the active status of time zones to control which time zones are available to end users for 
use in the applications

■ Manage multilingual translations to control how time zone information is displayed to users in 
multiple languages

Tasks for administering time zones include:

■ “Modifying Time Zones” on page 64

■ “Maintaining Translations of Time Zones” on page 65

For more information on global time zone support, see Global Deployment Guide.

Modifying Time Zones
You rarely need to modify a time zone’s regional settings. However, you may want to modify other 
time zone settings such as the display name or daylight savings rules, as these occasionally change.

NOTE: You cannot add or delete time zones.

To modify time zone settings

1 Navigate to Administration - Data screen > Time Zone Administration view.

2 In the Time Zone list, select the time zone record you want to modify.
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3 Modify the fields as necessary.

Some fields are described in the following table.

Maintaining Translations of Time Zones 
You maintain translations of the text-based fields for each time zone using the Time Zone 
Administration view.

To maintain translations of time zones

1 Navigate to Administration - Data screen > Time Zone Administration view.

2 In the Time Zone list, select the time zone you want to translate.

3 In the Time Zone Translation list, create a new record and complete the necessary fields, 
including the translation of the Name field for the selected language.

4 Repeat Step 3 for each language required for translation.

Date and Timestamps
The date and time used for timestamping records are obtained by the Siebel Server. When a remote 
user runs the Siebel client in disconnected mode, the Siebel Server runs on the user’s machine and 
takes the date and time from that machine.

If the Global Time Zone feature is enabled, then fields of data type UTCDATETIME are converted to 
UTC during Object Manager-based operations. For more information, see the Global Deployment 
Guide. 

Field Comments

Name Name of time zone.

Standard 
Abbreviation

The abbreviation for the time zone. 

UTC Offset Offset, in minutes, from Coordinated Universal Time (UTC) when daylight 
savings is not in effect.

DST Abbreviation The abbreviations for daylight savings time (DST).

DST Bias Incremental DST offset, in minutes, from UTC when DST is not in effect.

DST Start Ordinal Part of the rule that determines when DST starts. For example, if the rule 
is the first Sunday in April, First is defined in this field.

DST Start Day Part of the rule that determines when DST starts. For example, if the rule 
is the first Sunday in April, Sunday is defined in this field.

DST Start Month Part of the rule that determines when DST starts. For example, if the rule 
is the first Sunday in April, April is defined in this field.

DST Start Time Minutes after midnight that DST starts. For example, if DST starts at 2:00 
A.M., set the start time to 120.
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Setting Up Email, Fax, and Mail Accounts 
(Contact Us)
Salespeople use the Contact Us screen to answer questions and provide contact information to 
customers. If your organization uses Siebel eService, your customers can access this information 
directly from a Contact Us page on your Web site.

Creating a Contact Us Account
To help your salespeople provide information on a chosen topic, you can create different accounts, 
such as Technical Support, Shipping, and Sales.

To add a Contact Us account

1 Navigate to Administration - Application screen > Contact Us view.

2 In the Email, Fax and Mail Accounts list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

About Adding Email Addresses and Subjects
If your organization uses Siebel eService, any email addresses you include in Contact Us accounts 
appear on a Contact Us page on your Web site. You can create default email subjects that are added 
to the user’s Subject line when the user sends email through your Web site.

For more information, see Siebel eService Administration Guide.

Setting Up Industries
You can set up and maintain industry information used throughout the application. The information 
in the Industries view populates the Industries drop-down list, which is found in a variety of screens 
and views, such as in the Accounts and References screens. The Industry list can also be used by 
Siebel Assignment Manager to assign new leads or service requests to Siebel users. For example, a 
sales representative who covers the pharmaceutical industry can be assigned automatically to new 
accounts based on a Pharmaceutical Industry value. 

To add an industry

1 Navigate to Administration - Data screen > Industries view.

2 In the Industries list, create a new record. 

Field Description

Account Type Choose the Contact Us type.

Access List Indicates which employees can view the Contact Us account.
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3 Complete the Industry, SIC Code, and Type fields. 

NOTE: The Industry and SIC Code values must be unique. If you add a value that already exists, 
you receive an error message. 

Setting Up Languages
You can set up and maintain language information used throughout the application. The information 
in the Languages view populates the Language drop-down list, which is found in a variety of screens 
and views, such as in the References and SmartScripts screens. The Language field can also be used 
by Siebel Assignment Manager to give assignments to call center agents who work for international 
companies and speak a variety of languages with customers. 

For example, a sales representative for a German chemical manufacturing company could use a 
Danish SmartScript to make a sales call to a prospective customer in Copenhagen, and then make 
the same sales call using an Italian SmartScript when speaking to a prospective customer in Rome. 
In these cases, the Language field is used to identify the language into which each SmartScript has 
been translated.

To add a language

1 Navigate to Administration - Data screen > Languages view.

2 In the Languages list, create a new record. 

3 Complete the Name and Code fields.

NOTE: The Name and Code values must be unique. If you add a value that already exists, you 
receive an error message.

NOTE: Languages cannot be deleted because deleting languages may cause problems with Mobile 
Web Client synchronization. While the delete language command can be restored using Siebel Tools, 
this is strongly discouraged. Additionally, ask for assistance from Siebel Technical Services before 
modifying any language code.

About Case Sensitivity
By default, Siebel applications are case-sensitive. If you perform a query or search, there is a match 
only if the search criteria you enter are capitalized in the same way the data is capitalized in the 
database. 

If you do not want queries and searches to be case-sensitive, you can enable case insensitivity either 
for the entire application or for selected fields. Regardless of which setting you choose, users can 
use operators to force case-sensitive or case-insensitive searches.

For information on how case insensitivity affects performance, see Performance Tuning Guide.

To force a case-sensitive search, use the operator = followed by the criterion in single quotation 
marks. For example, if the user enters the criterion = ‘Computer’, the query returns only records that 
have “Computer” spelled with a capital C in the field.
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To force a case-insensitive search, use the operator ~LIKE. For example, if the user enters the 
criterion ~LIKE computer, the query returns all records that have “computer” in the field, regardless 
of capitalization. 

The user must also use ~LIKE to force case insensitivity in searches with complex criteria, regardless 
of the setting for case sensitivity. 

NOTE: You should determine your requirements for case-insensitive searching and set the 
appropriate parameters for the application or individual field before users enter any data.

Enabling Application-Wide Case 
Insensitivity

About the CaseInsensitive Parameter
Application-wide case sensitivity is controlled through the CaseInsensitive parameter of the named 
subsystem representing the data source definition. 

The CaseInsensitive parameter only affects which data is retrieved by queries. It does not affect the 
order in which data appears on the screen. The sort sequence is database-dependent, and 
independent of the CaseInsensitive parameter.

In addition, the content of SRF files is case-sensitive in most cases and is not affected by how this 
parameter is set in the application configuration file.

You change the CaseInsensitive parameter in different ways, depending on whether you are working 
with Siebel Web Client or Siebel Dedicated Web Client:

■ “Enabling Application-Wide Case Insensitivity for Siebel Web Client” on page 69

■ “Enabling Application-Wide Case Insensitivity for Siebel Dedicated Web Client” on page 69

About the InsensitivityFactor Parameter
When you change the CaseInsensitive parameter, you may also want to change the 
InsensitivityFactor parameter to minimize performance degradation. 

The default setting for the InsensitivityFactor parameter is 2.

NOTE: Do not change the default value of InsensitivityFactor for Gateway Data Source 
(GatewayDataSrc) in the CFG file. 

You may want to test a number of values for this parameter with your database, spool the SQL to 
see the effect of different settings on response time and then choose a value that meets your needs. 
For more information about the InsensitivityFactor parameter, see Siebel System Administration 
Guide.
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Enabling Application-Wide Case Insensitivity for Siebel Web Client
For Siebel Web Client, you make changes to the CaseInsensitive parameter in the Administration - 
Server Configuration screen.

To enable application-wide case insensitivity for Siebel Web Client

1 Navigate to the Administration - Server Configuration screen > Enterprises view.

2 Click the Profile Configuration view tab.

3 In the Profile Configuration list, select a data source record, for example, the Server Datasource.

4 In the Profile Parameters list, change the value of the DSCaseInsensitiveFlg to True.

Optionally, change the DSInsensitivityFactor parameter as well, to control performance 
degradation. 

5 Stop and restart the Application Object Manager (AOM) server components.

Enabling Application-Wide Case Insensitivity for Siebel Dedicated 
Web Client
For Siebel Dedicated Web Client, application-wide case sensitivity is controlled through the 
CaseInsensitive parameter in the configuration file for your application. 

The configuration file for each Siebel application has a section for each one of the potential data 
sources for the application. By default, each of these data source sections has the following line:

CaseInsensitive = FALSE

To enable application-wide case insensitivity for Siebel Dedicated Web Client

1 Use any text editor to open your application configuration (CFG) file. 

2 Change the CaseInsensitive parameter to

CaseInsensitive = TRUE

3 Optionally, change the InsensitivityFactor parameter to control performance degradation. 

The InsensitivityFactor parameter follows the CaseInsensitive parameter in each application 
configuration file. 

Enabling AOM Case Insensitivity
It is possible to have different case sensitivities for different Application Object Managers (AOMs). 

The procedure outlined here for changing the case settings for individual server components should 
only be carried out by an experienced configurator. 
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To set case insensitivity for a single AOM

1 Create a new Server Datasource that is the same as the standard Server Datasource except that 
DSCaseInsensitiveFlg = TRUE.

2 Create a new AOM. 

The new AOM is required because the Datasource parameters are fixed for the standard AOMs 
and cannot be changed there.

NOTE: Copying an object manager does not set all parameters automatically in the copy, so you 
need to set them manually.

3 For the following parameters, replace each ServerDataSrc value with your new Datasource name:

■ CFGDatasource

■ DataSource

■ NamedDataSource (This is an advanced parameter.)

Enabling Field-Specific Case 
Insensitivity
You can also make individual fields case-insensitive.

You control field-specific case insensitivity with the Use Default Sensitivity property. This property 
determines whether the field uses the default property specified by CaseInsensitive parameter in the 
CFG file, described previously. Table 11 illustrates the relationship between the application-wide 
CaseInsenstive parameter and the field-specific Use Default Sensitivity property.

To enable case insensitivity for individual fields

1 Leave the CaseInsensitive parameter set to FALSE in the application configuration file.

2 In Siebel Tools, navigate to the Business Component/Field screen. 

3 For each field you want to be case-insensitive, set the Use Default Sensitivity property in the field 
object to FALSE for the Field level Object Type.

You can also force the case of data in a field to be UPPER (all uppercase), LOWER (all lowercase), 
FIRSTUPPER (first letter of each word is uppercase, or NONE (unchanged). 

4 After doing this for all of the fields you want to control, recompile your SRF file.

Table 11. Case Sensitivity Behavior

Use Default 
Sensitivity = CaseInsensitive = TRUE CaseInsensitive = FALSE

TRUE Field is case insensitive Field is case sensitive

FALSE Field is case sensitive Field is case insensitive
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5 Replace the SRF file in your Siebel Server installation. 

Adding Web Browser Capabilities
Siebel applications come with a number of browsers configured for use. Generally, you do not need 
to make changes to the Web browser settings. However, if you need to add a capability to a browser, 
you can do so through the Web Browser Administration screen. 

Web browser capabilities identify what an end user's browser can and cannot do. They support the 
Siebel Web Engine's ability to provide different HTML tags and other markup tags to different 
browsers, based on what each particular browser is capable of rendering. This can also allow an 
administrator or developer to specify what looks best in a particular browser. 

When a user logs into a Siebel Web application, the Siebel Web Engine reads information 
encapsulated in the requests coming from the user's browser to determine the browser’s version and 
make. It then correlates that information with the data contained in the Web Browser Administration 
views to determine the browser’s capabilities.

One of the primary ways this information is applied is through conditional tags in Web templates. For 
example, if some of your users use an older browser that does not support frames, your template 
might include a conditional tag that prevents these users from receiving pages with frames. 
Conditional Web engine tags that evaluate browser capabilities can be used in all Siebel Web 
templates and Web applications, but are used most prominently in those that support wireless 
devices. For example, the SWLSStart.swt template includes the following conditional tag:

<swe:switch>

<swe:case condition="Web Engine User Agent, TestCapability, 'DefaultMarkup:XML'">

<swe:pageitem id="3" property="FormattedHtml" />

</swe:case>

By the time that the Web Engine interprets the swe:case tag, it has already determined what type 
of browser the user has. The usage of the tag causes the Web Engine to call the TestCapability 
method on the Web Engine User Agent business service. The TestCapability method returns TRUE if 
the user’s browser has a Capability called DefaultMarkup with a value of XML. When the condition is 
met (that is, the method returns TRUE) the tags between <swe:case> and </swe:case> are 
processed. For more information about the syntax of conditional tags, see Configuring Siebel 
eBusiness Applications.

Adding Additional Capabilities 
Siebel applications come with a number of predefined capabilities. These capabilities can be added 
to any browser. Some examples include:

■ FrameSupport. Indicates whether the browser can render frame tags (for example, 
<swe:frameset>).

■ CookiesAllowed. Indicates whether the browser supports cookies.
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■ HighInteract. Indicates whether the browser is among those supported for Siebel's High 
Interactivity Web applications (such as Internet Explorer 5.5).

■ ActiveX. Indicates whether the browser can support ActiveX controls.

You can also add other capabilities that are not included in the standard Siebel application. For 
example, you could add a capability named SupportsWingDingFont. New capabilities then become 
available for use in any browser definition.

To add a capability

1 Navigate to Administration - Web Browser screen > Capabilities view.

2 In the Capabilities list, create a new record.

3 Complete a name and description for the new capability.

Adding Additional Web Browsers
If you need to add a Web browser definition that is not included in the standard Siebel application, 
you can choose between the following two methods.

■ Add a parent browser definition. This definition includes all of the browser capabilities. Use 
this method if you need to add a completely new browser (such as Opera), or a major upgrade 
release of an existing browser (such as future releases of Microsoft Internet Explorer or 
Netscape). For information about this procedure, see “To add a parent Web browser” on page 74.

■ Add a child browser definition. Child browser definitions inherit the capabilities of the parent 
browser, and add additional capabilities as necessary. Use this method for adding interim 
releases based on a browser that is already defined. For example, a “dot” release, such as 5.7 
or 5.8. For information about this procedure, see “To add a child Web browser” on page 74.
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Required Browser Capabilities
For a browser to work correctly, it must include two capabilities that allow the browser to be identified 
at run time. The required capabilities are:

■ User-Agent. This capability names the browser. 

■ Accept. This capability indicates what types of documents the browser can open. 

These capabilities are part of HTTP standard information and appear in HTTP request headers sent 
from a browser. For example, a request from a Microsoft Internet Explorer 5.5 browser sent to a Web 
application might include the following lines:

Accept: image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, application/vnd.ms-
powerpoint, application/vnd.ms-excel, application/msword, */* 

User-Agent: Mozilla/4.0 (compatible; MSIE 5.5; Windows NT 4.0)

In this example, the value for the User-Agent capability would be Mozilla/4.0 (compatible; MSIE 5.5; 
Windows NT 4.0).

Both the User-Agent and Accept capabilities must be included. This is because at run time, the User-
Agent is checked to identify the browser. If the User-Agent is not recognized, the values for the 
Accept parameter in the header are compared to the Accept parameters of the browsers listed in the 
Web Browser Administration screen, to find the browser with the most closely matching Accept 
parameters. 

In addition to the User-Agent and Accept capabilities, if a browser is based on an existing parent 
browser, it must include the Parent capability.

NOTE: Parent browsers frequently do not have the User-Agent and Accept capabilities. This is 
because parent browsers are intended to serve as containers of other capabilities that can be 
inherited. If a browser does not have its own User Agent and Accept capabilities, then it is acting as 
a parent of another browser that has these capabilities.

Adding JumpTab Capability for Internet Explorer 5.0
If you are running your Siebel application on Internet Explorer 5.0, you need to set the JumpTab 
capability to True. 

(If the JumpTab capability is not set, users need to click the back button twice to return to the 
previous page.)

To add the JumpTab capability

1 Navigate to Administration - Web Browser screen > Capabilities view.

2 In the Capabilities list, select the JumpTab capability record.

3 In the form, in the Capability Value field, enter TRUE.
Applications Administration Guide Version 7.7, Rev. B ■ 73



Ongoing Application Administration Tasks ■ Administering Quick Fill Templates
Adding a Web Browser
Whether you are adding a parent browser or a child browser, the process is similar. However, in the 
case of a parent browser, you add all detailed components, and in the case of a child browser, you 
base the browser on an existing browser.

NOTE: Although a parent browser may contain the User-Agent and Accept capabilities, it does not 
have to. If you use parent browsers as templates for child browsers, do not include these two 
capabilities in the parent browser template. 

To add a parent Web browser

1 Navigate to Administration - Web Browser screen > Browsers view.

2 In the Browser list, create a new record.

3 Complete a name and description for the new browser.

4 Drill down on the record.

5 In the Capabilities list, create records for each of the capabilities for this browser.

NOTE: If there is an existing browser that contains most of the appropriate capabilities, you can copy 
it and then make changes. To do so, in Step 2, click the menu button and choose Copy Record instead 
of New Record. 

To add a child Web browser

1 Navigate to Administration - Web Browser screen > Browsers view.

2 Note the name of the parent browser (that is, the one on which you will base the new browser).

3 Create a new record.

4 Complete a name and description for the new browser.

5 Drill down on the record.

6 In the Capabilities list, create these three records:

■ Parent. Set the capability value to the parent browser you identified in Step 2.

■ User-Agent. Enter the appropriate User-Agent. 

■ Accept. Enter the types of documents that can be opened by the browser.

7 Add any additional capabilities that are not included in the parent browser or that differ from 
those inherited from the parent browser.

Administering Quick Fill Templates
For information about creating Quick Fill Templates, see Fundamentals.

Users can create quick fill templates for their personal use. Administrators can make these templates 
public so that all users have access to them. Administrators can also delete any quick fill template 
and make simple changes to the template record (such as name, sequence, and public flag). 
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To make a quick fill template public

1 Navigate to the Administration - Application screen > Quick Fill Templates Administration view.

2 Select the template record.

3 Click the Menu button, and select Make Public.

To edit a quick fill template

1 Navigate to the Administration - Application screen > Quick Fill Templates Administration view.

2 Select the template record.

3 Edit the fields as necessary. 

The Sequence Number determines the order in which the fields are filled in. 

Setting Up Default View Links for Screen 
Home Pages
For more information about screen home pages and setting up view links, see Fundamentals. 

Administrators can define links that appear on the quick links area of screen home pages. These 
default view links are visible to all users. 

To add a default view link to a screen home page

1 Navigate to the Administration - Application screen > View Links view.

2 In the Screen Homepages list, select the home page.

3 In the View Links list, create a new record and complete the necessary fields.

Make sure that the view you specify is available to all users.

TIP: Use increments of 10 to sequence the links. This gives users space to create their own view 
links between the default ones that you create.
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5 Working with Lists of Values
This chapter provides guidelines to administrators for working with lists of values within Siebel 
applications. It includes the following topics:

■ “About Lists of Values” on page 77

■ “Adding a New Value to an Existing List of Values” on page 78

■ “Clearing the Cache” on page 79

■ “List-of-Values Fields” on page 80

■ “Modifying a List of Values” on page 82

■ “Inactivating a Value in a List of Values” on page 83

■ “Constrained Lists of Values” on page 84

About Lists of Values
A list of values (LOV) is a set of values that populates a static picklist, which is accessed when a user 
clicks a drop-down list in the user interface.

Drop-down lists can be based on two types of picklists: static picklists and dynamic picklists. 

■ A static picklist has a selection list that is a static list of values. An example of a static picklist is 
a drop-down list containing postal abbreviations for states and countries. 

■ A dynamic picklist has a selection list that usually contains transactional data. An example of a 
dynamic picklist is a drop-down list containing account names. 

As a rule of thumb, dynamic picklists include all picklists that do not retrieve values stored in the 
S_LST_OF_VAL table. Dynamic picklists are typically rendered through a pick applet, such as the 
picklist used to choose an account for a contact. However, they can be configured to appear as 
a drop-down list.

The remainder of this section focuses on static picklists, whose contents can be administered from 
the list-of-values views. For information on how to set up a new list of values and configure both 
static and dynamic picklists, see Configuring Siebel eBusiness Applications. 

This section describes how to work with the values that populate static picklists, including how to 
create or modify values in an existing list of values, and inactivate values when you do not want them 
to display. In addition, it describes how lists of values can be constrained by selections in other lists. 

NOTE: If you will be creating multilingual lists of values (MLOV), you should also review Configuring 
Siebel eBusiness Applications.

There are two views in the Administration - Data screen in which you can view list-of-values data: 

■ In the List of Values view, a list view
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■ In the LOV Explorer view

The values in these two views are the same. Only the format in which the information is presented 
is different. The procedures in this section give instructions that specify using the list view. If you 
prefer to use the explorer view, you may do so.

Your Siebel applications come with numerous lists of values that support the static picklists used 
throughout Siebel screens. You can use these as they are, or you can modify them through the list-
of-values views to support your organization’s requirements. 

Adding a New Value to an Existing List of 
Values
In order to add an item to an existing list of values so that it shows up in a drop-down list, you must 
know its type. You can find out the type by querying the list-of-values list to determine the type 
associated with a specific display value. Then you can create a new record with that type. For 
instance, in the Accounts list you can see the Status drop-down list. Imagine that you use this field 
to indicate ratings for your accounts’ reliability. Initial settings are Gold and Silver. You might want 
to add another status of Bronze to this list, to give to customers that have a reliable account rating. 
The procedure below uses this example.

The maximum number of values allowed for one LOV type is 10,000.

To identify the list-of-values type for a display value

1 Navigate to the screen displaying the drop-down list to which you want to add a value (for 
example, the Accounts screen).

2 Select the drop-down list and make note of one of the choices. 

For example, in the Accounts screen, select the Status drop-down list and make note of the value 
Gold.

TIP: Be sure to note the capitalization and spacing of the choice.

3 Navigate to Administration - Data screen > List of Values view. 

4 In the list-of-values list, perform a query in the Display Value field, using the value you noted in 
Step 2.

5 In the list of records that is returned, identify the appropriate record by reviewing the entries in 
the Type field. 

List-of-values types usually have names that relate to the field labels in the screens where they 
are used. In this example, you would look for a type labeled something like ACCOUNT_STATUS. 

When you create a new value for this list, you will use this type.

To add a new value to an existing list of values

1 Navigate to Administration - Data screen > List of Values view. 
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2 Click New to create a new record, and then enter the list-of-values type in the Type field. 

3 Enter a new value in the Display Value field. 

For example, if Bronze is the status that your organization gives customers that have a reliable 
account rating, and you want to make Bronze available as in the Account Status drop-down, you 
would create a new record with ACCOUNT_STATUS as the type and Bronze as the display value. 

Make sure that the length of the Display Value you enter does not exceed the allowed length of 
the destination column.

4 Enter a value in the Language Independent Code field. This value is usually the same as the 
Display Value.

Make sure that the length of the Language Independent Code you enter does not exceed the 
allowed length of the destination column. 

NOTE: The Display Name and Language Independent Code must both be unique within a list-of-
values type, except when configuring a multilingual list of values. If you add a value that already 
exists, you get an error message. For example, there cannot be two ACCOUNT_STATUS records 
that have a display value of Bronze. For information about how this differs for multilingual lists 
of values, see the definition of the Language Independent Code field in Table 12 on page 80.

5 If applicable, in the Order field, you can enter a number to indicate the numerical order in which 
the value appears in a drop-down list. 

For example, if the order numbers for Gold and Silver are 1 and 2, respectively, the order number 
for Bronze would be 3.

6 If appropriate, complete the remaining fields in the record. 

For a description of these fields, see “List-of-Values Fields” on page 80.

7 Clear the LOV cache by clicking Clear Cache. 

After you have cleared the cache, you can navigate to a screen and select the new value in the related 
drop-down list. For example, you can navigate to the Accounts screen, select a record from the 
Accounts list, and then choose Bronze in the record’s Account Status drop-down list.

Clearing the Cache
A particular list of values is cached the first time a user opens a drop-down list that uses the list of 
values. This improves performance by avoiding the need to retrieve the list from the database upon 
subsequent usage of the drop-down list. However, this also means that updates to a list of values do 
not show up in a drop-down list until you clear the cache. Clearing the cache instructs the Siebel 
application to read the updated values out of the database and display them. 

Users who log in after you add or change a list of values can see the addition or change that you 
made. However, in order for you to see the changes that you made in real time, you must do one of 
the following: 

■ For the Dedicated Web Client, log out of the application and log back in.

■ For either the Web Client or the Dedicated Web Client, clear the cache.
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About LOV Caching on Screen Home Pages
LOV caching behaves slightly differently on screen home pages.

On screen home pages, the LOVs are cached as soon as the page is displayed. It is not necessary 
for the user to open the drop-down list in order to have the LOVs cached.

Procedure for Clearing the Cache

To clear the cache (using the Clear Cache button)

1 Navigate to Administration - Data screen > List of Values view. 

2 In the List of Values list, click Clear Cache. 

List-of-Values Fields
List-of-values records have the fields shown in Table 12. Not all fields for list-of-values records are 
displayed in the standard user interface. You can use the Columns Displayed menu option to see a 
field that is not displayed. 

Some list-of-values fields, such as High, Low, and Weighting Factor, are for use by specialized Siebel 
C++ code to store additional information about the selected list-of-values record. In addition, pick 
maps can use list-of-value fields such as High, Low, and Weighting Factor. Pick maps normally use 
the Display Value field, which causes the list item selected by the user to be stored in the database 
exactly as it appears in the list. These fields can be used to populate other fields of the business 
component in which the pick map is defined. 

If you need to use the High or Low fields, or other extra fields, use Siebel Tools to extend the PickList 
Generic BusComp by adding fields mapped to the corresponding columns on the S_LST_OF_VAL 
table. For example, you could use the High and Low fields to automatically fill in the high and low 
temperatures when a user picks a Month value in a Date drop-down list. To do so, you would add two 
pick maps to the Month field by adding the High and Low list of value fields to the Pick List field of 
Pick Map. For more information about the PickList Generic BusComp, and about configuring static 
picklists and pick maps, see Configuring Siebel eBusiness Applications.

NOTE: The Target High and Target Low fields are used exclusively with Smart Reports. For more 
information, see Siebel Reports Administration Guide.

Table 12. List-of-Values Fields

Field Description

Type The type of list of values (the field name). 

Display Value Value as displayed in the drop-down list.

Translate When checked, indicates that internationalization is needed. (There is 
no client or server functionality associated with this field.)
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Multilingual When checked, indicates that the list of values is part of a multilingual 
list of values (MLOV). (There is no client or server functionality 
associated with this field.)

Language Independent 
Code (LIC)

Along with the Display Value, the Language Independent Code 
uniquely identifies a value for a particular LOV type. In most cases the 
Language Independent Code is the same as the Display Value. 
However, the Language Independent Code and Display Value are 
different for multilingual lists of values (MLOVs). MLOVs allow a single 
logical list item to support multiple display values for users who are 
accessing the Siebel application in different languages. 

For example if the MR_MS (Personal Title) list of values were 
multilingual, there might be three list-of-values items with a Language 
Independent Code of Mr. These might have a display value and 
language of Mr. (English-American), Senor (Spanish - Modern), and 
Herr (German), respectively. German users would see Herr in the 
Personal Title drop-down list, Spanish users would see Senor and 
English users would see Mr. Although the display values vary across 
language instances, the value stored in the database when a user 
selects any one of these is always Mr. because that is the Language 
Independent Code associated with Herr, Senor, and Mr. 

Values entered in the Language Independent Code field are sometimes 
referred to as LIVs (language independent values).

Parent LIC (Language 
Independent Code)

The Language Independent Code of a parent list of values. Used in 
hierarchical lists of values, where the values that will display in a drop-
down list are constrained by the value selected in the parent drop-
down list of values. For more information, see “Constrained Lists of 
Values” on page 84.

There are only parents and children in this hierarchy. Grandchildren 
are not allowed. This is enforced by limiting the values in the Pick 
Parent dialog box to those values which do not themselves have parent 
display values.

Replication Level Specifies whether the translation is intended for use at all levels in the 
translation hierarchy or only at the regional level.

High Extra field available for use by pick maps or for customization.

Low Extra field available for use by pick maps or for customization.

Order The numerical order in which a value is displayed within a drop-down 
list.

Active When checked, indicates that the value is displayed to the end user. 
When unchecked, indicates that the value is not displayed to the end 
user.

Table 12. List-of-Values Fields

Field Description
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Modifying a List of Values
CAUTION: Use caution when modifying lists of values that are part of the seed data. Modifying some 
list-of-values fields that are used programmatically by the Siebel application can adversely impact 
standard Siebel functionality. However, you can modify the Display Value field without affecting 
standard Siebel functionality both when the list is a multilingual list of values (MLOV) and when it is 
a standard list of values. 

Modifying some lists of values can adversely impact standard Siebel functionality:

■ Do not change the Language Independent Code values for lists of values because the internal 
Siebel application uses the Language Independent Code field. 

■ Some lists of values are for use only by the internal Siebel application and should not be 
modified. For example, the list-of-values SOURCE_TYPE (Internal) and list-of-values types that 
include REPOSITORY in the Type field name are for internal use only.

■ Some list-of-values modifications can have undesired results. For example, changing all lists of 
values in the application to uppercase or changing the Language Independent Code from the 
Siebel standard can result in values not being displayed or being displayed improperly.

NOTE: Modifying a Display Value field does not automatically update records that have been 
populated with the old value. For example, if you change Ms. to Miz in the Display Value field, Miz 
show up in the drop-down list, but all contact records that were previously entered with Ms. in the 
Personal Title field still have Ms. in the Personal Title field.

For more information about multilingual lists of values (MLOVs), see Configuring Siebel eBusiness 
Applications.

In order to modify a value in a drop-down list, you must know its display value and type. You can 
find out the type by querying the list-of-values list for a specific display value. For example, if you 
needed to make a change to the value 1-ASAP in the Priority drop-down list in the Activities screen, 
you could do so using the following steps.

To modify an item in a list of values

1 Navigate to Administration - Data screen > List of Values view. 

2 Click the menu button, and then choose New Query.

Language Name Language used for the list of values Display Value field. 

Target Low Extra field used in Smart Reports.

Target High Extra field used in Smart Reports.

Weighting Factor Extra field available for use by pick maps or for customization.

Bitmap Bitmap file that is displayed.

Description Description of a specific value. 

Table 12. List-of-Values Fields

Field Description
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3 Enter the Display Value for the record you want to change in the Display Value field. 

For example, you might enter the value 1-ASAP.

4 Click the menu button, and then choose Run Query.

A list of records appears that includes the display value that you entered. More than one record 
may appear, and the records may have different types. 

5 In the list of records, select the record that you want to modify, and make the desired change.

6 To see the list-of-values modification in the application, click Clear Cache. For instructions about 
how to clear the cache, see “To clear the cache (using the Clear Cache button)” on page 80. 

Inactivating a Value in a List of Values
You can inactivate individual values in a list, but you cannot delete values. Inactive values are values 
that the application does not display to end users in a drop-down list, whereas active values are 
displayed to end users.

CAUTION: Inactivating some lists of values can adversely impact standard Siebel functionality.

Do not inactivate list-of-values types or values used internally by the Siebel application. For example, 
do not inactivate list-of-values types that include “Repository” in the Type field name.

Be careful when inactivating a list of values, because the application may depend on the list of values 
being present. 

Be careful when inactivating individual values as well. For example, if you inactivate the value 
Commercial in the Account_Type list of values, but you have existing or old account data that stored 
Account Type = Commercial, you may introduce inconsistencies in your data. If you want to 
inactivate a display value, you need to clean up the account records in the database first.

To inactivate a value in a list of values

1 Navigate to Administration - Data screen > List of Values view. 

2 If necessary, perform a query to locate the record you want to make inactive.

3 Select the list of values record you want to make inactive.

4 In the Active field, click the check mark. When a square containing an x appears, click the x. 

The x disappears and the Active field no longer contains a check mark.

5 To see that the value has been inactivated, click Clear Cache. 
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Constrained Lists of Values
Some drop-down lists are set up to display a subset of values based on a value set in another drop-
down list. For example, if you have two fields for Service Request, Area and Subarea, the values 
shown in the Area drop-down list might include Network and Upgrade. If the user chooses Network, 
that user might see a drop-down list for Subarea that includes Ethernet Card and 3rd Party Software. 
If on the other hand the user chooses Upgrade for the Area, that user might see CD-ROM, Disk Drive, 
Memory, and Operating System in the Subarea. Setting up this type of filtering is referred to as 
setting up a constrained picklist. In such a case, the lists of values have been configured to be 
dependent on one another. In this example, the Area drop-down list is considered to be the parent 
and the Subarea drop-down list is the child.

Figure 2 shows the values available in the Area drop-down list, and the values available in the 
Subarea list when Network and Upgrade have been selected, respectively.

Constrained picklists (or lists of values) must first be set up through Siebel Tools. After they are 
configured through Siebel Tools, specific values in lists can be made hierarchically dependent through 
the List of Values view. This is accomplished by using the Parent LIC attribute in the list-of-values 
record to specify which values show up when a value is selected in the parent drop-down list.

Figure 2. Contents of Drop-Down List Constrained by Parent Drop-Down List
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For example, the LOV Type SR_AREA is used by both the Area and Subarea drop-down lists in a 
Service Request. The values that show up in the Area drop-down list are constrained to those that 
have a Parent LIC value of External. Figure 3 shows how the records for these values appear in the 
list-of-values list, including the Parent LIC value of External.

The values that show up in the Subarea drop-down list are constrained to those that have a Parent 
LIC value that matches the user’s selection for the Area. For example, if the user selects Network in 
the Area drop-down, only those values that have the Parent LIC set to Network show up in the 
Subarea drop-down list, while if the user selects Upgrade in the Area drop-down, only those values 
that have the Parent LIC set to Upgrade show in the Subarea drop-down list. Figure 4 shows the 
records for the values that are available for both the Network and Upgrade parent values. 

Figure 3. LOV Records with the Same Parent LIC

Figure 4. LOV Records Constrained by the Values Upgrade and Network
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If you needed to change the parent Area to which a Subarea list item belongs, you would modify the 
Parent LIC code of the Subarea list item. Similarly, to add a new Subarea list item, you would create 
a new record, setting the list-of-values type to SR_AREA and the Display Value, Language 
Independent Code, and Language as described in “Adding a New Value to an Existing List of Values” 
on page 78. Then you would set the Parent LIC code to the appropriate parent area. By contrast, to 
add a new item to the Area drop-down list, you would follow the same steps, but specify that the 
Parent LIC code have the value External.

NOTE: The usage of the value External to identify items in the parent drop-down list is specific to 
this example. To determine what this value would be for any given pair of constrained picklists, 
reference the underlying configuration in the Tools Repository.

For information about constraining both static picklists (maintained through lists of values) and 
dynamic picklists, see Configuring Siebel eBusiness Applications. 

NOTE: In the example above using the Area and Subarea drop-down lists, both parent and child lists 
of values have the same list-of-values type. While this is not required, it has the advantage of 
avoiding EIM unique key violation errors. These errors can occur when constraining picklists using 
Siebel Tools, when the parent and child lists of values contain different list-of-values types. If you 
plan to use Siebel EIM to exchange list-of-values data, you should consider constraining picklists by 
configuring them so that the parent and child lists of values have the same list-of-values type. 
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This chapter is about Audit Trail. It includes the following topics:

■ “About Audit Trail” on page 87

■ “Process of Configuring and Using Audit Trail” on page 91

■ “Configuring Audit Trail in Siebel Tools” on page 91

■ “Specifying Business Components and Business Component Fields for Audit” on page 93

■ “Specifying Parent–Child Associations for Audit” on page 94

■ “Specifying Audit Trail Restrictions” on page 96

■ “Verifying Audit Trail Configuration” on page 97

■ “Viewing Audit Trail Records” on page 97

■ “Viewing Audit Trail Records” on page 97

■ “About the Audit Trail Engine Business Service” on page 100

About Audit Trail
Audit Trail creates a history of the changes that have been made to data in  Siebel applications. An 
audit trail is a record showing who has accessed an item, which operation was performed, when it 
was performed, and how the value was changed. Therefore, it is useful for maintaining security, 
examining the history of a particular record, documenting modifications for future analysis, and 
record keeping. Audit Trail logs information without requiring any interaction with, or input from, 
your users.

Audit Trail can be used for a variety of purposes. In a simple example, a call center uses an audit 
trail to track the status change of a service request, who changed it and when. Audit trail capabilities 
can also be used to track the time needed to change the state of an item, such as a service request 
from open to closed. A calculation of the time difference can help the call center manager measure 
and improve service quality. Audit trail can also be used to reproduce a record at a given point in 
time to maintain regulatory compliance by looking at the audit trail records of changes and the 
current state of the record.

NOTE: For any audit trail deployment, the combination of the number of fields audited and the 
number of audit records created by a given business process has performance implications. Auditing 
a large number of fields on a business component or auditing fields in a large number of business 
components may produce unacceptable performance that is counter to the overall business 
requirement. 

Audit trail works for replication and synchronization. For Siebel Remote and Siebel Replication users 
making changes to records Audit Trail records successfully committed transactions and also 
transactions that did not get synchronized to the server because of conflicts.
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Audit Trail Features
More Audit Trail features are described in the following topics:

■ “Audit Scope” on page 88

■ “Audit Trail Content” on page 88

■ “Audit Trail Modes” on page 88

■ “Audit Trail Constraints” on page 89

■ “Audit Trail for Siebel Remote and Siebel Replication Users” on page 90

■ “File Auditing and Database Auditing Modes” on page 90

■ “Audit Trail Recovery in File Auditing Mode” on page 91

Audit Scope
System administrators can specify the audit scope by the following means:

■ Operations (such as update, new, delete, and copy) performed on business components 

■ Operations performed in a specific time period

■ Only those operations performed by certain responsibilities, positions, or employees

Audit Trail Content
Audit Trail records the following information in selected business components:

■ Field

■ Row ID of the record being changed

■ Operation being performed (Update/New/Delete/Copy)

■ Original value

■ Changed value

■ User ID performing the operation

■ Date and time the operation was performed

Audit Trail Modes
The Siebel Web Client supports the following choice of audit trail modes:

■ File auditing. An audit trail can be written to files and later imported into the database, 
providing better performance.
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■ Database auditing. An audit trail can be written directly into the database, supporting both 
remote users and replicated databases. Changes to an audit trail field are cached in the 
application. Exiting from the Siebel application and restarting it writes all cached changes to the 
database. Alternatively, when the cache size is reached, all cached entries are automatically 
written to the database even without exiting from the application.

Audit Trail Constraints
The following cannot be audited:

■ The underlying business component not derived from CSSBCBase. This is because Audit Trail’s 
functionality resides only in business components of class CSSBCBase. The procedure “To 
determine if a business component can be audited” tells you how to determine whether or not a 
business component can be used in Audit Trail.

■ Virtual business components. This is because they are not derived from business components of 
class CSSBCBase.

■ The merge action.

■ Calculated fields. This is because, typically, the value for a calculated field is derived from a table-
based field. To audit a calculated field, you can audit the table-based field that was used to derive 
the calculated field.

■ Record inserts, updates, and deletes performed through Enterprise Integration Manager (EIM), 
Assignment Manager, or workflow policy actions. This is because these do not go through the 
Siebel Object Managers. 

To determine if a business component can be audited

1 Launch Siebel Tools.

2 In the Object Explorer, navigate to the Business Component object type.

3 In the Object List Editor, select the business component.

4 In the Class field, look for CSSBCBase. If the class is CSSBCBase, the business component can 
be used for Audit Trail.

CSSBCBase and CSSBusComp are the most basic class types. If there is a value in the Class field 
that is not CSSBCBase or CSSBusComp, then there is specialized functionality that has been 
written in C++ related to this class. 

NOTE: You can change the class from CSSBusComp to CSSBCBase. 

5 To see if this specialized class is related to CSSBCBase, drill down on the Class hyperlink.
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6 In the Super Class field, look for CSSBCBase. If the class is not CSSBCBase, drill down on the 
Super Class hyperlink.

NOTE: Repeat Step 6 until the Super Class field is either CSSBCBase, CSSBusComp, or blank.

Audit Trail for Siebel Remote and Siebel Replication 
Users
The following information applies to remote and replication users:

■ Disconnected users can use Audit Trail as well as connected users. Audit Trail stamps transactions 
with local machine time.

■ Remote and replication users should only used database auditing mode (and not file auditing 
mode). This is because file mode does not allow the auditing information to synchronized with 
the server database.

■ Audit trails are synchronized or replicated along with other data.

■ If the transaction is rejected during the conflict resolution, the corresponding audit trail record 
is not discarded.

File Auditing and Database Auditing Modes
The following information applies to file auditing and database auditing modes:

■ Database auditing writes transaction records directly to the database, while file auditing writes 
to the Siebel File System. You can later import these files into the database. (See “To import audit 
trail items from a file into the Siebel database” on page 98.) You can schedule import batch 
processes for these files using workflow processes. (See the ImportAll method in Table 13 on 
page 100.)

■ If you use file auditing mode, you have to import files into the database to have a comprehensive 
view and to be able to query for the information you need. Otherwise, you can view records only 
on a file-by-file basis.

■ For systems in which every user is a connected user, file auditing mode yields better 
performance. Systems using Siebel Remote should use database auditing. 

■ Purging and archiving can be done at the database level.

If the Super Class is... Then the business component...

CSSBCBase can be audited.

CSSBusComp cannot be audited.

 (blank) cannot be audited.
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Audit Trail Recovery in File Auditing Mode
When running in file auditing mode, instead of writing to the Siebel File System every time a new 
Audit Trail file is created, the Siebel application saves Audit Trail files to a file directory on the Object 
Manager to improve performance. When the Object Manager closes normally, these files are 
uploaded to the Siebel File System simultaneously. 

If the Object Manager exits abnormally, Audit Trail keeps track of which files have been uploaded to 
the Siebel File System and which ones have not. The next time Audit Trail starts, any files that have 
not been uploaded are uploaded automatically.

Process of Configuring and Using Audit 
Trail
This example process represents the tasks that are carried out when setting up and monitoring Audit 
Trail. 

1 “Configuring Audit Trail in Siebel Tools” on page 91 (Enabling Audit Trail)

2 “Specifying Business Components and Business Component Fields for Audit” on page 93

3 “Specifying Parent–Child Associations for Audit” on page 94

4 “Specifying Audit Trail Restrictions” on page 96 (Restricting according to user, position, or 
responsibility)

5 “Verifying Audit Trail Configuration” on page 97 

6 “Viewing Audit Trail Records” on page 97

Configuring Audit Trail in Siebel Tools
The Audit Trail functionality is not enabled in the preconfigured application. By enabling the Audit 
Trail business service with Siebel Tools, Audit Trail becomes available to application objects. You can 
turn off the Audit Trail for individual applications by deactivating the Audit Trail application event 
service for the application.

For workflows, the Audit Trail function will not work unless the Start Method of the Audit Trail Engine 
Business Service is included as a first step in the workflow process. For more information, see “About 
the Audit Trail Engine Business Service” on page 100.

NOTE: Audit Trail does not create history records for predefault values; predefault values are 
assumed to be part of the initial record. If, however, the default values are changed at a later date 
and those fields are set to be audited, then both the original and changed values are recorded.

Enabling the Audit Trail Engine Business Service
This task is a step in Process of Configuring and Using Audit Trail on page 91.
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To enable the Audit Trail Engine business service

1 Launch Siebel Tools.

2 In the Object Explorer, select the Business Service object, and then select the Business Service 
User Prop object.

3 Select Audit Trail Engine in the Business Services object list.

4 Configure the Business Service User Properties to use the following values:

NOTE: Audit Trail data is cached by the business service and only written out when the number 
of Audit Trail changes exceeds the specified cache size. You can also flush cached entries by 
logging out of the current session and then logging back in to check the Audit Trail data.

Disabling Audit Trail for an Application

To disable Audit Trail for an application

1 Launch Siebel Tools.

2 In the Object Explorer, double-click the Application object to expand it and select Application 
Event Services.

3 In the Application Event Services list, deactivate the Audit Trail Engine business service record. 
(Look for a record with the following values.)

Name Field Value Field Description

Audit Source TABLE Can be TABLE or FILE. Signifies the database or file 
auditing mode in which you are going to run Audit 
Trail. 

Cache Entries Size 1 The number of records to cache before writing the 
audit trail records for the selected mode. For 
example, if this field is set to 10 and Audit Source is 
running in FILE mode, then after the user makes 10 
audited changes for a particular business 
component, the Audit Trail engine creates one file in 
the Siebel File System. When running in TABLE 
mode, you should use the default value of 1 because 
there is no performance gain from increasing this 
value.

Enable TRUE Can be TRUE or FALSE. Determines the current state 
of the Audit Trail.

Name Field Value Field

Business Service Audit Trail Engine
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Configuring an Application for Audit Trail
Use the following procedure to enable a customized application object for auditing, or to re-enable 
an application object that has been turned off.

To configure an application for Audit Trail

1 Launch Siebel Tools.

2 In the Object Explorer, double-click the Application object to expand it and select Application 
Event Services.

3 In the Application Event Services list, create the following record if it does not already exist.

About Using Audit Trail with Object Interfaces
When accessing an Application Object Manager through object interfaces such as COM Data Control 
and Java Data Bean, Audit Trail is not started automatically. In these cases, you must invoke the 
Audit Trail Engine business service explicitly.

Specifying Business Components and 
Business Component Fields for Audit
You administer the business component and the business component fields to be audited.

This task is a step in Process of Configuring and Using Audit Trail on page 91.

To configure the business component and business component fields to be audited

1 Navigate to the Administration - Audit Trail screen.

Event Name Start

Method Name Start

Name Field Value Field

Business Service Audit Trail Engine

Event Name Start

Method Name Start

Name Start

Sequence 1 or the next available sequence number

Name Field Value Field
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2 In the Audit Trail Buscomp list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

3 In the Field list, create a new record for the field you want to audit.

4 Repeat Step 3 until the Field list shows all the fields in that business component that you want 
to audit.

NOTE: For any audit trail deployment, the combination of the number of fields audited and the 
number of audit records created by a given business process has performance implications. Auditing 
a large number of fields on a business component or auditing fields in a large number of business 
components may produce unacceptable performance that is counter to the overall business 
requirement. 

To disable individual business components

1 Navigate to Administration - Audit Trail screen.

2 Use one of the following methods to disable Audit Trail:

■ In the Audit Trail Buscomp list, enter an end date prior to today’s date in the End Date field.

■ In the Audit Trail Buscomp list, delete the record for the business component.

Specifying Parent–Child Associations for 
Audit
In the Siebel application, parent–child associations are set through:

Field Description

Assoc Specifies whether to audit associations with the child business 
components in the Child Buscomp list. See “Specifying Parent–Child 
Associations for Audit” on page 94.

Copy Select if you want to audit the Copy operation.

Delete Select if you want to audit the Delete operation. Clear this check box if 
you want to make sure that the delete operation is not audited.

End Date Date on which the auditing stops. 

To turn Audit Trail off for an individual business component, set the End 
Date to a date that has already passed. 

New Select if you want to audit the New operation.

Restriction Type Specifies whether there is a rule determining who gets audited.

Start Date Date on which the auditing starts. 

Update Select if you want to audit the Update operation.
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■ MVG (multi-value group) fields

■ Parent–child applets

Audit Trail can keep track of changes in parent–child associations. For example, you can audit the 
association (and dissociation) of contacts with accounts. 

This task is a step in Process of Configuring and Using Audit Trail on page 91.

To configure business components for auditing of parent–child associations

1 Determine the name of the child business component whose association you want to audit.

2 Navigate to the Administration - Audit Trail screen.

3 In the Audit Trail Buscomp list:

■ Select an existing record for the parent business component.

Or 

■ Create a new record for the parent business component and complete the necessary fields. 
Some fields are described in table in Step 2 on page 94 of the preceding procedure. 

4 Make sure that the Assoc field is checked.

5 Click the Child Buscomp view tab. 

6 In the Child Buscomp list, create a new record for the child business component whose 
association with the parent business component you want to audit. 

TIP: The Business Component dialog box lists all business components—query for the name of 
the child business component you identified in Step 1.
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Specifying Audit Trail Restrictions
You can restrict who gets audited by user, position, or responsibility.

For example, if you set the Restriction Type to “Users” on the Audit Trail Buscomp Fields view, you 
then go to the Audit Trail Users View and add the users whom you want to audit. Restriction by 
responsibility or position works in the same way.

This task is a step in Process of Configuring and Using Audit Trail on page 91.

To restrict by user

1 Navigate to Administration - Audit Trail screen.

2 Select a business component entry in the Audit Trail Buscomp list.

3 Click the User view tab.

4 In the Audit Trail Buscomp list, change the Restriction Type field to User.

5 Select the Audit Trail User list, and create or edit records.

Only these users are audited for the operations on this particular business component.

6 If you:

■ Changed the Restriction Type field in Step 4 (for example from No Restriction to User), then 
restart the Application Object Manager so that the changes take effect.

■ Only created or changed users, then start a new session to see the changes take effect.

To restrict by position

1 Navigate to Administration - Audit Trail screen.

2 Select a business component entry in the Audit Trail Buscomp list.

3 Click the Position view tab.

4 In the Audit Trail Buscomp list, change the Restriction Type field to Position.

5 Select the Audit Trail Position list, and create or edit records. 

Only these positions are audited for this particular business component.

6 If you:

■ Changed the Restriction Type field in Step 4 (for example from No Restriction to Position), 
then restart the Application Object Manager so that the changes take effect.

■ Only created or changed positions, then start a new session to see the changes take effect.

To restrict by responsibility

1 Navigate to Administration - Audit Trail screen.

2 Select a business component entry in the Audit Trail Buscomp list.
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3 Click the Responsibility view tab.

4 In the Audit Trail Buscomp list, change the Restriction Type field to Responsibility.

5 Select the Audit Trail Responsibility list, and create or edit records.

Only these responsibilities are audited for this particular business component.

6 If you:

■ Changed the Restriction Type field in Step 4 (for example from No Restriction to 
Responsibility), then restart the Application Object Manager so that the changes take effect.

■ Only created or changed responsibilities, then start a new session to see the changes take 
effect.

Verifying Audit Trail Configuration
The following steps are part of the verification process to make sure that the business component 
and business component fields were specified correctly.

This task is a step in Process of Configuring and Using Audit Trail on page 91.

To verify audit trail records

1 Navigate to the view for the business component that you want to audit.

2 Make a change to the data in that view.

3 If you are using database auditing, verify audit creation as follows:

a Navigate to Audit Trail screen > Audit Trail Items view.

b In the Audit Trail Items list, make sure there is a new record showing the changes that you made 
to the business component by querying the business component and field values.

4 If you are using file auditing mode, verify audit creation as follows:

a Exit and restart the application.

b Navigate to Audit Trail screen > Audit Trail List view.

NOTE: The Host Computer name in the Audit Trail record is the name of the machine on 
which the object manager is running. This field is not configurable.

c Verify that there is a new record in the Audit Trail list from your previous session and the 
corresponding Audit Trail Item list displays the changes you made to the business component.

Viewing Audit Trail Records
After you have set up the fields, operations, responsibilities, positions, and employees to be audited, 
you can read the results of the audit trails in the Audit Trail view and the Audit Trail Items view.
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Audit Trail View for File Auditing Mode
When you use file auditing mode, the Audit Trail list in the Audit Trail view provides a list of files that 
have been audited for each user, business component, and session. The Audit Trail Items list gives 
details of the selected file record. You have to import files into the database to have a comprehensive 
view; otherwise, you can view records on a file-by-file basis only.

CAUTION: You should purge and archive your records from the Siebel audit table S_AUDIT_ITEM 
regularly to prevent the table from becoming too large. Carry out these operations directly at the 
database level using native SQL. There is no EIM interface table corresponding to the S_AUDIT_ITEM 
table.

This task is a step in Process of Configuring and Using Audit Trail on page 91.

To import audit trail items from a file into the Siebel database

1 Navigate to Audit Trail screen > Audit Trail List view.

2 Select a record in the Audit Trail Buscomp list.

3 In the Audit Trail Item list, click the menu button and select Import Audit Trail Item.

The audit trail items are imported into the table.

4 From the Show drop-down list, select Audit Trail Items.

NOTE: If you go back to the Audit Trail view and try to import audit trail items that you have 
already imported, you will not be able to import them.

To view audit trail records and record details

1 Navigate to the Audit Trail screen > Audit Trail Items view.

2 Select a record in the Audit Trail list.

The Audit Trail Items list displays details of the selected record.

Querying Audit Trail Information
After recording or importing Audit Trail records into the database, you can query Audit Trail 
information in the Audit Trail Items view. For example, you can query Audit Trail items to determine 
changes made by team members, dates, or operations performed on a business component.

To query audit trail information

1 Navigate to the Audit Trail screen > Audit Trail Items view.

2 Query the list for Audit Trail items of interest.
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Linking Audit Trail to a Business 
Component
In some circumstances, you might need to link the Audit Trail view to a specific business component 
view. For example, a Call Center team might want to see the Audit Trail records for individual service 
requests. Using Siebel Tools, you can create a view that would allow the Call Center team to see 
these Audit Trail records, if the following conditions are met:

■ Audit Trail must be running in database auditing.

■ You must be able to audit the business component you are linking to Audit Trail. For information 
on determining if a business component can be used in Audit Trail, see “Audit Trail Constraints” 
on page 89.

NOTE: Because audit trail item records are not routed to mobile Web clients, data in these linked 
views can only be displayed in Siebel Web client and the Siebel Dedicated Web client. Make sure that 
mobile clients do not have access to views displaying audit trail data.

To link Audit Trail to a business component

1 Launch Siebel Tools.

2 Create a link between the Audit Trail Item 2 business component and the business component to 
which you are linking Audit Trail. Set the parent business component property of the link to the 
name of the audited business component. 

For example, if you are configuring the view to show the audit trail records for the Product Defect 
business component, the parent business component should be Product Defect. The Child 
Business Component for the link should be Audit Trail Item List 2. The Source and Destination 
Fields for the link should be Id and Record Id respectively.

3 Modify the business object for the business component to which you are linking Audit Trail. You 
need to create Audit Trail Item 2 as one of the business object components and specify the Link 
property as the link you created in Step 2.

4 Create a view which has an applet based on the selected business component as a parent and 
the Audit Trail Item List 2 applet as a child.

5 Add this view to a screen.

6 Launch a Siebel employee application.

7 Navigate to Administration - Application screen > Views view.

8 From the Show drop-down list, choose Responsibilities, and add the new view to applicable 
responsibilities.
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About the Audit Trail Engine Business 
Service
The Audit Trail Engine business service is located in the Object Manager and stays active as long as 
the Object Manager is active. The purpose of the Audit Trail Engine business service is to capture 
changes (updates and deletes) to records and to store them in the designated format (database or 
Siebel File System, according to the audit trail mode selected). For the various data operations, if 
the auditing condition is met, the business component being audited triggers the Audit Trail Engine 
business service. 

The methods listed in Table 13 are associated with the Audit Trail Engine business service. The Start, 
Stop, and ImportAll methods are accessible to an administrator and allow the performance of certain 
tasks.

The easiest way to use these methods is through a workflow process. If you want to stop or restart 
the Audit Trail Engine, create a new workflow process, or reuse an existing one: create a business 
service node that implements the Stop method or the Start method. For general information about 
Siebel workflows, see Siebel Business Process Designer Administration Guide.

Table 13. Exposed Methods in the Audit Trail Engine Business Service 

Method Mode

Internal 
Use 
Only Description

Start Both Starts the Audit Trail Engine.

Stop Both Stops the Audit Trail Engine.

ImportAll File 
only

Imports all the associated Audit Trail Item business 
component records.

AddTrailEntry Both X For the person specified, creates an audit trail entry to the 
pertinent data structure (unsaved audit list).

CommitTrail Both X Removes the uncommitted elements from the unsaved list 
and puts them on the saved list, and writes to the database 
or file if the cache size has been reached.

CrashRecover File 
only

X Saves file from local system to the Siebel File System.

Kill Unsaved 
Trail

Both X Kills the unsaved audit trail; this happens on an 
UndoRecord.
Applications Administration Guide Version 7.7, Rev. B100 ■



7 Creating and Administering 
iHelp
This chapter is about administering iHelp. It includes the following topics:

■ “About iHelp” on page 101

■ “Scenario for Administering iHelp” on page 101

■ “Process of iHelp Administration” on page 102

■ “Creating iHelp Item Records” on page 102

■ “Designing iHelp” on page 104

■ “Clearing the iHelp List Cache” on page 108

■ “Activating, Revising, and Deactivating iHelp Items” on page 108

■ “Translating iHelp Items” on page 110

■ “Importing and Exporting iHelp Items” on page 111

About iHelp
iHelp is real-time step-by-step instruction that helps users complete tasks within the application. 

iHelp is best used to provide instruction to first time or occasional users. 

NOTE: iHelp may not be appropriate for enforcing standards, because users are free to follow or not 
follow any given step.

For information about how to use iHelp, see Fundamentals.

About iHelp and Standard Activity Mode
iHelp instructions can be used in both standard and high interactivity mode. However, high 
interactivity mode is required to create and administer iHelp items. 

Scenario for Administering iHelp
This scenario provides an example of a process performed by two iHelp administrators. Your 
company may follow a different process according to its business requirements.

Introduction
The agents in training in the North American call centers of a multinational company want step-by-
step instructions on how to create activities.
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The iHelp Administrator in North America
The North American administrator creates an iHelp item to appear in the iHelp pane of the Activities 
and Accounts screens (screens frequently used by the agents). Because these instructions only 
pertain to call center agents, this iHelp item is set to be visible only to those users with the Call 
Center responsibility. 

The North American administrator and the call center managers are the only people who need to 
modify this iHelp item; the administrator restricts edit access by associating the Call Center access 
group with the iHelp task.

Various employees test the iHelp task. When the tests are complete, the administrator activates the 
iHelp item.

At the end of the month, a policy change takes place that effects some steps in the iHelp item. This 
is handled by creating two versions of the iHelp item. One item is set to expire at the end of the 
month and second item (with steps corrected for the new policy) is set to become active at the 
beginning of the next month.

In North America, the call centers operate in both English and French. The manager of the 
francophone call center revises the iHelp item, translating the text into French. 

The European iHelp Administrator in Europe
The European call centers use a different database, but they also want their call center agents to see 
this iHelp item. The North American administrator exports the iHelp item to file and sends it to the 
European administrator. Then, the European administrator imports the item into the European 
database, adds responsibilities and access groups, and activates the iHelp item.

Process of iHelp Administration
This example process represents the tasks that are carried out in the “Scenario for Administering 
iHelp” on page 101. 

1 “Creating iHelp Item Records” on page 102

2 “Designing iHelp” on page 104

3 “Clearing the iHelp List Cache” on page 108

4 “Activating, Revising, and Deactivating iHelp Items” on page 108

5 “Translating iHelp Items” on page 110

6 “Importing and Exporting iHelp Items” on page 111

Creating iHelp Item Records
The first task in creating iHelp items is to create the iHelp item record.

In this task, you determine the following for the iHelp item:

■ In which applications the iHelp item is displayed
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■ In which screens the iHelp item is displayed

■ Which users can see the iHelp item

■ Which administrators can modify the iHelp item

■ (Optional) Activation and expiration dates for the iHelp item

■ If the iHelp item is downloaded to remote and local databases

TIP: Although iHelp items can be exported and imported, best practice is to create and test your 
iHelp item in the production environment where it will be used. While testing, restrict visibility to the 
item by limiting the associated responsibilities.

This task is a step in Process of iHelp Administration on page 102.

To create an iHelp item record

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name This is the name that appears in the iHelp pane. Make sure that the name 
clearly identifies the iHelp item.

Do not include any special characters such as colons or quotation marks in the 
Name.

Remote 
Support

iHelp items can be downloaded to regional and local databases. Use this field 
to determine if items are downloaded:

■ All. Items are downloaded to both regional and local databases

■ Regional. Items are downloaded to regional databases only

■ None. Items are not downloaded to databases

Application Add the applications where you want the iHelp item to display. For example, if 
you want the iHelp item to be used in Siebel Call Center, set this field to Siebel 
Universal Agent (the internal name for the Call Center application).

Make sure that all these applications contain the screens and views needed for 
the item iHelp you create.

Private If this box is not selected, any user with access to the Administration - iHelp 
screen can modify the iHelp item. If you want to restrict edit access for this 
iHelp item, see Step 5 on page 104.

Activation 
Date

(Optional) If an activation date is set, the iHelp item does not appear in the 
iHelp pane until that date.

Expiration 
Date

(Optional) If an expiration date is set, the iHelp item does not appear in the 
iHelp pane after that date.
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3 Set which users can see the iHelp items (in the iHelp pane or Map):

a Click the Responsibilities view tab.

b Associate the responsibilities of those users who you want to see the iHelp item.

c Make sure the Active flag is selected for each responsibility.

NOTE: Users also need to have the Task Assistant Player View associated with at least one of 
their responsibilities.

4 Set the screens and views where the iHelp item appears:

a Click the Screens view tab.

b Associate screen name/business object/view tab records with the iHelp item.

Only screens and views that are common to all the applications specified in the Application 
field can be associated.

For example: to have an iHelp item appear on the Activities screen home page and the 
Activities screen (My Activities, My Team’s Activities, and so on), associate the Action Home 
and the Action business objects with the item.

5 If you want to restrict edit access for the item, set the access groups to determine who can modify 
the iHelp item:

a Click the Access Groups view tab.

b Associate access groups with the iHelp item. Make sure that you belong to one of the access 
groups.

c Click the More Info view and select Private check box in the form view.

For more information about access groups, see Security Guide for Siebel eBusiness Applications.

Designing iHelp
Assemble step-by-step iHelp instructions in the iHelp Designer by creating steps and connecting 
them with branches. 

Status The status changes when the Activate, Revise, and Deactivate buttons are 
clicked.

Version This field is automatically updated when a item of the same name is created or 
imported.

Description (Optional) Enter a description of the iHelp item. This description is for the 
administrator only. The text does not appear in the iHelp pane.

Field Comments
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Figure 5 shows an example of iHelp instructions displayed in the iHelp pane.

Figure 6 shows the fields listed in Step 3 of Figure 5, highlighted. 

Figure 5. Relation Between iHelp and Components of iHelp Designer

Figure 6. Fields Highlighted (Step 3)

iHelp Item Name

Section Label

Caption: “<b> Navigate</b> to the Activities 
screen > <v>My Activities view.</v>”

SubStep Caption

Indicates Multiple Branches from Step 3
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Figure 7 shows how the iHelp instructions appear in the iHelp Designer.

To access the iHelp Designer

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 Drill down on the name of the iHelp item.

To create an iHelp step

1 In the iHelp Designer, drag the Step or Start icon onto the grid.

The first step in any iHelp must be Start. The start step should navigate the user to the correct 
view for the iHelp item. Only one Start step is allowed per iHelp item. 

Figure 7. iHelp Designer Shows iHelp Steps That Correspond to Figure 5
Applications Administration Guide Version 7.7, Rev. B106 ■



Creating and Administering iHelp ■ Designing iHelp
2 In the Step form, complete the fields.

Some fields are described in the following table.

3 (Optional) Highlight a button or field:

a Click the Field and Button Highlights folder.

b In the Field and Button Highlights list, create new records and complete the fields.

NOTE: Most buttons, column headings, and single-value fields can be highlighted. These are 
applet controls with HTML Type of Field or MiniButton (all MiniButton types). MVG fields and 
read-only fields cannot be highlighted. 

4 (Optional) Create substeps:

a Click the SubSteps folder.

Field Comments

Name This name appear on the step’s icon in the iHelp Designer. The user does not 
see this name.

View Enter a view name if you want the step to:

■ Provide a hyperlink to a view.

■ Highlight buttons or fields on the view.

NOTE: If you provide a hyperlink to a screen which is different from the main 
screen for the iHelp, you may lose record context as you navigate to the other 
screen. For example, a user in the Contact Activities view of the Contacts 
screen, highlights an activity record and clicks an iHelp link to the Activities 
screen. In going to the Activities screen, the record context is broken. The 
highlighted activity is no longer selected, and the user must query for it again. 
If you remain in the same screen, context is generally maintained.

Only views that are common to all the applications specified in the Application 
field are available for selection.

Caption This is the text that appears in the step. 

Use the following tags to format step captions:

■ <b> and </b> for bold

■ <i> and </i> for italic

■ <u> and </u> for underlining

■ <v> and </v> for view navigation links

Section Label (Optional) This text appears above the step.

Description For the administrator’s use only. This description is not visible in the iHelp 
pane.
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b In the SubSteps list, create new records, and complete the Caption field.

NOTE: You cannot add view navigation links to substeps.

To connect steps with branches

1 Drag the Branches icon onto the grid.

2 Move the end points of the branch to connect two steps.

3 If multiple branches leave one step, set conditions on the branches:

a Click the Branches folder for the step.

b In the Branches list, complete the fields.

No Condition Expression is required for the last branch in the sequence.

For information on the Branch Condition Expression Designer, see Siebel Business Process 
Designer Administration Guide.

Clearing the iHelp List Cache
iHelp loads all iHelp items to the iHelp Map and iHelp pane when the application is initialized. When 
you modify iHelp items, you may need to clear the iHelp List Cache before you can see changes to 
the iHelp item (in the iHelp pane).

To clear the iHelp List Cache

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 From the menu button, choose Clear iHelp List Cache. 

Activating, Revising, and Deactivating 
iHelp Items
The Activate, Revise, and Deactivate buttons control:

■ The status of the iHelp items.

■ Whether the items are visible in the iHelp pane and iHelp Map.

■ Whether the items can be edited.

The behavior of these buttons is described in Table 14.
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To activate an iHelp item

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 Select an in-progress iHelp item.

3 Click Activate.

To revise an active iHelp item

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 Select an active iHelp item.

3 Click Revise.

To deactivate an iHelp item

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 Select an active iHelp item.

3 Click Deactivate.

Table 14. About the Activate, Revise, and Deactivate Buttons

Button When to Use Effect

Changes 
Status 
From... To...

Activate The iHelp item is 
complete and ready for 
general use. 

Cannot be modified 
(although it can be deleted)

The status and version no 
longer appear with the item 
name in the iHelp pane.

In Progress Active 1

1. Any active version of the item becomes Outdated

Revise You want to make 
changes to an active 
iHelp item.

Copies the iHelp item to a 
new record that can be 
edited.

For the new record, 
deselects Active flag on 
Responsibilities view.

Active

Inactive

In Progress

Deactivate You no longer want the 
item to display in the 
iHelp pane.

The iHelp item is no longer 
displayed in the iHelp pane 
or the iHelp Map.

Active Inactive
Applications Administration Guide Version 7.7, Rev. B ■ 109



Creating and Administering iHelp ■ Translating iHelp Items
Translating iHelp Items
When translating an iHelp Item, only the text strings that the user sees is translated. These text 
strings are: 

■ Item name

■ Section labels

■ Step captions

■ Substep captions

If translation is not defined for a language, the text from the base record is displayed.

To translate an iHelp item

1 Navigate to the Administration - iHelp screen > Translations view.

2 In the iHelp Items list, select an iHelp item.

3 In the Translations list, create a new record and complete the necessary fields.

Some fields are described in the following table.

4 Click the Designer view tab.

5 For each step:

a Open the Translations folder.

b Create a record to the Translations list and complete the fields.

6 For each substep:

a Open the Translations folder for the substep.

b In the Translations list, create a new record and complete the necessary fields.

Field Comments

Display Name Translation of the iHelp item name

Translations Folder for Substep 1
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Importing and Exporting iHelp Items
iHelp items can be exported and imported as XML files. 

Export and import iHelp items to:

■ Move iHelp items from one database to another, for example when upgrading

■ Create backups of iHelp items

You cannot move iHelp items between different types of Siebel repositories. For example, you cannot 
export from a Siebel Call Center application to a Siebel Automotive application. In general, you need 
to make sure that all the applications, screens, and views referenced in the exported item are 
available in the repository where the item is imported.

To export an iHelp item as an XML file

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 In the iHelp Items list, select an iHelp item. 

CAUTION: Make sure that the name of the item does not contain any special characters such as 
colons or quotation marks. 

3 From the menu button, choose Export iHelp Item Definition. 

To import an iHelp item

1 Navigate to the Administration - iHelp screen > All iHelp Items view.

2 From the menu button in the iHelp Items list, choose Import iHelp Item Definition. 

3 Browse for the iHelp item XML file and click Import.

If an iHelp item of the same name already exists, the imported iHelp item is imported as a new 
version of the item.

After import, the iHelp Items list is filtered to show only the newly imported item.

CAUTION: Responsibility and access group information is not exported or imported. 
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8 Message Broadcasting
This chapter explains the procedures necessary to administer message broadcasting for Siebel 
applications. It includes the following topics:

■ “About Message Broadcasting” on page 113

■ “Scenario for Administrating Message Broadcasting” on page 114

■ “Process of Message Broadcasting” on page 115

■ “Enabling and Disabling Message Broadcasting” on page 115

■ “Creating a Message Broadcast” on page 116

■ “About Automatically Updating Message Broadcasting Text” on page 119

■ “Configuring Message Broadcast Caching” on page 120

About Message Broadcasting
Message broadcasting provides a platform for administrators and other users with access to the 
Message Broadcasts view to send important information directly to users’ screens. Typically, this 
information is time-critical such as a due date, or it is updated frequently such as a call queue’s 
status.

NOTE: Message Broadcasting is available for employee applications. (It is not available for customer 
or partner applications.) 

The messages can be displayed by one of the following two methods:

■ Scroll messages in the message bar across the bottom of a user’s screen, visible at all times.

■ Display messages in a dialog box in the middle of the screen in addition to scrolling across the 
bottom of the screen.

Messages have severity levels (indicated by color) and activation and expiration dates.

Message Broadcasts can be created through the administration view, automatically from Siebel 
Business Process Designer, or remotely from a third-party application through Siebel eAI.

In What Order Are Messages Displayed?
Message Broadcast messages are retrieved from the Message table through the Siebel application 
server and sent to the message bars of the targeted Siebel Web Client sessions. There is no set order 
for the messages to appear on the message bar, that is, the order cannot be controlled by the 
administrator or the end user.
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About Disabling Messages
Users can disable their scrolling message bar, but the administrator can override this setting for 
broadcast messages.

About Message Broadcast Caching Versus Directly Polling the 
Database
There are two methods for ways for the application to obtain the messages for display:

■ The default behavior is to have the messages read from the database each time the message bar 
is refreshed. This method can adversely affect performance if the message bar is set to refresh 
frequently. 

■ Message Broadcast Caching stores messages in each application’s object manager. The messages 
are then broadcast through the Service Request Broker (SRBroker).

Scenario for Administrating Message 
Broadcasting
This scenario is an example of process flows performed by an administrator working with call center 
agents to create and send broadcast messages. Your company may follow a different process flow 
according to its business requirements.

The contact center administrator wants to inform customer-care representatives of the current total 
number of outbound calls relative to their day’s goal. In addition, the administrator wants the 
customer-care representatives to be aware of the current customer service levels and whether there 
are customers waiting for service.

After working with the telecommunications and application teams to define the appropriate real-time 
contact center statistics for his customer-care representatives and contact center, the contact center 
administrator creates broadcast messages, using statistics that come from a variety of sources and 
third party solutions. The real-time data feed into the Message Broadcasting tables are accomplished 
through Siebel eAI, UAN, or both after the appropriate statistics and their sources have been 
identified. The customer-care representatives then receive their individualized and group statistics 
on their message bar in real time.

In addition to providing his customer-care representatives with this real-time status information, the 
contact center administrator also wants to send informative messages to individuals and teams in 
real time. Throughout the shifts and work day, he sends these messages to individuals and teams 
using the Message Broadcasts view within the Siebel application. The contact center administrator 
can send a message to an individual employee, a set of employees with the same responsibility, a 
division of employees, or to all employees.

The customer-care representatives service customers using multiple communications channels with 
the Siebel application. The customer-care representative can receives contact center statistics 
calculated for an individual, group, or in summary on the message bar within their Siebel application. 
This real-time information updates the customer-care representatives as to whether they and the 
call center are meeting their service objectives.
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Process of Message Broadcasting
To set up message broadcasting, the administrator typically performs the following tasks:

1 “Enabling and Disabling Message Broadcasting” on page 115.

2 “Creating a Message Broadcast” on page 116.

Enabling and Disabling Message 
Broadcasting
By default, message broadcasting is enabled. As an administrator, you can enable or disable message 
broadcasting at the server level using the following modes:

■ Always enabled

■ Always disabled

■ User enabled (default) 

To enable or disable message broadcasting at the server level

1 For each application’s object manager, edit the Application Message Bar Flag parameter’s value, 
referring to Table 15.

For details on configuring server component (or AOM) parameters, see Siebel System 
Administration Guide.

Table 15. Application Object Manager Parameter Values

Parameter 
Value Description

TRUE Message broadcasting is always enabled. Users cannot disable message 
broadcasting by setting their personal preferences. For a Siebel Web Client 
deployment, the Siebel application pushes messages to users. For Mobile Web 
Client users, messages are synchronized.

If you set the Application Message Bar Flag parameter to true, you can specify 
the update interval for the message bar by selecting the Application Message 
Bar Update parameter and editing the Current Value. The default value is 120 
seconds. (If the update interval is less than the SessionTimeout set in the 
application’s CFG file, sessions never time out.)
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To enable or disable message broadcasting on Mobile and Dedicated Web Clients

1 Use a text editor to open the CFG file for your Siebel application.

2 Find the ShowMessageBar parameter in the CFG file.

For example:

ShowMessageBar=TRUE

3 Set the parameter value to TRUE, FALSE, or User Enabled. 

See Table 15 on page 115 for more descriptions of each parameter value. 

4 If you set the ShowMessageBar parameter to true, specify the update interval for the message 
bar by adding the following line to the CFG file:

MessageBarUpdateInterval = seconds

where seconds is the interval in seconds between message bar updates (refreshes). The default 
value is 120 seconds.

5 Save and close the CFG file.

Creating a Message Broadcast
When you create a message broadcast, all connected users that you specify receive the message 
immediately upon the date and time you have specified that the message be activated. Mobile users, 
such as field representatives, receive the activated messages when they synchronize.

NOTE: To send a message broadcast, you must have responsibilities that include access to the 
Message Broadcasts view.

FALSE Message broadcasting is always disabled. The message bar and message 
broadcast alerts do not appear on users’ screens. For a Siebel Web Client 
deployment, the Siebel application server does not push messages to users. 
For a mobile client users, messages are not synchronized.

User Enable 

(Or any value 
other than true or 
false)

This is the default setting. Message broadcasting is enabled; however, users 
can set their user preferences to enable or disable message broadcasting. 
When a Web client user disables message broadcasting, the Siebel application 
server does not push messages to the user. When a mobile client user disables 
message broadcasting, messages are not synchronized.

If you set the Application Message Bar Flag parameter to User Enable, the 
update interval is a user preference. For more information, see Fundamentals. 
(If the update interval is less than the SessionTimeout set in the application’s 
CFG file, sessions never time out.)

Table 15. Application Object Manager Parameter Values

Parameter 
Value Description
Applications Administration Guide Version 7.7, Rev. B116 ■



Message Broadcasting ■ Creating a Message Broadcast
Typically, the appearance of a message broadcast is designated by a single severity level, as specified 
in the Severity field. Each severity level is associated with a different color. The severity level that 
you choose determines the color of the message broadcast and how it is delivered.

In addition to using the Severity field to determine the appearance of a message, you can also 
combine multiple severity levels to create a message broadcast with unique formatting. By adding 
special tags to the text of a message broadcast, you can change the color of different sections of the 
message. The following tags are used to combine severity levels in a message:

■ [N] for Normal 

■ [H] for High

■ [U] for Urgent

For example, if your message has a severity of normal, but you want specific text to be highlighted, 
you can tag parts of the text with the code for High or Urgent. Here is an example:

The trunk line from [H]Chicago, Illinois [N]is [U]DOWN! 

The beginning of the message appears in the color for the severity of the message, Normal; the 
words Chicago, Illinois appears in the color for High; and the word DOWN! appears in the color for 
Urgent. 

To create a message broadcast

1 Navigate to the Administration - Communications screen > Message Broadcasts view. 

2 In the Message Broadcasts list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Abstract A brief description of the message. 

Activation Date/
Time

Date and time at which you want to start broadcasting the message. If 
the Activation field is left blank, the message is broadcast immediately. 

However, broadcasts are controlled by the application message interval 
and login. 

NOTE: The date and time are taken from the Siebel Server (not from the 
machine where the client browser is running). Make sure that the date 
and time are set correctly on the Siebel Server.

All Users Check this option to broadcast the message to all users.

Briefing Bulletin Check this option to distribute the message as a bulletin on the My 
Briefing page. For more information, see Siebel eBriefings Administration 
Guide.

Broadcast Required to send the message broadcast to recipient’s message bar. 
Check this option to broadcast and display the message. If not checked, 
the message is not broadcast in the message bar at the bottom of the 
screen.
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3 In the Message field, enter the message broadcast text you want to send.

4 (Optional) In the Message field, insert severity level tags as necessary to set the appearance of 
the message broadcast text.

Expiration Date/
Time

Date and time at which you want to stop broadcasting the message. If 
the Expiration field is left blank, the message does not expire and the 
message continues to be broadcast.

NOTE: The date and time are taken from the Siebel Server (not from the 
machine where the client browser is running). Make sure that the date 
and time are set correctly on the Siebel Server.

Message Required to create the message broadcast record. The text you want to 
send as the message broadcast. This field accepts up to 2,000 characters.

To use severity levels within the message text, see “About Automatically 
Updating Message Broadcasting Text” on page 119.

Recipient Division The broadcast message is sent to all users associated with the divisions 
selected in the Divisions dialog box.

This field can be used in combination with the Recipient Position field.

Recipient Position The broadcast message is sent to all users specified in the Recipients 
dialog box.

This field can be used in combination with the Recipient Division field.

For an employee name to show up in the Recipients dialog box, the 
employee must have a position defined and be marked active for that 
position. If multiple employees occupy the same position, the message is 
sent to all of them, even though you only see the active employee on the 
list.

Employees with multiple positions see messages sent to any of their 
positions, regardless of what position they log in as. 

Severity Required to create the message broadcast record. Choose the severity 
level to indicate the importance and appearance of the message. 

To force the message broadcast to appear in an alert box in the middle of 
the screen, in addition to its appearance on the message bar, select 
Urgent with Alert.

Field Comments
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About Automatically Updating Message 
Broadcasting Text
As an administrator, you can customize message broadcasting to automatically update message text 
that changes frequently. For example, a call center’s queue statistics frequently change. Every few 
minutes, an administrator has to update the statistics to make sure agents have the most accurate 
information. This manual approach is very time consuming and inefficient when dealing with 
frequently changing data.

You can use Siebel eAI to automatically update message broadcasting text. Your CTI middleware or 
ACD switch can provide the data for the Siebel application to distribute. 

The Broadcast Message business component manages the messages. The fields of this business 
component are listed and described in Table 16. These field names are necessary for developing the 
integration object.

A sample Visual Basic (VB) script follows, which demonstrates how to create and update a broadcast 
message with information, using the call center queue as an example. The sample Visual Basic script 
is generic; your CTI middleware’s API determines the structure of syntax like the Msg command. 

Table 16. Field Names for the Broadcast Message Business Component

Field Description

Abstract Short summary for identifying the purpose of a message, such as 
“Calls In Queue”

Activation Date/Time When the message broadcasting should begin

All To broadcast the message to all employees with positions defined

Body The text of the message displayed in the message bar

Division Used to set recipients using division

Division Id The internal identification value for Division

Expiration Date/Time When the message broadcasting should end

Position Used to set recipients using position

Position Id The internal identification value for Position

Recipient Used to set recipients using employee

Recipient Id The internal identification value for Recipient

Type Severity of the message as defined in the List of Values type 
BRDCST_MSG_TYPE

Via Broadcasting To send the message using message broadcasting

Via Interactive To send the message via Siebel eBriefings
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Sample Message Broadcasting Script
The script can be created through a button, an Excel macro, or another VB application. Because it is 
a script and not an application, it does not need the VB Set command. All the commands are standard 
to VB coding. 

This script is designed to update a message without an expiration date, not to create a new message 
every time. For more information on how to get or create a Siebel Application Object, see Configuring 
Siebel eBusiness Applications.

CAUTION: The code in this example updates single value fields. For information on how to update 
multi-value fields, see Configuring Siebel eBusiness Applications.

'Get "Broadcast Message" BusComp
Set BusObj = SiebelApplication.GetBusObject("Broadcast 

Message", errCode)
Set BusComp = BusObj.GetBusComp("Broadcast Message", errCode)

'Find "Calls Waiting" message
BusComp.SetSearchSpec "Abstract", "Calls In Queue", errCode
BusComp.ExecuteQuery 0, errCode
If BusComp.FirstRecord(errCode) <> True Then

'We need to create a new message
BusComp.NewRecord 0, errCode
BusComp.SetFieldValue "Abstract", "Calls In Queue", errCode
End If 

‘Prepare message using middleware API info.
Set Msg = "[N]Calls Waiting: [U]10"

'Update the record
BusComp.SetFieldValue "Body", Msg, errCode
BusComp.SetFieldValue "All", "Y", errCode

'Write the record
BusComp.WriteRecord errCode

In addition to writing a script, you can use Siebel Business Process Designer to create or update a 
broadcast message. For more information, see Siebel Business Process Designer Administration 
Guide.

Configuring Message Broadcast Caching
The following task describes how to configure your applications to take advantage of message 
broadcast caching. 

NOTE: Message Broadcast administration is not supported on Mobile Web Clients when message 
broadcasting caching is on. Additions, edits, and deletions to the Message Broadcasts list should be 
made when connected to the server.
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To configure message broadcast caching

1 Enable message broadcast caching at the server level: For each application’s object manager, set 
the Application Enable Message Broadcast Cache parameter to True.

For details on configuring server component (or AOM) parameters, see Siebel System 
Administration Guide.

NOTE: The default value for the Application Message Broadcast Cache Size parameter is 100. It 
is unlikely that you need to increase this value. The minimum cache size is the ratio [message 
bar refresh rate] / [message update interval]. For example, if the message bar updates every 
120 seconds and the message updates every 10 seconds, you need to set the cache size 
parameter to at least 12.

2 Enable message broadcast caching for Dedicated Web Clients (if any): Add or edit the 
EnableMsgbroadcastCache parameter in the [Siebel] section in your application’s CFG file:

EnableMsgbroadcastCache = TRUE

3 If you use any workflow policy that contains a workflow policy program of Type = Send Broadcast 
Message, then activate the Check New Broadcasted Message workflow policy, which belongs to 
the Siebel Messaging policy group.

For information about activating workflow policies, see Siebel Business Process Designer 
Administration Guide.

The Check New Broadcasted Message policy monitors the S_BRDCST_MSG table and invokes the 
Notify Broadcasted Message workflow process to broadcast any new message added to the table.
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This chapter explains the procedures necessary to create alerts for Siebel applications. It includes:

■ “About Alerts” on page 123

■ “Scenario for Using Alerts” on page 123

■ “Creating Alerts” on page 124

About Alerts
Alerts provide a platform for administrators and other users with access to the Alert Administration 
view to send long, complex, and customized messages directly to selected groups of recipients. 
Typically, these messages are time-critical, but also need to have associations with data in the 
company database (for instance, literature or products) and to be customized for the recipient.

For example, to communicate product pricing changes to a sales team with members around the 
world, a sales manager would want to be able to distribute new pricing structures and product 
information as soon as they are approved. Traditionally, this would be done with email messages, 
phone calls, or mailed literature. This approach presents some challenges:

■ To provide the necessary details, a large quantity of information may need to be distributed, with 
file attachments or links provided by the manager.

■ Different team members may require different price list or product information, depending on 
their organization, division, or position.

■ Distributing information to remote team members may produce a communication lag time.

Features of alerts include the following:

■ The abstract of alert messages are displayed in an applet on the recipients’ home page, listed in 
order of the priority specified by the sender. Recipients can click on the abstract to read the entire 
message.

■ Literature items, products, systems, and subsystems can be associated with alerts.

■ Access to price list and product information available to different team members may be 
controlled by organization, division, or position.

Scenario for Using Alerts
This scenario provides an example of a process flow performed by an administrator, a sales manager, 
and a Human Resources director. Your company may follow a different process flow according to its 
business requirements.
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A multinational software development corporation uses the Siebel Sales application to automate their 
sales workforce. The company is organized geographically by division for the purpose of access 
control, and alerts are enabled.

An international sales manager has just been given the go-ahead for a new set of software product 
bundles, which include one new product. He needs to communicate these price changes to his 
company’s sales force as soon as possible. Because pricing varies by geography, each of the four 
major geographical regions represented by his company’s four sales divisions need to receive a 
customized message about the new product bundles. He tells the Siebel administrator the details of 
the alert message that needs to be sent.

The Siebel administrator creates the alert message, and associates a price list and the new product 
with the message. She creates keywords that users will be able to search on to find the message at 
a later date, if necessary.

When the Siebel administrator sends the alert, a customized message is sent to all international sales 
representatives, with the appropriate price list for their division associated. The sales representatives 
see the alert message on their home pages upon login to the Web client or downloads alerts during 
synchronization. These users can navigate through the home page or Site Map to read the text and 
any associated literature items or products.

After sending the alert to the sales force, the Siebel administrator continues with other work. The 
Human Resources director has requested that employees be sent a weekly alert for the next month, 
reminding them to attend a benefits information session. The Siebel administrator creates this 
Human Resources alert, using the same process she used to create the sales force alert, but, instead 
of sending it as a single-message alert, she designates it to recur at weekly intervals. 

Creating Alerts
When you create an alert, all designated connected users receive the alert at the date and time the 
alert is activated. Mobile users, such as sales field representatives, receive an activated alert after 
synchronization.

To create an alert

1 Navigate to the Administration - Alert screen > Alerts view. 

2 In the Alerts list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Priority The priority of the message determines where the message appears in the list 
of alerts on the users’ home pages. Messages with the highest priority are at 
the top of the list.

Keyword Enter keywords that the user searches on to find this message.
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3 Drill down on the new record.

4 If you want to add literature as an attachment:

a Click the Literature view tab.

Type The type chosen from the drop-down list helps determine who receives the 
alert, as follows:

■ Employee Home Page Alert: Displays the alert on all employees’ home 
pages.

■ Partner Alert: Displays alerts to employees of registered partner 
companies. 

■ Program Information: Displays the alert to self-registered, individual 
partners.

■ Public Information: Displays the alert to unregistered, anonymous users.

Abstract Enter a brief abstract that summarizes the message. This appears as a 
hyperlink on the appropriate users’ home pages.

Activation Enter the date when the message will first appear to users.

Expiration Enter the date when the message will no longer appear to users.

Partner Alert Indicates that the alert is intended for partner companies. Make sure that this 
field is selected so that your alert will be seen.

Employee 
Alert

Indicates that the alert is intended for employee users.

Make sure that this field is selected so that your alert will be seen.

All Users Select this box if you want the alert to appear to all users, as indicated by the 
Employee Alert or Partner Alert check boxes. 

For example, if the Employee Alert check box is checked, and the All Users 
check box is checked, all employees receive the alert.

Message Body Type in the text of the message, including HTML formatting code if desired.

Alerts can be enhanced by using the following HTML formatting codes:

■ <b>text</b> = bold

■ <u>text</u> = underline

■ <i>text</i> = italics

■ <h4>text</h4> = font size

■ <a>href=“http:text”</a> = hyperlink to Web page or site

Message Body 
Preview

Displays message as it will look to users.

Field Comments
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b In the Literature list, create a new record for the literature item.

NOTE: Only literature of type Sales Tool can be added.

5 If you want to add a product as an attachment:

a Click the Product view tab.

b In the Product list, create a new record for the product.

6 If you want to specify the recipients:

a Click the Recipients view tab.

b From the Show drop-down list, select Recipient Divisions or Recipient Positions.

c Create new records to the Recipient List.

Remember, if you selected the All Users check box in Step 2 on page 124, the message will 
automatically be sent to all recipients.
Applications Administration Guide Version 7.7, Rev. B126 ■



10 Administering and Using Inbox
This chapter contains information about Inbox, how end users use Inbox and how administrators can 
make changes to Inbox types that are already configured.

If you want to create and configure new Inbox types or make changes to Inbox functionality that 
requires Siebel Tools, see Chapter 11, “Configuring the Inbox.”

This chapter includes the following topics:

■ “About the Inbox” on page 127

■ “Scenarios for Administering and Using the Inbox” on page 129

■ “Process of Administering and Using the Inbox” on page 130

■ “Reviewing All Inbox Items” on page 131

■ “Deleting Inbox Items” on page 132

■ “Setting Expiration Dates and Due Dates for Inbox Items” on page 132

■ “Changing the Destination View for an Inbox Type” on page 132

■ “Changing Inbox Downloading to Remote Databases” on page 133

■ “Adding Inbox Translations” on page 134

■ “Taking Action on Inbox Items (End User)” on page 134

■ “Reviewing Completed Items (End User)” on page 135

■ “Reviewing Submitted Items (End User)” on page 135

NOTE: If you have been using the previous version of Inbox and have upgraded to Version 7.7, see 
Upgrade Guide for the operating system you are using.

About the Inbox
The goals of the Inbox are to provide end users with:

■ A single screen that shows all approval and notification items assigned them regardless of the 
screen where the item originated.

■ Enough detailed information about the item so that they can act on the item from the Inbox and 
not have to navigate to other screens for more information.
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Table 17 lists some terminology used in this chapter.

How the Inbox Interacts with the Feature Objects
Inbox items contain references to the feature objects. 

Table 17. Inbox Terminology

Term Definition

Inbox item Inbox items are requests for approval and notification that appear in 
end users’ Inboxes. Inbox items point to other records (or to feature 
objects in the database) which require review or approval.

Inbox item is shortened to “item” in some text in this chapter.

Deactivated Inbox item The Inbox item has been processed or has expired. (It no longer 
appears in the Inbox Items List.)

Inbox screen This is the screen where the end users:

■ Take action on their current Inbox items

■ View their completed items

■ View their submitted items

Inbox Items List Inbox items that the user (the item’s owner) needs to act on appear 
in the Inbox Items List.

Submitted Items List Deactivated Inbox items that have been submitted by the user appear 
in the Submitted Items List.

Completed Items List Deactivated Inbox items appear in this list. Typically these are the 
items for which the approval process is complete.

Inbox action This is action that the end user takes on the Inbox item. Usually this 
is approval or rejection or acknowledgement. 

Inbox type The Inbox type determines some characteristics of the Inbox item, 
such as which actions (through business service methods) can be 
taken on it and its expiration date.

Destination view The Name hyperlink leads to the destination view (which displays 
data from the feature object).

Feature object A feature object is the underlying thing that the Inbox record points 
to; for example, a service request record or, for ESS, a row in the 
SmartScript session table. When you drill down on an item in the 
Inbox, you see the feature object.

ESS Siebel Employee Self-Service application. The Inbox is an important 
feature for this application. Information that is specific to the ESS 
application is called out in this chapter. 

Universal Inbox This is an alternate name for the Inbox. 
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Feature objects interact with Inbox items through the methods of the Universal Inbox business 
service. These methods can be invoked using various mechanisms, for example Run-time Events can 
catch the feature object’s business component operations. 

The Inbox interacts with feature objects through Inbox actions, which are defined as part of the 
Inbox type. Integration business service methods are invoked when the users take action on Inbox 
items.

Figure 8 illustrates interaction between feature objects and the Inbox.

About the Universal Inbox Business Service
The Universal Inbox business service is the interface between the underlying feature object and the 
Inbox items. Universal Inbox business service methods handle creation, update, deactivation, and 
deletion of Inbox items. 

CAUTION: Do not interact with the Inbox through any channel other than the Universal Inbox 
Business Service.

For information about the methods in Universal Inbox business service, see “Universal Inbox Business 
Service Methods” on page 149.

Scenarios for Administering and Using 
the Inbox
These two scenarios provide examples of processes performed by administrators and end users. Your 
company may follow a different process according to its business requirements. The examples 
provided in this topic are for an approval process, however, similar logic applies for other items such 
as notification.

■ “Scenario for Service Request Management” on page 130

Figure 8. How Inbox Interacts with Feature Objects
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■ “Scenario for Approving Personnel Action Forms Requests Captured Using ESS” on page 130

Scenario for Service Request Management
This organization has implemented an automated Inbox assignment and escalation policy for service 
requests. According to this policy, service requests are assigned based on the area, and an Inbox 
item is created to notify the service request owner of each assignment. In addition, an Inbox item 
is also created for the service request owner's manager—this is done based on a preset criterion, the 
priority of the service request. The Inbox was configured when the Siebel application was initially 
rolled out, but this recent change in policy requires the administrator to perform some tasks. 

The administrator changes the replication-level feature, which is currently set to Regional. He 
changes the setting so that Inbox items are downloaded to both regional and local databases. 

In addition, the policy has to be implemented in Japanese installations, so he adds the appropriate 
language translation. 

Previous Inbox items have been lingering in the Inbox for too long, so the administrator reduces the 
item expiration period. 

Finally, he adds a new drilldown destination view for certain users who do not have access to the 
standard Service Request views.

Scenario for Approving Personnel Action Forms Requests Captured 
Using ESS
The Human Resources manager at a company has outlined new personnel action policies for 
employees. Management has mandated that personnel change requests be filed electronically. An HR 
representative for the employee’s department must first check and approve the request, followed by 
an approval from the employee’s immediate supervisor, and the departmental vice president. This 
new policy is handed off to a Siebel administrator for implementation.

After using the Employee Self-Service feature to set up and activate the integrated Personnel Action 
Form (PAF), the administrator designs the approval flows for the business object using Siebel 
Business Process (Workflow) Administration. Using the Inbox, the administrator creates the required 
approval type. When an end user submits this particular item, the approval type created by the 
administrator invokes the approval workflow process.

A manager at the company submits a PAF. The form is routed to the human resources representative, 
then the manager, and finally the vice president. Each approver can reject the form and send it back 
to the requestor. If approved, the process flow results in an update of data fields.

Process of Administering and Using the 
Inbox
This section lists some of the tasks that administrators and end users might follow to administer and 
manage Inbox items. Your company may follow a different process according to its business 
requirements.
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Administrator Procedures
The following list includes some of the straightforward changes that the administrator can make to 
Inbox types that have already been configured. For detailed information about how to set up and 
configure Inbox, see Chapter 11, “Configuring the Inbox.”

■ “Reviewing All Inbox Items” on page 131

■ “Deleting Inbox Items” on page 132

■ “Setting Expiration Dates and Due Dates for Inbox Items” on page 132

■ “Changing the Destination View for an Inbox Type” on page 132

■ “Changing Inbox Downloading to Remote Databases” on page 133

■ “Adding Inbox Translations” on page 134

End-User Procedures
The following list shows the procedures that the end user, an employee, manager, or approver, 
typically perform. 

The end user (an employee, manager, or approver) uses the Inbox to:

■ “Taking Action on Inbox Items (End User)” on page 134

■ “Reviewing Completed Items (End User)” on page 135

■ “Reviewing Submitted Items (End User)” on page 135

Reviewing All Inbox Items
Administrator can view all the Inbox items. The administrator can also take action on any Inbox item.

To review all items

1 Navigate to the Administration - Inbox screen and one of the following views:

■ All Inbox Items. All items that are in users’ Inbox Items Lists—the administrator sees one 
record for each owner.

■ All Completed Items. All items that are in users’ Completed Items Lists—the administrator 
sees one record for each owner. 

■ All Submitted Items view. All items that are in users’ Submitted Items Lists—the 
administrator sees one record for each originator.

2 Click the Detail view tab to see information about the feature object.

3 Click the History view tab to see who owns the item and which owners have taken action on the 
item.
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Deleting Inbox Items
The administrator can delete Inbox items in the All Submitted Items view. When an item is deleted, 
it is deleted for all owners and for the user who submitted it.

To delete Inbox items

1 Navigate to the Administration - Inbox screen > All Submitted Items view.

2 Delete Inbox records.

Setting Expiration Dates and Due Dates 
for Inbox Items
Each Inbox item that gets created is associated with an Inbox type. Fields in the Inbox Type record 
determine the expiration and due dates for items of that type.

■ Item Expiration Duration (Days). The item expires this many days after submission.

■ Default Queue Duration (Days). The item is due this many days after it appears in the owner’s 
Inbox.

This task is a step in Process of Administering and Using the Inbox on page 130.

To change how item expiration and due dates are set for Inbox items of a given type

1 Navigate to Administration - Inbox screen > All Inbox Types view.

2 In the Inbox Types list, select a record and edit the following fields.

Changing the Destination View for an 
Inbox Type
If the Inbox item is set up to link to a particular view through the Name hyperlink, you can easily 
change this destination view or add new destination view. (The Name field as a hyperlink is shown 
in Figure 10 on page 140.)

Field Comments

Default 
Queue 
Duration 
(Days)

This field determines the due date for the item. When the item has been in the 
owner’s Inbox for more than this many days, the Past Due flag is turned on. 

Item 
Expiration 
Duration 
(Days)

This field determines the expiration date for the item. The Expiration field 
appears in the Submitted Items List. (By default, no action is taken when the 
item expires.)
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For example, if some users do not have responsibilities to see the current destination view, you can 
add a destination view that they can see. 

Multiple views can be associated with one Item type. Each view is assigned a sequence number. 
When users drill down on the Item hyperlink in the Inbox, they see the first view in the sequence 
that they have access to (based on their responsibilities). 

This task is a step in the Process of Administering and Using the Inbox on page 130.

Procedure

To add or change destination views for an Inbox type from the Views view

1 Navigate to Administration - Inbox screen > Actions view.

2 Select the Inbox type.

NOTE: If there is a record in the Action list where Action = Name Drilldown, then changing the 
destination view in the Views view has no effect. You need to change the Name Drilldown instead. 
For information on how to do this, see “Setting Up Inbox Actions” on page 142.

3 Click the Views view tab.

4 In the Views list, do one of the following:

a Edit the View name or Sequence # for an existing record.

b Create a new record and complete the View and Sequence # fields.

Make sure that the view you enter belongs to Business Object specified for the Inbox type.

Changing Inbox Downloading to Remote 
Databases
Inbox items can be set to download to regional and local databases. If your Inbox type is currently 
configured to download to remote databases, you can change this setting.

NOTE: If your Inbox type is not currently set to download to remote databases, see “Configuring 
Inbox for Use with Remote Databases” on page 144.

This task is a step in the Process of Administering and Using the Inbox on page 130.

To change remote downloading for an Inbox type

1 Navigate to Administration - Inbox screen > All Inbox Types view.

2 Select the Inbox type.

3 In the form view, edit the Replication Level:

■ All. To download Inbox items to regional and local databases

■ Regional. To download Inbox items to regional databases only
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■ None. Items are not downloaded to remote databases

CAUTION: If the Replication Level is currently set to None, see “Configuring Inbox for Use with 
Remote Databases” on page 144 before changing it.

Adding Inbox Translations
If you have a multilingual Siebel application, and the Inbox is not currently supporting all languages, 
you can use the Translations view to extend language support.

Create a translation record for each language supported in your multilingual application. 

This task is a step in Process of Administering and Using the Inbox on page 130.

To set up an Inbox translation

1 Navigate to Administration - Inbox screen > All Inbox Types view.

2 In the Inbox Types list, select the Inbox item and click the Translations view tab.

3 In the Translations list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Taking Action on Inbox Items (End User)
End users can take action on items that are sent to them for approval. The most typical actions are 
to approve, to reject, and to acknowledge. The actions available to the end user are determined by 
the item’s Inbox type.

This task is a step in Process of Administering and Using the Inbox on page 130.

To approve or reject an Inbox item

1 Navigate to the Inbox in the Site Map.

2 Select My Inbox Items or My Team’s Inbox Items.

3 In the Inbox Items list, select the item you want to approve or reject.

NOTE: You can click the Name hyperlink to review the feature object.

4 In the Action field, select the desired action, for example, Approved.

5 (Optional) In the Comments field, enter a brief explanation.

When the record is saved, the business service and method defined (in the Inbox type) for the action 
are triggered.

Field Comments

Display Name Translation of the Inbox type Name.
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Reviewing Completed Items (End User)
The History view lets end users track the progress of the items through each stage of the approval 
process. For example, managers can review the approval decision and comments made by each 
approver. 

This task is a step in Process of Administering and Using the Inbox on page 130.

To review items that have been previously approved

1 Navigate to the Inbox screen.

2 From the Show drop-down list, select My Completed Items or My Team’s Completed Items.

3 In the Completed Items List, select the item you want to review.

4 Drill down on the Name hyperlink to review the feature object. 

Reviewing Submitted Items (End User)
Users can review the Inbox items that they have submitted. They can check the progress of an item, 
for example, to see who has approved it and who has not.

This task is a step in Process of Administering and Using the Inbox on page 130.

To review submitted items

1 Navigate to the Inbox screen.

2 From the Show drop-down list, select My Submitted Items or My Team’s Submitted Items.

3 Review the Inbox items that you (or your team) have submitted.
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11 Configuring the Inbox
This chapter contains information about configuring the Inbox. 

For administration and end-user information about the Inbox, see Chapter 10, “Administering and 
Using Inbox.”

This chapter includes the following topics:

■ “Process of Setting Up and Configuring Inbox” on page 137

■ “Planning for Inbox Configuration” on page 138

■ “Creating Inbox Items” on page 138

■ “Creating Inbox Types” on page 139

■ “Setting Up Inbox Links to Views and SmartScripts” on page 141

■ “Setting Up Inbox Actions” on page 142

■ “Configuring Inbox for Use with Remote Databases” on page 144

■ “Setting Up Inbox Approval Translations” on page 145

■ “Configuring the Toggle Applets for Inbox Views (in Siebel Tools)” on page 146

■ “Configuring the Category Icon for the Inbox (in Siebel Tools)” on page 147

■ “Configuring Action Buttons for Inbox Views (in Siebel Tools)” on page 148

■ “Setting the Log File for Troubleshooting” on page 149

■ “Universal Inbox Business Service Methods” on page 149

■ “Examples of Inbox Triggers” on page 168

Process of Setting Up and Configuring 
Inbox
The following section describes the processes an administrator might follow to set up and configure 
the Inbox.

1 “Planning for Inbox Configuration” on page 138 

2 “Creating Inbox Items” on page 138

3 “Creating Inbox Types” on page 139

4 “Setting Up Inbox Links to Views and SmartScripts” on page 141

5 “Setting Up Inbox Actions” on page 142

6 “Configuring Inbox for Use with Remote Databases” on page 144
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7 “Setting Up Inbox Approval Translations” on page 145

Planning for Inbox Configuration
Before you start configuring the Inbox, you need to do some research and planning.

This task is a step in Process of Setting Up and Configuring Inbox on page 137.

To plan an Inbox Configuration

1 Choose the feature object you want to integrate with the Inbox.

For example, Employee Self-Service forms, Service Requests, Opportunities.

2 Analyze how the object is currently being accessed by answering the following questions: 

a Is the object accessed from the UI or from workflow processes? Is the object accessed from one 
place or many? 

b How is the object related to other objects? Are other objects dependent on the object?

c What operations do end users perform on the object?

3 Determine the integration mechanism by considering what needs to happen to the object after 
it enters the Inbox. 

There are two kinds of integration with the Inbox:

■ Inbound (Typically triggered through workflows, eScripts, Runtime Event, or Workflow 
Monitor agents)

■ Outbound (Typically through workflows and eScripts)

For example, if end users access the feature object in other ways besides through the Inbox, you 
need to synchronize (inbound) the Inbox with the object’s current data. (See also Figure 8 on 
page 129.)

4 Consider the following best practices:

■ Only interact with the Inbox through the methods in the Universal Inbox business service. 
(Do not edit Inbox fields directly.)

■ Do not customize fields in the Inbox.

■ Once an Inbox item has been deactivated for a given owner, it cannot be reactivated. Instead, 
create a new Inbox item for that owner.

Creating Inbox Items
Inbox items are created by the Universal Inbox business service. Methods for this business service 
can be called using various mechanisms, for example:

■ Workflows

■ Workflow Monitor Agent
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■ eScripting

■ Runtime Events

If you want to configure the application to have Inbox items created in a certain screen or for a 
business component, the following procedure outlines how this can be done.

This task is a step in Process of Setting Up and Configuring Inbox on page 137.

To configure the application to create Inbox items

1 Review the information about the Inbox business service, methods and workflows at the end of 
this chapter.

2 Review the procedures for setting up Inbox types.

3 Use one of the ways given in the preceding list to call the Inbox business service and create Inbox 
items. 

Creating Inbox Types
Each Inbox item that gets created is assigned an Inbox type. The Inbox type sets the following 
characteristics for the Inbox item:

■ Action Type

■ Category

■ Replication Level

■ Integration Object Name

■ Business Object Name

■ Item Expiration Duration (Days)

■ Default Queue Duration (Days) (Due date)

■ Views and SmartScripts that link to the Inbox item

■ Effects of the actions that the user can choose

Action Type
The action type is the LOV type that determines the actions the user can choose to take on an Inbox. 

Example
The action type is UINBOX_STATUS_TYPE. 
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There are three LOV records of type UINBOX_STATUS_TYPE: Approved, Received, and Rejected. 
These represent the actions that the user can take on an Inbox item of this type, as shown in 
Figure 9.

NOTE: Because the effect of action is set per Item type, this LOV type can be used for many Item 
types, but the effect of approving or rejecting can be different for each Item type.

Category
The category determines the icon that appears in the Category field for the item in the Inbox. See 
Figure 10.

The category field can be useful for querying and sorting Inbox item and Inbox type records. For 
information about editing the Category icon, see “Configuring the Category Icon for the Inbox (in 
Siebel Tools)” on page 147.

Procedure
This task is a step in Process of Setting Up and Configuring Inbox on page 137.

To create an Inbox type

1 Navigate to Administration - Inbox screen > All Inbox Types view.

Figure 9. The Action Drop-Down List in the Inbox

Figure 10. The Check Mark Indicates the Category Is Approvals
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2 In the Inbox Types list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

Setting Up Inbox Links to Views and 
SmartScripts
As an administrator you can specify that the Name field for the Inbox item drills down to a particular 
view and optionally runs a SmartScript. The Name field as a hyperlink is shown in Figure 10 on 
page 140.

Multiple views can be associated with one Item type. Each view is assigned a sequence number. 
When users drill down on the Item hyperlink in the Inbox, they see the first view in the sequence 
that they have access to (based on their responsibilities). 

How to Set up Views and SmartScripts for an Inbox Type
This task is a step in Process of Setting Up and Configuring Inbox on page 137.

NOTE: If you have set a Name Drilldown action, then view records you set up are ignored.

To set up views and SmartScripts for an Inbox type

1 Navigate to the Administration - Inbox screen > All Inbox Types view.

2 In the Inbox Types list, select a record, and then click the Views view tab.

Field Comments

Replication 
Level

If you do not want to download Inbox items to remote databases, select None. 
Otherwise, see “Configuring Inbox for Use with Remote Databases” on page 144.

Integration 
Object Name

If there is an integration object associated with the Inbox type, you can specify 
it here. This is no special logic associated with this field. 

Business 
Object Name

Enter the feature object that the destination view belongs to.

Default 
Queue 
Duration 
(Days)

This field determines the due date for the item. When the item has been in the 
owners Inbox for more than this many days, the Past Due flag is turned on. 

Item 
Expiration 
Duration 
(Days)

This field determines the expiration date for the item. The Expiration field 
appears in the Submitted Items List. (By default, no action is taken when the 
item expires.)
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3 In the Views list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Setting Up Inbox Actions

About Actions
There are four circumstances where a business service method can be invoked to act on an Inbox 
item. A different action type is used for each. These are summarized in Table 18.

About Deactivate Item Upon Finish and Deactivate Owners Upon 
Finish Fields
There are two ways that an Inbox item can be deactivated:

■ Deactivation can be done through one of the Universal Inbox Business Service methods. 

Field Comments

View Specify the view that an end user sees when they drill down on an Inbox item. 
For ESS, use the EmpSS Form Player view.

Sequence # Specifies the sequence in which views are available to the end user.

SmartScript Specifies the SmartScript to be run in the view.

SmartScripts are primarily used for ESS integration with Inbox. For example, 
an ESS Summary Form SmartScript.

Table 18. Actions for Inbox Types

Action Invokes the Specified Business Service Method When . . .

Action Field 
Dropdown

The user takes action (edits the Action field) on the Inbox item.

Name Drilldown The user drills down on the item’s Name hyperlink. (Another way you can 
configure this hyperlink is through the Views view. See “Setting Up Inbox Links 
to Views and SmartScripts” on page 141.)

Local Validation The user, in a remote database, drills down on the item’s Name hyperlink. For 
more information, see “Configuring Inbox for Use with Remote Databases” on 
page 144.

Initialize This action is provided for backward compatibility. Unless you are upgrading, 
use of this action is not recommended. For more information, see the Upgrade 
Guide for the operating system you are using.

This action invokes the Initialize method of the Universal Business Service. It 
creates an Inbox item and starts the defined method. 
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■ The Inbox type can be set up so that if the business method in the Actions record finishes without 
error, the item is deactivated. The item can be deactivated for all the owners or only for owner 
who takes the action:

■ If Deactivate Item Upon Finish is set, when one owner takes action on the item, the item is 
deactivated for all owners and all owners see the item in their Completed Items List. 

■ If Deactivate Owners Upon Finish is set, when one owner takes action, the item is deactivated 
(and moved to the Submitted Items List) for that owner alone. The item remains in the other 
owners’ Inbox List.

Procedure
This task is a step in Process of Setting Up and Configuring Inbox on page 137.

To set up an Inbox action

1 Navigate to Administration - Inbox screen > All Inbox Types view.

2 In the Inbox Types list, select the approval record, and click the Actions view tab.

3 In the Actions list, create a new record and complete the necessary fields.

Some fields are described in the following table.

In addition to the arguments passed in the Business Service Method Arguments field, the 
following arguments are always passed:

■ BusinessObjectName (Feature object name)

Field Comments

Action See Table 18 on page 142.

Business Service Specifies business service to be used. For example, Workflow Process 
Manager.

Business Service 
Method

Specifies the method to be invoked for the business service selected 
above. For example, RunProcess.

Business Service 
Method Arguments

Specifies the arguments required for invoking the business service 
method. 

If the Workflow Process Manager business service is being used, your 
workflow needs to contain process properties with these same 
argument names. For the above example, the arguments might be 
"ProcessName", "Location Change - Business Title Edit (Single Step 
Manager)".

Deactivate Item Upon 
Finish

Select to deactivate the Inbox item (for all owners) after the method 
has successfully completed.

Deactivate Owners 
Upon Finish

Select to deactivate the Inbox item (for one owner) after the method 
has successfully completed.
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■ InboxItemId (Row Id of the Inbox item)

■ InboxTypeName (The Inbox type for the item)

■ ActionLIC (Value selected in Action)

■ ObjectId (Id of the feature object)

■ InboxTypeId (Id of the Inbox type of the Inbox item)

■ OwnerInfoId (Id of the Inbox item owner)

NOTE: The Inbox Action passes the row id of the feature object in ObjectId. Within a workflow 
process, the id of the primary business component on which the process is based should be 
stored in process properties “Object Id” (with a space). Therefore, the workflow process should 
first copy the content of “ObjectId” to “Object Id” if needed.

Configuring Inbox for Use with Remote 
Databases
Inbox items can be downloaded to regional and local databases.

The Inbox functionality downloads Inbox item records but does not download the underlying feature 
object. 

CAUTION: The Inbox configurator must make sure that the feature object is downloaded; for 
example that the service request records that the Inbox item points to is downloaded to the local 
database.

If you are downloading Inbox items to remote databases, it is recommended that you set up a 
Localization Validation action. The Localization Validation action invokes a business service method 
(that you defined) when a remote user attempts to drill down from the Inbox to view the underlying 
feature object. The method you define needs to return an argument to the Inbox, telling it that the 
feature object is not there. The Inbox then displays an error message to the user and prevents the 
drill down. 

To configure the Inbox for remote use

1 Define a business service with a business service method that:

a Accepts the following arguments from the Inbox:

❏ InboxItemId

❏ OwnerInfoId

❏ ObjectId

❏ InboxTypeName

❏ BusinessObjectName

❏ IntegrationObjectName

❏ Name-value pairs from the Inbox Parameters tables
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b Looks for the feature object, and, if the feature object is found, sets the output argument 
LocalValidationError to N. 

2 Navigate to Administration - Inbox screen > All Inbox Types view.

3 In the Inbox Types list, select the type record.

4 In the More Info form, set the Replication Level:

■ All. To download Inbox items to regional and local databases

■ Regional. To download Inbox items to regional databases only

5 Click the Actions view tab.

In the Actions list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Setting Up Inbox Approval Translations
If your Siebel application is multilingual, you need to create a translation record for each language. 

Use the Translations view to specify Inbox Type names in other languages.

This task is a step in Process of Setting Up and Configuring Inbox on page 137.

To set up an Inbox translation

1 Navigate to Administration - Inbox screen > All Inbox Types view.

2 In the Inbox Types list, select the approval record and click the Translations view tab.

3 In the Translations list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Action Local Validation

Business Service The business service that you defined in Step 1.

Business Service 
Method

The business service method that you defined in Step 1. 

Business Service 
Method Arguments

Arguments for the business service method.

Field Comments

Display Name Translation of the Inbox type Name.
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Configuring the Toggle Applets for Inbox 
Views (in Siebel Tools)
The Inbox supports dynamic toggle applets in three types of views, see Table 19.

Setting up the dynamic applet toggles determines what form applet appears in the lower portion of 
the Inbox Detail views. In general, you want the applet based on the business object of the 
underlying feature object. 

Example
For example, if you are setting up the Inbox for service request approvals, you can create a dynamic 
applet toggle that displays the Service Request Detail Applet form applet (when the business object 
for the Inbox type is Service Requests). You then create a link between the Inbox business 
components and the Service Request business component so that the service request information 
can display in the Inbox detail views.

Procedure

To configure dynamic toggle applets for the Inbox

1 In Siebel Tools, create an applet child object for the appropriate toggle applet (Table 19), as 
follows:

■ Applet = a form applet (Make sure that an Applet Web Template is defined for the Edit mode 
of this applet.)

■ Auto Toggle Field = Item Type BusObj Name

■ Auto Toggle Value = the business object of the Inbox type (For example, Service Request.)

For more information about how to configure applet toggles, see Configuring Siebel eBusiness 
Applications.

2 Create a links between the feature object’s business component and the two Inbox business 
components (UInbox Item and UInbox Item Task). 

Table 19. Dynamic Toggle Applets for Inbox

Views Supporting Dynamic 
Toggle Applet Toggle Applet Name

Corresponding 
Business 
Component for 
Views

Inbox items detail views UInbox Item Task Toggle List Applet UInbox Item Task

Completed items detail views

Submitted items detail views UInbox Item Toggle List Applet UInbox Item
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a Create a link record.

b Complete the fields as follows:

■ Name = this field is automatically populated after the Parent Business Component and Child 
Business Component fields are completed

■ Parent Business Component = UInbox Item Task or UInbox Item

■ Child Business Component = the business component for the dynamic applet toggle, for 
example, Service Request

■ Source Field = Item Object Id

■ Destination Field = the Id of the feature object displayed in the dynamic applet toggle; 
usually this is Id)

For more information about creating links, see Configuring Siebel eBusiness Applications.

3 Associate the business component for the dynamic applet toggle with the two Inbox business 
objects (UInbox ItemTask and UInbox Item History). For each link:

a Create a business object component record.

b Complete the fields as follows:

■ Name = the name of the business component for the dynamic applet toggle, for example 
Service Request

■ Link = the name of the link from Step 2

Configuring the Category Icon for the 
Inbox (in Siebel Tools)
You can change and add to the icons that appear in the Category field by editing the Bitmap Category 
called Inbox Category. 

For more information about bitmap categories and working with images, see Configuring Siebel 
eBusiness Applications.

To add Category icon for a Category field value

1 Add the icon image file (.gif) to the images directory.

Base the size of your image on the existing Category icons in this directory, for example, 
icon_approval.gif.

2 In Siebel Tools, create a bitmap record for the Bitmap Category object called Inbox Category and 
complete the fields as follows:

■ Name = the Language-Independent Code for the value, from the UINBOX_INBOX_TYPE LOV, 
for example CAMPAIGNS

■ Bitmap = The name of the file from Step 1

■ Bitmap Category = Inbox Category
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Configuring Action Buttons for Inbox 
Views (in Siebel Tools)
In the preconfigured Siebel application, users take action on an Inbox item by choosing from the 
Action drop-down list. 

You can configure the Inbox so that the first five values in the Action drop-down list display as 
buttons on the UInbox Item Task List Applet applet. See Figure 11 for an example.

Activating the Inbox Action Buttons
Which controls you activate depends on whether your application runs in standard or in high 
interactivity mode.

For more information about working with controls in applets, see the section about editing applet 
layout in Configuring Siebel eBusiness Applications.

To configure action buttons for standard interactivity

1 Navigate to the UInbox Item Task List Applet.

2 Select the Edit List Applet Web Template and then activate the following Applet Web Template 
Items:

■ ActionControl0

■ ActionControl1

■ ActionControl2

■ ActionControl3

■ ActionControl4

To configure action buttons for high interactivity

1 For the Applet Siebel Object called UInbox Item Task List Applet, select the Edit List Applet Web 
Template item.

Figure 11. Example of Action Buttons

Action Buttons
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2 Activate the UInboxCustomCtrl.

The first five entries in the Action drop-down list display as buttons on the applet. 

Configuring Background Colors for the Inbox Action Buttons
If you edited the cascading style sheet for the list applet and changed the background colors, you 
need to edit the background colors for the action buttons so that they match the applet.

To change the background colors for the action buttons
■ For the UInboxCustomCtrl Applet Control, edit these user properties, shown in the following 

table.

Setting the Log File for Troubleshooting
For troubleshooting problems with the Inbox, set the Inbox log file to a verbose level. 

To set the level of the Inbox log file for troubleshooting
■ Set the Log Level for the Inbox log file (Alias = InboxLog) to 5.

For information about log files, see System Monitoring and Diagnostics Guide for Siebel eBusiness 
Applications.

Universal Inbox Business Service 
Methods
This section discusses the Universal Inbox business service and lists its methods.

Definitions needed to understand the Universal Inbox Business Service (see also Figure 12):

■ Inbox item and Inbox item owner. For most of this chapter, the term Inbox item has been 
used synonymously with Inbox item owner. But to understand how the methods for the Universal 
Inbox business service work, it is necessary to distinguish between the two: 

■ The Inbox item. This is the record that appears in the Submitted Items views. 

■ The Inbox item owner. This is the record that appears in Inbox Items and Completed Items 
views. Owner information contained in this record. Typically there are one or more Inbox item 
owner records associated with one Inbox item record.

User Property Comment Default Value

ActiveBackgroundColor Color code for the active 
background color

#333399

InActiveBackgroundColor Color code for the inactive 
background color

#ffffff
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■ Name-value pairs. In addition to the predefined fields that belong to the Inbox item records 
(such as, type name, expiration date), there is provision to store additional data with the Inbox 
item in the form of name-value pairs. The name-value pairs are typically used to record data 
specific to the underlying feature object. The name-value pairs are stored in the Inbox 
Parameters table associated with the Inbox item.

Table 20 lists the Universal Inbox business service methods.

Figure 12. Relationship Between Inbox Items and Inbox Item Owners

Table 20. Universal Inbox Business Service Methods

Method Name Description

1 CreateInboxEx This method creates an Inbox item and an Inbox item owner.

2 CreateInbox This method creates multiple Inbox items and multiple Inbox 
item owners.

3 CreateInboxItem This method creates multiple Inbox items.

4 CreateInboxOwner This method creates multiple Inbox item owners for an Inbox 
item.

5 IsInboxItemExisted This method checks if an Inbox item exists.

6 GetInboxItemInfo This method returns field values from an Inbox item and, if 
GetParams is true, returns the name-value pairs for the Inbox 
item.

7 GetInboxParamInfo This method returns the name-value pairs for an Inbox item.

8 GetInboxOwnerInfoEx This method returns field values for an Inbox item owner. 

9 GetInboxOwnerInfo This method returns field values for multiple Inbox item owners 
for a given Inbox item, and returns information about the 
action status of the items.

10 SetInboxParamInfo This method inputs name-value pairs for an Inbox item.

11 UpdateInboxItemInfo This method updates field values for an Inbox item.

12 DeactivateInboxItem This method deactivates all Inbox item owners for an Inbox 
item and updates field values for that Inbox item.

This record appears in the 
Submitted Items views.

These records appear in the Inbox 
Items and Completed Items views.
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CreateInboxEx Method
This method creates an Inbox item and an Inbox item owner. 

See Table 21 and Table 22.

Input Arguments

13 DeactivateInboxOwner This method deactivates an Inbox item owner and updates field 
values for that Inbox item owner.

14 UpdateInboxOwnerInfo This method updates field values for an Inbox item owner.

15 DeleteInboxItem This method deletes an Inbox item and all associated Inbox 
item owners.

16 Initialize This method is intended for use only by those upgrading from 
the 7.5.3 version of the application.

This method creates an Inbox item and starts the business 
service method defined in the Initialize action.

17 RouteInboxItem This method is intended for use only by those upgrading from 
the 7.5.3 version of the application. For more information 
about this method, see Upgrade Guide for the operating 
system you are using.

This method deactivates existing Inbox item owners and 
creates new Inbox item owners for an Inbox item.

Table 21. CreateInboxEx Method, Property Set, Type = InboxInfo

Property Name Req’d Comments

InboxName Y

InboxTypeName Y

InboxPartyId Y

Comments

ObjectId

InboxExpirationDuration In seconds

InboxUTCExpirationTS UTC timestamp

Table 20. Universal Inbox Business Service Methods

Method Name Description
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Output Arguments

CreateInbox Method
This method creates multiple Inbox items and multiple Inbox item owners.

See Table 23 and Table 26.

ReplicationLevel Indicate whether this Inbox item needs to be 
routed when using remote databases.

■ All = HQ, Regional, Local

■ Regional = HQ, Regional

■ None = HQ

OwnerPartyId Y

OwnerPriority

OwnerQueueDuration In seconds

OwnerUTCStartWorking
TS

UTC timestamp

OwnerActionLIC Language independent code

OwnerUTCDueTS UTC timestamp

The name-value pairs are put into the Inbox Parameters table

Table 22. CreateInboxEx Method, Property Set

Property Name Comments

InboxItemId

OwnerInfoId

Table 21. CreateInboxEx Method, Property Set, Type = InboxInfo

Property Name Req’d Comments
Applications Administration Guide Version 7.7, Rev. B152 ■



Configuring the Inbox ■ Universal Inbox Business Service Methods
Input Arguments

Table 23. CreateInbox Method, Property Set, Type = InboxInfo

Property Name Req’d Comments

Child properties Multiple children are allowed. See Table 24.

Table 24. CreateInbox Method, Child Property Set, Type = InboxItemInfo

Property Name Req’d Comments

InboxName Y

InboxTypeName Y

InboxPartyId Y

ObjectId

InboxExpirationDuration In seconds.

InboxUTCExpirationTS UTC timestamp.

Comments

The name-value pairs are put into the Inbox Parameters table.

Child properties Multiple children are allowed. See Table 25.

Table 25. CreateInbox Method, Grandchild Property Set, Type = InboxOwnerInfo

Property Name Req’d Comments

OwnerPartyId Y

OwnerPriority

OwnerQueueDuration In seconds

OwnerUTCDueTS UTC timestamp

OwnerUTCStartWorkingTS UTC timestamp

OwnerActionLIC Language independent code
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Output Arguments

CreateInboxItem Method
This method creates multiple Inbox items.

See Table 29 and Table 30.

Input Arguments

Table 26. CreateInbox Method, Property Set

Property Name Comments

Child properties Multiple children can be returned. See Table 27.

Table 27. CreateInbox Method, Child Property Set, Type = ItemOutput

Property Name Comments

InboxItemId The row Id of the newly created Inbox item.

Child properties Multiple children can be returned. See Table 28.

Table 28. CreateInbox Method, Grandchild Property Set, Type = OwnerInfoOutput

Property Name Comments

OwnerPartyId

OwnerInfoId

Table 29. CreateInboxItem Method, Property Set, Type = InboxItemInfo

Property Name Req’d Comments

InboxName Y

InboxTypeName Y

InboxPartyId Y

ObjectId

InboxExpirationDuration In seconds

InboxUTCExpirationTS UTC timestamp

Comments
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Output Arguments

CreateInboxOwner Method
This method creates multiple Inbox item owners for an Inbox item. If DeactivateOthers is true, the 
method deactivates the current active Inbox item owners before creating new ones.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 31 and Table 33.

ReplicationLevel Indicate whether this Inbox item needs to be 
routed when using remote databases.

■ All = HQ, Regional, Local

■ Regional = HQ, Regional

■ None = HQ

The name-value pairs are put into the Inbox Parameters table

Table 30. CreateInboxItem Method, Property Set, Type = ItemOutput

Property Name Comments

InboxItemId The row Id of the newly created Inbox item

Table 29. CreateInboxItem Method, Property Set, Type = InboxItemInfo

Property Name Req’d Comments
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Input Arguments

Output Arguments

Table 31. CreateInboxOwner Method, Property Set

Property Name Req’d Comments

InboxItemId

ObjectId

InboxTypeName

DeactivateOthers Default is yes (deactivate others).

Child properties Multiple children are allowed. See Table 32.

Table 32. CreateInboxOwner Method, Child Property Set, Type = InboxOwnerInfo

Property Name Req’d Comments

OwnerPartyId Y

OwnerPriority Language independent code

OwnerQueueDuration In seconds

OwnerUTCDueTS UTC timestamp

OwnerUTCStartWorking
TS

UTC timestamp

OwnerActionLIC Language independent code

Table 33. CreateInboxOwner Method, Property Set, Type = ItemOutput

Property Name Comments

InboxItemId The row Id of the newly created Inbox item.

Child properties Multiple children can be returned. See Table 34.

Table 34. CreateInboxOwner Method, Child Property Set, Type = OwnerInfoOutput

Property Name Comments

OwnerPartyId

OwnerInfoId
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IsInboxItemExisted Method
This method checks if an Inbox item exists.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 35 and Table 36.

Input Arguments

Output Arguments

GetInboxItemInfo Method
This method returns field values from an Inbox item and, if GetParams is true, returns the name-
value pairs for the Inbox item.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 37 and Table 38.

Table 35. IsInboxItemExisted Method, Property Set

Property Name Req’d Comments

InboxItemId

ObjectId

InboxTypeName

Table 36. IsInboxItemExisted Method, Property Set

Property Name Comments

IsInboxItemExisted 1 or 0

InboxItemId

HasActiveOwners Indicates if the Inbox item has active owners (1 or 0)
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Input Arguments

Output Arguments

GetInboxParamInfo Method
This method returns the name-value pairs for an Inbox item.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 39 and Table 40.

Table 37. GetInboxItemInfo Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated

ObjectId For searching, not updated

InboxTypeName For searching, not updated

GetParams If Y, returns all name-value pairs

Table 38. GetInboxItemInfo Method, Property Set

Property Name Comments

ObjectId

InboxTypeId

InboxTypeName

InboxName

InboxPartyId

Comments

InboxUTCExpirationTS UTC timestamp

Name - value pairs
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Input Arguments

Output Arguments

GetInboxOwnerInfoEx Method
This method returns field values for an Inbox item owner. If the Inbox item owner is in the screen-
active business component record, the method returns the values from the screen-active business 
component.

The method searches as follows:

1 OwnerInfoId

2 InboxItemId, OwnerPartyId

3 ObjectId, InboxTypeName, OwnerPartyId

See Table 41 and Table 42.

Input Arguments

Table 39. GetInboxParamInfo Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated

ObjectId For searching, not updated

InboxTypeName For searching, not updated

Table 40. GetInboxParamInfo Method, Property Set

Property Name Comments

Name - value pairs

Table 41. GetInboxOwnerInfoEx Method, Property Set

Property Name Req’d Comments

ObjectId For searching, not updated

InboxTypeName For searching, not updated

OwnerPartyId For searching, not updated

InboxItemId For searching, not updated

OwnerInfoId For searching, not updated
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Output Arguments

GetInboxOwnerInfo Method
This method returns field values for multiple Inbox item owners for a given Inbox item, and returns 
information about the action status of the items.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 43 and Table 44.

Input Arguments

Table 42. GetInboxOwnerInfoEx Method, Property Set

Property Name Comments

OwnerInfoId

OwnerPriority

OwnerActionLIC

OwnerUTCDueTS

OwnerComments

OwnerStartWorkingTime

OwnerEndWorkingTime

Table 43. GetInboxOwnerInfo Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated

ObjectId For searching, not updated

InboxTypeName For searching, not updated

ActiveOwnerOnly Default is TRUE. Indicates that information is 
returned only for active owners. 

EvaluateOR Evaluate the OR condition on all owners’ actions 
based on the Action which is passed in from the 
caller

EvaluateAND Evaluate the AND condition on all owners’ actions 
based on the Action which is passed in from the 
caller
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Output Arguments

SetInboxParamInfo Method
This method inputs name-value pairs for an Inbox item.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 46.

Input Arguments

Table 44. GetInboxOwnerInfo Method, Property Set

Property Name Comments

OREvalResult 1 or 0

ANDEvalResult 1 or 0

Child Properties Multiple children can be returned. See Table 45.

Table 45. GetInboxOwnerInfo Method, Child Property Set, Type = InboxOwnerInfo

Property Name Comments

OwnerInfoId

OwnerPriority

OwnerActionLIC Language independent code

OwnerUTCDueTS UTC timestamp

OwnerComments

OwnerStartWorkingTime UTC timestamp

OwnerEndWorkingTime UTC timestamp

Table 46. SetInboxParamInfo Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated

ObjectId For searching, not updated
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UpdateInboxItemInfo Method
This method updates field values for an Inbox item.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 47.

Input Arguments

InboxTypeName For searching, not updated

The name-value pairs are put into the Inbox Parameters table

Table 47. UpdateInboxItemInfo Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated.

ObjectId For searching, not updated.

InboxTypeName For searching, not updated.

InboxName Value passed cannot be empty.

InboxPartyId Value passed cannot be empty.

ReplicationLevel Indicate whether this Inbox item needs to be 
routed when using remote mobile client.

Possible values are:

■ All = HQ, Regional, Local

■ Regional = HQ, Regional

■ None = HQ

Comments

InboxExpirationDuration In seconds. Value passed cannot be empty.

InboxUTCExpirationTS UTC timestamp. Value passed cannot be empty.

The name-value pairs are put into the Inbox Parameters table.

Table 46. SetInboxParamInfo Method, Property Set

Property Name Req’d Comments
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DeactivateInboxItem Method
This method deactivates all Inbox item owners for an Inbox item and updates field values for that 
Inbox item.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 48.

Input Arguments

Table 48. DeactivateInboxItem Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated.

ObjectId For searching, not updated.

InboxTypeName For searching, not updated.

InboxName Value passed cannot be empty.

InboxPartyId Value passed cannot be empty.

ReplicationLevel Indicate whether this Inbox item needs to be 
routed when using remote mobile client.

Possible values are:

■ All = HQ, Regional, Local

■ Regional = HQ, Regional

■ None = HQ

Comments

InboxExpirationDuration In seconds. Value passed cannot be empty.

InboxUTCExpirationTS UTC timestamp. Value passed cannot be empty.

The name-value pairs are put into the Inbox Parameters table.

Child Properties Multiple children are allowed. See Table 49.

Table 49. DeactivateInboxItem Method, Child Property Set, Type = InboxOwnerInfo

Property Name Req’d Comments

OwnerPartyId For searching, not updated

OwnerInfoId For searching, not updated
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DeactivateInboxOwner Method
This method deactivates an Inbox item owner and updates field values for that Inbox item owner.

The method searches as follows:

1 OwnerInfoId

2 InboxItemId, OwnerPartyId

3 ObjectId, InboxTypeName, OwnerPartyId

If there is SSASqlErrWriteConflict conflict, clear the error message in order not to show the error 
message on UI.

See Table 50.

Input Arguments

OwnerPriority

OwnerActionLIC Language independent code

OwnerComments

OwnerStartWorkingTime UTC timestamp, or

Y, T, or TRUE to set to the current time.

OwnerEndWorkingTime UTC timestamp, or

Y, T, or TRUE to set to the current time.

Table 50. DeactivateInboxOwner Method, Property Set

Property Name Req’d Comments

ObjectId For searching, not updated

InboxTypeName For searching, not updated

OwnerPartyId For searching, not updated

InboxItemId For searching, not updated

OwerInfoId For searching, not updated

OwnerPriority

OwnerActionLIC Language independent code

OwnerComments

Table 49. DeactivateInboxItem Method, Child Property Set, Type = InboxOwnerInfo

Property Name Req’d Comments
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UpdateInboxOwnerInfo Method
This method updates field values for an Inbox item owner.

The method searches as follows:

1 OwnerInfoId

2 InboxItemId, OwnerPartyId

3 ObjectId, InboxTypeName, OwnerPartyId

See Table 51.

Input Arguments

OwnerStartWorkingTime UTC timestamp, or

Y, T, or TRUE to set to the current time.

OwnerEndWorkingTime UTC timestamp, or

Y, T, or TRUE to set to the current time.

Table 51. UpdateInboxOwnerInfo Method, Property Set

Property Name Req’d Comments

ObjectId For searching, not updated

InboxTypeName For searching, not updated

OwnerPartyId For searching, not updated

InboxItemId For searching, not updated

OwerInfoId For searching, not updated

OwnerPriority

OwnerActionLIC Language independent code

OwnerQueueDuration In seconds

OwnerUTCDueTS UTC timestamp

OwnerComments

Table 50. DeactivateInboxOwner Method, Property Set

Property Name Req’d Comments
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DeleteInboxItem Method
This method deletes an Inbox item and all associated Inbox item owners.

The method searches as follows:

1 InboxItemId

2 ObjectId + InboxTypeName

See Table 52.

Usage Example
Call this method when the underlying feature object for the Inbox item has been deleted. 

Input Arguments

Initialize Method
This method is intended for use only by those upgrading from the 7.5.3 version of the application.

This method creates an Inbox item and starts the business service method defined in the Initialize 
action.

CAUTION: Priority is no longer an input argument for the Initialize method. (Task) Priority is an 
input argument for the RouteInboxItem Method.

See Table 53.

OwnerStartWorkingTime UTC timestamp, or

Y, T, or TRUE to set to the current time.

OwnerEndWorkingTime UTC timestamp, or

Y, T, or TRUE to set to the current time.

Table 52. DeleteInboxItem Method, Property Set

Property Name Req’d Comments

InboxItemId For searching, not updated

ObjectId For searching, not updated

InboxTypeName For searching, not updated

Table 51. UpdateInboxOwnerInfo Method, Property Set

Property Name Req’d Comments
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Input Arguments

RouteInboxItem Method
This method is intended for use only by those upgrading from the 7.5.3 version of the application. 
For more information about this method, see Upgrade Guide for the operating system you are using.

This method deactivates existing Inbox item owners and creates new Inbox item owners for an Inbox 
item.

See Table 54 and Table 56.

Input Arguments

Table 53. Initialize Method, Property Set

Property Name Req’d Comments

ItemType Y

ItemDescription Y

ItemObjectId Y

ItemSubmittedBy Y

ItemPriority  Not supported in version 7.7

ItemQueueDuration

ItemComments

Table 54. RouteInboxItem Method, Property Set

Property Name Req’d Comments

ItemWorkflowInstanceId Y

Child Properties Y Multiple children are allowed. See Table 55.

Table 55. RouteInboxItem Method, Child Property Set, Type = TaskOwnerInfo

Property Name Req’d Comments

TaskOwnerId Y

TaskStatus

TaskPriority
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Output Arguments

Examples of Inbox Triggers
This section presents samples of Inbox triggers.

■ “Inbox Trigger Used in ESS” on page 168

■ “Inbox Trigger Using Server Script” on page 169

Inbox Trigger Used in ESS
This section presents a sample of SmartScript code. 

This code is entered in the Script_Finish statement of the ESS Form (SmartScript). It can be accessed 
from the Administration - SmartScript screen > Scripts view in the ERM application. For more 
information, see about Linking Self-Service Forms to the Inbox in Siebel Employee Relationship 
Management Administration Guide.

The purpose of the script is to take data from the ESS Form (SmartScript) as well as some required 
arguments to invoke the Universal Inbox business service under the Initialize method. When the user 
submits the ESS Form (SmartScript), this eScript code is launched, invoking the Universal Inbox 
business service, and creating an Inbox item based on the parameters specified in the eScript and 
the Inbox type.

function Script_Finish ()
{

var szScriptSessionId;
var szRequester;
var svc;
var indata;
var outdata;
var ssPage;
var ssQuestion;
var EmployeeLastName;
var EmployeeFirstName;
var RequestedChange;

Table 56. RouteInboxItem Method, Property Set, Type = ItemOutput

Property Name Comments

InboxItemId The row Id of the newly created Inbox item.

Child properties Multiple children can be returned. See Table 57.

Table 57. RouteInboxItem Method, Child Property Set, Type = OwnerInfoOutput

Property Name Comments

 OwnerPartyId

 OwnerInfoId
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var PAFComments;
var PAFPriority;
var szSSLanguageCode;
var szSSCurrencyCode;

ssPage = GetPage("PAF Which Change");
ssQuestion = ssPage.GetQuestion("Display Employee Last Name");

   EmployeeLastName = ssQuestion.GetCurrentValue();
ssQuestion = ssPage.GetQuestion("Display Employee First Name");
EmployeeFirstName = ssQuestion.GetCurrentValue();
ssQuestion = ssPage.GetQuestion("PAF Change Requested");
RequestedChange = ssQuestion.GetCurrentValue();
ssQuestion = ssPage.GetQuestion("PAF Comments");
PAFComments = ssQuestion.GetCurrentValue();
ssQuestion = ssPage.GetQuestion("PAF Priority");
PAFPriority = ssQuestion.GetCurrentValue();

// Cancel saving everything to the database
Cancel ();

indata =TheApplication ().NewPropertySet ();
outdata = TheApplication ().NewPropertySet ();

// Get the login name of the user
szRequester = TheApplication ().LoginName ();
// Get SmartScript Save Session table Id.
szScriptSessionId = GetSessionId ();

szSSLanguageCode = GetParameter("Language");
szSSCurrencyCode = GetParameter("Currency");

indata.SetProperty ("SmartScriptLanguageCode", szSSLanguageCode);

// ItemObjectId, ItemType, ItemSubmittedBy, and ItemDescription are the
// required input arguments for the "Universal Inbox.Initialize"
indata.SetProperty ("ItemObjectId", szScriptSessionId);
// Item Type is the Approvals Inbox type defined in the
// Approvals Inbox Administration screen
indata.SetProperty ("ItemType", "Personnel Action Form");
// Short Description of the inbox item
indata.SetProperty ("ItemDescription", RequestedChange + " PAF" + " for " + EmployeeFirstName + " " +

EmployeeLastName);
indata.SetProperty ("ItemSubmittedBy", szRequester);

// ItemQueueDuration, ItemPriority, and ItemComments are the
// optional input arguments for the "Universal Inbox.Initialize"
indata.SetProperty ("ItemQueueDuration", "129600");
indata.SetProperty ("ItemPriority", PAFPriority);
indata.SetProperty ("ItemComments", PAFComments);
svc = TheApplication ().GetService ("Universal Inbox");
svc.InvokeMethod("Initialize", indata, outdata);

}

Inbox Trigger Using Server Script
This section presents a sample Server Script that calls Inbox methods.

This code is entered in the PreWriteRecord statement for the Project business component in Siebel 
Tools. The purpose of this code is to take data from the project record as well as some required 
arguments to invoke the Universal Inbox business service under the Initialize method. When the user 
changes the value of the Status field to For Approval, this eScript code is launched, invoking the 
Universal Inbox business service and creating an Inbox item based on the parameters specified in 
the eScript and the Inbox type.
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function BusComp_PreWriteRecord ()
{

var FldProjectStatus = this.GetFieldValue("Status");

if (FldProjectStatus == "For Approval")
{
var szScriptSessionId;
var szRequester;
var svc;
var indata;
var outdata;

indata =TheApplication ().NewPropertySet ();
outdata = TheApplication ().NewPropertySet ();

// Get the login name of the user
szRequester = TheApplication ().LoginName ();

// ItemObjectId, ItemType, ItemSubmittedBy, and ItemDescription are the
// required input arguments for the "Universal Inbox.Initialize"
var FldProjectNum = this.GetFieldValue("Project Num");
indata.SetProperty ("ItemObjectId", FldProjectNum);
// Item Type is the Approvals Inbox type defined in the
// Approvals Inbox Administration screen
indata.SetProperty ("ItemType", "ChangeManagement");
// Short Description of the inbox item
indata.SetProperty ("ItemDescription", FldProjectNum);
indata.SetProperty ("ItemSubmittedBy", szRequester);

   // ItemQueueDuration, ItemPriority, and ItemComments are the
// optional input arguments for the "Universal Inbox.Initialize"
indata.SetProperty ("ItemQueueDuration", "129600");
indata.SetProperty ("ItemPriority", "High");
indata.SetProperty ("ItemComments", "Change Management Project");
svc = TheApplication ().GetService ("Universal Inbox");
svc.InvokeMethod("Initialize", indata, outdata);
}

return (ContinueOperation);
}
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This chapter describes the administrative setup tasks that need to be performed before the Messages 
screen and views are used. It also explains how end users create, view, sort, and send messages.

NOTE: The Messages functionality is unrelated to the message broadcasting and alerts discussed in 
Chapter 9, “Alerts” and Chapter 8, “Message Broadcasting.”

This chapter includes the following topics:

■ “Scenario for Setting Up Messages” on page 171

■ “Process of Setting Up and Using Messages” on page 172

■ “About Using Messages” on page 172

■ “Setting Up Messages” on page 172

■ “About Email and Screen Alerts” on page 173

■ “Creating a New Message (End User)” on page 173

■ “Setting Up Single and Recurring Alerts (End User)” on page 175

■ “Viewing Messages (End User)” on page 175

■ “Sorting Messages by Intervals (End User)” on page 176

■ “Sending a Message Using Email (End User)” on page 176

Scenario for Setting Up Messages 
This scenario provides an example of a business process performed by an administrator and a sales 
representative to set up and manage messages. Your company may follow a different process 
according to its business requirements.

A corporation has hired four new sales representatives. The Siebel administrator must set up 
message functionality for these new employees. The administrator sets up accounts for each new 
sales representative and checks to make sure that the Communications Management and the 
Workflow Management component groups are enabled. 

Next, the administrator activates the Messages workflow policies and the Siebel Message send email 
and Siebel Message send email for activity owner workflow processes. 

The administrative assistant for the sales representatives receives a message for a sales 
representative, either by phone or by voice mail. Instead of writing the message out by hand, the 
administrative assistant enters the message in the Messages screen and assigns the message to the 
sales representative. 

The administrative assistant associates the message with an existing account, adds information in 
the Comments field, and attaches a spreadsheet file to the message. The administrative assistant 
then prioritizes the message and send it either as an email or a screen alert.
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By default, a message is marked private, which means that only the administrative assistant and 
sales representative can review the message. The administrative assistant can alternately choose 
not to mark the message private, and then any individual with access to the account, activity, 
contact, opportunity, or service request associated with the message can view it.

Process of Setting Up and Using 
Messages
To set up and use messages, the administrator and the end user typically perform the following 
tasks:

■ “Setting Up Messages” on page 172

■ “Creating a New Message (End User)” on page 173

■ “Setting Up Single and Recurring Alerts (End User)” on page 175

■ “Sorting Messages by Intervals (End User)” on page 176

■ “Sending a Message Using Email (End User)” on page 176

About Using Messages
End users, such as sales representatives and call center agents, can use messages to communicate 
with others who also use Siebel applications. They can create messages, view and sort messages, 
and associate activities and other items with messages. Using messages allows end users to maintain 
a history of the communication associated with a contact, account, opportunity, or information 
request.

Setting Up Messages 
Administrators need to set up workflows for the Messages screen and views before a new employee 
can have email access.

NOTE: Make sure that users have the Message User responsibility so that they can access Messages 
views. For more information about setting responsibilities for users, read about defining 
responsibilities in Security Guide for Siebel eBusiness Applications.

To set up workflows for the Messages screen and views

1 Make sure that the Communications Management and the Workflow Management component 
groups are enabled. 

2 Activate the Messages workflow policies. All Messages workflow policies are in the Siebel 
Messaging policy group. 

3 Activate Siebel Message send email and Siebel Message send email for activity owner workflow 
processes. 
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For detailed information about how to set up workflows, see Siebel Business Process Designer 
Administration Guide.

About Email and Screen Alerts
There are two types of message alerts you can establish to send screen or email and screen alerts. 
You can set up email and screen alerts for messages and individuals to whom you delegate message-
related activities, and perform the following tasks:

■ Set up an alert for an individual to whom you routinely send messages

For instance, you routinely send messages to the same individuals, and you want to set up a 
standard alert method to let them know you have sent a message.

■ Set up an alert for a single message so the recipient receives an alert

For instance, you send a message to an individual for whom you have not set up a message alert, 
but you can also set up an alert for the individual message.

You can opt to receive both email alerts and screen alerts simultaneously.

Email Alerts. A message generates an email alert when the following events occur:

■ A message is created and the Alert Type field has a value of Email or Email and Screen Alert.

■ A message is assigned to you, and you have set up an alert to receive email when messages or 
activities are assigned to you by a contact or employee.

■ An activity is assigned to you, and you have set up an alert to receive email when messages or 
activities are assigned to you.

■ You send an email from your Siebel application.

Screen Alerts. A message generates a screen alert when the following events occur:

■ A message is created and the Alert Type field of the Messages form has a value of Screen Alert 
or Email and Screen Alert.

■ A message is assigned to you, and you have set up an alert to receive a screen alert when 
messages or activities are assigned to you by a contact or employee.

■ An activity is assigned to you, and you have set up an alert to receive a screen alert when 
messages or activities are assigned to you.

Creating a New Message (End User)
You can create a message using the Message screen.

To create a new message

1 Navigate to the Messages screen > Messaging List view.
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2 In the Messaging list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Account Shows the Account name associated with the message, if applicable.

Alert Type Allows you to select a value from the drop-down list to indicate the alert 
type for the message. Default values include None, Email, Screen Alert, 
and Email and Screen Alert.

Assigned To A required field that displays the name of the individual to whom you are 
assigning the message. You can select a default value in the Default 
Assigned To field in the User Preferences screen. See Fundamentals for 
more information on user preferences.

Comment An optional text field that displays additional information.

Date/Time An editable field that displays the month, day, year and the hour, minute, 
second that the message was created. 

Email Address Automatically populates the email address when you select the contact 
record.

First Name Automatically populates the first name of the contact when you select the 
contact record.

Home Phone # Automatically populates the home telephone number when you select the 
contact record.

Last Name A required field that displays the last name of the contact you selected as 
the message recipient. After a record is saved, you can drill down on the 
hyperlink to navigate to Contacts and More Info.

Message A text field that displays the content of the message.

Mobile Phone # Automatically populates the mobile telephone number when you select the 
contact record. 

Opportunity Displays the Opportunity associated with the message, if applicable. Click 
the select button to choose an opportunity.

Priority Allows you to select a value from the drop-down list to indicate the 
message priority. Default values include 1-ASAP, 2-High, 3-Medium, and 4-
Low.

Private A check box which, when selected, allows only the message creator and 
recipient to view the message. When the check box is cleared, team 
members associated with the opportunity, account, contact, and service 
request can view the message.

SR # The Service Request number associated with the message, if applicable.
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Setting Up Single and Recurring Alerts 
(End User)
You can set up an ongoing alert type for an individual. This individual always receives an alert when 
you assign a message to him.

You also can assign an alert to a single message to notify the recipient of a message. You can do this 
either while you are creating the message or after you have saved the message.

To set up a recurring message alert

1 Navigate to the Messages screen > Messaging List > Message Alert Setup view.

2 In the Message Alerts Setup list, click New.

3 In the new Message Alert record, click the select button in the Last Name field.

4 In the Pick Contact dialog box, select the name, and then click OK.

5 In the Alert Type drop-down list, select the type of alert.

The default value in the Alert Type field is None. Other values are Email Alert, Screen Alert, and 
Email and Screen Alert.

To send a single message alert

1 Navigate to the Messages screen > Messaging List > Daily Messages view.

2 In the Daily Messages list, click New.

3 In the Message Details form, click the drop down list in the Alert Type field, and then choose the 
type of alert to assign to the message.

Viewing Messages (End User)
You can view messages assigned to you, or created by you, using your Siebel application.

To view messages assigned to you

1 Navigate to the Messages screen > Messaging List view.

Status Allows you to select a value from the drop-down list to indicate the 
message status. Default values include New, Read, Delegated, Return Call, 
and Completed.

Work Phone # Automatically populates the business telephone number when you select 
the contact record.

Field Comments
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2 In the Messaging list, select the message to read.

3 In the Message Details form, review the text in the Message field.

To view messages created by you

1 Navigate to the Messages screen > Messaging List > All Messages view.

2 In the All Messages list, select Columns Displayed from the Menu drop-down list.

3 In the Columns Displayed dialog box, move Created By from the Available Columns list to the 
Selected Columns list, and then click Save.

4 In the All Messages list, click Query, complete the Created By field, and then click Go.

5 In the All Messages list, sort the messages by the Date/Time field.

Sorting Messages by Intervals (End 
User)
Use the appropriate view tab to sort messages into Daily, Weekly, or Monthly lists. You also can use 
queries to achieve the same result. The default query for the Messaging list displays all messages, 
but you can select predefined Daily, Weekly, or Monthly queries to refine your lists.

To sort messages by intervals

1 Navigate to the Messages screen.

A list of messages you received today appears in the Messaging list.

2 Click Query and, in the Messages dialog box that appears, enter the date for which you want to 
find messages, and click Go.

A list of messages for the specified date appears.

3 Click Today to reset the date to the current date.

4 Click the Weekly Messages view tab to view messages you received in the previous seven-day 
interval.

5 Click the Monthly Messages view tab to view messages you received in the last 30 days.

Sending a Message Using Email (End 
User)
You can send email messages to the recipient from within Siebel application. The recipient either can 
be inside or outside your corporate firewall because the Siebel application uses the email address 
associated with the contact information for the recipient. After you create a message and complete 
the necessary fields, you can send the message as an email. For information on standard email 
functionality within Siebel eBusiness Applications, see Fundamentals.
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To send an email message

1 Navigate to the Messages screen.

2 In the Messaging list, select the message to send as an email message.

3 From File menu, select Send Email.

4 In the Send Email dialog box, complete the fields for the email, and then click Send.

In the email form, click To to display the Address Book dialog box.
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This chapter describes the features of Content Center. It includes the following topics:

■ “About Content Center” on page 179

■ “Content Center Job Roles and Terms” on page 180

■ “Business Scenario for Using Content Center” on page 182

■ “Process of Setting Up and Using Content Center” on page 183

■ “Setting Up a Content Staging Environment” on page 184

■ “Configuring Content Objects for Content Center” on page 186

■ “Modifying Business Components for Content Center” on page 186

■ “Creating Integration Objects for Content Center” on page 188

■ “Modifying Integration Objects for Content Center” on page 189

■ “Setting Up Content Center Approval Workflows” on page 189

■ “Setting Up Content Center Publication Workflows” on page 192

■ “About the Content Project Business Service” on page 193

■ “Setting Up Content Types” on page 194

■ “Setting Up Contributors and Approvers” on page 195

■ “Creating Content Projects” on page 195

■ “Contributing and Approving Content (End User)” on page 197

■ “Publishing Content Projects” on page 198

About Content Center
Content Center allows you to create and manage authored content, which includes items such as 
price lists, service solutions, and static Web site content, for Siebel eBusiness Applications.

Content Center features include:

■ Preview and simulation. You can use a content staging environment to preview and test 
content before you publish it to your production environment. The staging environment displays 
content exactly as it will appear to customers, employees, and partners in your production 
environment. The staging environment runs on a separate database from the production 
environment.
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■ Content projects. You can group a set of content items into one content project, so that related 
changes can be made together. For example, you can create a content project to manage all the 
products, catalog categories, price lists, and marketing literature for your company’s summer 
catalog.

■ Approval processes. You can use Siebel Business Process Designer to design approval 
processes that allow team members to review a content item before it is published. Siebel 
Business Process Designer allows you to assign tasks based on a predefined list of content 
contributors and approvers.

■ Publishing. After content is approved, Content Center uses Siebel Business Process Designer to 
publish it to a production environment. The XML-based publication business service can handle 
both complex database content and unstructured content that is stored in the file system. This 
component helps maintain transactional integrity between all the items in a content project.

Content Center Job Roles and Terms
Descriptions of Content Center job roles are in Table 58, and terms are defined in Table 59.

Table 58. Content Center Job Roles

Position Responsibilities

Content 
Administrator

One or more people in your business who are authorized to administer 
content. These people need to understand your business requirements in 
order to know what types of content and content items need to be managed 
and the appropriate contributor and approver workflows. 

Depending on your business requirements, one or more of these people may 
also be responsible for selecting and possibly configuring the appropriate 
business components, content objects, and content types. Alternatively, this 
may be done by an application developer.

Content 
Contributor

A person in your business who is authorized to contribute content items. 
Examples are technical writers, Web designers, and graphic artists.

Content Approver A person in your business who is authorized to approve content posted to 
your company’s Web site. Examples are managers and your company’s 
attorneys.
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Table 59. Content Center Terms

Term Definition

Content The components of the application that are authored, as opposed to application 
code. Siebel applications recognize the following classes of content:

■ Business rules, such as personalization rules and assignment rules

■ Application content, such as product catalog, price lists, and product 
promotions

■ Web content, such as Web templates and static Web pages, typically stored 
as HTML, XML, and image files

■ Documentation, such as product data sheets, forms, and white papers

Content Center provides content production services for three of the classes 
listed above: application content, Web content, and documentation, while 
content asset management only applies to Web content and documentation.

Content Asset An instance of content managed within Content Center and stored in the content 
asset repository. Content assets are typically comprised of unstructured 
markups and can be related to other content assets. For example, an HTML 
content asset can link to other pages or reference images. For more information, 
see Chapter 14, “Content Asset Management.”

Content Item Represents a transaction (add, update, delete) stored and associated with a 
piece of content.

Content Object Specifies the information that will be transferred from the staging environment 
to the production environment when the content is published. Each content 
object is composed of a business object and an integration object.
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Business Scenario for Using Content 
Center
This scenario provides an example of a scenario performed by a content administrator (in this case, 
the business manager), a Web site designer, an application developer, and content contributors and 
approvers. Your company may follow a different process flow according to its business requirements.

The business manager and Web site designer have designed the company’s Internet home page. The 
page includes a section which will display a single targeted Web offer to customers visiting the site. 
The contents of this section will require a managed contribution and approval process to produce 
accurate and timely display of product offers. 

First the application developer makes an Offer business component that is content-enabled and 
defines the Web Offer content type. Then he works with the business manager to develop some 
personalization rules to target the Web offers, tests the home page, and deploys the home page to 
the production environment.

The business manager is concerned that the graphics contained in various Web offers may clash with 
the company logo, so she edits the single approval workflow for the Web Offer content type. She 
creates an additional approval step for the site designer position, and associates the appropriate 
contributor and approver positions to those steps in the approval workflow.

Content Project A group of related content items. Grouping content items into projects makes it 
easier to manage changes that should be published simultaneously. Delete 
because this is defined on the first page.

Content Type A set of business rules you define for handling content, including rules that apply 
to the approval workflow, contributors, approvers, and the application views 
your company uses to edit or preview content. Each content type is based on a 
content object, and is associated with an approval workflow and a group of 
contributors and approvers.

The following are examples of content types authored in Siebel applications that 
can be managed through Content Center:

■ Siebel Sales Catalog: catalog, categories, product, product line, and product 
literature

■ Siebel Pricer: price list, pricing factor, rate list, and volume discount 

■ Siebel Marketing: offers (Web, phone, email, direct mail, newsletter), 
campaign, and marketing development fund

■ Siebel Service: service solution, decision issue, resolution document, and 
SmartScript

The term Content Type is also used to describe the file type (or filename 
extension) of a content asset.

Table 59. Content Center Terms

Term Definition
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Next, she configures the publication workflow, setting the connect string for the server in the 
production environment.

She then sets up the content project, adding the content items that make up tasks required to create 
the Web offer. These will be routed to the Content Inboxes of the content contributors and approvers 
as set up in the approval workflow.

After the content items have been completed and approved, she publishes the project to the 
production environment.

Process of Setting Up and Using Content 
Center
This example process represents the tasks that are carried out in the “Business Scenario for Using 
Content Center” on page 182. Typically Step 1 to Step 6 are carried out once and Step 7 to Step 9 are 
carried out many times.

1 “Setting Up a Content Staging Environment” on page 184

2 “Configuring Content Objects for Content Center” on page 186

3 “Setting Up Content Center Approval Workflows” on page 189

4 “Setting Up Content Center Publication Workflows” on page 192

5 “Setting Up Content Types” on page 194

6 “Setting Up Contributors and Approvers” on page 195

7 “Creating Content Projects” on page 195

8 “Contributing and Approving Content (End User)” on page 197

9 “Publishing Content Projects” on page 198
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Figure 13 illustrates the process and indicates who might typically perform each task. 

Setting Up a Content Staging 
Environment
A content staging environment is similar to a test environment, except that you use it to test content 
rather than application configuration. This allows you to develop and test new content without 
affecting your production applications. 

After content is approved, Content Center uses workflows and the Content Project business service 
to send it to the production environment. For general information about Siebel workflows, see Siebel 
Business Process Designer Administration Guide.

Figure 13. Example Process for Setting Up and Using Content Center
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Required Components for a Content Staging Environment

Content Center requires a separate Siebel eBusiness Applications installation for your content 
staging environment. The physical hardware for this environment should be the appropriate size for 
supporting the number of content center administrators, contributors, and approvers who manage 
your business content. 

For more information about installing Siebel eBusiness Applications, see the Siebel Installation Guide 
for the operating system you are using for the operating system you are using.

Your staging environment should contain the following components:

■ Database

■ Siebel Gateway Name Server

■ Siebel Server

■ File System

■ Web Server and Siebel Web Extension

Maintaining Consistency Between Staging and Production 
Environments
It is important that the staging and production environments are consistent when Content Center is 
implemented. 

The most important element to keep synchronized is the Siebel repository (SRF) file. This file defines 
the structure of the application data, for example, the business components and the integration 
objects.

Keeping the data synchronized is not relevant, with the exception of content and related data. For 
example, if you use Content Center to manage product literature, then Content Center synchronizes 
the content by publishing it from staging to the production environment. In this case, products could 
be related data that also need to be kept synchronized. Although you may have chosen not to 
manage products through Content Center, nevertheless you must have a user key, such as product 
ID, that exists in both the staging and production environments so that the association of a piece of 
literature to a product can be made in the staging area and reproduced in the production 
environment.

The following are some tips to help you maintain consistency between your staging and production 
environments.

■ If your production environment has not yet been installed, the database administrator should 
install two separate database instances (one for staging and one for production) using an 
identical Siebel repository (SRF) file, and initialize both instances with the same seed data. This 
makes sure that the content object definitions in your staging and production environments are 
the same.

For more information, see the Siebel Installation Guide for the operating system you are using.
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■ If your production environment is already active, the database administrator should install the 
staging environment using the same Siebel repository (SRF) file as used for the production 
environment. Make a copy of your database and use the copy to initialize your staging 
environment.

■ Because you perform most or all content administration tasks in your staging environment, you 
should either disable or limit access to the appropriate content administration views in your 
production environment. This helps prevent administrators from accidentally making updates in 
the production environment. 

Configuring Content Objects for Content 
Center
The content object definition specifies the information that is transferred from the staging 
environment to the production environment when the content is published. 

Content objects are based on business objects and integration objects. Siebel Systems provides 
some prebuilt content objects which you can use, or configure to meet your business needs. See 
Appendix B, “Content Center Reference” for details about the prebuilt content object definitions.

You use content objects to create one or several content types. Each content type is based on a 
content object, and is associated with an approval workflow and a group of contributors and 
approvers. For example, from the Product content object, you might create two different content 
types: Software Products and Hardware Products. These two content types may have different 
approval workflows, as well as different contributors and approvers. For more information, see 
“Setting Up Content Types” on page 194.

To set up content objects

1 Use Siebel Tools to identify or define the business object on which you base the content object. 
For more information on configuring business objects, see Configuring Siebel eBusiness 
Applications.

2 Modify the business components to meet the content object requirements. For instructions, see 
“Modifying Business Components for Content Center” on page 186. 

3 Use the Integration Object Builder wizard in Siebel Tools to create an integration object. For 
instructions, see “Creating Integration Objects for Content Center” on page 188. 

4 Modify the integration object to meet the content object requirements. For instructions, see 
“Modifying Integration Objects for Content Center” on page 189.

NOTE: You do not need to create content objects for content assets. These are provided with the 
preconfigured product.

Modifying Business Components for Content Center
NOTE: This step is potentially recursive. Complete this step before using the Integration Object 
Builder wizard in Siebel Tools to create integration objects.
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After you have identified or defined the business object on which your content object is based, check 
its business components for underlying tables that contain foreign keys to other tables. If there are 
business components with foreign keys, you must modify them to assure the integrity of foreign keys 
when these objects are published.

Typically, you need to follow one of the following two processes to modify the business components. 

To modify the business components containing foreign keys 

1 Create a join in the business component from each foreign key column to the row_id of the 
foreign key’s table.

2 Create fields in the business component for all user key columns in the foreign key's table. If any 
of these columns are foreign keys, repeat Step 1.

3 Assign a PickList and fill the PickMap with the foreign key and all related user key fields, including 
any intermediate foreign key fields.

4 Add Pick Map UpdOnlyIfNull columns for each Id type column in the Pick Map.

The UpdOnlyIfNull column should be the same one as its parent on the Pick Map.

Or, if the business component table contains a foreign key to a child (or other descendent) object in 
the business object:

To modify the business components where the business component table contains 
a foreign key to a child object

1 Create a Multi Value Link to the business component on the foreign key table.

2 Include the entire foreign user key as multi-value fields. Expand foreign keys in the user key by 
joining and adding fields to the Multi Value Link business component.

3 Set the Primary Id field of the Multi Value Link to the foreign Key column.

NOTE: To resolve foreign keys to child (descendent) objects in the correct order, you must specify a 
sequence number and XML sequence number for the resulting integration object.
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If two business components joined by a foreign key contain user key columns of the same name, 
create different field names for each user key column. Table 60 shows an example.

NOTE: Later, you disable all other user keys, so you only need to check for duplicate names in your 
business component’s _U1 table user key.

Creating Integration Objects for Content Center
Integration objects are sometimes called EAI objects, because they use Enterprise Application 
Integration (EAI) technology. You use the Integration Object Builder wizard in Siebel Tools to create 
integration objects. For more information, see Integration Platform Technologies: Siebel eBusiness 
Application Integration Volume II.

To create an integration object

1 In Siebel Tools, select File > New Object.

2 From the dialog box, select Integration Object.

The Integration Object Builder wizard guides you through the process of setting up an integration 
object. 

Table 60. Example: How to Handle Identical User Key Column Names

Business Component User Key Columns Comments

Internal Product Sales Tool BU_ID This is a foreign key from the Internal Product 
Sales Tool business component to the 
Organization business component.

NAME This is a _U1 user key column in the Internal 
Product Sales Tool business component. 

This user key column name is identical to the 
one in the Organization business component 
described below.

In the Internal Product Sales Tool, create a 
field called Name to map to this column.

Organization NAME This is a user key column in the Organization 
business component. 

This user key column name is identical to the 
one in the Internal Product Sales Tool 
business component described above.

In the Internal Product Sales Tool, create a 
field called Organization Name to join to this 
column.
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After you create the integration object, you need to modify it to meet the requirements for a content 
object. For instructions, see “Modifying Integration Objects for Content Center” on page 189.

Modifying Integration Objects for Content Center
Use the following guidelines to modify integration objects to meet content object requirements.

To modify integration objects
■ In the integration object, make sure that the link that defines the parent to child relationships 

allows update and delete. If the link does not allow those operations, replace it with a link that 
does.

■ In the integration object user properties, add AdminMode, value Y. This gives the EAI Siebel 
Adapter permissions to do synchronization against a Siebel database.

■ Disable these types of integration components:

❏ All calculated fields.

❏ All integration components created from Multi-Value Link (MVL) components, unless your 
business requires that you transfer those multi-values to your production environment.

❏ If more than one field is mapped to a table column, all fields except one.

❏ For integration components that have file attachments, the field that stores the file 
revision number. For example, in the Admin Sales Tool integration component, disable 
the LitFileRev field.

■ In the integration component, disable:

❏ The NoDelete, NoInsert, and NoUpdate user properties.

❏ All user keys except the one that is based on the _U1 table user key, which is used for 
integration between the two Siebel databases.

❏ All identification (Id) fields. (Make sure that each field is listed in the Pick Map 
UpdOnlyIfNull list of its entry in the pickmap for the user key of its join table.)

Setting Up Content Center Approval 
Workflows
You can use Siebel Business Process Designer to manage workflows for the content item approval 
process. When the Start Project or Request Start Project action is invoked on a content project, the 
approval workflows associated with each content item in the project are instantiated.

Approval workflows allow you to specify the structure for contributing, reviewing, and approving 
content. The designated contributors and approvers are notified by new records in their Content 
Inbox at the appropriate step in the content production and approval process. For more information 
about designating contributors and approvers, see “Setting Up Content Types” on page 194.
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A state model and some workflows are associated with the approval workflow included in the seed 
data that is provided in Siebel applications. You can use these processes in your deployment, modify 
them to meet the needs of your business, or simply use them as a guide for creating your own 
approval workflows.

For more information on creating or modifying workflows, see Siebel Business Process Designer 
Administration Guide.

NOTE: All Content Center workflows should be placed into the Content Center group.

About the Content Item State Model
A state model, called Content Item Status, controls the status changes of a content item.

Table 61 describes each of the content item states.

Table 61. Content Item Status

State Description

Pending Submit Applied by the workflow process. 

If the current task in the workflow is a Contribute task, the workflow process 
applies the Pending Submit state to indicate that an end user is expected to 
perform some action on the content item.

Submitted Applied by an end user.

A content contributor applies the Submitted state to indicate that the 
actions associated with this content item have been completed.

Pending Approval Applied by the workflow process. 

If the current task in the workflow is an Approval task, the workflow process 
applies the Pending Approval state to indicate that an end user is expected 
to review the content item.

Approved Applied by an end user.

A content approver applies the Approved state to indicate that the content 
item has been reviewed and approved.

Rejected Applied by an end user.

A content approver applies the Rejected state to indicate that the content 
item has been reviewed and disapproved.
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About the Content Approval (Single Approver) Workflow
The Content Approval (Single Approver) workflow is a simple workflow that demonstrates a single 
approver approval process. You can use this workflow with or without modification.

The Content Approval (Single Approver) workflow uses these step types to construct the business 
logic for content item approval:

■ Content Task Subprocess. This step type is used to indicate that the Content task assigns the 
content item to an end user to perform some action. Each Content task has a type and a 
sequence number. The task type is either contribution or approval. The task sequence indicates 
the Siebel position to which the content item should be assigned, as specified on the content 
item. This step calls the Content task workflow subprocess. For more details about the 
subprocess, see “About the Content Task Subprocess” on page 191.

■ State Decision Point. This step type performs branching logic in the approval process. The 
branching logic is based on the state that is applied to the content item after a Content task. For 
example, a decision point is used to reassign a content item to the originator after it is rejected.

■ State Update Siebel Operations. The Siebel Operation step type is used to make updates to 
the content item state.

You can use these workflow components to create new approval workflows or to modify the Content 
Approval (Single Approver) workflow for your business. For example, if you require two approval 
tasks, you can add two Content Task Subprocesses and State Decision Points.

About the Content Task Subprocess
The Content Task Subprocess contains the common logic of assigning a content item and waiting for 
a user action. The parent approval process calls this subprocess each time a content item is assigned 
to an end user. Calling this task causes the content item to appear in the Content Inboxes for those 
users associated with the current sequence (TaskSeq).

Canceled Applied by an end user.

A content contributor or approver applies the Canceled state to indicate that 
the content item should no longer be included in the current content project.

Completed Applied by the workflow process. 

This is a terminal state that indicates that the workflow approval process has 
been completed for the content item. A content item must be in the 
Completed state before it can be published.

Table 61. Content Item Status

State Description
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The parent business process must pass in the input arguments shown in Table 62.

The Content Task Subprocess performs these actions:

■ Sets the content item state to either Pending Submit or Pending Approve, depending on the 
TaskType for the current task. 

■ Sets the content item Current Approval Sequence Number field to the TaskSeq value. This makes 
the content item visible to the appropriate end users in the Content Inbox view.

■ Waits for the end user to take action on the content item and make a state change to the item. 
When this occurs, the workflow process resumes and returns control to the parent approval 
process.

About the Auto Complete Workflow
An approval workflow must be run for each content item before a content project can be published. 
(See “To start the project approval workflow” on page 196.) To publish content without routing it 
through approvers and contributors, use the Auto Complete workflow. The Auto Complete workflow 
is a simple workflow, provided with the seed data. It sets the status of a content item to Completed 
immediately so that the project is ready for publication.

Setting Up Content Center Publication 
Workflows
The Content Project business service publishes content projects. It can transfer any data that can be 
accessed through a business component: both complex database content and unstructured content. 
Transactional integrity is maintained between all the items in a content project.

Project publishing is controlled by workflows. This provides flexibility in the publishing process. When 
a business manager invokes either the Publish or Request Publish action for a project, the publication 
workflow associated with the project is instantiated.

Siebel applications provide two predefined publication workflows in the standard product:

Table 62. Parent Approval Process Input Arguments

Input 
Argument Description

Object Id The content item ID from the parent (Content Approval) to the child (Content 
Task) Subprocess.

TaskSeq Passes the sequence number of the current task.

TaskType Indicates that the current task is either type Contribute or type Approve.
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■ Content Publish workflow

This workflow publishes a content project from a staging environment to a production 
environment. There is only one step in this workflow, which calls the Content Project business 
service. You may extend this process to meet your specific business requirements. For example, 
you may create additional workflow steps to integrate with other systems or wait for a specified 
period of time before publishing.

■ Content Publish to Files workflow

This workflow is similar to the Content Publish workflow, except that the content project is 
published to XML files in a specified directory instead of to the production environment.

You can use these processes in your deployment, modify them to meet the needs of your business, 
or simply use them as a guide for creating your own publication workflows.

For more information on creating or modifying workflows, see Siebel Business Process Designer 
Administration Guide.

NOTE: All Content Center workflows should be placed into the Content Center group.

About the Content Project Business 
Service
The Content Project business service is designed to publish a content project from the staging 
environment to the production environment or to publish the content items as XML files. In the 
publication workflow, the Export method of this business service is called, indicating that the content 
items in the project will be exported from the staging environment. The publishing target is set using 
two method arguments, specified as workflow properties:

■ Connect String. A Siebel connect string, specified as: 

siebel://namesrvr:2320/enterprise/objmgr/siebsrvr

For example: siebel://demosrvr:2320/siebel/SCCObjMgr_enu/demosrvr 

The Content Project business service connects to the specified object manager, such as 
SCCObjMgr for Siebel Call Center, as the current user and makes the appropriate updates, 
inserts, and deletes for each content item in the project. These changes are made by the content 
object in the sequence specified in Siebel Tools for each content object.

■ Export Directory. The name of a file system directory into which the XML should be placed. For 
example, C:\temp or \\fileserver\publish\export. The directory must exist and be accessible 
to the object manager. Specifying this property exports the content items within the project as 
a series of Siebel XML files. The files use the naming convention:

■ Upload content object name.xml—for content items that are to be added.

■ Delete content object name.xml—for content items that are to be deleted in the target 
system.

NOTE: Detailed information about the other methods in this business service are given in 
Appendix B, “Content Center Reference.”
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Setting Up Content Types
Content types define the business rules for managing a class of content through the creation and 
approval process. 

Each content item is assigned a content type. The content type determines the following for the 
content item:

■ The approval workflows

■ Which views are used to preview or edit the content

A set of predefined content types are provided. You can also create new content types according to 
your business process, as described in the following procedure.

NOTE: Do not confuse content types with content asset types. For information about content asset 
types, see “About the Content Asset Types View” on page 207.

To set up content types

1 Navigate to the Administration - Content Center screen > Content Types view.

2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name Unique name of the content type.

Content Object The object chosen from this MVG specifies the information that is 
transferred during publishing.

For more information, see “Configuring Content Objects for Content Center” 
on page 186.

Approval 
Workflow

Defines the content contribution, review, and approval process for this 
content type. For more information, see “Setting Up Content Center Approval 
Workflows” on page 189.

Content Type 
Views

A list of the views used to administer or preview content of this type. These 
views determine the end-user navigation from the Content Inbox. 
Examples are the destination views for the Item Reference hyperlink, in 
Step 3 in the “To contribute (create or edit) a content item” procedure on 
page 197 and the Action hyperlink in Step 4 in the “To contribute (create or 
edit) a content item” procedure on page 197.

Picklist Determines the drop-down list used to select content of this type.

Pick Applet Determines the pick applet used to select content of this type.
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Setting Up Contributors and Approvers
After you set up approval workflows for content objects, you must specify contributors and approvers 
for the content. 

When you create a content type, you assign default contributors and approvers to each sequence 
number. If necessary, these defaults can be overridden (Content Item detail view) when the content 
item is created.

To set up a contributor or approver

1 Navigate to the Administration - Content Center screen > Content Types view.

2 Select the content type for which you would like to create a list of contributors and approvers.

3 Click the Contributors and Approvers view tab.

4 In the Contributors and Approvers list, create a new record.

5 In the Position field, select a position from the Pick Position dialog box.

6 In the Seq field, specify a sequence number for the selected position.

You can specify multiple positions for the same sequence number. Doing so places the content 
item into multiple Content Inboxes for this task; however, only one individual is able to complete 
the task.

7 In the Comment field, add a default comment for each position. 

Comments are visible to users when they receive the content item in their Content Inbox.

Creating Content Projects
You can use a Content Project to manage the process of creating, editing, and deleting application 
content. The Content Project provides a virtual folder through which a set of related content item 
changes can be managed. You use the Content Projects view to create projects, start the project 
approval workflows, and review content project status. 

To create a content project

1 Navigate to the Administration - Content Center screen > Content Projects view.

2 In the Content Projects list, create a new record, specifying a name and description.

3 In the More Info form fill in the Plan Publication Date field—the date you plan to publish this 
project. 

This date does not automatically publish the project.

4 In the Publication Workflow field, select the publication workflow that you want to use for this 
project.

5 Click the Content Items view tab.
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6 In the Content Items list, create a new record and complete the necessary fields.

For each content item, you must specify a descriptive name, a content type, a description of the 
work to be performed, and a status (Add, Update, or Delete). If the item has a status of Update 
or Delete, you can also specify the item reference, which allows you to select the specific piece 
of content that should be changed. 

NOTE: You can change any contributors or approvers for a content item by editing the 
Contributors and Approvers list.

To start the project approval workflow

1 Navigate to the Administration - Content Center screen > Content Projects view.

2 From the Content Projects list, select the appropriate content project.

3 In the More Info form, do one of the following:

■ Click Start Project. This changes the state of the project from Draft to In Process and 
instantiates the approval workflows synchronously. This means that users must wait for all 
workflow processes to begin before regaining control of the user interface. For large projects, 
this could take several minutes.

■ Select Request Start Project from the Menu button drop-down list. This changes the state of 
the project from Draft to In Process and instantiates the approval workflows asynchronously 
on a separate server component, which returns control to users more quickly. This is the 
recommended method to use for projects that contain thirty or more items. This method 
requires that the Content Project Start server component is online. (See Siebel System 
Administration Guide for information about starting server components.)

NOTE: If you add more content items to the project after it is in the In Process state, invoke the 
Start Project or Request Start Project action again to start the approval workflows for the new 
content items.

To review status of content project and content items

1 Navigate to the Administration - Content Center screen > Content Projects view.

2 From the Content Projects list, select the appropriate content project.

The status of the project is given in the More Info form. The table below explains the Project 
Status values.

Project 
Status Description

Draft The project has been created and the approval workflow has not been started.

In Process The approval workflow has been started.

Published The project has been published.
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3 Click the Content Items view tab.

You can review the status of each content item, and check or change its assignment. By clicking 
the Item Reference for a content item, you can preview the current state of the content. See 
Table 61 on page 190 for possible status values.

Contributing and Approving Content 
(End User)
The Content Inbox is the screen that Content Contributors and Approvers use to interact with the 
approval workflow. In the My Content Items view users see any content item currently assigned to 
their position by the approval workflow, and are able to drill down on hyperlinks to the appropriate 
views to contribute, edit, preview, and approve content.

To contribute (create or edit) a content item

1 Navigate to the Content Inbox screen.

2 From the Show drop-down list, select My Content Items.

The Content Items list contains all of the content items currently assigned to you by the approval 
workflow.

Items that require contribution can be identified by the status Pending Submit.

3 Drill down on an item and do any of the following:

■ Click the Contributors and Approvers view tab to see the users assigned to the contribution 
and approval process.

■ Click the History view tab to review actions taken on the item to date.

■ Drill down on Item Reference hyperlink to preview the content item.

4 Drill down on the Action hyperlink and use the associated administration view to create or edit 
content. 

This link dynamically takes you to the Add/Edit view associated with the content type. If the 
action is Delete, this link is not active. Instead, completion of a deletion task indicates approval 
to delete the referenced item.

For more information about editing content assets, see Chapter 14, “Content Asset Management.”

5 Return to the Content Inbox using the back button.

6 If the content item is an Add action, update the Item Reference field on the content item to 
reference the content you just created. Clicking the Item Reference pop-up displays a pick list 
from which you can select the content record that you just created.

7 Click on the Item Reference link to view the item and verify that it is complete and accurate. 

Return to the Content Inbox using the back button.

8 Add comments as needed to the content item, and change the status of the item as appropriate. 
For example, change the status from Pending Submit to Submitted.
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To approve content 

1 View all content items in the Content Inbox and select an item to work on.

Items that require approval can be identified by the status Pending Approval.

2 Drill down on an item and do any of the following:

■ Click the Contributors and Approvers view tab to see the positions assigned to the 
contribution and approval process.

■ Click the History view tab to review actions taken on the item to date.

■ Drill down on Item Reference hyperlink to preview the content item.

3 Make any comments to the content item, and change the status of the item as appropriate. 

For example, change the status from Pending Approval to Approved or Rejected.

Publishing Content Projects
After the content for a project has been added and approved, use the Content Center publication 
workflow to publish to your production environment.

Make sure that:

■ The correct publication workflow for the project has been specified. (See Step 4 in the “To create 
a content project” procedure on page 195.)

■ The status of the project is In Process and the status of each item in the project is Completed.

To publish a content project

1 Navigate to the Administration - Content Center screen > Content Projects view.

2 From the Content Projects list, select the appropriate content project.

3 Do one of the following:

■ Click Publish. This changes the state of the project to Published and instantiates the 
publication workflow synchronously. This means that users must wait for all workflow 
processes to begin before regaining control of the user interface. For large projects, this 
could take several minutes.

■ Select Request Publish from the Menu button drop-down list. This instantiates the publication 
workflow asynchronously on a separate server component, which returns control to users 
more quickly. This is the recommended method to use for projects that contain thirty or more 
items. This method requires that the Content Project Publish server component is online. 
(See Siebel System Administration Guide for information about starting server components.) 

4 If you selected Request Publish in Step 3:

a Navigate to the Administration - Server Management screen > Components view.
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b In the Components list, select the Content Project Publish record, and check the State field in 
the Tasks list.

    If publication fails, the task's state is “Exit with Error.”

NOTE: A content project cannot be republished, except by creating a new content project, for 
example by copying the published project.
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14 Content Asset Management
This chapter describes setting up, creating, and managing content assets. It includes the following 
topics:

■ “About Content Assets” on page 201

■ “Business Scenario for Content Asset Management” on page 201

■ “Process of Managing Content Assets” on page 202

■ “Defining Content Sets to Contain Content Assets” on page 202

■ “Adding Content Assets to a Content Set” on page 203

■ “Setting the Home Page for a Content Set” on page 204

■ “Viewing and Editing Content Asset Properties” on page 204

■ “Checking Content Assets In and Out” on page 206

■ “Editing HTML Content” on page 207

■ “About the Content Asset Types View” on page 207

■ “About Configuring Content Asset Management” on page 207

You can use the content asset repository for storing and managing unstructured content such as 
assets and sets of assets. Content Asset Management establishes check-out and check-in procedures 
to serialize access to content, and prevent changes from being lost by users trying to update content 
simultaneously. Content can be rolled back to earlier versions if the changes made were 
unsatisfactory.

About Content Assets
You can use the content asset repository for storing and managing unstructured content as assets 
and sets of assets. Content assets are typically unstructured data such as Web pages, images, 
Microsoft Office documents, and text files.

Content Asset Management establishes check-out and check-in procedures to serialize access to 
content, and prevent changes from being lost by users trying to update content simultaneously. 
Content can be rolled back to earlier versions if the changes made were unsatisfactory.

Business Scenario for Content Asset 
Management
Content Asset Management is typically used in conjunction with other screens in the Siebel eBusiness 
Application, for example Microsite Management, Group News, and Info Center. For a sample scenario 
where Content Asset Management is used, see “Scenario for Microsite Management” on page 213.
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Process of Managing Content Assets
This example process represents the typical tasks in creating and managing content assets: 

■ “Defining Content Sets to Contain Content Assets” on page 202

■ “Adding Content Assets to a Content Set” on page 203

■ “Setting the Home Page for a Content Set” on page 204

■ “Viewing and Editing Content Asset Properties” on page 204

■ “Checking Content Assets In and Out” on page 206

■ “Editing HTML Content” on page 207

Defining Content Sets to Contain 
Content Assets
Content sets are collections of content assets. Every content asset must belong to a content set and 
should have a unique name within that set. In addition to content assets, content sets can contain 
other content sets.

After a content set is defined, you can:

■ Add content assets to the set

■ Add other content sets to it

■ Preview the home page asset of the set

■ Review the history of the set

■ Establish the locks on content assets in the set

To create a content set

1 Navigate to the Administration - Content Center screen > Content Sets view.

2 In the Content Set list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name A unique name for the content set record.

Title A short descriptive title for the content set.

Description Text describing the content set.

Home Page This field cannot be filled in until there are content assets in the content set. 
See “Setting the Home Page for a Content Set” on page 204.

Parent The name of an existing content set that contains this new content set.
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Adding Content Assets to a Content Set
Content assets can only be created as child records of a content set. 

To add content assets to a content set

1 Navigate to the Administration - Content Center screen > Content Sets view.

2 In the Content Set list, select the content set to which you want to add an asset.

3 Click Add Content.

4 Do either of the following actions: 

■ Click the File Options button and specify a local file.

■ Type in a URL or network path.

5 If you typed in a URL or network path, click the URL Options button and set the URL and network 
file options in the dialog box.

Some fields are described in the following table.

6 (Optional) Click Advanced to set the Advanced Options for the asset.

Some fields are described in the following table.

Field Description

Follow Links Select to have the pages that are linked-to from the specified Web page are 
copied, and, in turn, links to those pages copied as well.

Max Depth Indicates the level to which links are copied. For example, if Max Depth = 
1, pages that are linked-to from the specified page are copied, but not 
pages that they link to.

Restrict to 
Subdirectory

Select so that, if links are followed, only links to pages within the same 
directory as the specified page are copied.

Retrieve 
Graphics

Select to have graphics on the specified Web page copied along with the 
text.

URL options

Network file options

Field Comments

Content Type This is the Content Asset Type. Leave this field set to Auto-Detect (the 
default) to have the application determine the asset type, or select a 
type from the dialog box to set a specific type. 

Lock Select this to lock the content asset, so that others cannot edit it.

Comments Enter comments for this version of the content asset.
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Setting the Home Page for a Content Set
After adding content assets to the content set, you can specify one of these assets to be the home 
page. The home-page asset displays when the content set is previewed. Because links on the preview 
applet are active, if the content set contains a portal-style HTML page, this is the best page to choose 
as the home-page asset.

To set the home page for a content set

1 Navigate to the Administration - Content Center screen > Content Sets view.

2 In the Content Set list, select the content set and complete the Home Page field.

3 Click the Preview view tab to see the home page.

Viewing and Editing Content Asset 
Properties
The following procedure describes the fields in the Content Assets view and use of the Preview, Links, 
Referenced by, Versions, and Access Groups views.

To review and edit the properties of a content asset record

1 Navigate to the Administration - Content Center screen > Content Sets view, and select the 
content set that contains the content asset.

2 Click the Assets view tab. 

3 Drill down on the content asset name.

NOTE: You can also navigate to a particular content asset record by querying in the Content 
Assets view or by clicking on the asset-name hyperlinks on the Content Explorer.

4 Click Edit.

5 Complete or edit the fields in the Asset Detail form as required.

Some fields are described in the following table.

Field Comments

Name A name for the content asset record. The name should be unique 
within in the content set.

Title A descriptive title for the content asset.

Activation

Expiry

Sets activation and expiration dates for the content asset. 

There is no logic associated with this date in the Content Center 
module, but when this content is used by other modules, such as 
Microsite Management, these dates are used to determine whether 
the content is displayed.
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6 Click the Preview view tab to preview the content asset.

If the content asset is an HTML file or an image, the asset displays directly in the Preview applet. 
For other types of content assets, the title of the asset appears as a hyperlink, from which you 
can open the asset in the application that you choose.

7 Click the Links view tab to review the links within a content asset.

These may be links to graphics, to HTML pages, or to email addresses. They may be external 
links or they may be links to other assets within the content asset repository (internal). 

If the link is internal, Content Center checks whether the link is valid.

8 Click the Referenced by view tab to review the other content assets that contain links to this 
content asset.

9 Click the Versions view tab to view information about the versions of the asset stored in the 
content asset repository.

10 Click the Access Groups view tab to view who has read and write access to the content asset:

■ Read access. If the Private field is set, only those groups listed have read access. If the 
Private field is not set, there are no restrictions on who has read access to the asset. 

■ Write access. If any access groups have the Allow to Edit field checked, only they have write 
access. If the Allow to Edit field is blank for all, there are no write restrictions on the asset. 

For information about creating access groups, see Security Guide for Siebel eBusiness 
Applications.

Content (Asset) Type This field is set when the content asset is created and cannot be 
modified.

Language Code Sets the language code for the content asset.

Private If a content asset is private, only users on the associated access 
groups can view the asset. If this box is not selected, the asset is 
public and any user can view the asset, regardless of any access 
groups specified for the asset.

To... Select It and Click...

Roll back to a previous version Restore

Download a version to file Save to File

Preview a version Preview

Field Comments
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Checking Content Assets In and Out
Checking out a content asset downloads the asset file and locks the asset so that others cannot make 
changes to it.

Checking in a content asset uploads a new version of the content asset and unlocks the asset.

To check out a content asset

1 Navigate to the Administration - Content Center screen > Content Sets view, and select the 
content-asset record to check out. 

2 Click Check Out.

Your user ID appears in the Locked by field.

To check in a content asset

1 Navigate to the Administration - Content Center screen > Content Sets view, and select the 
content-asset record to check in. 

2 Click Check In.

3 In the Check In Content dialog box:

a Click the browse button and select a file or URL that contains the content asset you are checking 
in.

b Click Unlock to allow others to modify this content asset after check in.

c Add comments describing how this version differs from the last.

About the Content Asset Commands on the Menu Button
Most users only need to use the Check Out and Check In buttons. However, other content asset 
commands are available on the menu button of the Asset Detail form in the Content Assets view:

■ Lock. Locks the content asset by the current user.

■ Unlock. Unlocks the content asset. For example, you can use this command if you check out an 
asset, but then decide that you do not want to make any changes to it.

■ Save to File. Downloads the content asset to a file, but does not lock the asset.

■ Replace. Creates a new version of the content asset. The Replace command is available only 
when the asset is locked.

■ Delete. Deletes the content asset record and is equivalent to the Delete Record command. This 
soft delete keeps past versions of the asset in the content asset repository. Deleted assets can 
be accessed through the Contents Sets History view.
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Editing HTML Content
You can edit content assets of type HTML directly within the Siebel application using the integrated 
HTML editor.

NOTE: To edit large or complex HTML files, you may prefer to use a third-party HTML or text editing 
application.

To edit HTML content using the integrated HTML editor

1 Navigate to the Administration - Content Center screen > Content Sets view, and select an HTML 
content-asset record to edit. 

2 Click Edit HTML.

The content asset is automatically checked out, and the integrated HTML editor opens.

3 Click on the edit area, and make changes as required. 

For general information about the integrated HTML editor, see Fundamentals.

4 Click Save.

The content asset is automatically checked in.

About the Content Asset Types View
The Content Asset Types view contains the file types, and associated DTR (document type rules) files, 
extensions, and MIME types, that are recognized by Content Asset Management. 

Although you can add new content asset types if necessary, it is unlikely that you will need to. Many 
file types are provided with the preconfigured Siebel application. 

CAUTION: It is recommended that you do not edit or delete records in this view and that you do not 
delete any DTR files from your Siebel installation. 

About Configuring Content Asset 
Management
Content assets can be added to the Content Center repository by specifying a filename on a shared 
directory or by specifying a URL. In both cases, files that are linked-to from the specified file or URL 
can be imported by selecting to Follow Links. 

When shared network files are imported to the Content Center repository in this way, the permissions 
for the directory access are those of the server process account. Because the server process account 
typically has more extensive privileges than the user, there is a security risk of users importing 
content from directories to which they do not have access. 

To prevent this, importing from shared directories has been disabled except for those directories that 
are listed in the contentbase.ini file. It is recommended that you limit this list of allowed directories 
to a set that you can easily monitor and manage. 
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On the Windows platform, the contentbase.ini file can be found in SIEBEL_ROOT\siebsrvr\bin, and, 
on the UNIX platform, the file can be found in SIEBEL_ROOT/siebsrvr/lib. The default file looks like 
this:

[Global Settings]

ImportFileEnabled=1

ImportFilePath=SiebelContentShare

■ ImportFileEnabled. If ImportFileEnabled=1, file import is allowed from directories identified in 
the ImportFilePath parameter. If ImportFileEnabled=0 import is allowed only from URLs (where 
the URL’s server enforces security) and import from shared directories and followed links is 
disabled.

■ ImportFilePath. The value of this parameter determines the directories from which the user can 
import files. This value is a string of subpath names, delimited by semicolons. The directory 
specified by the user for file import must contain one of the subpaths listed. 

For example, if the ImportFilePath parameter is set to 
SiebelContentShare;EngShare;\\orion;sales\content, users can import files from these 
directories:

\\myPC\SiebelContentShare

\\ServerA\EngShare\GroupWeb

\\orion\users\NewsBulletins

However, you cannot import files from these directories:

\\myPC\SiebelContentShareAll

\\ServerA\Mysales\content

NOTE: The network path is interpreted relative to the server machine, not the client machine. 
Therefore, local paths like C:\ refer to directories on the server machine. And, for example, if the 
server machine is running UNIX, then the UNC path syntax \\orion\users\ is not valid; instead, it 
might be /net/orion/users/.

If you use the default (out-of-the-box) contentbase.ini file, the administrator or individual users need 
to set up one or more shared directories named SiebelContentShare to contain those files (and those 
files that are referenced by the specified files) that they want to import as content assets.
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This chapter describes how to use Microsite Management to create Web pages and manage Web page 
content.

It includes the following topics:

■ “About Microsite Management” on page 209

■ “Scenario for Microsite Management” on page 213

■ “Process of Microsite Management” on page 214

■ “Viewing and Editing Page Information” on page 214

■ “Using the Page Designer and Its Tools” on page 217

■ “Managing Groups of Page Items” on page 231

■ “Previewing a Page” on page 232

■ “Publishing a Page” on page 233

■ “Deleting a Page” on page 233

■ “Creating and Applying Templates” on page 234

■ “About Creating Search Indexes” on page 235

■ “About Configuring Microsite Management” on page 236

About Microsite Management
Many companies have multiple content managers whose responsibilities include adding and 
modifying data on Web pages. The layout and maintenance of data and hypertext links must be done 
as efficiently as possible, without requiring IT resources. The Microsite Management module is 
designed to simplify creation and maintenance of Web pages. Everything from site organization and 
creation of new pages through to editing text and graphics is carried out from the Microsite 
Management screen.

Unstructured and Structured Content Definitions
Both structured and unstructured page items can be included on pages created within the microsite 
management module:

■ Unstructured Content. Such as HTML files, graphics, and links to documents. Unstructured 
content can be authored in a variety of environments, including Microsoft FrontPage, PowerPoint, 
and Word and the integrated HTML editor within the Siebel applications. Placement of structured 
content on pages is carried out using Page Designer in the Microsite Manager screen. 
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■ Structured Content. Such as product catalogs and lists of opportunities. In general, structured 
content is authored in the Siebel application environment. Placement of structured content on 
pages is carried out in Siebel Tools, by editing applets on views. 

Key Features
Key features of Microsite Management are:

■ Page Administrator Explorer Tree. Gives a hierarchically organized view of all the pages in 
your Web site.

■ Page Designer. A graphical drag-and-drop page layout tool that allows page designers and 
content managers to quickly create different types of content anywhere on a page.

■ Preview. Allows you to preview pages according to content status (for example, approved or 
draft) and according to release and expiration dates.

■ Templates. Grouped content items that can be placed on multiple pages and updated for all 
pages at once. 

■ Access Control. Is set at both the page and page item level so you can control which access 
groups can see and edit content.

■ Transparent Integration with Content Center. Allows setting up and routing the tasks of 
creating, editing, and approving with Siebel Content Center. When a link to a file is added to a 
page, that file is added to the Siebel content repository as a content asset, and can be version-
controlled with Content Center. For more information, see Chapter 13, “Content Center.”

■ One-Click Publishing. Publishes directly from the Microsite Management screen, creating a 
content project and automatically approving the page content. 

■ Usage Collection. Ability to monitor users’ visits to Microsite pages. For more information, see 
Chapter 16, “Usage Collection.”
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The Page Designer and the Finished Page
Figure 14 and Figure 16 show the relationship between a finished page and Microsite Management’s 
Page Designer layout tool that was used to create the page. The content on the page is indicated by 
page item icons in Page Designer. The areas of the page, such as the navigation bar, are indicated 
schematically in Page Designer.

Figure 14. Microsite Page
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If you prefer, you can revert to the older style of navigation bar (shown in Figure 15). See “Changing 
the Navigation Bar Style in Microsite Pages” on page 239.

About Microsite Management and Standard Activity Mode
Microsite pages can be used in both standard and high interactivity mode. But, high interactivity 
mode is required to create and administer microsite pages. 

Figure 15. Older Style Navigation Bar with Blue Border

Figure 16. The Page Layout Schematic of the Microsite Page in Page Designer
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Scenario for Microsite Management
These scenarios provide an example of microsite management tasks performed by the microsite 
owner and a content author for the microsite. Your company may follow a different process according 
to its business requirements.

Standard Microsite Management Scenario

Introduction
The microsite owner for the analyst relations group of a large company has been asked to develop 
a new microsite on the company intranet. The old Analyst Relations microsite contains out-of-date 
information and is hard to maintain. Using Microsite Management will make setting up the site and 
maintaining content much easier. The new site will include links to analysts’ reports, lists of key 
contacts, information on the company’s policies, and reports on competitors. 

The Microsite Owner
In cooperation with the company intranet administrator, the microsite owner reviews the existing 
structure of the company’s Web site. Together they determine that the new Analyst Relations 
microsite should be available from the Sales root-level page. After the company intranet 
administrator has created the Sales root-level page, the microsite owner creates the new Analyst 
Relations page link on the Sales screen.

The microsite owner creates links to other intranet and Internet pages and to views within the Siebel 
application. He adds some text and graphics along with content created in applications such as 
Microsoft Word, Microsoft Excel, HMTL, and Adobe Acrobat.

The microsite owner associates the access groups to each of the page items. He makes sure that 
only certain groups of end users will see the items displayed on the page and also that the right 
contributors are able to edit the items’ content. 

Date ranges are also associated with each of the page items, so that only current content appears 
on the page. Because a number of page items require the same access groups and dates, the 
microsite owner uses the group properties feature, which allows him to set the same properties for 
all selected items together. 

At various stages in the page design, the microsite owner previews the page. Because some of the 
content is time sensitive, he previews the page as it will appear on several dates in the future. 

In order that users can use the Siebel Search Center to find the page, the microsite owner creates 
search indexes on the content.

When the content is complete, the microsite owner publishes the new page directly from the 
Microsite Management screen and deletes the old page.

All the pages available from the Sales page contain the same set of links and images in the navigation 
bar. This set of page items makes up a template. When the new Analyst Relations page is complete, 
the microsite owner edits the template to include a link to the new page. Now, all the Sales pages 
contain a link to the new page.
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Microsite Scenario with Content Center
Depending upon the complexity of the analyst relations microsite and the approvers (and authors) 
involved, the company may choose to use Content Center to streamline the production of this 
microsite, as outlined here:

■ The corporate marketing director in charge of analyst relations creates a content project that her 
team uses to create the analyst relations microsite; in the project she specifies the tasks involved 
in producing the microsite.

■ The Content Center workflow routes these tasks to the designated microsite owner who views 
them in his Content Inbox.

■ The microsite owner drills down on the content task and creates the new analyst relations 
microsite.

■ After content has been drafted, the microsite owner submits them for approval to the designated 
reviewers in the project’s approval workflow.

■ When the microsite and its contents have been approved, the microsite is published from the 
Content Center’s staging environment to the production environment.

Process of Microsite Management
This is an example of a simple process flow for Microsite Management. Your company may follow a 
different process according to its business requirements.

1 “Viewing and Editing Page Information” on page 214 (to review the existing structure of the Web 
site)

2 “Creating a Root-Level Page” on page 216 (to create a root-level page, if necessary)

3 “Using the Create New Page Tool” on page 218 (to create a new page linked to the root-level page)

4 “Using the Page Designer and Its Tools” on page 217 (to edit the page, and add links and other 
content)

5 “Managing Groups of Page Items” on page 231 (to set access groups and activation dates for 
content)

6 “Previewing a Page” on page 232 (to preview the new page)

7 “Publishing a Page” on page 233 (to publish the new page)

8 “Deleting a Page” on page 233 (to delete the old page)

9 “Creating and Applying Templates” on page 234 (to edit templates used on multiple pages)

Viewing and Editing Page Information
The Page Administration view includes:

■ The Page Administration Explorer tree

■ A list of pages, displaying those pages at the level selected on the tree
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■ A More Info form displaying fields associated with the page selected in the page list

■ A templates list displaying the templates associated with a page 

The root-level pages are the top level of the page hierarchy. All other pages are children of a root-
level page or another page. 

This structure helps you organize the pages. However, there are no requirements for, or restrictions 
on, hypertext links between child and parent pages. 

The position of a page in the hierarchy is determined by the Parent Page field and the Order field.

Figure 17 shows the Page Administration Explorer tree and the Page list of the Page Administration 
view.

This task is a step in the Process of Microsite Management on page 214.

To find a page in the tree and modify its properties

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration > More Info view.

2 Use the Page Administration Explorer tree to find and select the page whose properties you want 
to modify.

3 In the More Info form, edit fields as required.

Some fields are described in the following table.

Figure 17. Page Administration Explorer Tree and Page List Applets

Field Comments

Page Title A title for the page, up to 90 characters long. This title is used to identify 
the record but does not appear on the microsite.

Parent Page The parent page determines where the page is nested in the page hierarchy.
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Creating a Root-Level Page
The root-level pages are those pages that appear at the top of the Page Administration Explorer tree. 
Typically only a few employees should have the responsibilities required to access the Portal Screen 
Administration view where root-level pages can be created.

In general, you have a screen tab for each of the root-level pages. You can use Siebel Tools to create 
a screen tab for a new root-level page. For information, see the page tabs topic in Configuring Siebel 
eBusiness Applications.

Best practice is to standardize on a limited number of these pages in order to keep the top root-level 
of the explorer tree uncluttered and to restrict the number of screen tabs in the application. 

This task is a step in the Process of Microsite Management on page 214.

To create a root-level page

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Portal Screen 
Administration view.

Access Groups Use this field to restrict read and read-write (select Editor field) access to 
this page.

If this field is blank, there are no restrictions on who can view and edit this 
page, provided they have the view responsibilities for the template view 
and the Page Designer view.

If no editor is specified, all the access groups can edit this page.

If you do not have access to this page, the Page Title hyperlink is 
unavailable in the Page list.

View Determines the Siebel view that the page is based on. For information about 
creating new views, see Configuring Siebel eBusiness Applications.

Order Determines the sequence of the page in its level of the Page Administration 
Explorer tree.

Description Typically used to describe the page.

Comments Typically used to enter comments about changes made to the page.

Item Approvers If one or more access groups are specified for this field, only users who 
belong can set the status of page items to approved.

Field Comments
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2 In the Portal Screen list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Using the Page Designer and Its Tools
The Page Designer view is the center of the Microsite Management module. The Page Designer applet 
contains a graphical drag-and-drop page layout and tools for adding unstructured content, such as 
text, graphics, links to Siebel views, and links to other pages, to the designated sections of your 
page.

In the Page Designer UI, applets that contain structured content (such as an Activities, 
Opportunities, or Calendar applet on an employee’s page) are indicated by the words “Not Editable.” 

These sections describe the tools that you use to place page items (content and links):

■ “Using the Create New Page Tool” on page 218

■ “Using the Insert Template Tool” on page 220

■ “Using the Create Menu Tool” on page 221

■ “Using the Link Existing Page Tool” on page 223

■ “Using the Link App View Tool” on page 224

■ “Using the Add Web Link Tool” on page 225

■ “Using the Create Content Tool” on page 226

Field Comments

Screen Name for the root-level page.

Default View 
Name

Determines the Siebel view that the page is based on. For information about 
creating new views, see Configuring Siebel eBusiness Applications.

The view that determines the Web template used by this page.

Access Groups Use this field to restrict read and read-write (select Editor field) access to 
this page.

If this field is blank there are no restrictions on who can view and edit this 
page, provided they have the view responsibilities for the template view 
and the Page Designer view.

If no editor is specified, all the access groups can edit this page.

Order Determines the sequence of the page at the top level of the Page 
Administration Explorer tree.

Inactive If the root-level page is inactive:

■ The root-level page and its child pages do not appear in the Page 
Administration view

■ The page is not displayed in the application
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■ “Using the Insert Content Tool” on page 227

■ “Using the Insert File and the Insert Image Tools” on page 228

These sections describe tasks you can do in the Page Designer:

■ “Editing Page Item Properties” on page 229

■ “Deleting Page Items” on page 230

■ “Saving and Canceling Changes to the Page Layout” on page 231

Using the Create New Page Tool
There are two ways to create a new page:

■ Using the Create New Page button in the Page Administration view

■ Using the Create New Page tool in the Page Designer (see following procedure)

When using the Create New Page tool, you choose a parent page where you want to create link to 
the new child page. This places the page appropriately in the page hierarchy and makes sure that 
you do not create an orphan page (a page that is not accessible from any other page). 

When you create a new page, it is likely that you want the page to look much like the parent page. 
For example, you might want to keep the same copyright information in the footer and the same list 
of links in the navigation bar. When you create the new page, you can select what content you want 
to copy from the parent to the child page. 

Similarly, you can have the child page inherit the same access controls as the parent.

NOTE: If you want to create new root-level page, see “Creating a Root-Level Page” on page 216.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To create a new page

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

2 In the Page list, click the Page Title hyperlink for the page that will contain a link to the new page.

3 From the Page Designer toolbar, drag the Create New Page tool to the position on the layout 
where you want the new page link to appear. 
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4 Complete the fields in the Create New Page dialog box. 

Some fields are described in the following table.

Field Comments

Name This is the text that appears as the navigation link to the new page.

Release Date Specifies the date when the link becomes active.

The link appears when the date is between the release date and the 
expiration date and the status is Approved.

Expiration Date Specifies the date when the link is no longer active.

Access Group Use this field to restrict read and read-write (select Editor field) access to 
the navigation link.

If this field is blank there are no restrictions on who can view and edit this 
navigation link.

If no editor is specified, all the access groups can edit this navigation link.

Status The status of the link: Approved, Designed, Draft, Final, Printed, Shipped, 
or Submitted.

The Approved and Draft status fields determine what content is displayed 
in the page preview. See “Previewing a Page” on page 232.

If access groups are specified for Item Approvers field (Page Administration 
> More Info view), then only users who belong can set the status to 
Approved.

Title A title for the page, up to 90 characters long. This title is used to identify 
the record but does not appear on the microsite.

Order Determines the sequence of the page in its level of the Page Administration 
Explorer tree.

■ Page Title

■ Navigation 
Bar

■ Body

■ Quick Picks

■ Page Footer

A check mark in these boxes indicates the content in the sections of the 
current page which are copied into the new page. Sections must exist on 
the selected page if they are to be copied to the new page. 

■ All Other 
Sections

If you have used Siebel Tools to configure views with new applet types that 
contain unstructured content, then checking All Other Sections copies 
content from those sections to the new page.
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NOTE: By default, the Parent Page and View are the same as those in the linked-from page 
chosen in Step 2 on page 218. These fields as well as the Description field can be edited in the 
Page Administration view; see “Viewing and Editing Page Information” on page 214.

Using the Insert Template Tool
Use the template tool to place templates (predefined sets of page items) on the page. 

For information about templates, see “Creating and Applying Templates” on page 234.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To insert a template

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Insert Template tool to the position on the layout where 
you want the template to appear. 

3 Complete the fields in the Insert Template dialog box. 

Some fields are described in the following table.

Inherit Access 
Controls

If selected, Access Group values for the new page and any page items 
copied are inherited from the current (parent) page. 

If not selected, there are no access restrictions on who can view and edit 
the new page.

Open New Page If selected, the new page opens in the Page Designer UI when the link is 
saved. If not selected, the Page Designer UI continues to display the current 
(parent) page after the link is saved.

Field Comments

Name This is the name of the template.

Release Date Specifies the date when the template becomes active.

The template contents appear when the date is between the release date 
and the expiration date and the status is Approved.

Field Comments
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Using the Create Menu Tool
Menus are containers for links. Menus format links in three ways, as shown in Figure 18: 

■ Hierarchical menus

■ Dropdown menus

■ List menus

Most typically, you want to add menus to the navigation bar of your page, but menus can be added 
to any page section. 

This task is part of Step 4 in the Process of Microsite Management on page 214.

Expiration Date Specifies the date when the template is no longer active.

Status The status of the link: Approved, Designed, Draft, Final, Printed, Shipped, 
or Submitted.

The Approved and Draft status fields determine what content is displayed 
in the page preview. See “Previewing a Page” on page 232.

Figure 18. Types of Menu

Field Comments

List (Menu Size = 10)DropdownHierarchical
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To create a menu of links

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Create Menu tool to the position on the layout where 
you want the menu to appear. 

3 Complete the fields in the Create Menu dialog box. 

Some fields are described in the following table.

4 Create links for the menu using the link tools described in the following topics.

5 If you are creating a hierarchical menu, indent links to create the hierarchy:

■ To indent one link, right-click the link and choose Increase Indent or Decrease Indent.

Field Comments

Name This is the name of the menu.

Menu Type See Figure 18 on page 221.

Release Date Specifies the date when the menu becomes active.

The menu appears when the date is between the release date and the 
expiration date and the status is Approved.

Expiration Date Specifies the date when the menu is no longer active.

Menu Size Only applies to menus of type Menu List. Enter the number of menu items 
to show in the list at one time. 

Status The status of the link: Approved, Designed, Draft, Final, Printed, Shipped, 
or Submitted.

The Approved and Draft status fields determine what content is displayed 
in the page preview. See “Previewing a Page” on page 232.
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■ To indent multiple links, see “Managing Groups of Page Items” on page 231.

This is the indentation used to produce the hierarchical menu shown in Figure 18 on page 221.

For information about configuring hierarchical menus, see “Configuring Menu Colors and Icons for 
Hierarchical Menus” on page 238.

Using the Link Existing Page Tool
Using the Link Existing Page tool, you can create navigation links to other pages within the Microsite 
Management system. 

If you want to create navigation links to external pages, see “Using the Add Web Link Tool” on 
page 225.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To create a navigation link between Microsite Management pages

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Link Existing Page tool to the position on the layout 
where you want the new page navigation link to appear. 
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3 Complete the fields in the Link Existing Page dialog box.

Some fields are described in the following table.

Using the Link App View Tool
Using the Link App View tool, you can create links from a page to a particular view in the Siebel 
application. 

For example, you might want to create a link from your sales representatives’ home page to the My 
Expense Reports view on the Expense Reports screen. 

This task is part of Step 4 in the Process of Microsite Management on page 214.

To create a link from a page to a view in the Siebel application

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Link App View tool to the position on the layout where 
you want the application link to appear. 

Field Comments

Name This is the text that appears as the navigation link to the new page.

View-Page Select the target page for the navigation link. You can select any page in 
the application from the Pick Parent Page dialog box.

Release Date Specifies the date when the navigation link becomes active. 

The link appears when the date is between the release date and the 
expiration date and the status is Approved.

Expiration Date Specifies the date when the navigation link is no longer active.

Access Group Use this field to restrict read and read-write (select Editor field) access to 
this page.

If this field is blank there are no restrictions on who can view and edit this 
page, provided they have the view responsibilities for the template view 
and the Page Designer view.

If no editor is specified, all the access groups can edit this page item.

Status The status of the link, for example Approved, Designed, Draft, Final, 
Printed, Shipped, or Submitted.

The Approved and Draft status fields determine what content is displayed 
in the page preview. See “Previewing a Page” on page 232.
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3 Complete the fields in the Link Application View dialog box.

Some of the fields are described in the following table.

Using the Add Web Link Tool
Using the Add Web Link tool, you can link to external pages, identified by a URL. For example, on 
your microsite, you can provide links to your partners’ Web sites.

There are a number of ways that the external page can be displayed from the Microsite Management 
page:

■ Frame. Within the frame of the current page.

■ In-Line. Directly in the applet on the current page. Displaying pages in-line works best with 
simple pages. Large or complex pages, such as those that use JavaScript, can slow down the 
system and cause unexpected results. Be sure to test in-line pages.

■ New Window. Launching a new browser window when the link is clicked; this allows the user 
to switch between the two pages.

■ Window. Displaying the external page in the current browser window.

This task is part of Step 4 in the Process of Microsite Management on page 214.

Field Comments

Name This is the text that appears as the navigation link to the new page.

View From the Pick View dialog box, choose the application view that you want 
to display when the link is clicked.

Release Date Specifies the date when the navigation link becomes active. 

The link appears when the date is between the release date and the 
expiration date and the status is Approved.

Expiration Date Specifies the date the link is no longer active.

Access Group Use this field to restrict read and read-write (select Editor field) access to 
this page item.

If this field is blank there are no restrictions on who can view and edit this 
page item.

If no editor is specified, all the access groups can edit this page item.

Status The status of the link: Approved, Designed, Draft, Final, Printed, Shipped, 
or Submitted.

The Approved and Draft status fields determine what content is displayed 
in the page preview. See “Previewing a Page” on page 232.
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To create a link from a page to an external page

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Add Web Link tool to the position on the layout where 
you want the external link to appear. 

3 Complete the fields in the Add Web Link dialog box.

Some fields are described in the following table.

Using the Create Content Tool
Using the Create Content tool, you can create rich-text content directly to the page through the 
integrated HTML editor.

Field Comments

Name This is the text that appears as the navigation link to the new page.

URL Enter the exact URL of the destination for the link.

Symbolic URL Instead of entering a URL, choose a symbolic URL. (Symbolic URLs can be 
set up in the Administration - Integration screen.)

For example, enter the symbolic URL of an Analytics report.

HTML Display Choose how the external page is displayed: Frame, In-Line, current 
Window, or New Window.

Release Date Specifies the date when the link becomes active.

The link appears when the date is between the release date and the 
expiration date and the status is Approved.

Expiration Date Specifies the date when the link is no longer active.

Access Group Use this field to restrict read and read-write (select Editor field) access to 
this page item.

If this field is blank, there are no restrictions on who can view and edit this 
page item.

If no editor is specified, all the access groups can edit this page item.

Status The status of the link: Approved, Designed, Draft, Final, Printed, Shipped, 
or Submitted.

The Approved and Draft status fields determine what content is displayed 
in the page preview. See “Previewing a Page” on page 232.
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Typically, you would use the Create Content Tool for creating short or simple content, such as 
captions or labels. 

NOTE: To create complex HTML or large amounts of text, you may prefer to use a third-party HTML 
or text editing application to create an HTML file, and then place the file’s contents on the page using 
the Insert File tool. See “Using the Insert File and the Insert Image Tools” on page 228.

The formatted text entered and saved in the editor is saved as a content asset in the Content Asset 
Management’s repository. For more information about the content assets, see Chapter 14, “Content 
Asset Management.”

For general information about the integrated HTML editor, see Fundamentals.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To add HTML directly to a page

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Create Content tool to the position on the layout where 
you want the new content type to appear. 

3 In the Create Content dialog box, click Edit HTML.

4 In the editor, type and format text, and add links and graphics.

5 Click Save to save the HTML to the content asset repository and close the HTML Editor.

6 Complete the fields in the Create Content dialog box.

Some of the fields are described in the table in Step 3 in the “To create a link from a page to an 
external page” procedure on page 226.

Using the Insert Content Tool
Using the Insert Content tool, you can add to your page content assets that stored in the content 
asset repository. For more information about the content assets, see Chapter 14, “Content Asset 
Management.”

For example, there may be a content asset that is a GIF image of your corporate logo, which you 
want to use to brand your page. Or, a content asset may be an Adobe Acrobat file, describing 
departmental policies, that you want to link to your page.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To add content assets to a page

1 Open the page you want to edit in the Page Designer:
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a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Insert Content tool to the position on the layout where 
you want to add the content asset. 

3 In the Insert Content dialog box, click the select button in the Asset Name field and use the Pick 
Content dialog box to select the content asset you want to add.

The Pick Content dialog box filters the content assets:

■ The default filter shows assets in content set for the current page.

■ Click the ellipsis button to select a different content set.

■ Click Find All to list content assets in all content sets.

4 Complete the fields in the Insert Content dialog box.

Some of the fields are described in the table in Step 3 in the “To create a link from a page to an 
external page” procedure on page 226.

Using the Insert File and the Insert Image Tools
Using these tools, you can insert files (such as HTML files, MS Word files, and Adobe Acrobat) and 
graphics files from your local file system, from shared networks and from the Web.

The difference between using the Insert File tool and the Insert Image tool is that the HTML display 
for the Insert Image tool is always set to In-Line.

When these files are added to your page, they are also stored as content assets in the content asset 
repository. For more information about the content assets, see Chapter 14, “Content Asset 
Management.”

This task is part of Step 4 in the Process of Microsite Management on page 214.

To add a file or graphic to a page

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 From the Page Designer toolbar, drag the Insert File (or the Insert Image) tool to a position on 
the layout. 

The Insert File (or the Insert Graphic) dialog box appears.

3 Do either of the following actions:

■ Click the ellipsis button and specify a local file.

■ Type in a URL or network path.
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4 If you typed in a URL or network path, click the URL button and set the URL and network file 
options in the dialog box. 

Some fields are described in the following table.

For more information about adding content assets and setting up how files are imported, see 
“Adding Content Assets to a Content Set” on page 203 and “About Configuring Content Asset 
Management” on page 207

5 In the Insert File or Insert Image dialog box, complete the fields.

Some of the fields are described in the table in Step 3 in the “To create a link from a page to an 
external page” procedure on page 226.

6 (Optional) Click the Advanced button and set the options. 

Some of the fields are described in the following table.

Editing Page Item Properties
The preceding topics explained how to use the Page Designer UI to create new page items, for 
example, links to pages and graphics.

Field Comments

Retrieve 
Graphics

Select to have graphics on the specified Web page copied along with the 
text.

Follow Links Select to have the pages that are linked-to from the specified Web page are 
copied, and, in turn, links to those pages copied as well.

Restrict to 
Subdirectory

Select so that, if links are followed, only links to pages within the same 
directory as the specified page are copied.

Max Depth Indicates the level to which links are copied. For example, if Max Depth = 
1, pages that are linked-to from the specified page are copied, but not 
pages that they link to.

Field Comments

Title Enter a descriptive title for the content set. If no title is provided, the Name of 
the page item is used for the content asset title. (The Name for the content 
asset record is the file name, not the page item name.)

Content 
Type

This is the Content Asset Type. Leave this field set to Auto-Detect (the default) 
to have the application determine the asset type, or select a type from the 
dialog box to set a specific type. 

Lock Select this to lock the content asset, so that others cannot edit it.

Comments Enter comments for this version of the content asset.
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To edit page item properties, you select a page item on the Page Designer UI and modify its 
properties in the Page Item Properties form. The fields and buttons that are available in the Page 
Item Properties view depend upon the type of page item selected. 

Items of type HTML, Web Content, Graphics, and File are content assets and are stored in the content 
asset repository. Details about these content assets can be viewed in the Asset Detail view, and these 
content assets can also be checked out for editing. 

Some items can be edited using the integrated HTML Editor, launched from the Edit HTML button on 
the Page Item Properties form.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To edit a page item

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 In the Page Designer UI, select the page item whose properties you want to edit.

3 In the Page Item Properties form, edit the fields. 

NOTE: Those fields and buttons that are not appropriate for the selected page item are 
unavailable.

4 Use the Check-Out, Check-In, Lock, and Unlock buttons to open and edit content. (For more 
information about checking out content assets and locking content assets, see Chapter 13, 
“Content Center.”)

5 Click Asset Details to open the Content Assets view and to:

a See information about the selected item.

b Roll-back to a previous version of the content asset.

c Review the content asset for broken links.

For more information about the Content Assets view, see Chapter 13, “Content Center.”

6 To edit HTML content, click Edit HTML. 

For more information about the integrated HTML editor, see Fundamentals.

Deleting Page Items
Deleting items from a page is done through the Web Designer UI. 

NOTE: Any item that has been saved in the content asset repository remains there even after the 
associated page item is deleted.

This task is part of Step 4 in the Process of Microsite Management on page 214.
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To delete a page item

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 In the Page Designer UI, select the page item and type CTRL + DEL.

Saving and Canceling Changes to the Page Layout
In the Page Designer view, page records are saved in the same way that other records are saved in 
the application. 

Use the Cancel button to return page items to their last-saved positions, removing any just-created 
page items and adding back any just-deleted page items. 

However, changes made to the page item properties (such as Status) are not lost when Cancel is 
clicked.

For example, if you move a link from the navigation bar to quick picks, change its status from Draft 
to Approved, and then click Cancel, the link returns to the navigation bar but its status remains 
Approved.

This task is part of Step 4 in the Process of Microsite Management on page 214.

To save a page record
■ In the Page Designer view do one of the following:

■ Click Save.

■ Click Preview.

■ Select another page.

■ Navigate to a different view.

To cancel changes to the page layout
■ After making changes to the page layout in the Page Designer UI, click Cancel.

The layout reverts to how it was when the record was last saved.

Managing Groups of Page Items
To make page management easier, page items can be grouped and common properties assigned to 
them. For example, use grouping to:

■ Set the indent level for a group of menu items.

■ Set a release date for a group of page items.
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This task is a step in the Process of Microsite Management on page 214.

To group page items

1 Open the page you want to edit in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 Select all of the page items you want to manage as a group.

Hold the SHIFT key while clicking on the page items to select multiple items.

3 Click Group Properties.

4 Complete the fields as required in the Page Items Group dialog box.

Only those properties that are common to all types of page items appear in this dialog box: 
Increase Indent, Decrease Indent, Release Date, Expiration Date, Access Group, and Status.

Previewing a Page
After laying out the content on the Page Designer UI, you can preview the page. 

Whether or not content appears on the displayed page depends upon the page item’s release date, 
expiration date, and status.

The preview feature in Page Designer allows you to:

■ Set a date for the preview (content inactive on that date does not appear).

■ Choose to display only approved content, only draft content, both approved and draft content, 
or all content regardless of status.

This task is a step in the Process of Microsite Management on page 214.

To preview a page

1 Open the page you want to preview in the Page Designer:

a Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

b In the Page list, click the Page Title hyperlink.

2 Click Preview.

3 In the Preview Details dialog box, specify the Preview Status and Preview Date and click OK.

The rendered page appears in preview mode. 

4 Return to the Page Designer UI by clicking the back button.
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Publishing a Page
You can publish the page directly from the Page Administration view of the Microsite Management 
screen. 

CAUTION: Before you can publish from the Microsite Management screen you need to set up the 
workflows for content projects. See Chapter 13, “Content Center.”

The Publish button on the Page Administration view: 

■ Creates a content project for each page.

■ Names the content project: project-prefix page-name date time, for example MyProject Publish 
Folders 01/22/2004 11:03:48. 

■ Sets the Publication Workflow for the content project to Content Publish.

■ For each page item, creates a content item of type Microsite Folder. 

■ Invokes the Approval Workflow for the Microsite Folder content type. (This workflow should be 
set to Auto Complete. It changes the status of each item to Completed so that it can be 
published.)

■ Invokes the Content Publish workflow for the content project. (This workflow calls the Export 
method of the Content Project business service, which exports the project from the staging 
environment to the production environment or the export directory). 

To publish a page

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration > More Info view.

2 In the Page list, select the page or pages you want to publish.

You can only publish pages for which you have write access.

3 Click Publish.

4 Complete the fields in the Publish Project Details dialog box.

Deleting a Page
Pages can be deleted from the Page Administration view. Root-level pages can also be deleted from 
the Portal Screen Administration view.

When a page is deleted:

■ The status of any navigation links to that page (on other pages within Microsite Management) is 
changed to Draft. This prevents broken links from appearing on displayed pages.

Field Comments

Project Prefix Enter text for the project name.

Publish Child Pages Select to have the child pages of the selected page published.
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■ The Access Group field for any navigation links to the page are reset (no access restrictions).

■ The target page (View-Page) for the link is set to NULL. When you edit a link where the View-
Page is NULL, you must specify a valid View-Page before you can save changes to the link.

To delete a page

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Page 
Administration view.

The hierarchical structure of screens and subordinate pages appears on the left, and the page 
list and detail form appear on the right. Click the + sign to expand a folder.

2 Select the page you want to delete, and delete the record.

Creating and Applying Templates
Templates are sets of page items that are created in the Template Designer and can be placed on 
page sections. Templates are best used for content that appears on multiple pages and that may 
require updating. 

The advantages of templates are:

■ Templates can be applied to many pages at once.

■ When a template is updated, the updated content appears on all pages referencing that template.

Figure 19 shows the Template Administration view. Templates can be organized into folders.

The templates you create can be added to: 

■ Individual pages in the Page Designer, see “Using the Insert Template Tool” on page 220

■ Many pages at once, see “To add a templates to multiple pages” on page 235

Figure 19. Template Administration View
Applications Administration Guide Version 7.7, Rev. B234 ■



Microsite Management ■ About Creating Search Indexes
To create a template

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Template 
Administration view.

2 In the Template list, create a new record and complete the necessary fields.

Some fields are described in the following table.

3 Drill down on the template name.

4 Use the Template Designer to add and edit items on the template.

The tools on the Template Designer work the same way as the tools on the Page Designer. (See 
“Using the Page Designer and Its Tools” on page 217.)

To add a templates to multiple pages

1 Navigate to the Microsite Management (or Administration - Microsite) screen > Template 
Administration > Pages view.

2 In the Templates list, select the template you want to add.

3 In the Pages list, click Add to Pages.

4 Complete the fields and follow the directions given in the Add Template to Pages dialog box.

About Creating Search Indexes
Content assets on microsite pages can be integrated with the Siebel Search Center. This allows users 
to find pages by searching for keywords. For information about creating indexes for Search Center, 
see Siebel Search Administration Guide.

Field Comments

Folder Flag Leave blank.

(Select the folder flag to create a folder to contain template items.)

Order Determines the sequence of the template at the top level of the Portal 
Template Explorer tree.

Active If the template is active it can be added to pages (using the Insert Template 
tool). 
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About Configuring Microsite 
Management
There are a number of aspects of Microsite Page Management that you can configure:

■ “Configuring Microsite Caching” on page 236

■ “Adding New View Layouts to the mmlayout.txt File” on page 237

■ “Configuring Menu Colors and Icons for Hierarchical Menus” on page 238

■ “Changing the Navigation Bar Style in Microsite Pages” on page 239

Configuring Microsite Caching
By default, page caching of microsite pages and content is turned on. However, you can configure 
the caching behavior of Microsite pages by editing the application’s CFG file.

The advantage of caching is that microsite pages are rendered faster. 

The disadvantage of page caching is that if you make a change to a page using Page Designer, the 
updated page is not displayed until the caching time-out has expired.

TIP: If you have both a staging and a production environment, consider using page caching in the 
production environment, but not in the staging environment.

To configure caching for Microsite pages
■ Create or edit the [ERM Page Rendering] section in your application’s CFG file.

See Table 63 for information about the page caching parameters. 

NOTE: Set time outs according to how often pages and contents are updated. If pages are 
updated frequently, set time outs low.

Table 63. Microsite Caching Parameters

Parameter Name Comments Default

EnablePageCache Page cache caches Microsite page contents including Microsite 
applets and Group News applets on a per AOM (Application 
Object Manager) basis.

TRUE

EnableDefaultView
PageCache

The default-view page cache caches the default Microsite page 
for a view on a per AOM basis. 

TRUE

EnablePageAccess
Cache

The page-access cache caches whether a page is private or 
public on a per AOM basis.

TRUE

EnableUserPageAc
cessCache

The user-page access cache caches whether a given user has 
access to a particular page on a per user session basis. 

TRUE
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Adding New View Layouts to the mmlayout.txt File
The mmlayout.txt file is used by Page Designer to schematically represent the layout of the applets 
in the view (Figure 16 on page 212). The file contains layout information for all Siebel preconfigured 
views designed to contain unstructured content. 

On a Windows platform, the mmlayout.txt file can be found in SIEBEL_ROOT\siebsrvr\bin. On a 
UNIX platform, the file can be found in SIEBEL_ROOT/siebsrvr/lib.

If you have created new views in your Siebel application, and you want to use these views for 
microsite pages, you need to edit the mmlayout.txt file to schematically describe how the applets in 
your views are laid out.

NOTE: For information about creating views, see Configuring Siebel eBusiness Applications. 

EnableUserPageIte
mAccessCache

The user-page item access cache caches whether a given user 
has access to a particular page item on a per user session basis.

TRUE

PageCacheSize Size of page cache in pages. 

CAUTION: If PageCacheSize > 256, make sure to monitor the 
memory usage of the AOM.

Setting to 0 disables page caching.

256

PageCacheTimeout Lifetime, in minutes, of page cache entries. Setting to 0 disables 
page caching.

5

DefaultViewPageCa
cheTimeout

Lifetime, in minutes, for default-view page cache entries. 
Setting to 0 disables default-view page caching.

10

PageAccessCacheTi
meout

Lifetime, in minutes, for page-access cache entries. Setting to 0 
disables page-access caching.

10

Table 63. Microsite Caching Parameters

Parameter Name Comments Default
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Configuring Menu Colors and Icons for Hierarchical 
Menus
You can edit the display colors, line spacing, and icons for hierarchical menu items. (See Figure 20.)

To set colors and line spacing for hierarchical menu items

1 Open the ePortalNavBarAppletDeptPage_LeftNav.swt file. 

Figure 20. Menu Levels

Root Level (Not Selected)

Child Level (Not Selected)

Root Level (Selected)

Collapse 
Icon

Expand 
Icon

Leaf Icon (Blank)
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2 Edit the file as follows:

For example, changing HEIGHT: 20 to LINE-HEIGHT: 0.8em tightens the line spacing to a fixed 
size.

For more information about editing Siebel Web templates, see Configuring Siebel eBusiness 
Applications. 

To change the expand, collapse, and leaf icons for hierarchical menu items
■ Edit the graphics in the following files found in the images directory:

■ mm_expand.gif

■ mm_collapse.gif

■ mm_blank.gif

For more information about images, see Configuring Siebel eBusiness Applications. 

Changing the Navigation Bar Style in Microsite Pages
Change the underlying Web template if you prefer the older blue-bordered navigation bar, you can 
revert to it by changing the underlying Web template used for the Microsite views.

To revert to the old blue-bordered navigation bar
■ For each Microsite view:

To Change the Style for 
This Type of Menu Item... Edit This Line...

In This Section of the 
File...

Root-level, not selected TD.mmRootLevel TD { COLOR: 

Navy; HEIGHT: 20;}

Root Level Menu Items

Child-level, not selected TD.mmChildLevel TD { 

COLOR: Navy; HEIGHT: 20;}

Child Level Menu Items

Selected (any level) TD.mmSelected TD { COLOR: 

NAVY; HEIGHT: 20;}

Menu Item currently selected 

Change the . . . From the Newer . . To the Older . . .

Applet Web template ePortalNavBarAppletDeptPage_L
eftNav.swt

ePortalNavBarAppletDeptPage.swt

View Web Template dccView_15_60_25.swt dccView_25_50_25.swt
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This chapter describes setting up and tracking hits on microsite pages, group news articles, and 
views and downloading of content assets.

It includes the following topics:

■ “About Usage Collection” on page 241

■ “Scenario for Usage Collection” on page 242

■ “Process of Usage Collection” on page 242

■ “Setting Up the Run-time Event to Collect Usage Data for Views” on page 242

■ “Setting System Preferences for Usage Collection” on page 243

■ “Reviewing the Usage-Tracking Log Files” on page 244

About Usage Collection
The usage collection feature creates log files that record when users: 

■ View microsite pages

■ View group news articles

■ Download content assets

■ (Optionally) View views in the Siebel application

Figure 21 shows an example of a usage-tracking log file.

Usage is monitored across the database, with a separate log file for each AOM (Application Object 
Manager) process. New log files can be created each hour, day, week, or month. Log files can be 
saved in CSV, XML, or W3C format. 

Figure 21. Sample Log File — CSV Format Displayed in a Spreadsheet Application
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These log files provide structured raw data for import into reporting tools: such tools can vary from 
a simple spreadsheet program to a complex data warehouse application like Siebel Analytics. 

Scenario for Usage Collection
This scenario provides an example of a process performed by the administrator. Your company may 
follow a different process according to its business requirements. 

Introduction
An organization has recently installed Siebel applications and management wants to measure user 
adoption. They want to collect information about which employees are using the system and which 
views and microsite pages are accessed most often.

The Administrator
The administrator enables usage collection. He chooses to have the usage-tracking log files output 
in the XML format and to have new log files created each day.

Each morning the administrator reviews the log files from the previous day, imports them into a 
customized reporting tool, and distributes the resulting reports to others in the implementation 
team.

Process of Usage Collection
This example process represents the tasks that are carried out in the “Scenario for Usage Collection” 
on page 242. 

1 “Setting Up the Run-time Event to Collect Usage Data for Views” on page 242

2 “Setting System Preferences for Usage Collection” on page 243

3 “Reviewing the Usage-Tracking Log Files” on page 244

Setting Up the Run-time Event to Collect 
Usage Data for Views
If You . . . Then . . .

Want to track hits to views in the Siebel 
application

You need to create a run-time event to monitor view 
activation. See the following procedure.

Do not want to track hits to views (but do 
want to track hits to microsite pages, 
group news articles, and content assets)

Continue to “Setting System Preferences for Usage 
Collection” on page 243.
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This task is a step in Process of Usage Collection on page 242.

For information about how to create run-time events, see Siebel Personalization Administration 
Guide.

To create a run-time event to collect usage data for views

1 Create an action set.

2 Create an action, setting these fields as follows:

3 Associate an event with the action set, setting these fields as follows:

Setting System Preferences for Usage 
Collection
The system preferences for enabling and configuring usage collection are described in Table 64.

Field Name Value

Action Type BusService

Business Service Name Usage Tracking Service

Business Service Method EventType=Runtime Event

Field Name Value

Object Type Application

Event ViewActivated

Action Set Name Name of the action set created in Step 1

Table 64. System Preferences for Usage Collection

System 
Preference Default Description

UsageTracking 
Enabled

FALSE Set to TRUE to turn on Usage Collection.

UsageTracking 
Log Time Period

Hourly Specify how often a new log file is created. 

Allowed values: Hourly, Daily, Weekly, and Monthly.

CAUTION: Set this according to the usage levels you expect. 
Monthly may create excessively large log files for a high-usage 
application.
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This task is a step in Process of Usage Collection on page 242.

To enable and configure system preferences for Usage Collection
■ Refer to Table 64 and to “Setting System Preferences” on page 50.

Reviewing the Usage-Tracking Log Files
Usage-tracking log files are written to the directory that you specify in the system preferences. The 
log files are named:

SiebelUsageTracking_HOST_PID_YYYY-MM-DD_HH.FF 

Where: 

■ HOST = Server host name

■ PID = Process ID of the AOM

■ YYYY-MM-DD-HH = Formatted date and time

■ FF = File format (XML, W3C, or CSV)

UsageTracking 
LogFile Dir

N/A Specify the directory path for the log files. Make sure that the 
Siebel Server has read and write access to the directory.

Example: \\fileserver\directory

UsageTracking 
LogFile Encoding

ASCII Specify encoding for the log file. This is usually set to ASCII.

Some other allowed values are UNICODE, ARABIC, GREEK, and 
HEBREW.

UsageTracking 
LogFile Format

XML Specify the log file format. 

Allowed values: CSV, XML, and W3C

UsageTracking 
Sess Cache Size

100 Specify the number of session IDs cached. Session IDs (that 
map to login IDs and IP addresses) are cached so that this data 
does not have to be looked up for each user action. 

Allowed values: 10 to 1000

Table 64. System Preferences for Usage Collection

System 
Preference Default Description
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For example, SiebelUsageTracking_sshost_2624_2004-03-15_16.XML is the log file begun at 4 P.M. 
on March 15, 2004.

NOTE: Log files are not created for periods when there is no activity. For example, if UsageTracking 
Log Time Period = Hourly but there are no users from 1:15 A.M. to 4:55 A.M., log files are not created 
for the 2 A.M. or 3 A.M. hours.

This task is a step in Process of Usage Collection on page 242.

To review usage-tracking log files

1 Open or import the log files in your reporting tool of choice.

2 Purge log files when necessary.

Table 65. Data Written to Usage-Tracking Log Files

Data Column Comments

User User’s login ID

IP IP address of the session

Session ID Unique ID for the session

Type Four possible values:

■ MM Page — Indicates viewing of a microsite page

■ GN Article — Indicates viewing of a group News Article

■ CB Asset — Indicates downloading of a content asset

■ ViewActivated — Indicates viewing a view in the Siebel application

Row ID Data row ID of the microsite page, group news article, or content asset

Name The name of the microsite page, group news article, content asset, or view

Event Start Date Time The time the user clicked on the item

Event End Date Time The time of the user’s next event

Status Indicates success
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This chapter contains information about activities. It includes the following topics:

■ “About Activities” on page 247

■ “Creating Activities (End User)” on page 249

■ “Working with Others’ Activities (End User)” on page 252

■ “Delegating an Activity (End User)” on page 253

■ “Viewing Activities Associated with Another Record Type (End User)” on page 253

■ “About Configuring Owner and Employee Fields for Activities” on page 254

About Activities
Siebel applications use activities to organize, track, and resolve a variety of tasks, from finding and 
pursuing opportunities to closing service requests. If a task requires multiple steps that one or more 
people may carry out, activities greatly simplify the job. Activities can help:

■ Define and assign the task

■ Provide information to complete the task

■ Track the progress of the task

■ Track costs and bill for the task

These are the major advantages of breaking down a task into one or more activities:

■ The ownership of the problem can remain at the management level, when required.

■ The employee looking at assigned activities can identify only the required information.

■ Reporting is simplified.

■ Activities can be assigned to more than one person.

Activities are used to represent tasks in many situations such as scheduling and recording meetings, 
appointments, and interactions with customers and prospects. If one task leads to follow-up tasks, 
it is possible to associate follow-up activity records with a parent activity record.

Activities can be viewed in several different locations, including the following: 

■ My To Do List in the Activities screen. This list shows all the user’s activities, regardless of 
status. Access this list by navigating to the Activities screen and choosing My To Do List from the 
Show drop-down list. 

■ My To Do’s in the Calendar screen. This list displays a subset of the data displayed in the My 
To Do List in the Activities screen, activities that have not been completed. For general 
information about using the Calendar screen, see Fundamentals.
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Assignment Methods
Activities are assigned to employees. Activity assignment can take place in a number of ways:

■ Manual assignment

■ Automatic assignment to the creator of the activity (by predefaulting the Owner field to the 
activity’s creator)

■ Automatic assignment using Assignment Manager (see Siebel Assignment Manager 
Administration Guide).

Business Objects Associated with Activities
Siebel activity objects may be associated with other Siebel business objects. Some common 
associations are listed in Table 66. In most cases, this association is with a set of activities defined 
by an activity plan and individual (or stand-alone) activities. In a few cases, an object is associated 
either with an activity template or with stand-alone activities (not both).

Table 66. Association of Activity Object with Other Siebel Objects

Screen Name Business Object
Stand-Alone 
Activities

Activities from 
Templates

Accounts Account Yes Yes

Agreements Service Agreement Yes Yes

Assets Asset Management Yes No

Campaigns Campaign Yes No

Contacts Contact Yes Yes

Messages Messaging Yes No

Opportunities Opportunity Yes Yes

Orders (Order Line Items 
view)

Order Entry Yes Yes

Preventive Maintenance FS PM Plan Item No Yes

Programs Program (DBM) No Yes

Projects Project Yes Yes

Quality Product Defect Yes No

Repairs FS Repair Yes Yes

References Reference Yes No

Service Service Request Yes Yes
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Creating Activities (End User)
Using activities, you can assess the investment in time and resources to maintain and grow account 
relationships. Sales managers also have a record of the activities of their sales representatives as 
they manage account relationships. Sales teams can use activities to avoid duplicating efforts across 
the team, and to share information about pending and completed activities. 

NOTE: Activities that are assigned specific dates and times appear on both the Activities and the 
Calendar screens. For more information, see Fundamentals.

To create an activity

1 Navigate to the Activities screen > Activity List view.
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2 In the Activities list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Account The account associated with the activity.

Activity # A default, application-generated number.

Alarm The Alarm check box sets the activity reminder. A reminder dialog 
box appears when the activity is due. You can either set an alarm 
for an individual activity, or you can set a default alarm for all your 
activities. For more information, see Fundamentals.

Attachments Indicates whether there are attachments associated with this 
activity. This field does not appear by default in the Service 
Activities view, but can be displayed through the use of the 
Columns Displayed command.

Audience A list of values established by your company that allows you to 
specify which audiences can view the activity. Examples of values 
are employees, partners, and customers.

Billable A check box which when selected, indicates the activity is a 
revenue-generating event.

Category A list of values established by your company that allows you to 
specify a category for the activity. 

Service related activities are often created by one individual (such 
as a call center agent) and completed by another (such as a service 
repair representative). Consequently, when a service related 
category value is selected (such as Diagnostic, Field Engineer 
Activity, Preventative Maintenance or Other), the owner of the 
activity is deleted so that the activity is unassigned. The user can 
then reassign the activity by adding a new value to the owner field. 
If the customer is using Siebel Assignment Manager, the activity is 
automatically reassigned.

Comments A text field for activity notes and information to be shared by the 
team.

Cost Estimate The monetary value associated with the activity estimate.

Created The date and time the activity was created.

Created By The user ID of the activity creator. 

Description A text entry field that can be used for additional information about 
the activity.
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Display In A field that determines where an activity appears. The field has 
three values—Calendar and Activities, To Do and Activities, 
Activities Only. If, for example, you want an activity to appear in 
your calendar, you must set the Display In field to Calendar and 
Activities and make sure that the activity has a start time. 

If you set the Type field to To Do, the Display In field automatically 
changes to To Do and Activities. On the home page, To Do activities 
appear in the My Activities list and do not appear in the My 
Calendar list. 

Due An editable date field that displays a date and time by which the 
activity must be completed.

Duration A list of values established by your company that allows you to 
choose the duration of an activity. Default values are in minute 
segments, for example 5, 10, 15, and 20.

Employees The User ID of the activity creator. You can select multiple 
employees for an activity, but only one employee can be 
designated as primary.

End The proposed date and time for the activity completion.

Global Owner The employee who is responsible for the activity.

Meeting Location A text field that can be used for location information that is shared 
by the sales team. Examples of meeting locations are Conference 
Room B and Main Campus Facility.

New Automatically selected when ownership is changed from the 
activity creator to another user. Automatically cleared when the 
new owner views activity details by clicking the hyperlink in the 
Type field. 

Opportunity A dialog box that allows you to associate an opportunity with an 
activity.

Owner The primary employee associated with the activity. The default 
owner is the creator of the activity. Enter a new value into the field 
by typing the User ID directly into the field, or click the select 
button and choose the primary employee from the Pick Employee 
dialog box. The new Owner value that you enter also replaces the 
primary employee that appears in the Employee field. Conversely, 
if you add a new primary to the Employee field, this new primary 
also appears in the owner field.

Price List A list of values established by your company that allows you to 
specify which price list is associated with a billable activity.

Priority A list of values established by your company that allows you to 
assign a priority to the activity. Default values include 1-ASAP, 2-
High, 3-Medium, and 4-Low.

Field Comments
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NOTE: The My To Do filter allows you to view each activity that has been designated as a To Do item 
using the Display In field. Choose My To Do List from the Show drop-down list to access this feature. 
You can further refine the To Do List by using the predefined queries that appear in the Queries drop-
down list. For example, if you select the Uncompleted Activities query, the To Do items that do not 
have a status of Done appear. You can also view uncompleted To Do items in the To Do list that 
appears on the calendar screen. This list, by default, only shows To Do items that are not yet 
complete.

Working with Others’ Activities (End 
User)
The following procedure describes how to work with another user’s activity records, if that user has 
granted you permission to do so.

For information about how to grant permission for another user to work with your activity records, 
see about granting access to your calendar in Fundamentals.

To work with another user’s activity records

1 Navigate to the Activities screen > Others’ Activities List view.

Private When selected, the activity becomes visible only to the users listed 
in the Employees field and the Siebel administrator. 

Project Allows you to associate a project with an activity.

Rate List A list of values established by your company that allows you to 
specify which rate list is associated with a billable activity.

Repeat Frequency If Repeat Frequency is selected, this field displays the interval at 
which the activity repeats. Default values include daily, weekly, 
monthly, and yearly.

Repeat Until An editable field that displays the date and time for the last interval 
of the final meeting in the series.

Site A default value that is automatically entered when you associate 
the account with an activity.

Start An editable field that displays the activity creation date and time.

Status A list of values established by your company that allows you to 
assign a status to the activity. Default values include 
Acknowledged, Cancelled, Declined, Scheduled, and Completed.

Type A list of values established by your company that allows you to 
define the activity type. Default values include Call, 
Correspondence, and Email.

Field Comments
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2 In the drop-down list in the header, select the user whose activities you want to work with, and 
click Go.

If you have add-and-modify access to the records, the New button in the Activities list is 
available, and you can work with these records as your own. If you have not been granted 
permission to make changes, the New button is inactive.

Delegating an Activity (End User)
If you work as part of a sales team or you are a sales manager, you may manage other people’s 
activities. You can delegate an activity to another member of the sales team, an employee, or a 
partner.

To delegate an activity

1 Navigate to the Activities screen > Activity List view. 

2 Select the activity that you want to delegate.

3 Edit the Owner field, selecting the individual to whom you want the activity assigned.

To reassign or remove ownership of an activity using the Employee field

1 Navigate to the Activities screen > Activity List view.

2 Select the activity that you want to reassign.

3 Edit the Employees field, adding or removing employees as required. 

4 (Optional) Designate one of the employees as the Primary. 

To assign an activity using Assignment Manager

1 Navigate to the Activities screen > Activity List view.

2 Select the activity that you want to reassign.

3 In the form, click the menu button and choose Assign.

NOTE: If the delegator uses Siebel Assignment Manager to reassign an activity, the delegator is 
automatically removed from the employee list.

Viewing Activities Associated with 
Another Record Type (End User)
For example, users researching service requests can review the activities related to the selected 
service request in the Service Request Detail view. This view lists the completed and scheduled 
activities for the service request. 
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The procedure below uses the Service Request screen as an example, but many other screens also 
have activity views.

To view activities for a service request

1 Navigate to the Service Requests screen > Service Request List view. 

2 Drill down on a service request record.

3 Click the Activities view tab.

The Activities list represents every scheduled task for the selected service request as well as the 
service request history.

4 (Optional) Create a new activity and complete the fields.

5 To see more information about an activity, drill down Type field. 

About Configuring Owner and Employee 
Fields for Activities
Depending on your business process, you may want to configure the Siebel application so that the 
Employees and Owner fields for activities are always left blank when the activity is created. (The 
Owner field displays the primary from the Employee field.)

To achieve this, use Siebel Tools to set the predefault value of the Primary Owned By field (which 
maps to the Owner field that appears in the UI) in the Action business component to blank.
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Methods
This chapter contains information about activity plans, activity templates, sales methods, and sales 
stages. It includes the following topics:

■ “About Activity Templates and Activity Plans” on page 255

■ “About Sales Methods” on page 256

■ “Scenarios for Activity Plans” on page 256

■ “Process of Administering and Using Activity Plans” on page 257

■ “Defining a Sales Methodology” on page 257

■ “About Activity Assignment” on page 259

■ “Creating an Activity Template” on page 260

■ “Creating TAS Customer Milestone Templates in a Localized Application” on page 261

■ “Deleting an Activity Template” on page 262

■ “Setting a Default Sales Methodology (End User)” on page 263

■ “Using an Activity Plan (End User)” on page 263

For information about creating activity templates for field service activities, see Siebel Field Service 
Guide.

About Activity Templates and Activity 
Plans
Activity templates are created by an administrator and are blueprints for sets of activities. Activity 
templates can be invoked by end users to create activity plans.

You can select an appropriate activity template for the goal you want to achieve, which generates a 
list of activities associated with the activity template. This generated list of activities is an activity 
plan. An activity plan saves you from creating a new list of activities for each sales call, corporate 
visit, and special event. Typically, activity plans incorporate a company’s best practices. Using 
activity plans, you can locate, assign, schedule, and track the progress of related activities. 

For instance, the following list of activities can serve as an activity template for a corporate visit with 
clients for product demonstrations:

■ Book a conference room

■ Set an agenda

■ Confirm the date and time with the customer

■ Make arrangements for presenters
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This set of tasks, when defined as a template and applied to create the activity plan, helps sales team 
members follow the steps your company recommends to prepare for a corporate visit. The list drives 
critical tasks and defines the recommended lead time for each activity within the template.

Each activity template is associated (through its Type value) with a certain business object. See 
Table 66 on page 248 for a list of business object and screens that use activity templates. In activity 
plans views, only activity templates that have been associated with the active business object can 
be invoked. For example, on the Opportunity screen, only templates for opportunity activities are 
visible. Selecting a template creates all the activities defined by that template.

About Sales Methods
A sales method is an approach used in the sales process. The administrator sets up sales methods 
and sales stages that represent the organization’s desired sales process. A method may encompass 
every stage associated with the sales process, from prospecting to forecasting to closing deals. You 
can set up as many methods and sales stages as your organization needs. Sales representatives can 
then use the method most appropriate for their opportunities.

Sales methods can differ even within one organization. For instance, a sales method for dealing with 
complex multimillion dollar opportunities may include as many as fifteen stages, while a sales 
method of a low dollar opportunity may require only four. 

Sales methods and stages are only associated with activity templates and assessment templates of 
type Opportunity.

Scenarios for Activity Plans
This scenario provides an example of a process performed by the administrator and the end users in 
a sales situation. Your company may follow a different process flow according to its business 
requirements.

Scenario for Sales
A sales organization has adopted a new sales methodology in order to improve the effectiveness of 
its salespeople. The business analyst has provided the administrator with a detailed document 
describing the sales method, the stages of the method, and the activities that each salesperson 
should perform at each stage of the deal. The outline of the document looks like this:

Our New Sales Method

> Stage 1, Prospecting, the lead discovery phase. (Status = Open)

> Stage 2, Qualification of the lead and working up the deal. (Status = Open)

∨  Stage 3, Closing the deal and entering the order. (Status = Won)

> Activity 1, Prepare the quote within 2 days

> Activity 2, Email the quote to manager for approval within 3 days
Applications Administration Guide Version 7.7, Rev. B256 ■



Activity Plans and Sales Methods ■ Process of Administering and Using Activity Plans
> Activity 3, Create the contract within 1 week

> Stage 4, Lost deal. (Status = Lost)

The administrator creates a new sales method record (New Sales Method) and four associated sales 
stage records (Prospecting, Qualification, Closing, and Lost). 

Next, she creates four new activity templates, one for each stage. The activity template describes 
the activities and milestones that the salespeople should perform at that stage. 

Because the salespeople enter their own opportunity records, the administrator sets up the activity 
template details so that the salesperson who enters the opportunity is automatically assigned 
ownership of the activities. 

Sales people set their user preferences to specify that their default sales methodology is the New 
Sales Method, so that this methodology is automatically filled in when they create their 
opportunities. 

When salespeople enter their opportunity records and specify a sales stage, the activity template for 
that stage automatically generates and assigns the activities appropriate for the stage. And, because 
lead times were set up in the activity template details, the due dates for the activities are calculated 
automatically, based on the date that the opportunity entered the sales stage.

Process of Administering and Using 
Activity Plans
This example process represents the tasks that are carried out in the course of administering and 
using activity plans and sales methods.

■ “Defining a Sales Methodology” on page 257

■ “Creating an Activity Template” on page 260

■ “Creating TAS Customer Milestone Templates in a Localized Application” on page 261

■ “Deleting an Activity Template” on page 262

■ “Setting a Default Sales Methodology (End User)” on page 263

■ “Using an Activity Plan (End User)” on page 263

Defining a Sales Methodology
There are two parts to creating a sales methodology:

■ Creating the sales method record

■ Creating a sales stage record for each stage in the methodology

NOTE: Sales methods and stages are associated with activity templates and assessment templates 
of type Opportunity. If you are not intending to create a template of this type, you do not need to 
define a sales methodology.
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You use the Sales Methods view of the Applications Administration screen to define sales methods 
and to create and associate sales stages with each of those methods.

To create a sales method and associated sales stages

1 Navigate to the Administration - Data screen > Sales Methods view.

2 In the Sales Methods list, create a new record and complete the necessary fields.

3 In the Sales Stages list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Phase This value is used for rolling up many different stages into phases. Phases 
simplify management and reporting of the sales cycle. Select the one that best 
matches the stage you are currently adding. For example, a stage called 
Prospecting would best match the lead discovery phase. 

The choices in this drop-down list are configured by using the 
SALES_STAGE_PHASE_TYPE type in the List of Values. For more information, 
see Chapter 5, “Working with Lists of Values.”

The default choices are:

■ A - Lead Discovery

■ B - Working the Deal

■ C - Closing

■ D - Lost Deal

Status The choices in this drop-down list are configured by using the 
SALES_STAGE_STATUS type in the List of Values. For more information, see 
Chapter 5, “Working with Lists of Values.” The default choices are Open, Won, 
and Lost.

Quota Factor The amount by which a sales representative’s quota is multiplied by for that 
sales stage. 

As you move deals from one stage to another, some deals fall out of the 
pipeline. In order to eventually close $1,000,000 in revenues, you might need 
$10,000,000 worth of stage 01 deals, or $5,000,000 worth of stage 04 deals, 
or $1,500,000 of stage 08 deals. This means your quota factors in this case is 
10 for stage 01, 5 for stage 04, and 1.5 for stage 08.

In your Siebel application, a sales representative’s quota is the sum total of his 
or her revenue quota objectives on all of his or her active quota plans.

The default value is 1.

Order The sales stage’s position in the list of values in the Opportunities screen.
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Before the Sales Method and Sales Stage can be used, the cache may need to be refreshed. For more 
information, see “Clearing the Cache” on page 79. 

About Activity Assignment
Activities created using activity templates can be assigned automatically to:

■ The employee who is specified in the template. 

■ The employee who creates the activity, using activity templates (this is usual in a sales situation).

■ No employee (this is recommended when Assignment Manager is used to assign the activity).

The assignment is determined by the values in the Employee and Category fields of the activity 
record in the Activity Template Details list, according to Table 67. 

NOTE: Activities created directly in the Activities screen are similarly affected by the Category value. 
If the Category value is changed to Field Engineer Activity, Repair Activity, Preventive Maintenance, 
or Other, the values of Owner and Category fields are deleted and set to NULL when the record is 
saved.

Win 
Probability

The probability or likelihood (out of 100) that, after successfully completing this 
stage, the deal is eventually won. In theory, the later the stage, the higher the 
win probability should be, because each stage brings the salesperson closer to 
winning the deal.

Duration The number of days in a particular stage required for an average deal under 
average circumstances.

Stalled Deal 
Limit

The number of days that an opportunity can be in a particular sales stage. If 
the opportunity exceeds this limit, you can consider the deal to be stalled. 
There is no effect on the sales stage or any other aspect of the opportunity.

Table 67. Employee and Category Values Determine Activity Assignment

If Employee 
Is... and Category Is... Then the Activity Is...

NOT NULL Any value 
(NULL or NOT NULL)

Assigned to the employee who is 
specified in the Employee field of the 
template.

NULL Field Engineer Activity
Repair Activity,
Preventive Maintenance, or Other

Not assigned. The Employee and 
Owner fields are blank in the created 
activity.

NULL Not Field Engineer Activity, Repair 
Activity, Preventative Maintenance, or 
Other

Assigned to the employee who creates 
the activity (by applying the activity 
template).

Field Comments
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Creating an Activity Template
You use the Activity Templates view of the Administration - Data screen to create activity templates.

NOTE: For information about creating service activity templates using the Service Details view, see 
Siebel Field Service Guide.

To create an activity template without grandchild records

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

3 Click the Activity Template Details view tab.

Field Comments

Sales Stage If you are creating a template of type Opportunity, select the sales stage with 
which you would like to associate the activity template. When the sales stage is 
selected, the Sales Method field is automatically filled in.

When this sales stage (and sales method) are specified for an opportunity and 
Auto Trigger is selected, the activity template is used to automatically populate 
the Activity Plan view for that opportunity. 

For information about creating sales stages and methods, see “Defining a Sales 
Methodology” on page 257.

Type Select the type that specifies where you would like the template to be available. 
For example, select Account if you want to use this template to create activity 
plans for accounts, or Milestone for TAS customer milestones.

The choices in this drop-down list are configured by using the 
TEMPLATE_OBJECT_TYPE type in the List of Values. For more information, see 
Chapter 5, “Working with Lists of Values.”

Sales 
Method

When the sales stage is selected, the Sales Method field is automatically filled 
in.

Public There is no logic associated with this field. You may choose to use it in 
conjunction with workflows and search specifications. 

Auto Trigger If you are creating a template of type Opportunity, select this field to have the 
activity plan automatically generated for opportunities with this sales stage.
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4 In the Activity Templates Details list, create a new record and complete the necessary fields.

Some fields are described in the following table.

5 Create a new activity template detail record for each activity associated with the activity 
template.

Creating TAS Customer Milestone 
Templates in a Localized Application
The sample TAS Customer Milestone activity template is available only in English. If you are running 
a localized version of the Siebel Sales application (that is, a version in a language other than English) 
and are using the Target Account Selling (TAS) module, you need to create an activity template of 
type Milestone, as outlined in the following procedure.

Field Comments

Type The choices in this drop-down list are configured by using the TODO_TYPE 
type in the List of Values. For more information, see Chapter 5, “Working 
with Lists of Values.”

Duration The time needed to complete the activity. This field determines the end 
time for the activity.

Lead The lead time for the activity.

Units Units of time to measure the lead time of the activity.

Employees User names of the people who are to perform the activity. 

See “About Activity Assignment” on page 259.

Alarm Whether an alarm should go off when it is time for the activity.

Category See “About Activity Assignment” on page 259.

Lock Assignment Whether the Employees field should be locked so that assignment cannot 
be changed by Assignment Manager. (Assignment can still be changed 
manually, for example, by the administrator.)

Required This check box indicates that the activity must be completed. This is for 
information only; there is no associated code.

Display In Choose to display the activity in the Calendar screen, the Activity screen, 
or in both. This field is not displayed by default.

Breakable This is an input parameter to Siebel Scheduler. For more information, see 
Siebel Field Service Guide.

Lock Schedule This field is used for service activity templates. For more information, see 
Siebel Field Service Guide.

Work Time This field is used for service activity templates. For more information, see 
Siebel Field Service Guide.
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To translate a TAS Customer Milestone template for a localized application

1 Navigate to Application - Data screen > Activity Templates view.

2 In the Activity Templates list, query for records of type Milestone where Milestone is the 
translation of the English word in the localization language. 

NOTE: For the translation, see the Interface Terminology Look-up manual for your language, or, 
in the List of Values, look for the Display Value that corresponds to the Language-Independent 
Code for Milestone. For more information about List of Values, see Chapter 5, “Working with Lists 
of Values.”

Six records should be found by the query:

■ 1-Request Offering(s)

■ 2-Evaluate Offering(s)

■ 3-Approve / Select

■ 4-Legal / Purchasing

■ 5-Implement

■ 6-Measure

3 For each of the six templates:

a Click the Activity Templates Detail view tab.

b Make sure that for each detail record, the Type is Recommended Activity where Recommended 
Activity is the translation of the English phrase in the localized language. (See note in Step 2.)

c Optional: Translate the Description of each detail record into the localized language.

4 Follow the procedure for adding a milestone in “Adding Customer Milestones” on page 555, and 
make sure that the six Activity Templates (Step 2 of this procedure) appear in the Event field 
drop-down list.

Deleting an Activity Template
CAUTION: If you delete an activity template, all activities associated with activity plans that 
reference the template are also deleted.

To delete an activity template

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Templates list, select and delete the activity template record.
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Setting a Default Sales Methodology 
(End User)
End users can set a default sales methodology in their preferences so that each time they create a 
new opportunity, their default sales methodology is filled in for the opportunity record.

To set a default sales methodology

1 From the application-level menu, choose Tools > User Preferences.

2 On the link bar, click Price List & Sales Methodology.

3 In the Sales Methodology field, select the methodology that you want to have as the default. 

Using an Activity Plan (End User)
An activity plan defines the activities needed to implement a project or goal, or to resolve issues that 
frequently occur. For example, if a service-oriented activity plan is associated with a service request, 
the plan might include standard set of activities required to resolve the SR.

Activity plans use activity templates that establish the list of activities to be completed. Activity 
templates, created by administrators, may have various levels of details pertinent to each member 
of a team, such as requisitioning parts and tools, steps involved in the service activities, or special 
directions or instructions. 

After an agent chooses an activity plan, the steps are in place to help diagnose and resolve the 
customer’s issues, and the agent can move to the next customer call. Either Assignment Manager or 
an administrator can assign the activities to the appropriate users.

To create activities associated with an activity plan

1 Navigate to the Service Request screen > Service Request List view.

2 In the Service Request list, select the service request, and drill down on the SR #.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, create a record, and in the Template field, select the appropriate activity 
template for the service request.

5 In the Planned Start field, enter the start date and time for activities related to the service 
request.

6 Save the Activity Plan.

Activities associated with the plan are automatically generated and appear in the Activities 
subview. 
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19 Assessments
This chapter contains information about assessments. It includes the following topics:

■ “About Assessment Templates” on page 265

■ “Scenario for Using and Administering Assessments” on page 265

■ “Process of Administering and Using Assessments” on page 266

■ “Creating an Assessment Template” on page 266

■ “Performing an Assessment (End User)” on page 268

■ “Assessing an Opportunity for Target Account Selling (End User)” on page 269

About Assessment Templates
An assessment template is a model used to generate an assessment. Assessment templates can be 
created to assess opportunities, contacts, and accounts, as well as other areas of the Siebel 

applications, such as the Ideal Customer assessment used by the Strategic Selling® module.

Assessments ask questions (in the form of attributes) and score the answers in order to determine 
a single total score or percentage, which measures or ranks a given opportunity, contact, account, 
or so on. 

Assessments are made up of one or more attributes. Each attribute has a name, a weight, a set of 
allowable values and a description field. For example, a common attribute for an account might be 
Credit History. The values for this attribute might include Excellent, Good, Average, and Poor. Each 
of these values carries a numerical score and, optionally, instructions for the end user on how to 
choose the correct value. 

Typically, the administrator creates assessment templates, and end users apply the templates and 
carry out the assessments. 

Scenario for Using and Administering 
Assessments
This scenario provides an example of a process performed by the administrator and the end users in 
a sales situation. Your company may follow a different process according to its business 
requirements.

A sales organization has adopted a new sales methodology in order to improve the effectiveness of 
its salespeople. The business analyst has provided the administrator with a detailed document 
describing the sales method.
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Because the salespeople have too many opportunities to deal with at once, they need to prioritize 
their opportunities. To help them to this, the business analyst has created a standardized assessment 
document that he recommends all salespeople use to rank their opportunities. The outline of 
assessment document looks like this:

Assessing a Lead at the Qualification Stage

> Attribute 1: Adaptability to New Technology, weight = 5

∨  Attribute 2: Number of potential users, weight = 7

0 to 50, score = 0, Too small

51 to 100, score = 1, Route to telesales

101 to 500, score = 2, Route to middle market

more than 500, score = 6, Pursue aggressively

∨  Attribute 3: Sponsor’s stance, weight = 10

Adversarial, score = -5, Strongly against us

Weak, score = 0, Neutral or slight favor another vendor

Moderate, score = 5, Willing to recommend our product

Strong, score = 10, Believes we are the best choice

> Attribute 4: Lead’s purchase profile and history, weight = 5

The administrator uses the information in this document to create an assessment template 
associated with the qualification stage. When a salesperson reaches the qualification stage of the 
deal, the Assessments view for that opportunity is automatically populated with the questions that 
need to be answered in order to assess and prioritize the opportunity.

Process of Administering and Using 
Assessments
This example process represents the tasks that are carried out in the course of administering and 
using assessments.

■ “Creating an Assessment Template” on page 266

■ “Performing an Assessment (End User)” on page 268

■ “Assessing an Opportunity for Target Account Selling (End User)” on page 269

Creating an Assessment Template
You use the Sales Assessment Templates view of the Administration - Data screen to create 
assessment templates.
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To create an assessment template

1 Navigate to the Administration - Data screen > Sales Assessment Templates view.

2 In the Assessment Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

3 In the Assessment Attributes list, create a new record for each attribute you want to assess. 

Some fields are described in the following table.

:

Field Comments

Assessment The name of the template.

Type Select the type that specifies where you would like the template to be 
available. For example, select Contact if you want to use this template to 
create an assessment plan for contacts. 

The choices in this drop-down list are configured by using the 
TEMPLATE_OBJECT_TYPE type in the List of Values. For more 
information, see Chapter 5, “Working with Lists of Values.”

Sales Stages If you are creating a template of type Opportunity, select sales stages 
with which you would like to associate the assessment template.

When one of these sales stages (and matching sales method) is specified 
for an opportunity, the assessment template is used to automatically 
populate the Assessments view for that opportunity.

Sales Method This field is filled when a sales stage is selected.

Field Comments

Order The attribute’s position in the Assessment Attributes list.

Name Name of the attribute.

Weight The relative importance of the attribute.

Max Child This field contains the maximum score from the Attribute Values list.

Weight Times 
Score

This is the product of the Weight and the Max Child values.
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4 For each assessment attribute, create a record for each possible value of the attribute. 

Some fields are described in the following table.

These values appear in the Pick Attribute Value dialog box when the end user applies the 
template. For information about using an assessment template, see “Assessing an Opportunity” 
on page 494.

How Assessment Scores Are Calculated
The total score for the assessment is determined by summing weighted scores for each assessment 
attribute:

where n is the number of assessment attributes in the template.

The score is also calculated as a percentage of the maximum score possible:

where Max_Scorei is the largest score for any value in the Attribute Values list for the ith attribute. 

This is the Max Child value shown in the Assessment Attributes applet. For example, in the 
assessment example in the “Scenario for Using and Administering Assessments” on page 265, the 
largest score for Attribute 2 is 6 and the largest score for Attribute 3 is 10.

Performing an Assessment (End User)
The following procedure shows how to assess an opportunity, but the procedure is essentially the 
same for any screen where assessments can be performed.

Field Comments

Order Indicates the value’s position in the Attribute Values list.

Value The name of the value, for example, Excellent, Good, or Average.

Score The number of points that the value represents.

Description Additional information about the value to help the assessor.
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An opportunity assessment helps you qualify opportunities and verify resource allocation. Using an 
assessment template, you can select values and attributes to assign a composite value to the 
opportunity.

NOTE: In some companies, your Siebel application automatically generates assessments, but if this 
process has not been automated, you can create assessments manually.

To assess an opportunity

1 Navigate to the Opportunities screen > List view.

2 In the Opportunities list, drill down on the opportunity which you want to assess.

3 Click the Assessments view tab, and create a new record.

4 In the Template Name field specify an assessment template.

5 Save the assessment record. 

Assessment attributes associated are automatically generated and appear in the Assessment 
Attributes list.

6 In the Assessment Attributes list, specify a value and add comments for each attribute.

A composite assessment score for the opportunity appears as a percentage value in the parent 
Assessment list. This percentage compares the score you entered in the assessment attribute 
line items to the maximum possible score for the opportunity. You can use this percentage to 
qualify the opportunity.

Assessing an Opportunity for Target 
Account Selling (End User)
Sales professionals can use the Assessments view to evaluate the opportunity using criteria 
developed by Siebel MultiChannel Services. Assessments must be completed before determining the 
best strategy. An assessment focuses on the following four key questions:

1 Is there an opportunity?

2 Can we compete?

3 Can we win?

4 Is it worth winning?

Sales professionals assess their organization’s position and the position of their top competitors 
against these criteria. As the sales campaign progresses, sales professionals repeat this assessment 
and then compare the results to past assessments to evaluate and monitor their position at each 
sales stage.

The first few times an assessment is performed, use the TAS Coach to help evaluate and answer each 
set of assessment questions. After a number of assessments are performed and you are familiar with 
the criteria and methodology, use the Assessment form to rate the criteria.
Applications Administration Guide Version 7.7, Rev. B ■ 269



Assessments ■ Assessing an Opportunity for Target Account Selling (End User)
To begin an assessment

1 Navigate to the Opportunities screen > List view.

2 In the Opportunities list, drill down on the opportunity which you want to assess.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Assessments. 

The Assessments list includes all the assessments you and your sales team have performed to 
date. Use the Assessments list to compare opportunity assessments for your company and your 
competitors.

5 In the Assessments form, click New.

6 In the new record, the Assessment For field defaults to Our Company for self assessments. If you 
are assessing a competitor’s position, enter the competitor in this field. 

7 In the Assessment form, click TAS Coach, and then complete the assessment criteria questions. 

For more information, see “Using the TAS Coach” on page 270.

Using the TAS Coach
The Assessment TAS Coach uses Siebel SmartScripts technology to help sales professionals evaluate 
opportunities. The explorer pane expands to show the individual questions in each question set, and 
the form at right provides information on assessment considerations and rating selection.

To perform an assessment using TAS Coach

1 Assess the position of each of the criteria in the Assessments list by selecting a plus (+), a minus 
(-), or a question mark (?) from the drop-down list.

2 Click Next to advance to the next set of criteria questions.

■ Click Previous to return to criteria you have already assessed.

■ Click Cancel to return to the Assessments view without saving the assessment.

■ If you want to pause in the middle of a TAS Coach assessment, and then return to the 
assessment at a later time, click Finish Later. The assessment does not appear in the 
Assessments list until it is completed. 

Your assessment is saved in the SmartScripts screen’s My Saved Session view. Use Site Map to 
navigate to the SmartScripts screen.

If you do not have enough information to answer the question, select the question mark (?).

3 When you have rated all criteria, click Finish to return to the Assessments list.

You must click Finish to save the criteria ratings.
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This chapter describes the resource and calendar access tasks performed by the administrator.

It includes the following topics:

■ “About Calendar Access and Resources” on page 271

■ “Scenarios for Calendar Administration” on page 271

■ “Process of Calendar Administration” on page 272

■ “Setting Up Resources” on page 273

■ “Adding and Modifying Calendar Access” on page 273

■ “Deleting Calendar Access” on page 274

■ “About Configuring the Calendar” on page 274

About Calendar Access and Resources

About Resources
Resources are typically things such as conference rooms and audio-visual equipment that are 
reserved and used by employees for meetings and other calendar activities. Resources have 
availability associated with them and can be invited as participants to calendar activities in much the 
same way as employees and contacts are invited to calendar activities. For more information about 
adding participants to activities, see Fundamentals. The administrator is responsible for setting up 
and maintaining the list of resources.

About Calendar Access
Normally employees grant each other access to their calendars as described in Fundamentals. 
However, there are various situations when the administrator may be required to add, modify, or 
delete calendar access for employees.

Scenarios for Calendar Administration
These scenarios provide examples of calendar tasks performed by the administrator. Your company 
may follow a different process according to its business requirements.

Resource Administration
This topic presents two scenarios requiring resource administration:
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■ Before the Siebel application is rolled out to end users, the administrator creates resource 
records. He creates resource records for all the conference rooms for the various floors and 
buildings of the company’s sites. He also creates resource records for the audio-visual equipment 
that employees may want to reserve for use at their meetings. 

■ After the Siebel application is rolled out, the company grows and more sites and conferences 
rooms are added. Old audio-visual equipment is discarded and new equipment is purchased. The 
administrator continues to maintain the list of resources, keeping it up-to-date. 

See “To administer resources for calendar activities” on page 273 for the procedure associated with 
these scenarios.

Calendar Access Administration
Here are three scenarios requiring calendar access administration:

■ Employee A is out of the office unexpectedly. Employee B needs to view Employee A’s calendar 
so that she can cancel his appointments. Employee B asks the administrator to give her access 
to Employee A’s calendar. See “To give Employee B access to Employee A’s calendar” on page 273.

■ An executive has been granted access to many of his colleagues’ calendars. When the executive 
moves to a new division, he no longer needs to access to these employees’ calendars. He asks 
the administrator to clear the list by removing his name from all employees’ Calendar Access List 
views. (Alternatively, the executive could have contacted all the employees whose calendars are 
on his Owner drop-down list and asked each of them to remove his name from their calendar 
access lists.) See “To remove all employees from an employee’s Calendar Owner drop-down list” on 
page 274.

■ When an employee leaves the company, the administrator removes the employee’s name from 
the Owner lists of other employees. See “To remove an employee (A) from all employees’ Calendar 
Access List views” on page 274.

Process of Calendar Administration
This example process represents the tasks that are carried out in the “Scenarios for Calendar 
Administration” on page 271. 

Setting up of resources is completed before the end users begin to set up meetings. Other tasks are 
carried out according to the company’s business needs.

1 “Setting Up Resources” on page 273

2 “Adding and Modifying Calendar Access” on page 273

3 “Deleting Calendar Access” on page 274
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Setting Up Resources

To administer resources for calendar activities

1 Navigate to Administration - User screen > Resources view.

2 In the Resources list, create a new record and complete the necessary fields.

TIP: If the Description and Site fields are not sufficient to identify the resource, other fields can 
be added to the Resources list applet. For example, your company may want to add Building 
Number and Floor fields to help end users find and identify resources. For information on creating 
and exposing fields, see Configuring Siebel eBusiness Applications.

3 Edit and delete resource records as required.

Adding and Modifying Calendar Access
There are two Calendar Administration views that can be used to modify calendar access:

■ Calendar Admin Access Received lists all the calendars that the selected employee can access.

■ Calendar Admin Access Granted lists all the employees who can access the selected employee’s 
calendar.

To give Employee B access to Employee A’s calendar

1 Navigate to Administration - User > Employees > Calendar Administration > Access Granted.

2 In the Employees list, select the employee (Employee A).

3 In the Calendar Administration list, create a new record or select an existing record and complete 
the Last Name and Update Access fields.

To view all the calendars to which an employee has access

1 Navigate to Administration - User screen > Employees > Calendar Administration > Access 
Received view.

Field Comments

Last Name This is the name of the Employee B who wants to access Employee A’s 
calendar. 

Update Access If this is selected and marked Y, Employee B has read/write access to 
Employee A’s calendar.

If this is marked N, Employee B has read-only access to Employee A’s 
calendar.
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2 In the Employees list, select the employee.

The Calendar Administration list shows calendars to which the employee has access.

NOTE: Records can be added, modified, and deleted from this view.

Deleting Calendar Access
For a selected employee, the administrator can delete all employees from the Access Granted or the 
Access Received list.

To remove all employees from an employee’s Calendar Owner drop-down list

1 Navigate to Administration - User screen > Employees > Calendar Administration > Access 
Received view.

2 In the Employees list, select the employee.

3 Make sure that you have selected the employee whose Calendar view Owner drop-down list you 
want to clear.

4 From the menu button in the Access Received list, select Delete All. 

This command deletes all records in the list. The employee selected in the Employees list no 
longer has access to any calendars other than his or her own. 

NOTE: Alternatively, you can use the Delete Record command to remove just one selected 
employee from the employee’s calendar owner drop-down list.

To remove an employee (A) from all employees’ Calendar Access List views

1 Navigate to Administration - User > Employees > Calendar Administration > Access Granted.

2 In the Employees list, select the employee (Employee A).

3 Make sure that you have selected the employee that you want to remove from all employees’ 
calendar access lists.

4 From the menu button in the Access Granted list, select Delete All.

This command deletes all records in the list. The calendar of the employee selected in the 
Employees list can no longer be accessed by any other employees.

NOTE: Alternatively, you can use the Delete Record command to delete the employee from one 
selected employee’s calendar access list.

About Configuring the Calendar
This section describes some aspects of the Calendar feature that configurators or administrators can 
configure:

■ “Alarm Manager Load Frequency” on page 275
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■ “Days for Retroactive Alarms” on page 275

■ “Required Fields in the eCalendar Detail Applet” on page 275

■ “The To Do List from the Calendar View” on page 276

■ “Calendar Activity Description and ToolTip Text” on page 276

■ “Start and End Times for Calendar Activity Display” on page 278

■ “Calendar Drilldown” on page 278

■ “Drag-and-Drop Action for the Calendar Applet” on page 279

■ “Changing Controls in the Calendar Detail View” on page 281

■ “Showing or Hiding Side Applets on the Life Sciences Calendar” on page 281

Alarm Manager Load Frequency
A system preference called Alarm Manager Load Frequency determines how frequently the calendar 
alarm queries the server for alarm-enabled appointments. The default value is 60 minutes, but you 
may want to change this time to better suit your business needs: querying the server less frequently 
results in fewer SQL calls. However, each SQL call takes longer to execute. In certain cases, this 
trade-off results in improved performance. (Also, if the alarm frequency is less than the session time-
out set in the eapps.cfg file, sessions never time out.)

For information on how to edit system preferences, see “Setting System Preferences” on page 50.

Days for Retroactive Alarms
Retroactive alarms are alarms for past events that did not display before the event because the user 
was not logged in. By default, the application is set to display retroactive alarms for missed events 
up to 14 days in the past. You can change the number of days for retroactive-alarm display by editing 
the RetroAlarmInterval user property of the Alarm Manager business service.

Required Fields in the eCalendar Detail Applet
In the preconfigured application, the Type field is the only required field in the Calendar Detail form 
in the Calendar Detail view. If you make other fields required, you must predefault these fields. This 
is because when users create a new record or drill into a record from the calendar grid, an implicit 
save of the record is triggered. If any fields are required but not predefaulted, their values are null 
when the implicit save is triggered and an error message will be generated.

For more information about predefaulting fields, see Configuring Siebel eBusiness Applications.
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The To Do List from the Calendar View
You can configure the calendar view (HI Activity Calendar View) so that the Calendar To Do list applet 
does not appear.

You might choose to do this if your employees do not use the To Do list or if you need more space 
for the calendar applet on the view.

To remove the To Do list from Calendar views

1 Open the CCViewHIC.swt file in a text editor.

For more information about SWT (Siebel Web Template) files, see Configuring Siebel eBusiness 
Applications.

2 Comment out the following text (the first line is already commented):

<!--Column 2 -->

<td valign="top" width="21%">

<swe:for-each count="20" iteratorName="currentId" startValue="201">

<swe:applet hintMapType="Applet" id="swe:currentId" property="Formatted…

</swe:for-each>

</td>

3 Save and close the file.

Calendar Activity Description and ToolTip Text

Calendar Activity Description
By default, the Description field is used as the hyperlink for calendar activities, as shown in Figure 22 
on page 277. However, by editing the Description applet user property on the calendar applet, you 
can change the calendar activity hyperlink to display another field, for example, to display the 
Meeting Location field. See Table 68 for information about this user property.

TIP: If you want to display contents of more than one field, create a calculated field that 
concatenates other fields and set the concatenated field name as the value of the Description user 
property. For example, this is done for the calendar applet (CS CG Activity HI Calendar Applet) used 
by the Consumer Sector application.

ToolTip Text
When you move the pointer over a calendar activity hyperlink, ToolTip text appears (Figure 22 on 
page 277). The contents of these ToolTips are configurable through applet user properties. See 
Table 68 on page 277 for information about these user properties.
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Figure

User Properties for Calendar Activity Hyperlink and ToolTip Text

Figure 22. The Calendar Activity Hyperlink and ToolTip Text in the Activity HI Calendar Applet

Table 68. Calendar Applet User Properties for Calendar Activity Hyperlink and ToolTip Text

Applet User 
Property Description

Description The value of this field is displayed as the calendar activity hyperlink. By default, 
this is the Description field.

Enable Dynamic 
Tooltip

Set this to Y to enable customized ToolTip contents through the use of the 
ToolTip user properties.

If dynamic ToolTips are not enabled, then the ToolTip text defaults to display 
the field values for Type, Description, Start (Sdate), End (Edate), and 
Comment, as shown in Figure 22.

Tooltip, 
Tooltip 1, 
Tooltip 2, ...
Tooltip n

Each ToolTip user property contains the name of an applet control. The ToolTip 
text displayed is the applet control’s caption and the value of the field. 

If ToolTip text is enabled but no ToolTip user properties are defined, then the 
default ToolTips are displayed.

The calendar activity hyperlink defaults to 
the Description field

ToolTip text
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Start and End Times for Calendar Activity Display
Two fields determine the start and end times for activity display in the calendar applet. By default, 
these fields are usually the planned start and completion dates, but other fields can be used by 
editing the Sdate and Edate applet user properties. 

See Table 69 for a list of calendar applet user properties for calendar activity start and end time.

Calendar Drilldown
By default, the calendar activity hyperlink is hard-coded to drill down to the eCalendar Detail View. 
However, this hard coding can be overridden to allow single or dynamic drilldowns to be configured 
through Siebel Tools. For example, the Consumer Sector and Pharma applications use this override 
to configure dynamic drilldown from their calendar applets (CS CG Activity HI Calendar Applet and 
LS Pharma Activity HI Calendar Applet).

If you want to configure the calendar drilldown, you can edit the Override Default Drilldown user 
property (Table 70 on page 278). Special requirements for configuring calendar drilldown are:

■ Only the eCalendar Detail View can handle recurring calendar activities.

■ There must be one drilldown object uniquely named Description.

■ For all drilldown objects, the Hyperlink Field value must be Id.

■ In the case of dynamic drilldowns, if none of the dynamic drilldown criteria are met, drilldown is 
set to the eCalendar Detail View.

Table 69. Calendar Applet User Properties for Calendar Activity Start and End Times

Applet User 
Property Description

Sdate The name of the field that indicates the activity start date and time for display 
in the calendar applet.

Edate The name of the field that indicates the activity end date and time for display 
in the calendar applet.

Table 70. Calendar Applet User Property to Enable Drilldown Configuration

Applet User 
Property Description

Override Default 
Drilldown

Set this to Y to override the hard-coded drilldown to the eCalendar Detail View 
and to allow normal drilldown configuration for the calendar applet within 
Siebel Tools. 
Applications Administration Guide Version 7.7, Rev. B278 ■



Calendar ■ About Configuring the Calendar
Drag-and-Drop Action for the Calendar Applet
A list applet in the Calendar view can be configured so that one or more records can be dragged from 
the list applet and dropped onto the calendar applet. The behavior of the drag-and-drop action is 
configurable. For example:

■ In the Pharma application: dragging a record from the Activities list to the daily calendar applet 
updates the Planned Start date for the activity according to where it is dropped on the calendar.

■ In the Consumer Sector application: dragging records from the Activities list to the calendar 
applet creates a new record of type In Store Visit for the account and associates appropriate 
activity records to the new In Store Visit record. If multiple records are dragged, the account for 
the new record is based on the account of the last record in the dragged group. 

User properties on the list applet determine the drag-and-drop behavior. (Table 71)

Table 71. Applet User Properties for Calendar Drag-and-Drop (Set on the List Applet)

Applet User 
Property Description

Calendar Default 
Action

Set this to NewRecord to create a new calendar activity record when a 
record is dragged from the list applet to the calendar applet. (This is also 
the default behavior, unless the Calendar Drag Method user property is 
set.)

Set this to UpdateTime to change the time field in the source (dragged) 
record according where the record is dropped in the calendar applet. (No 
new record is created.) This behavior is seen in the Pharma application.

Calendar UpdateTime 
Field

If Calendar Default Action = UpdateTime, set the Calendar UpdateTime 
Field user property to the time field in the source applet that you want to 
have updated by the drag-and-drop action. 

For example, in the Pharma application (Pharma Calendar Activity List 
Applet), this is set to Planned.

Calendar Drag Field, 
Calendar Drag Field1, 
Calendar Drag Field2, 
Calendar Drag Field3 
...
Calendar Drag Fieldn

If Calendar Default Action = NewRecord, set the Calendar Drag Field user 
properties to copy data from the source record to the new calendar activity 
(target) record. 

The format for these user properties is 
Source_field_name,Target_field_name 

For example, to copy content from a field named Summary in the source 
record to the Description field in the calendar activity record: Calendar 
Drag Field = Summary,Description.

Calendar Drag 
Associate

If Calendar Default Action = NewRecord, set this user property to Y if you 
want to have the source records associated with the new (target) record. 
The dragged records become child records of the new calendar activity 
record.
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Calendar Drag Child 
Associate Field

If Calendar Drag Associate = Y, set this user property to the name of the 
field in the dragged (source) records that is to associate them with the new 
calendar activity record. The field specified gets populated with the row ID 
of the new calendar activity record.

Calendar Drag 
Method

If the default calendar action does not meet your needs, it is possible to 
supply your own method to control the drag-and-drop action. This is done 
by setting this user property to the method name. 

If this user property is set, the preceding user properties are ignored.

For example, in the Consumer Sector application, this is set to the Drag 
And Drop Handler method.

Calendar Drag 
BusComp

If a method is supplied in the Calendar Drag Method user property, enter 
the name of the business component on which you want to invoke the 
method. If this user property is not specified, the method is invoked on 
the current business component.

For example, in the Consumer Sector application, this is set to the In Store 
Visit business component.

Calendar Drag BusObj If a business component is supplied in the Calendar Drag BusComp user 
property, enter the name of the business object to use when retrieving the 
Calendar Drag BusComp business component. 

If this user property is not specified, the current business object is used. 
However, it is better to specify a value for this business object, even if it 
is the same as the current business object. This is to make sure that 
instantiating the Calendar Drag BusComp business component does not 
affect other business components within the current view.

For example, in the Consumer Sector application, this is set to the In Store 
Visit business object.

Table 71. Applet User Properties for Calendar Drag-and-Drop (Set on the List Applet)

Applet User 
Property Description
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Changing Controls in the Calendar Detail View
The Calendar Detail view (accessed by clicking the New button on the daily, weekly, or monthly 
calendar views) has three buttons that are managed by the specialized class 
CSSSWEFrameGanttHiMode in the HI Gantt Chart applet. Table 72 shows the button name and the 
pop-up applet invoked by the button.

Showing or Hiding Side Applets on the Life Sciences 
Calendar
The calendar pages for the Siebel Life Sciences application have list applets on the right side of the 
calendar applet. See Figure 23 on page 281. 

A user property called Suppress Side Applets Calendar Types on the LS Pharma Activity HI Calendar 
Applet determines whether or not the side list applet is displayed. 

For example, you can choose to have the side list applet displayed with the daily and weekly 
calendars but not with the monthly calendar.

Table 72. Participant Availability Buttons

Buttons Name Popup Applet Invoked

Add Employee HI Gantt Chart Employee Pick Applet

Add Resource HI Gantt Chart Resource Pick Applet

Add Contact HI Gantt Chart Contact Pick Applet

Figure 23. LS Pharma HI Activity Calendar View with Daily Calendar Applet and Side List Applet
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To hide or show the side list applet on the LS Pharma HI Activity Calendar View
■ For the LS Pharma Activity HI Calendar Applet, edit the Suppress Side Applets Calendar Types 

applet user property to include the calendars for which you want to hide the list applet. 

For example, set the value to Daily, Weekly5, Weekly7, Monthly to hide the side list applet on all 
the calendars.
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This chapter is about state models: how to set them up and how they work. It includes the following 
topics:

■ “About State Models” on page 283

■ “Scenario for State Models” on page 284

■ “Process of Setting Up State Models” on page 284

■ “Configuring Business Components for State Models” on page 285

■ “Creating State Models and State Transitions” on page 286

■ “Activating State Models” on page 288

■ “Configuring Child Modification for State Models” on page 289

About State Models
State model functionality allows you to constrain the state of an object by prescribing allowed state 
values and allowed state transitions. For example, a service request object may be constrained to 
three states: Open, Closed, and Pending. Furthermore, the state transitions may be constrained to: 
Open to Pending, Open to Closed, and Pending to Closed. 

For Siebel workflows, state models provide a data-driven method for extending control based on the 
state of the object. For general information about Siebel workflows, see Siebel Business Process 
Designer Administration Guide.

The state model functionality consists of three key elements:

■ State Model. A blueprint of acceptable states and state transitions that are enforced by the state 
machine.

■ State Machine. An engine that enforces the transitions between states for an object during its 
lifetime. The state represents where the object is in its lifetime. The state can also control 
whether the data of that object can be modified. For example, a record that is in a Closed state 
may be considered frozen, such that its attributes cannot be modified. The state machine reviews 
all required conditions defined for the state model before the state transition is completed.

■ State Transition. Defines the allowable migration of an object from one state to the next. For 
instance, a record that has been closed but must be reopened may go from the Closed state to 
an Open state and may go from Open to Pending, but may not transition directly from Closed to 
Pending. 

Specific conditions can be associated with state transitions. For example, you can specify that 
only certain individuals can initiate state transitions or that a transition can only be initiated if 
the object meets certain criteria.
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Scenario for State Models
This scenario provides an example of a process performed by the administrator. Your company may 
follow a different process according to its business requirements.

A company has recently configured its Siebel application to support its case review process. To do 
this, they created a new business component called Case, along with a supporting Case screen and 
views.

The administrator’s task is to set up a state model on this new business component. 

First, the administrator uses Siebel Tools to check that Case business component is based on the 
CSSBCBase class. Then, she discovers that the configurator has already enabled the state model user 
property for this business component. 

Within the Siebel application, she creates a state model based on the Status field (an LOV field) of 
the Case business component.

The state model contains three allowed states:

■ Open. This is set as the default state, the state of any newly created cases.

■ Assigned. 

■ Closed. This is set as a No Delete and No Update state so that a closed case is read-only and 
cannot be deleted.

The state model contains two allowed transitions:

■ From Open to Assigned. Because company policy is that only managers may assign cases, this 
transition is restricted to the managers’ positions.

■ From Assigned to Closed. Company policy also requires that employees write a resolution 
summary of each case before closing. To encourage this, a condition is created so that the status 
cannot be changed to Closed if the Resolution-Summary field is left blank.

Finally, the administrator activates the state model by restarting the server. 

Process of Setting Up State Models
This example process represents the tasks that are carried out in the “Scenario for State Models” on 
page 284. 

1 “Configuring Business Components for State Models” on page 285. This is only required if the 
business component has not been enabled for state models.

2 “Creating State Models and State Transitions” on page 286.

3 “Activating State Models” on page 288.
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Configuring Business Components for 
State Models
You can create state models on business components that are:

■ State-model enabled in the preconfigured application

■ Based directly on the CSSBCBase class and that are enabled using the procedure given in this 
section

Creating state models for business components based on subclasses of CSSBCBase class is not 
supported by Siebel Systems. In particular, do not create or modify state models on the Enterprise 
Service Definitions, SRM Request, and SRM Repeating Request business components. These are used 
for server administration.

This task is a step in Process of Setting Up State Models on page 284.

To find out if a business component is already enabled for state models

1 Navigate to the Administration - Application screen > State Models view.

2 Create a new record and try to complete the Business Component field. 

Some business components are described in the following table. 

3 Delete or undo the new record.

To enable a business component for state models functionality in Siebel Tools

1 Make sure that the business component is based on the CSSBCBase class.

2 Create a new business component user property with the following properties:

■ Name=State Model 

■ Value=Y

If the Business Component 
You Want

Then That Business 
Component Continue with Procedure

Is listed in the Business 
Component dialog box

Is already enabled “To create a new state model” on 
page 286

Is not listed in the Business 
Component dialog box

Is not enabled “To enable a business component 
for state models functionality in 
Siebel Tools” on page 285
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Creating State Models and State 
Transitions
This section describes how to create and define state models and state transitions.

To enable a state model on a business component, the field used should:

■ Be an LOV (list of values) or MLOV (multilingual lists of values) field.

■ Have no dependencies on other fields. (For example, do not use a constrained LOV field or a 
calculated field.)

This task is a step in Process of Setting Up State Models on page 284.

To create a new state model

1 Navigate to the Administration - Application screen > State Models view.

Some fields are described in the following table.

2 Click the States view tab.

3 In the State list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Activation The date on which the state model begins to be enforced.

NOTE: You can set up more than one state model for a given field as long as 
the activation to expiration periods do not overlap.

Business 
Component

The business component that the state model is based on. The dialog box for 
this field displays all of the business components that have been enabled for 
the state model. To enable a business component that is not enabled by 
default, see “Configuring Business Components for State Models” on page 285. 

Expiration The date on which the state model is no longer enforced.

Field The name of the field that the state transitions apply to. The dialog box for 
this field displays the fields that are defined for the business component.

Name A name that uniquely identifies the state model. 

Field Comments

State Name The dialog box for this field presents the list of values for this field.

Default The default state name specifies a beginning value for the business component 
field.

NOTE: If the field is predefaulted in Tools, then it cannot be overridden by the 
state model.
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4 Click the Transitions view tab.

5 In the Transitions list, for each restricted transition, create a new record and complete the 
necessary fields.

Some fields are described in the following table.

No Delete 1 If checked, records in this state cannot be deleted unless they are referenced 
by a parent record in which the Cascade Delete property is set to Delete. 
Cascade Delete always overrides the State Model restrictions. For information 
about how No Delete effects child records, see “Configuring Child Modification 
for State Models” on page 289.

No Update 1 If checked, records in this state are read-only and cannot be updated. 

NOTE: No Update also affects a record’s child records. For example, if an 
account becomes read-only due to use of the No Update restriction, the 
related contacts for the account also become read-only, so inserting and 
deleting contacts is not possible.

Restrict 
Transition

If checked, only defined transitions from this state are allowed. 

If checked and there are no transitions defined, the state becomes an end 
state, where users cannot transition from it to any other state.

If not checked, this state can transition to any of the defined states.

1. Note: Even if No Delete and No Update restrictions are specified for the state model, MVG fields that do not have a direct 
parent-child link between the parent field and the MVG applet are not read-only when a record is in a No Update or No Delete 
state. To avoid confusion for end users, you can remove MVG fields from the child applet. 

Field Comments

From State The original field value for the state transition. 

NOTE: If a state transition is not defined for the default State Name value, the 
field that the state model is based on cannot be changed.

To State The new field value for the state transition, changing from the value indicated 
in From State.

Public Indicates that all users are allowed to make the transition. If checked, records 
in the Authorized Positions list are ignored. For more information, see Step 6 
on page 288.

Field Comments
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6 To restrict a state transition to a subset of users (positions), clear the Public field for the 
transition and create records in the Authorized Positions list.

NOTE: If the Public Flag is not checked and no positions have been added in the Authorized 
Positions list, no users are able to make the transition.

Activating State Models

How Are State Models Activated?
Your new state model does not become available to users until a new Application Object Manager 
(AOM) server process is created. By restarting the server or the Application Object Manager (AOM) 
server components, you start new AOM processes that obtain your new state model from the 
refreshed state model cache.

Rule Field

Rule Operator

Rule Value

These three fields allow you to specify a simple field condition that must be 
satisfied for the transition to occur.

For example, a state transition is created that allows users to change the 
status of a service request from Open to Closed when the sub-status is 
Resolved uses a rule like this:

The syntax for rules is the same as the syntax for calculated field values and 
field validation in Siebel Tools. For more information about the syntax, see 
about operators, expressions, and conditions in Siebel Developer’s Reference.

Rule 
Expression

Allows for the creation of complex or multiple conditions that must be satisfied 
for the transition to occur.

The syntax for the Rule Expression field is the same as the syntax for 
calculated field values and field validation in Siebel Tools. For more 
information about the syntax, see about operators, expressions, and 
conditions in Siebel Developer’s Reference.

Field Comments
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How Are State Models Activated for Mobile Users?
For mobile users who connect through Siebel Remote, the state model is enforced once a user has 
synchronized with the database server. State models are supported on regional nodes. For more 
information about support for regional nodes, see the section about restricting mobile client routing 
in the Siebel Business Process Designer Administration Guide and Siebel Remote and Replication 
Manager Administration Guide.

How Are State Models Enforced?
State models are enforced on the Siebel business logic level. Thus, state models are enforced for 
updates made through Siebel Visual Basic, Siebel eScript, and workflow processes. However, state 
models are not enforced for updates made through Enterprise Integration Manager (EIM) or workflow 
policy programs because these do not go through the Siebel Object Managers.

How the AOM Reads State Model Objects
State model objects are read from the run-time database, not from the compiled Siebel repository 
file (SRF). 

NOTE: If you are distributing state models to other environments, you need to migrate the run-time 
database tables for the state model (as well as distributing the SRF file).

Procedure
This task is a step in Process of Setting Up State Models on page 284.

To activate state models
■ Do one of the following:

■ Restart the server.

■ Restart the Application Object Manager (AOM) server components.

Configuring Child Modification for State 
Models
By default, child records cannot be created, modified, or deleted when the state of the parent record 
is No Delete. 

You can change this behavior in two ways:

■ Globally. At the business-service level by editing the Enable Child Modification user property for 
the State Model Cache business service.

■ Locally. If child modification is enabled at the business-service level, you can disable it for 
individual business components using the State Model Enable Child Modification business 
component user property. 
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To enable child modification for all business components
■ In Siebel Tools, set the State Model Cache business service Enable Child Modification user 

property to Y.

This allows you to create, modify, and delete child records, even when the parent record state is 
No Delete.

To disable child modification for an individual business component if child 
modification is globally enabled
■ In Siebel Tools, set the State Model Enable Child Modification user property for the business 

component to N.

The interaction of the Enable Child Modification (business service) and the State Model Enable 
Child Modification (business component) user properties is summarized in this table.

If the Enable Child 
Modification business 
service user property is 

And the State Model 
Enable Child Modification 
business component user 
property is

Then, for the business 
component, child 
modification is

Y Y or blank Enabled

Y N Disabled

N any value Disabled
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This chapter is about setting up the Document Server. It includes the following topics:

■ “About the Document Server” on page 291

■ “About Obtaining the Required Hardware for the Document Server” on page 291

■ “Process of Setting Up the Document Server” on page 292

■ “Installing the Siebel Server for the Document Server” on page 292

■ “Installing Microsoft Office Applications on the Document Server” on page 294

■ “Enabling the Component Group for the Document Server” on page 295

■ “Setting MaxTasks Parameters for the Document Server” on page 295

■ “Synchronizing Components for the Document Server” on page 296

■ “(Optional) Configuration for the Document Server” on page 296

About the Document Server
The Document Server is required for Siebel Correspondence, Siebel Presentations, and Siebel 
Proposals. The Document Server is used to generate Microsoft Word and Microsoft PowerPoint 
documents.

About Running Document Server Functionality on Siebel Mobile Web 
Clients
This chapter focuses on installing and setting up the communal Document Servers that are used by 
(connected) Siebel Web Clients. However, the Siebel Document Server functionality is available for 
the Siebel Mobile Web Client as well. For example, this allows field sales representatives to generate 
proposals, presentations, and correspondences while traveling.

In the case of the Siebel Mobile Web Client, it is necessary that Microsoft Office be installed locally 
on the mobile machine to act as the Document Server. 

About Obtaining the Required Hardware 
for the Document Server
The Document Server is supported on Windows platforms only. This is because Microsoft Office only 
runs on the Windows platform. See the System Requirements and Supported Platforms on Siebel 
SupportWeb for information about which Windows platforms are supported.
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To maintain stability and performance, the Document Server must run on a dedicated host machine. 
The Siebel Server on this machine should host one instance of the Siebel Documents component 
group. No other components should be running other than required system components. 

The Document Server can be run successfully on a machine that meets the minimum hardware 
requirements for a Siebel installation. For example, a two-processor machine can be used.

To support more users, you can run additional instances of the Siebel Documents component group 
on additional dedicated host machines.

Process of Setting Up the Document 
Server
To set up the Document Server in preparation for using Correspondence, Presentations, or Proposals, 
perform the following tasks: 

■ “Installing the Siebel Server for the Document Server” on page 292

■ “Installing Microsoft Office Applications on the Document Server” on page 294

■ “Enabling the Component Group for the Document Server” on page 295

■ “Setting MaxTasks Parameters for the Document Server” on page 295

■ “Synchronizing Components for the Document Server” on page 296

Installing the Siebel Server for the 
Document Server
This task is a step in “Process of Setting Up the Document Server” on page 292.

Install the Siebel Server on the dedicated host machine of the Document Server. For general 
information about installing the Siebel Server, see Siebel Server Installation Guide for Microsoft 
Windows.

During installation, you have the option to enable component groups. Select the Siebel Documents 
and the System Management component groups. Do not enable any other component groups. (You 
also need to make sure that Siebel Documents component group is not enabled on your main Siebel 
Server.)

Enabling the Siebel Documents component group can also be performed after installation is 
complete, as described in the section “Enabling the Component Group for the Document Server” on 
page 295. 

NOTE: Whenever the Siebel Server is restarted, the Document Server must also be restarted after 
the Siebel Server has been brought up.

Make sure that you use the same SRF file on your Document Server as you use on your other Siebel 
Server. If you update one SRF file, remember to update the SRF file on all your Siebel Server 
machines, including the Document Server.
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Installing the Siebel Server in a Heterogenous Environment
There are some special considerations for setting up the Document Server (Windows platform) when 
your main Siebel Server runs on a UNIX platform. 

There are two approaches you can use:

■ Install third-party mounting software, such as Samba, to allow the Document Server (Windows 
platform) to access the Siebel file system on the UNIX platform.

■ Disable the File System Manager Server component on the Document Server (Windows platform)

Procedures describing both these approaches are given here.

NOTE: The Siebel File System Manager and the physical file system should be on the same platform 
if no cross-platform mounting tool is used.

To set up the Document Server in a heterogeneous environment using third-party 
mounting software

1 Install third-party software, such as Samba, that will allow the Windows machine to access the 
Siebel file system on the UNIX machine.

2 Make sure that the enterprise parameter Siebel File System on the Siebel Server on the Windows 
machine points to the Windows share for the Siebel File System on the UNIX machine.

3 Make sure that the Siebel Documents component group is disabled for the Siebel Server on the 
UNIX machine.

4 Before you install the Siebel Server (the Document Server) on the Windows machine, make sure 
that the Siebel Gateway Name Server and the Siebel Server are up and running on the UNIX 
machine. 

5 During installation of the Siebel Server on the Windows machine, enable only the Siebel 
Documents and the System Management component groups. 

To set up the Document Server in a heterogeneous environment without third-party 
mounting software 

1 Make sure that the Siebel File System enterprise parameter is set to the full path of the Siebel 
File System on the UNIX machine.

2 Make sure that the Siebel Documents component group is disabled for the Siebel Server on the 
UNIX machine.

3 Before you install the Siebel Server (the Document Server) on the Windows machine, make sure 
that the Siebel Gateway Name Server and the Siebel Server are up and running on the UNIX 
machine. 

4 During installation of the Siebel Server on the Windows machine, enable only the Siebel 
Documents and the System Management component groups. 

5 On the Siebel Server (the Document Server) on the Windows machine:
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a Disable the File System Manager Server (alias FSMSrvr) component.

NOTE: For information about re-enabling components, see Siebel System Administration 
Guide.

b In the Enterprise component definition, for the Document Server component, set the Siebel File 
System component parameter to *FSM*

c Synchronize all components.

6 Restart the Siebel Servers on the UNIX machine and on the Windows machine.

Installing Microsoft Office Applications 
on the Document Server
You must install Microsoft Office on the dedicated host machine of the Document Server.

For information about which versions of Microsoft Office are supported, see Release Notes on Siebel 
SupportWeb and System Requirements and Supported Platforms on Siebel SupportWeb for your 
Siebel application.

This task is a step in “Process of Setting Up the Document Server” on page 292.

To install Microsoft Office

1 Log on to the server machine using the same user account that the Siebel Server NT service uses. 
This user account must belong to the Administrators group. 

NOTE: The install must use the same account to be used by the NT Service. The installer 
configures COM security settings so that the installing user account has the correct permissions 
to access and launch the application. If the install uses an account other than the Siebel Server 
NT service account, errors may occur when the Document Server tries to launch the application.

2 Install Microsoft Office using a typical or complete installation. Verify that your version of 
Microsoft Office installs the Web Authoring Tools (HTML) component with the typical installation. 
If it does not, you will need to use the custom installation option and install all of the typical 
components as well as the Web Authoring Tools (HTML) component.

3 Start the applications that will be used by the Document Server. 

This forces the applications to register themselves.

4 If you use Siebel Proposals, make sure that the Microsoft Word option “Confirm conversion at 
open” option is not selected.

This option is found on the Tools menu: Tools > Options > General.

5 Close the applications.
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Enabling the Component Group for the 
Document Server
This task is a step in “Process of Setting Up the Document Server” on page 292.

If you have not already done so during installation, you must enable the component group named 
Siebel Documents. This group contains the DocServer component, which generates Correspondence, 
Presentations, and Proposals. For more information about enabling this group, see Siebel System 
Administration Guide.

Setting MaxTasks Parameters for the 
Document Server
Due to Siebel design limitations, third-party Microsoft Office applications run in a single-threaded 
environment. This means the document server is only capable of processing a single document at a 
time on the server. To increase the number of documents being printed at any one time, it is 
recommended you increase the number of servers.

This task is a step in “Process of Setting Up the Document Server” on page 292.

There are two Siebel Application Object Manager parameters that need to be set:

■ MaxTasks. This parameter should be set to 1. If MaxTasks is greater than 1, an error message 
is sent to the log file as an alert. Processing of the request continues, but results are 
unpredictable when two requests arrive at the same time.

■ Honor MaxTasks. This parameter affects the queuing process and the performance of 
Document Server. For more information, see Table 73.

To set MaxTasks parameters

1 Set MaxTasks to 1.

2 Set Honor MaxTasks to TRUE.

For information about setting parameters, see the section about Siebel Application Object Manager 
parameters in the Siebel System Administration Guide.

Table 73. Honor MaxTasks Parameter for the Document Server

Setting Behavior

TRUE All requests to Document Servers queue on the SRM_REQUEST table; requests 
are not assigned to a Document Server until one is free to take the request. (This 
is the recommended value.)

FALSE Requests are queued on the DocServer component’s internal queue. If the 
Document Server stops processing (for example, crashes) all queued processes 
on that server are lost.
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Synchronizing Components for the 
Document Server
This step is not specific to the Document Server, but is a required post-installation step for the server 
infrastructure. 

To synchronize components for the Document Server
■ See general information about synchronizing components in the Siebel System Administration 

Guide.

(Optional) Configuration for the 
Document Server
This topic describes a number of optional configurations for the Document Server:

■ “(Optional) Configuring Report Generation” on page 296

■ “(Optional) Enabling HTML Generation for Correspondence” on page 297

■ “(Optional) Configuring Application Recycle Period” on page 297

■ “(Optional) Specifying the Target Server” on page 298

■ “(Optional) Enabling Additional Logging” on page 298

(Optional) Configuring Report Generation
If you plan to include report sections in proposals, you must specify the Actuate connect string. Set 
this parameter on each object manager that will be submitting document requests. The value of the 
parameter will be included in the request sent by the object manager to the DocServer. When 
DocServer begins processing the request, it will use the parameter to connect back to the object 
manager to retrieve data for the report.

To specify the Actuate connect string

1 Start the Server Manager. 

2 Modify the server parameter ActuateConnStr to contain the following information:

siebel.tcpip://gatewayserver:port/enterpriseserver/objectmgr/siebelserver 

For example, if \\gtwy is the gateway server host, Sieb01 is the Siebel Server, siebel is the 
Enterprise Server, and you want to run your proposal with report section on Siebel Call Center, whose 
object manager is SCCObjMgr, you should enter the following command:

srvrmgr> change param ActuateConnStr=siebel.tcpip://gtwy/siebel/SCCObjMgr/Sieb01 
for comp SCCObjMgr
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The parameter ProposalReportTimeoutInSecond also affects the generation of reports. This is the 
time-out setting that controls how long the Document Server component will wait for a report to be 
generated. The default value is 1800 seconds.

(Optional) Enabling HTML Generation for Correspondence
By default, correspondence is only saved in document format, not in HTML format. In the My 
Correspondence Requests view, the View HTML command is unavailable, and the user cannot view 
the correspondence in HTML format. 

The server parameter DocumentServerViewHTML specifies whether the Document Server generates 
HTML versions of documents. The default value is FALSE. By default, the Document Server only 
generates documents in their native format, and not in HTML. To allow the user to display 
correspondence in HTML format, you must edit the parameter DocumentServerViewHTML to give it 
the value True instead of False. Any documents generated after the parameter is enabled is saved in 
both formats.

When you generate HTML documents, a copy of the generated document is created in HTML and 
stored in the Siebel File System. This may affect performance, and it will increase the storage space 
required in the File System. The clarity of the HTML document depends on your Office application’s 
ability to translate its native format into HTML.

Entering the following command allows generation of HTML versions of Correspondence, Proposals, 
and Presentations. 

To enable generation of HTML versions of documents 

1 Start the Server Manager. 

2 Enter the following command:

Srvrmgr> change param DocumentServerViewHTML=True for comp DocServer

NOTE: While this procedure uses the Server Manager, parameters can also be changed using the 
Administration - Server Configuration screen. 

(Optional) Configuring Application Recycle Period
You use the parameter MSWordLiveCount to control how often the Office applications are restarted. 

Each parameter can be set to a positive integer that specifies the number of documents to be 
processed before it shuts down and restarts the corresponding Office application. A value of 0 (the 
default) indicates that the applications will not be shut down. If the parameter value is set to any 
integer other than 0 and the Document Server fails to launch, the corresponding application will be 
shut down and then restarted again.

To change the values of these parameters

1 Start the Server Manager.

2 To change the application recycling period for Microsoft Word, which is used by Correspondence 
and Proposals, enter the following command:
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Srvrmgr> change param MSWordLiveCount=5 for comp DocServer

3 To change the application recycling period for Microsoft PowerPoint, which is used by 
Presentations, enter the following command:

Srvrmgr> change param MSPPLiveCount=5 for comp DocServer

(Optional) Specifying the Target Server
If you are running multiple Document Servers within the same enterprise, then the server 
infrastructure will route document requests to different Document Servers in order to achieve load 
balancing. 

However, it sometimes may be useful to specify that all requests be routed to one Document Server. 
For example, you can do this to help diagnose a server problem.

To route all requests to one document server 

1 Start the Server Manager. 

2 Enter the following command:

srvrmgr> change param DocumentServerName=DocSrvr1

(Optional) Enabling Additional Logging
You may want to enable additional logging. This can be helpful for debugging. 

The event logging system writes events to the log file based on the log level for each event type. The 
number you specify indicates the filtering level for logging. The default value is 3, which means that 
events with a level of 1, 2, or 3 will be logged, while events with a level of 4 or 5 will be suppressed. 
Setting the filtering level to 5 means that all events will be logged.

NOTE: In the final command on the list, the parameter must be in quotation marks, because it has 
a space in it. In the other commands, quotation marks are optional and are not included in the list.

To enable additional logging

1 Start the Server Manager. 

2 Enter the following commands: 

srvrmgr> change evtloglvl GenericLog=5 for comp Docserver

srvrmgr> change evtloglvl ProposalDebug=5 for comp Docserver

srvrmgr> change evtloglvl ProposalDetail=5 for comp Docserver

srvrmgr> change evtloglvl PresentationDebug=5 for comp Docserver

srvrmgr> change evtloglvl PresentationDetail=5 for comp DocServer

srvrmgr> change evtloglvl DocServerDebug=5 for comp DocServer
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srvrmgr> change evtloglvl DocServerDetail=5 for comp DocServer

srvrmgr> change evtloglvl CorrespDebug=5 for comp DocServer

srvrmgr> change evtloglvl CorrespDetail=5 for comp DocServer

srvrmgr> change evtloglvl MSProjectDebug=5 for comp DocServer

srvrmgr> change evtloglvl "MS ProjectDetail"=5 for comp DocServer

For more information about event logging, see System Monitoring and Diagnostics Guide for Siebel 
eBusiness Applications.
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23 Correspondence
This chapter is about administering and using Siebel Correspondence. It includes the following 
topics:

■ “About Siebel Correspondence” on page 301

■ “Scenario for Correspondence” on page 303

■ “Process of Setting Up and Using Correspondence” on page 304

■ “Creating and Updating the SIEBEL.HTML File” on page 304

■ “Creating Correspondence Templates in Microsoft Word (Admin and End User)” on page 306

■ “(Optional) Inserting Files into Correspondence Templates” on page 307

■ “Creating Correspondence Template Records in the Siebel Application” on page 308

■ “Generating Correspondence (End User)” on page 309

■ “Configuring Additional Merge Fields For Correspondence Templates” on page 312

For information about the Documentation Server and other software that is required for Siebel 
Correspondence, see Chapter 22, “Document Server.” 

About Siebel Correspondence
Siebel Correspondence allows employees and partners to generate correspondence from any location 
with access to the Web. It also makes it easy for them to direct correspondence to fulfillment centers 
that print and mail it, so they can produce and send correspondence even if they are on the road and 
do not have access to a printer. 

For example, if sales representatives want to do mass mailings to customers in cities where they are 
giving presentations, Siebel Correspondence allows them to log on from any location where they 
have Web access. Then they can create personalized form letters to invite customers in a specific 
city to a specific presentation, and direct these letters to be printed and mailed by a fulfillment 
center. 

First, an administrator creates templates (usually form letters and labels) that employees and 
partners can use for their everyday correspondence. Then, employees and partners can 
automatically generate correspondence based on this template and on data from the Contact 
business component.
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About Correspondence Templates
Siebel correspondence templates are created and edited in Microsoft Word (DOC file format). 
Correspondence templates contain fixed text and one or more merge fields. The merge fields are 
placeholders that are populated with variable information from your Siebel database, such as a 
Contact’s name and address, when users generate a correspondence for one or more recipients.

Users can create their own personal templates, and administrators can create correspondence 
templates for users. 

About Correspondence with Multiple Languages and Locales
The fixed text of each correspondence template is written using specific locale conventions and 
language. In order to support Global Deployment, the author of the correspondence template can 
explicitly indicate the locale and language using the Locale and Language fields in the 
correspondence template record. The Document Server then uses these settings to substitute 
correctly localized data into the merge fields of the correspondence template. The following types of 
fields are affected:

■ MLOV fields

■ Global data fields

■ Locale-sensitive fields, such as dates and currencies

Correspondence Terms Defined
Definitions of terms used in this chapter are given in Table 74.

Table 74. Correspondence Terminology

Term Definition

correspondence template This is a Microsoft Word file (DOC or HTM). It usually contains one or 
more merge fields. It should not contain code (including field codes 
such as ASK) or macros. 

Typically, this file contains a form letter where the address and 
salutation are merge fields that can be automatically filled in for 
multiple recipients.

label template The label template is a correspondence template specifically for a 
mailing label. Label templates are created much the same way as 
other correspondence templates, but are generated using the 
Generate Label command instead of the Generate Correspondence 
command. 

insertion template This is a Word, text, or HTML file. It may not contain any merge fields.

personal correspondence 
template

A correspondence template that users create for their own use. It 
cannot be used by others, although the administrator can view, edit, 
and delete it.
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Scenario for Correspondence
This scenario provides an example of a business process performed by an administrator and sales 
representatives managing correspondence. Your company may follow a different process according 
to its business requirements.

A company has already installed the Documentation Server and wants to make Siebel 
Correspondence available to its sales representatives so that they can send literature with 
personalized cover letters to customers who request product information.

The administrator sets up the cover letter (correspondence) template and mailing label template that 
the sales representatives will use. 

When customers request product literature, the sale representatives generate personalized cover 
letters and mailing labels and specify what literature needs to be included in the mailing. The 
customers’ name and address details are taken from the contacts list in the Siebel database.

The sales representatives review and sometimes modify the cover letter before submitting the 
correspondence to a fulfillment center where it is printed and mailed. The changes made to the cover 
letter can be saved back to the Siebel File System by saving the document.

correspondence template 
record

This is the record in the Siebel database that contains the 
correspondence template. (The correspondence template is stored in 
the Siebel File System.) These records appear in the Correspondence 
Templates and the Personal Templates views.

correspondence record This is the record in the Siebel database that contains the generated 
correspondence. A correspondence record must have a 
correspondence template record associated with it. In addition, it can 
have a label template record associated with it.

merge field Merge fields are placeholders in the correspondence template that 
are populated with information from records in the Siebel database, 
such as a contact’s last name. (These are also called mail merge 
fields.)

merge data Data from the Siebel database that is copied into the merge fields 
when correspondence is generated. 

SIEBEL.HTML file Lists the database columns used as merge fields in the most recently 
generated correspondence. (The file is updated each time 
correspondence is generated.)

When correspondence templates are created in Microsoft Word, the 
SIEBEL.HTML file is used as the data source file.

Table 74. Correspondence Terminology

Term Definition
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Process of Setting Up and Using 
Correspondence
To set up and use correspondence, perform the following tasks:

■ “Creating and Updating the SIEBEL.HTML File” on page 304

■ “Creating Correspondence Templates in Microsoft Word (Admin and End User)” on page 306

■ “(Optional) Inserting Files into Correspondence Templates” on page 307

■ “Creating Correspondence Template Records in the Siebel Application” on page 308

■ “Generating Correspondence (End User)” on page 309

■ “Configuring Additional Merge Fields For Correspondence Templates” on page 312

Creating and Updating the SIEBEL.HTML 
File

About the SIEBEL.HTML File
The SIEBEL.HTML file is the data interface between the Siebel application and Microsoft Word. During 
the document generation process, the Document Server exports merge data into the SIEBEL.HTML 
file. Microsoft Word then reads this file and inserts the data into the merge fields in the 
correspondence template.

When you create correspondence templates, the SIEBEL.HTML file that you generate from a blank 
template is used as the data source file, determining which merge fields can be added to the 
correspondence template. 

Figure 24 on page 304 shows a portion of a SIEBEL.HTML file. The column headers represent 
database fields and the cells contain the values of those fields for the mostly recently generated 
correspondence.

Administrators can augment the set of merge fields available using Siebel Tools. For information, see 
“Configuring Additional Merge Fields For Correspondence Templates” on page 312.

The SIEBEL.HTML file is not installed (out of the box). It is created in the \REPORTS directory the first 
time correspondence is generated. 

Figure 24. Part of the SIEBEL.HTML File
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Procedure for Creating or Updating the SIEBEL.HTML File
This procedure should be carried out in the following situations:

■ By the administrator before correspondence templates are created for the first time (in order to 
create the SIEBEL.HTML file)

■ By end users who use disconnected Siebel Mobile Web Clients and want to create personal 
correspondence templates on their local machines (in order to create the local SIEBEL.HTML file)

■ By the administrator after additional merge fields have been configured (See “Configuring 
Additional Merge Fields For Correspondence Templates” on page 312.)

This task is a step in “Process of Setting Up and Using Correspondence” on page 304.

To initially create (or update) the SIEBEL.HTML file by generating a blank 
correspondence template

1 In Microsoft Word, create and save a blank document. 

2 Navigate to the Correspondence screen > Personal Templates view.

3 In the Templates list, create a new record and, in the Template field, specify the blank 
correspondence template that you created in Step 1.

4 On the link bar, click My Correspondence Requests.

5 In the Correspondence list, create a new record.

6 In the Template field, select the template record that you created in Step 3.

7 Click Generate.

The SIEBEL.HTML file that is created in the \REPORTS directory contains all the database columns 
that are for use as merge fields.
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Creating Correspondence Templates in 
Microsoft Word (Admin and End User)
There are a number of starting points for creating a correspondence template in Microsoft Word:

■ An existing Microsoft document, for example a company form letter. (Make sure that the 
document does not contain any merge fields not defined in SIEBEL.HTML, or any code, or any 
macros.)

■ A new, blank Microsoft Word document

Two procedures are given in the following section: one for Microsoft Word 2000 and one for Microsoft 
XP. Both procedures explain how to add merge fields (defined in the SIEBEL.HTML file) to Microsoft 
Word documents.

This task is a step in “Process of Setting Up and Using Correspondence” on page 304.

To create a template and add merge fields in Microsoft Word 2000

1 Copy the current version of the SIEBEL.HTML file to your local hard drive, for example, to the My 
Documents directory.

2 In Microsoft Word, create a new document or open the document that you want to use as the 
starting point for your correspondence template.

3 From the Tools menu, choose Mail Merge. 

4 In the Mail Merge Helper dialog box, click Create > Form Letters. (Or, if you are creating a label 
template, choose Create > Mailing Labels.)

5 Click Active Window to use the current document.

6 In the Mail Merge Helper dialog box, click Get Data > Open Data Source and open the 
SIEBEL.HTML file.

7 Close the Mail Merge Helper dialog box.

If the template file does not yet contain merge fields, an information box states this. Click Edit 
Main Document in the box.

8 Add and edit the text in the document as required.

9 Add merge fields as required:

a Position the insertion point where you want the merge data to appear.

b Click the Insert Merge Fields button and insert the appropriate merge field. 

10 When you have finished adding merge fields, exit from mail merge mode:

a Click the Mail Merge Helper button on the Mail Merge toolbar. 

b In the Mail Merge Helper dialog box, click Create > Restore to Normal Word Document.

CAUTION: If you do not restore the document to normal mode, the Document Server can 
hang when correspondence is generated.

c Click Yes to continue.
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d Close the Mail Merge Helper dialog box.

11 Save the file with a .doc extension and close.

To create a template and add merge fields in Office XP

1 Copy the current version of the SIEBEL.HTML file to your local hard drive, for example, to the My 
Documents directory.

2 In Microsoft Word, create a new document or open the document that you want to use as the 
starting point for your correspondence template.

3 From the Tools menu, choose Letter and Mailings > Show Mail Merge Toolbar.

4 In the toolbar, click the Main document setup button.

5 In the Main Document Type dialog box, select Letters. (Or, if you are creating a label template, 
select Labels.)

6 On the Mail Merge toolbar, click the Open Data Source button and open the SIEBEL.HTML file.

7 Add and edit the text in the document as required.

8 Add merge fields as required:

a Position the insertion point where you want the merge data to appear.

b Click the Insert Merge Fields button and insert the appropriate merge field. 

9 When you have finished adding merge fields, click the Main document setup button on the Mail 
Merge toolbar and, in the Main Document Type dialog box, select Normal Word Document.

CAUTION: If you do not restore the document to normal mode, the Document Server can hang 
when correspondence is generated.

10 Save the file with a .doc extension and close.

(Optional) Inserting Files into 
Correspondence Templates
The Siebel Correspondence file insertion feature allows you to insert one or more files (called 
insertion templates) into a correspondence template. These insertion templates can be in Word, text, 
or HTML files.

You can add insertion templates containing generic content into one or many correspondence 
templates. For example, you can create a company description in a separate insertion template and 
then include it in several correspondence templates. If the description changes, you only have to 
modify the insertion template instead of every correspondence template.
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You may add as many insertion templates into a correspondence template as necessary. The file 
name for each insertion template must be unique and each insertion template must be inserted into 
the correspondence template independently. Insertion templates may not be nested. For example, 
you may insert File1.doc, File2.doc, and File3.doc into a template named FollowUp.doc. But, you may 
not insert File1.doc into File2.doc, and then insert File2.doc into FollowUp.doc.

TIP: Remember to create correspondence template records for your insertion templates as well as 
for your correspondence templates.

This task is a step in “Process of Setting Up and Using Correspondence” on page 304.

To add an insertion template into a correspondence template

1 If it does not already exist, create the insertion template using Microsoft Word. (Make sure that 
your insertion template does not contain merge fields, code, or macros.)

2 Open the correspondence template to which the insertion template is to be added.

3 Insert a separate line with the following command at the location where the insertion template 
is to be displayed:

[[File Name]] 

Do not include the file extension. For example, if insertion template is File1.doc, enter [[File1]].

4 Save the file with a .doc extension and close.

Creating Correspondence Template 
Records in the Siebel Application
In order to make the correspondence templates available to the Siebel application, they must be 
added to the Siebel File System by creating a correspondence template record. There are two views 
in the Siebel application where correspondence template records can be added:

■ Administration - Document screen > Correspondence Templates view. This view is used by the 
administrator who creates correspondence templates for multiple employees.

■ Correspondence screen > Personal Templates view. This view is used by employees who create 
correspondence templates that are only for their personal use.

TIP: Remember to create correspondence template records for your insertion templates as well as 
for your correspondence templates.

NOTE: You should always perform system administration tasks, such as administration of 
correspondence templates, against the server database. Although you can perform these tasks 
against your local database and synchronize, doing so has the potential to cause errors, including 
data conflicts. In addition, performance problems can result from a large local database, and from 
routing large numbers of transactions. 

This task is a step in “Process of Setting Up and Using Correspondence” on page 304.
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To add a template record

1 Navigate one of the following: 

■ Administration - Document screen > Correspondence Templates view

■ Correspondence screen > Personal Templates view

2 In the Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Generating Correspondence (End User)
End users generate correspondence using the administrator-defined correspondence templates or 
the personal templates that they create themselves. 

Using Microsoft Word, they can edit the template for a selected correspondence record (Modified 
Template), and they can edit the generated correspondence document. The edits made to the 
correspondence document can be saved back to the Siebel File System by saving the merged Word 
document. 

Literature can be attached to the correspondence. (For general information about Literature, see 
Chapter 28, “Literature.”) 

This task is a step in “Process of Setting Up and Using Correspondence” on page 304.

Field Comments

Active Indicates whether or not the correspondence template is available for use.

NOTE: It is recommended that you make the template inactive before 
modifying it to prevent other users from attempting to use it while you are 
modifying it. After you have finished your modifications, check the Active field 
again. 

Update File 
(or Update)

A check mark in this field indicates that mobile users will have their copy of the 
template to be updated automatically each time the original file is changed.

Template 
Name

The name of a correspondence template, label template, or insertion template.

Personal A check mark in this field specifies that the correspondence template is a 
personal correspondence template, which can only be used by the creator.

Download 
File

Allows users to request templates from the server. When a check mark appears 
in this field, the document is retrieved during the next synchronization session. 
This field applies only to Siebel Remote users.

Language The language used by the Document Server to render merge fields based on 
MLOV and Global Data Business Component fields.

Locale The locale used by the Document Server to format merged data based on locale-
sensitive business component fields, such as phone numbers. If no locale is 
specified, the application’s locale is used.
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To generate correspondence

1 Navigate to the Correspondence screen > My Correspondence Requests view.

NOTE: You can navigate to this screen from anywhere in the application by choosing File > Send 
Letter from the application-level menu. 

2 In the Correspondence list, create a new record and complete the Template field.

Some fields are described in the following table.

3 In the Recipients list, add records for the contacts or employees who you want to receive the 
correspondence.

Specifying large numbers of recipients affects performance and time required to generate the 
correspondence. 

If you create a new record in the Add Recipients dialog box, the individual is added to the 
Contacts list.

Field Comments

Document Status See Step 6.

Template Specify the name of the correspondence template that you want to use 
for the correspondence. 

Fulfillment Center Specify a fulfillment center that can produce and distribute the document 
and enclosures on your behalf. For more information, see Chapter 26, 
“Fulfillment Centers.”

Generated 
Document

After the correspondence has been generated, you can drill down on the 
hyperlink in this field to preview the document merged with the name 
and address of the selected recipient in the Recipients list.

Generated Label Drill down on the hyperlink in this field to preview the label merged with 
the name and address of the selected recipient in the Recipients list.

Label Status The system status for the label during generation. Default values include 
In Progress, Generating, Completed, and Failed.

Label Template The name of the label template defined by your company and created by 
your Siebel administrator, or your personal template.

Modified Template See Step 5.

Opportunity Specify the name of the opportunity associated with the correspondence. 
Drill down on the hyperlink in the opportunity name field to open the 
Opportunity details form.
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4 If you want to include literature in the correspondence, add records to the Enclosures list.

Literature must be of type Sales Tool* and cannot be marked as internal.

NOTE: If you are working in a Mobile Web Client environment (remote), you must have the 
literature files available in your local environment. If the Local check box is selected, you can 
work with the file in a remote environment. To download the file from the server the next time 
you synchronize, select the Request check box for the Literature record in the Enclosures list. 

5 If you want to make edits to the correspondence template that will apply to all recipients but only 
for this correspondence record, edit the file in the Modified Template field. 

This file (like the correspondence template) is stored in the Siebel File System.

6 Click Generate.

For Web Client (network connection): Because the Document Status field does not automatically 
update, click the Update button to refresh the record and see the current status of your 
correspondence. The following table lists the status values you may see.

7 For Web Client (network connection): Drill down on the Merged hyperlink in the Generated 
Document field.

Or, if you do not have Microsoft Word installed locally and do have enabled HTML generation, click 
the menu button and choose View (HTML) to display a document in your Web browser.

NOTE: If you are using the Mobile Web client, the generated correspondence opens 
automatically.

8 (Optional) Make edits to individual pages of the generated correspondence and save the changes 
back to the Siebel File System before printing, batch printing, or submitting to a fulfillment 
center.

■ For information about fulfillment centers, see Chapter 26, “Fulfillment Centers.”

■ For information about batch printing, see “About Batch Printing” on page 381.

9 (Optional) Generate labels for the correspondence:

a Complete the Label Template field.

b From the menu button, choose Generate Label.

For information about printing correspondence, see Chapter 26, “Fulfillment Centers.”

Status Meaning

In Queue Request sent to available document server.

Generating Document server is creating the Word merge document.

Completed Document is available and can be accessed from the Generated Document field.

Failed Document server encountered errors. Check the Document Error and Label 
Error fields for error messages.
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Configuring Additional Merge Fields For 
Correspondence Templates
The exported data is taken from two places:

■ If the correspondence was created from a view based on service requests, the data is taken from 
the Service Request Recipient business component.

■ If the correspondence was created from the Correspondence list view, or from a view not based 
on service requests (such as the Opportunities screen), the data is taken from the Recipients 
business component.

New fields in the Recipients business component are restricted to those based on columns in the 
S_CONTACT table or those obtained through join relationships. Joins can be added for tables that 
have a master-detail relationship with S_CONTACT, where S_CONTACT is the detail table. You need 
to add the join to the Recipients business component.

New fields in the Service Request Recipient business component are restricted to those based on 
columns in the S_CONTACT table, the S_SRV_REQ table, or columns available through joins to these 
tables.

Table 75 summarizes the contents of the two business components and the contexts in which they 
are used. For more information on adding fields, see Developing and Deploying Siebel eBusiness 
Applications and Configuring Siebel eBusiness Applications.

Table 75. Summary of Merge Fields Sources and Uses

Source Business 
Component Source Tables Used In

Recipients ■ S_CONTACT

■ Joins with tables that have a 
master-detail relationship 
with S_CONTACT (with 
S_CONTACT as the detail 
table).

Correspondence created:

■ Directly in the Correspondence 
List View

■ From any view not based on 
service requests

Service Request 
Recipient

■ S_CONTACT

■ S_SRV_REQ

■ Joins with tables that have a 
master-detail relationship 
with one of these two (with 
S_CONTACT or S_SRV_REQ 
as the detail table).

Correspondence created from views 
based on service requests.
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To configure an additional merge field

1 In Siebel Tools, add the new field to either the Recipients business component or the Service 
Request Recipient business component.

CAUTION: Make sure that the field’s database column name does not exceed 38 characters. 
(This is because Microsoft Word cannot handle merge fields with long names.)

2 Add the name of the new field to the business component’s user property called Export Field #, 
where # is an integer. 

If necessary, you can create additional user properties by incrementing the integer.

3 Update the SIEBEL.HTML file (“Creating and Updating the SIEBEL.HTML File” on page 304) before 
creating a correspondence template containing the new field.

NOTE: You can have up to 63 merge fields in the SIEBEL.HTML file; Microsoft Word does not display 
fields beyond this limit. 
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This chapter is about administering and using Siebel Presentations. It includes the following topics:

■ “About Siebel Presentations” on page 315

■ “Process of Creating Presentation Templates” on page 316

■ “About Generating Presentations (End User)” on page 334

■ “Scenario for Generating Presentations (End User)” on page 334

■ “Process of Generating Presentations (End User)” on page 335

■ “Sample Presentation Templates” on page 342

For information about the Documentation Server and other software that is required for Siebel 
Presentations, see Chapter 22, “Document Server.” 

About Siebel Presentations
Siebel Presentations allows your sales representatives to create presentations (and other types of 
documents) based on templates that you create in Microsoft PowerPoint.

Traditionally, salespeople create presentations by starting with a presentation that worked in the past 
and then modifying it for the current prospect. Salespeople must not only change such basic 
information as the customer’s name, but also possibly restructure the presentation so that it fits this 
new prospect’s unique needs. For example, the original presentation may have been focused on 
price, whereas the new prospect is more concerned with other decision criteria, such as speed or 
extra functionality. 

With Siebel Presentations, once the presentation administrator has created the right templates, the 
salesperson can click one button to build the correct presentation for a specific account or 
opportunity. Siebel Presentations uses information that salespersons have entered in the early 
stages of an opportunity to create the presentation. 

Salespeople can add deal-specific information to the presentation without worrying about formatting 
or presentation. Using the Presentation Library, salespeople can find any additional information and 
automatically insert it into the presentation. 

System Requirements for Siebel 
Presentations
Certain system requirements must be met to use Siebel Presentations.
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System Requirements for the Siebel Web Client
To use Siebel Presentations, you must have:

■ All of the components that are required to use the Siebel application installed on the server, such 
as a Siebel Server and a Web Server. 

■ The Document Server installed on one or more Windows machines.

■ Microsoft Office.

NOTE: If you are deploying the Siebel Server in UNIX and want to use Presentations, a separate 
Windows machine is required for the Document Server.

Siebel Presentations uses the Document Server, which is a component of the Siebel Server which lets 
users on the Web work with Word, and PowerPoint documents on the server. 

For more information on installing the components required to use the Siebel application, see Siebel 
Installation Guide for the operating system you are using.

Your employees or partners who use Siebel Presentations need:

■ A Web browser to use the product. 

■ Optionally, Microsoft Office to edit documents.

For information on the Web browsers that are supported by Siebel applications, see System 
Requirements and Supported Platforms on Siebel SupportWeb.

System Requirements for the Siebel Remote Web Client
Siebel Presentations is available for the Siebel Remote Web Client as well as for the Siebel Web 
Client. The user interface for Presentations is identical in the Siebel Remote Web Client and the Siebel 
Web Client. 

Siebel Remote Web Client processes requests to generate documents locally, so field sales 
representatives can generate correspondences, proposals, and presentations when they are out of 
the office. To run Siebel Presentations on the Siebel Remote Web Client, you must have Microsoft 
Office installed on the same machine as the Siebel Remote Web Client. 

Process of Creating Presentation 
Templates
To create presentation templates, perform the following tasks:

■ “Creating Template Slides in Microsoft PowerPoint” on page 317. To create the slides needed by the 
template, you must write their content and insert bookmarks for such variables as company, 
contact name, address.

■ “Creating a Record for the Presentation Template” on page 320. Use your Siebel application to 
create a single record for the template.

■ “Defining Presentation Template Sections” on page 321. Specify which sections the presentation 
should contain.
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■ “Adding Components to Presentation Template Sections” on page 327. Specify which components 
each section should contain.

■ “Using Conditions in Presentation Templates” on page 328. Optionally, you can add conditions to 
specify that sections or components are included in the presentation only under certain 
circumstances.

■ “Defining Presentation Field Mappings” on page 329. Specify which Siebel objects correspond to 
each bookmark in your PowerPoint component slides. You also specify the name of this mapping 
in the template record.

■ “Creating the Presentation Library” on page 331. In this optional step, which can be done at any 
time, you create a separate library of slides that salespeople can draw upon to customize their 
presentations.

■ “Allowing Users to Display Presentations in HTML Format” on page 334. Update settings on the 
document server to allow end users to view presentations in HTML.

Creating Template Slides in Microsoft 
PowerPoint
The first step is to create slides in Microsoft PowerPoint. These slides consist of one style slide and 
multiple component slides, as shown in Figure 25.

Figure 25. PowerPoint Slides That Can Make Up a Presentation Template
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The components shown in Figure 25 on page 317 are only examples. You could have other 
components, such as a table of contents or a set of collateral, and you could omit the quotes or 
product descriptions. However, a template must have a presentation background slide and one or 
more component slides.

NOTE: See Release Notes on Siebel SupportWeb for information about which versions of Microsoft 
PowerPoint are supported.

NOTE: Presentations can only use fields from one business object. If you want to include additional 
fields, you must use Siebel Tools to add the business components that include these fields to the 
business object that is the basis of the presentation. 

To create the template slides, you go through the following stages:

■ Planning the template. Decide what components the template should have.

■ Creating the style slide. Create the slide that gives all the template components a standard 
formatting. 

■ Creating the component slides. Create a slide for each component of the template. 

These tasks are a step in “Process of Creating Presentation Templates” on page 316.

Planning the Presentation Template
Before you create the slides in PowerPoint, you must determine how the presentation should look 
and what type of information it should contain. Begin by looking at previous successful presentations 
to see what sections they contained. For example, did they all contain an agenda, an executive 
overview slide, and a product summary slide? Next, look to see what current slides you have on 
hand, and what customer questions these pieces answer. Then decide how to organize your 
information. What topics could be standard across all presentations? What topics are specific to 
certain presentations? What is the best order for the pieces in the presentation you are creating? 
Finally, decide what fields to insert to customize their presentations (for example, contact name, 
account name, industry). You will use this information to create bookmarks in your PowerPoint slides.

Creating a Presentation Background Slide
After you plan your templates, work on the presentation background slide for this template, which 
is the slide that serves as your title slide and also specifies the background layout and formatting of 
the entire presentation. This background slide may contain your company logo, special colors and 
background designs, and headers and footers. 

NOTE: The following procedure may vary slightly, depending on your version of Microsoft 
PowerPoint.

To set up styles for your presentation template

1 Create a new slide in Microsoft PowerPoint. 

2 Since this slide will also serve as your title slide, you may want to select the title slide layout 
template and enter the title of the presentation.

3 Select the background colors and font size.
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4 Choose View > Header and Footer, and create and apply a header and a footer for your template.

5 Switch to the Master Slide view, and select formatting options that will apply to your whole 
presentation.

6 Close the Master Slide view, and return to the Slide view (choose View > Slide).

7 Save the file:

■ Choose a name that uses only alphanumeric characters. 

■ Use the .ppt extension for PowerPoint.

8 Close the file.

Creating Presentation Template Components
The next step in developing your template is to create components, the slides that make up the body 
of your presentation. 

A component is the Siebel Presentations term for a Microsoft PowerPoint presentation that includes 
standard text and personalized data. 

To create a component, you type the standard text and then create bookmarks, or Microsoft 
PowerPoint placeholders for custom data. When a salesperson generates a presentation, these 
bookmarks will be replaced with data from the Siebel application. 

NOTE: The following procedure may vary slightly, depending on your version of Microsoft 
PowerPoint.

To create a component with bookmarks

1 Create a new slide in Microsoft PowerPoint.

2 Type the standard text, pictures, bulleted information, and so on that belongs in this component.

3 Place the cursor where you want to create a bookmark.

4 Enter the following text:

[[“name of bookmark”]] 

For example, to create a bookmark for the company name, type:

[[Company]] 

5 Write down the name of the bookmark, because you will need it later when you map the 
bookmark to a Siebel field name. 

6 Repeat Step 3 through Step 5 for every bookmark you want to insert. 

NOTE: If the same field is being inserted in several places, you can copy its bookmark and paste 
it into other parts of the document.

7 Save the component slide as a PPT file.
Applications Administration Guide Version 7.7, Rev. B ■ 319



Presentations ■ Creating a Record for the Presentation Template
Creating a Record for the Presentation 
Template
After you have created your template slides in PowerPoint, you can use Siebel Presentations to 
specify how they are assembled in the template. 

This task is a step in “Process of Creating Presentation Templates” on page 316.

To create a record for the presentation template

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name Enter a name for the template. 

Default If you want this template to be the default presentation template, place a check 
mark in the Default field. When the user clicks Auto Presentation, Siebel 
Presentations uses the default template if there are no decision issues that 
match the theme of a presentation. You can only select one Opportunity 
Presentation default and one Account Presentation default.

Category Select one of the following types of templates:

■ Opportunity Presentation. These templates are available only when you 
are working with Opportunities. 

■ Account Presentation. These templates are available only when you are 
working with Accounts.

Mapping 
Name

Used to indicate the group of bookmark fields to be used with this template. 
You can leave this field blank for now, until you create a mapping.

Template 
File Name

Attach the template file.

Theme If you want to associate the template with a particular decision issue, click the 
select button in the Theme field, and select a theme from the Pick Decision 
Issue dialog box. When you give your presentation template a theme, you 
associate it with a particular decision issue that is important for your 
opportunity. When a presentation theme matches the number one decision 
issue for the current opportunity, Siebel Presentations automatically selects the 
correct template when the user clicks Auto Presentation. Users can also select 
a theme template if they want.

Because accounts do not relate to decision issues, the Theme field is not 
applicable for Account Presentation templates. It only applies to Opportunity 
Presentation templates.

Description Enter a description of the template.
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Defining Presentation Template 
Sections
Once you have created your PowerPoint slides and a record for your template, define the structure 
of your presentation template.

A presentation is made up of sections, which divide and subdivide your presentation. Depending on 
your needs, a single section might contain multiple components or a single component.

The type of a section depends on what type of data it contains. For example, file sections contain 
slides, chart sections reference Siebel charts, and so on.

You define the structure of the presentation template by creating sections in the Administration - 
Document screen > Presentation Templates view, which are associated with the Template record you 
created for this template. 

These tasks are a step in “Process of Creating Presentation Templates” on page 316.

Creating Top-Level Sections for the Presentation Template
First you must create top-level sections, then you can add subsections to these top-level sections. 
Your presentation structure can have multiple levels of sections, since a subsection can contain other 
subsections.

To create top-level sections

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Template Explorer, in the left frame, click the plus sign (+) next to the icon representing 
this template.

The Sections folder appears in the list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder. 

The Sections list appears in the right frame.

4 In the Sections list, create a new record. 

5 In the Name field, enter a name for this section.

The section name is the title of the slide for some types, such as Bullet Slide.

6 In the Sequence field, specify the order in which this section should appear in the presentation. 

Language The language in which the template was written.

Locale Only the templates specific to this locale will be shown.

Field Comments
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7 In the Section Type field, indicate the type of section you are creating. The following table 
describes the different section types available to you.

8 Complete the fields applicable to your section type. Table 76 on page 323 describes the fields that 
you should complete for each type of section.

Type Comments

Bullet Slide Creates a slide and inserts a list of Siebel data in bullet format—for example, 
a list of products the opportunity is interested in.

This section name is used as the slide title.

Chart Creates a slide and inserts a Siebel chart. The chart is automatically 
centered, and you can change x, y, and z axes. 

File Contains only presentation slides or text. If you are using PowerPoint, they 
must be in PPT, DOC, or TXT format. If you indicate text, it creates a slide 
and inserts the text.

Locator Pulls in slides or text (PPT slides or TXT files) from the Siebel Encyclopedia. 
If you create a locator section, Siebel Presentations can dynamically pull in 
slides from the marketing encyclopedia that relate to the products the 
opportunity is interested in. For example, if you want the presentation to 
dynamically insert slides related to the products on the opportunity, use a 
Locator.

The file types must be PPT, TXT, or RTF. If more than one marketing slide 
meets the Locator criteria you specify, Siebel Presentations inserts each.

Organization 
Chart

Creates a slide and pulls in Organization charts for the Account or 
Opportunity associated with the template. Charts are automatically 
centered.

Table Creates a slide and pulls Siebel data into a table format. You select fields to 
be included, the sequence of the fields, and the column length. Tables are 
automatically centered. By selecting a Table Section, you also enable 
creation of a Related Table section. See “Adding Related Table Subsections to 
the Presentation Template” on page 326.

Two-Column 
Slide

Creates a slide that puts two sections next to each other. You can, for 
example, show a list of key features of a product (a Bullet Slide section) next 
to a picture of the product (a File section). You specify the two subsections, 
which can be any of the other section types.
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9 Repeat Step 4 on page 321 through Step 8 to add all the top-level sections that are needed.

Table 76. Selected Fields for the Presentation Template Administration View

Section Type Field Comments

Bullet Slide Business Object The Siebel business object from which the information is 
taken. Select from the list, which contains all available 
business objects from your repository, or enter the name in 
the field. For example, to include a Bullet List of products 
offered with the quantity and ship date for the opportunity, 
the business object is Opportunity.

File N/A You do not need to complete any fields for this type of 
section.

Chart Business Object The Siebel business object the chart information is coming 
from (for example, Opportunity). Select from the Business 
Object list, which lists all available business objects from 
your repository.

Chart or Table 
Name

The name of the chart applet you want to insert into this 
section. For example, “Opportunity Chart Applet - Current 
Opportunity Analysis.” The list also contains all available 
applets from your repository.

Search Spec Any search criteria you want to use to restrict data for the 
chart (for example, Revenue > 500000).

Category With charts that contain multiple X-axis options, this field 
allows you to set which option to use for the X-axis. For 
example, in the Lead Analysis by Rep chart, the X-axis can 
be Sales Representative or Quality.

Function With charts that contain multiple Y-axis options, this field 
allows you to set which option to use for the Y-axis. For 
example, in the Lead Analysis by Rep chart, the Y-axis can 
be Number of Opportunities, Opportunity Revenue, or 
Average Opportunity Revenue.

Series This field allows you to set the Z-axis you wish to use for 
charts that contain multiple Z-axis options.
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Locator Information 
Retrieval 
Method

Select which relationship to use to find the literature. For 
example, Oppty Competitor, which are the slides on 
competitors associated with the opportunity.

To associate literature with a product, competitor, or 
partner, use the Literature Administration view (or the 
Decision Issue, Competitor, or Product Administration 
views).

Retrieved 
Literature 
Category

Indicate what type of literature you are looking for (for 
example, brochures, specification sheets, and so on).

This helps you to filter out the slides from the rest of the 
documents in the marketing encyclopedia, to be included in 
your presentation.

Organization 
Chart

Business Object The Siebel object from which the information is taken. 
Select from the Business Objects dialog box, which contains 
all available business objects from your repository.

Chart or Table 
Name

The name of the applet that contains the organization chart 
data. For example, the Opportunity Organization Analysis 
applet.

Table 76. Selected Fields for the Presentation Template Administration View

Section Type Field Comments
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Adding Subsections to the Presentation Template
After adding top-level sections, you may want to add subsections to one or more of them. 

Table Business Object This is the Siebel business object from which the 
information is taken. Select from the Business Objects 
dialog box, which contains all available business objects 
from your repository. 

For example, if you want to include a table of products being 
offered, with the quantity and ship date for the opportunity, 
the business object is Opportunity.

Chart or Table 
Name

The name of the applet where the table data is stored.

In the example used for Business Object, the applet is 
Opportunity Product Applet.

Table Fields Open the Table Fields dialog box and then, for each field you 
want in the table, click New and enter the following 
information:

■ The Field Name of the field; for example, Product.

■ The Sequence in which you want the field listed.

■ The Width of the column; the default (and minimum) 
width is 100 pixels. A second way to define column width 
is by percentage of the table width. When a value is 
entered into table width, column width equates to 
percentage of total table width. For example, if there are 
three fields and table width is set to 100, field widths of 
25, 65, and 35 would equate to 25%, 65%, and 35% of 
the total width of the table. In this example, if the table 
width was not set, the field widths would equate to 25, 
65, and 35 pixels.

■ The Alignment of the data in the field: Left, Center, or 
Right.

Two-Column Slide N/A Create two subsections under the section you have 
designated as Two-Column Slide. For each subsection, 
complete the fields appropriate to that type of section. For 
example, if you want to show a Chart section next to a Table 
section, create a subsection of the Chart section type (and 
complete the Chart-related fields shown in this table) and 
create a subsection of the Table type (and complete the 
Table-related fields shown in this table).

Table 76. Selected Fields for the Presentation Template Administration View

Section Type Field Comments
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To add subsections to an existing section

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Template Explorer, in the left frame, click the plus sign (+) next to the template to which 
you want to add a subsection.

The template’s Sections folder appears.

3 In the Template Explorer, click the plus sign (+) next to the Sections folder for this template. 

The Explorer displays the sections for this template, and the Sections list is displayed to the right. 

4 In the Template Explorer, click the plus sign (+) next to the section to which you want to add a 
subsection.

The Sections and Components folders appear for this template.

5 Click the plus sign (+) next to the Sections folder for this section. 

The Sections list appears, listing all subsections under this section.

6 Use the Sections list to add a subsection in the same way you used it to add a top-level section, 
as described in “Creating Top-Level Sections for the Presentation Template” on page 321.

NOTE: When a presentation generates, a section generates before any of its subsections and is 
displayed prior to a subsection in the finished presentation.

Adding Related Table Subsections to the Presentation Template
After adding a Table Name subsection, you can add related tables that provide detailed information 
for the first table. For example, if the tables subsection contains a quote record, the related table 
can contain the quote line items. The relationship between the information is essentially a parent-
child-grandchild relationship; the opportunity is the parent record, the quote table is the child, and 
the related table containing the quote line items is the grandchild.

To add a related table

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Template Explorer list, in the left frame, click the plus sign (+) next to the template to 
which you want to add a related table.

The Sections folder appears in the list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder.

The Sections list appears in the right frame.

4 In the Sections list, add a new section or edit an existing section.

5 In the Section Type field, select Table and enter the Table Name.

6 Complete all necessary fields.
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7 In the Explorer list, click the plus sign (+) next to the Related Tables folder.

NOTE: The Related Table folder in the Template Explorer is used only for the Table section type. 
This folder can be edited only if a table is already added.

8 In the Related Tables dialog box, complete the fields as described in the following table.

Adding Components to Presentation 
Template Sections
Now that you have defined the structure of your document, you must specify the location of the 
component slides that will probably make up the bulk of your presentation.

For sections that draw upon data from a Siebel database (such as Chart and Report), you have 
specified all the information necessary for Siebel Presentations to generate the appropriate contents. 
However, the component documents, which you created earlier in PowerPoint, are not part of the 
presentation until you add them to the appropriate sections.

NOTE: Components can be added to any kind of section (not just a File section), and a section can 
contain multiple components.

Components can be PPT or DOC, TXT, or RTF files. When they are not PPT files, Siebel Presentations 
creates a slide (with your template background) and imports the text into the slide. PowerPoint 
inserts the TXT and DOC files based on how you have formatted the documents. For example, 
PowerPoint inserts TXT or DOC paragraphs in the slide as paragraphs, but if your file contains TXT 
or DOC indented or bulleted paragraphs, PowerPoint attempts to create a slide for each bullet point, 
or one slide for all bullet points, depending on the formatting and carriage returns in your document.

To make sure that TXT or DOC files are inserted correctly in your PowerPoint presentation, open the 
text or PowerPoint document itself in PowerPoint and verify that the format is correct. The format 
you see when you open the file in PowerPoint will be the same format Siebel applications use in the 
presentation.

This task is a step in “Process of Creating Presentation Templates” on page 316.

To add a component to a presentation template

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Templates Explorer, in the left frame, select the template to which you want to add a 
component.

The Sections and Components folders appear for the template.

Field Comments

Business Object Select the Siebel object to which this table is related. 

Table Name Select the name of the related table applet.

Field Name Select the fields that will be displayed in this table. If none are selected, 
all fields appear.
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3 Click the plus sign (+) for the Components folder.

The Components list appears on the right.

4 In the Components list, create a new record.

The Add Sales Tools dialog box appears. 

5 In the Add Sales Tools dialog box, perform one of the following actions:

■ Select the component you want to add and click Add.

■ If your component does not appear in the dialog box, click New.

6 Complete the component fields as described in the following table.

Using Conditions in Presentation 
Templates
You can add query conditions to a section or a component to specify the conditions under which the 
section or component will be used in the presentation. For example, if you have two executive 
summaries—one for deals of over $100,000 and another for smaller deals—you can use the condition 
field in each Executive Summary section to allow Siebel Presentations to insert the appropriate 
executive summary based on which condition is true.

These tasks are a step in “Process of Creating Presentation Templates” on page 316.

Entering Criteria
You can enter query criteria in a section or component record’s Condition field (such as [Revenue] > 
100000). If the condition is TRUE, the section or component is included. If the condition is FALSE, 
the section of component is not included. 

If you do not specify a condition, the section or component is always used. 

You can create conditions for any field that relates to the business object of your presentation; use 
Opportunity fields for opportunity presentations, and Account fields for account presentations. If the 
definition of a condition needs to be based on fields from another business object, then you must 
add those fields to the Opportunity or Account business object through either a link or a join. The 
syntax for conditions is similar to the syntax for Siebel queries. For more information about the 
syntax of Siebel queries, see Fundamentals and Siebel Developer’s Reference. 

Field Comments

Name Enter a name for the component. 

Sequence Specify the order in which this component should appear in the section.

Attachment Name This field was filled in automatically when you selected a file from the 
Add Sales Tool dialog box.

Condition Enter a condition and this component will be displayed only when the 
condition is true.
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Examples of Criteria
The following examples illustrate the syntax for conditions:

■ If the opportunity is for a Pentium computer, you want to insert a component about the 
advantages of the Pentium chip. In the Condition field for this component, type the following 
condition:

EXISTS [Product] LIKE "Pentium*"

This condition would look at the products listed for the opportunity. If the product name begins 
with Pentium, Siebel Presentations would insert the component. Otherwise, Siebel Presentations 
would leave out this component.

NOTE: To use a product in a condition, the product must have been entered using the Products 
view of the Opportunities screen. The condition will not work with products that were entered as 
Quote line items. 

■ If the account is located in Georgia, you want to enter a section with terms and conditions limited 
to that state. In the section’s Condition field, you would enter the following:

EXISTS ([State] = "GA") 

or 

[State] = "GA"

You would use the first line if the account is located only in GA, and the second line if the account 
is located in GA and another location.

This condition will look at the state for the account, and if the state is GA then the section would 
be included in the presentation; otherwise, Siebel Presentations would skip this section and move 
on to the next.

■ If the opportunity has a revenue amount greater than $1,000,000 and it is expected to close this 
year, you want to insert a component on a special program for this type of customer. Enter the 
following condition in the Condition field for the component:

[Revenue] > 1000000 AND [Close Date] <= ("12/31/02") AND [Close Date] >= ("1/1/02")

After you enter a condition, test it as a query on the view you are going to use it on. For example, 
the above example involving Revenue and Close Date can be tested as a query on the My 
Opportunities view. If the query returns the data you expect, the query is probably in the correct 
format for your condition field.

Defining Presentation Field Mappings
When you created the component slides of your presentation, you probably included bookmarks for 
personalized fields. You must map the bookmarks in the template’s components to Siebel fields.

This mapping tells Siebel Presentations which Siebel field to use for substituting data for a particular 
bookmark in your presentation template. For example, by mapping the bookmark Company to the 
Account field, you tell Siebel Presentations to replace each Company bookmark with the value of the 
Account field.
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You cannot map fields to a bookmark in the template’s header or footer, unless that bookmark is also 
somewhere else in the content of the template, other than in the footer or header. 

Since you may be working with multiple presentation templates, you can have multiple sets of 
bookmarks. You could have one mapping for one presentation template and another mapping for 
another presentation, or you could use a single mapping for several presentation templates. In either 
case, you must specify a mapping name in your template record to associate the template with a 
specific mapping.

If you map a bookmark to a multi-value field, the primary record of the group is retrieved. If you 
want to retrieve multiple values from a multi-value field, you can add a Table section to the document 
template. This section type will retrieve multiple values from the multi-value field in table format. 

To map the bookmarks in a template’s components to fields, you must: 

■ Create a mapping.

■ Associate a template with the mapping. 

These tasks are a step in “Process of Creating Presentation Templates” on page 316.

Creating a Mapping
To create a field mapping, first create a record for the mapping, and then map the fields.

NOTE: For Siebel Tools objects to be accessible in the Siebel application, the Siebel repository must 
be updated in the appropriate database.

To create a record for a mapping 

1 Navigate to the Administration - Document screen > Presentation Field Mappings view. 

2 In the Business Objects list, create a new record. 

3 Complete the fields as described in the following table.

4 In the Business Objects Explorer, in the left frame, click the plus sign (+) next to the business 
object for which you created a mapping.

5 Select the Business Components folder.

Field Comments

Mapping Name Enter a name for the mapping. 

Business Object Use the Business Objects dialog box to select the business object that 
contains fields used in the presentation, and then click OK. For example, 
if you are creating an opportunity presentation, select Opportunity in the 
Business Object field.

Description Enter a description of the mapping for your own use. 
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6 In the Business Component list, create a new record and complete the fields.

NOTE: You can associate more than one business component mapping with an object. For example, 
if you are creating an opportunity presentation, you would select the Opportunity business 
component. You could also select the TAS Account business component to create mappings for views 
under the Opportunity TAS view.

Mapping the Fields
Now that you have created a record for the mapping, the next step is to map the fields.

To map the fields 

1 Navigate to the business component that contains the fields to be mapped.

2 Click the plus sign (+) next to the Business Component name.

The Business Component Fields folder appears.

3 Click the plus sign (+) next to the Business Component Fields folder.

The Business Component Fields list appears.

4 In the Business Component Fields list, create a new record and complete the necessary fields.

5 Repeat Step 4 for each field that needs to be mapped.

Associating a Mapping with a 
Presentation Template
After you have created a mapping, you must associate it with a template to make it apply to all the 
components in that template. You can associate a mapping with one or more templates. 

To associate a mapping with a presentation template

1 Navigate to the Administration - Document screen > Presentation Templates view. 

2 In the Templates list, select the template record with which you want to associate the mapping.

3 In the Mapping Name field, select the mapping you created earlier.

Creating the Presentation Library
As a presentation administrator, you create and maintain the Presentation Library, which consists of 
slides that sales representatives can add to their presentations. 
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Slides in the Presentation Library are different from the other components you created earlier, 
because components are part of the presentation template, which are automatically included in 
presentations generated from that template. Slides in the Presentation Library are available to sales 
representatives only on an as-needed basis. As an administrator, you can also recommend 
documents to include in the templates.

After sales representatives create a default presentation automatically, they can add more slides 
from the Presentation Library or use the Edit Layout command to customize the presentation. The 
Presentation Library allows multiple presentations created from the same template to have different 
contents.

As an administrator, you place the various components in the Presentation Library and maintain the 
information. When the sales representatives need additional slides to add to a presentation, they 
review the Presentation Library, select the component they want to insert, and automatically insert 
it into the presentation. 

The sales force cannot update the information in the Presentation Library. The only sections and 
components available to sales representatives are those you provide for them. 

To prepare the Presentation Library, you must:

■ Create Microsoft PowerPoint files for the Presentation Library.

■ Add sections for the Presentation Library.

■ Add components to the Presentation Library sections.

■ Recommend documents to be included in templates.

These tasks are a step in “Process of Creating Presentation Templates” on page 316.

Creating Presentation Files for the Presentation Library
You create presentation files for the Presentation Library in the same way that you create the 
presentation templates themselves. Use Microsoft PowerPoint to enter text, graphics, and 
bookmarks, and then map these bookmarks to fields in your Siebel database. 

NOTE: The only type of component that can be included in the Presentation Library is the File section 
type. Other section types (Charts, Reports, and so on) can be included only in the initial template.

Adding Sections to the Presentation Library
Sections are used to organize slides in the Presentation Library. For example, if some of the slides 
in the Presentation Library are marketing pieces and others are technical, you may want to create a 
section for each of these. Then the users will be able to browse through the marketing pieces and 
through the technical pieces separately. You must add at least one section to the Presentation 
Library. For more information about creating presentation sections, see “Defining Presentation 
Template Sections” on page 321.

To add sections to the Document Library

1 Navigate to the Administration - Document screen > Presentation Library view. 
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2 In the Library Explorer, in the left frame, click the plus sign (+) of Presentation Library.

The Sections folder appears under the Library.

3 Add the sections to this folder as needed.

Adding Components to the Presentation Library
After adding sections to the presentation library, you add components to them. 

For more information about adding presentation components, see “Adding Components to 
Presentation Template Sections” on page 327.

To add components to the Presentation Library

1 Navigate to the Administration - Document screen > Presentation Library view. 

2 Use the Library Explorer to navigate to the section to which you want to add a component.

3 Add the component to the library just as you would add a component to a presentation.

Recommending Content for a Presentation
As the administrator, you can simplify the process of creating a quick presentation by associating 
recommended content with the presentation template.

To associate recommended content with a presentation

1 Navigate to the Administration - Document screen > Presentation Library view. 

2 Use the Library Explorer to navigate to the section to which you want to add recommended 
content.

3 Open the selected section folder.

4 Click on the plus sign (+) of the Components folder. 

5 Select a component.

6 In the Components record, click in the Recommended Template field.

7 Add a Recommended Template to the Component record. You can recommend a component to 
one template or to many templates. For example, a legal clause might be required in all 
templates.

8 Repeat Step 5, Step 6, and Step 7 for each component that needs recommended content.

NOTE: Recommended templates are displayed when a presentation is edited using the Edit 
Layout command and the Show Recommended Only box is selected.
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Allowing Users to Display Presentations 
in HTML Format
By default, presentations are only saved in document format, and not in HTML format. The user’s 
View HTML button is unavailable, and the user cannot view the presentations in HTML format. 

To allow the user display presentations in HTML format, you must edit the parameter 
DocumentServerViewHTML to give it the value True instead of False. 

NOTE: Users of the Remote Client cannot view presentations in HTML format. 

To allow users to display presentations in HTML format

1 Start the Server Manager.

2 Enter the command:

Srvrmgr> change param DocumentServerViewHTML=True for comp DocServer

NOTE: While this procedure uses the Server Manager, parameters can also be changed in the 
Administration - Server Configuration screen. For more information, see Siebel System 
Administration Guide.

About Generating Presentations (End 
User)
Using template slides created by the presentation administrator, sales professionals can create, 
modify and print presentations for an opportunity, using the Opportunities screen > Presentations 
view.

Presentations automatically take details you have recorded about an account or opportunity and 
combine them with a predefined template to create a Microsoft PowerPoint presentation.

The administrator at your company creates presentation templates that include consistently 
formatted components, such as text, tables, and diagrams, that are designed to address specific 
issues. When you generate a presentation, you merge details about a specific account or opportunity 
in these predefined templates. 

After generating a presentation, you can modify it to meet your customer’s requirements by changing 
the order of slides and adding slides from the Presentation Library. If the presentation generated by 
a template is adequate, you can create and print it.

Scenario for Generating Presentations 
(End User)
This scenario provides an example of the business process performed by a sales representative 
creating presentations for prospective accounts. Your company may follow a different process 
according to its business requirements.
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A sales representative is asked by a prospective customer to deliver a presentation on service 
offerings. The sales representative has already recorded the opportunity and its related details in 
Siebel Sales, including the number one decision issue—price.

The sales representative navigates to the Opportunities screen’s Presentations view and creates a 
new presentation record. Because price is the most important decision issue, the presentation is 
based on a template that includes slides that address price issues. 

When the sales representative generates a draft of the presentation, the presentation is formatted 
according to standards established by the sales representative’s company, and includes the relevant 
slides. The sales representative makes some minor adjustments to the presentation, and saves it.

Process of Generating Presentations 
(End User)
To generate presentations, perform the following tasks:

■ “Creating a Presentation (End User)” on page 335

■ “Generating a Presentation Draft (End User)” on page 336

■ “Modifying Presentation Structure and Adding Content (End User)” on page 336

■ “Printing a Presentation (End User)” on page 341

■ “Locking a Presentation (End User)” on page 342

Creating a Presentation (End User)
Because presentations can include details about an account or an opportunity, presentations can be 
created from either the Accounts screen or the Opportunities screen.

This task is a step in “Process of Generating Presentations (End User)” on page 335.

To create a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, click Auto Presentation.

A presentation is automatically generated based on the default template. The new presentation 
record appears in the Presentations list.

NOTE: To generate a presentation using an alternate template, click New in the Presentation list and 
complete the necessary fields in the form.
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Generating a Presentation Draft (End 
User)
You can generate a presentation draft as a starting point for creating the presentation you deliver to 
a customer. The draft is a Microsoft PowerPoint presentation.

If you have Microsoft PowerPoint installed on your local computer, you can edit this presentation. If 
you do not have Microsoft PowerPoint installed, you can view the presentation, and you can add 
sections and change the order of sections, but you cannot edit slides.

If you are creating a presentation in a Siebel Web Client environment (network), follow Step 1 
through Step 4 in the following procedure.

If you are creating a presentation in a Mobile Web Client environment (remote) and have the Mobile 
Web Client installed locally on your computer, follow Step 1 through Step 3 in the following 
procedure.

This task is a step in “Process of Generating Presentations (End User)” on page 335.

To generate a presentation draft

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, select the presentation, and then 
click Generate Draft.

In Queue appears in the Status field. 

A draft of the presentation is created if you are using Siebel Mobile Client (remote environment).

4 Click Update to generate a presentation from the server if you are working in a Siebel Web Client 
(network) environment.

The status of the presentation refreshes when you click Update. Status values include In 
Progress, Generating, Completed, and Failed.

Modifying Presentation Structure and 
Adding Content (End User)
After creating and viewing a draft of a presentation, end users may decide that they want to change 
the order of the sections or add new sections.

The following tasks describe how to view, modify, and add content to the presentation:

■ “Viewing the Structure of a Presentation” on page 337

■ “Adding Content to the Presentation” on page 337

■ “Changing the Order of Sections in a Presentation” on page 338

■ “Adding Components to a Presentation” on page 339
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■ “Modifying a Presentation Component” on page 341

These tasks are a step in “Process of Generating Presentations (End User)” on page 335.

Viewing the Structure of a Presentation
End users can view the structure of a presentation in the Presentation Table of Contents view, which 
allows viewing of the hierarchy of sections and components that make up the presentation. 

Sections represent the main points of a presentation, and each section can consist of subsections 
and components. Components are the slides used in each section. In some cases, sections can also 
be set up to generate slides.

To view the structure of a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field.

The Presentation Table of Contents appears showing the structure of the presentation.

3 In the Presentation Table of Contents explorer, click the plus sign (+) next to each section to 
expand sections and components.

Adding Content to the Presentation
If an administrator has created slides and included them in the Presentation Library, end users can 
customize the presentation by adding one or more of these slides using the Edit Layout command.

To add content to the presentation

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, select the presentation, and then 
click Edit Layout.

The Template Layout dialog box appears, displaying two columns:

■ The Content Library lists the components in the Presentation Library that can be included in 
the presentation.

■ The Table of Contents column lists the components in the Presentation Library that are 
selected for the presentation and the order in which they will be displayed.
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4 In the Content Library column, use the directional buttons to move selected sections from the 
Content Library column into the Table of Contents column. If you make a mistake, click Reset 
Layout to undo all changes to the Table of Contents column. When you are finished, click Save.

NOTE: If the Show Recommended Only check box is selected, only those components 
recommended by the administrator are displayed. If this box is empty, all available components 
are displayed. For more information, see “Allowing Users to Display Presentations in HTML Format” 
on page 334.

5 In the Presentations list, select the presentation, and then in the presentation record, drill down 
on the hyperlink in the Name field to view the new content.

Changing the Order of Sections in a Presentation
When end users add a section to a presentation, the section numbers are not automatically 
resequenced. If a section is inserted within the current sequence, end users must modify each 
sequence number. The sequence numbers in the Presentations list determine the order in which 
sections and components appear. 

There are two methods that can be used to resequence presentation sections and components:

■ Edit Layout.

■ Presentation Table of Contents.

To use Edit Layout

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, select the presentation in the Presentations list, and then click 
Edit Layout.

4 In the Template Layout dialog box, use the sequencing arrows to change the order of the 
sections, and then click Save.

To use Presentation Table of Contents

1 Navigate to Opportunities screen, and in the Opportunities list, select the opportunity associated 
with the presentation.

2 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

3 In the Presentation Table of Contents explorer, click the plus sign (+) to expand each section.

4 In the Sections list, select a section, and change the number in the Sequence field.

To remove sections in a presentation

1 Navigate to the Opportunities screen > Opportunities List view.
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2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentation Table of Contents explorer, click the plus sign (+) to expand the sections.

5 In the Sections list, select the section and click Delete.

NOTE: You can also use the Edit Layout command to remove content from a presentation. For 
more information, see “To use Edit Layout” on page 338.

Adding Components to a Presentation
Components are the slides that make up presentations. Components can be added to sections from 
the Presentation Library, the Siebel Encyclopedia, or from another location, such as a local hard 
drive. More than one component can be added to a section.

The Presentation Library offers a hierarchical structure that administrators can use when designing 
literature components that can be associated with a presentation. Using the Presentation Library, end 
users can navigate to a section or subsection and select the component file associated with the 
section.

To add a component to a presentation

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentations Table of Contents explorer, click the plus sign (+) next to the presentation 
you want to change. 

The Sections folder appears. 

5 Click the plus sign (+) next to the Sections folder.

Each section associated with the presentation appears in the Sections list. 

6 Click the plus sign (+) next to the section to which you want to add a component.

7 In the Sections list, click Library.

The Presentation Library view appears.

8 In the Presentation Library explorer, click the plus sign (+) for Presentation Library. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where the presentation is located. 

c Click the plus sign (+) next to the Components folder.

The list of components for that section appears. 
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9 In the Components list, select the component and then click Add Components.

The component file is added to the Components folder located in the section you selected.

To add a Siebel Encyclopedia component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the presentation.

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click New.

6 In the Add Sales Tools dialog box, select each record you want to add and then click Add.

NOTE: Only PPT files can be added as components directly into a template section.

To add a component from another location

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit.

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the presentation.

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the next to the section where you want to add a new file.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click New.

6 In the Add Sales Tools dialog box, click New.

7 In the Components list, enter a name and sequence for the file, and then click the select button 
in the File Name field to attach the file.

8 Attach the file using the Add Attachment dialog box.
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Modifying a Presentation Component
End users can modify a component file if they have Microsoft PowerPoint installed locally on their 
computer. End users must have the application that was used to create the component. 

To modify a presentation component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Name field of the presentation you want to edit. 

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the presentation. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, drill down on the hyperlink in the File Name field.

6 In the File Download dialog box, click Open to begin editing the file. Make any necessary edits 
and do one of the following:

a Click Save to save the file. If the Local check box is selected for this component, the file will be 
updated in the Siebel application.

b Click Save As to save the file to your local hard drive and then:

❏ In the Components list, select the component (saved locally), click Edit, and locate the 
modified component.

❏ Select the modified component, and then add it.

The old component is replaced with the new one.

Printing a Presentation (End User)
After generating a presentation, and the status is Completed, end users can print the presentation. 

This task is a step in “Process of Generating Presentations (End User)” on page 335.

To print a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the presentation you want to print.

2 Click the Presentations view tab, and in the Presentations list, drill down on the hyperlink in the 
Draft Name field of the presentation you want to print.

The presentation appears in the application in which it was created. 
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3 From the application, print the presentation.

Locking a Presentation (End User)
Lock allows end users to secure the completed presentation, making the presentation read-only and 
unable to be edited. Only the presentation’s author, the author’s manager, that manager’s manager, 
and so on, can unlock or modify the presentation.

This task is a step in “Process of Generating Presentations (End User)” on page 335.

To lock the presentation

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the presentation.

3 Click the Presentations view tab, and in the Presentations list, select the presentation.

4 In the presentation record, select the check box in the Locked field.

NOTE: If the Locked check box does not appear, click the menu button in the Presentations list, and 
then choose Columns Displayed. For more information about using Columns Displayed, see 
Fundamentals.

Sample Presentation Templates
Siebel Business Applications come with a sample database. The Administration - Document screen 
> Presentation Templates view includes several sample document templates.

These sample presentations can be used as a reference when defining your own presentation 
template. In this sample database you will find the following Siebel Presentations sample 
presentations: 

■ Corporate Presentation (Opportunity category)

■ Corporate Presentation - Account (Account category)
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This chapter is about administering and using Siebel Proposals. It includes the following topics:

■ “About Siebel Proposals” on page 343

■ “System Requirements for Siebel Proposals” on page 344

■ “Process of Creating Proposal Templates” on page 345

■ “Creating Proposal Template Documents in Microsoft Word” on page 346

■ “Creating Records for Proposal Templates” on page 351

■ “Defining Proposal Template Sections” on page 352

■ “Adding Components to Proposal Template Sections” on page 358

■ “Using Conditions in Proposal Templates” on page 359

■ “Defining Proposal Field Mappings” on page 360

■ “Associating a Mapping with a Proposal Template” on page 363

■ “Creating the Proposal Library” on page 363

■ “Allowing Users to Display Proposals in HTML Format” on page 365

■ “Scenario for Generating Proposals (End User)” on page 366

■ “Process of Generating Proposals (End User)” on page 366

■ “Creating a Proposal (End User)” on page 367

■ “Generating a Proposal Draft (End User)” on page 367

■ “Modifying and Adding Content to a Proposal (End User)” on page 368

■ “Printing a Proposal (End User)” on page 372

■ “Locking a Proposal (End User)” on page 373

■ “Sample Proposal Data: Field Mappings and Templates” on page 373

For information about the Documentation Server and other software that is required for Siebel 
Proposals, see Chapter 22, “Document Server.” 

About Siebel Proposals
Siebel Proposals allows your sales representatives to create proposals (and other types of 
documents) based on templates that you create in Microsoft Word.
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Traditionally, sales representatives create proposals by starting with a proposal that worked in the 
past and then modifying it for the current prospect. Sales representatives must not only change such 
basic information as the customer’s name, but also possibly restructure the proposal so that it fits 
the new prospect’s unique needs. For example, the original proposal may have been focused on price, 
whereas the new prospect is more concerned with other decision criteria, such as speed or extra 
functionality. 

With Siebel Proposals, after the proposal administrator has created the right templates, the sales 
representative can click one button to build the correct proposal for a specific account or opportunity. 
Siebel Proposals uses information that sales representatives have entered in the early stages of an 
opportunity to create the proposal. 

Sales representatives can add deal-specific information to the proposal without worrying about 
formatting or presentation. Using the Proposal Library, sales representatives can find any additional 
information and automatically insert it into the proposal. 

NOTE: The Siebel proposal document engine is also used to create agreement documents. 
Administrators who create the agreement templates can follow the steps in this chapter for creating 
proposals. Users can then select the agreement template and generate an agreement document.

System Requirements for Siebel 
Proposals
Certain system requirements must be met to use Siebel Proposals.

System Requirements for the Siebel Web Client
To use Siebel Proposals, you must have:

■ All of the components that are required to use the Siebel application installed on the server, such 
as a Siebel Server and a Web Server. 

■ The Document Server installed on one or more Windows machines.

■ Microsoft Office installed on the Document Server machine.

NOTE: If you are deploying the Siebel Server in UNIX and want to use Siebel Proposals, a separate 
Windows machine is required for the Document Server.

Siebel Proposals uses the Document Server, which is a new component of the Siebel Server that lets 
users on the Web work with Word documents that are on the server. 

Your employees or partners who use Siebel Proposals need:

■ A Web browser to use the product 

■ Optionally, Microsoft Office to edit documents

For information on the Web browsers that are supported by Siebel applications, see System 
Requirements and Supported Platforms on Siebel SupportWeb.
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System Requirements for the Siebel Remote Web Client
Siebel Proposals is available for the Siebel Remote Web Client as well as for the Siebel Web Client. 
The user interface for Proposals is identical in the Siebel Remote Web Client and the Web Client. 

Siebel Remote Web Client processes requests to generate documents locally, so that field sales 
representatives can generate correspondences, proposals, and presentations while traveling. To run 
Siebel Proposals on the Remote Web client, you must have Microsoft Office installed on the same 
machine as the Remote Web Client. 

Process of Creating Proposal Templates
To create templates, you perform the tasks shown in Figure 26:

1 “Creating Proposal Template Documents in Microsoft Word” on page 346. To create the documents 
needed by the template, you must write the text and insert bookmarks for such variables as 
company, contact name, and address.

2 “Creating Records for Proposal Templates” on page 351. Use your Siebel application to create a 
single record for the template. 

3 “Defining Proposal Template Sections” on page 352. Specify which sections the proposal should 
contain.

4 “Adding Components to Proposal Template Sections” on page 358. Specify which components each 
section should contain. 

5 “Using Conditions in Proposal Templates” on page 359. Optionally, you can add conditions to 
specify that sections or components are included in the proposal only under certain 
circumstances.

6 “Defining Proposal Field Mappings” on page 360. Specify which Siebel objects correspond to each 
bookmark in your Word component documents. You also specify the name of this mapping in the 
template record.

7 “Associating a Mapping with a Proposal Template” on page 363. Associate the mapping with a 
template to make it apply to all the components in that template. 

Figure 26. Siebel Proposal Process Flow
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8 “Creating the Proposal Library” on page 363. In this optional step, which can be performed at any 
time, you create a separate library of documents that sales representatives can draw upon to 
customize their proposals.

9 “Allowing Users to Display Proposals in HTML Format” on page 365. Update settings on the 
document server to allow end users to view proposals in HTML.

Creating Proposal Template Documents 
in Microsoft Word
The first step for creating proposal templates is to create documents in Microsoft Word. These 
documents consist of one style document and multiple component documents, as shown in Figure 27.

The components shown in Figure 27 are only examples. You could have other components, such as 
a table of contents or a set of collateral, and you could omit the quotes or product descriptions, for 
example. However, a template must have a style document and one or more component documents. 

NOTE: See Release Notes on Siebel SupportWeb for information about which versions of Microsoft 
Word are supported.

To create the template documents, you perform the following tasks:

Figure 27. Word Documents That Can Make Up a Proposal Template
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■ Planning the template. Decide what components the template should have.

■ Creating the style document. Create the document that gives all the template’s components 
a standard format. 

■ Creating the component documents. Create a document for each component of the template.

These tasks are a step in “Process of Creating Proposal Templates” on page 345.

Planning the Proposal Template
Before you create the documents in Word, you must determine how the proposal should look and 
what type of information it should contain. 

Begin by looking at previous successful proposals to see what sections they included. For example, 
did they all have a cover letter, an executive summary, and a quote? Also, look at the documents 
your company currently has on hand, and the customer questions these pieces answer. Then decide 
how to organize your information. What topics could be standard across all proposals? What topics 
are specific to certain proposals? What is the best order for the pieces in the proposal you are 
creating? Finally, decide what fields to insert to customize their proposals (for example, contact 
name, account name, and industry). You will use this information to create bookmarks in your Word 
documents.

As part of your planning, you should look at the sample templates that come with Siebel Proposals, 
which are described in “Sample Proposal Data: Field Mappings and Templates” on page 373.

NOTE: Proposals use fields from only one business object. If you want to include additional fields, 
you must use Siebel Tools to add the business components that include these fields to the business 
object that is the basis of the proposal.

Creating a Styles Document
After you plan your template, you work on the styles document for the template. This Word document 
will define the layout of your proposal and may include such things as headers, footers, your logo, 
and special margins.

The layout options you specify will automatically be applied to all the components used in the 
proposal.

NOTE: Do not type any content into this document. The content will come from the individual 
component documents that you will create later.

To set up styles for your template

1 Create a new document in Microsoft Word. 

2 Set up margins, headers, footers, fonts, and other layout options for your template.

3 When you are finished creating styles, save the file:

■ Choose a name that uses only alphanumeric characters. 

■ Use the .doc extension for Microsoft Word.

4 Close the file.
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Creating Components for Proposal Templates
The next step in developing your template is to create components, which are the text pieces that 
make up the body of your proposal. 

A component is a Microsoft Word document that includes standard text and personalized data. For 
example, a cover letter component includes your standard cover-letter text and personalized data 
such as the name and address of the contact to whom the letter is addressed.

To create a component, you type the standard text and then create bookmarks, or Microsoft Word 
placeholders for custom data. When a sales representative generates a proposal, these bookmarks 
will be replaced with data from the Siebel application. 

NOTE: The following procedures may vary slightly, depending on your version of Microsoft Word. 
Microsoft Word 2003 is supported for Siebel 7.5.3, 7.7.2 and 7.8. If you are using Microsoft Word 
2003, begin with the procedure “To create a component with bookmarks in Microsoft Word 2003” on 
page 348. If you are not using Microsoft Word 2003, begin with the procedure “To create a component 
with bookmarks in Microsoft Word versions other than 2003” on page 350.

To create a component with bookmarks in Microsoft Word 2003

1 In Microsoft Word, create a new document and do one of the following:

a Select an item to which you want to assign a bookmark.

b Click where you want to insert a bookmark.

2 From the Insert menu, choose Bookmark.

3 In the Bookmark dialog box, in the Bookmark name field, enter or select a name for the 
bookmark.

NOTE: Bookmark names must begin with a letter and may contain numbers if desired. They 
cannot include spaces. You can use the underscore character to separate words.

4 Click Add.
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5 From the Insert menu, choose Field.

6 From the Categories drop-down list, click Links and References, and then click Ref in the Field 
names list.

7 Click the Field Codes button.

REF appears in the Field codes field.

8 In the Field codes field, enter the name of your bookmark after REF. 

For example, you might type Company for company name, so that the Field codes field contains: 

REF Company

NOTE: If the text inserted into a bookmark contains double quotes ("), the inserted text will 
automatically be preceded by a backslash (\). If you do not want the backslash to appear in the 
inserted text, change the double quotes to single quotes in the Siebel software.

9 Note the name of the bookmark; you will need it when you map the bookmark to a Siebel field 
name.

10 Select the Preserve formatting during updates check box if you want to maintain the format of 
the merged text.

11 Click OK to insert the field. 

12 Repeat Step 2 on page 348 through Step 11 to add bookmarks for every field you want to insert 
in the text. 

NOTE: If the same field is being inserted in several places, you can copy its bookmark and paste 
it into other parts of the document.

13 Save the component document as a DOC file.
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To create a component with bookmarks in Microsoft Word versions other than 2003

1 In the Microsoft Word document, enter the standard text that belongs in this component.

2 Place the cursor where you want to create a bookmark, and choose Insert > Field. 

3 Click Links and References in the Categories list, and then click Ref in the Field Names list.

REF appears in the Description field.

4 In the Comments box, enter the name of your bookmark after REF. 

For example, you might type Company for company name, so that the Comments box contains: 

REF Company

The bookmark name must begin with a letter; it cannot begin with a number.

NOTE: If the text inserted into a bookmark contains double quotes ("), the inserted text will 
automatically be preceded by a backslash (\). If you do not want the backslash to appear in the 
inserted text, change the double quotes to single quotes in the Siebel software.

5 Note the name of the bookmark, because you will need it when you map the bookmark to a Siebel 
field name.

6 Select the Preserve formatting during updates check box if you want to maintain the format of 
the merged text.

7 Click OK to insert the field. 

In your document, the following message appears:

Error! Reference source not found.

This message is Word’s normal bookmarking convention. The error text will be replaced by 
appropriate data at the time of draft generation.

Type the name of your 
bookmark after REF.
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8 Repeat Step 2 on page 350 through Step 7 to add bookmarks for every field you want to insert in 
the text. 

NOTE: If the same field is being inserted in several places, you can copy its bookmark and paste 
it into other parts of the document.

9 Save the component document as a DOC file.

Creating Records for Proposal Templates
After you have created your template documents in Word, you can use Siebel Proposals to specify 
how they are assembled in the template. 

This task is a step in “Process of Creating Proposal Templates” on page 345.

To create a record for the proposal template

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Templates list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Name Enter a name for the template. 

Default If you want this template to be the default proposal template, select this 
check box. When the user clicks Auto Proposal, Siebel Proposals uses the 
default template if there are no decision issues that match the theme of a 
proposal. You can select only one Opportunity Proposal default and one 
Account Proposal default.

Category Select one of the following types of templates:

■ Opportunity Proposal. These templates are available only when you 
are working with Opportunities. 

■ Account Proposal. These templates are available only when you are 
working with Accounts.

■ Agreement. These templates are available when you are working with 
Siebel Professional Services Agreements.

■ Quote. These templates are available only when you are working with 
Quotes.

■ Order. These templates are available only when you are working with 
Orders.

Mapping Name Used to indicate the group of bookmark fields to be used with this 
template. Leave this field blank until you create a mapping.
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Defining Proposal Template Sections
After you have created your Word documents and a record for your template, define the structure of 
your proposal template.

A proposal is made up of sections, which divide and subdivide your proposal. Depending on your 
needs, a single section might contain multiple components or a single component.

The type of a section depends on the nature of the data it contains. For example, file sections contain 
documents, chart sections reference Siebel charts, report sections reference Siebel reports, and so 
on.

You define the structure of the proposal template by creating sections in the Administration - 
Document screen > Proposal Templates view, which are associated with the template record you 
created for this template. You must create top-level sections. Optionally, you can add subsections to 
these. Your proposal structure can have multiple levels of sections, because a subsection can contain 
other subsections.

These tasks are a step in “Process of Creating Proposal Templates” on page 345. 

Creating Top-Level Sections for Proposal Templates
First, you must create top-level sections. 

To create top-level sections

1 Navigate to the Administration - Document screen > Proposal Templates view. 

Template File 
Name

The Word template document. (This is the style document.)

Theme If you want to associate the template with a particular decision issue, click 
the select button to open the Pick Decision Issue dialog box and then pick 
a theme. When you give your proposal template a theme, you associate it 
with a particular decision issue that is important for your opportunity. 
When a proposal theme matches the number one decision issue for the 
current opportunity, Siebel Proposals automatically selects the correct 
template when the user clicks Auto Proposal. Users can also select a theme 
template if they want.

Because accounts and agreements are not related to decision issues, the 
Theme field is not applicable for Account Proposal, Agreement, Quote, or 
Order templates. It is used only for Opportunity Proposal templates.

Description Enter a description of the template.

Language The language in which the template was written.

Locale Only the templates specific to this locale will be shown.

Field Comments
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2 In the Template Explorer list, in the left frame, click the plus sign (+) next to the template record 
that you created for this proposal.

The Sections folder appears in the Explorer list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder.

The Sections list appears in the right frame.

4 In the Sections list, create a new record.

5 In the Name field, enter a name for the section, which will not appear in the proposal itself.

6 In the Sequence field, specify the order in which this section should appear in the proposal.

7 In the Section Type field, indicate the type of section you are creating. 

The following table describes the section types available.

8 Complete the fields applicable to your section type. 

Table 77 describes the fields that you should complete for each type of section.

Type Comments

Chart Inserts a Siebel chart. The chart can be placed in the left margin, right 
margin, or centered, and you can change the x, y, and z axes. 

File Contains only proposal text in DOC or TXT format.

Locator Pulls in documents from the Siebel Encyclopedia. For example, if you create 
a locator section, Siebel Proposals can dynamically pull in documents from 
the encyclopedia that are related to the products the opportunity is 
interested in. For instance, if you want the proposal to dynamically insert 
text related to the products on the opportunity, use a locator. The file types 
must be DOC, TXT, or RTF. If more than one marketing document meets the 
locator criteria you specify, Siebel Proposals inserts each.

Organization 
Chart

Creates a slide and pulls in organization charts for the account or 
opportunity associated with the template. Charts are automatically 
centered.

Report Dynamically inserts a Siebel report (such as Siebel Quote). 

When inserting reports, the Proposal engine converts the Actuate report to 
HTML and inserts the HTML version as a table in your proposal. When 
designing reports to be included in Siebel Proposals, you may want to review 
headers and footers, because HTML sometimes crops these.

Only Actuate reports can be included. Microsoft Access reports cannot be 
included.

Table Pulls Siebel application data into a table format. You select fields to be 
included, the sequence of the fields, and the column length. By selecting a 
table section, you also allow creation of a related table section. See “Adding 
Related Table Subsections to Proposal Templates” on page 357.
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9 Repeat Step 4 on page 353 through Step 8 to add all the top-level sections that are needed.

Table 77. Selected Fields in the Proposal Template Administration View

Section Type Field Comments

All Condition Conditions can be applied to all section types. For 
information about conditions, see “Using Conditions in 
Proposal Templates” on page 359.

File N/A Only the Condition field is applicable.

Chart Business Object The Siebel business object from which the chart information 
is coming (for example, Opportunity). Select from the 
Business Objects dialog box, which lists all available Siebel 
business objects.

Chart or Table 
Name

The name of the chart applet you want to insert into this 
section (for example, “Opportunity Chart Applet - Current 
Opportunity Analysis”). The list contains all available 
applets.

Search Spec Any search criteria you want to use to restrict data for the 
chart. For example, Revenue > 500000.

Width How wide the chart should be in the proposal document. The 
default width is 400 pixels. 

Height How high the chart should be in the proposal document. The 
default height is 300 pixels. 

Category With charts that provide multiple X-axis options, this field 
allows you to set the option to use for the X-axis. For 
example, in the Lead Analysis by Rep chart, the X-axis can 
be Sales Representative or Quality.

Function With charts that provide multiple Y-axis options, this field 
allows you to set the option to use for the Y-axis. For 
example, in the Lead Analysis by Rep chart, the Y-axis can 
be Number of Opportunities, Opportunity Revenue, or 
Average Opportunity Revenue.

Series This field allows you to set the Z-axis you wish to use for 
charts that provide multiple Z-axis options.

Chart Location Location of the chart on the proposal page: Left, Right, or 
Center. Any text components you include in your chart 
section will wrap around the chart. For example, if you put 
your chart on the left, the text component will be inserted to 
the right of the chart.
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Locator Information 
Retrieval 
Method

Select the relationship to use to find literature. For example, 
Oppty Competitor Lit, which is the literature on competitors 
associated with the opportunity.

Retrieved 
Literature 
Category

Indicate the type of literature you are looking for (for 
example, brochures, or specification sheets). This helps you 
to filter out the documents from the encyclopedia that you 
want to include in the proposal. 

Organization 
Chart

Business Object The Siebel object from which the information is taken. Select 
from the Business Objects dialog box, which contains all 
available business objects from your repository. 

Chart or Table 
Name

The name of the applet that contains the organization chart 
data. For example, the Opportunity Organization Analysis 
applet.

Report Business Object The Siebel business object from which the report 
information is coming (for example, Opportunity). Select 
from the Business Objects dialog box, which lists all 
available Siebel business objects. For example, to include a 
quote report in your proposal, you would select Quote.

Report Name The name of the report you want to insert in this section. 
Select from the Reports dialog box, which shows all available 
reports. For example, you might choose Proposal Quote.

Link Spec Specifies the data to insert in your report. In the previous 
quote example, the Link Spec is Opportunity, Id/Quote, 
Opportunity Id. The syntax of the Link Spec is:

<Parent Business Component Name><Comma><Parent-
ID Field Name><Slash><Child Business Component 
Name><Comma><Child-ID Field Name> 

Descriptions of these fields can be found in Siebel Tools 
Online Help. The Child-ID-Field-Name may vary, depending 
on whether the relationship between your parent business 
component and child business component is one-to-many or 
many-to-many. You or your system administrator can find 
Link Spec information in the Siebel Repository.

You can include only Actuate reports.

Search Spec The search criteria. For example, if you want to insert only 
the Active Quotes for the Opportunity, your Search Spec is 
Active = ‘Y’.

Table 77. Selected Fields in the Proposal Template Administration View

Section Type Field Comments
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Adding Subsections to Proposal Templates
After adding top-level sections, you may want to add subsections to one or more of them. 

Table Business Object This is the Siebel object from which the information is taken. 
Select from the Business Objects dialog box, which contains 
all available business objects from your repository. For 
example, if you want to include a list of products being 
offered to the opportunity, the business object is 
Opportunity.

Chart or Table 
Name

This is the name of the applet where the table data is stored.

In the example used for Business Object, the applet is 
Opportunity Product Applet.

Width Width represents a percentage of the space available 
between the template margins. If you choose 100, that 
equates to 100% of the space between the template 
margins. If you enter 125, that represents 125% of the 
space between the borders.

If left blank, the width of the columns in the table is based 
on pixels.

Table Fields Click the select button to open the Table Fields dialog box; 
then, for each field you want in the table, add a new record 
and enter the following information:

■ The Field Name of the field; for example, Product.

■ The Sequence in which you want the field listed.

■ The Width of the column in the table; column Width is 
measure in pixels. The default (and minimum) column 
width is 100 pixels. A second way to define column width 
is by percentage of the table width. When a value is 
entered into table width, column width equates to 
percentage of total table width. For example, if there are 
three fields and table width is set to 100, field widths of 
25, 65, and 35 would equate to 25%, 65%, and 35% of 
the total width of the table. In this example, if the table 
width was not set, the field widths would equate to 25, 
65, and 35 pixels.

■ The Alignment of the data in the field: Left, Center, 
Right.

Table 77. Selected Fields in the Proposal Template Administration View

Section Type Field Comments
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To add subsections to an existing section

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Template Explorer list, in the left frame, click the plus sign (+) next to the template to 
which you want to add a subsection.

The Sections folder appears in the list.

3 In the Template Explorer, click the plus sign (+) next to the Sections folder for this template. 

The Explorer list shows the sections for this template, and the Sections list appears to the right. 

4 In the Template Explorer, click the plus sign (+) next to the section to which you want to add a 
subsection.

The Sections, Related Table, and Components folders for this section appear in the list.

5 Click the plus sign (+) next to the Sections folder for this section. 

The Sections list appears, listing all subsections under this section.

6 Use the Sections list to add a subsection in the same way you used it to add a top-level section, 
as described in “To create top-level sections” on page 352.

NOTE: When a proposal is generated, a section is generated before any of its subsections and is 
displayed above a subsection in the finished document.

Adding Related Table Subsections to Proposal Templates
After adding a Table Name section, you can add related tables that provide detailed information for 
the first table. For example, if the tables subsection contains a quote record, the related table can 
contain the quote line items. The relationship between the information is essentially a parent-child-
grandchild relationship; the opportunity is the parent record, the quote table is the child, and the 
related table containing the quote line items is the grandchild.

To add a related table

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Template Explorer list in the left frame, click the plus sign (+) next to the template to 
which you want to add a related table.

The Sections folder appears in the list.

3 In the Explorer list, click the plus sign (+) next to the Sections folder.

The Sections list appears in the right frame.

4 In the Sections list, add a new section or edit an existing section.

5 In the Section Type field, select Table and enter the table name.

6 Complete all necessary fields.
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7 In the Explorer list, click the plus sign (+) next to the Related Table folder.

NOTE: The Related Table folder in the Template Explorer is used only for the Table section type. 
This folder can be edited only if a table has already been added.

8 In the Related Tables dialog box, complete the fields as described in the following table.

Adding Components to Proposal 
Template Sections
Now that you have defined the structure of your document, you must specify the location of the 
component documents that will probably make up the bulk of your proposal.

For sections that draw on data from a Siebel database (such as Chart and Report), you have specified 
all the information necessary for Siebel Proposals to generate the appropriate contents. However, 
the component documents, which you created earlier in Word, are not part of the proposal until you 
add them to the appropriate sections.

NOTE: Components can be added to any kind of section (not just a File section), and a section can 
contain multiple components.

This task is a step in “Process of Creating Proposal Templates” on page 345.

To add a component to a proposal template

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Templates Explorer, in the left frame, click the plus sign (+) next to the template to which 
you want to add a component.

3 Click the plus sign (+) next to the Sections folder.

4 Click the plus sign (+) next to the particular section that will include a component.

The Sections, Related Table, and Components folders appear.

5 Click the plus sign (+) next to the Components folder.

The Components list appears on the right.

6 In the Components list, create a new record.

Field Comments

Business Object Select the Siebel object to which this table is related. 

Table Name Select the name of the related table applet.

Field Name Select the fields to be displayed in this table. If none are 
selected, all fields appear. The width is interpreted the 
same way as the parent table section. If the width of the 
table section is set, the width of the fields is used as 
percentages instead of pixels.
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7 In the Add Sales Tools dialog box, select the component you want to add and click Add.

8 If your component does not appear in the list, click New and complete the fields as described in 
the following table.

Using Conditions in Proposal Templates
You can add query conditions to a section or a component to specify the conditions under which the 
section or component will be used in the proposal. For example, if you have two executive 
summaries—one for deals of over $100,000 and another for smaller deals—you can use the Condition 
field in each Executive Summary section to allow Siebel Proposals to insert the appropriate executive 
summary based on the condition that is true.

These tasks are a step in “Process of Creating Proposal Templates” on page 345.

Entering Criteria
You can enter query criteria in a section or component record’s Condition field (such as [Revenue] > 
100000). If the condition is TRUE, the section or component is included. If the condition is FALSE, 
the section or component is not included. 

If you do not specify a condition, the section or component is always used. 

You can create conditions for any field that is related to the business object of your proposal; use 
Opportunity fields for opportunity proposals, and Account fields for account proposals. If the 
definition of a condition needs to be based on fields from another business object, you must add 
those fields to the Opportunity, Account, Order, or Quote business object through either a link or a 
join. 

The syntax for conditions is similar to the syntax for Siebel queries. 

For more information about the syntax of Siebel queries, see Fundamentals and Siebel Developer’s 
Reference. 

Examples of Criteria
The following examples illustrate the syntax for conditions:

Field Comments

Name Enter a name for the component. 

File Name This field was filled in automatically when you selected a 
file from the Add Sales Tool dialog box.

Sequence Specify the order in which this component should appear in 
the section.

Condition Enter a condition and this component will be displayed only 
when the condition is true.
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■ If the opportunity is for a Pentium computer, you want to insert a component about the 
advantages of the new Pentium II chip. In the Condition field for this component, type the 
following condition:

EXISTS [Product] LIKE "Pentium*"

This condition would look at the products listed for the opportunity. If the product name began 
with Pentium, Siebel Proposals would insert the component. Otherwise, Siebel Proposals would 
leave out this component.

NOTE: For you to use a product in a condition, the product must have been entered using the 
Products view of the Opportunities screen. The condition will not work with products that were 
entered as Quote line items. 

■ If the account is located in Georgia, you should enter a section with terms and conditions limited 
to that state. In the section’s Condition field, you enter the following:

EXISTS ([State] = "GA") 

or 

[State] = "GA"

You use the first line if the account is located only in Georgia, and the second line if the account 
is located in Georgia and another location.

This condition will look at the state for the account. If the state is Georgia, then the section is 
included in the proposal. Otherwise, Siebel Proposals skips this section and moves on to the next.

■ If the opportunity has a revenue amount greater than $1,000,000 and it is expected to close this 
year, you should insert a component on a special program for this type of customer. Enter the 
following condition in the Condition field for the component:

[Revenue] > 1000000 AND [Close Date] <= ("12/31/2003") AND [Close Date] >= ("1/1/
2003")

After you enter a condition, test it as a query in the view you are going to use it in. For example, 
the above example involving Revenue and Close Date can be tested as a query in the My 
Opportunities view. If the query returns the data you expect, the query is probably in the correct 
format for your Condition field.

Defining Proposal Field Mappings
When you created the component documents of your proposal, you probably included bookmarks for 
personalized fields. You must map the bookmarks in the template’s components to Siebel fields.

This mapping tells Siebel Proposals which Siebel field to use for substituting data for a particular 
bookmark in your proposal template. For example, by mapping the bookmark Company to the 
Account field, you tell Siebel Proposals to replace each Company bookmark with the value of the 
Account field.

You cannot map fields to a bookmark in the template’s header or footer unless that bookmark is also 
somewhere else in the content of the template, other than in the footer or header. 
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Because you may be working with multiple proposal templates, you can have multiple sets of 
bookmarks. Therefore, you might have one mapping for one proposal template and another mapping 
for another proposal. Or you might use a single mapping for several proposal templates. In either 
case, you must specify a mapping name in your template record to associate the template with a 
specific mapping.

If you map a bookmark to a multi-value field, the primary record of the group is retrieved. If you 
want to retrieve multiple values from a multi-value field, you can add a Table section to the proposal 
template. This section type will retrieve multiple values from the multi-value field in table format. 

To map the bookmarks in a template’s components to fields, you must perform the following tasks:

■ Create a mapping 

■ Associate a template with the mapping

These tasks are a step in “Process of Creating Proposal Templates” on page 345.

NOTE: You may want to base your mappings on the sample mappings that come with Siebel 
Proposals, which are described in “Sample Field Mappings” on page 374. 

Creating a Mapping
To create a field mapping, first create a record for the mapping, and then map the fields.

NOTE: For Siebel Tools objects to be accessible in the Siebel application, the Siebel repository must 
be updated in the appropriate database.

To create a record for a mapping

1 Navigate to the Administration - Document screen > Proposal Field Mappings view. 

2 In the Business Objects list, create a new record and complete the necessary fields.

Some fields are described in the following table.

3 In the Business Objects Explorer, click the plus sign (+) next to the business object for which you 
just created a mapping.

The Business Components folder for this business object appears.

4 Click the plus sign (+) next to this Business Components folder.

The Business Components list for this business object appears. 

Field Comments

Mapping Name Enter a name for the mapping. 

Business Object Select the business object that contains fields used in the proposal. For 
example, if you are creating an opportunity proposal, select Opportunity 
from the Business Objects dialog box.

Description Enter a description of the mapping for your own use. 
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5 In the Business Component list, create a new record and complete the necessary fields.

Some fields are described in the following table.

NOTE: You can associate more than one business component mapping to an object. For example, if 
you are creating an Opportunity proposal, you select the Opportunity business component. You can 
also select the TAS Account business component to create mappings for views under the Opportunity 
TAS view.

Mapping the Fields
Now that you have created a record for the mapping, the next step is to map the fields.

To map the fields 

1 Navigate to the Business Component that contains the fields to be mapped.

2 Click the plus sign (+) next to the Business Component name.

The Business Component Fields folder appears.

3 Click the plus sign (+) next to the Business Component Fields folder.

The Business Component Fields list appears.

4 In the Business Component Fields list, create a new record and complete the necessary fields.

Some fields are described in the following table.

5 Repeat Step 4 for each field that needs to be mapped.

For samples, see “Sample Field Mappings” on page 374.

Field Comments

Business Component The business components must be related to the 
business object. 

Search Specification The search specification limits the records returned 
from the business component. If the search 
specification is not entered, all records from the 
business component will be returned.

Field Comments

Bookmark The bookmark you have added to the Word document.

Business Component 
Field

The fields contained in the business component.
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Associating a Mapping with a Proposal 
Template
After you have created a mapping, you must associate it with a template to make it apply to all the 
components in that template. You can associate a mapping with one or more templates. 

This task is a step in “Process of Creating Proposal Templates” on page 345.

To associate a mapping with a template

1 Navigate to the Administration - Document screen > Proposal Templates view. 

2 In the Templates list, select the record for the template with which you want to associate the 
mapping.

3 In the Mapping Name field, select the mapping you created earlier.

Creating the Proposal Library
As a proposal administrator, you create and maintain the Proposal Library, which consists of pieces 
of text that sales representatives can add to their proposals. In the Siebel File System, these pieces 
of text are components of the File section type.

Documents in the Proposal Library are different from the other components you created earlier, 
because components are parts of the proposal template, which are automatically included in 
proposals generated from that template. Documents in the Proposal Library are available to sales 
representatives only on an as-needed basis. As an administrator, you can also recommend 
documents to include in the templates. 

After sales representatives create a default proposal automatically, they can add more documents 
from the Proposal Library or use the Edit Layout command to customize the default proposal. The 
Proposal Library allows multiple proposals created from the same template to have different 
contents, and it can help sales representatives find answers to specific Request for Proposal (RFP) 
questions.

As an administrator, you place the various components in the Library and maintain the information. 
When the sales representatives need additional text to add to a proposal, they review the documents 
in the Library, select the component they want to insert, and automatically insert it into the proposal. 

The sales force cannot update the information in the Library. The only sections and components 
available to sales representatives are those you provide for them.

To prepare the Proposal Library, you must:

■ Create document files for the Proposal Library

■ Add sections for the proposal Proposal Library

■ Add components to the Proposal Library sections

■ Recommend documents to be included in templates

These tasks are a step in “Process of Creating Proposal Templates” on page 345.
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Creating Document Files
You create document files for the Proposal Library in the same way that you create the proposal 
templates themselves. Use Microsoft Word to enter text and bookmarks, and then map these 
bookmarks to fields in your Siebel database. 

NOTE: The only type of section that can be included in the Proposal Library is of the File section type. 
Other section types (Charts, Reports, and so on) can be included only in the template as described 
in “Defining Proposal Template Sections” on page 352.

Adding Sections to the Proposal Library
Sections are used to organize documents in the Proposal Library. For example, if some of the 
documents in the Proposal Library are white papers and others are specifications, you may want to 
create a section for each of these. Then the users will be able to browse through the white papers 
and through the specifications separately. You must add at least one section to the Proposal Library. 
For more information about adding sections, see “Defining Proposal Template Sections” on page 352.

To add sections to the Proposal Library

1 Navigate to the Administration - Document screen > Proposal Library view. 

2 In the Library Explorer, in the left frame, click the plus sign (+) next to the Library folder, if that 
folder is not already open.

3 Click the plus sign (+) next to the Proposal Library.

The Sections folder appears under it.

4 Click the plus sign (+) next to the Sections folder.

5 Add sections to this folder just as you added sections for the proposal.

Adding Components to the Proposal Library
After adding sections to the Proposal Library, you add components to them. 

To add components to the Proposal Library

1 Navigate to the Administration - Document screen > Proposal Library view. 

2 Use the Library Explorer to navigate to the section to which you want to associate a component.

3 Add the component to the library just as you would add a component to a proposal.

Recommending Content for a Proposal
As the administrator, you can simplify the process of creating a quick proposal by associating 
recommended content with the proposal template.
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To associate recommended content with a proposal

1 Navigate to the Administration - Document screen > Proposal Library view. 

2 Use the Library Explorer to navigate to the section to which you want to add recommended 
content. 

3 Open the selected section folder.

4 Click the plus sign (+) next to the Components folder. 

5 Select a component.

6 In the Components record, click the Recommended Templates field.

7 Add a Recommended Template to the Component record. You can recommend a component to 
one template or to many templates. For example, a legal clause might be required in all 
templates.

8 Repeat Step 5, Step 6, and Step 7 for each component that needs recommended content.

NOTE: Recommended contents are displayed when a proposal is edited using the Edit Layout 
command and the Show Recommended Only check box is selected.

Allowing Users to Display Proposals in 
HTML Format
By default, proposals are saved only in document format, not in HTML format. The user’s View HTML 
button is unavailable, and the user cannot view the proposals in HTML format. 

To allow the user display proposals in HTML format, you must edit the parameter 
DocumentServerViewHTML to give it the value True instead of False. 

NOTE: Users of the Remote Client cannot view proposals in HTML format. 

To allow users to display proposals in HTML format

1 Start the Server Manager.

2 Enter the command:

Srvrmgr> change param DocumentServerViewHTML=True for comp DocServer

NOTE: While this procedure uses the Server Manager, parameters can also be changed in the 
Administration - Server Configuration screen. For more information, see Siebel System 
Administration Guide.
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Scenario for Generating Proposals (End 
User)
This scenario provides an example of the business process performed by a sales representative 
creating proposals for accounts. Your company may follow a different process according to its 
business requirements.

A software company receives a Request for Proposal (RFP) from a prospect interested in outsourcing 
part of the information technology department. The sales representative assigned to the RFP selects 
the opportunity in Siebel Sales, and then creates a new proposal record based on the organization’s 
standard template for proposals. 

The sales representative composes a draft of a proposal that meets the requirements of the RFP, 
adding sections such as a cover letter, executive summary, the proposal body, and sections that 
outline the company’s experience, and references. After conferring with sales team members, the 
sales representative modifies the proposal, changing the order of some of the sections, and adding 
other sections from the Proposal Library.

Process of Generating Proposals (End 
User)
Using proposal templates created by the proposal administrator, sales representatives can create, 
modify and print proposals for an opportunity, using the Opportunities screen > Proposals view.

A proposal is an offer to sell products or services with specific terms and conditions. A proposal can 
be long or short, simple or complex. Even a simple proposal consists of several sections such as a 
cover letter, an executive summary, and a price quotation.

A proposal takes the details you have recorded about an account or opportunity and combines them 
with a predefined template to create a document tailored to the customer’s needs. The template 
defines the initial formatting and structure of your proposal and can include predefined components, 
such as text, tables, and diagrams. It can also be set up to include files from the Proposal Library, 
such as product descriptions and standard terms and conditions. After generating a proposal, you 
can modify it to meet your customer’s requirements.

To generate proposals, perform the following tasks:

■ “Creating a Proposal (End User)” on page 367 (Required)

■ “Generating a Proposal Draft (End User)” on page 367 (Required)

■ “Modifying and Adding Content to a Proposal (End User)” on page 368 (Optional)

■ “Printing a Proposal (End User)” on page 372 (Optional)

■ “Locking a Proposal (End User)” on page 373 (Optional)
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Creating a Proposal (End User)
Before end users can generate a draft of the proposal, they must create a proposal and associate the 
proposal with an opportunity or account. The following procedure explains how to create a proposal 
using the Opportunities screen as an example. The Accounts screen could be used as well.

This task is a step in “Process of Generating Proposals (End User)” on page 366.

To create a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, click Auto Proposal.

Auto Proposal automatically generates a proposal based on a default template or Decision Issue 
associated with the opportunity.

NOTE: To generate a proposal based on a different template, in the proposal record select a different 
template from the Template drop-down list.

Generating a Proposal Draft (End User)
After creating a proposal, end users can generate a proposal draft. The draft is a standard word 
processing document that can be edited if Microsoft Word is installed on the end user’s computer.

End users creating a proposal in a Siebel Web Client environment (network connection) should follow 
Step 1 through Step 4.

End users creating a proposal in a Mobile Web Client environment (remote) who have the Mobile Web 
Client installed locally should follow Step 1 through Step 3.

This task is a step in “Process of Generating Proposals (End User)” on page 366.

To generate a proposal draft

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and click Generate 
Draft.

In Queue appears in the Status field. 

A draft of the proposal is created if you are in Mobile Web Client environment (remote).

4 Click Update to generate a proposal from the server if you are working in a Siebel Web Client 
network environment.

The status of the proposal refreshes when you click Update. Status values include In Progress, 
Generating, Completed, and Failed.
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Modifying and Adding Content to a 
Proposal (End User)
After creating and viewing a draft of a proposal, end users may decide to change the order of the 
sections, or add new sections.

The following tasks describe how to view, modify, and add content to the proposal:

■ “Viewing the Structure of a Proposal” on page 368

■ “Adding Content to the Proposal” on page 368

■ “Changing the Order of Sections in a Proposal” on page 369

■ “Adding Components to a Proposal” on page 370

■ “Modifying a Proposal Component” on page 372

These tasks are a step in “Process of Generating Proposals (End User)” on page 366.

Viewing the Structure of a Proposal
End users can view the structure of a proposal in the Proposal Table of Contents view, which allows 
viewing of the hierarchy of sections and components that make up a proposal when it is generated. 

Sections are the headings that appear in the proposal. Sections can contain subsections and 
components. Components consist of the actual written information that appears in the proposal. A 
component can contain multiple files. 

To view the structure of a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and drill down on 
hyperlink in the Name field.

The Proposal Table of Contents appears, showing the structure of the proposal. 

4 In the explorer pane, click the plus sign (+) next to each section to expand sections and 
components.

Adding Content to the Proposal
If an administrator has created optional sections in the Proposals Library, end users can customize 
the proposal by adding one or more of these sections. The Edit Layout command allows end users to 
add content to a proposal using the Proposal Library.
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To add content from the Proposal Library

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and click Edit Layout.

4 In the Template Layout dialog box, to display more items in the Content Library list, clear the 
Show Recommended Only check box. 

NOTE: If the Show Recommended Only check box is selected, only those component templates 
recommended by the administrator are displayed. If this check box is cleared, all available 
components are displayed. For more information, see “Sample Proposal Data: Field Mappings and 
Templates” on page 373.

5 In the Template Layout dialog box, move items from the Content Library pane to the Table of 
Contents pane, and then click Save.

6 In the Proposals list, drill down on the proposal name to open the Proposal Table of Contents view 
to see the new content.

Changing the Order of Sections in a Proposal
When end users add a section to a proposal, the sequence numbers are not automatically 
regenerated. If a section is inserted within the current sequence, each sequence number must be 
modified. The sequence numbers in the Proposals list determine the order in which sections and 
components appear. There are two methods that can be used to resequence proposal sections and 
components:

■ Edit Layout.

■ Proposal Table of Contents.

To use Edit Layout

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal and click Edit Layout.

4 In the Template Layout dialog box, use the sequencing arrows to change the order of the 
sections.

NOTE: The Show Recommended Only check box is automatically selected in the Template Layout 
dialog box only if there are recommended components in the list. Otherwise, the check box is 
cleared.

To use Proposal Table of Contents

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.
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3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand each section.

5 In the Sections list, change the number in the Sequence field for each selected section.

To remove sections in a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand each section.

5 In the Sections list, select the section and click Delete.

NOTE: You can also use the Edit Layout command to remove content from a proposal. For more 
information, see “To use Edit Layout” on page 369.

Adding Components to a Proposal
Section components are the boilerplate text that make up a proposal. To add components, 
components must already be associated with the section. End users can add components to sections 
from the Proposals Library, from the Siebel Encyclopedia, or from another location, such as a local 
hard drive. More than one component can be added to a section.

The Proposal Library offers a hierarchy structure that administrators can use when designing 
literature components that can be associated with a proposal. Using the Proposal Library, end users 
can navigate to a section or subsection, and then select the component file associated with the 
section. 

To add a component to a proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposals Table of Contents explorer, click the plus sign (+) next to show the hierarchy of 
the proposal you want to change.

The Sections folder appears.

5 Click the plus sign (+) to expand the Sections folder.

Each section associated with the proposal appears in the Sections list. 

6 Click the plus sign (+) to expand the section that will contain the new component.
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7 In the Sections list, click Library.

The Proposals Library view appears.

8 In the Proposals Library Explorer, click the plus sign (+) for Proposals Library. 

a Click the plus sign (+) next to the Sections folder.

b Click the plus sign (+) next to the section where the proposal is located.

The list of components for that section appears. 

9 In the Components list, click the plus sign (+) next to the Components folder, select the 
component in the list, and then click Add Components.

The component file is added to the Components folder located in the section you selected.

To add a Siebel Encyclopedia component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand the proposal 
contents.

a Click the plus sign (+) next to the Sections folder to expand the folder.

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then choose New Record.

The Add Sales Tools dialog box appears.

6 In the Add Sales Tools dialog box, select each record you want to add, and then click Add.

NOTE: Only DOC and TXT files can be added as components directly into a template section.

To add a component from another location

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) next to the proposal to expand 
the proposal.

a Click the plus sign (+) next to the Sections folder.

b Click the plus sign (+) next to the section where you want to add a new file.
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c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then choose New Record.

6 In the Add Sales Tools dialog box, click New. 

7 In the Components form, enter a name and sequence for the file, and then click the select button 
in the File Name field to attach the file.

8 Attach the file using the Add Attachment dialog box.

Modifying a Proposal Component
End users can modify a component file if they have Microsoft Word for Proposals installed locally on 
their computer. End users must have the same application that was used to create the component. 

To modify a component

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Name 
field of the proposal you want to edit.

4 In the Proposal Table of Contents explorer, click the plus sign (+) next to the proposal. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file from the 
Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, select the component, and then drill down on the File Name hyperlink.

6 In the File Download dialog box, click Open to begin editing the file. Make any necessary edits 
and do one of the following:

a Click Save to save the file. If the Local check box is selected for this component, the file will be 
updated in the Siebel application.

b Click Save As to save the file to your local hard drive and then:

❏ In the Components list, select the component (saved locally), click Edit, and locate the 
modified component.

❏ Select the modified component, and then add it.

The old component is replaced with the new one.

Printing a Proposal (End User)
After generating a proposal, and the status is Completed, end users can print the proposal to send 
to the prospective customer.
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This task is a step in “Process of Generating Proposals (End User)” on page 366.

To print a proposal

1 Navigate to the Opportunities screen, and in the Opportunities list, select the opportunity 
associated with the proposal you want to print.

2 Click the Proposals view tab, and in the Proposals list, drill down on the hyperlink in the Draft 
Name field of the proposal you want to print.

The proposal opens in Microsoft Word.

3 Print the proposal using Microsoft Word.

Locking a Proposal (End User)
Lock allows end users to secure the completed proposal, making the proposal read-only and unable 
to be edited. Only the proposal author, the author’s manager, and that manager’s manager, and so 
on, can modify or unlock the proposal.

This task is a step in “Process of Generating Proposals (End User)” on page 366.

To lock the proposal

1 Navigate to the Opportunities screen > Opportunities List view.

2 Drill down on the opportunity associated with the proposal.

3 Click the Proposals view tab, and in the Proposals list, select the proposal.

4 In the proposal record, select the check box in the Locked field.

NOTE: If the Locked check box does not appear, click the menu button in the Proposals list, and then 
choose Columns Displayed.

Sample Proposal Data: Field Mappings 
and Templates
To help you create your first proposal, your Siebel application includes sample data. 
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Sample Field Mappings
The Administration - Document screen > Proposal Field Mappings view includes two mappings: 
Opportunity and Account. These mappings list common fields you can use in creating your proposal. 
Table 78 and Table 79 show these mappings.

Use the Bookmark name in your Word document when you create a bookmark (for example, REF 
Company) and select this mapping for the Proposal Templates you create. It will match to the Siebel 
Business Component field (for example, Account) in your proposal draft with that assigned mapping.

Sample Templates
Siebel Business Applications come with a sample database. Both the Opportunities screen > 
Proposals view and the Accounts screen > Proposals view include several sample proposal templates 
for Microsoft Word. 

Table 78. For Business Object: Opportunity, Business Component: Opportunity

Bookmark Business Component Field

Company Account

Address Street Address

City City

State State

ZipCode Postal Code

Country Country

Industry Industry

Table 79. For Business Object: Account, Business Component: Account

Bookmark Business Component Field

Company Account

Address Street Address

City City

State State

ZipCode Postal Code

Country Country

Industry Industry

Account Type Type
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These sample proposals can be used as a reference when you define your own proposal template. In 
this sample database, you will find the following Siebel Proposals sample proposals: 

■ Standard

■ Standard Account

■ Strategic

■ Quality Strategic Account

The sample templates fall into the following categories: 

■ Standard: Oppty Ppsl

■ Standard Account: Acct Ppsl

■ Strategic: Oppty Ppsl

■ Opportunity Account Plan: Oppty Ppsl

■ Quality Strategic Account: Acct Ppsl

Seed Templates
Customers using the Target Account Selling Module (TAS) can run an Opportunity Plan report in 
Microsoft Word using the TAS Opportunity Plan template. This proposal template is available in the 
seed database. For more information on setting up the TAS Opportunity Plan template, see the 
Upgrade Guide for the operating system you are using.
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26 Fulfillment Centers
This chapter is about setting up and using fulfillment centers to print and distribute documents 
generated through Siebel Correspondence or Siebel Proposals. It includes the following topics:

■ “About Fulfillment Centers” on page 377

■ “Process of Setting Up and Using Fulfillment Centers” on page 377

■ “Adding Fulfillment Center Records” on page 378

■ “Giving the Fulfillment Center Access to Siebel Correspondence and Siebel Proposals” on page 378

■ “Sending Correspondence to a Fulfillment Center” on page 379

■ “Monitoring Fulfillment Requests” on page 379

■ “Recalling Submitted Correspondence” on page 380

About Fulfillment Centers
When your users have completed correspondence and want to send it to the recipient, either they 
can print out and mail the letter themselves, or they can direct their correspondence to a fulfillment 
center that prints and mails it for them. A fulfillment center might be a division of your company, 
such as your marketing department. 

You might want to use a fulfillment center for several reasons:

■ To allow your users to produce correspondence in any location where they can access the 
Internet, even if they do not have a printer. 

■ To save your users time, since they do not have to print out and mail their correspondence.

■ To create consistency in your company’s outgoing correspondence.

■ To allow one location to fulfill all requests for collateral and literature materials included with 
correspondence as enclosures.

If you have set up fulfillment centers, the user can generate correspondence and then click Submit 
to submit the correspondence for fulfillment. When the user clicks Submit, the Status Field of the 
correspondence request changes to Submitted, and the request becomes read-only. You cannot 
make any further changes in it without using the Recall command.

Process of Setting Up and Using 
Fulfillment Centers
To set up and use a fulfillment center, perform the following tasks:

■ “Adding Fulfillment Center Records” on page 378
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■ “Giving the Fulfillment Center Access to Siebel Correspondence and Siebel Proposals” on page 378

■ “Sending Correspondence to a Fulfillment Center” on page 379

■ “Monitoring Fulfillment Requests” on page 379

■ “Recalling Submitted Correspondence” on page 380

Adding Fulfillment Center Records
You must create one or more fulfillment center records, so users can select a fulfillment center when 
they create a correspondence request.

This task is a step in “Process of Setting Up and Using Fulfillment Centers” on page 377.

To add a fulfillment center

1 Navigate to the Administration - Data screen > Fulfillment Centers view. 

2 In the Fulfillment Centers list, create a new record and complete the fields. Some fields are 
described in the following table. 

Giving the Fulfillment Center Access to 
Siebel Correspondence and Siebel 
Proposals
The fulfillment team at the fulfillment center must monitor pending fulfillment requests. Everything 
submitted by a requestor is visible to the fulfillment team in the Fulfillment screen.

Fulfillment center employees fulfill the request by viewing and printing the correspondence request 
and including the enclosures listed. The fulfillment center employees may either print the enclosure, 
or get an already-printed copy (if the enclosure is a glossy brochure, for instance). 

Field Comments

Name Enter the name of the fulfillment center.

Main Phone # Enter the telephone number of the fulfillment center.

Main Fax # Enter the fax number of the fulfillment center.

Fulfillment 
Team

Use the Fulfillment Team dialog box to select one or more employees at the 
fulfillment center. If necessary, click New to add employees to this dialog box. 
After you have selected the employees, click Close. 

These people will be able to view correspondence submitted to this fulfillment 
center. If there is no one on a fulfillment team, no one will be able to see 
correspondence submitted to this fulfillment center.

Description Enter a description of the fulfillment center.
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If you have licensed Siebel Workflow, you can create a workflow to send email to the fulfillment 
center automatically whenever there is a new request for it to fulfill.

This task is a step in “Process of Setting Up and Using Fulfillment Centers” on page 377.

To give the fulfillment center access to Siebel Correspondence

1 Set up fulfillment center employees as Siebel Correspondence users, in the same way that you 
set up your own employees or your channel partners as Siebel Correspondence users. For more 
information about setting up users of Siebel applications, see Security Guide for Siebel eBusiness 
Applications. 

2 Give fulfillment center employees a responsibility that lets them see the Fulfillment screen. Use 
the responsibility in the seed data named Fulfillment Center Employee. For more information 
about responsibilities, see Chapter 3, “Initial Setup.”

3 Tell fulfillment center employees what URL they should use to view correspondence through the 
Internet.

Sending Correspondence to a Fulfillment 
Center
When the fulfillment center has access to Siebel Correspondence, you can submit fulfillment requests 
from the Correspondence list. 

This task is a step in “Process of Setting Up and Using Fulfillment Centers” on page 377.

To send correspondence to a fulfillment center

1 Navigate to the Correspondence screen > My Correspondence Requests view.

2 In the Correspondence list, select the correspondence that you want to submit to your fulfillment 
organization. 

3 Select the appropriate fulfillment center from the correspondence record’s Fulfillment Center 
drop-down list.

4 Click Submit.

The Document Status changes to In Queue.

Monitoring Fulfillment Requests
When you submit correspondence to a fulfillment center, the status of the correspondence is set to 
Submitted. When your correspondence request is fulfilled, the fulfillment center updates the status 
to Completed, which associates an activity with each recipient (contact). You can monitor the status 
to determine the date and time that your correspondence was sent and time your follow-up calls and 
sales visits accordingly.

This task is a step in “Process of Setting Up and Using Fulfillment Centers” on page 377.
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To monitor fulfillment requests

1 Navigate to the Correspondence screen > My Correspondence Requests view.

2 In the Correspondence list, select the correspondence record, and then verify that Completed 
appears in the Status field.

Similarly, a fulfillment center manager monitors the status of pending requests by looking at the 
entry in the Status column of records in the Fulfillment screen.

Recalling Submitted Correspondence
You can recall correspondence records that you have submitted, as long as the correspondence 
records have not been fulfilled. You can recall correspondence to modify it and resubmit it for 
fulfillment.

This task is a step in “Process of Setting Up and Using Fulfillment Centers” on page 377.

To recall correspondence

1 Navigate to the Correspondence screen > My Correspondence Requests view.

2 In the Correspondence list, select the correspondence you want to recall.

3 Click the menu button, and then click Recall.

The Status field value reverts from Submitted to In Progress. 
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This chapter is about setting up and using batch printing for documents generated by the Document 
Server (Correspondence, Proposals, and Presentations). It includes the following topics:

■ “About Batch Printing” on page 381

■ “Setting Up Batch Printing for Administrators and Users” on page 382

■ “Batch Printing Instructions for Administrators” on page 382

■ “Configuring Printers for Server-Based Batch Printing” on page 383

■ “Batch Printing Instructions for End Users” on page 384

About Batch Printing
Batch printing simplifies the task of printing multiple correspondence items. The user first selects 
one or more correspondence items, and then selects the Print option from the menu button. The 
documents are then printed on the appropriate printer. 

Siebel applications support two types of batch printing, server-based and client based. Initially, the 
print menu item appearing in the Correspondence and Fulfillment screens is configured to perform 
client-based batch printing. However, the administrator can use Siebel Tools to reconfigure these 
menus to use server-based batch printing, either in addition to, or instead of, client-based batch 
printing.

Client-Based Batch Printing
When a user prints a document using client-based batch printing, the Siebel application launches 
Microsoft Word on the user’s client system. It then retrieves the document from the Siebel File 
System and prints it to the default printer configured for the user’s desktop session.

For this feature to work correctly, the end user must configure the browser to allow the Siebel 
application to launch Microsoft Word. This requires changing the security option called “Initialize and 
script ActiveX controls not marked safe” to either Enable or Prompt for the security zone containing 
the Siebel application URL. Typically, this is either the “Local intranet” zone or the “Trusted” zone. 
Users should verify that any other URL in this zone can be trusted with this security privilege.

Server-Based Batch Printing
When a user prints a document using server-based batch printing, a request is sent to the DocServer 
server component. This component then prints the document to the printer specified by the user in 
User Preferences. If the user has not specified a preference, the document is printed on the default 
printer configured on the Document Server machine by the system administrator.
Applications Administration Guide Version 7.7, Rev. B ■ 381



Batch Printing ■ Setting Up Batch Printing for Administrators and Users
Setting Up Batch Printing for 
Administrators and Users
Table 80 lists procedures for setting up batch printing for both administrators and end users. 
Administrators need to set up server-based batch printing; end users need to set up both server-
based and client-based batch printing.

Batch Printing Instructions for 
Administrators
As an administrator, you need to set up the server-based batch printing function.

To add server Print menu items to the Correspondence and Fulfillment screens

1 Start Siebel Tools.

2 In the Object Explorer window, under Siebel Objects, select Applet.

3 In the Applets window on the right, enter “Correspondence List Applet” in the Name column and 
click Query.

4 In the Object Explorer, select Applet Method Menu Item.

5 In the Applet Method Menu Item window, enter “Server Printer” in the Menu Text column and 
click Query.

6 Highlight the record and clear the Inactive check box in the Inactive column.

7 In the Applet Method Menu Item window, enter Server Print Label in the Menu Text column and 
click Query.

8 Highlight the record, and clear the Inactive check box in the Inactive column.

9 In the Application menu, click Tools and select Compile Projects, and then in the Project Selection 
window, pick project Corresp (SSE). 

Table 80. Procedures for Setting Up Batch Printing

Setup Procedures for Administrators Setup Procedures for End Users

Add server Print menu items to the 
Correspondence and Fulfillment screens.

Verify system requirements for client-based 
batch printing.

Set up the printer configuration. Configure Internet Explorer to permit client-
based batch printing.

Add a printer connection to the Document 
Server machine.

Add a printer connection to the desktop for 
client-based batch printing.

Change the default printer (if necessary). Change the default printer (if necessary).

Specify a printer for server-based batch printing.
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10 Browse and select the appropriate siebel.srf file, and click Compile.

11 Repeat Step 3 to Step 10 for the Fulfillment screen, querying for Fulfillment List Applet in the 
Applet window.

12 Verify that Server Printer and Server Print Label menu items appear in the applet menus of the 
Correspondence and Fulfillment screens.

Configuring Printers for Server-Based 
Batch Printing
When a user invokes server-based batch printing on a correspondence document, a request is sent 
to the DocServer component. This request contains the values for the Default Printer and Printer 
Driver preferences the user has selected in the Siebel Correspondence User Preferences screen. After 
receiving the request, Document Server uses Microsoft Word to convert the document into a 
PostScript file. The style of PostScript generated is determined by the value for the Printer Driver 
user preference. This parameter specifies the name of a network printer. The PostScript file 
generated by Microsoft Word is suitable for this printer and all other printers of the same model. After 
the PostScript file is generated, Document Server sends the file to the printer specified in the Default 
Printer user preference.

As an administrator, you need to complete the following tasks to support server-based batch printing.

1 Identify the printer models within your enterprise that will be used for server-based batch 
printing.

2 For each model, select one network printer and add a printer connection to it on the Document 
Server machine.

3 Designate one configured printer as the default printer for the Document Server machine.

4 Provide the list of configured printers to end users, who will use this list to select a Printer Driver 
in User Preferences.

For example, an organization has five Xerox Model A printers, named xrx001 to xrx005, and five 
Canon Model B printers, named cnn001 to cnn005. A printer server named hqsrvr is used to route 
requests to all of the printers. The administrator decides to use xrx005 to represent the Xerox Model 
A printers and cnn005 to represent the Canon Model B printers, then adds printer connections on the 
Document Server machine for each. The xrx005 printer is chosen as the default printer. These 
connections are used by the DocServer component to generate PostScript files. Only one printer for 
each model is actually configured on the Document Server machine. After creating the printer 
connections, the administrator notifies the end users of the network names of the configured printers 
(in this case: \\hqsrvr\xrx005 and \\hqsrvr\cnn005).
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Continuing the example, a user now wants to use the cnn003 printer for personal batch printing 
requests. To do this, the user navigates to the User Preferences screen > Correspondence View and 
enters \\hqsrvr\cnn003 in the Default Printer field and \\hqsrvr\cnn005 in the Printer Driver field. 
All subsequent batch printing requests the user submits are sent to the cnn003 printer. 

NOTE: If a user does not specify a default printer in the User Preferences screen > Correspondence 
view, then batch printing requests (submitted by that user) are sent to the Document Server’s 
default printer. In this case, printing is directly through Microsoft Word; no intermediate PostScript 
file is created.

To add a printer connection to the Document Server machine

1 Login to the Document Server machine using the same User ID used by the Windows Service 
running the Siebel Server.

2 Select Start > Settings > Printers.

3 Double-click the Add Printer icon.

4 On the Welcome screen, click Next.

5 On the Local or Network Printer screen, select Network Printer and click Next.

6 On the Locate Your Printer screen, select Network Printer and click Next.

7 On the Default Printer screen, select either Yes or No and click Next.

8 Click Finish.

To change the default printer

1 Login to the Document Server machine using the same User ID used by the Windows Service 
running the Siebel Server.

2 Navigate to Start > Settings > Printers.

3 In the printer list, right-click the desired printer and choose Set as Default.

Batch Printing Instructions for End 
Users
To batch print, end users select correspondence items in the Correspondence screen list, click the 
menu button, and then click Print. The Print menu item is only active if the selected correspondence 
record has a value of Completed in the Document Status field.

The Print menu item in the Correspondence and Fulfillment screens is configured for client-based 
printing. However, administrators can configure server-based printing in addition to (or instead of) 
client-based printing.

Check with the system administrator to determine which print method is available.
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Preparing for Client-Based Batch Printing 
To prepare for client-based batch printing, complete the following tasks:

■ “To configure Internet Explorer to allow client-based batch printing” on page 385

■ “To add a printer connection to your desktop” on page 385

■ “To change the default printer” on page 386

■ “To print documents using client-based printing” on page 386

When you use client-based batch printing, the Siebel application launches Microsoft Word on your 
client system. The application retrieves the document from the Siebel File System and prints it to 
the default printer configured for your desktop session. Before using client-based batch printing, 
verify that the following prerequisites have been completed:

■ Install Microsoft Word on the client system.

■ Configure Internet Explorer to start Microsoft Word.

■ Configure the default printer for your desktop system.

NOTE: The options in the following procedures may vary depending on which version of Microsoft 
Office you are running.

To configure Internet Explorer to allow client-based batch printing

1 Start Internet Explorer and log in to the Siebel Sales application.

2 In Internet Explorer, select Tools > Internet Options.

3 Select the Security tab, and click Custom Level.

The security zone used by Siebel is highlighted (either Local intranet, or Trusted). Verify that any 
other URL in this zone can be trusted with extra security privileges.

4 In the Security Settings dialog box, locate the following option: 

Initialize and script ActiveX controls not marked safe

5 Change the option setting to either Enable or Prompt, and click OK.

6 Click Yes to answer the question, Are you sure you want to change the security for this zone?

7 In the Internet Options dialog box, click OK.

To add a printer connection to your desktop

1 Select Start > Settings > Printers.

2 Double-click the Add Printer icon.

3 Click Next in the Welcome screen.

4 In the Local or Network Printer screen, select network printer, and then click Next.

5 In the Locate Your Printer screen, select Type the Printer Name.

6 Enter the network name of the printer, or click Browse and select the printer, and then click Next.
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7 In the Default Printer screen, choose either Yes or No, and then click Next.

8 In the Completing the Add Printer Wizard screen, click Finish.

To change the default printer

1 Select Start > Settings > Printers.

The current default printer is marked with a check mark.

2 Select a new default printer by right-clicking the desired printer and choosing Set as Default.

To print documents using client-based printing

1 Close files that are open in Microsoft Word.

2 Navigate to either the Correspondence screen or Fulfillment screen.

3 In the Correspondence list, select one or more records.

Each selected correspondence record must have a Document Status of Completed.

4 In the Correspondence list, click the menu button, and then click Print.

The selected documents are printed to the default printer.

Preparing for Server-Based Batch Printing
To prepare for server-based batch printing, complete the following tasks:

■ “To specify a printer for server-based batch printing” on page 386

■ “To print documents using server-based printing” on page 387

Server-based batch printing sends a printing request to the Siebel Document Server. The document 
is then sent to the printer specified in User Preferences. If you do not specify a printer, the document 
is printed on the default printer configured by the system administrator.

To specify a printer for server-based batch printing

1 Navigate to the User Preferences screen > Correspondence view.

2 In the Default Printer field, enter the network name of the printer used for Correspondence. 

The network name should contain both the printer server name and the printer name as shown 
in the following example.

\\printer_server_name\printer_name

3 In the Printer Driver field, enter the name of the printer driver used to generate an intermediate 
file during the printing process, and then click Save.

The system administrator should provide you with a list of printer drivers and their associated 
printer types. Select the Printer Driver associated with the printer you previously specified in 
Step 2.
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To print documents using server-based printing

1 Navigate to either the Correspondence screen or Fulfillment screen.

2 Select one or more records in the Correspondence list. 

Selected correspondence must have a Document Status of Completed.

3 In the Correspondence list, click the menu button and then click Print.

The selected documents are printed to the default printer specified in User Preferences.
Applications Administration Guide Version 7.7, Rev. B ■ 387



Batch Printing ■ Batch Printing Instructions for End Users
Applications Administration Guide Version 7.7, Rev. B388 ■



28 Literature
This chapter describes the use of Literature in the Siebel application. It includes the following topics:

■ “About Siebel Literature” on page 389

■ “About Setting Up Literature Files” on page 390

■ “Creating and Modifying Literature Files” on page 390

■ “Creating Literature Records” on page 391

■ “Creating Translation Records” on page 393

■ “Creating Literature Item Kits” on page 394

■ “About Making Literature Visible to Users” on page 395

■ “Sharing Literature Through the Products Screen” on page 396

■ “Sharing Literature Through the Competitors Screen” on page 396

■ “Sharing Literature Through the Decision Issues Screen” on page 397

■ “Sharing Literature Through the Correspondence Screen” on page 398

■ “Sharing Literature Through eBriefings” on page 398

■ “Sharing Literature Through Literature or Infocenter” on page 399

About Siebel Literature
Siebel Literature allows you to give your users access to sales and marketing literature, such as 
product brochures, white papers, data sheets, and other types of literature items. Users view these 
documents using the application that created them, for example, Microsoft Word, Lotus Word Pro, or 
Adobe Acrobat.

Literature items may also be grouped into literature kits. Literature kits may include items not 
normally thought of as literature, such as promotional hats, coffee mugs, or T-Shirts. These kits may 
then be made available for distribution through fulfillment centers. Literature kits are covered later 
in this chapter. Fulfillment is covered in Chapter 23, “Correspondence.”

After you create literature records and associate documents with them, your employees can use 
literature in several ways: 

■ Employees can use the Literature or Infocenter screen to search through all the literature that is 
available to them. 

■ You can associate literature with business objects such as products or decision issues. Then users 
can display the literature when they are looking at the record for the associated business object. 
For example, the user can navigate to the Product screen, select a product, and click the Product 
Literature view tab to find all literature items associated with that product. 
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■ When your employees use the Correspondence screen to create correspondence, they can 
include literature as enclosures. The user or fulfillment center may print out this literature 
document, or it may use preprinted copies of literature such as glossy brochures. It may also 
enclose promotional items that are parts of literature kits.

■ Employees can track literature associated with products, industries, accounts and competitors so 
that they appear on your Briefing pages.

About Setting Up Literature Files
To set up a literature file, you must

■ Create the document in another program 

■ Create a Literature record that includes the document in your Siebel application 

NOTE: You may want to create a literature record without associating a document with it. For 
example, if the record represents an item such as a hat or cup, which is part of a literature kit, you 
need not associate a document with it. 

Creating and Modifying Literature Files
Literature files can be created or saved using many kinds of software. The following file types are 
among the most common:

■ Adobe Acrobat (PDF)

■ Excel (XLS)

■ Word (DOC)

■ PowerPoint (PPT)

■ Bitmap (BMP)

■ JPEG (JPG)

To create a new literature file

1 Create a literature file in the appropriate software application.

2 Save the file on your hard drive.

To modify an existing literature file

1 Navigate to the Administration - Document screen > Literature view. 

2 Click the literature file that you want to modify.

Information about the file is displayed in the More Info form. You can use this form to change 
existing comments or characteristics; for example, Distribution Method.

The actual literature file opens in the type of tool that was used to create it; for example, Word.
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3 Modify the file, and save it locally. 

4 Upload the modified file to the existing Literature record.

Creating Literature Records
After you have created a literature file, you need to create a literature record in the Siebel database, 
in order to make the file available to Siebel applications users.

To create a literature record

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, create a new record and attach the literature file.

The new file is added to the available literature. Appropriate information is displayed in the 
Literature list and the More Info form.

3 Enter the rest of the information required in the Literature list blank row and the More Info form 
of the new record. 

Some fields are described in the following table.

Field Comments

Name Enter a name for the literature record.

Description Enter a description of the document. Because literature items can be 
in any language, you may want to indicate the language of the item 
in this field (or in the Name field).

Literature Type Select the type of the literature. You can create new literature types 
in the List of Values Administration view. 

Because the Literature Type field is used to filter literature items in 
various applets (by setting the Search Specification property for the 
applet in Siebel Tools), you should be careful when editing the 
Literature Type field.

Size The size of the literature file. The information is automatically entered 
based on the size of the file that you select.

File Type The file type of the literature file, for example DOC or PDF. The 
information is automatically entered based on the type of the file that 
you select.

Modified The date that the literature file was last modified. The information is 
automatically updated whenever the file is updated. 

Update File A check mark in this field indicates that users’ copies of the literature 
are updated automatically each time the original file is updated.

File Name Click Browse and, in the Choose File dialog box, select the document 
file. You can also enter the file name manually.
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Synopsis Optionally, enter a synopsis of the document’s content.

Release Date The release date when the document is first displayed in My Briefings. 
For more information about eBriefings, see Siebel eBriefings 
Administration Guide. 

Expiration Date The expiration date when the document will no longer be displayed in 
My Briefings. For more information about eBriefings, see Siebel 
eBriefings Administration Guide.

Author Optionally, click the select button and select the document’s author. 

Accounts Select accounts with which the literature is associated. The literature 
is displayed in the Account Briefing if this account is tracked by the 
user. For more information, see Siebel eBriefings Administration 
Guide.

Competitors Select competitors with which the literature is associated. Use this 
field to allow the user to display the literature using the Competitors 
screen. 

If you also select the Internal field, this literature is displayed in the 
Comparative Literature view of the Competitors screen. If you do not 
select the Internal field, this literature is displayed in the Competitor’s 
Literature view of the Competitors screen. 

The literature is also displayed in a Competitor Briefing, if this 
competitor is tracked by the user. For more information, see Siebel 
eBriefings Administration Guide.

Internal Select this field if the document is internally sensitive and not 
intended for public distribution. 

If Internal is selected, the literature is not available as an enclosure 
in the Correspondence screen, and it is displayed in the Comparative 
Literature list of the Competitors screen.

If Internal is not selected, the literature is available as an enclosure 
in the Correspondence screen, and it is displayed in the Competitive 
Literature list of the Competitors screen.

Local For users of the Remote Client, this fields specifies whether the 
document is available on the local File System. If a document is not 
available locally, the user can request it by selecting the Request 
field.

Request For users of the Remote Client, if this check box is selected, the 
literature is downloaded during each synchronization session. 

Field Comments
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Creating Translation Records
Translated literature files can be created using any of the previously listed software tools. (See 
“Creating and Modifying Literature Files” on page 390.) You can create a record in the Siebel 
application for any translated file associated with your document. 

Distribution Method Use this drop-down list to specify whether or not the file is 
automatically downloaded to users of the Remote Client.

Publish: During each synchronization session, if your user does 
nothing, the file is downloaded automatically. If your user explicitly 
skips the file, the file is not downloaded in that synchronization 
session. 

By Request: During synchronization, the user receives the record, but 
not the actual file. To receive the file, the user must select the 
Request field.

Industries Select any industries associated with the literature. The literature is 
displayed in My Briefing if the user tracks the industry.

Products Select any products associated with the literature. Use this field to 
allow the user to display the literature using the Products screen. The 
literature is displayed in My Briefing if the user tracks the product.

Organization Select organizations that will have visibility to this data.

Web Display If you are linking to a Web page, use this field to determine how to 
display it.

Frame. Displays a link to the Web page. When the user clicks the link, 
the page appears in the current frame.

Window. Displays a link to the Web page. When the user clicks the 
link, the page appears in an expanded window. The user must use the 
Web browser’s Back button to return to Siebel ERM.

New Window. Displays a link to the Web page. When the user clicks 
the link, the page is displayed in a new browser window, allowing the 
user to switch between Siebel ERM and the Web page.

In-Line. Displays the entire Web page in the selected section of the 
portal page. 

Displaying Web pages in-line works best with simple Web pages. 
Large or complex pages, such as those that use JavaScript, can slow 
down the system and cause unexpected results. Be sure to test in-
line pages before distributing them to users.

Field Comments
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To associate a translated document with a literature record

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, select an existing record. 

3 Click the Translations view tab.

4 In the Translation list, create a new record and attach the translated document.

Make sure that the file name clearly indicates that this is the translated file.

Creating Literature Item Kits
After you have created more than one literature file, you can combine individual files and other 
material to create literature item kits. This feature allows you to combine individual literature items 
into groups, so you can work with the group instead of with of the individual files. Literature item 
kits are used only as enclosures in correspondence. 

For instance, you might have a set of literature items for prospective customers, including 
promotional brochures for your most popular products. You might also include items that are not 
documents: for example, a promotional kit for one of your products might include a brochure, a 
specifications sheet, a coffee cup, and a T-shirt.

Creating a literature item kit makes it easier to send this information out. When the user adds an 
attachment to correspondence, the user only has to select one literature item kit instead of all the 
individual items. Then the fulfillment center can mail all the items with the correspondence. 

When you create a literature item kit, you create a Literature record that represents the entire kit, 
and you associate Literature Item records with it that represent the items in the kit. The fulfillment 
center can view the Literature record, but cannot view the Literature Item records. To let the 
fulfillment center know which items make up the kit, you can:

■ Pack kits together at the fulfillment center. For example, you have a kit named Sales Promo 
that includes a brochure and a hat. The brochure and hat might be be shrink wrapped together 
at the fulfillment center or they might be stored in one bin at the fulfillment center, so the 
fulfillment center can select one of each item in the bin. Then, when the fulfillment center sees 
that they must fulfill the Sales Promo literature record, they would mail out this shrink-wrapped 
package or the items from this bin. 

■ Make the Literature record a bill of materials. You can include a document in the Literature 
record that describes all the Literature Items in the kit, or use the Literature records Description 
or Synopsis field to list all the Literature Items in the kit. For example, if the kit consists of a 
sales brochure and a hat, you would create a Literature record that represents the entire kit, you 
would attach two Literature Item records to it that represent the brochure and the hat, and you 
might also use the description field of the Literature record to say the kit includes a brochure and 
a hat. Then the fulfillment center would read the description field and mail out the items listed. 

To create a literature item kit

1 Navigate to the Administration - Document screen > Literature view. 
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2 In the Literature list, create a new record or select an existing record. 

This record represents the literature item kit, so you should give it a name that indicates the kit 
contents.

3 Click the Literature Items tab.

The fields previously displayed in More Info are shown under the Literature list at the top. The 
fields in the Literature Items list, in the middle of the view, display specific item information. The 
Component Items list appears at the bottom of the view.

4 In the Literature Items list, create a new record and complete the necessary fields.

Some fields are described in the following table.

5 In the Component Items list, create a new record.

6 Select the record to be added and click Add.

7 In the Component Items list, create any other new records that are needed to create the kit.

About Making Literature Visible to Users
You can make literature visible to users in the following ways: 

■ The Products Screen. You can associate literature with a product, and the user can display it 
using the Products screen. 

■ The Competitors Screen. You can associate literature with a competitor, and the user can 
display it using the Competitors screen. 

■ The Decision Issues Screen. You can associate literature with a decision issue, and the user 
can display it using the Decision Issues screen. 

■ The Correspondence Screen. You can deselect the Internal field of a literature record and the 
user can select it as an enclosure in correspondence. 

■ eBriefings. You can associate literature with an account competitor, product, or industry. 
Literature is displayed in the Account Briefing, Competitor Briefing, or My Briefing page as a 
hyperlink. 

Field Comments

Primary Indicates whether this is the primary item in the kit. 

Physical 
Form

A description of the item’s physical form. This field supports multiple values to 
allow for multiple physical forms. For a document, you might choose 8 1/2 x 11 
and Microfiche.

# of Pages The number of pages in the document, if applicable.

In Stock Select the check box to specify whether the item is in stock, if applicable.

Part # The item’s part number, if applicable.
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■ The Literature Screen or Infocenter. You can make literature visible to users, so it is included 
in the list of literature that they display in the Literature or Infocenter screen. 

Sharing Literature Through the Products 
Screen
End users who are salespeople find it useful to view literature about your products when they are 
viewing other information about the products. If you associate literature with a product, end users 
can view this literature when they view the product record in the Products screen. 

To share literature through the Products screen

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, select a literature record or create a new literature record. 

3 In the More Info form, click the select button in the Products field.

4 In the dialog box, select a Product and Part # to be associated with the literature record, and 
then click OK.

If no Products were previously associated with the literature record, you can use the Associated 
Products dialog to set up a new association.

Sharing Literature Through the 
Competitors Screen
Salespeople find it useful to view their competitors’ literature or to view literature that your company 
has prepared that compares your products with your competitors. If you associate literature with a 
competitor, end users can view this literature when they view the competitor record in the 
Competitors screen. 

To share literature through the Competitors screen, you must associate it with a competitor. You must 
also decide whether to select the Internal flag, which determines whether it is displayed in the 
Comparative Literature List or the Competitive Literature list of the Competitors screen: 

■ If you select the Internal flag, the literature appears in the Comparative Literature list, and it is 
not available as an enclosure in the Correspondence screen. 

■ If you do not select the Internal flag, the literature appears in the Competitive Literature list, and 
it is available as an enclosure in the Correspondence screen. 

Whether you select Internal depends on what type of literature it is:

■ Competitors’ literature. Your salespeople may want to use literature produced by competitors, 
such as sales brochures, to help them compare your products with what the competition is 
offering, However, you would not want to distribute this literature outside your company. You 
should select Internal, so the literature is not available in the Enclosures list of the 
Correspondence screen, but it appears in the Comparative Literature in the Competitors screen.
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■ Comparative literature for internal use. You may develop comparative literature internally, 
such as competitive intelligence, that is meant for use by your salespeople and that you do not 
want to distribute outside your company. You should select Internal, so the literature is not 
available in the Enclosures list of the Correspondence screen, but it appears in Comparative 
Literature in the Competitors screen. 

■ Comparative literature for external use. You may develop comparative literature internally 
that is aimed at your customers, or you may have third party comparative reports that you want 
to distribute to your customers. You should not select Internal, so the literature is available in 
the Enclosures list of the Correspondence screen, and it also appears in Competitive Literature 
in the Competitors screen.

To share literature through the Competitors screen

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, select a literature record or create a new literature record. 

3 In the More Info form, click the select button in the Competitors field.

4 If the competitors that you want to list appear in the dialog box, select the competitors, and then 
click Close.

5 If the specific competitors are not listed in the dialog box, click New.

The Competitors dialog box changes, now listing all possible competitors. You can use the Find 
button to locate a specific company.

6 In the Competitors dialog box, select the competitors and click OK.

When users display this competitor record in the Competitors screen, they are able to display the 
literature in Comparative Literature list if you selected Internal or in the Competitive Literature 
list if you did not select Internal.

Sharing Literature Through the Decision 
Issues Screen
End users who are salespeople find it useful to view literature about a decision issue when they are 
viewing other information about the decision issue. If you associate literature with a decision issue, 
end users can view this literature when they view the decision issue. 

To share literature through the Decision Issues screen

1 Navigate to the Administration - Data screen > Decision Issues view. 

2 In the Decision Issues list, select the decision issue that you want to associate the literature with. 

The More Info list shows information about the issue. Existing literature records are listed under 
the Literature tab.

3 In the Literature list, create a new record. 
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4 Select the literature item that you want to associate with the decision issue, and click OK. 

The Literature list shows the selected literature item.

Sharing Literature Through the 
Correspondence Screen
End users may want to use literature as enclosures in correspondence. They may also use literature 
records that represent literature item kits as enclosures in correspondence. 

Literature is available to users in the correspondence screen if the Internal field of the Literature 
record is not selected. 

To share literature through the Correspondence screen

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, select a literature record or create a new literature record. 

Make sure the Internal field of this record is not selected. 

When users create correspondence, they are able to add this literature as an enclosure. 

Sharing Literature Through eBriefings
Siebel eBriefings are personalized pages that combine information from the Siebel database, such 
as links with a user’s new opportunities or new service requests, with background information about 
businesses the user works with. The user can choose which customer accounts and competitors to 
track, and information about those businesses appear in the Account Briefing and Competitor 
Briefing view of that user’s eBriefings screen. You can include links to literature about the account 
or competitor.

To share literature through eBriefings, you can associate it with Accounts, Competitors, Industries, 
or Products. 

For more information about Briefings, see Siebel eBriefings Administration Guide.

To share literature through eBriefings

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, select a literature record or create a new literature record. 

3 If you want to display the literature in Account Briefings, in the More Info Accounts field, select 
the accounts with which the literature is associated. The end users who are tracking that account 
see the literature item in the Account Briefing.

4 If you want to display the literature in Competitor Briefings, in the More Info form’s Accounts 
field, select the competitors with which the literature is associated. End users must track that 
competitor for it to appear in Competitor Briefing.
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5 In the Release Date field, enter the first date when the literature will appear in briefings. 
Literature associated with products or industries appears in My Briefing if the end user tracks 
those products and industries.

6 In the Expiration Data field, enter the last date that you want the literature to appear in briefings. 

Sharing Literature Through Literature or 
Infocenter
Your end users may work with literature by displaying the Literature screen or Infocenter screen and 
searching the Literature list in that screen for the piece of literature they need. 

You generally share literature with users by associating the user with access groups and associating 
literature with categories. Before you can do this, you must create categories that include literature, 
create access groups that include end users, and associate the categories with the access groups. 
For more information, see Security Guide for Siebel eBusiness Applications. 

After you have completed this preliminary work, you can assign literature to end users as follows: 

■ When you produce new literature, associate it with the appropriate category and it is visible to 
all end users in access groups associated with that category.

■ When you hire new employees, associate them to with the appropriate access group and so that 
they have visibility to all the literature in categories associated with that category. 

A business manager who administers literature makes it visible to users by associating it with the 
appropriate category in either the Literature Administration screen or the Catalog Administration 
screen. After it is assigned in either of these ways, users in access groups associated with this 
category are able to display it in the Literature screen.

To associate literature with a category using the Literature Administration screen

1 Navigate to the Administration - Document screen > Literature view. 

2 In the Literature list, select the record for the literature you want to associate with a category. 

3 In the Category form, create a new record.

4 In the dialog box, select the item to be associated with the category, and then click OK.

The literature is associated with the category. 

To associate literature with a category using the Catalog Administration screen

1 Navigate to the Administration - Catalog screen > Catalog Administration view.

2 In the Catalogs list, drill down on the Name of the catalog to be associated with the literature. 

A Categories list appears. 

3 Click the Literature view tab.

4 In the Literature list, create a new record.
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5 In the dialog box, enter identifying information about the literature (for example, the document 
Name), and then click Go.

6 When the dialog box reappears listing the needed literature, select the literature item and click 
OK.

The literature is associated with the category.
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This chapter is about Global Target List Management. It includes the following topics:

■ “About Global Target List Management” on page 401

■ “Scenario for Global Target List Management” on page 402

■ “Process of Global Target List Management” on page 403

■ “Creating Target Lists by Querying (End User)” on page 403

■ “Editing Target Lists (End User)” on page 404

■ “Creating Target Lists By Combining Lists (End User)” on page 404

■ “Applying Target Lists (End User)” on page 405

■ “Creating Activities From Target Lists (End User)” on page 405

■ “About Configuring Target Lists” on page 406

About Global Target List Management

Global Target List Management Is For SIA Only
The Global Target List Management only applies to Siebel Industry Applications (SIA) such as Siebel 
Life Sciences and Siebel Financial Services. Global Target List Management does not apply to non-
SIA applications such as Siebel Sales or Siebel Call Center.

What Is Global Target List Management?
Global Target List Management is used to create reusable lists of party entities (accounts, contacts, 
employees, positions, and prospects) from many different views in the application. These lists can 
be applied in various views and can be used to create activities. 

Target lists differ from PDQs (saved queries) in that target lists are static; the saved list contains a 
specific set of records. Whereas, the records returned by a PDQ can vary over time as edits are made 
to the database.

Global Target List Management builds on the general List Management features that are available for 
both SIA and the non-SIA applications. 

Things you can do with Global Target List Management that you cannot do with general List 
Management are:

■ Create lists in many views (not just in the List Management view)

■ Apply lists in many views
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■ Create lists of accounts and positions

■ Generate activities for records in a list

What Kind of Lists Can Be Created?
In the preconfigured application, you can create and apply target lists for contacts, accounts, 
positions, and employees.

However, the application can be configured for lists of prospects.

Where to Find More Information

Scenario for Global Target List 
Management
This scenario provides one simple example of a process performed by an administrative assistant. 
There are many ways that target lists can be used in your company’s business processes. 

An administrative assistant has been asked to send personalized birthday gifts to all of the company’s 
top clients who have birthdays in the upcoming month, March. She uses Global Target List 
Management to help her create a set of activities, one for each gift she needs to purchase and send. 

First, she notices that the company administrator has already prepared a list of the top clients. This 
top-client list is not a private list and so the list can be used by the administrative assistant. 

Next, she queries for company contacts who have birthdays in March and saves these records to a 
private list, which she calls March-birthdays. 

Then, she combines her March-birthdays list and the companies top-client list. The list resulting from 
this intersection contains the company’s top clients who have birthdays in March. 

The last step is to create an activity for each client in the final list. Each activity can be marked 
completed when the client’s gift has been sent. 

Topic See

General List Management functionality, including field descriptions 
and instructions for importing and exporting lists

Siebel Marketing User Guide

Call List functionality, which is unique to Financial Services Siebel Finance Guide

Professional and account targeting, which is unique to Siebel 
Pharma

Siebel Life Sciences Guide
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Process of Global Target List 
Management
This example process represents the tasks that are carried out in the “Scenario for Global Target List 
Management” on page 402. 

■ “Creating Target Lists by Querying (End User)” on page 403

■ “Editing Target Lists (End User)” on page 404

■ “Creating Target Lists By Combining Lists (End User)” on page 404

■ “Applying Target Lists (End User)” on page 405

■ “Creating Activities From Target Lists (End User)” on page 405

Creating Target Lists by Querying (End 
User)
The most usual way to create a target list is by querying and then saving to a target list some or all 
of the party records returned by the query.

This task is a step in Process of Global Target List Management on page 403.

To create a target list by querying

1 Navigate to a screen where target lists are enabled. 

2 Perform a query.

3 On the toolbar, click the Save Target List button.

The records you save can be... For example...

Those records returned by the query If you query contacts, you can save those contact 
records to a target list

The records associated with those 
records returned by the query

If you query opportunities, you can save the positions on 
the opportunities’ sales teams to a target list (You 
cannot save the opportunity records to a target list.)
Applications Administration Guide Version 7.7, Rev. B ■ 403



Global Target List Management ■ Editing Target Lists (End User)
4 Complete the fields in the Save to List dialog box.

Some fields are described in the following table.

Editing Target Lists (End User)
You can add and delete records from saved target lists.

This task is a step in Process of Global Target List Management on page 403.

To edit a target list

1 Navigate to the List Management screen > Lists view.

You can also navigate to this view by clicking the Save and Edit button in the Save to List dialog 
box as in Step 4 on page 404.

2 Drill down on the target list record.

3 Click the appropriate view tab.

Creating Target Lists By Combining Lists 
(End User)
You can create new lists by combining existing lists. Lists can be combined as unions or intersections.

Field Comments

Based On You can save the records themselves, for example contacts or accounts. Or, you 
can save the contacts or positions (team) associated with the records. If 
multiple contacts or positions can be associated with the records, you can 
choose to save all or only the primary.

The choices available depend on the view.

Private If this check box is selected, only you can view and apply this list. 

If this check box is cleared, all users can view and apply this list.

If the Target List Contains... Use This View to Add or Delete from the List...

Accounts Accounts

Team members Positions

Contacts All Contacts, My Contacts, or List Contacts and 
Prospects

NOTE: The My Contacts view filters the list to show 
only your contacts.

Employees Employees
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This task is a step in Process of Global Target List Management on page 403.

To create a target list by combining other lists

1 Navigate to the List Management screen > Lists view.

2 Select the lists you want to combine.

3 Click Create Union or Create Intersection.

Applying Target Lists (End User)
Once you or an administrator have created target lists, you can apply them. For a target list to be 
applied, you must be in a target list-enabled view.

This task is a step in Process of Global Target List Management on page 403.

To apply a target list

1 Navigate to a screen where target lists are enabled. 

2 On the toolbar, click the Apply Target List button.

3 In the Apply Target List dialog box:

a Select one or more lists

b Click Available to preserve the current query (That is, records are displayed only if they are in 
both the list and the current query.) 

c Click OK, Union, or Intersection to apply the list(s)

Creating Activities From Target Lists 
(End User)
From the List Management screen, you can create activities for each member in a list. 

How fields for the activities are completed, including which fields are copied from the list member 
records, is determined by “activity templates.” These templates are set up by the Siebel 
administrator; see “Setting Up Data Map Object “Activity Templates” for Target Lists” on page 406. In 
the preconfigured application, the “activity templates” can only be applied for lists of contacts.

This task is a step in Process of Global Target List Management on page 403.

To create an activity for each party in a list

1 Navigate to the List Management screen > Lists view.

2 Select a list record.

3 Click Create Activity.
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4 In the Create Activity dialog box, select an “activity template.” 

NOTE: These “activity templates” are data map objects created through the Data Transfer 
Utilities. They are not the same as the activity templates used to create activity plans. 

About Configuring Target Lists
This section discusses some aspects of configuring Global Target List Management:

■ “Setting Up Data Map Object “Activity Templates” for Target Lists” on page 406

■ “About Workflows for Global Target List Management” on page 407

■ “Configuring Global Target List Management to Create Activities Asynchronously” on page 407

■ “Enabling Application of Target Lists on an Applet” on page 408

■ “Enabling Saving of Target Lists in an Applet” on page 409

Setting Up Data Map Object “Activity Templates” for 
Target Lists
Some activity template data map objects are provided in seed data. (These are listed in Step 4 on 
page 406.) You can edit these objects or create your own objects, using those provided as a model. 
For more information about Data Map Objects, see Siebel Finance Guide.

“Activity Template” For each contact in the list, creates a ...

Customer Status Call High priority activity of type Call - Outbound 

Customer Status Email High priority activity of type Email - Outbound

End Information Email Medium priority activity of type Email - Outbound

Targeted Call Activity of type Targeted Call
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About Workflows for Global Target List Management
Four workflows for Global Target List Management are provided in seed data. These are described in 
Table 81. 

Configuring Global Target List Management to Create 
Activities Asynchronously
In the preconfigured application, when the Create Activities for List command (Create Activity 
button) is invoked, activities are created synchronously. If your users typically create activities for 
long lists, the response time for synchronous creation can be slow. To resolve this, you can configure 
the application to create the activities asynchronously. 

To configure asynchronous activity creation from target lists

1 In Siebel Tools: 

Table 81. Workflows for Global Target List Management

Workflow Description

SLM Create Activity 
From List

This workflow can be used to create activities asynchronously. See 
“Configuring Global Target List Management to Create Activities 
Asynchronously” on page 407.

SLM Edit Call List 
Workflow

This workflow is triggered by the Save and Edit button on the Save to List 
dialog box. This workflow takes the user to the List Mgmt Lists View of the 
List Management screen.

SLM List Operation - 
Generic

Modification of this workflow is not recommended.

This workflow is triggered when the Create Union and Create Intersection 
buttons are clicked. 

SLM Update Parent Modification of this workflow is not recommended.

This workflow is triggered when a new member (such as a contact or an 
account) is added to a list. The workflow checks the content type of the new 
member and updates the Content field for the list if necessary. 

For example, if an account is added to a list of contacts, the Content field 
is changed to Hybrid. 

For This Applet
Change This Applet 
User Property

From the Default 
Value of To This Value

SLM Create 
Activity Popup

On Close Invoke 
Parent Method

ContinueCreateActivity ContinueCreateActAsync
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2 Activate the SLM Create Activity From List workflow.

For general information about Siebel workflows, see Siebel Business Process Designer 
Administration Guide.

Enabling Application of Target Lists on an Applet
You can configure list applets so that target lists can be applied to them. 

In order for a list applet to be configurable, the business component on which the applet is based 
must contain an multi-value id field for the list category (accounts, contacts, employees, positions, 
or prospects). 

To configure a list applet so that target lists can be applied

1 Create a multi-value link between the applet’s business component and the List Mgmt Lists 
business component where:

■ Destination Business Component = List Mgmt Lists

■ Destination Link is one of the following (as appropriate for the list category that will be 
applied in the applet):

❏ SLM Account/List Mgmt Lists

❏ Contact/List Mgmt Lists

❏ Employee/List Mgmt Lists

❏ Position/List Mgmt Lists

❏ Prospects/List Mgmt Lists

For example, the SIS Account List Applet is based on the Account business component; it 
contains a multi-value link called List Mgmt Lists, where Destination Link = SLM Account/List 
Mgmt Lists.

2 Create a multi-value field for the applet’s business component where:

■ Multivalue Link = The multi-value link created in Step 1

■ Field = Id
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3 For the applet’s business component, create a user property called TargetProp (or TargetProp 1, 
TargetProp 2, and so on), and enter a value for the user property in the form:

“Entity Display Name”, “Multi-Value Field Name”, “List Category”

For example, “Accounts”, “List Mgmt List Id”, “Accounts” 

The following table describes each term.

4 Repeat Step 1 to Step 3 for each category of list that you want to be able to apply to the applet. 

5 (Optional) Add an “Apply List” item to the applet’s menu button.

a Create an Applet Menu Method Item for the applet.

b If the applet’s business component contains 

❏ Only one TargetProp user property, set Command to Apply List Popup—Simple. 

❏ Multiple TargetProp user properties for the applet, set the command property to Apply 
List Popup. 

c Set Menu Text to Apply List.

NOTE: If you do not carry out this step, target list can still be applied using the Apply Target List 
button in the toolbar or using the application-level menu Edit > Apply List. 

Enabling Saving of Target Lists in an Applet
You can configure list applets so that target lists can be saved from them. 

In order for a list applet to be configurable, the business component on which the applet is based 
must contain an id field for the party entity that you want to save to the list. 

To enable target list saving for a list applet

1 In Siebel Tools, create a user property for the applet called Save Target List Source n, where n 
is a consecutive integer starting from 1. 

For example, the first user property that you create for the applet is named Save Target List 
Source 1, the second is named Save Target List Source 2, and so on.

Term in User Property 
Value Description

Entity Display Name This must be one of the Language-Independent Code values 
defined for the SLM_FIELD_DISPLAY LOV. 

Multi-Value Field Name The name of the field created in Step 2.

List Category This must be one of the display values defined for the 
SLM_LST_CATEGORY LOV: Account, Contact, Employee, Position, 
or Prospect.
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2 Find or create the list column for the party entity that you want to save:

a On the applet’s business component, locate the id field of the party entity. 

b If the applet does not have a List Column that maps to that id field, create one. 

3 Enter a value for the user property of the form: 

“List Column”, “Saved Entity Name”, “PrimaryOnly”, “Extra Src Field 1”, “Extra Dst Field 1”, “Extra 
Src Field 1”, “Extra Dst Field 2”

For example, these properties applied to the SIS Account List Applet: 

■ Save Target List Source 1 = “SLM Position - Primary”, “Position”, “PrimaryOnly” 

Saves the primary team member on the accounts.

■ Save Target List Source 2 = “SLM Contact”, “Contact”, “ ”, “Main Phone Number”, “Acct Phone 
Number” 

Saves all contacts and the main phone number of the account with each contact. 

NOTE: For the preceding example, the destination list member business component (SLM 
List Member - Contact) needs to have a field that can store the account phone number. 

The following table describes each term for the Save Target List Source user property.

Term in 
User 
Property 
Value 1

Required 
or 
Optional Description

List Column Required The name of a list column identified in Step 2. The Field value for 
this list column is the source business component field for the 
target list. This field must be an id field.

The Display Name value for this list column is used in the List Name 
drop-down list in the Save to List dialog box. See Figure 28 on 
page 411.

Saved Entity 
Name

Required The content of target list that you are saving: Contact, Employee, 
Account, Position, or Prospect.

PrimaryOnly Required 2 If the list column corresponds to a multi-value id field, then use the 
“PrimaryOnly” term to save only the primary record of the multi-
value group to the target list. If this term is not specified or empty, 
then all records in the multi-value group are saved to the target 
list. 

Extra Src 
Field 1

Optional If you want to save an additional field to the target list, specify the 
field name of this source.

Extra Dst 
Field 1

Optional 3 If you specify an Extra Src Field 1, then specify a destination field 
name. This field must exist in the list member’s applet and 
corresponding business component so that it can be seen in the 
List Management screen.
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4 Repeat Step 1 and Step 3 to create a user property for each type of list that you want users to 
be able to create in that applet.

Extra Src 
Field 2

Optional If you want to save an additional field to the target list, specify the 
field name of this source.

Extra Dst 
Field 2

Optional 4 If you specify an Extra Src Field 2, then specify a destination field. 

1. Terms must be enclosed in double quotes and separated by commas.

2. Optional if no Extra Src Field 1 is specified and not “PrimaryOnly”.

3. Required if Extra Src Field 1 is specified.

4. Required if Extra Src Field 2 is specified.

Figure 28. Save to List Dialog Box for the SIS Account List Applet

Term in 
User 
Property 
Value 1

Required 
or 
Optional Description

The Display Name value for the 
SLM Contact - Primary list 
column
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30 D&B Integration
This chapter describes the integration of D&B data with your Siebel application. It includes the 
following topics:

■ “About D&B Data” on page 413

■ “Business Scenarios for D&B” on page 414

■ “About the D&B D-U-N-S Number” on page 415

■ “Process of Integrating D&B Data” on page 415

■ “Obtaining D&B Data” on page 416

■ “Loading D&B Data” on page 416

■ “Loading D&B Data Using Sample Scripts” on page 417

■ “About Siebel Update Server Components” on page 420

■ “Running the Siebel Update Server Components” on page 424

■ “Setting Up the Symbolic URL for Access to the D&B Database” on page 428

■ “Configuring D&B Integration” on page 429

■ “Field Mappings for Configuration of D&B Integration” on page 433

About D&B Data
D&B is a leading provider of business information. D&B’s information and technology solutions help 
businesses find profitable customers, reduce credit risk, manage receivables, and manage vendors. 
D&B’s database of commercial information consists of over 75 million records world wide. 

For connected users, you can use your Siebel application to integrate with D&B data and reports. As 
a mobile client, you can access D&B data for accounts and contacts that have been promoted from 
D&B marketing data.

This allows you to:

■ Use D&B marketing data within your Siebel application.

■ Access D&B business and credit reports from within your Siebel application.

You can use this D&B data to support the following:

■ New Business or Customer Acquisition. By querying on company size, line of business, and 
other criteria provided by D&B, you can generate lists of prospects to add to the sales pipeline 
or to support outbound marketing programs. By using the D&B corporate family linkage 
information, you can identify new prospects and opportunities within a company’s extended 
family.
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■ Customer Segmentation and Penetration. You can profile specific market segments such as 
geography, industry, size, and other criteria to identify untapped opportunities or better align 
sales territories.

■ Customer Qualification. Use your access to D&B business and credit reports to obtain detailed 
background and risk information on a company in order to focus sales efforts on higher-
probability accounts and shorten the sales cycle.

NOTE: This chapter describes how the administrator loads and updates D&B data. For information 
about viewing and using D&B data within the Siebel application, see Chapter 30, “D&B Integration.”

Business Scenarios for D&B
The following scenarios describe how you can use D&B data in your company.

Build and Grow Current Customer Relationships
A company can increase market penetration across its existing customer base by determining how 
many relationships the company already has within a corporate family structure. Sales managers and 
representatives can use D&B D-U-N-S numbers to view the organizational hierarchies of clients and 
aggregate account attributes at each level.

For instance, a sales representative plans to sell computers to 20 business locations and he discovers 
that there are locations for this company that he has not yet contacted. In another situation, the 
sales manager may want to see a rollup of opportunities and the potential revenue for each 
subsidiary and location for a specific company on a worldwide basis.

New Business or Customer Acquisition
Because a sales organization is always looking for more leads to new business, sales professionals 
can access company information in the Siebel D&B database, allowing them to generate prospects 
in their territories.

With D&B, the sales representative can query the Siebel D&B database using criteria to target new 
leads. The sales representative can query using demographic data, revenue profiles, or other criteria. 
After generating a list of leads, the sales representative can automatically add the companies and 
contacts to their company’s accounts list. These promoted accounts and contacts are automatically 
updated when D&B updates occur.

Customer Satisfaction and Account Planning
Standardizing customer information on the D&B D-U-N-S number gives you a means for house-
holding your customer data and eliminating duplicate customer records. This increases your ability 
to manage existing customer relationships because all opportunities for a customer are linked to the 
same customer record.

Add D&B’s corporate family linkage, and you have the ability to manage and plan for customers at a 
local and global level. For example, you may want to see a roll up of all opportunities and potential 
revenue for all companies and locations related to a particular company worldwide. 
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D&B Search for New Account Information
Sales professionals can access the D&B database in real time to find and retrieve new D&B account 
information that is immediately available for use within Siebel Sales. This information includes 
company demographic, corporate linkage, and address data maintained by D&B.

For example, a sales representative discovers a new opportunity, but the representative cannot find 
the account in either the Siebel account list or the D&B account list. Instead of creating a new 
account, the sales manager performs a real-time D&B search to obtain up-to-date, quality 
information that can be used to automatically establish a new Siebel account. This provides the sales 
team with valuable information that they can use when working on the new opportunity.

About the D&B D-U-N-S Number
The D-U-N-S (Data Universal Numbering System) number is a crucial component of D&B data. A D&B 
D-U-N-S number is a nonindicative, nine-digit number assigned to each business location in the D&B 
database. Each D-U-N-S number has a unique, separate, and distinct operation and is maintained 
solely by D&B. Industries and organizations around the world use the D&B D-U-N-S number as a 
global standard for business identification and tracking.

Each company has a unique D&B D-U-N-S number associated with it. It acts as a unique identifier 
for a company in the D&B database.

To uniquely identify the association between different companies in the D&B database, each company 
also has associated D&B D-U-N-S numbers.

Several categories of D&B D-U-N-S numbers exist:

■ D&B D-U-N-S Number—each unique business location listed in the D&B database is assigned a 
D&B D-U-N-S number. This column is called simply DUNS Number in your Siebel application.

■ Global Ultimate D-U-N-S—the D&B D-U-N-S number belonging to a business’s worldwide 
ultimate parent company. 

■ Domestic Ultimate D-U-N-S—the D&B D-U-N-S number belonging to the highest-level family 
member within a specific country.

■ Parent/HQ D-U-N-S—the D&B D-U-N-S number belonging to a business’s immediate 
headquarters or parent.

These numbers allow D&B to establish the relationships between different companies.

Process of Integrating D&B Data
The process of integrating D&B data into the D&B Account tables and the Siebel Account tables in 
the Siebel database involves the following steps:

1 Obtaining D&B Data

2 Loading D&B Data into staging tables in the Siebel database

3 Running the Siebel Update Server Components
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Obtaining D&B Data
You must obtain three data files from D&B:

■ The Marketing Data file

■ The MRC file

■ The SIC file

Request these files in Siebel format, also referred to as 2202 or GDMDI data file format. D&B should 
be able to provide files in this format without difficulty.

To obtain MRC and SIC files, send email to:

dnb4siebel@dnb.com

In addition to these files, you can request D&B data layout documentation from D&B.

The Marketing Data File. This file contains detailed company information, such as the company’s 
legal name, address, contact information, and so on.

The MRC and SIC Files. These are both reference files required by the Siebel D&B modules. Both 
files contain information referenced by the demographic company data provided by D&B.

MRC stands for Management Responsibility Code. The MRC file contains a list of lookup values for 
the contacts and their positions such as CEO, Vice President of Marketing, and so on. Each contact 
has an associated numerical code that is referenced by the D&B marketing data to determine the 
title or position of a company contact.

SIC stands for Standard Industrial Classification and is a code developed by the Federal government 
to describe the type of activity performed by the business at this location. The SIC file contains a list 
of SIC codes assigned and maintained by D&B along with their definitions. D&B’s Primary SIC code 
indicates the line of business that provides the largest revenue contribution to the business. D&B 
also maintains and assigns six levels of subsidiary SIC codes to describe in greater detail additional 
lines of business activity for a given company. By default, the SIC code provided in the SIC file and 
the Marketing Data file is the 4-digit SIC code. 

Loading D&B Data
After you have obtained the three D&B data files, you can start to load the data into the Siebel 
database. You can load the files in any order, but you must load all three files before running the 
Siebel update server component.

When creating your data loading scripts, refer to the documentation provided by D&B and to Siebel 
Data Model Reference.

The scripts and processes differ according to your database platform.

NOTE: When you integrate D&B data for the first time, you may want to contact Siebel Professional 
Services to obtain sample loading scripts for use as templates. See “Loading D&B Data Using Sample 
Scripts” on page 417.
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The scripts load D&B data into staging tables in the Siebel database, as shown in Table 82.

NOTE: Definitions of these tables can be found in Siebel Data Model Reference.

Because SIC and MRC files change only rarely, updating D&B data usually requires deleting and 
reloading the D&B marketing data in the S_DNB_UPDATE table alone.

If you need to load new versions of the SIC and MRC files, you must delete the previously used 
staging tables. 

Table 83 lists what D&B data to delete and what to load.

After loading files, you must run the D&B Update Manager (D&B) and the D&B Update Manager 
(Siebel) as described in “About Siebel Update Server Components” on page 420.

Loading D&B Data Using Sample Scripts
This section provides some guidance on how to use sample scripts for:

■ “Loading D&B Data on Oracle” on page 418

■ “Loading D&B Data on DB2” on page 418

Table 82. Staging Tables for Uploading D&B Data

File Upload Location

Marketing Data file S_DNB_UPDATE table

This table is used as a staging area for the un-normalized D&B Marketing 
data.

SIC file S_DNB_SIC table

MRC file S_DNB_MRC table

Table 83. Loading or Reloading D&B Data

If You Are... Then...

Loading D&B data for the first time ■ Load the three D&B data files: Marketing Data file, 
SIC file, and MRC file.

Updating D&B data with a new Marketing 
Data file, but the SIC and MRC files have 
not changed

■ Delete data from the S_DNB_UPDATE table.

■ Load the Marketing file.

Updating D&B data with new Marketing 
Data, SIC, and MRC files

■ Delete data from the S_DNB_UPDATE, the 
S_DNB_SIC, and the S_DNB_MRC tables.

■ Load the three D&B data files: Marketing Data file, 
SIC file, and MRC file.
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■ “Loading D&B Data on Microsoft SQL Server” on page 419

The sample scripts are not provided as part of the Siebel product, but may be obtained from Siebel 
Professional Services.

CAUTION: Before running scripts, you should check them against the D&B data layout 
documentation and against the S_DNB_UPDATE table columns documented in Siebel Data Model 
Reference. Then, modify the scripts as required.

Loading D&B Data on Oracle
Oracle installations require you to run SQLLOADER control files. You need the following control files:

■ s_dnb_update.ctl (for loading Marketing Data file into S_DNB_UPDATE table)

■ s_dnb_sic.ctl (only required if loading the SIC file)

■ s_dnb_mrc.ctl (only required if loading the MRC file)

NOTE: This procedure is based on the assumption that you understand how to run SQLLOADER. 
SQLLOADER is described in the Oracle documentation.

To load D&B data if you are using Oracle

1 Verify that the column order of your D&B file matches the column requirements in the CTL file 
before running the loading script.

2 Truncate the appropriate staging tables (see Table 83 on page 417). 

To optimize loading performance, drop all indexes on the S_DNB_UPDATE table and re-create 
them after the scripts have completed. This can be done using Siebel utilities ddlexp (to back up 
the indexes before dropping) and ddlimp (to re-create them).

3 Modify the SQL file as appropriate for:

■ The name of your database

■ The D&B filename and directory location

■ The database table owner

■ The user ID and password (with loading privileges) that you are using to load the data

4 Run SQLLOADER.

Loading D&B Data on DB2
DB2 installations require you to run DB2 IMPORT. You need the following SQL files:

■ imp_update_new.sql (for loading Marketing Data file into S_DNB_UPDATE table)

■ imp_sic_new.sql (only required if loading the SIC file)

■ imp_mrc_new.sql (only required if loading the MRC file)

NOTE: This procedure is based on the assumption that you understand how to run DB2 IMPORT. DB2 
IMPORT is described in the DB2 documentation.
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To load D&B data if you are using DB2

1 Verify that the column order of your D&B file matches the column requirements in the SQL file 
before running the loading script.

2 Truncate the appropriate staging tables (see Table 83 on page 417). 

To optimize loading performance, drop all indexes on the S_DNB_UPDATE table and re-create 
them after the scripts have completed. This can be done using Siebel utilities ddlexp (to back up 
the indexes before dropping) and ddlimp (to re-create them).

3 Modify the SQL file as appropriate for:

■ The name of your database

■ The D&B filenames and directory location

■ The database table owner

■ The user ID and password (with loading privileges) that you are using to load the data

4 Run DB2 IMPORT.

5 Optional: After running the import scripts, update the DB2 catalog statistics by executing 
RUNSTATS on the three tables that received the D&B data (S_DNB_MRC, S_DNB_SIC, 
S_DNB_UPDATE).

Loading D&B Data on Microsoft SQL Server
Microsoft SQL Server installations require you to run SQL scripts. You need the following format files 
and SQL scripts:

■ For loading the Marketing Data file:

■ S_DNB_UPDATE.fmt—a format file to load the data into the tempS_DNB_UPDATE table

■ S_DNB_UPDATE.sql—an SQL script that loads the data into S_DNB_UPDATE table

■ For loading the SIC file:

■ S_DNB_SIC.fmt—a format file to load the data into the tempS_DNB_SIC table

■ S_DNB_SIC.sql—an SQL script that loads the data into the S_DNB_SIC table

■ For loading the MRC file:

■ S_DNB_MRC.fmt—a format file to load the data into the tempS_DNB_MRC table

■ S_DNB_MRC.sql—an SQL script that loads the data into the S_DNB_MRC table

NOTE: This procedure is based on the assumption that you understand how to run bcp (bulk copy 
process) or similar data-loading utility. The bcp utility is described in the Microsoft SQL Server 
documentation.

To load D&B data if you are using Microsoft SQL Server

1 Verify that the column order of your D&B file matches the column requirements in the SQL file 
before running the loading script.
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2 Truncate the appropriate staging tables (see Table 83 on page 417). 

To optimize loading performance, drop all indexes on the S_DNB_UPDATE table and re-create 
them after the scripts have completed. This can be done using Siebel utilities ddlexp (to back up 
the indexes before dropping) and ddlimp (to re-create them).

3 Modify the SQL file as appropriate for:

■ The name of your database

■ The D&B filename and directory location

■ The database table owner

■ The user ID and password (with loading privileges) that you are using to load the data

4 Run bcp or another data loading utility.

About Siebel Update Server Components
Whenever you load or reload D&B data, you must update the D&B Account tables and the Siebel 
Account tables in the Siebel database. This update is accomplished by running server components: 

■ D&B Update Manager (D&B): Moving D&B marketing data from the staging table 
(S_DNB_UPDATE) into the normalized D&B Account tables, which are the basis for the D&B All 
Accounts View (Figure 29 on page 421).

■ D&B Update Manager (Siebel): Updating the records in the Siebel Account tables for accounts 
with matching D-U-N-S numbers (Figure 30 on page 422). 

■ A third component, D&B Update Manager MultiTask, is also provided. This component can be used 
in place of D&B Update Manager (D&B) or D&B Update Manager (Siebel) to run the update using 
multiple, parallel processes (“Multiple Task Siebel Update Server Component” on page 422).

Overview of the Update Process
This section outlines the process of loading D&B data from the staging tables to the D&B Account 
tables through to updating the Siebel account tables. 

This process recommends using the D&B Update Manager MultiTask server component to run server 
component tasks in parallel. However, use of the single task D&B Update Manager (D&B) and D&B 
Update Manager (Siebel) server components is also documented in this chapter.

1 Make sure you have loaded the D&B data into the staging tables as discussed in “Loading D&B 
Data” on page 416 and “Loading D&B Data Using Sample Scripts” on page 417.

2 Update the D&B Account tables with data from the staging tables:

a To optimize performance, you may choose to do one of the following:

❏ For first time data loading, that is, when there are no D&B records in the database, drop 
the indexes on these D&B Account tables: S_DNB_ORG, S_DNB_ORG_SIC, 
S_DNB_CON_MRC, and S_PRSP_CONTACT. 
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❏ For subsequent updates, drop the indexes on the S_DNB_ORG table only, all except for 
the indexes S_DNB_ORG_U1 (DUNS_NUM), S_DNB_ORG_P1 (ROW_ID), and 
S_DNB_ORG_M01 (the clustered index) on this table. 

b Create a search specification on the D-U-N-S number to set up your preferred batch sizes and 
determine the corresponding D-U-N-S number ranges per batch for loading the data from the 
staging tables to the D&B Account tables.

c Execute concurrent D&B Update Manager (D&B) server tasks by running the D&B Update 
Manager MultiTask server component. See “Multiple Task Siebel Update Server Component” on 
page 422 and “Running the Siebel Update Server Components” on page 424.

d Continue to execute the concurrent D&B Update Manager (D&B) server tasks until all data is 
loaded into the D&B Account tables.

e If you dropped indexes on the D&B Account tables, re-create them. This can be done using Siebel 
utilities ddlexp (to back up the indexes before dropping) and ddlimp (to re-create them).

3 Update the Siebel Account tables from the D&B Account tables for accounts with matching 
D-U-N-S numbers by executing concurrent D&B Update Manager (Siebel) server tasks using the 
D&B Update Manager MultiTask server component. See “Multiple D&B Update Manager (Siebel) 
Processes” on page 423 and “Running the Siebel Update Server Components” on page 424.

Single Task Siebel Update Server Components
The update server components are part of the Dun and Bradstreet Enterprise Component Group. This 
group and each of its D&B Batch Components must be enabled. Once enabled, each component can 
be run as a batch task. Figure 29 shows how the staging tables are mapped to the D&B Account 
tables.

Figure 29. D&B Update Manager (D&B) Table Names
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Figure 30 shows how the D&B Account tables are mapped to the Siebel Account tables.

“Field Mapping for the D&B Update Manager Process” on page 433 lists the default table mapping from 
the D&B Account tables to the Siebel Account tables that are used by the D&B Update Manager 
(Siebel) server component.

Multiple Task Siebel Update Server Component
You can use the server component DNBUpMgrMultiTask to spawn multiple Update Manager 
processes. Running several parallel processes helps you maximize your performance with large data 
loads and gives you greater scheduling flexibility. You can control the number of processes that are 
created by editing the dnbtask.cfg file. The dnbtask.cfg file contains two sections, one to set tasks 
for the D&B Update Manager (D&B) process and the second to set tasks for the D&B Update Manager 
(Siebel) process.

The dnbtask.cfg file is located in the sqltempl subdirectory, in the server installation directory. 

Multiple D&B Update Manager (D&B) Processes
By default the dnbtask.cfg file sets up three simultaneous tasks, based on D-U-N-S number ranges. 
The DNBUpMgrDNB portion of the file looks like this:

[DNB]

Task1 = ,100000000

Task2 = 100000000,200000000

Figure 30. D&B Update Manager (Siebel) Table Names
Applications Administration Guide Version 7.7, Rev. B422 ■



D&B Integration ■ Process of Integrating D&B Data
Task3 = 200000000,

These three ranges translate into three DNBUpMgrDNB tasks, each taking care of loading records 
within a particular D-U-N-S number range:

,100000000 means D-U-N-S numbers < 100000000

100000000,200000000 means D-U-N-S numbers >=100000000 and < 200000000

200000000, means D-U-N-S numbers >=200000000

Edit the file to change the number of parallel processes created or the range of D-U-N-S numbers 
updated.

CAUTION: If you use DNBUpMgrMultiTask to run multiple UpdateMgr processes, you must make 
sure that processes running at the same time have mutually exclusive ranges. Unpredictable results 
occur if multiple processes collide. 

Multiple D&B Update Manager (D&B) Processes with First Time Data 
Loading
The first time you load D&B data, that is, when there are no D&B records in the database, you may 
use a special SQL file (dnbinitial.sql) which is optimized to do only inserts. This results in faster 
loading of data than using the dnbmaps.tsq file.

To use the dnbinitial.sql file, set the server component parameter DNBConfigFile to dnbinitial.sql. For 
examples, see “Running the Siebel Update Server Components” on page 424.

For subsequent updates, the DNBConfigFile should be set to dnbmaps.tsq.

NOTE: The dnbinitial.sql file assumes that you dropped the indexes on the D&B Account tables when 
loading data (“Loading D&B Data Using Sample Scripts” on page 417).

Multiple D&B Update Manager (Siebel) Processes
By default the dnbtask.cfg file sets up five simultaneous tasks, based on tables updated. The 
DNBUpMgrSieb portion of the file looks like this:

[Siebel]

Task1 = UPDATE_SIEBEL_ACCOUNT

Task2 = UPDATE_INDUST, COMMIT, UPDATE_SIEBEL_INDUST, COMMIT,
UPDATE_SIEBEL_SYNONYM 

Task3 = UPDATE_SIEBEL_ADDR_PHY, COMMIT, UPDATE_SIEBEL_ADDR_MAIL

Task4 = UPDATE_SIEBEL_CONTACT 

Task5 = UPDATE_SIEBEL_LOC1, COMMIT, UPDATE_SIEBEL_LOC2, COMMIT, UPDATE_SIEBEL_LOC3
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You may edit the file to change the number of parallel processes created. However, note that the 
order of the updates within individual tasks is important; for example UPDATE_INDUST should be 
done before UPDATE_SIEBEL_INDUST. Use caution when updating the DNBUpMgrSieb portion of the 
dnbtask.cfg file.

CAUTION: If you have modified the RTI configuration file to insert new accounts into the Siebel 
Accounts table, do not run the multiple task process. Instead you must run the single task D&B 
Update Mgr (Siebel) server component. Make sure you have modified the dnbmaps.sql file used by 
the single task server component. The order of the updates is critical to data integrity if new accounts 
are being added.

Running the Siebel Update Server Components
There are two ways to run the Siebel update server components:

■ From within the Siebel application

■ From a command line interface, using Siebel Server Manager
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The procedures for running the update processes from both within the Siebel application and from 
the command line are shown in Table 84. Whatever procedures you choose to follow, make sure that 
the D&B Update Manager (D&B) process is complete before you start the D&B Update Manager 
(Siebel) process.

NOTE: If you have just installed the Siebel Server or if you have made changes to the Siebel Name 
Server, you need to synchronize before running the Siebel update server component. For more 
information about synchronizing server components, see Siebel System Administration Guide.

TIP: If you are going to run the D&B Update Mgr (Multi-task) component, make sure that the 
maximum number of tasks (MaxTasks parameter) is set correctly to accommodate the number of 
tasks that you specified in the dnbtask.cfg file. For information about MaxTasks, see Siebel System 
Administration Guide.

To run the D&B Update Manager (D&B) server component from within your Siebel 
application (single task process)

1 Check that the Dun and Bradstreet component group is enabled.

2 Submit a component job for D&B Update Mgr (D&B); make sure to set the Mode to Asynchronous.

Table 84. Procedures for Running Siebel Update Server Components

Process From Within the Application From the Command Line Interface 1

1. For general information about using Siebel Server Manager, see Siebel System Administration Guide.

D&B “To run the D&B Update Manager (D&B) 
server component from within your Siebel 
application (single task process)” on 
page 425

OR

“To run the D&B Update Manager (D&B) 
server component from within your Siebel 
application (multiple task process)” on 
page 426

“To run the D&B Update Manager (D&B) 
server component from a command line 
(single or multiple task process)” on 
page 427

Siebel “To run the D&B Update Manager (Siebel) 
server component from within your Siebel 
application (single task process)” on 
page 426

OR

“To run the D&B Update Manager (Siebel) 
server component from within your Siebel 
application (multiple task process)” on 
page 426

“To run the D&B Update Manager (Siebel) 
server component from a command line 
(single or multiple task process)” on 
page 427
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3 When the D&B Update Mgr (D&B) is done, open the log directory. If there have been problems 
with the process, there will be a log file, which you should review. The log file is named 
DNBUpMgrDNB_TaskNumber.log.

For information on running server components, see Siebel System Administration Guide.

To run the D&B Update Manager (D&B) server component from within your Siebel 
application (multiple task process)

1 Check that the Dun and Bradstreet component group is enabled.

2 Prepare a component job for D&B Update Mgr (Multi-task): 

■ Make sure to set the Mode to Asynchronous.

■ Create a job parameter where Name is Task Code (Abbreviation is DNBTaskCode) and Value 
is DNB.

■ If the data is being loaded for the first time, create a job parameter where Name is 
Configuration File Name (Abbreviation is DNBConfigFile) and Value is dnbinitial.sql.

3 Submit the component job.

4 When the process is done, open the log directory. If there have been problems with the process, 
there will be a log file, which you should review.

For information on running server components, see Siebel System Administration Guide.

To run the D&B Update Manager (Siebel) server component from within your Siebel 
application (single task process)

1 Check that the Dun and Bradstreet component group is enabled.

2 Submit a component job for D&B Update Mgr (Siebel); make sure to set the Mode to 
Asynchronous.

3 When the D&B Update Mgr (Siebel) is done, open the log directory. If there have been problems 
with the process, there will be a log file, which you should review. The log file is named 
DNBUpMgrDNB_TaskNumber.log.

For information on running server components, see Siebel System Administration Guide.

To run the D&B Update Manager (Siebel) server component from within your Siebel 
application (multiple task process)

1 Check that the Dun and Bradstreet component group is enabled.

2 Prepare a component job for D&B Update Mgr (Multi-task): 

■ Make sure to set the Mode to Asynchronous.

■ Create a job parameter where Name is Task Code (Abbreviation is DNBTaskCode) and Value 
is Siebel.

3 Submit the component job.
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4 When the process is done, open the log directory. If there have been problems with the process, 
there will be a log file, which you should review.

For information on running server components, see Siebel System Administration Guide.

To run the D&B Update Manager (D&B) server component from a command line 
(single or multiple task process)

1 Log in to the server using Server Manager. Use a command with this format:

SIEBEL_ROOT\siebsrvr\bin\>srvrmgr /g gateway /e enterprise_name /u db_username /p 
password /s siebserver

Examples:

>srvrmgr /g evlab6 /e siebel /u sadmin /p sadmin /s evlab6

2 At the srvrmgr prompt, enter one of the following commands:

■ start task for comp DNBUpMgrDNB (for single task process)

■ start task for comp DNBUpMgrMultiTask with DNBTaskCode=DNB (for multitask process)

■ start task for comp DNBUpMgrMultiTask with DNBTaskCode=DNB, 

DNBConfigFile=dnbinitial.sql (for initial data loading; see “Multiple D&B Update Manager 
(D&B) Processes with First Time Data Loading” on page 423)

3 During the DNBUpMgrDNB or DNBUpMgrMultiTask server process, monitor the status by entering 
the list task command:

list task for comp DNB%

4 When the D&B Update Mgr (D&B) or D&B Update Mgr (Multi-task) server process is finished, open 
the log directory. If there have been problems with the process, there will be a log file, which 
you should review. The log files are named DNBUpMgrDNB_TaskNumber.log or 
DNBUpMgrMultiTask_TaskNumber.log.

For information on running server components, see Siebel System Administration Guide.

To run the D&B Update Manager (Siebel) server component from a command line 
(single or multiple task process)

1 Log in to the server using Server Manager. Use a command with this format:

SIEBEL_ROOT\siebsrvr\bin\>srvrmgr /g gateway /e enterprise_name /u db_username /p 
password /s siebserver

Examples:

>srvrmgr /g evlab6 /e siebel /u sadmin /p sadmin /s evlab6

2 At the srvrmgr prompt, enter one of the following commands:

■ start task for comp DNBUpMgrSIEB (for single task process)

■ start task for comp DNBUpMgrMultiTask with DNBTaskCode=Siebel (for multitask process)
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3 During the DNBUpMgrDNB or DNBUpMgrMultiTask server process, monitor the status by entering 
the list task command:

list task for comp DNB%

4 When the D&B Update Mgr (D&B) or D&B Update Mgr (Multi-task) server process is finished, open 
the log directory. If there have been problems with the process, there will be a log file, which 
you should review. The log files are named DNBUpMgrDNB_TaskNumber.log or 
DNBUpMgrMultiTask_TaskNumber.log.

For information on running server components, see Siebel System Administration Guide.

Setting Up the Symbolic URL for Access 
to the D&B Database
When you have a connection to the Internet and have a D&B account set up already (with a user ID 
and password), you can:

■ Obtain the most current account information by invoking real-time searches of the D&B database 
and online purchase

■ Access and order D&B business and credit reports

For more information about D&B reports and about searching D&B for new accounts, see “Accessing 
Company Data and Reports with D&B” on page 439.

To access D&B data live from your Siebel application through the D&B Web site, you must first 
contact D&B for a user ID, password, and payment options. Then you can set up your Siebel 
application to access the D&B database.

To set up the symbolic URL for D&B real-time search and update

1 Navigate to the Administration - Integration screen > WI Symbolic URL List.

2 From the Show drop-down list, choose Symbolic URL Administration.

3 In the Symbolic URL list, select DNBGlobalAccess.

4 Make sure the URL is https://globalaccess.dnb.com/access/scripts/broker.asp

5 In the Symbolic URL Arguments list:

a Select the USERID record, and enter the user ID provided by D&B in the Argument Value field.

NOTE: This field is not case-sensitive.

b Select the USERPASS record, and enter the password provided by D&B in the Argument Value 
field.

To set up the symbolic URL for D&B report ordering

1 Navigate to the Administration - Integration screen > WI Symbolic URL List.
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2 From the Show drop-down list, choose Symbolic URL Administration.

3 In the Symbolic URL list, select DNBReport.

4 Make sure the URL is https://reportserver/scripts/ProductRetriever and that the Host 
Name is www.dnb.com.

5 In the Symbolic URL Arguments list:

a Select the USERID record, and enter the user ID provided by D&B in the Argument Value field.

NOTE: This field is not case-sensitive.

b Select the USERPSWD record, and enter the password provided by D&B in the Argument Value 
field.

6 From the Show drop-down list, select Host Administration.

7 In the HTTP Host list, make sure that there is a record where Name is www.dnb.com and Virtual 
Name is reportserver.

NOTE: If you are using Siebel eBriefings and want to enable a link from briefing documents to the 
D&B report ordering site, see Siebel eBriefings Administration Guide. 

Configuring D&B Integration
For general guidance on configuration, refer to Table 85.

A number of specific configuration topics are discussed in this section:

■ Update Server Process Configuration on page 430

■ Account Promotion and Prospect List Creation Configuration on page 430

■ Running the D&B Update Manager (D&B) Process Without Updating or Deleting Existing Data on 
page 431

Table 85. What to Configure?

If You Need to Customize the… Then…

Single task server processes for D&B Update 
Manager (D&B) or D&B Update Manager 
(Siebel)

■ Edit the dnbmaps.sql file in the 
…\siebelserver\SQLTEMPL directory.

Multiple task server processes for D&B 
Update Manager (D&B) or D&B Update 
Manager (Siebel)

■ Edit the dnbmaps.tsq file in the 
…\siebelserver\SQLTEMPL directory.

Account promotion ■ Configure the maps listed in Table 91.

■ Determine and make, if necessary, 
corresponding changes in the update server 
processes.
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■ Running the D&B Update Manager (Siebel) Process Without Updating Account Name or Account 
Location on page 432

TIP: When debugging in your test environment, increase the event log level to 4 to see more details 
in the log file. However, it is strongly recommended that you set the level to 1 (the default) when 
you run in a production environment in order to prevent the log file from overflowing. For information 
on event logging, see System Monitoring and Diagnostics Guide for Siebel eBusiness Applications. 

Update Server Process Configuration
The D&B update server processes use the Batch Real-Time Integration (RTI) technology and the RTI 
configuration files (dnbmaps.sql for single task and dnbmaps.tsq for multiple tasks). You can edit the 
RTI configuration files to suit your business requirements. 

The general syntax of the RTI maps specified in the configuration files is as follows:

UPDATE_SOME_TABLE.MOD1TABLE = [Target Table to update]

UPDATE_SOME_TABLE.MOD1WHERE = [A WHERE clause]

UPDATE_SOME_TABLE.MOD1INSERT = [TRUE/FALSE]

UPDATE_SOME_TABLE.MOD1UPDATE = [TRUE/FALSE]

UPDATE_SOME_TABLE.MOD1DELETE = [TRUE/FALSE]

UPDATE_SOME_TABLE.MOD1SQL = [A Valid SQL Query]

The RTI configuration files are located in the …\siebelserver\SQLTEMPL directory. 

“Field Mapping for the D&B Update Manager Process” on page 433 lists the default mapping for the D&B 
Update Manager (Siebel) server component.

Use caution when making changes to these RTI configuration files. It is recommended that you 
engage a qualified professional for your customization process.

CAUTION: Do not change the default DELETE setting in the existing UPDATE* sections. Do not set 
DELETE to TRUE. If your business need necessitates deleting rows in the target table as part of the 
D&B Update Manager process, consult Siebel Professional Services for help with this customization 
process.

Account Promotion and Prospect List Creation Configuration
You can select specific fields that will be populated by the D&B promotion to a Siebel account or by 
the D&B list-creation process. These are controlled by maps in the business component user 
properties within the DNB Account and DNB Contact business components. These maps are listed in 
Table 91 on page 437.

Using Siebel Tools, you can change, add, or delete source and destination field mapping. Reference 
the map descriptions given in Table 91 on page 437 to determine which map to use for a given set of 
source and destination fields. 
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Use caution when making changes to these maps. It is recommended that you engage a qualified 
professional for your customization process.

CAUTION: Although the delete capability is available, it is recommended that you deactivate 
unwanted map entries instead of deleting them. This is safer and can be accomplished by checking 
or clicking the deactivate column for the undesired entry.

You can create an entry using the following syntax:

Name Column: [MAP NAME]: [DESTINATION FIELD]

Value Column: [D&B SOURCE FIELD]

NOTE: Each map works only with a specific Destination Business Component and a specific Source 
Business Component.

Running the D&B Update Manager (D&B) Process Without Updating or 
Deleting Existing Data
Depending on your business process, you may want to run the D&B Update Manager (D&B) server 
component without updating or deleting any existing data in the S_DNB_ORG table. This is done by 
editing the RTI configuration file. 

To edit the RTI configuration file so that existing data in the S_DNB_ORG table is not 
updated or deleted

1 Open the RTI configuration file (dnbmaps.sql for single task or dnbmaps.tsq for multiple task) in 
a text editor.

2 Search for the UPDATE_DNB_ACCOUNT section under [Common] heading. 

3 Modify the section to look like the following (If you are using the default file, you need only to 
change UPDATE_DNB_ACCOUNT.MOD1UPDATE from TRUE to FALSE):

UPDATE_DNB_ACCOUNT.Function = NONE

UPDATE_DNB_ACCOUNT.MOD1TABLE = S_DNB_ORG

UPDATE_DNB_ACCOUNT.MOD1WHERE = WHERE 1 = 1

UPDATE_DNB_ACCOUNT.MOD1INSERT = TRUE

UPDATE_DNB_ACCOUNT.MOD1UPDATE = FALSE

UPDATE_DNB_ACCOUNT.MOD1DELETE = FALSE

UPDATE_DNB_ACCOUNT.MOD1TXNLOG = FALSE

4 Save and close the file.
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Running the D&B Update Manager (Siebel) Process Without Updating 
Account Name or Account Location
Depending on your business process, you may want to run the D&B Update Manager (Siebel) server 
component without updating the existing account names and account locations. This is done by 
editing the RTI configuration file.

To edit the RTI configuration file so that account names are not updated

1 Open the RTI configuration file (dnbmaps.sql for single task or dnbmaps.tsq for multiple task) in 
a text editor.

2 Search for UPDATE_SIEBEL_ACCOUNT.MOD1SQL under the Oracle, Oracle 8, Microsoft SQL Server, 
or DB2 statements.

3 Search for dnb.BUSINESS_NAME within the UPDATE_SIEBEL_ACCOUNT.MOD1SQL SELECT statement.

4 Comment out the line that begins dnb.BUSINESS_NAME… as shown.

UPDATE_SIEBEL_ACCOUNT.MOD1SQL = 

 SELECT acct.ROW_ID ROW_ID,

;dnb.BUSINESS_NAME NAME,

5 Save and close the file.

To edit the RTI configuration file so that account locations are not updated (single 
task)

1 Open the dnbmaps.sql file in a text editor.

2 Search for the UPDATE_SIEBEL = UPDATE_SIEBEL_ADDR_PHY… statement. This statement specifies 
the Siebel Table Groups to be updated when D&B Update Manager (Siebel) server component is 
run.

3 Within this statement, remove COMMIT, UPDATE_SIEBEL_LOC1, COMMIT, UPDATE_SIEBEL_LOC2, 
COMMIT, UPDATE_SIEBEL_LOC3.

4 Save and close the file.

To edit the RTI configuration file so that account locations are not updated (multiple 
task)

1 Open the dnbtask.cfg file in a text editor.

2 Under the [Siebel] section, comment out the line that begins Task5… as shown.

;;Task5 = UPDATE_SIEBEL_LOC1, COMMIT, UPDATE_SIEBEL_LOC2, COMMIT, 
UPDATE_SIEBEL_LOC3

3 Save and close the file.
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Field Mappings for Configuration of D&B 
Integration
This section provides field mapping information for three types of D&B integration processes:

■ Field Mapping for the D&B Update Manager Process

■ Field Mapping for D&B Real-Time Updates

■ Field Mapping for Account Promotion and Prospect Lists

Field Mapping for the D&B Update Manager Process
D&B Update Manager (D&B) server component. For the table mapping for the D&B Update 
Manager (D&B) component, examine the appropriate tables (Figure 29 on page 421) using Siebel 
Tools. The default field mappings can be determined by examining the UPDATE_DNB* sections of the 
RTI configuration file (dnbmaps.sql or dnbmaps.tsq).

D&B Update Manager (Siebel) server component. When the D&B Update Manager (Siebel) 
server component is run (Figure 30 on page 422), the fields listed in Table 86, Table 87 on page 434, 
and Table 88 on page 435 are mapped. The field mappings can also be determined by examining the 
UPDATE_SIEBEL* sections of the RTI configuration file.

For information about changing these default mappings, see “Update Server Process Configuration” 
on page 430.

Table 86. S_DNB_ORG Table Mapping for D&B Update Manager (Siebel)

From Column To Table To Column

DUNS_NUM S_ORG_EXT DUNS_NUMBER

BUSINESS_NAME S_ORG_EXT NAME

TRADESTYLE S_ORG_SYN NAME

SCND_TRADESTYLE S_ORG_SYN NAME

PHYS_STREET_ADDR       S_ADDR_ORG ADDR

SECOND_STREET_ADDR     S_ADDR_ORG ADDR

PHYSICAL_CITY          S_ADDR_ORG CITY

PHYSICAL_STATE         S_ADDR_ORG PROVINCE or STATE

PHYSICAL_ZIP           S_ADDR_ORG ZIPCODE

COUNTRY_NAME S_ADDR_ORG COUNTRY

COUNTY_NAME S_ADDR_ORG COUNTY

MAIL_ADDRESS S_ADDR_ORG ADDR

MAIL_ADDRESS_2 S_ADDR_ORG ADDR

MAIL_CITY S_ADDR_ORG CITY
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The S_PRSP_CONTACT table contains information about the D&B contacts such as the name of the 
CEO and various company executives. D&B provides up to four contacts per D&B account.

MAIL_STATE S_ADDR_ORG STATE

MAIL_ZIP S_ADDR_ORG ZIPCODE

TELEPHONE S_ORG_EXT PH_NUM

FAX_NUMBER S_ORG_EXT FAX_PH_NUM

ANNL_SLS_AMT S_ORG_EXT_X ATTRIB_14

CURRENCY_CODE S_ORG_EXT BASE_CURCY_CD

EMPLOYEES_TOTAL S_ORG_EXT_X ATTRIB_26

EMPLOYEES_HERE S_ORG_EXT EMP_COUNT

YEAR_STARTED S_ORG_EXT_X ATTRIB_27

LOC_TYPE_STAT_IND S_ORG_EXT included in LOC

PUBLIC_PRIVATE_IND S_ORG_EXT_X ATTRIB_08

GLBLULT_DUNS_NUM S_ORG_EXT GLBLULT_DUNS_NUM

DOM_ULT_DUNS_NUM       S_ORG_EXT DOM_ULT_DUNS_NUM

PAR_DUNS_NUM           S_ORG_EXT PAR_DUNS_NUM

LINE_OF_BUSINESS S_ORG_EXT_X ATTRIB 03

PCT_GROWTH_SLS_3YR     S_ORG_EXT_X ATTRIB_15

Table 87. S_PRSP_CONTACT Table Mapping for D&B Update Manager (Siebel)

From Column To Table To Column

LAST_NAME S_CONTACT LAST_NAME

FST_NAME S_CONTACT FST_NAME

MID_NAME S_CONTACT MID_NAME

PER_TITLE S_CONTACT PER_TITLE

PER_TITLE_SUFFIX S_CONTACT PER_TITLE_SUFFIX

JOB_TITLE S_CONTACT JOB_TITLE

SEX_MF S_CONTACT SEX_MF

Table 86. S_DNB_ORG Table Mapping for D&B Update Manager (Siebel)

From Column To Table To Column
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The S_DNB_ORG_SIC table contains the Standard Industrial Classification (SIC) code developed by 
the US Government. The code is assigned to businesses and other organizations by classifying and 
subdividing the activity performed by that establishment at that location. D&B provides up to six SICs 
per D&B account. In the D&B Update Manager process, the primary SIC code is mapped to the 
S_INDUST table and all SIC codes are mapped to the S_ORG_INDUST table.

Table 89 describes how address and contact information is updated by the D&B Update Manager 
(Siebel) process.

Field Mapping for D&B Real-Time Updates
When you purchase account information through the D&B Web site using the D&B real-time search 
and update feature in the Siebel application, certain fields in the Siebel business components are 
populated. These fields are a subset of the fields that are populated by the D&B Update Manager 
(D&B) server component. For example, D&B does not provide the contact first, last, and middle 
names fields in the real-time update.

Table 88. S_DNB_ORG_SIC Table Mapping for D&B Update Manager (Siebel)

From Column To Table To Column

ROW_ID S_INDUST PR_INDUST_ID

S_ORG_INDUST  INDUST_ID

Table 89. Update Rules for Addresses and Contacts

If This D&B Information Changes... Then...

Street address

City

(Abbreviated) state

A new address record is added to the Address 
table.

Address information other than street address, 
city, or state

The address record is updated in the Address 
table.

Phone number

Fax number

The address record is updated in the Address 
table.

Contact first name or

Contact last name

A new contact record is added to the Contact 
table.

Contact information other than first or last 
name

The contact record is updated in the Contact 
table.
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Table 90 lists the fields that may be populated or updated when you purchase account information 
using the D&B real-time search and update feature.

Table 90. Fields Populated by D&B Real-Time Search and Update

D&B WorldBase Marketing Plus with 
Linkage

Siebel Business Component Name.Field 
Name

Business Structure Code (Location Type) DNB Account.Location Type

Domestic Ultimate Name DNB Account.Domestic Ultimate Business Name

Global Ultimate Name DNB Account.Global Ultimate Business Name

Parent/HQ Business Name DNB Account.Parent HQ Name

Physical State DNB Account.State Name

Business Name DNB Account.Business Name

Trade Style DNB Account.Trade Style

Street Address DNB Account.Physical Address

Mail Address DNB Account.Mail Address

City Name DNB Account.Physical City

Mail City Name DNB Account.Mail City

Physical State/Province Abbreviation DNB Account.Physical State

Mailing State/Province Abbreviation DNB Account.Mail State

ZIP/Postal Code DNB Account.Physical Zip

Mail Postal/ZIP Code DNB Account.Mail Zip

Country Name DNB Account.Country Name

D&B D-U-N-S Number DNB Account.DUNS Number

Telephone Number DNB Account.Main Phone 2

Cable/Telex Code DNB Account.Cable Telex Number

Facsimile Number DNB Account.Main Fax 2

National ID DNB Account.National Identification Number 2

SIC Code DNB Account.SIC Code

Primary Local Activity Code DNB Account.Primary Local Activity Code

Year Started DNB Account.Year Started 1

Employees Here DNB Account.Employee Here

Employees Total DNB Account.Employee Total

Annual Sales US Dollars DNB Account.Sales Volume

Annual Sales Local DNB Account.Annual Sales Local Currency
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Field Mapping for Account Promotion and Prospect Lists
When end users promote D&B accounts or create prospect lists from the D&B screen, fields in the 
DNB Account and DNB Contact business components are mapped to fields in other business 
components. These maps are listed in Table 91 and can be viewed in detail in the Business 
Component User Properties window of Siebel Tools.

For information about promoting accounts and creating prospect lists, see Chapter 38, “Opportunities 
(End User).” 

Legal Status DNB Account.Legal Status

Subsidiary Code DNB Account.Subsidiary Indicator

Import / Export / Agent Ind. DNB Account.Import Export Code

Global Ultimate D&B D-U-N-S Number DNB Account.Global Ultimate DUNS

Global Ultimate Indicator DNB Account.Global Ultimate Indicator

Global Ultimate WorldBase Country Code DNB Account.Global Ultimate Country Code

Domestic Ultimate D&B D-U-N-S Number DNB Account.Domestic Ultimate DUNS

Headquarter/Parent D&B D-U-N-S Number DNB Account.Parent HQ DUNS

HQ/Parent WorldBase Country Code DNB Account.Parent/HQ Country Code

Table 91. Maps of D&B to Siebel Fields for Promotion and List Creation

User Property 
Prefix and Map 
Name

D&B 
Source 
Business 
Component

Siebel 
Destination 
Business 
Component Process and Description

Account Map DNB 
Account

Account Promotion

Specifies the fields in DNB Account that is 
copied to Account business component

Contact Map DNB Contact Contact Promotion

Specifies the fields in DNB Contact that is copied 
to Contact business component

Mailing Address 
Map

DNB 
Account

Business 
Address

Promotion

Specifies the mailing address fields in DNB 
Account that is copied to Business Address

Table 90. Fields Populated by D&B Real-Time Search and Update

D&B WorldBase Marketing Plus with 
Linkage

Siebel Business Component Name.Field 
Name
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Physical Address 
Map

DNB 
Account

Business 
Address

Promotion

Specifies the physical address fields in DNB 
Account that is copied to Business Address

Prospect Info Map DNB Contact List Mgmt 
Prospective 
Contact

Create Prospect List

Specifies the biological information (such as last 
name, first name, and so on) 

Prospect Contact 
Info Map

DNB 
Account

List Mgmt 
Prospective 
Contact

Create Prospect List

Specifies the contact information (such as 
company, address, phone number, and so on) 
fields in the DNB Account that is copied into the 
List Mgmt Prospective Contact

Table 91. Maps of D&B to Siebel Fields for Promotion and List Creation

User Property 
Prefix and Map 
Name

D&B 
Source 
Business 
Component

Siebel 
Destination 
Business 
Component Process and Description
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This chapter describes how to use D&B data and reports to manage customer relationships, acquire 
new customers, and create high quality new account records. It includes the following topics:

■ “Accessing Company Data and Reports with D&B” on page 439

■ “Viewing D&B Aggregate Data for a Company” on page 439

■ “Promoting a D&B Account” on page 440

■ “Creating a Prospect List from D&B Data” on page 440

■ “Viewing a D&B Report” on page 441

■ “Using Global Integration to Add New D&B Accounts” on page 441

Accessing Company Data and Reports 
with D&B
The D&B screen allows you to access D&B marketing data as well as business and credit reports from 
within your Siebel application. 

You can directly access D&B data for use in prospecting, qualifying leads, and generating marketing 
lists. You also can integrate D&B data and reports into your Siebel application, allowing you to 
perform the following tasks:

■ Use D&B information to standardize data for your customer accounts

■ Access D&B business and credit reports

■ Search D&B for new accounts

■ Generate prospect lists based on D&B relationships and demographic data

■ View account hierarchies and related opportunities across a corporate family structure

Viewing D&B Aggregate Data for a 
Company
When you have the D&B account information loaded into your Siebel application, a number of views 
allow you to use the data and view company hierarchies. The following procedure explains how to 
view aggregate data for a company using the D&B screen.

NOTE: D&B data for a company is read-only until the company is promoted to a Siebel account. For 
more information, see “Promoting a D&B Account” on page 440.
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To view aggregate data

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the account for which you want to view the aggregate data.

3 In the More Info form, click Query.

4 In the query form, enter the query criteria, and then click Go.

A list of D&B accounts that meet your criteria appear.

NOTE: If the DUNS # field does not appear in the list, click the menu button, choose Columns 
Displayed, and adjust the list of displayed columns.

Promoting a D&B Account
You can use the D&B list to locate accounts that are potential sales leads. After you identify accounts 
that meet your criteria, you can promote the accounts into your accounts list.

To promote a D&B account

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company or companies that you want to add to your accounts 
list.

■ To select a sequence of account records, hold down the SHIFT key and click the account 
records. 

■ To select multiple accounts that are not in sequence, hold down the CTRL key and click the 
account records.

3 In the D&B Accounts list, click Promote as Siebel Account.

A check mark appears in the Promoted field and the company is added to your Siebel application. 

Drill down on the hyperlink in the Business Name field to view the account profile and related 
contacts.

Creating a Prospect List from D&B Data
You can use D&B data to generate sales leads. One way to use sales leads is to create a prospect list 
for your telesales or sales team to contact.

To create a prospect list

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company or companies that you want to include in your list, 
and then click Create D&B Lists.

The contacts associated with the company or companies are added to a prospect list.
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3 To view the prospect list, select D&B Lists from the Show drop-down list.

4 In the D&B Lists list, select the list and drill down on the list name hyperlink to view accounts on 
the list.

Viewing a D&B Report
After a D&B report order is set up by your administrator, you can view business and credit reports 
from within your Siebel application. This information can also be viewed from the Accounts screen’s 
D&B Reports view tab.

To view a D&B report

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company for which you want to view reports.

3 Click the Reports view tab.

The D&B report for the selected company appears. 

Using Global Integration to Add New 
D&B Accounts
After a D&B Global Integration access is set up by your administrator, you can access D&B real-time 
within your Siebel application and enter criteria to locate new accounts in the D&B database. Search 
criteria can include the business name with state/province and country information, D&B D-U-N-S 
number, local business ID, and telephone number.

When you execute a search for new D&B accounts, the search criteria is sent to D&B's Global 
Integration, along with the user’s D&B account name and password. When D&B receives the 
information, Global Integration automatically selects the single best search method to execute based 
on the criteria. D&B calculates the criteria matches and returns the number to Siebel. If there are 
no matches for the criteria, the requestor is notified.

At this point, you can opt to purchase the account information, or cancel the Global Integration 
search process. If an account is purchased, data received from D&B is added to the Siebel D&B tables 
and is available in D&B All Accounts view.

NOTE: If the selected account already exists in your Siebel D&B database, the account is not 
purchased. 

To initiate D&B’s Global Integration search

1 Navigate to the D&B screen > D&B Accounts List view.

2 Click Search D&B for New Account.
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3 In the Search D&B dialog box, complete the fields for the query.

The following illustration shows an example of the search criteria form.

You must enter sufficient data to initiate a query in the United States. For example, as the 
following figure shows, in the Search D&B form you can enter Business Name, State/Province 
and Country as criteria, or just the D-U-N-S number, or the Local Business ID and Country, or 
the Phone number and Country. If you only enter the Business Name, the search fails because 
the data is insufficient.

The following table describes the Search D&B query fields.

Field Comments

Business Name The Name/Address search is the most commonly used search 
method. At a minimum, the business name and country must be 
supplied. For Canadian businesses, the province must also be 
included. 

When you are searching for a business by name, do not use wildcard 
characters, (*) for unknown characters in the name.

Additional information such as town, street address, and postal code, 
can be included to increase the chances of finding an exact match.

Street Address

City

State/Province

Country Name

ZIP Code

DUNS # This search method allows you to enter a known D&B D-U-N-S 
number to verify the identity of a business. The D&B D-U-N-S 
number should contain only nine numeric characters (no spaces, 
dashes, and so on). 
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4 After you have entered the criteria, click Search D&B.

The following figure shows sample search results, with the business name, city, and state in the 
Search Results list.

Local Business ID Many countries have their own numbering schemes to identify local 
businesses. Normally, this is a government-sponsored schema for 
the purpose of business registration and tax filing. 

The local business ID submitted in a search should only contain 
numeric characters (no spaces, dashes, and so on). A country code 
must also be included with the request. 

D&B Global Integration supports searching by the following local 
business identifiers.

Australia—CAN 

Belgium—BTW/TVA

France—SIREN

Germany—Hr. Number

Ireland—Company House

Italy—CCIAA

Netherlands—KvK Nr

Portugal—Fiscal

Spain—CIF/NIF

Sweden—Company House

United Kingdom—Company House

Phone # If using a telephone number search, enter the telephone number as 
dialed from within the country, including the area code or city code 
if required. The international long distance code (country code) 
should not be included. 

For example 9086655000 for a search in New Jersey, US; 
9055686000 for a search in Ontario, Canada; 01494422000 for a 
search in High Wycombe, England; 0104009400 for a search in 
Rotterdam, Netherlands. 

The telephone number should contain only numeric characters (no 
spaces, dashes, and so on).

Field Comments
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5 In the Search D&B list of results, select an account, and then click Purchase.

Click Refine Query to modify the query criteria. Click Cancel to return to the D&B Accounts list 
without purchasing.

The purchased account is highlighted in the D&B Accounts list.
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This chapter describes setting up ASIs for accounts, contacts, and households. It includes the 
following topics:

■ “About ASIs for Accounts, Contacts, and Households” on page 445

■ “Setting Up Account, Contact, and Household ASIs” on page 446

■ “ASI Workflow Descriptions” on page 448

About ASIs for Accounts, Contacts, and 
Households
ASIs allow you to integrate Siebel applications with other applications in real time. 

The Accounts, Contacts, or Households screens use ASIs to exchange data with any external system 
such as a back-office application. These are listed in Table 92.

You must set up these ASIs shipped with your Siebel application before they can be used. This 
chapter provides the procedures that you must perform to set up these ASIs. Depending on your 
business needs, you may choose to set up ASIs and activate workflows for some or all of the GUI 
commands listed in Table 92.

For general information about ASIs, see Application Services Interface Reference.

Table 92. ASIs for Accounts, Contacts, and Households

Screen GUI Command Workflow
Outbound and 
Inbound ASI Pairs

Accounts Update External System Synchronize Account ASI External Account

Siebel AccountAccounts (Credit 
Profile view)

Refresh Get Account ASI

Contacts Update External System Synchronize Contact ASI External Contact

Siebel Contact

Households Update External System Synchronize Household ASI External Household

Siebel Household
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Setting Up Account, Contact, and 
Household ASIs
This section describes how to set up the prebuilt ASIs for Accounts, Contacts, and Households:

1 Set up outbound and inbound Web services. See “Setting Up Web Services for Account, 
Contact, and Household ASIs” on page 446.

2 Activate workflows. See “Activate Workflows for Account, Contact, and Household ASIs” on 
page 447.

Other tasks you may want to perform are:

■ Extending ASIs. See Application Services Interface Reference.

■ Deactivating fields in the ASIs. See Application Services Interface Reference.

■ Customizing ASI workflows. See Siebel Business Process Designer Administration Guide.

Setting Up Web Services for Account, Contact, and Household ASIs
To set up the Web services, you must set up both outbound and inbound Web services for the ASIs. 
The procedures that follow show you the steps required for each ASI.

To set up an outbound Web service

1 Navigate to the Administration - Web Services screen > Outbound Web Services view. 

2 In the Outbound Web Services list, create a query to display the record with External Account, 
External Contact, or External Household in the Name field.

3 Verify that the fields in the Outbound Web Services list match those in the following table. 

4 In the Service Ports list, click New, and enter the following values in the fields of the new record.

Namespace Name Status

http://siebel.com/asi/ One of the following:

External Account

External Contact

External Household

Active

Field Comments

Name Enter a name for the port.

Port Type Enter External Account, External Contact, or External Household.

Transport Select from the drop-down list.
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To set up an inbound Web service

1 Navigate to the Administration - Web Services screen > Inbound Web Services view. 

2 In the Inbound Web Service list, create a query to display the record with Siebel Account, Siebel 
Contact, or Siebel Household in the Name field.

3 Verify that the fields in the Inbound Web Services list match those in the following table. 

4 In the Service Ports list, review the information in the fields for the service port and make any 
changes required for your system.

5 In the Operations list, review the information shown and make any changes required for your 
system.

Activate Workflows for Account, Contact, and Household ASIs
You must activate the following workflow processes used for real-time integration of account, contact 
and household data:

■ Synchronize Account ASI

■ Get Account ASI

■ Synchronize Contact ASI

■ Synchronize Household ASI

For a description of these workflows, see “ASI Workflow Descriptions” on page 448.

To activate workflows used by Account, Contact, and Household ASIs
■ See Siebel Business Process Designer Administration Guide.

Address When you select a transport, the field will be populated with a template address. 
Edit the address based on where you are sending the data.

Binding If a SOAP header is expected by the receiving application, select SOAP_RPC.

Namespace Name Status

http://siebel.com/asi/ One of the following:

Siebel Account

Siebel Contact

Siebel Household

Active

Field Comments
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ASI Workflow Descriptions
This section describes the workflow processes that are used to invoke the ASIs for account processes. 

It is not necessary to modify these workflows, but you can modify them to suit your business model. 

Synchronize Account ASI
This workflow submits the account information to the outside system to synchronize the information 
between the two systems.

■ Query For Account By Id: Queries for the account on the current system using the object ID. 
Returns an account property set containing the account information.

■ External Account Proxy: Calls the Synchronize method on the outside system, passing in the 
account property set. This step returns an account property set, which will contain any changes 
the outside system made to the account.

■ Synchronize Account: Takes the account property set returned by the previous step and 
synchronizes it with the account in the current system.

Synchronize Contact ASI
The Synchronize Contact ASI process is essentially the same as the Synchronize Account ASI 
process, except that contact replaces account.

Synchronize Household ASI
The Synchronize Household ASI process is essentially the same as the Synchronize Account ASI 
process, except that household replaces account.

Get Account ASI
This workflow queries the outside system to retrieve the latest information on the account. It returns 
the new information and synchronizes the account on the current system.

■ Query Account By Id: Queries for the account on the current system using the object ID. Returns 
an account property set containing the account information.

■ Isolate Integration Id: In the next step, the workflow uses a query by example. Query by 
example takes the property set and looks for an account with exactly the same values for the 
fields in the property set. If the account has changed on the outside system, those values will no 
longer match. The workflow needs to query by a value that does not change, that is, the 
integration ID. Isolate Integration Id takes in a property set and removes all the fields, except 
the integration ID.

■ External Account Proxy: Using the property set, which only has an integration ID now, this step 
queries by example on the outside systems. Once it finds the account with that integration ID, 
it returns an account property set containing the account information.

■ Synchronize Account: Takes the account property set returned by the previous step and 
synchronizes it with the account in the current system.
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This chapter describes using contacts in the Siebel application. It includes the following topics:

■ “About Contacts” on page 449

■ “Scenario for Contacts” on page 449

■ “Adding a Contact” on page 450

■ “Associating a Contact with an Account” on page 452

■ “Associating a Contact with an Opportunity” on page 452

■ “Associating Attachments with a Contact” on page 452

■ “Promoting a Personal Contact to a Sales Contact” on page 453

■ “Creating a Profile for a Contact” on page 453

■ “Adding a Contact to a Synchronization List” on page 453

■ “Updating Contact Information in External Systems” on page 454

About Contacts
Contacts are individuals with whom your company conducts business or expects to conduct business 
in the future. These individuals can be employees of other companies, independent consultants, 
vendors, or personal acquaintances. Contacts can be associated with several accounts, but a contact 
is the primary on only one account. Contacts can also be associated with a number of opportunities.

This chapter describes how sales professionals can use the Contacts screen to record information 
about individuals who interact with their company.

Scenario for Contacts
This scenario provides an example of a business process performed by a sales representative 
managing new and existing contacts. Your company may follow a different process according to its 
business requirements.

In the course of a business day, a sales representative interacts with other professionals. These 
formal and informal exchanges can result in potential leads or sales opportunities. 

A sales representative determines if her company has done business with a particular company by 
reviewing account and contact records. In cases where contacts are not listed, the sales 
representative creates new contact records in the Siebel Sales application, and associates the 
contacts with new or existing accounts.
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If the possibility of doing business—an opportunity—arises, the sales representative creates the 
opportunity and associates activities and contacts with the opportunity. This helps the sales 
representative track important milestones for obtaining and closing deals.

Adding a Contact
When a sales representative identifies an individual as a possible source for leads, that individual’s 
information is added to Siebel Sales as a contact. Team members can access this contact information 
while they are working on potential business opportunities. 

A contact team is a group of employees or partners who can view the contact information in the My 
Contacts view. If you work in a Mobile Web Client environment and are a member of the contact 
team, the contact information is downloaded to your local database the next time you synchronize. 

Use the following procedure to create a contact record.

To add a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, create a new record and complete the necessary fields.

A contact record only appears on the My Contacts view if you are on the contact team for the 
contact.

3 Drill down on the record and click the More Info view tab to display additional fields in the More 
Info form.

Some fields are described in the following table.

Field Comments

Account Displays the account with which the contact is associated.

Address Line 1 Inherits the primary address for the account associated with the 
contact. You cannot add address information in this field.

Comments A text field that shows any additional information associated with the 
contact.

Contact Method A list of values established by your company that is used to define the 
contact’s preferred method of interaction. Default values include 
Email, Fax, Pager, and Phone.

Contact Team A default value based on your user ID. After you create a contact, you 
are automatically listed as the primary team member. You can add 
individuals to the contact team by selecting them from the employee 
list. Only a manager or administrator can change the primary contact 
team member, or can delete the primary contact team member.

Disable Cleansing A check box which, when selected, does not allow data cleansing.
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Employee Flag If checked, this flag indicates that the contact is an employee of your 
company.

First Name A required field that displays the contact’s first name.

Global Owner Displays the name of the team member who is the global account 
owner. In cases of multinational or global companies, this designates 
one main account team member to oversee the account.

Households Displays the household to which the contact is affiliated. Households 
allow you to track and target contact affiliations, and often these 
contacts share an address. For more information on Households, see 
Chapter 39, “Households.”

Job Title A text field that displays the contact’s professional title.

Last Name A required field that displays the contact’s last name.

Lock Assignment A check box which, when selected, locks the contact team assignment 
from reassignment by Siebel Assignment Manager.

Manager Last Name Displays the manager’s last name. This field must be populated before 
you can perform an organizational analysis.

Middle Initial An optional field that displays the contact’s middle initial.

Never Call A check box which, when selected, indicates that the contact should 
not be telephoned as a method of contact.

Never Email A check box which, when selected, indicates the contact does not want 
to receive email.

Never Mail A check box which, when selected, indicates that the contact does not 
want to receive mail from your company.

Organization A default value displaying the name of the organization to which you 
belong. Your system administrator sets up organizations in your Siebel 
application. You can associate multiple organizations with an 
opportunity, but your organization is listed as the default organization.

Send Email Updates A check box which, when selected, indicates that the contact is willing 
to receive email updates about products and services.

Status Examples are Active, Qualified, Marked for Deletion.

Sync A read-only check box, which indicates the user has included the 
contact record in the user’s Sync List. Requires Siebel Server Sync.

Sync List A dialog box that displays the User IDs of users who synchronize the 
contact with a personal information manager (PIM) such as Lotus 
Notes or Microsoft Outlook. Requires Siebel Server Sync.

Time Zone Displays the time zone in which the contact works or lives.

Field Comments
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Associating a Contact with an Account
A contact can be associated with one or more accounts, although the contact is designated as the 
primary on only one account. Use the Accounts view to list accounts associated with a contact.

To associate a contact with an account

1 Navigate to the Contacts screen > Contacts List > Accounts view.

2 Query for the contact and create records in the Accounts list. 

Associating a Contact with an 
Opportunity
A contact can be a source of revenue for the organization. Potential revenue-generating events are 
called opportunities. You can associate a contact with an opportunity to track information about both 
the opportunity and the contact.

To associate a contact with an opportunity

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact, and then click the Opportunities view tab.

3 In the Opportunities list, click New.

4 In the Add Opportunities dialog box, select the opportunity to associate with the contact, and 
then click OK.

Associating Attachments with a Contact
An attachment is a file created in another application that you can associate with a contact record. 
Documents can be attached to contact records to maintain an interaction history for the contact or 
the opportunity. Attachments can include email correspondence, pending contracts, and product data 
sheets. Associating attachments with a contact record allows the sales team to share information 
about the contact.

To associate an attachment with a contact

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact, and then click the Attachments view tab.

3 In the Attachments list, click New.

The Update File check box is automatically selected as a default. If you do not want the attached 
file automatically updated as the source file changes, clear the check box.

4 In the Attachment Name field, click the select button.
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mple, 
5 In the Add Attachment dialog box, click Browse.

6 In the Choose File dialog box, select the file, and then click Open.

7 In the Add Attachment dialog box, click Add.

The attachment appears in the Attachments list.

Promoting a Personal Contact to a Sales 
Contact
Contact records can be promoted from the My Personal Contacts view to the My Contacts view.

To promote a contact from My Personal Contacts to My Contacts

1 Navigate to the Contacts screen > Personal Contacts List view.

2 In the Contacts list, select the contact for promotion.

3 In the Contact form, clear the check box in the Private field.

The Contact record appears in the My Contacts list.

NOTE: You cannot designate a contact as Private (My Personal Contacts) from the My Contacts list.

Creating a Profile for a Contact
A profile consists of information that is collected about a contact. This information can include a 
contact’s expenditure approval, hobbies, education, and the name of the contact’s spouse.

To create a profile

1 Navigate to the Contacts screen > Contacts List > Profile view.

2 Query for the contact.

3 In the Profile form, complete the fields.

Adding a Contact to a Synchronization 
List
A contact can be added to a list for synchronization with a personal information manager (PIM), for exa
Microsoft Outlook, using Siebel Server Sync. For more information about synchronizing contacts, see 
Siebel Server Sync Guide.

To add a contact to a sync list

1 Navigate to the Contacts screen > Contacts List view.
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2 In the Contacts list, select the contact to be added to the Sync List.

3 Click the menu button, and then select Add to Sync List.

A check mark appears in the Sync check box in the Contact form.

A contact can also be added to a different Sync List by clicking the select button in the Sync List 
field in the contact form.

To remove a contact from a sync list

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, select the contact to be removed from the Sync List.

3 Click the menu button, and then select Remove from Sync List.

The check mark is removed from the Sync check box in the Contact form.

Updating Contact Information in 
External Systems
If the Siebel administrator has set up real-time integration of contacts between Siebel Sales and a 
back-office system or other systems in your organization, you can use the Update External System 
command to send new and modified contact information from Siebel Sales to another system.

This Application Services Interface (ASI) feature allows a real-time contact data update between 
Siebel and a third-party external system, maintaining consistent customer information across the 
enterprise and eliminating manual entry of customer data in multiple systems.

The Update External Systems command also can be used to synchronize account data with external 
systems. For more information, see “Updating Account Information in External Systems” on page 462.

This procedure assumes that the Siebel administrator has completed the work necessary to allow 
real-time contact integration through ASI. For information about how to set up the Web services 
administration to communicate with the external system, ASI structures, configuring and 
customizing the ASI, see Application Services Interface Reference and Chapter 32, “Integration Using 
ASIs.”

To update contact information in an external system

1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, create a new record and complete the necessary fields.

3 (Optional) Navigate to the Contacts screen > Contacts List > Accounts view.

4 (Optional) In the Accounts list, click New, and then complete the fields to associate an account 
with the contact.

5 In the Contacts applet, click the menu button, and then choose Update External System.
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An account represents the relationship between a company and the companies or individuals with 
whom it conducts business. Sales representatives use the Accounts screen and its associated views 
as the primary navigation tool for customer interactions.

This chapter describes how sales professionals can use the Accounts screen to create new customer 
accounts, modify and add account information for existing customers, respond to customer inquiries, 
and view account information.

This chapter includes the following topics:

■ “Scenario for Accounts” on page 455

■ “Creating an Account” on page 456

■ “Associating a Contact with an Account” on page 459

■ “Associating an Account with an Activity” on page 459

■ “Associating an Account with an Opportunity” on page 460

■ “Performing Account Assessments” on page 461

■ “Updating Account Information in External Systems” on page 462

■ “Viewing Account Credit Profiles” on page 462

Scenario for Accounts
This scenario provides an example of the business process performed by a sales representative 
managing new and existing accounts. Your company may follow a different process according to its 
business requirements.

At a vendor site, a sales representative meets a prospect. After a brief discussion, the sales 
representative determines that the prospect is interested in learning more about the products and 
services that the sales representative’s company sells. The sales representative sets up a sales call 
with the prospect.

During the sales call, the sales representative asks a number of questions to determine the account 
structure of the prospect’s business and to decide how best to meet the prospect’s needs.

The sales representative learns that the prospect’s business has four locations, and that each service 
is billed through the main office, and each location receives a billing statement. 

After the meeting, the sales representative returns to the office and begins creating the account 
structure for the prospect’s business.
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Creating an Account
After a business relationship is identified, you can enter the details about the account. As account 
details evolve or change, you can update the account information. Before adding a new account, 
search the accounts list to make sure the account does not already exist.

To create an account

1 Navigate to the Accounts screen > Accounts List view.
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2 In the Accounts list, create a new record and complete the necessary fields.

Drill down on the account record and click the More Info view tab to see more fields.

Some fields are described in the following table.

Field Comments

Account Type A list of values established by your company defines the type of 
account. Default values include Commercial, Competitor, Consultant, 
and Customer.

Assignment Area Code Displays an area code for the account. This indicates that a sales 
representative from the same area code should be assigned to the 
account.

Assignment Country 
Code

Displays a country code for the account. This indicates that a sales 
representative from the same country code should be assigned to the 
account.

PO Auto-Approval Limit The amount for which a Purchase Order can be automatically 
approved.

Competitor A check box which, when selected, indicates the account is a 
competitor.

Current Volume Displays a monetary amount that represents the account’s current 
sales volume.

Disable Cleansing A check box which, when selected, does not allow data cleansing.

Domestic Ultimate 
DUNS

Displays the D-U-N-S number for the domestic ultimate, which is the 
highest member in the hierarchy for the same business entity within 
the same country. A case can be its own domestic ultimate.

DUNS# The Data Universal Numbering System (D-U-N-S) numeric serial 
number for a company. The D-U-N-S number is unique for each 
company.

Expertise A list of values established by your company that defines the area of 
expertise for the account. Default values include Technology, Quality 
Control, and Client Management.

Global Owner Displays the ID of the team member who is the global account owner. 
In cases of multi-national or global companies, this designates one 
main account team member to oversee the account.

Global Ultimate DUNS Displays the D-U-N-S number for the global ultimate, which is the 
highest member in the hierarchy for the same business entity 
worldwide.

Inventory Location Displays the physical location of the inventory.

Lock Assignment A check box which, when selected, locks the sales team assignment 
from reassignment by Siebel Assignment Manager.

Name A required value that identifies the account.
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NOTE: When a company change names or merges with another company, you must transfer account 
names and contacts to the new account name. Contact Siebel Technical Support or your 
implementation team for more information on how to rename an account.

Organization Displays the name of the organization with which the account is 
associated in your Siebel application.

Parent Displays a parent account if the account is a subsidiary of a larger 
company.

Parent/HQ DUNS D&B number for the account's parent account.

Partner A check box which, when selected, indicates the account is a 
business partner.

PO Approval Limit Displays a monetary limit up to which a PO is approved.

PO Approved A check box which, when selected, indicates the Purchase Order (PO) 
has been approved.

Potential Volume Displays a monetary amount that represents the account’s potential 
sales volume.

Price List Displays a price list associated with the account. Your application 
administrator establishes price lists based on criteria defined by your 
company.

Reference A check box which when selected indicates the account offers a 
reference for your company’s products or services.

Referenceable as of Displays the date when the account first became a reference

Shipping Information A text field for additional shipping details.

Shipping Terms A list of values established by your company that defines the terms 
for shipping. Default values include Due, FOB, TBD, and No Charge. 

Stage A list of values established by your company that defines the account 
stage according to your sales or other methodology. Default values 
include Project Planning and Strategy, Analysis and Design, Testing 
and Production Pilot, Rollout, and On Hold.

Status A list of values established by your company that defines the account 
status. Default values include Active, Contract Pending, Gold, and 
Inactive.

Synonyms Displays a synonym for the account.

URL Displays the Universal Resource Locator (URL) for the account Web 
site.

Field Comments
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Associating a Contact with an Account
As you work with a prospective account, you develop business relationships with the contacts 
associated with an account. 

Contacts can belong to multiple accounts, only one of which can be the primary account. Deleting a 
contact record in the Accounts screen’s Contacts view only removes the contact’s association with 
the account. The original contact record is still available in the Contacts list. 

To associate a new contact with an account 

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, drill down on the account, and then click the Contacts view tab.

3 In the Contacts list, click New, and complete the fields for the contact.

To associate an existing contact with an account

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, drill down on the account, and then click the Contacts view tab.

3 In the Contacts list, click Add.

4 In the Add Contacts dialog box, enter query criteria for the contact, and then click Go.

5 Select the contact to add, and then click OK.

To update an external system with an account contact

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, drill down on an existing account, and then click the Contacts view tab.

To create a new account, see “Creating an Account” on page 456.

3 In the Contacts list, select the contact.

4 In the contact record, drill down on the contact name hyperlink, and then in the contact form, 
complete any additional fields. 

5 In the Contact form, click the menu button, and then choose Update External System.

Associating an Account with an Activity
An activity is a task or event that is generally, but not always, performed for a contact, an account, 
or an opportunity. You will most likely attend meetings, calls, presentations, and perform other 
activities associated with an account. You can use the Activities list to enter and track account-
related activities. If the activity has a time associated with it, the activity appears in the Activities 
list and Calendar.
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An account can have a number of activities associated with it. You can associate an activity with an 
account to track which activities you have completed and track those you want to accomplish in the 
future as you manage the account relationship.

To associate an account with an activity

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, drill down on the account associated with the activity, and then click the 
Activities view tab.

3 In the Activities list, create a new record and complete the necessary fields.

a In the Type field, drill down on the hyperlink for the default value to change the type of activity. 

b In the Display In field, choose the display method for the activity.

For example, the activity can appear in Calendar and Activities, To Do and Activities, and 
Activities Only.

Associating an Account with an 
Opportunity
Accounts are a source of business for your company. An opportunity is a potential revenue-
generating event and the opportunity record stores information that you can use to manage 
accounts.

To associate an account and an opportunity

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, drill down on the account.

3 Click the Opportunities view tab.

4 In the Opportunities list, create a new record and complete the necessary fields.

The Account field and the Primary (team member) field are automatically populated. The Close 
Date field value defaults to the opportunity creation date.

5 To display more fields, in the Opportunities list click the menu button and then choose Columns 
Displayed.

The following table describes some of the fields.

Field Comments

Account A value inherited from the selected account. 

Close Date Allows you to enter the expected date on which the opportunity closes. The 
default date is the opportunity creation date. Modify the close date if the 
opportunity closes on a different date, because this date is used in revenue 
forecasting.
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Performing Account Assessments
Account assessments can be used to compare accounts to one other, compare them to a model, or 
to determine what information is present or not for an account. You complete the assessment by 
selecting the appropriate values for the different opportunities.

To perform an account assessment

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, drill down on the account, and click the Assessments view tab.

3 In the Assessments list, create a new record and complete the necessary fields.

a In the Template Name field, click the select button.

The Select Assessment Template dialog box appears.

b Select the template, and then click OK.

4 Click the Assessment Attribute subview tab, and then click the show more button.

■ In the Value field, click the select button and then select the appropriate value for the 
account.

A composite assessment score for the account appears as a percentage value in the parent 
Assessment list. This percentage compares the score you entered in the assessment attribute 
line items to the maximum possible score for the account. You can use this percentage to profile 
the account.

Name Displays the name of the opportunity.

Primary Displays your User ID when you create the opportunity. This value can be 
changed.

Priority Flag A check box which indicates that an account is a high priority (urgency for 
sales team). When the priority is set by selecting the check box, a flag 
appears in the priority column.

Revenue Allows you to enter the currency amount of the opportunity. This field 
defaults to zero. 

Sales Stage A list of values established by your company that defines the sales stages 
associated with the sales method you selected.

Field Comments
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Updating Account Information in 
External Systems
If your Siebel administrator has set up real-time account integration between Siebel Sales and a 
back-office system or other systems in your organization, you can use the Update External System 
command to send new and modified account information from Siebel Sales to another system in real-
time.

This Application Services Interface (ASI) feature allows you to initiate a real-time account data 
update between Siebel and external system, maintaining consistent account information across the 
enterprise and eliminating manual entry of account data in multiple systems.

By default, in the Accounts screen, the Update External System command triggers the business 
process Synchronize Account ASI. This business process sends account information to the external 
system, and updates Siebel with the response from the external system. This business process can 
be viewed by navigating to the Business Processes screen from the Site Map, and querying for the 
business process name.

The following procedure explains how to send account information from Siebel Sales to another 
system. The contacts that are associated with the account must sent separately to the external 
system. For more information, see “Updating Contact Information in External Systems” on page 454. 

This procedure assumes that your Siebel administrator has completed the work necessary to allow 
real-time account integration through ASI. For information about how to set up the Web services 
administration to communicate with the external system, ASI structures, configuring and 
customizing the ASI, see Application Services Interface Reference and Chapter 32, “Integration Using 
ASIs.”

To synchronize account information with an external system

1 Navigate to the Accounts screen > Accounts List view.

2 In the Accounts list, select an account record.

To create a new account record, see “Creating an Account” on page 456.

3 In the Account list, click the menu button, and then choose Update External System.

Viewing Account Credit Profiles
If your organization uses back-office software or another external credit management system to 
store customer credit information, you can use the Credit Profile read-only view to get the most 
current account credit profile information.

The Accounts screen’s Credit Profile view allows you to improve employee productivity by providing 
visibility to complete customer information within your Siebel application, and streamlines the quote-
to-cash process by allowing the sales professional to identify potential credit problem early.
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This procedure assumes that your Siebel administrator has completed the work necessary to allow 
real-time account integration through Application Service Interfaces (ASI). For information about 
how to set up the Web services administration to communicate with the external system, ASI 
structures, configuring and customizing the ASI, see Application Services Interface Reference and 
Chapter 32, “Integration Using ASIs.”

To view account credit profile information

1 Navigate to the Accounts screen > Accounts List view.

2 In the accounts list, drill down on the account, and then click the Credit Profile view tab.

The Credit Profile form appears, and includes information on credit status, risk category, credit 
limit, and so on.

Fields in this form are read-only, except for the Skip Credit flag check box and Credit Auto 
Approval Limit. For more information on how to use these fields, see Siebel Order Management 
Guide.

3 Click Refresh to update the information in the Credit Profile form.
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35 Using Accounts in Siebel Call 
Center
This chapter describes how call center agents can use the Accounts screen to record information 
about companies and other organizations that interact with your company.

Account information is closely related to information about contacts and prospects, and is similar to 
information about households. Later chapters in this guide provide more detailed information about 
how to use the Contacts, Prospects, and Households screens. 

This chapter includes the following topics:

■ “Managing Business Data with the Accounts Screen” on page 465

■ “Scenario for Accounts” on page 466

■ “End-User Procedures for Accounts” on page 466

■ “Creating an Account” on page 466

■ “Adding Contacts to an Account” on page 469

■ “Sending Account Information to an External System” on page 470

Managing Business Data with the 
Accounts Screen 
An account can be a company representing a customer, a prospective customer, a partner, a supplier, 
or a competitor.

Call center agents can use the Accounts screen to organize and track data when performing the 
following tasks:

■ Creating accounts

■ Creating and associating activities with an account

■ Associating contacts with an account

■ Researching the following kinds of account information:

■ Service Requests

■ Contractual Agreements

■ Product Issues 

■ Activity History

■ Account Status
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If your organization serves mostly businesses, the Accounts screen is a good screen to use when 
answering general inbound phone calls. If your organization serves mostly individual consumers, or 
if you are answering inbound calls related to a marketing campaign, the Contacts screen is a better 
screen to use when answering inbound calls.

Scenario for Accounts
The Accounts screen and views often provide the central navigation point to help call center agents 
research customers and respond to inbound calls. The type of call determines which view is used by 
the agent in the application. The following scenarios provide examples of how the Accounts screen 
is used:

■ The call center agent needs to see existing account information, including the products owned 
by the account, to assist a caller with a service request or to follow up on a service request.

■ A caller contacts the call center in response to a sales campaign. Assuming the caller is unknown, 
the call center agent creates an new account. First, the agent records the account name, address, 
and other important information. Then, the agent adds a contact or enters other information 
about the new account. Finally, the agent associates the contact with the campaign that resulted 
in the call.

■ A call center agent wants to enter information about a prospective account. For example, the 
agent may call a prospective customer to find out if the customer located requested information 
on the company’s Web site, and whether the customer requires any additional information. The 
agent adds notes that can be used by a sales representative or schedules follow-up activities to 
help manage the account relationship.

End-User Procedures for Accounts
This section includes the following end-user procedures for working with the Accounts screen:

■ Creating an Account on page 466

■ Adding Contacts to an Account on page 469

■ Sending Account Information to an External System on page 470

Creating an Account
As a central object for managing customer relationships, an account record must be created for each 
prospective or customer account before other supporting information can be entered about the 
account. After an account is created, an agent can begin to add and track important details such as 
individual contacts, opportunities, and service requests.

To create an account

1 Navigate to the Accounts screen.
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2 In the More Info form, click New, and complete the fields for the new record.

To view additional fields, click the show more button.

The following table describes some of the fields.

Field
Visible by 
Default? Comments

Account Team Yes Employees assigned to work with this account. If a 
call center user is not a member of the Account 
Team, that user will not receive information about 
this account during Mobile Web Client 
synchronization.

Account Type Yes Indicates the relationship of the account to your 
company. Typical values include Customer, 
Competitor, Consultant, Partner, Vendor, and so on.

Address Line 1 No First line of account address. This value appears in 
some Contacts screen views, as well as Account 
screen views, for contacts that are associated with 
this account.

Address Line 2 No Second line of account address. This value appears 
in some Contacts screen views, as well as Account 
screen views, for contacts that are associated with 
this account.

Assignment Area Code No Indicates account area code for Siebel Assignment 
Manager to use when automatically setting 
attributes such as Account Team memberships. 
Assignment Manager checks this value for matches 
to assignment rules.

Assignment Country 
Code

No Indicates account country code for Siebel 
Assignment Manager to use when automatically 
setting attributes such as Account Team 
memberships. Assignment Manager checks this 
value for matches to assignment rules.

Currency No Monetary unit to be used in transactions with the 
account.

Current Volume Yes Value of the products and services that a customer 
has purchased, so far.

Disable Cleansing No When selected, prevents data quality cleansing, 
which verifies that the address is real and 
standardizes address formatting.

Domestic Ultimate 
DUNS

No D&B D-U-N-S (Data Universal Numbering System) 
number belonging to the highest-level related 
member within a specific country.
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DUNS # No D&B D-U-N-S number for the account. If the 
account has separate operations at multiple sites, 
this number applies to the current site.

Expertise Yes Indicates expertise level or type required by the 
account. Siebel Assignment Manager checks this 
value for matches to assignment rules when 
automatically setting attributes such as Account 
Team memberships. 

Global Ultimate DUNS No The D&B D-U-N-S number belonging to the 
worldwide ultimate parent company of the account.

Industries No Types of business engaged in by the account.

Location Type No Type of facility operated by the account at the 
specified site. 

Lock Assignment No When selected, prevents Assignment Manager from 
making changes to the Account Team.

Name Yes Name of the account.

Organization No Organization within your company that is assigned 
to work with the account.

Parent Yes Company of which the account is a subsidiary.

Parent/HQ DUNS No D&B D-U-N-S number belonging to the company of 
which the account is a subsidiary or to the 
headquarters site of the account.

Parent Site No Location of the company of which the account is a 
subsidiary.

Partner Yes When selected, indicates that the account selected 
represents an external enterprise that is a partner 
of your company.

PO Approved Yes When selected, indicates that the account may use 
purchase orders to buy goods or services from your 
company.

PO Auto-Approval 
Limit

No Maximum value of goods or services the account 
can buy from your company using purchase orders, 
unless further approvals are obtained.

Potential Volume Yes Total estimated value of goods and services that a 
customer will buy.

Price List No List of prices to be quoted to this account.

Reference Yes Indicates that the account can be used as a 
reference for potential customers to contact.

Field
Visible by 
Default? Comments
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Adding Contacts to an Account
As agents work closely with prospective or customer accounts, they need to accurately maintain the 
contacts associated with the account. The following procedure describes how to add one or more new 
contacts for an account.

To add contacts to an account

1 Navigate to the Accounts screen, and select the account in the Accounts list.

2 Click the Contacts view tab.

3 In the Contacts list, create a new record and complete the necessary fields.

4 Click the hyperlink in the Last Name field to navigate to the Contacts screen to add additional 
information about the contact.

Referenceable as of No Date the account became a reference.

Shipping Information No Text field for any special information about shipping 
to the account. 

Shipping Terms No Type of shipping charges to be used with this 
account. 

Site Yes Location of the account.

Stage Yes Phase customer has reached in the planning and 
deployment life cycle of the products they have 
purchased.

Status Yes The current stage in the customer interaction life 
cycle. Defaults to Active for a new account record. 
If set to Candidate, only Account Team members 
will get information concerning this account during 
Mobile Web Client synchronization.

Synonyms No Text field for alternate names for the account. For 
example, an account record for International 
Business Machines might have IBM as an entry in 
the Synonym field. Helpful when querying or when 
using Siebel Data Quality.

Territories No Sales territories associated with the account.

Field
Visible by 
Default? Comments
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Sending Account Information to an 
External System
If the Siebel administrator has set up real-time account integration between Siebel Call Center and 
another system in your organization, you can use the Update External System command to send new 
and modified account information from Siebel Call Center application to the other system.

By default, in the Accounts screen, the Update External System command triggers the business 
process Synchronize Account ASI. This business process sends account information to the external 
system, waits for a response from the external system, and then updates the Siebel database with 
the response.

The following procedure describes how to send information about an account from Siebel Call Center 
to another system. This procedure assumes that your Siebel administrator has completed the 
necessary work to enable real-time account integration through Application Service Interfaces (ASI). 
For information about ASI structures, see Application Services Interface Reference. For information 
about setting up ASIs, see Chapter 32, “Integration Using ASIs.”

To send account and contact information to an external software system

1 Navigate to the Accounts screen, and in the Accounts list, select an account.

2 Click the Contacts view tab, and in the Contacts list, add the contacts that are associated with 
the account.

If account contacts are not yet listed, follow the instructions in “To add contacts to an account” on 
page 469 to specify account contacts.

3 In the Contacts list, click the hyperlink in the Last Name field to display the Contact form and an 
Activities list for the selected contact.

4 In the Contact form, click the menu button, and then choose Update External System.

You may observe a slight pause while the information is sent and the response from external 
system is received. 

5 Click the thread bar to return to the Account form.

6 In the Account form, click the menu button, and then choose Update External System.

Siebel Call Center can also receive account credit information from an external system, using the 
Account Credit Profile view.
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This chapter describes the administration and management tasks associated with Siebel Global 
Accounts. It includes the following topics:

■ “About Global Accounts” on page 471

■ “Scenario for Using and Administering Global Accounts” on page 471

■ “Process of Using and Administering Global Accounts” on page 472

■ “Generating a Default Hierarchy” on page 473

■ “Creating a Custom Hierarchy” on page 473

■ “Assigning a Custom Hierarchy to an Organization” on page 474

■ “Updating a Custom Hierarchy” on page 474

■ “Viewing Global Accounts (End User)” on page 475

About Global Accounts
Siebel Global Accounts is a module that provides sales professionals with global account-level 
visibility into the interactions that the company’s sales organization and partner’s sales organizations 
have had with the account. Users can view all accounts, opportunities, activities, contacts, and 
account team members across the account hierarchy on one screen, allowing sales professionals to 
build a deep understanding of target accounts. 

Global Account hierarchies are not provided preconfigured with your Siebel eBusiness Application. 
They must be set up by an administrator. There are two kinds of account hierarchies that can be set 
up by the administrator:

■ Default. This type of account hierarchy is based solely on the accounts’ Parent fields. This 
account hierarchy is self-maintaining in that whenever the Parent field of any account is updated, 
the default hierarchy is also updated. Once set up, the default hierarchy is applied to all 
organizations that do not already have an organization.

■ Custom. This type of hierarchy is created by the administrator, either by modifying the default 
hierarchy or from the beginning. Once set up, this hierarchy is independent of the accounts’ 
Parent fields, and as such must be updated by the administrator when changes occur.

Scenario for Using and Administering 
Global Accounts
This scenario provides an example of a process flow performed by the accounts administrator. Your 
company may follow a different process flow according to its business requirements.
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A large company, Corp 123, wants to view consolidated data at the global account level. This 
company has two organizations set up in its Siebel application: a sales organization and a financial 
organization. The accounts administrator sets up two account hierarchies, one for each organization. 
These hierarchies allow end users to view the opportunities and contact information associated with 
parent accounts. 

The sales organization uses the default hierarchy, which is based on the Parent account field. For 
various reasons, the financial organization requires a modified version of the account hierarchy. One 
of these reasons is that some accounts’ billing structures are different from the accounts’ purchasing 
structures. For example, in the case of XYZ Inc. there are four XYZ accounts who are customers of 
Corp 123: the XYZ Holding company, two regional subsidiaries, and a financial company. The 123 
sales organization wants to view the account hierarchy where all accounts report to the parent 
holding company. Because all account billing for the XYZ companies is funneled through XYZ 
Financial, Corp 123’s financial organization wants to view the account hierarchy where all accounts 
report to the XYZ Financial. Figure 31 shows the two hierarchies.

The default hierarchy used by the sales organization updates automatically when new accounts are 
added or Parent fields are changed. However, the accounts’ administrator updates the finance 
hierarchy on a weekly basis as new accounts are added and the structure of existing accounts 
changes.

The global accounts manager wants to review all opportunities at Corp 123. The global accounts 
manager navigates to the Accounts screen, and selects the Global Accounts view tab. In this view, 
the manager can see the opportunities for Corp 123.

The global accounts manager can use the Enterprise Selling process (ESP) module to develop global 
account strategies. See Chapter 44, “Enterprise Selling Process” for a discussion of how to use ESP 
with global accounts. 

Process of Using and Administering 
Global Accounts
The process for global accounts administration requires four tasks. These tasks should be carried out 
in the order presented:

1 “Generating a Default Hierarchy” on page 473

2 “Creating a Custom Hierarchy” on page 473

3 “Assigning a Custom Hierarchy to an Organization” on page 474

Figure 31. Examples of Account Hierarchies
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4 “Updating a Custom Hierarchy” on page 474

5 “Viewing Global Accounts (End User)” on page 475

Generating a Default Hierarchy
Follow this procedure to set up a default hierarchy. Once generated, this default hierarchy is 
automatically assigned to organizations without an account hierarchy. 

To change the account hierarchy assigned to an organization, see “Assigning a Custom Hierarchy to 
an Organization” on page 474.

To create a default hierarchy

1 Navigate to the Accounts screen > Global Accounts Administration view.

2 In the Account Hierarchy list, click Generate Hierarchy.

A new account hierarchy is created.

Some fields are described in the following table.

TIP: If the generated hierarchy does not appear in the Account Relationships lists, refresh the 
view by navigating to a different view and then returning to the Global Accounts view.

3 In the Account Relationships list, review the hierarchy records.

NOTE: If end users are using the application when you generate the account hierarchy, they 
must log off and log on again to see the default account hierarchy in the rollup views.

Creating a Custom Hierarchy
You can create a custom hierarchy by generating a hierarchy as described in the preceding section 
or by starting from the beginning and creating a series of new records in the Account Relationships 
list.

To create a custom hierarchy

1 Navigate to the Accounts screen > Global Accounts Administration view.

2 In the Account hierarchy list, create a new record and complete the necessary fields. Do not 
check Default.

Field Comments

Name A default name is generated based on your user ID and the date.

Default Select so that the account hierarchy is the default. The default hierarchy is 
assigned to all organizations without an account hierarchy and is updated 
when new Parent fields on the account records are added or modified.
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3 In the Accounts Relationship list: 

a Create new records for each of the top level parent accounts. Leave the Parent Account field 
blank for each of these.

b Create new records for the child accounts, entering the Parent Account for each.

To create a custom hierarchy based on the default hierarchy

1 Create an account hierarchy as described in “To create a default hierarchy” on page 473.

2 Select the account hierarchy record and make sure that the Default field is not selected.

3 In the Account Relationships list, edit the Parent Account field for existing accounts and create 
new relationship records as required. 

Accounts without Parent Accounts are at the top of the hierarchy and must be entered before 
their child records can be completed.

Assigning a Custom Hierarchy to an 
Organization
An organization uses the default hierarchy unless a custom hierarchy has been assigned to it.

To assign a custom hierarchy to an organization

1 Navigate to the Administration - Group screen > Organizations view.

2 Select the organization whose account hierarchy you want to change.

3 In the More Info form, in the Account hierarchy field, select the custom hierarchy that you want 
the organization to use when viewing global accounts.

Updating a Custom Hierarchy
Custom hierarchies are static and must be updated by the administrator. There are two approaches 
to updating an account hierarchy:

■ Edit the account relationships in the current hierarchy.

■ Restore the hierarchy to the default (parent account) hierarchy, and then edit the account 
relationships in the hierarchy.

To update a custom hierarchy

1 Navigate to Accounts screen > Global Accounts Administration view.

2 Select the account hierarchy record.

3 Do one of the following:
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■ In the Account Relationships list, edit the Parent Account fields for existing accounts and 
create new relationship records as required.

■ In the Account Relationships list, click Restore Hierarchy to return the hierarchy to the 
default, and then edit the Parent Account fields for existing accounts and create new 
relationship records as required.

Viewing Global Accounts (End User)
Available as an option, Global Accounts allow users to see opportunities, activities, contacts, and 
account team information for an account and its subsidiary accounts. 

Global Accounts consist of a parent account, the child accounts, the child accounts’ children, and so 
on. These hierarchies are determined in one of two ways:

■ Hierarchies are determined by the value in the parent field on the Account Record.

■ Hierarchies are determined by the administrator who creates custom hierarchies. 

Global Accounts are created and maintained by the administrator. If an account has no child account 
or the administrator has not defined a hierarchy for an account, then a message appears advising 
you that the selected record is not included as part of your defined hierarchy. For more information 
on how global-account hierarchies are created, see “Creating a Custom Hierarchy” on page 473.

To view global accounts information

1 Navigate to the Accounts screen > Global Accounts Hierarchy List view.

2 From the Show drop-down list, choose My Global Accounts.

Other Show drop-down list options include All Global Accounts, and Global Accounts Across 
Organizations.

The Global Accounts subviews appear, as shown in the following figure, with the explorer at left 
showing the hierarchy of account, subaccounts, contacts, and opportunities, and the list at right 
showing records associated with each subview.

3 Click the individual view tabs for Subaccounts, Contacts, Activities, Opportunities, and Account 
Team.

Records associated with these subviews appear in a list at the right of the explorer.
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The Opportunities screen allows you to manage and track information associated with a potential 
revenue-generating event. Using the Opportunities screen, you can gather customer requirements, 
review information about the customer, assemble a sales team, review and update information about 
competitors, track activities, track private notes and team notes, create quotes, and automatically 
generate presentations and proposals.

This chapter contains the following topics:

■ “About Opportunity Workflows” on page 477

■ “Setting Up Opportunity Notification Workflows” on page 478

■ “Setting Up the Communications Profile” on page 478

■ “Activating the Opportunity Notification Workflow Processes and Policies” on page 479

■ “Rerouting an Opportunity” on page 481

■ “Modifying Opportunity Workflows” on page 481

■ “Setting Up the Get Manager Email” on page 482

■ “Opportunity Audit Trail” on page 482

■ “Setting Up Lead Sources for Opportunities” on page 483

About Opportunity Workflows
Opportunity workflows enhance lead routing and provide sales professionals with greater visibility 
into their sales activities. These workflows are executed from the Opportunities screen. An 
opportunity record describes important information about the opportunity such as the account, 
potential revenue of the deal, the probability of closure, the lead status and sales stage, the sales 
team primary, and the expected close date. 

The predefined opportunity workflows allow you to use email to capture information related to the 
opportunity and distribute timely notifications to key members of the sales team. These workflows 
help improve the efficiency and effectiveness of the sales cycle while also providing sales 
representatives and sales managers greater visibility into sales activities. The email notification 
process is activated only if the opportunity has a possible revenue of more than $50,000. 

The seven predefined opportunity workflows are:

■ Opportunity Assigned Notification Process

■ Opportunity Inactive Notification Process

■ Opportunity Lost Notification Process

■ Opportunity Pending Notification Process
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■ Opportunity Won Notification Process

■ Create rerouted Oppty Activity

■ Get Manager Email

For information about configuring, implementing, testing, and monitoring workflows, see Siebel 
Business Process Designer Administration Guide.

Setting Up Opportunity Notification 
Workflows
Follow these steps to correctly set up the opportunity workflows: 

■ Revise all Siebel workflows so that they are editable and have a status of In Progress. All Siebel 
workflows are initially inactive and cannot be edited. Make any necessary changes and activate 
the workflows.

■ Verify that the Workflow Server component and the Communication Manager component are 
enabled and running. For detailed instructions, see the system requirements and supported 
platform documentation for your Siebel application. 

■ Set up the communication profile. See “Setting Up the Communications Profile” on page 478.

■ Set up and activate the workflows and policies. 

■ Activate the opportunity workflow processes. See “Activating the Opportunity Notification 
Workflow Processes and Policies” on page 479.

■ Modify Opportunity workflows, as necessary. See “Modifying Opportunity Workflows” on 
page 481.

■ Set up the Create Reroute Oppty Activity. See “Rerouting an Opportunity” on page 481.

■ Set up the Get Manager Email. See “Setting Up the Get Manager Email” on page 482.

■ Load run-time events for the emails. See Siebel Business Process Designer Administration Guide.

■ Generate the triggers. See Siebel Business Process Designer Administration Guide.

■ Run the workflow monitoring agent. See Siebel Business Process Designer Administration Guide.

Setting Up the Communications Profile
You must specify the communications profile before using the notification workflows.

To set up the communications profile

1 Navigate to the Administration - Communications screen > Communications Drivers and Profiles 
view.

2 Select the record for the Internet SMTP/POP3 Server driver.
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3 Click on the Profiles tab, and create a new profile. Name the profile Opportunity Notification 
Profile.

4 In the Profile Parameter Overrides list, enter records and values for the following fields: 

■ From Address

■ SMTP Server 

For more information about implementing and configuring communications integrations for your 
Siebel applications, including creating profiles for the Internet SMTP/POP3 Server driver, see Siebel 
Communications Server Administration Guide.

Activating the Opportunity Notification 
Workflow Processes and Policies
There are five different workflow processes that will generate automatic emails. All of these 
processes need to have the communication profile specified. See “Setting Up the Communications 
Profile” on page 478.

■ Opportunity Assigned Notification Process

■ Opportunity Inactive Notification Process

■ Opportunity Pending Notification Process

■ Opportunity Lost Notification Process

■ Opportunity Won Notification Process

The following procedure sets up this automatic notification process.

To set up the opportunity workflows
■ See Siebel Business Process Designer Administration Guide for general instructions on how to set 

up workflows.

■ For each of the workflows listed above, make sure to:

❏ Revise

❏ Set the Communication Profile to Opportunity Notification Profile

❏ Activate

❏ Clear the Expiration field

Opportunity Assigned Notification Process
This workflow sends an email message to both the primary sales representative and the sales 
representative’s direct manager when a new lead is assigned to a sales representative. The email 
provides the basic information about the opportunity, including the opportunity ID and account, the 
primary revenue amount, and the number of days allowed before the lead is withdrawn and rerouted. 
The sales representative is directed to the Opportunities screen for further details.
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Opportunity Inactive Notification Process
This workflow sends out an email notice when the sales representative has accepted a lead by 
changing the Status field to Accept, but has not taken any action on the lead for 30 consecutive days. 
An email reminder is sent to both the sales representative and the sales representatives direct 
manager. The notice reminds the sales representative that if no action is taken on the lead within 
seven days, the lead will be withdrawn from the queue and rerouted.

The default time lapse between when the lead is accepted (or last worked on) and when the email 
is delivered is 30 days. This default can be modified by editing the Duration Days.

NOTE: Out-of-the-box reassignment of leads is executed manually. You may want to create a 
workflow that automatically reassigns the lead to a sales manager or administrator after a specified 
amount of time.

Opportunity Pending Notification Process
This workflow sends an email notice when the sales representative has not responded or taken action 
on the opportunity for five days. This occurs when the sales representative has not changed the 
Status field from pending to accept, reject, or reroute. The email is sent to both the primary sales 
representative and the sales representative’s direct manager. The email reminds the sales 
representative to act on the lead or risk having the lead withdrawn from the queue. 

To modify the time lapse between lead assignment and email delivery

1 Navigate to Administration - Business Process screen > Policies view.

2 Select Email Notification of Pending Oppty.

3 Verify that the policy is activated.

4 Select the policy and modify the Duration and Units fields.

5 Activate the workflow and run the Workflow Monitor Agent. See Siebel Business Process Designer 
Administration Guide.

Opportunity Lost Notification Process
This workflow sends an email message to both the primary sales representative and the sales 
representative’s direct manager when an opportunity is closed with a loss. The status of the 
opportunity must change to lost before the email notice is generated. The email refers to the 
Opportunities screen and asks the sales representative to update the Reason field.

Opportunity Won Notification Process
This workflow sends an email message to both the primary sales representative and the sales 
representative’s direct manager when an opportunity is closed with a win. The status of the 
opportunity must change to win before the email notice is generated. The email refers to the 
Opportunities screen and asks the sales representative to update the Reason field.
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Rerouting an Opportunity
The Create Rerouted Oppty Activity workflow is executed when a sales representative receives a lead 
and changes the Status field to Reroute. The workflow creates a new Activity record with Type = 
Reroute for the designated sales operator. This informs the sales operator that a specific opportunity 
has been requested for rerouting. All reassigned opportunities are listed in the Activities view as 
rerouted activities.

NOTE: If a sales manager or sales administrator is responsible for rerouting leads, you can modify 
the workflow so that the Create Rerouted Oppty Activity is assigned to the sales manager or 
administrator. You can also create a workflow that reassigns the lead to a sales manager or 
administrator.

To set up the opportunity reroute activity
■ Revise the Create Reroute Opportunity Activity workflow process, replacing the default with the 

login of the sales operator who will receive the activity. (Remember that the login is case-
sensitive.)

Modifying Opportunity Workflows
An administrator can modify the opportunity workflows; the email language can be modified, the 
notification time can be changed, and lead notification restrictions can be set.

NOTE: The opportunity workflows are shipped as seed data. To modify a workflow, you should make 
a copy of the original workflow, and then modify the copy.

To modify the language of an opportunity workflow email
■ In the Send Out Emails step, edit the Message Body input argument.

The text includes field placeholders for data from the opportunity record. These placeholders 
appear as “+[Placeholder field]+”.

To restrict conditions for delivery of emails

1 Navigate to the Administration - Business Process screen > Policies view.

2 Select one of the email notification policies:

■ Email Notification of Assigned Oppty

■ Email Notification of Inactive Oppty

■ Email Notification of Lost Oppty

■ Email Notification of Pending Oppty

■ Email Notification of Won Oppty

3 In the Conditions applet, select a condition, or create a new condition.
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4 Click on the Operation and Value fields and modify the condition.

For example, to send email notifications for leads that have a high lead quality, create the 
following condition:

Condition Field = Opportunity Lead Quality

Operation = “=”

Value = “1-excellent”

To stop sending email notifications to a sales representative’s manager
■ Edit the workflow so that there is a single connector between Start and End. (Delete all other 

arrows.)

Setting Up the Get Manager Email
This process identifies the manager of the sales representative so that the manager can receive a 
copy of the five email notifications that are delivered. Because the Get Manager Email process is part 
of the five notification processes, the Get Manager Email process must be activated for the other 
processes to function correctly. 

An email is sent to the sales representative and the appropriate manager for each of the notification 
workflows. 

Opportunity Audit Trail
The Opportunity Audit Trail allows users to track changes that have been made to the opportunity 
record. Any time a member of the opportunity sales team creates a new opportunity record, updates 
the opportunity, deletes data, or copies the opportunity, the action is tracked in the Opportunity Audit 
Trail view.

Initially, changes to the following fields are tracked:

■ Revenue class

■ Probability

■ Stage

■ Stage ID

■ Status

For information on how to track more fields, see Chapter 6, “Audit Trail.”
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Setting Up Lead Sources for 
Opportunities
(Lead) sources for opportunities are created, modified, and deleted through the Lead Sources view 
of the Data Administration screen.

The following procedure describes how to add lead sources so that they can be associated with 
opportunities.

In addition, campaigns automatically appear as lead sources of type Marketing Campaign. For more 
information about Campaigns, see Siebel Marketing User Guide.

To create a lead source

1 Navigate to Opportunities screen > Lead Sources Administration view.

2 Create a new record and complete the necessary fields.
Applications Administration Guide Version 7.7, Rev. B ■ 483



Opportunities ■ Setting Up Lead Sources for Opportunities
Applications Administration Guide Version 7.7, Rev. B484 ■



38 Opportunities (End User)
This chapter describes end user tasks related to opportunities. It includes the following topics:

■ “About Opportunities” on page 485

■ “Scenario for Opportunities” on page 486

■ “Opportunities Processes and Procedures” on page 487

■ “About Opportunities Lead Assignment” on page 488

■ “About Lead Response” on page 488

■ “About Lead Qualification, Sales Methods, and Stages” on page 489

■ “Creating an Opportunity” on page 490

■ “Changing the Primary Sales Team Member” on page 493

■ “Monitoring Significant Opportunity Transactions” on page 494

■ “Assessing an Opportunity” on page 494

■ “Viewing Decision Issues for an Opportunity” on page 495

■ “Associating a Contact with an Opportunity” on page 495

■ “Activities Associated with an Opportunity” on page 496

■ “Associating a Product with an Opportunity” on page 496

■ “Creating a Quote from an Opportunity” on page 497

■ “Creating an Organization Analysis” on page 498

■ “Adding Attachments and Notes to Opportunities” on page 501

■ “Opportunity Charts” on page 502

■ “Generating Opportunity Reports” on page 504

About Opportunities
An opportunity is defined as a potential revenue-generating event. Opportunity-related information 
is recorded and tracked in the views associated with the Opportunities screen. This chapter describes 
how sales professionals can use the Opportunities screen to perform the following tasks:

■ Receive and respond to new leads that are assigned to you

■ Create new opportunities and enter related information such as accounts, contacts, activities, 
and products

■ View, qualify, and update opportunities assigned to you and your sales team (if you are a 
manager)
Applications Administration Guide Version 7.7, Rev. B ■ 485



Opportunities (End User) ■ Scenario for Opportunities
■ Track the status of an opportunity through the sales cycle from creation to closure

■ Share information about the opportunity with sales team members 

■ Generate quotes, presentations, and other types of information needed to close the deal

Scenario for Opportunities
This scenario provides an example of how a sales representative works with leads and opportunities. 
Your company may follow a different process according to its business requirements.

Opportunity Lead Conversion
A company uses Siebel Marketing to develop a campaign as part of a new product introduction. 
During the campaign, a telemarketing agent uses Siebel Call Center to contact prospects associated 
with the campaign. During her conversations with prospects, the agent qualifies leads by determining 
whether each prospect is interested in the new product offering. When a prospect expresses interest 
in learning more about the new product, the agent creates a new lead.

Using Siebel Assignment Manager, the lead is automatically routed to the sales representative who 
is most qualified to work on the lead and whose schedule can accommodate the new assignment.

When the sales representative logs in to the Siebel Sales application, she sees the new lead in the 
Opportunities list on her home page. Drilling down on the lead takes the sales representative to the 
Opportunities screen. After reviewing details about the lead, such as the customer information, 
probability of closing, and the products that the customer is interested in purchasing, the sales 
representative decides to accept the lead by changing the Status field to Accept.

After the sales representative accepts the lead, she begins to work on the lead by assembling 
members of the sales team, conducting further research on the customer and its requirements, 
coordinating and recording activities, uploading agreements, and generating proposals and 
presentations for the customer. As the sales representative works through the sales cycle, she 
updates information about the sales stage and keeps private notes as well as notes that she shares 
with other members of the sales team. Eventually, the sales representative develops a quote from 
the Opportunities screen. When the customer accepts the quote, it is converted into an order.

NOTE: Siebel Marketing, Siebel Call Center, Siebel Sales, and Siebel Quotes are fully integrated, 
separately licensed product offerings. You need to license these products to access the views.

Opportunity Tracking
At a trade show, a sales representative meets a prospective customer who could be a lead for a new 
business opportunity. When the sales representative returns to the office, he discovers the company 
is listed in Siebel Sales as an account, but the person he met is not listed as a contact.

The sales representative proceeds to add the prospective customer as a contact, and then creates 
the opportunity. He then schedules meetings and creates associated activities, and enters other 
potential contacts associated with the opportunity.
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As the sales process continues, the sales representative gathers and updates information about the 
account, its contacts, and the opportunity that he is pursuing. As the relationship grows, the sales 
representative can add, view, and share stored information and key knowledge with other members 
of the sales team.

Opportunity Generated Quote
A sales representative is assigned to the sales team for an opportunity. As the sales representative 
gathers product information about the customer requirements, she enters that information in the 
Siebel Sales application. After she presents to the customer, the customer indicates that the 
representative’s company is on the short list for the deal, and that the representative should submit 
a quote. 

The sales representative creates a quote automatically based on the information she has already 
entered into the Siebel Sales application. After she generates the quote, she synchronizes the quote 
information with the revenues associated with the opportunity. By making sure these numbers are 
in sync, the sales representative establishes that the data associated with her opportunity is current 
and that her forecasts are accurate.

Opportunities Processes and Procedures
When you are working with opportunities, you perform the following key tasks:

■ Create an opportunity. For more information, see “Creating an Opportunity” on page 490.

■ Change the primary team member. For more information, see “Changing the Primary Sales 
Team Member” on page 493.

■ Monitor transactions. For more information, see “Monitoring Significant Opportunity 
Transactions” on page 494.

■ Assess opportunities. For more information, see “Assessing an Opportunity” on page 494.

■ Manage decisions. For more information, see “Viewing Decision Issues for an Opportunity” on 
page 495.

■ Add contacts. For more information, see “Associating a Contact with an Opportunity” on 
page 495.

■ Add activities. For more information, see “Activities Associated with an Opportunity” on page 496.

■ Associate products. For more information, see “Associating a Product with an Opportunity” on 
page 496.

■ Create quotes. For more information, see “Creating a Quote from an Opportunity” on page 497.

■ Performing an organization analysis. For more information, see “Creating an Organization 
Analysis” on page 498.

■ Adding attachments, and notes. For more information, see “Adding Attachments and Notes to 
Opportunities” on page 501.

■ Generate and viewing charts and reports. For more information, see “Opportunity Charts” on 
page 502 and “Generating Opportunity Reports” on page 504.
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About Opportunities Lead Assignment
As a sales representative, you can view new leads in the Opportunities list on your home page, or 
you can navigate to the Opportunities screen to view new leads that you did not create but were 
assigned to you. There are a number of ways in which a lead might be assigned to you:

■ A lead is generated through a campaign and automatically routed using Siebel Assignment 
Manager and predefined rules.

■ A lead is entered into the system by an administrator and automatically routed using Siebel 
Assignment Manager and predefined rules.

■ An opportunity is created by a sales manager or sales representative who adds you to the sales 
team.

In each of these scenarios, you are able to view the lead or opportunity because you have been added 
to the sales team, either as the primary on the sales team or as a sales team member. If you are 
receiving a lead for the first time and you are the primary on the sales team, the Status field in the 
More Info view is set to Pending by default. You can accept, reject, or reroute the lead by changing 
the value in the Status field.

If the administrator has activated the email notifications, predefined processes send email messages 
to you, alerting you of the following events.

■ You have received a new lead and should accept, reject, or reroute the lead within seven days.

■ You received a new lead five days ago and should accept, reject, or reroute the lead within two 
days.

■ You have accepted a lead but have not worked on the lead in 30 days.

■ You have won the sales opportunity and should enter the reason in the system.

■ You have lost the sales opportunity and should enter the reason in the system.

The wording of the emails and the wait periods can be modified. Opportunity Workflows only sends 
email if the opportunity has revenue greater than $50,000. For more information, see Chapter 37, 
“Opportunities.”

About Lead Response
After you, as a sales representative, receive a lead, you can choose to accept, reject, or reroute the 
lead.

■ Rejecting the Lead. You can reject a lead by changing the Status field to Reject in the More 
Info view. Enter the reason for rejecting the lead in the Reason field. The lead remains in your 
queue until it is reassigned by your manager.

■ Rerouting the Lead. If you decide to reroute a lead by changing the Status field in the More 
Info form to Reroute, a Reroute activity automatically is created. Enter the reason for rerouting 
the lead in the Reason field. The lead remains in your queue until it is rerouted by your manager.

■ Accepting the Lead. You can accept a lead by changing the Status field in the More Info form 
to Accept. Enter the reason for accepting the lead in the Reason field.
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About Lead Qualification, Sales Methods, 
and Stages
When you, as a sales representative, accept a lead, you can begin to work on the lead in the 
Opportunities screen. The records in the Opportunities list include both leads and opportunities. 
Leads are defined as opportunities that have not yet been qualified. 

Lead qualification status is indicated in the Sales Stage field. The list of values in the Sales Stage 
field varies depending on which sales method you are using. 

A sales method is a formalized approach or methodology used during the sales process. A sales 
method can encompass all activities associated with the sales process, from prospecting to 
forecasting to closing deals. This approach allows sales representatives to use the method most 
appropriate for their opportunities. 

The application administrator establishes values in your Siebel application that represent the sales 
methods and sales stages for your company. It is a recommended business practice to designate a 
default sales method in your Siebel application. This practice allows a sales method to be associated 
with each opportunity and aids in charting and reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for managing a complex 
multimillion dollar opportunity can include 15 stages, while a sales method for a simple low-dollar 
opportunity may require only four stages.

Your application administrator creates and implements the sales stages that your company uses. For 
more information about creating or implementing sales methods, see “Defining a Sales Methodology” 
on page 257.

Table 93 shows sales methodologies (Accelerated, Default, Standard, Strategic Selling), and the 
associated sales stage for each methodology (for example, 01 - Prospecting). The table also shows 
if the record is a lead or is an opportunity at each sales stage.

Table 93. Sales Methods and Sales Stages

Accelerated Default and Standard Strategic
Lead or 
Opportunity

01 - Prospecting 01 - Prospecting 01 - Universe Lead

02 - Potential Lead 02 - Above Lead

02 - Qualification 03 - Qualification 03 - In the Funnel Opportunity

04 - Opportunity 04 - Best Few Opportunity

05 - Building Vision Opportunity

06 - Short List Opportunity

07 - Selected Opportunity
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Creating an Opportunity
You should create a new record each time you identify an opportunity.

NOTE: Each time a new opportunity record is created, a primary Revenue record is automatically 
created for the opportunity. 

To create an opportunity

1 Navigate to the Opportunities screen > List view.

2 Create a new record.

3 Drill down on the record.

4 Click the More Info view tab.

5 Complete the necessary fields.

Some fields are described in the following table.

03 - Closing 08 - Negotiation 05 - Won Opportunity

09 - Closed or Won Opportunity

04 - Lost 09 - Closed or Lost 00 - Lost Opportunity

Field Comments

Best Case Allows you to enter the currency amount the deal could generate in the 
best-case scenario. This amount is higher than the value in the 
Revenue field.

Channel A list of values established by your company that defines the sales 
channel. Default values include Direct and Indirect.

Close Date Allows you to enter the expected date on which the opportunity closes. 
The default date is the same as the Created Date. It is important to 
modify the date, if the opportunity closes on a different date, because 
this date is used in revenue forecasting.

Committed A check box which, when selected, indicates there is a high probability 
that the deal will close, and that the deal should be included in your 
revenue forecast.

Cost Expense associated with the opportunity.

Domestic Ultimate 
D-U-N-S

Displays the D-U-N-S number for the domestic ultimate, which is the 
highest member in the hierarchy for the same business entity within 
the same country. A case can be its own domestic ultimate.

Table 93. Sales Methods and Sales Stages

Accelerated Default and Standard Strategic
Lead or 
Opportunity
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DUNS # The Data Universal Numbering System (D-U-N-S) numeric serial 
number for a company. The D-U-N-S number is unique for each 
company.

Executive Priority This check box can be used to flag a significant opportunity. Sales 
executives can query for high-priority opportunities for tracking 
purposes.

Expected value Displays a currency value that is calculated based on the potential 
revenue field multiplied by the value in the probability field. A lower 
percentage in the probability field reduces the expected value that is 
included in your revenue forecast.

Global Ultimate 
DUNS

Displays the D-U-N-S number for the global ultimate, which is the 
highest member in the hierarchy for the same business entity 
worldwide.

Lead Partner The lead partner field is populated automatically when the source of the 
opportunity is a campaign with a lead partner. 

If you create an opportunity from a response, and the response had a 
campaign associated with it, the opportunity inherits the lead partner 
from the campaign. 

If you create a new opportunity and select a campaign as the source, 
the opportunity inherits the campaigns lead partner, if it has one. 

Lock Assignment A check box which, when selected, locks the sales team assignment so 
that Siebel Assignment Manager does not alter the current opportunity 
assignment.

Margin A calculated field that displays the revenue figure minus the cost.

Opportunity Currency A list of values established by your company that allows you to specify 
the currency type associated with the opportunity. The selected value 
does not affect forecasting. 

Organization A default value that displays the organization name associated with the 
person creating the opportunity. Your system administrator sets up 
organizations in your Siebel application. 

You can associate multiple organizations with an opportunity.

Parent HQ DUNS Displays the D-U-N-S number of the parent organization’s HQ location, 
if this is a subsidiary record.

Partner Approval 
Status

A list of values established by your company that allows you to specify 
the approval status of the lead partner for the opportunity.

Primary Displays the user ID of the primary sales team member. This value 
defaults to your user ID if you are creating a new opportunity.

Field Comments
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Probability % The Probability reflects the percentage of confidence you have that the 
deal will close with the specified revenue on the specified close date. 
By default, the probability adjusts automatically based on the sales 
stage of the opportunity. You can manually override the probability 
value.

Reason A list of values established by your company that allows you to specify 
a reason that the opportunity was accepted, rejected, rerouted, won, 
or lost.

Revenue Allows you to enter the currency amount of the opportunity. If you are 
using the Products, Quotes or Revenue view tabs, you can make sure 
your summary revenues are calculated and are in sync. The amount 
entered affects forecasting.

Revenue Class A list of values established by your company that allows you to define 
the quality of the expected revenue. For more information, see “About 
Revenue Class and Revenue Type” on page 493.

Revenue Type A list of values established by your company that allow you to define 
the kind and source of the expected revenue. For more information, see 
“About Revenue Class and Revenue Type” on page 493.

Sales Method A list of values established by your company that includes the sales 
methodologies. Default values include Strategic Selling, Accelerated 
Sales Process, Default Sales Methodology and Standard Sales Process.

Sales Stage A list of values established by your company that allows you to specify 
the sales stages associated with the selected sales method. 

Sales Team This list shows who is on the sales team for the opportunity. When you 
create an opportunity, you are automatically listed as the primary sales 
team member. You can add employees to the sales team by selecting 
them from the employee list. Only a manager or administrator can 
change or delete the primary sales team member.

You can set a Priority flag for individual members of the sales team. If 
an opportunity is a priority for all team members, the Priority Flag is 
set in the Opportunity List and Explorer views. 

Source A dialog box that allows you to associate the sources of the sales lead 
with the opportunity. Typical source values include specific events, 
campaigns, or conferences.

Source Type A default value that displays the category of the primary source. For 
instance, a specific seminar that is the source of the opportunity is 
identified with a value of Seminar in this field. 

Split Revenue A system populated check box that indicates a split revenue record has 
been created.

Field Comments
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About Revenue Class and Revenue Type
Revenue Class and Revenue Type fields appear on both the Opportunity and the Revenue forms. 
These two fields are the same fields in the database, and they are linked through a database join, 
which means changes made in the Opportunity form are reflected on the Revenue form and changes 
made in the Revenue form appear in the Opportunity form. 

The Revenue Class and Revenue Type lists of values are based on the internal business process for 
each company. The standard values can be adapted to your business, or the lists of values changed 
by your application administrator to reflect the stages of your company’s sales process and the 
manner in which your company recognizes revenue.

■ Revenue Class Field. Your company can define the quality of the revenue at a given time by 
setting the list of values in the Revenue Class field to reflect the sales stages you use. Sample 
values are Pipeline, Upside, Expected, Committed, and Closed.

■ Revenue Type Field. Your company may want to differentiate between kinds of revenues and 
their sources. For instance, your company may classify revenue by Software, Consulting, and 
Hardware categories, or by Booked versus Billed revenue, which are defined in the list of values. 
Defining revenue types allows you to query revenues or view charts sorted by the category of 
the revenue.

For more information, see Siebel Forecasting Guide.

Changing the Primary Sales Team 
Member
The administrator or manager of the primary sales representative can change the person assigned 
as the primary member of the sales team.

To change a primary team member

1 Navigate to the Opportunities screen > List view.

2 From the Show drop-down list, choose My Team’s Opportunities.

3 In the Opportunities list, drill down on the opportunity.

4 Click the More Info view tab.

5 In the More Info form, click the select button in the Sales Team field.

Territories A default value based on the territories defined by your company. Your 
system administrator controls the territory assignment function set up 
by your sales manager. 

Worst Case Allows you to enter the currency amount the deal could generate in the 
worst-case scenario. This amount is lower than the value in the 
Revenue field.

Field Comments
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6 In the Team Members dialog box, select the team member to assign and select the Primary check 
box.

NOTE: If you have access to the Data Administration screen, you can change a primary team 
member assignment there.

Monitoring Significant Opportunity 
Transactions
Sales executives can monitor significant opportunity transactions by querying for opportunities 
flagged as Executive Priority. These flagged opportunities can be tracked by the executive team 
regardless of the revenue or forecast commitment. Tracking high-priority opportunities helps the 
executive maintain the most accurate quarterly revenue forecast and plan involvement in the most 
promising opportunities.

To flag an opportunity as an executive priority

1 Navigate to the Opportunities screen > List view.

2 In the Opportunities list, select the opportunity.

3 In the Opportunities list, click the menu button and choose Columns Displayed.

4 In the Columns Displayed dialog box, move Executive Priority and Executive Priority Date from 
the list of Available Columns to the list of Selected Columns and click Save.

The fields appear in the record for the selected opportunity.

5 In the opportunity record, click the check box in the Executive Priority field.

The Executive Priority Date field automatically shows the current date after the Executive Priority 
flag is checked.

Assessing an Opportunity 
An opportunity assessment helps you qualify opportunities and verify resource allocation. Using an 
assessment template, you can select values and attributes to assign a composite value to the 
opportunity.

NOTE: In some companies, your Siebel application automatically generates assessments, but if this 
process has not been automated, you can create assessments manually.

To assess an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity with which you want to associate the assessment.

3 Click the Assessments view tab, and create a new record.
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a In the Template Name field, click the select button.

The Select Assessment Template dialog box appears.

b Select the template, and then click OK.

c Click the menu button, and then choose Save.

An explicit Save is required.

4 Click the Assessment Attribute subview tab, and then click the show more button.

A list of assessment attributes appears.

5 In the Value field, click the select button and choose the appropriate value for the attribute.

Repeat this step for each attribute in the list.

A composite assessment score for the opportunity appears as a percentage value in the parent 
Assessment list. This percentage compares the score you entered in the assessment attribute 
line items to the maximum possible score for the opportunity. You can use this percentage to 
qualify the opportunity.

Viewing Decision Issues for an 
Opportunity
Decision issues are specific areas of interest that can influence a prospect’s buying decision during 
the sales cycle. These decision issues provide you with an opportunity to present the advantages of 
your solution to the customer.

You can track these decision issues using the Opportunity screen’s Decision Issues view, and use this 
information to develop your sales strategy and address customer concerns. For more information, 
see Chapter 43, “Decision Issues.”

Associating a Contact with an 
Opportunity
As you work with an opportunity, you want to maintain information about the contacts associated 
with the opportunity. For more information about contacts, see Chapter 33, “Contacts.”

The Opportunity screen’s Contacts view allows you to store and review contact-related information 
for an opportunity.

To associate a new contact with an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Contacts view tab, and in the Contacts list click New.

4 In the new record, complete the fields.
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To associate an existing contact with an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Contacts view tab, and in the Contacts list click Add.

4 In the Add Contacts dialog box, enter query criteria for the contact, and then click Go.

5 Select the contact or contacts you want to add, and then click OK.

NOTE: To select a sequence of contact records, hold down the SHIFT key and click the contact 
records. To select multiple contacts that are not in sequence, hold down the CTRL key and click the 
contact records.

Activities Associated with an 
Opportunity
The Opportunities screen’s Activities view allows you to track activities at the opportunity level, 
maintain a calendar and to-do list for the opportunity, and delegate activities related to the 
opportunity to your sales team. For more information about Activity Plans and associated activities, 
see Chapter 17, “Activities.”

Associating a Product with an 
Opportunity
Specific products can be associated with an opportunity. For example, if a customer is interested in 
purchasing a new software suite, this information can be specified in the Products view.

After the product is associated with the opportunity, you can drill down on the product to review 
additional information such as product features and prices.

Later, this data can be used when you are building a presentation, quote, or proposal based on the 
opportunity.

To associate a product with an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Products view tab.
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4 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Creating a Quote from an Opportunity
Using the Quotes view, you can automatically create and revise quotes for the opportunity. For more 
information on quotes and orders, see Siebel Order Management Guide.

To create a quote from an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Products view tab.

4 In the Products list click New, and then add a product.

For more information, see “Associating a Product with an Opportunity” on page 496.

5 In the Product record, complete the fields.

a Enter the number of product units the customer is interested in purchasing

b In the Auto Quote field, select the check box to display a check mark.

6 Click the Quotes view tab, and then in the Quotes list, click Auto Quote.

A quote record is automatically created, with some fields completed and a status of In Progress.

If a price list is associated with the account, the Price List field is automatically completed. If no 
price list is associated, in the Price List field click the select button and choose a price list. For 
more information on price lists, see Pricing Administration Guide.

7 In the quote record, drill down on the hyperlink in the Name field.

You can change the system-generated name for a name that is more meaningful in the quote 
details form.

Field Comments

Covered Product This field can be completed only if the product (specified in the Product 
field) is a service product.

Summary Use this field to indicate that the product is a summary product. 

For example, if the opportunity is for a computer system, check 
Summary for the computer system product, but not for the CPU, 
monitor, keyboard, and mouse products that make up the system.

This Summary field also appears (read-only) in the Revenues screen > 
List view.
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8 In the quote’s Line Items list, add line items, and then click the menu button and choose Reprice.

The Reprice function makes sure that the quote total reflects the prices from the price list, and 
multiplies those prices by the quantities that you enter in the products view.

9 In the Quote form, click the menu button and choose Update Opportunity, and then return to the 
Opportunity form.

The Update Opportunity function verifies that the opportunity's revenue line items are in sync 
with the quote line items.

Use the History icon or the thread bar to navigate back to the Opportunity form.

To update opportunity revenues

1 In the Opportunity list, drill down on the opportunity, and then click the Revenues view tab.

2 In the Revenues list choose List from the Revenues drop-down menu.

3 In the Revenues list, click the menu button and choose Update Opportunity.

After this process is completed, the revenue amounts that appear in the Products, Revenues, and 
Quotes views are synchronized and the Opportunity’s Revenue field displays a calculated sum of 
the individual revenue line items associated with the opportunity.

NOTE: Siebel Quotes is a separately licensed product offering. You cannot access the Quotes view 
tab if you have not licensed this product.

Creating an Organization Analysis
You can automatically create organization charts to help you analyze your key contacts and develop 
your relationship strategy to win the opportunity.

Siebel Sales automatically generates organization charts based on contacts associated with each 
opportunity. When you update contact information, your changes are reflected in the organization 
chart.

To add existing contacts to the organization analysis

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Organization Analysis view tab.

4 In either the default Organization Analysis chart view or in the Contacts list (toggle view), click 
New.

The Add Contacts dialog box appears.

5 Select one or more contacts to add, and then click OK.

NOTE: You can select sequential contacts by holding down the SHIFT key while selecting the 
contact records.
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To create new contacts for the organization analysis

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Organization Analysis view tab.

4 In either the default Organization Analysis chart view or in the Contacts list (toggle view), click 
New.

5 In the Add Contacts dialog box, click New.

6 In the new contact record enter the contact information in the fields, and then click Save.

NOTE: If you create a new contact directly from the Organization Analysis chart view, then an 
explicit Save is required to update the chart.

The Level of Influence value determines the degree of shading that appears in the Contact node 
in the Organization Analysis chart. The following table details values and shading.

You can update contact information from either the Opportunities screen or from the Contacts 
screen. 

Using Drag and Drop to Depict Organization Hierarchy
From the Organization Analysis chart view you can drag and drop contacts to indicate professional 
relationships within the organization.

To create the hierarchy

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 Add or create contacts, as described in “To add existing contacts to the organization analysis” on 
page 498 and “To create new contacts for the organization analysis” on page 499.

In the Organization Analysis chart area the nodes (boxes) appear for each of the contacts you 
have analyzed and associated with the opportunity.

5 Select the contact node and drag it beneath the contact node that depicts the contact’s manager.

When you drop the contact node on its manager’s node, a formal line between the nodes appears, 
reflecting the reporting relationship.

Value in Level of Influence Fields Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark gray
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6 Repeat Step 5 for each contact until you have completed the organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle view). The 
Manager’s Last Name and Manager’s First name fields of the contact automatically populate 
based on the drag and drop actions. To expose this information in the contacts list, click the menu 
button, and then choose Columns Displayed.

Drawing Lines of Influence
You can also map the politics in the customer organization by identifying informal lines of influence 
between contacts. Mapping informal lines of influence helps you identify contacts who are not highly 
ranked (and are easier to access) but who have significant influence on key decision makers. Lines 
of Influence information is automatically updated in the Contacts screen’s Relationships view. You 
can add Lines of Influence information in the Relationships view if you prefer.

To draw lines of influence

1 In the Organization Analysis chart area, select the contact node, and simultaneously hold down 
the CTRL key.

2 Drag and drop the selected contact on other contacts to draw the lines of influence.

The CTRL key must be depressed throughout this process in order for the informal line of 
influence to appear.

To delete lines of influence
■ In the Organization Analysis chart area, select the line and press the DELETE key.

You may also right click the mouse in the Organization Chart area, and choose Edit > Delete from 
the menu.

Viewing and Printing the Organization Analysis
After you associate contacts with an opportunity and enter values for the manager, reports, 
associates and the influence level for each, you can view an organization chart of all your contacts. 

To view the Organization Analysis chart

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.
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4 From the drop-down list, choose Organization Analysis.

An organization chart appears with the contact information you entered.

Each contact appears in a hierarchy based on the influence level or managerial structure assigned 
to the contact. 

NOTE: Double-click the contact node to navigate to the Contacts screen’s Activities view to add 
follow-up activities for the contact.

To print an Organization Analysis chart

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.

4 From the drop-down list, choose Organization Analysis.

5 Right click the mouse in the Organization Analysis chart workspace, and choose Print from the 
menu.

You can adjust the zoom level at which you want to print the Organization Chart. Large charts 
print across multiple pages.

Adding Attachments and Notes to 
Opportunities
The Attachments view allows you to associate relevant files such as requests for proposals, strategic 
information documents, and slide presentations that other sales team members can use as they work 
this opportunity. You can add private or public notes that are shared with members of the sales team, 
using the Notes view tab.

To add an attachment to an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Attachments view tab.

4 In the Attachments list, click New.

5 In the new record, click the select button in the Attachment Name field, and in the Add 
Attachments dialog box, click Browse to navigate to the file.

6 In the Choose File dialog box, locate the file and then click Open.

The file name and path appears in the Add Attachments dialog box.
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7 In the Add Attachments dialog box, click Add.

The Attachment name, size, type and modified fields are automatically completed for the record, 
and the Update File field is checked.

8 In the Comments field for the attachment record, enter a description of the attachment.

To add private and public notes to the opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity. 

3 Click the Notes view tab.

4 In the Notes list, choose Public or Private from the drop-down menu to specify a private note or 
one that is shared.

5 In the Notes list, click New, and complete the fields for the new record.

The Created By field is automatically completed with the creator’s User ID.

a In the Type field, select the note type.

Examples of note types are legal, reference, and directions.

b In the Description field, enter the note text.

Opportunity Charts
Several charts are available that support analysis of opportunities data. The data can be depicted in 
a variety of formats such as pie graph, bar graph, and so on. 

Table 94 describes each opportunity analysis chart.

Table 94. Opportunities Charts

Chart Description

Activity Analysis Displays the number of activity types for the selected record.

Current Opportunity 
Analysis

Displays a scatter diagram of the selected opportunity by revenue and 
probability. The bottom chart displays sales stage.

Lead Analysis Displays the number of opportunities or revenue by organization or 
primary sales representative. The data is segmented by lead quality. 

Lead Source Analysis Displays the number of opportunities, revenue, or average revenue by 
time period. The data is segmented by lead source.

Lead Source Pipeline 
Analysis

Displays the number of opportunities by sales stage and lead source.

New Business Analysis Displays the number of opportunities, revenue, or average revenue 
over a time period.
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Viewing the Opportunity Sales Pipeline Analysis Chart
The Sales Pipeline Analysis works by evaluating the total revenue and count of opportunities by a 
selected sales methodology and then evaluating the total against each applicable quota.

NOTE: The Sales Pipeline Analysis Chart considers only active Quota plans, regardless of duration. 

To display sales pipeline analysis information

1 Navigate to the Opportunities screen > List view.

2 From the Show drop-down list, select an Opportunities list.

For example, you might choose All Opportunities.

3 In the Opportunities list, click Query

4 In the Opportunities form, query on a Sales Method, and then click Go.

5 Click the Charts view tab.

6 In the Charts list, select Sales Pipeline Analysis from the Show drop-down list.

7 From the secondary Show drop-down list, choose either % of Count Quota, or % of Revenue 
Quota, and then click Go.

NOTE: Pipeline charts cannot be copied by dragging (as pie and bar charts can).

Opportunity Analysis Displays the number of opportunities by product, source, territory, 
and competitor.

Pipeline Analysis Displays the number of opportunities or revenue by sales stage, 
organization, revenue size, or sales method.

Probability Cluster 
Analysis

Displays a scatter diagram of your opportunities by revenue and 
probability.

Rep Analysis Displays the number of opportunities, revenue, or average revenue by 
sales representative. The data can be segmented by sales stage and 
win probability.

Revenue Analysis by Rep Displays the number of opportunities and revenue by sales 
representative.

Sales Method Bar Displays number of opportunity products or revenue by sales method. 
The data is segmented by sales stage.

Sales Pipeline Analysis Displays the percentage of revenue quota and percentage of count 
quota.

Sales Pipeline Phases 
Analysis

Displays sales pipeline phases and the percentage of revenue quota or 
count quota achieved per phase.

Table 94. Opportunities Charts

Chart Description
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Viewing the Sales Pipeline Phases Analysis Chart
The Sales Pipeline Phases chart provides an overall view of the revenue generated for opportunities 
in an organization. Sales phases are basic components used to group stages together into basic sales 
categories.

To view the sales pipeline phases analysis chart

1 Navigate to the Opportunities screen > List view.

2 From the Show drop-down list, select an Opportunities list.

3 In the Opportunities list, click Query.

4 In the opportunities form, query for a Sales Method, and then click Go.

5 Click the Charts view tab.

6 In the Charts list, select Sales Pipeline Phases Analysis from the Show drop-down list.

7 From the secondary Show drop-down list, choose either % of Count Quota, or % of Revenue 
Quota, and then click Go.

Generating Opportunity Reports
You also can generate reports of your opportunities data. Available reports include:

■ Opportunities by Category

■ Opportunities by Sales Rep

■ Opportunity Summary

■ Opportunity List

■ Pipeline Report by Rep

■ Smart Report - Opportunity Detail

■ Opportunity Status

■ Opportunity Marketing Events Summary

To generate an opportunity report

1 Navigate to the Opportunities screen > List view.

2 Select an opportunity.

3 Click the Reports button and select a report. 

Configuring the Opportunities by Category Report
The Opportunities by Category report can be configured to sort by City, Close Date, Sales Cycle 
Stage, Source, Source Date, State, Territory, or ZIP Code.
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To configure the Opportunities by Category report

1 Navigate to the Opportunities screen > List view.

2 Select an opportunity.

3 Click the Reports button and select the Opportunities by Categories report. 

4 In the Opportunity Parameters dialog box, choose a sort parameter in the Sort By field, and then 
click Finish.
Applications Administration Guide Version 7.7, Rev. B ■ 505



Opportunities (End User) ■ Generating Opportunity Reports
Applications Administration Guide Version 7.7, Rev. B506 ■



39 Households
Household information is closely related to information about contacts, and is similar to information 
about accounts. Other chapters in this guide provide more detailed information about how to use the 
Contacts and Accounts screens. 

This chapter describes how call center agents can use the Households screen to record information 
about groups of individual consumers who interact with the agents’ company. It includes the 
following topics:

■ “Household Contact Tracking” on page 507

■ “Scenario for Households” on page 508

■ “End-User Procedures for Households” on page 508

■ “Adding a Household Record” on page 508

■ “Adding Contacts to a Household” on page 510

■ “Adding Activities to Household Records” on page 511

■ “Storing and Viewing Information About Households” on page 512

■ “Sending Household Information to an External System” on page 513

Household Contact Tracking
A household is a collection of individual consumers who are economically affiliated and who share 
common purchasing or service interests. Individuals may or may not be related to one another and 
may belong to other households. Typically, a household shares the same residential address. Siebel 
Call Center allows an organization to address the complexity of dynamic households by tracking all 
household information through the appropriate household contact. If contacts leave a household to 
join another, their associated information moves with them.

The Households screen displays information about customer households. You can use the Households 
screen and its related views to work with the following kinds of information:

■ Contacts (household members)

■ Activities

■ Attachments

■ Service Requests

■ Notes

■ Assets

■ Opportunities

■ Agreements
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The Household views summarize information that relates to all the individual contacts who are 
members of the household. For example, you might want to view a list of all the service requests 
from a particular household, regardless of which household member made the request.

The Household More Info view tab and the Household Contacts view tab allow editing, but other 
Household views are read-only. If you want to add activities, service requests, notes, attachments, 
assets, opportunities, and agreements, you must navigate to the Household Contact list and click the 
appropriate contact hyperlink to reach a view where you can enter the necessary information.

Scenario for Households
Call center agents commonly use the Households screen in a business-to-consumer setting. Viewing 
household information allows for cross-selling, upselling, and sell-through opportunities. Combined 
with Siebel Marketing and Analytics, the Households screen provides the basis for consumer 
segmentation and analysis.

The Households screen displays market segment information on the household as a whole, as well 
as a summary of information about the individual contacts who are household members. Call center 
agents use the Households screen to identify and capture demographic information about a 
household, and also to review assets, products, activities, and contact information associated with 
the household. This information helps the agent assess the customer’s data and history to better 
meet the customer’s needs.

End-User Procedures for Households
This section describes the following end-user procedures for working with the Households screen:

■ Adding a Household Record on page 508

■ Adding Contacts to a Household on page 510

■ Adding Activities to Household Records on page 511

■ Storing and Viewing Information About Households on page 512

■ Sending Household Information to an External System on page 513

Adding a Household Record
Use the following procedure to add a household record.

To add a household

1 Navigate to the Households screen > List view.
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2 In the list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Fields Comments

Address Automatically populated with the address of the primary household contact.

Category Indicates the value of the household to your organization. Available values 
are Platinum, Gold, Silver, and Standard.

City Automatically populated with the city where the primary household contact 
resides.

Created Date and time the record was created. Automatically populated.

Created By User ID of the person who created the record.

Head of 
Household

The main decision-maker for the household. Available values are all the 
contacts for the household.

Household # Unique identifier for the household. Automatically populated.

Income Total income from all members of the household. 

Name A name that identifies the household. Typically this is the last name of one 
or more contacts who are members of the household.

Organization The organization that interacts with the household.

Revenue Revenue your organization obtains from this household.

Segment Indicates general economic class of the household, or home-ownership 
status. Typical values are White Collar, Blue Collar, Rural, Own Residence, 
and Renter.

Size Total number of people in the household.

State Automatically populated with the state where the primary household contact 
resides.

Status The current stage in the customer interaction life cycle. Defaults to Active 
for a new household record.

Team Employees assigned to work with this household. If a call center user is not 
a member of the household team, that user will not receive information 
about this household during Mobile Web Client synchronization. 

Type Types of people that make up the household. Typical values include Family 
- Children, Family - No children, Family - Senior Citizen, and Single.

Wealth Estimated total wealth of the household.

Zip Code Automatically populated with the zip code of the primary household contact.
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Adding Contacts to a Household
Contacts are individuals associated with a household. Agents can specify one person in the household 
as the head of household and then identify the others as spouse, child, or dependent parent.

To add contacts to a household

1 Navigate to the Households screen > List view.

2 Drill down on the household to which the contacts will be added.

3 Click the Contacts view tab.

4 In the Contacts list, use one of the following methods to specify the contact you want to add:

■ To add an existing contact to the household, click Add, select the contact from the Add 
Contacts dialog box, and click OK.

■ To add a new contact to the household, click New.

5 Complete the fields for the record.

The following table describes some of the fields.

To specify an address for the household contact

1 Navigate to the Households screen > List view.

2 Drill down on a household record.

3 Click the Contacts view tab.

4 In the Contacts list, select the contact and drill down on the hyperlink in the Last Name field.

The Contact form and an Activities list appears.

Field Comments

Alias Contact’s nickname.

Date 
Entered

Date that the contact became a member of the household.

Date Exited Date that the contact left the household.

Employee 
Flag

Indicates that the contact is an employee of your company.

Income Contact’s income.

Households One or more households in which the contact is a member.

Primary When selected, designates the current contact as the main decision-maker for 
the household.

Relationship Indicates the role of the contact within the household.
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5 Click the Addresses view tab, and in the Addresses list, create a new record and complete the 
fields.

6 Click the thread bar to return to the Household Contacts view, and then scroll down to display 
the Household Contacts More Info form.

7 In the More Info form, click the select button in the Address field to display the Contact Addresses 
dialog box.

8 In the Contact Addresses dialog box, select the row and the Primary check box for the contact’s 
main address, and then click OK.

9 In the More Info form, complete additional fields.

The following table describes some of the fields.

NOTE: In the Households screen, a contact’s address is the residential or personal address. In 
the Contacts screen, the address displayed in the Contact form and the Contact More Info form 
is the address of the account associated with the contact. The Addresses view tab for the 
Contacts screen holds the list where a contact’s other addresses can be specified. Household 
addresses can only be selected from these individual contact addresses. 

Adding Activities to Household Records
Add activity records to household records to track appointments, meetings, email messages, and 
other tasks related to households. The following procedure describes how to add an activity from the 
Household screen. For more information about Activities, see Chapter 17, “Activities.” 

To add an activity for a household

1 Navigate to the Households screen > List view.

2 Drill down on the household for which the activity will be added.

3 Click the Contacts view tab.

4 In the Contacts list, select the contact, and then drill down on the Last Name hyperlink.

The Activities view for the Contacts screen appears.

Field Comments

Account Business or organization associated with the contact.

Address Contact’s address or addresses. The procedure for entering 
addresses to be displayed in this field is described in Step 4 on 
page 510.

Email Contact’s email address. 

Site Site of the account associated with the contact.
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5 In the Activities list, create a new record and complete the necessary fields.

The fields are described in Chapter 17, “Activities.”

Storing and Viewing Information About 
Households
The following types of information can be indirectly related to a household by associating the 
information with the contact record for any member of the household:

■ Attachments

■ Notes

■ Opportunities

■ Service Requests

■ Agreements

■ Assets

The Household screen’s views that correspond to these types of information are read-only. The 
information must be stored and modified using Contact screen views.

To store additional information related to a household contact

1 Navigate to the Households screen > List view.

2 Drill down on a household record.

3 Click the Contacts view tab.

4 In the Contacts list, drill down on the Last Name hyperlink to display the Contacts screen.

5 Click the appropriate view tab for the type of information you want to add:

■ Attachments

■ Notes

■ Opportunities

■ Service Requests

■ Agreements

■ Assets

6 In the view tab list, create a new record and complete the necessary fields.

If the contact who is associated with Attachments, Notes, Opportunities, Service Requests, 
Agreements, or Assets leaves the household, the information stays accessible through the Household 
screen if Siebel Call Center users register the contact’s departure by adding an exit date to the 
Household Contact record. If a user deletes the Household Contact record for the departing contact, 
the information associated with that contact is no longer associated with the contact’s former 
household. 
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To view additional information related to a household

1 Navigate to the Households screen > List view.

2 Drill down on a household record.

3 Click the view tab for the type of information you want to view:

■ Attachments

■ Notes

■ Opportunities

■ Service Requests

■ Agreements

■ Assets

The corresponding list appears. 

Sending Household Information to an 
External System
If the Siebel administrator has set up real-time household integration between Siebel Call Center and 
another system in your organization, agents can use the Update External System command to send 
new and modified household information from your Siebel application to the other system.

By default, in the Households screen, the Update External System command triggers the business 
process Synchronize Household ASI. This business process sends household information to the 
external system, waits for a response from the external system, and updates the Siebel database 
with the response.

The following procedure describes how to send information about a household from Siebel Call Center 
to another system. This procedure assumes that the Siebel administrator has completed the work 
necessary to enable real-time household integration through Application Service Interfaces (ASI). 
For information about ASI structures, see Application Services Interface Reference. For information 
about setting up ASIs, see Chapter 32, “Integration Using ASIs.”

To send household and contact information to an external software system

1 Navigate to the Households screen > List view.

2 Drill down on a households record.

Follow the instructions in the procedure “To add a household” on page 508 to create a new 
household record.

3 Click the Contacts view tab, and choose a contact from the list.

If household contacts have not yet been added, follow the instructions in “To add contacts to a 
household” on page 510 to specify household contacts.
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4 In the contact record, drill down on the hyperlink in the Last Name field.

The Contact form and an Activities list appears.

5 In the Contact form, click the menu button, and then choose Update External System.

You may observe a slight pause while the information is sent and the external system’s response 
is received. 

6 Click the thread bar to return to the Household form.

7 In the Household form, click the menu button, and then choose Update External System.

You may observe a slight pause while the information is sent and the external system’s response 
is received. 
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This chapter describes how sales professionals can use the References screen to access accounts that 
can be designated as references, and to associate contacts, activities, profiles, and notes with each 
reference. 

This chapter contains the following topics:

■ “Scenario for References” on page 515

■ “Managing Accounts and References” on page 516

■ “Designating an Account as a Reference” on page 516

■ “Associating an Activity with a Reference” on page 516

■ “Associating a Contact with a Reference” on page 517

■ “Associating an Attachment with a Reference” on page 518

■ “Adding a Reference Activity to the Calendar” on page 518

■ “Adding a Note to a Reference” on page 519

■ “Adding Profile Information to a Reference” on page 519

■ “Searching for References” on page 519

■ “Viewing Reference Assets and Profiles Charts” on page 520

Scenario for References
This scenario provides an example of the business process performed by a sales representative using 
references to compete for new business. Your company may follow a different process according to 
its business requirements.

A sales representative is attempting to win a 2,500-seat software sales opportunity for his company. 
In a series of meetings with the prospect, the sales representative demonstrates his product line and 
submits a quote. The sales representative receives a call from the prospective customer requesting 
a chance to speak with existing software customers as a point of reference before agreeing to the 
terms of the quote.

The sales representative searches the list of references, and performs a query to find accounts that 
meet specific criteria. The accounts must be designated as referenceable, in the same industry as 
the prospective customer, and listed as maintenance in the sales stage.

The sales representative finds companies that meet the criteria. She selects a company for the 
reference, and telephones the primary representative to get permission to use the customer as a 
reference. The representative agrees and sets up a conference call to discuss the opportunity with 
the prospect. 
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Managing Accounts and References
The References screen provides you with customer reference information that you can use as a sales 
tool when managing sales, marketing, and public relations initiatives. As a sales team member, 
providing potential customers with a list of referenceable accounts adds immediate legitimacy to any 
sales situation and gives you a competitive advantage. You also can use the References screen to 
determine the best reference for a current initiative. 

You can use the References list to search for accounts that are referenceable. A calendar view of 
reference activities is also available.

The following procedures describe how to manage accounts references using the references screen:

■ Designating an Account as a Reference on page 516

■ Associating an Activity with a Reference on page 516

■ Associating a Contact with a Reference on page 517

■ Associating an Attachment with a Reference on page 518

■ Adding a Reference Activity to the Calendar on page 518

■ Adding a Note to a Reference on page 519

■ Adding Profile Information to a Reference on page 519

■ Searching for References on page 519

■ Viewing Reference Assets and Profiles Charts on page 520

Designating an Account as a Reference 
You can mark an account as referenceable using the check box in the account record’s Reference 
field. During the reference process, you can set the reference stages.

To designate an account as a reference

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the More Info view tab. 

4 In the Account details form, select the Reference check box.

Associating an Activity with a Reference
In the Activities view, you can see each activity associated with an account. Activities associated with 
a reference appear in the Calendar view. See Fundamentals for more information on Calendar.
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Figure 32 shows a sample References list. Reference record fields provide information on the primary 
representative, the corporate sponsor, and so on.

NOTE: Only these Activity Types appear in this view: Reference - Call, Reference - Testimonial, 
Reference - Visit.

To associate an activity with a reference

1 Navigate to the References screen > Reference List view.

2 Drill down on a reference record.

3 Click the Activities view tab.

4 In the Activities list, create a new record and complete the necessary fields.

For more information, see Chapter 17, “Activities.”

Associating a Contact with a Reference
You can designate a specific contact within a referenceable account. This contact can provide you 
with reference information or the individual can be the point-of-contact for activities associated with 
the account.

To associate a contact with a reference

1 Navigate to the References screen > Reference List view.

2 Drill down on a reference record.

3 Click the Contacts view tab.

4 In the Contacts list, perform one of the following steps.

a Click Add to open the Add Contacts dialog box, and then select the contact from the list.

b Click New to add a new row to the Contacts list, and then complete the necessary fields for the 
contact.

Figure 32. References List
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Associating an Attachment with a 
Reference
The Attachments view lists attachments associated with a reference account. You can add new 
attachments or view attachments associated with the account. Reference Attachments include 
account attachments as well as reference attachments.

To associate an attachment with a reference

1 Navigate to the References screen > Reference List view.

2 Drill down on a reference record.

3 Click the Attachments view tab.

4 In the Attachments list, create a new record.

5 In the Attachment Name field, click the select button, and in the Add Attachment dialog box, click 
Browse.

6 In the Choose File dialog box, select the file, and then click Open.

7 In the Add Attachment dialog box, click Add.

Adding a Reference Activity to the 
Calendar
The Calendar view details all reference activities associated with the account. In the calendar, you 
can view, by month, the number of reference activities associated with the account. This view allows 
you to manage the number of initiatives for the account and determine if the customer is being 
contacted too often.

To add a calendar item for a reference

1 Navigate to the References screen > Reference List view.

2 Drill down on a reference record.

3 Click the Calendar view tab.

The reference form appears with the calendar. 

4 In the Calendar view, click New.

5 In the Calendar Detail form, complete the necessary fields, and then click Save This One. 

NOTE: Only these Activity Types appear in the Reference Calendar: Reference - Call, Reference 
- Testimonial, Reference - Visit .
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Adding a Note to a Reference
The Reference screen’s Notes view allows you to add notes to the selected reference account. Notes 
can be shared with others, and notes can be designated as private. Reference notes are visible in 
both the Account screen and the Reference screen. If you create a note in either the Accounts screen 
or the Reference screen, it is accessible in both views.

To add a note to a reference

1 Navigate to the References screen > Reference List view.

2 Drill down on a reference record.

3 Click the Notes view tab.

4 In the lower link bar, click Private Notes or Shared Notes.

5 In the Notes list, create a new record and complete the necessary fields.

Adding Profile Information to a 
Reference
The Profile view allows you to update the account with information about the assets owned by the 
account, and information about the service profile. The service profile is a list of all external products 
the account is using in its operating environment. For instance, if your company sells application 
software, you might add information about the server hardware and end-user operating system used 
in conjunction with your products.

To add profile information to a reference

1 Navigate to the References screen > Reference List view.

2 Drill down on a reference record.

3 Click the Profile view tab.

The Profile list and the Service Profile subviews appear.

4 In the Profile list, create a new record and complete the necessary fields.

5 In the Service Profile list, create a new record and complete the necessary fields.

Searching for References
Use the All References Read Only and All References Across Organizations Read Only lists to search 
for references applicable to your accounts. These views are read-only; you cannot modify 
information, and a contacts list is not available. To use the reference contact information, contact 
the reference owner, whose User ID appears in the Primary Rep field.
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To search for references

1 Navigate to the References screen > Reference Read Only List view.

As an alternative, select All References Across Organizations Read Only view.

2 In the References list, click Query, enter criteria in the query form, and then click Go.

3 In the reference record, drill down on the name hyperlink in the Primary Rep field to view 
reference owner information.

Viewing Reference Assets and Profiles 
Charts
Reference charts provide a graphical analysis of referenced account assets and profiles. The Asset 
Analysis chart provides a graphical view of the assets, and the Profile Analysis chart provides a 
graphical representation of the profile information associated with all reference accounts. Both charts 
are read-only.

To view Assets and Profile Analysis charts

1 Navigate to the References screen.

2 From the link bar, choose Asset Analysis or Profile Analysis.

The Reference Assets or Reference Profile list appears with the analysis chart.

3 In the chart, select the type (3D, 2D) from the drop-down list, and then click Go.
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Sales professionals can track information about accounts, opportunities, and contacts using the 
Categories screen and associated views. This chapter describes how to use predefined categories to 
sort and search for specific criteria, and enter information that defines a personal sales approach and 
style. The information can be shared with other members of the sales team or kept private.

NOTE: The categories discussed in this chapter are not the same as the categories associated with 
Catalog administration which are used primarily for access control. For information about this other 
kind of category, see the Siebel eSales Administration Guide.

This chapter includes the following topics:

■ “Scenario for Categories” on page 521

■ “Adding a Category” on page 522

■ “Searching for a Category” on page 522

Scenario for Categories
This scenario provides an example of a business process performed by a sales representative using 
the Categories screen and views. Your company may follow a different process according to its 
business requirements.

A sales representative wants to track information to help manage relationships with current and 
potential customers. Categories, which can be designated as private or shared with the sales team, 
provide the sales representative with a way to organize information about an account, opportunity, 
or contact.

The sales representative can track the most active accounts by creating a category called Hot 
Accounts, and then select that category for each account that she wants to add to her active list. 

The sales representative also can view a list of all the opportunities she has closed over a period of 
time. If she sets up a Closed category, she can see which opportunities she has closed during the 
previous year. 

Sales professionals also can use categories to track personal information about contacts. For 
instance, a sales representative can record hobbies, such as golf or tennis, and designate that 
category for contacts she plans to invite to her company-sponsored sporting events. In addition, she 
can track family names or add contacts to a category called Holiday List that allows her to create a 
seasonal mailing list.
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Adding a Category
You can add categories to accounts, contacts, and opportunities. The procedure that follows explains 
how to add a category for accounts. You can add a category for contacts or opportunities by 
navigating to the appropriate screen.

To add an account category

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record for which you want to add a category.

3 Click the Categories view tab.

4 In the Categories list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Searching for a Category
You can search for specific accounts, opportunities, and contacts using the categories you and your 
team have defined. The procedure that follows describes how to search for an account category. Use 
the same procedure for the Opportunities, Contacts, and Personal categories.

To search for an account category

1 Navigate to the Categories screen > Account Categories view.

2 In the Categories list, click Query. 

3 In the Category form, click the select button in the Category field.

4 In the Pick Catalog dialog box, choose a category, and then click OK.

5 In the Categories query form, click Go.

Field Comments

Category Choose an existing category or create a new one.

Category Rank A value that defines the category. The rank can be any numeric value. 

Private A check box which, when selected, restricts sales team members from 
seeing how you have categorized the account. When the check box is 
selected, the category is private.

Clear the check box to designate the category as Public allowing access 
by team members.

Value The value assigned to the category. Create new values as required.
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In competitive sales situations, it is imperative for the sales representative to have information about 
competitors to strengthen his sales strategy and differentiate his company's image and offerings. 

This chapter describes how to use the Competitors screen to examine comparisons of your company 
and competitors, view comparative literature of your products and those of your competitors, and 
associate a competitor with an opportunity.

This chapter includes the following topics:

■ “Scenario for Competitors” on page 523

■ “Associating a Competitor with an Opportunity” on page 523

■ “Viewing Competitor Comparisons” on page 524

Scenario for Competitors
This scenario provides an example of a business process performed by a sales representative using 
the competitors view. Your company may follow a different process according to its business 
requirements.

A sales representative logs into the Siebel Sales application and discovers a newly qualified 
opportunity. He navigates to the Competitors view to review the competition for the opportunity. One 
competitor is listed for the deal. The sales representative is not familiar with the company and drills 
down on the competitor name hyperlink to learn more.

In the Company Comparisons view, the representative can view a side-by-side comparison of his 
company and the competitor’s company as well as comparison of products. He can access 
competitive intelligence documents compiled by his company about this competitor, and the 
literature items that the competitor has published.

A colleague in Telesales calls the sales representative and indicates that there is a new competitor 
trying to win the deal. The sales representative adds the new competitor to the opportunity to allow 
the sales team to research the new competition.

Associating a Competitor with an 
Opportunity
Associating a competitor with an opportunity notifies the sales team about the competition for the 
deal and provides the team with a link to the information it needs to deliver a consistent, winning 
sales strategy.
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To associate a competitor with an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Competitors view tab.

4 In the Competitors list, create a new record and complete the necessary fields.

TIP: Drill down on the hyperlink in the competitor Name field to navigate to the Competitors 
screen to obtain more information.

Some fields are described in the following table.

Viewing Competitor Comparisons
In many sales situations it is necessary to discuss competitive information with a prospect. Using the 
Competitors screen, you can view comparisons about companies, products, and services, and also 
find literature to prepare for sales calls.

To view competitor comparisons

1 Navigate to the Competitors screen > Competitor List view.

2 Drill down on a competitor record.

3 Click the Company Comparisons view tab.

The Company Comparisons, Competitor’s Literature, and Comparative Literature lists appear.

4 In the Competitor’s Literature list, select the literature item you want to view, and then drill down 
on the hyperlink in the Name field.

5 In the Comparative Literature list, select the literature item you want to view, and then drill down 
on the hyperlink in the Name field.

Field Comments

Comments A text field that allows you to record additional information about the 
competitor.

Name Displays the competitor’s company name as a hyperlink. 

Primary A check box which, when selected, indicates that the competitor is the primary 
rival for the deal.

Status A list of values established by your company that allows you to specify the 
prospect’s interest level in the competitor’s offerings. Default values include 
Some Interest, Evaluation in Progress, Existing Relationship, and Not Satisfied.

Threat A list of values established by your company that allows you to specify the 
value of the competitor’s threat. Default values include 1-Low, 2-Medium, 3-
High, 4-Very High.
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Decision issues are specific areas of interest that can influence a prospect’s buying decision. 
Customers and prospective customers may ask questions and express concerns about the solutions 
you propose, and your company in general, during the sales cycle. Decision issues provide you with 
an opportunity to develop a sales strategy and address customer concerns.

This chapter describes how to use the Decision Issues view to associate customer questions and 
concerns with an opportunity. Decision issues are the criteria a prospective customer uses to 
evaluate a potential supplier and product before making a decision to buy.

This chapter includes the following topics:

■ “Scenario for Decision Issues” on page 525

■ “Creating Decision Issues” on page 525

■ “Associating Decision Issues with an Opportunity (End User)” on page 526

■ “Adding Decision Issues Details (End User)” on page 526

Scenario for Decision Issues
This scenario provides an example of a business process performed by a sales representative using 
decision issues. Your company may follow a different process according to its business requirements.

A sales representative logs into the Siebel Sales application and discovers a new opportunity for a 
software module his company sells. The 2,500-seat opportunity has been qualified by a colleague in 
the Telesales department, and the sales representative wants to move forward with the opportunity. 
The sales representative reviews the list of contacts, and then calls the main prospect to introduce 
himself and gather some initial requirements. Based on this conversation, the sales representative 
adds two new decision issues which are important to this prospect—customer references and search 
engines in the software. 

Creating Decision Issues 
Typically the administrator sets up the list of decision issues. End users associate these decisions 
issues with other records, but cannot edit the decision issue text.

To create a decision issue record

1 Navigate to the Decision Issues screen > Decision Issues Administration view.

2 Create a new record and complete the necessary fields.
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Associating Decision Issues with an 
Opportunity (End User)
After you qualify an opportunity, you can associate the related decision issues with the opportunity 
and rank the decision issues in order of importance to the prospect.

To associate a decision issue with an opportunity

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record associated with the decision issue.

3 Click the Decision Issues view tab.

4 In the Decision Issues list, create a new record and complete the necessary fields.

NOTE: Your application administrator enters decision issue data that has been defined in your 
company. For more information, see your application administrator.

Adding Decision Issues Details (End 
User)
After associating a decision issue with an opportunity, drill down on the decision issue name hyperlink 
to access associated views. These views, shown in Figure 33, allow you to enter details that help you 
position your company’s offerings around the selected issue. By clicking a view tab you can specify 
related issues, associate literature, and attach files to the decision issue.

Figure 33. Decision Issues Details View
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To add decision issue details

1 Create a Decision Issue associated with an opportunity as detailed in “To associate a decision issue 
with an opportunity” on page 526.

2 In the Decision Issues list, drill down on the hyperlink in the Decision Issue field.

The selected decision issue read-only form appears with subview tabs, Related Issues, Literature, 
and Attachments, as shown in Figure 33.

To add related issues

1 Click the Related Issues view tab, and then click Query.

2 In the Related Issues query form, enter the query information, and then click Go.

To associate literature with the decision issue

1 Click the Literature view tab, and then click Query.

2 In the Literature query form enter the query information, and then click Go.

Select the Auto Update check box if you want to update associated literature when source 
literature files are updated.

To associate attachments with the decision issue

1 Click the Attachments view tab, and then click Query.

2 In the query form, click the select button in the Attachment Name field.

3 In the Add Attachment dialog box, specify a file name or URL, and then click Add.

In the Add Attachment dialog box, click Browse to navigate to the file you want to attach.
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44 Enterprise Selling Process
This chapter contains the following topics:

■ “About Enterprise Selling Process” on page 529

■ “Using ESP Methodology to Manage Accounts” on page 530

■ “Scenario for Enterprise Selling Process” on page 530

■ “Process of Enterprise Selling” on page 531

■ “Adding ESP Business Unit and Service Unit Information” on page 532

■ “Adding ESP Business and Service Unit Offerings” on page 533

■ “Conducting an ESP Organizational Analysis” on page 535

■ “Charting the Organization’s Reporting Structure” on page 536

■ “Adding Partners for ESP Analysis” on page 538

■ “Viewing the BU/SU Offering Summary” on page 539

■ “Adding ESP Objectives” on page 539

■ “Adding ESP Account Plan Highlights” on page 540

■ “Viewing an ESP Manager’s Review” on page 541

■ “Generating ESP Account Plan and Account Map Reports” on page 541

About Enterprise Selling Process
Sales professionals can use Siebel Enterprise Selling Process (ESP) methodology from Siebel 
MultiChannel Services to penetrate, cover, and grow large strategic accounts—especially global 
accounts. Enterprise Selling Process is a separately licensed module that integrates with the Siebel 
Sales application.

The ESP module helps sales professionals identify the customer's business drivers and initiatives, 
uncover opportunities in key business and service units, develop global account strategies, manage 
key executive and partner relationships, and coordinate team activities.

The ESP module is designed to support users who are already familiar with the ESP methodology, 
based on the learning programs offered by Siebel MultiChannel Services. Users should first complete 
an initial account analysis to select the units, opportunities, and partners, using the tools provided 
in the ESP workshop. After the analysis, the business units, opportunities, and partners are entered 
and tracked using the Siebel ESP module. 
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Using ESP Methodology to Manage 
Accounts
Siebel Enterprise Selling Process (ESP) software provides support for the Enterprise Selling Process 
methodology from Siebel MultiChannel Services. The software module allows account teams to better 
make use of the ESP account management methodology to penetrate, cover, and grow large strategic 
accounts— especially global accounts. Using the software, sales professionals can be more effective 
at identifying the customer's business drivers and initiatives, uncovering opportunities in key 
business and service units, developing global account strategies, managing key executive and 
partner relationships, and coordinating team activities.

The Siebel Enterprise Selling Process software module provides the following features:

■ Support for the Enterprise Selling Process methodology

■ An overview of Account Plan Highlights, such as the goal, the value proposition, and the critical 
success factors for driving business in the account

■ A set of objectives for driving business in the account and an action plan for achieving each 
objective

■ Analysis of the offerings that address each business and service unit's needs, along with the 
associated revenue from Installed Base, Current, and Potential Opportunities 

■ Automatic creation of an organization chart that visually shows an analysis of key players and 
their relationships

■ Automatic creation of ESP reports including the Account Map and Account Plan

Scenario for Enterprise Selling Process
This scenario provides an example of the business process performed by a sales manager using the 
ESP methodology. Your company may follow a different process according to its business 
requirements.

An account manager has completed the ESP methodology workshop. At the end of the workshop, she 
develops a plan for her account. She plans to use the ESP software module to enter her account plan 
information to share with her team, and to track performance over the next several quarters against 
the plan.

The account manager begins by launching Siebel Sales and navigating to the Accounts screen. She 
selects the targeted account from the list of accounts, and then moves to the Enterprise Selling 
Process view to begin her account analysis. 

First, the account manager enters the account's business and service units and key information 
about each unit such as the unit's culture, her company's level of relationship with the unit, and the 
strategy she plans to apply to the unit. This provides her team with important sales information about 
each unit that sales team members plan to contact. 
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Then, the account manager enters information about the potential, current, and installed base 
opportunities by offering for each unit. This information helps the team understand where they have 
coverage and penetration in each unit and with which offerings. After the account's units and 
opportunities are mapped, the account manager analyzes the organizational structure within the 
account. The account manager defines both the formal and informal organizational structures and 
determines who is important within the account and whom the team needs to spend more time with 
to close the identified opportunities. 

The account manager continues by analyzing the partners involved with this account so she can 
identify and use partnership capabilities within the key business and service units. The manager 
enters her value proposition, goal, critical success factors and objectives for the account based on 
her analysis. She then enters activities that are necessary to meet each objective, and assigns 
objectives to the appropriate team member. This allows the account manager to coordinate with her 
team in a goal-oriented fashion.

When the account manager is ready to share her Account Plan, she runs the report and emails it to 
her team and manager. Her manager can also review the report online and enter her comments in 
the Manager's Review form. 

Process of Enterprise Selling
The Enterprise Selling Process (ESP) module consists of eight views. Information provided in these 
views comprises the overall account plan. The ESP Account Plan and the ESP Account Map reports 
can be automatically generated from the ESP module.

The procedures associated with the eight ESP views describe how to use the Enterprise Selling 
Process module.

1 “Adding ESP Business Unit and Service Unit Information” on page 532

2 “Adding ESP Business and Service Unit Offerings” on page 533

3 “Conducting an ESP Organizational Analysis” on page 535 and “Charting the Organization’s 
Reporting Structure” on page 536 (Organizational Analysis)

4 “Adding Partners for ESP Analysis” on page 538

5 “Viewing the BU/SU Offering Summary” on page 539

6 “Adding ESP Objectives” on page 539

7 “Adding ESP Account Plan Highlights” on page 540

8 “Viewing an ESP Manager’s Review” on page 541

9 “Generating ESP Account Plan and Account Map Reports” on page 541
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Adding ESP Business Unit and Service 
Unit Information
The Business Unit and Service Unit (BU/SU) Overview helps you segment the account into more 
manageable business and service units. Each business or service unit in your account has different 
characteristics that affect your ability to sell into the unit. This view helps you profile each unit to 
determine these characteristics. It also helps you to make decisions about where to apply your 
resources and how to successfully integrate into the organization.

To add BU/SU overview information

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click BU/SU Overview.

5 In the list, create a new record, enter a name for the business or service unit, and then complete 
the fields.

The following table describes the fields in the BU/SU Overview record. 

Field values are discussed during methodology training, and are available as part of the 
methodology documentation.

6 Repeat Step 5 for each Business or Service Unit in the account.

NOTE: If you are using ESP to analyze an account that has associated child accounts, the child 
accounts automatically appear in the BU/SU Overview list.

Field Comments

Culture A list of values that defines the culture (sales environment and sales 
approach) favored by the business or service unit. Examples are 
Entrepreneurial, Individualistic, Bureaucratic, and Collaborative. 

Strategy Type A list of values that defines your strategy to penetrate, cover and grow the 
relationship with the business or service unit. The values are Create, Exit, 
Expand, Protect, and Pursue.

Initiatives A text field that allows you describe the initiatives on which you plan to 
focus for the business or service unit. Example are improve ROI by 10% 
and increase customer satisfaction.

Level of 
Relationship

Your company’s perception of its relationship with the business or service 
unit. Examples are Problem Solver, Trusted Advisor, and Credible Source.

Marketing Enter information in this text field about an existing marketing campaign 
or new marketing campaign that you want to apply or develop for this 
business or service unit.
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Adding ESP Business and Service Unit 
Offerings
The Offerings view helps sales professionals to identify opportunities to sell their offerings (products 
and services) into key business or service units in the account. The sales professional can use this 
view to maintain a balance of current and future revenue in the account. It also helps to identify 
opportunities for greater account penetration. 

To add offerings

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click BU/SU Overview.

5 In the Business/Service Unit field, drill down on the hyperlink of the unit to which you want to 
add offerings. 

The name of the unit you drilled down on appears in the Account form at the top of the screen. 
The account type for this unit should be ESP BSU. The Show drop-down list automatically shows 
the Offerings view. To add offerings, the Account Type must be ESP BSU. When the Account Type 
is set to ESP BSU, the New button is inactive in the BU/SU Overview view and in the Objectives 
view. This behavior is controlled by the business component user property Parent Read Only 
Field.
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6 In the Offerings list, create a new record and complete the necessary fields.

Some fields are described in the following table.

NOTE: You can enter the revenue associated with potential opportunities without creating a new 
opportunity in the database. 

Field Comments

Potential Oppty 
Name

A Potential Opportunity has long-term revenue implications and ties to the 
customer's business initiative. The opportunity may or may not occur and 
may be classified as unqualified. Click the select button in this field to add 
existing opportunities, or to create new opportunities. 

Potential Oppty 
Revenue

The revenue classified as Potential that is associated with the opportunity.

Current Oppty 
Name

A Current Opportunity is in the sales cycle and has a significant associated 
revenue or market value. The opportunity can be the result of a new or 
installed business. Click the select button in this field to add existing 
opportunities, or to create new opportunities. 

Current Oppty 
Revenue

The revenue classified as Current that is associated with the opportunity.

Install Base 
Name

An Installed Base opportunity can be categorized in one or more of the 
following groups.

■ Servicing and maintaining

■ Upgrades, add-ons

■ Contract extensions

■ Non-competitive

Click the select button in this field to add existing opportunities or to create 
new opportunities. 

Install Base 
Revenue

The revenue classified as Install Base that is associated with the 
opportunity.

Value to 
Customer

Choose a numeric value to indicate your assessment of how critical the 
initiative is to the enterprise's overall strategy.

Value to Us Choose a numeric value after evaluating the following factors.

■ Short-term revenue potential

■ Future revenue potential

■ Profitability

■ Degree of risk

■ Strategic value
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7 When you have finished identifying opportunities in the unit for your offerings, navigate back to 
the BU/SU Overview view, select a new unit, and repeat Step 5 and Step 6. 

Conducting an ESP Organizational 
Analysis
Using the Organizational Analysis view, sales professionals can map the structure and politics of the 
customer's organization to build and expand the relationship with the customer. After completing 
additional assessments to identify the most influential people and how to use these relationships, 
sales professionals can automatically create formal and informal organizational charts that visually 
summarize their contact analyses. 

To conduct an organizational analysis

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

You can conduct an organizational analysis at the Account level or at the Business/Service Unit 
level. 

4 Perform the following steps to conduct an Account-level Organizational Analysis.

a In the lower link bar, click Organizational Analysis.

The Organization Chart view appears, showing all contacts associated with the account.

b Proceed to Step 6 of this procedure.

5 Perform the following steps to conduct a Business/Service Unit Organizational Analysis.

a In the BU/SU Overview list, drill down on the name hyperlink of the unit for which you are 
conducting an organizational analysis.

The name of the unit appears in the Account form at the top of the screen. The Show menu 
automatically changes to the Offerings view.   

b In the lower link bar, click Organizational Analysis.

The Organization Chart view appears, showing all contacts associated with the unit.

c From the Show menu, choose Contacts (toggle).

All the contacts that have been created for this business or service unit appear.

d Proceed to Step 6 of this procedure.

NOTE: In the Organizational Analysis view, you can toggle between the Organization Chart 
view and the Contacts list view. Contacts previously associated with the account or unit 
automatically appear in both views. The contacts shown in the Contacts list appear in the 
Organization Chart view. 
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6 In the Contacts list, create a new record and complete the necessary fields to associate an 
existing contact with the account or unit. 

To create a new contact record, click New in the Add Contacts dialog box. 

NOTE: You can also create contacts by clicking New on the Organization Chart toggle view. If 
you create a new contact from the Organization Chart, an explicit Save is required to return to 
the Organization Chart view.

7 In the Contacts list, analyze each contact based on the criteria taught in the ESP methodology 
training program.

The criteria includes Role, Your Status, Level of Influence, Adaptability to Change, and Coverage.

The Level of Influence value for the contact determines the degree of shading that appears in 
the Contact node in the Organization Chart. The following table describes the shading associated 
with the Level of Influence value.

8 In the Contacts list, use the drop-down list to toggle to the Organization Chart view. For more 
information, see “Charting the Organization’s Reporting Structure” on page 536.

Charting the Organization’s Reporting 
Structure
The Organization Chart displays nodes (boxes) that contain information for each of the contacts you 
have analyzed and associated with the account or contact. Figure 34 shows a contact node with 
associated information.

You can visually represent the formal hierarchy in the organization by creating the Organization 
Chart for the account or unit.

Value in Level of Influence Field Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark gray

Figure 34. Contact Node
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To represent a reporting structure

1 In the Organization Chart view, select the contact node and drag it beneath the node that 
represents the manager of the contact.

After you drop the contact node on the manager node, a line between the nodes appears, 
reflecting the reporting relationship. 

2 Repeat this process for each contact until you have completed the organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle view). Information 
about the manager of the contact appears in the fields Manager Last Name, and Manager First 
Name. To expose this information in the list, click the menu button, and then select Columns 
Displayed.

To delete contacts from the organization chart

1 In the Organization Chart view, select the contact node, right click, and choose Edit > Delete 
from the menu.

You can also delete a contact by selecting the contact node, and then pressing the DELETE key. 

2 To confirm the deletion, click OK.

When you delete a contact, the contact is removed from the contacts list as well as the 
organization chart.

Using the Organization Chart to Draw Lines of Influence
You can also map the political structure in the account or unit organization by identifying informal 
lines of influence for contacts. This feature helps you identify contacts who are not highly ranked 
(and are easier to access) but who have significant influence on key decision makers. 

Lines of Influence information is automatically updated in the Relationships view of the Contacts 
screen. You can add lines of influence in the Relationships view if you prefer.

To draw a line of influence 

1 In the Organization Chart view, select the contact, and then simultaneously hold down the CTRL 
key on your keyboard. 

2 Select the contact node, and then drag and drop the contact node onto other contacts to draw 
the lines of influence.

The CTRL key must be depressed throughout this process for the informal line of influence to 
appear.

To delete lines of influence
■ Select the line, and then press the DELETE key. 

You can also select the line, right click the mouse, and then choose Edit > Delete from the menu.
Applications Administration Guide Version 7.7, Rev. B ■ 537



Enterprise Selling Process ■ Adding Partners for ESP Analysis
Printing the Organization Chart
You can print the Organization chart for distribution to your sales team. 

NOTE: The Organization Chart does not print in the Account Plan Report or Account Map Report. You 
must print it from the Organization Chart view using the right-click menu.

To print an organization chart

1 In the Organization Chart view, right-click your mouse.

2 From the menu, choose the Zoom level at which you want to print the chart. 

Adding Partners for ESP Analysis
The Partners view helps you to analyze and execute key partnership strategies while identifying and 
using partnership capabilities across the enterprise. This view also helps you develop initiatives used 
to engage key partners.

To add a partner

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click BU/SU Overview.

5 In the list, drill down on the name hyperlink for the unit to which partners will be added.

The name of the unit appears in the Account form at the top of the screen. The Account Type 
must be ESP BSU to add partners to the unit. 

The Offerings list appears below the Account form.

6 In the lower link bar, click Partners.

7 In the Partners view, create a new record and complete the necessary fields. 

NOTE: Partners are stored as Accounts in the database. The Partner flag is checked in the Add 
Accounts dialog box.

8 Navigate back to the BU/SU Overview to add partners to another unit.

9 Select a new business or service unit, and repeat Step 7.

To add a contact

1 In the Partners list, select the partner, and drill down on the hyperlink in the Name field. 

The Accounts screen, Contacts view appears.
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2 In the Contacts list, click Add to select an existing contact.

Click New to add and enter information on a new contact.

3 In the Add Contacts dialog box, select a contact, and then click OK.

NOTE: You can select multiple contacts by holding down the SHIFT key and selecting multiple 
contacts.

To add activities

1 In the Contacts list, drill down on the hyperlink in the Last Name field.

The Contacts detail form and Activities view appears.

2 In the Activities list, create a new record and complete the necessary fields.

If you select Calendar and Activities in the Display In field, you must specify a Start date and 
time for the record to appear in the Calendar.

To delegate the activity, click the select button in the Owner field, and from the Pick Assigned To 
dialog box, select the owner of the activity. For more information, see Chapter 17, “Activities.”

Viewing the BU/SU Offering Summary
The BU/SU Offering Summary is a read-only view that allows you to see all the offerings (and 
associated opportunities) you have added to each business and service unit in the account.

NOTE: Verify that the account name in the Account form does not show one of your units. You must 
select the main account for which you are conducting the ESP analysis to see all the offerings by unit.

To view BU/SU offerings

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click BU/SU Offering Summary.

The offerings associated with each unit in the account appear. You can also see the potential, 
current, and installed base opportunities for each offering associated with each unit. 

Adding ESP Objectives
The Objectives view helps the sales professional to develop an initial plan for the account. Sales 
professionals can create specific types of objectives (for example, Business Development, Revenue, 
and Cross-Account) for each unit or resource to improve strategic planning and account team 
coordination. 
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The defined objectives link to an Action Plan form that sales professionals can use to develop action 
plans to achieve each objective they set. Moreover, the sales professional can verify that the action 
plan is implemented, because the activities assigned in the Action Plan form automatically appear in 
the assignee’s activities list.

To add objectives

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click Objectives.

5 In the list, create a new record and complete the necessary fields. 

Some fields are described in the following table.

6 Drill down on the Unit or Resource hyperlink.

The Objective details form appears with the Action Plan list.

7 In the Action Plan list, create a new record and complete the necessary fields.

The Actions you create in the Action Plan list appear in your Activities, Calendar, and To Do List, 
based on the Display In value you selected. To appear in the Calendar, the start date for the 
action must be entered.

Adding ESP Account Plan Highlights
The Account Plan Highlights view allows the sales professional to enter the achievement goals for 
the account. The sales professional can communicate the strategic plans for the account to the sales 
team and to sales management, using the Account Goal, Value Proposition, and Critical Success 
Factor fields.

Field Comments

Unit or Resource The Unit or Resource for which you are creating the objective. Units 
can be a business or service unit, opportunities, offerings, or groups 
of units. Examples of Resource names are Marketing, Customer 
Satisfaction, or Partners.

Objective Type The type of objective being defined. Choose from the three primary 
objective types, Cross Account, Revenue, and Business Development.

Objective The objective for the unit or resource.

Strategy A text entry field. Enter a statement that explains how the objective 
will be achieved.
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■ Goal. The account goal is a statement that describes the level of business you desire with the 
customer within the next few years. Express the goal, if possible, in terms of relationship and 
revenue.

■ Value Proposition. The value proposition is a statement that describes your value to the 
customer. The value proposition should be written from the perspective of the customer.

■ Critical Success Factor. Specific to the ESP Account Plan, critical success factors are the events 
or resources necessary to the success of your plan.

To add account plan highlights

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click Account Plan Highlights. 

The Overview form and the Critical Success Factors form appear.

5 In the Overview form, enter statements in the Goal and Value Proposition fields. 

6 In the Critical Success Factors form, enter a statement in the Critical Success Factors field.

Viewing an ESP Manager’s Review
The sales manager uses the Manager's Review view to enter an assessment of the sales 
professional's ESP account plan. The manager can add comments in the Manager’s Review, which 
includes the date of each review. 

The sales representative and other nonmanagers have read-only access to this view. 

To view a manager’s review

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on an account record.

3 Click the Enterprise Selling Process view tab.

4 In the lower link bar, click Manager’s Review. 

Generating ESP Account Plan and 
Account Map Reports
You can automatically generate an Account Plan report and an Account Map report for your selected 
account. The reports can be printed or emailed.
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To create a report

1 Navigate to the Accounts screen > Accounts List view.

2 Drill down on the account associated with the report.

3 Click the Enterprise Selling Process view tab.

4 Click the Reports button and select ESP Account Plan or ESP Account Map.

For more information on reports see Fundamentals and Siebel Reports Administration Guide.
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This chapter describes how the Target Account Selling (TAS) module integrates with Siebel Sales to 
help sales professionals win deals. The TAS module provides automated support and coaching to help 
sales professionals in the following ways:

■ Assess opportunities, relationships with key customer contacts, and their competitive position

■ Develop competitive and relationship strategies to win the deal

■ Execute the strategy and track progress against the action plan

The TAS opportunity management methodology is a separately licensed offering developed by Siebel 
MultiChannel Services.

This chapter includes the following topics:

■ “Using Target Account Selling to Manage Opportunities” on page 543

■ “Scenario for Target Account Selling” on page 544

■ “Process of Target Account Selling” on page 545

■ “Completing a TAS Overview” on page 546

■ “Assessing an Opportunity” on page 547

■ “Developing Strategy with TAS Competitive Analysis” on page 550

■ “Conducting an Organizational Analysis” on page 551

■ “Developing a Relationship Strategy” on page 554

■ “Adding Customer Milestones” on page 555

■ “Viewing PRIME Activities” on page 556

■ “Adding Notes” on page 557

■ “Creating TAS Opportunity Plan and Initial Plan Reports” on page 558

Using Target Account Selling to Manage 
Opportunities
The Target Account Selling module provides full support for the Target Account Selling (TAS) sales 
methodology from Siebel MultiChannel Services. Using the Target Account Selling methodology and 
the Target Account Selling module, sales professionals can assess opportunities, conduct 
organizational and competitive analysis, and develop and execute effective sales strategies.

The Siebel Target Account Selling software module provides the following features:

■ Full support for the Target Account Selling methodology
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■ A TAS Coach to help sales professionals assess their opportunities, including Tips to reinforce key 
concepts in the TAS methodology

■ A TAS Coach that recommends what competitive strategy to take, and identifies the pros and 
cons of the recommended strategy

■ Automatic creation of the Organization Map that allows you to view both the formal hierarchy 
and lines of influence in the customer organization. This helps sales professionals develop 
relationship strategy

■ Support in identifying and ranking the decision criteria of each contact

■ Team planning to make sure that key Customer Milestones are addressed

■ Automatic creation of the TAS Opportunity Plan. The report can be configured to print selected 
sections

■ Automatic creation of the TAS Initial Plan

■ The TAS Opportunity Plan template that generates an editable Microsoft Word file (available to 
customers who have the separately licensed Proposal Generator)

Scenario for Target Account Selling
This scenario provides an example of the business process performed by a sales manager using the 
Target Account Selling (TAS) methodology. Your company may follow a different process according 
to its business requirements.

A sales representative meets with a customer and discovers a new opportunity. The sales 
representative plans to use the Target Account Selling (TAS) methodology from Siebel MultiChannel 
Services (MCS) to develop a sales strategy for this new deal. TAS is supported by her Siebel Sales 
application, allowing the sales representative to analyze the opportunity and its multiple decision 
makers.

Opportunity Assessment
The sales representative selects the opportunity within Siebel Sales, and navigates to the Target 
Account Selling views to begin the process. She sees several views that she can use to profile and 
assess the opportunity, develop her value proposition and competitive strategy, and create a detailed 
action plan to achieve her goals. 

She begins by developing an overview of the opportunity. She enters some high-level information, 
including a profile of the account and the opportunity. This information provides strategic insight that 
her sales team can use and helps her to connect the project to the customer’s business drivers. The 
sales representative also enters details about her goal for the opportunity, the solution she is 
offering, and the business value this solution provides. She continues by entering a description of 
the compelling event that is causing the customer to act. This helps her to determine the customer’s 
sense of urgency to close the deal. She concludes by summarizing her high-level strengths and 
weaknesses for the deal.
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Now that she has a general overview of the opportunity, she begins to assess her position using the 
TAS criteria that Siebel MCS has developed from analyzing the best practices of top sales 
professionals. She also rates the position of her key competitors using these criteria. She uses the 
TAS Coach on the Assessments screen to help her complete the assessment. The assessment helps 
her qualify the opportunity and understand her company’s position in the deal.

Competitive and Relationship Strategy Development
Next, the sales representative begins to analyze her competitors for the opportunity and to 
determine what strategy she should use to win the deal. She uses the TAS Coach, available from the 
Competitive Analysis screen, for competitive strategy recommendations.

She continues by analyzing the prospect’s organization. She maps both the formal and informal 
structures so that she can be sure she is spending time with the right contacts. When she completes 
the analysis, she views the organizational chart that summarizes her assessment and identifies key 
players and relationships she can use to close the deal.

Now that she knows who to talk to, the sales representative begins to develop a relationship strategy. 
She enters the business and personal agenda, as well as key decision issues, for each contact. This 
preparation helps her to determine what message to deliver to each contact.

Strategy Execution
The sales representative is now prepared to develop her action plan to win the opportunity. First, she 
navigates to the Customer Milestones view to document key events or milestones in the customer’s 
buying process. This view helps her plan the activities that she and her sales team should take to 
address the customer’s requirements at each milestone. Then, she enters key action steps and 
resources needed and assigns the actions to members of her sales team. She can choose to have 
the activities appear in her calendar, activities, or to-do list, or in those of another assignee. She 
navigates to the PRIME Activities view where she can see all the activities she created to meet 
customer milestones, as well as add action items required to win the deal. She also makes some 
additional notes about the opportunity and makes the notes available for the entire team to view.

The sales representative’s manager requests a copy of the TAS Opportunity Plan. The sales 
representative configures the report to display relevant sections of the Opportunity Plan, generates 
the report, and then emails it to her manager. 

Process of Target Account Selling
Siebel Target Account Selling (TAS) consists of eight views that automate the steps in the TAS 
methodology. The TAS Initial Plan report and the TAS Opportunity Plan report can be generated from 
the TAS module.

The TAS Opportunity Plan template is available with Siebel Proposal Generator (a separately licensed 
module), which automatically creates the Opportunity Plan using Microsoft Word.

The procedures associated with the Target Account Selling views describe how to use the Target 
Account Selling module. 
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For more information on reports, see “Creating TAS Opportunity Plan and Initial Plan Reports” on 
page 558.

1 “Completing a TAS Overview” on page 546

2 “Assessing an Opportunity” on page 547

3 “Developing Strategy with TAS Competitive Analysis” on page 550

4 “Conducting an Organizational Analysis” on page 551.

5 “Viewing PRIME Activities” on page 556 (for relationship strategy)

6 “Adding Customer Milestones” on page 555

7 “Viewing PRIME Activities” on page 556 (for PRIME activities)

8 “Adding Notes” on page 557

Completing a TAS Overview
The Overview view provides a starting point that sales professionals can use to consolidate their 
observations about the account and opportunity and share strategic insights with their sales teams.

Using this view, sales professionals can profile their customers’ important business initiatives and 
requirements. In addition, sales professionals can summarize the strategic goal, value proposition, 
and overall position.

To complete a TAS overview

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the first form, complete the necessary fields. 

The following table describes the fields.

TIP: Position the pointer on the information icon to see information on the view.

Field Comments

Customer’s Business 
Profile

Describes the customer's business conditions. Identify the 
customer's major lines of business, affiliations, products, and 
markets. Include information about recent mergers and 
acquisitions.

Customer’s Revenue The customer's annual revenues or sales.

Fiscal Year End The month and day in which the customer's 12-month accounting 
period ends.

Customer’s Profit The customer's annual profit.
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5 In the Overview form, complete the necessary fields. 

The following table describes the fields.

NOTE: If this is a new opportunity, you must create a new record and associate it with an account 
before you can enter text in the Customer’s Business Profile field. For more information, see 
Chapter 37, “Opportunities.”

Assessing an Opportunity
Sales professionals can use the Assessments view to evaluate the opportunity using criteria 
developed by Siebel MultiChannel Services. Assessments must be completed before determining the 
best strategy. An assessment focuses on the following four key questions:

1 Is there an opportunity?

Field Comments

Opportunity Profile Describes the customer's project or application. Identify the 
customer's business objectives for the project, the total cost and 
budget for the project, and how the project affects the customer's 
overall business.

Customer’s Compelling 
Event

Describes what is driving the customer to make a decision or change 
the current situation. Identify the payback if the customer makes a 
change, or the consequences if they do not act. Note the specific 
date associated with the consequences or payback.

Critical Success Factors Identifies actions you, the competition, and your customer must do 
for you to win this opportunity.

Our Strengths Identifies business, organizational, and political issues that give 
your sales team an advantage in the deal.

Goal Describes your desired, long-term position with the customer. 
Identify how a closer relationship with you advances the attainment 
of their business goals. Include the long-term gain for your business 
such as future or strategic value.

Our Solution Describes the solution you plan to offer to the customer. Address 
how the solution works in the customer's environment and how it 
meets their compelling event. Include any alliances or business 
partner solutions required to make it operational for the customer.

Our Weaknesses Identifies business, organizational, and political issues that could 
put your sales team at risk in the deal.

Our Unique Business 
Value

Describes your value proposition. Make sure it is specific to this 
customer, defines a measurable business result, and creates 
credibility by proving your ability to deliver. The value proposition 
should be confirmed with the customer, and differentiate you from 
your competitors.
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2 Can we compete?

3 Can we win?

4 Is it worth winning?

Sales professionals assess their organization’s position and the position of their top competitors 
against these criteria. As the sales campaign progresses, sales professionals repeat this assessment 
and then compare the results to past assessments to evaluate and monitor their position at each 
sales stage.

The first few times an assessment is performed, use the TAS Coach to help evaluate and answer each 
set of assessment questions. After a number of assessments are performed and you are familiar with 
the criteria and methodology, use the Assessment form to rate the criteria.

To begin an assessment

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Assessments.

The Assessments list includes all the assessments you and your sales team have performed to 
date. Use the Assessments list to compare opportunity assessments for your company and your 
competitors.

5 In the Assessments form, create a new record.

6 In the new record, the Assessment For field defaults to Our Company for self assessments. If you 
are assessing a competitor’s position, specify the competitor. 

7 In the Assessment form, click TAS Coach and complete the assessment criteria questions. 
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Using the TAS Coach
The Assessment TAS Coach, shown in Figure 35, uses Siebel SmartScripts technology to help sales 
professionals evaluate opportunities. The explorer pane expands to show the individual questions in 
each question set, and the form at right provides information on assessment considerations and 
rating selection.

To perform an assessment using TAS Coach

1 Assess the position of each of the criteria in the Assessments list by selecting a plus (+), a minus 
(-), or a question mark (?) from the drop-down list.

2 Click Next to advance to the next set of criteria questions.

■ Click Previous to return to criteria you have already assessed.

■ Click Cancel to return to the Assessments view without saving the assessment.

■ If you want to pause in the middle of a TAS Coach assessment, and then return to the 
assessment at a later time, click Finish Later. The assessment does not appear in the 
Assessments list until it is completed. 

Your assessment is saved in the SmartScripts screen’s My Saved Session view. Use Site Map to 
navigate to the SmartScripts screen.

If you do not have enough information to answer the question, select the question mark (?).

3 When you have rated all criteria, click Finish to return to the Assessments list.

NOTE: You must click Finish to save the criteria ratings.

Figure 35. TAS Coach Screen
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Developing Strategy with TAS 
Competitive Analysis
The Competitive Analysis view helps sales professionals to develop competitive strategy. For each 
competitor, the sales team can evaluate strengths and weaknesses and anticipate the competitor’s 
strategy. The view also help the sales team to assess its own position against the competitor and to 
refine its strategy to win the deal. 

Use the TAS Coach to help you establish your sales strategy. TAS Coach provides recommendations 
based on the information you enter.

NOTE: If you use the TAS Coach to refine your strategy, enter information in the Our Competitive 
Strategy field. If you are analyzing a competitor’s strategy, enter the information in the Competitors 
list.

When you determine what your strategy will be, enter a summary in the Our Competitive Strategy 
text field in the Competitive Analysis view.

To add competitive analysis information

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Competitive Analysis.

5 In the Competitors list, create a new record and complete the necessary fields.

After you have analyzed your competitors, you determine the strategy you will take in the deal. 
Enter your strategy, based on what you think the competitor will do, in the Our Competitive 
Strategy field.

Using the TAS Coach for Competitive Analysis
The TAS Coach can help you develop a competitive strategy after you have completed the TAS 
Assessment for your company and competitors. You can also answer TAS Coach questions from your 
competitors' perspective to help you anticipate the strategy that competitors are likely to take. You 
may need to refer to your assessment criteria ratings during a TAS Coach session, and may want to 
review or print the assessments before starting. See “Creating TAS Opportunity Plan and Initial Plan 
Reports” on page 558.

To use the TAS Coach for competitive analysis

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Competitive Analysis.
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5 In the Competitive Strategy form, click TAS Coach.

The TAS Coach screen appears, as shown in the following figure, detailing strategy types such 
as Fragment, Frontal, and Disengage, and includes a description of how to use the TAS coach.

6 During the TAS Coach session, answer each question presented, and then click the Continue 
hyperlink to proceed to the next question.

During the session, an interim evaluation of each answer is provided, outlining the relevant 
issues that you must consider.

Click the Back hyperlink to return to a previous question.

At the conclusion of the session, TAS Coach recommends the type of strategy to take.

7 At the TAS Coach Recommends screen, drill down on the Click here for variations hyperlink for 
additional strategy options.

8 When you complete the TAS Coach session and review the TAS Coach recommendation, click the 
Back arrow to return to the Competitive Analysis view.

9 Enter the strategy you will take in the Our Competitive Strategy field.

Conducting an Organizational Analysis 
Sales professionals can use the Organizational Analysis view to create formal and informal 
organizational charts that visually summarize their contact analyses.

The Organizational Analysis view toggles between a Contacts list and an Organization Map. Contacts 
previously associated with the opportunity automatically appear in both views. The contacts shown 
in the Contacts list appear in the Organization Map view. 
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The toggle control list is shown in Figure 36. You can click New in either the Contacts list view or the 
Organization Map to create contact records. Position the pointer on the information icon to display 
information on the view.

Regardless of which view you use to create or select contacts, analyze each contact based on the 
criteria taught in the Target Account Selling methodology training program. This criteria includes 
Buying Role, Your Status, Level of Influence, Adaptability to Change, and Coverage.

The Level of Influence that you assign to each contact determines the degree of shading that appears 
in the contact node in the Organization Map. Table 95 explains the contact node shading for each 
value in the Level of Influence field.

You can also map the politics in the customer organization by identifying formal and informal lines 
of influence between contacts. Mapping informal lines of influence helps you identify contacts who 
may not be ranked highly (and are easier to access) but have significant influence on key decision 
makers. 

To begin an organizational analysis

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Organizational Analysis.

The Organization Map view appears.

5 Add new contacts.

You can also add new contacts by choosing Contacts from the drop-down list and entering the 
contacts in the list.

Figure 36. Organizational Analysis View, Contacts List, and Organization Map Toggle

Table 95. Level of Influence Shading for Contacts

Value in Level of Influence Field Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark gray
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To create the Organization Map

1 In the view drop-down list toggle, select Organization Map.

The organizational chart displays the nodes (boxes) containing information for each of the 
contacts you have analyzed and associated with the opportunity. 

The following figure shows an example of a contact node (box) with the Level of Influence 
shading of dark gray. The node includes information about the contact, such as the contact’s title 
and other contact analysis information (Decision Maker, Mentor).

You can visually represent the formal hierarchy in the organization by creating the Organization 
Map of key contacts in the deal.

2 Select the contact node and drop it on top of the contact node that represents the contact’s 
manager.

When you drop the contact node on the manager node, a line appears between the nodes, 
reflecting the reporting relationship.

3 Repeat this procedure for each contact until you have completed the organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle view). The Manager 
Last Name and Manager First Name fields in the contact record are automatically populated. To 
expose this information in the contacts list, click the menu button, and then choose Columns 
Displayed.

To delete contacts on the Organization Map
■ Right-click on the contact node and choose Edit > Delete from the menu.

NOTE: Contacts deleted from the organization map are no longer associated with the opportunity. 
However, the contact record still exists in your Contacts screen list.

To draw lines of influence

1 In the Organization Map, press the CTRL key and simultaneously select the contact. 

2 Drag and drop the selected contact node on other contacts to draw the lines of influence.

The CTRL key must be depressed throughout this process for the informal line of influence to 
appear. 

NOTE: This information is automatically updated in the Relationships view of the Contacts 
screen. You can indicate lines of influence in the Relationships view if you prefer.
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To delete lines of influence on the Organization Map
■ Right-click on the line and choose Edit > Delete from the menu.

To print the Organization Map

1 Right-click on the Organization Map and select Zoom from the menu.

2 Choose the Zoom level at which you want to print the chart. 

3 Right-click the Organization Map again and choose Print from the menu. 

The Organization Map prints at the selected zoom level. Large charts print across multiple pages.

NOTE: The Organization Map does not print in the Initial Plan Report or Opportunity Plan Report. 
You must print it from the Organization Map view using the right-click menu.

Developing a Relationship Strategy
Information captured in the Relationship Strategy view helps sales professionals develop a 
relationship strategy for each of the key players for an opportunity. The view allows sales teams to 
share their understanding of the business and personal decision issues for each contact.

To add relationship strategy information

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Relationship Strategy.

5 In the list, create a new record.

6 From the Add Contacts dialog box, select the contact or contacts you want to add, and then click 
OK.

NOTE: All contacts added in the Organization Map automatically appear in the Contacts list, and 
all contacts added in the Contacts list appear in the Organization Map.

7 In the Relationship Strategy list, complete the Business Agenda, Personal Agenda and 
Relationship Strategy fields for each contact.

You only need to complete this information for key players in the organization, based on their 
role, level of influence, and rank.

8 Add decision criteria:

a In the Relationship Strategy list, select a contact.

b In the Decision Criteria list, create a new record and complete the necessary fields.

NOTE: The administrator may want to create a record called Custom that users can select from 
the list of decision criteria. This record can be used to track issues that are unique to the contact 
and do not already exist in the database.
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Adding Customer Milestones
Milestones are formal steps in the customer’s buying process. The Customer Milestones view helps 
sales professionals identify and track customer requirements that must be met as the sales cycle 
progresses. After the milestones are set, use the Our Activities list to target specific activities that 
need to be accomplished to meet each milestone. These activities might include formal 
presentations, product demonstrations, benchmarks, proposals, and other activities required to 
make the sale. Figure 37 shows the Customer Milestones list, and the activities associated with the 
selected milestone in the Our Activities subview list.

Milestones are similar to Activity Plan templates that are created with predefined activities. For 
example, the initial milestone, Request Offering, is associated with recommended activities to be 
performed by you and your sales team. These activities might include understanding the problem or 
opportunity, defining the customer’s Compelling Event and confirming the budget, completing an 
opportunity assessment, and developing an organization map for the customer’s business. 

A sample of customer milestone types is included with the Siebel Sales application. Your 
administrator can change the milestones, based on your business needs. You and your sales team 
can create, edit and delete activities associated with the milestones that address the opportunity.

To add a milestone

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click Customer Milestones.

Figure 37. Customer Milestones View with Associated Activities
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5 In the Customer Milestones list, create a new record.

The current date appears in the Date field. 

6 In the Event field, select the type of event from the list. 

A set of suggested activities appears in the Our Activities list. You must save the type of event 
for the activities to appear. 

7 In the Description field, enter a description of the milestone event.

8 In the Customer Responsibility field, choose the customer contact who is the key contact and 
owner of the milestone event.

Repeat the procedure until you have entered all key milestone events. Review the recommended 
activities for each milestone before adding new milestones.

To add associated activities to each milestone

1 Follow the procedure “To add a milestone” on page 555 to create a customer milestone.

2 In the Our Activities list, add a new activity record and complete the fields.

a In the Type field, choose the activity type from the list.

b In the Display In field, choose where you want the activity to appear.

Options are Activities Only, Calendar and Activities, and To Do and Activities. If you choose 
Calendar and Activity as the display method, you must enter a start date for the activity for 
it to appear in the calendar.

c In the Resources text field, describe the resources required to support the activity.

d If the activity will be delegated, for example, from a manager to a member of the sales team, 
click the hyperlink in the Owner field, and query for the new owner in the Employees list.

The default owner is the User ID of the activity creator.

Viewing PRIME Activities
The PRIME Activities view helps sales professionals develop the necessary action steps to execute 
the strategy and win the opportunity. The PRIME acronym underscores the initiatives that are used: 

■ Prove your value

■ Retrieve missing information

■ Insulate against competition

■ Minimize your weaknesses

■ Emphasize your strengths

These activities can be assigned with due dates to members of the sales team and automatically 
appear in individual calendars and activity lists. Use this view to update the entire sales team, and 
to measure progress while implementing the sales strategy. 
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All the activities created in the PRIME Activities view automatically appear in the Activities view 
associated with the opportunity. Your sales organization may wish to standardize on one of these 
views

Activities created in the Our Activities list in the Milestones view also appear in the PRIME Activities 
list, providing a method for tracking. (In the Customer Milestones list, you must select the milestone 
to see the associated activities.) 

Using this view, you can create activities that are not specific to milestones, such as follow-up actions 
associated with assessments and the organizational analysis.

To add PRIME activities

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 In the lower link bar, click PRIME Activities.

5 In the list, create a new record and complete the necessary fields.

Identify the actions and resources required to implement your strategy, and then select a 
member of your sales team who is responsible for the activity.

Adding Notes
The Notes view consolidates comments (for example, notes and directions) created by various 
members of the sales team. These can be marked for general viewing or can be kept private. The 
Notes view allows the sales team to aggregate and track observations about the opportunity 
throughout the sales process.

To add a note

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Notes view tab.

4 Select Public Notes or Private Notes tab at top right.

5 In the Notes view, create a new record.

The Date and Type are added to the record automatically.

6 Complete the Description field.
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Creating TAS Opportunity Plan and 
Initial Plan Reports
You can automatically create reports to make it easier to review your TAS plans. These can be printed 
or emailed to share with your sales team. Available reports include the TAS Opportunity Plan and TAS 
Initial Plan reports. You can configure the Opportunity Plan report to print specific sections.

The TAS Opportunity Plan Report prints all the assessments completed for Our Company and all 
competitors on the three most recent dates. The TAS Initial Plan Report prints all the assessments 
completed for Our Company and all competitors on the one most recent date. 

Using the separately licensed Proposals module, you can apply the TAS Proposal Template to 
generate an editable Microsoft Word document of the TAS Opportunity Plan Report.

To create a report

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Target Account Selling view tab.

4 Click the Reports button and select TAS Initial Plan or TAS Opportunity Plan.

■ To print specific sections of the Opportunity Plan report, click the check boxes associated with 
the sections in the Configure Opportunity Plan dialog box and click Finish.
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This chapter describes how sales professionals can use Miller Heiman's Strategic Selling methodology 
within the Siebel Sales application to close new business. The Strategic Selling module is a separately 
licensed product. Using the Strategic Selling module, sales professionals can enter sales objectives, 
assess buying influences, understand their competitive position, and create an action plan to execute 
the competitive strategy. This information is available in a report, called the Blue Sheet. 

This chapter includes the following topics:

■ “Using Strategic Selling to Support the Sales Process” on page 559

■ “Scenario for Strategic Selling” on page 560

■ “Process of Strategic Selling” on page 561

■ “Meeting the Single Sales Objective” on page 561

■ “Adding Buying Influences Information” on page 563

■ “Adding Position Summary Information” on page 564

■ “Adding Possible Actions” on page 564

■ “Viewing and Adding Best Actions” on page 565

■ “Creating a Blue Sheet Report” on page 566

Using Strategic Selling to Support the 
Sales Process
The Strategic Selling software module in Siebel Sales provides full support for the Strategic Selling 
methodology from Miller Heiman. Sales professionals can reinforce and use the Strategic Selling 
sales process within Siebel Sales, applying the sales methodology and other sales tools to close new 
business. 

Siebel Strategic Selling software provides the following features:

■ Support for the Strategic Selling methodology (a separately licensed service available through 
Miller Heiman, Inc.)

■ Assessment of the opportunity compared to the ideal criteria

■ Analysis of key contacts and development of a relationship strategy

■ Tools to improve your position based on your sales objective

■ Support in developing an action plan to execute your sales strategy

■ Automatic generation of a Blue Sheet report 
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Scenario for Strategic Selling
This scenario provides an example of the business process performed by a sales manager using 
Strategic Selling. Your company may follow a different process according to its business 
requirements.

A sales representative joins the sales team for a new opportunity. Before he makes any calls into the 
account, the sales representative plans to perform a Miller Heiman Strategic Selling analysis of the 
opportunity. The sales representative locates the opportunity in his opportunity list and then selects 
the Strategic Selling view tab.

Single Sales Objective
In the Single Sales Objective view, the sales representative reviews the information typically shown 
at the top of the Strategic Selling Blue Sheet. He gauges his general feeling about the opportunity. 
He notes that two fields have been carried over from the Siebel account form—the dollar volume of 
business that he is currently doing with the account and the amount that he plans to do with the 
account over the next year or more. These two fields are read-only. 

The sales representative proceeds to assess his competitive position and determines the timing for 
his priorities. He selects the Strategic Selling Assessment template and evaluates the opportunity to 
determine how it compares against an ideal customer. Based on his evaluation, the opportunity is 
automatically scored.

Buying Influences
The sales representative then navigates to the Buying Influences view. Contacts associated with the 
opportunity automatically are shown in the view. He adds new contacts and assesses his relationship 
strategy with each of them. Each contact can play a variety of roles in the evaluation, and each buyer 
can have a reason for participating in the evaluation. The personal win and business results tell the 
sales representative and his team the benefits for his contact, and the ratings show how well the 
sales representative has covered all aspects of the opportunity. The sales representative then enters 
evidence to support his ratings.

Position Summary
In the Position Summary view, the sales representative completes a description of his company’s 
strengths and weaknesses (red flags) in the deal. He also identifies information required to close this 
opportunity.
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Possible and Best Actions
Now that he has set his Single Sales Objective and completed his customer and competitive analysis, 
the sales representative creates an action plan for his team to win this opportunity. He goes to the 
Possible Actions view and adds a list of possible actions generated during a collaborative session with 
his team. The actions the team will take are marked Best. These automatically appear in the Best 
Actions view where the sales representative assigns them to sales team members and marks the due 
date for each action. These activities automatically appear on the assignee’s calendar, to-do list, or 
activities list, based on the choice in the Display In field for each activity. The sales representative 
can check this list at any time as the deal progresses to track the status of the activities.

Blue Sheet Report
After the sales representative has finished entering and updating his Strategic Selling information, 
he can generate a Blue Sheet report that he can print or email to share with his team.

Process of Strategic Selling
The Strategic Selling module consists of five views and a number of subviews. Information provided 
in these views comprises the Strategic Selling methodology. A Blue Sheet Report can be 
automatically generated from the Strategic Selling module.

The procedures associated with the Strategic Selling views describe how to use the Strategic Selling 
module.

1 “Meeting the Single Sales Objective” on page 561

2 “Adding Buying Influences Information” on page 563

3 “Adding Position Summary Information” on page 564 

4 “Adding Possible Actions” on page 564

5 “Viewing and Adding Best Actions” on page 565

6 “Creating a Blue Sheet Report” on page 566

Meeting the Single Sales Objective 
Siebel Strategic Selling helps sales professionals meet their sales objectives for the account. By 
assessing and testing their position, sales professionals can make sure their sales teams evaluate 
the probability for meeting the Single Sales Objective, as taught in the Miller Heiman Strategic 
Selling process. The software module also helps sales professionals analyze whether or not they are 
working on the right sales objective, or an objective where closing the deal meets both the 
customer's needs and the sales professionals' long-term goal for the account. Sales professionals 
can evaluate the opportunity compared to an Ideal Customer profile, providing an understanding of 
their position and underscoring the best strategy to take.
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To assess your position

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Strategic Selling view tab.

The Strategic Selling Position form, Ideal Customer Assessment list, and Ideal Customer Criteria 
list appear with the Opportunity form.

4 In the form, complete the fields to identify the competition for the opportunity and assess your 
position.

The following table describes the fields in the Position form.

Assessment criteria are taught by Miller Heiman instructors in the Strategic Selling methodology 
workshop.

5 In the Ideal Customer Assessment list, create a new record.

6 Set the Template Name field to Ideal Customer Criteria and save the record.

An explicit Save is required for the assessment criteria to appear.

Field Comments

Adequacy of Current 
Position

Select the value that best describes how you feel about your 
current position. Examples of values are Euphoria, Great, OK, 
Secure, Comfort, and Worry.

My Position vs. Competition Select the value that describes your position compared to your 
key competitors. Examples of values include Only Alternative, 
Front Runner, Shared, and Zero.

Timing for Priorities Select the value that describes the timing for your priorities. 
Examples are Urgent, Active, Work It In, and Later.
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7 In the Ideal Customer Criteria list, select a value for each assessment criterion.

The opportunity assessment is automatically scored based on the selected values.

The Assessment Score and its percentage of the Max Score, defined in the Assessment template, 
appear in the Ideal Customer Assessment list.

The following illustration shows an Ideal Customer Assessment record, and the Ideal Customer 
Criteria list shows the criteria associated with the assessment.

Adding Buying Influences Information
The Buying Influences view helps sales teams identify the role each contact plays and each contact’s 
reason for participating in the project. The personal win and business results recorded in this view 
help the sales professional to understand the outcome benefit for the contact. By understanding the 
business and personal agendas of their contacts, sales professionals can form effective relationships 
and consider where to dedicate resources.

To add buying influence information

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Strategic Selling view tab.

4 In the lower link bar, click Buying Influences.

5 In the list, create a new record.

6 In the Add Contacts dialog box, select contacts you want to add.

To enter new contacts, click New in the Add Contacts dialog box.

7 In the Buying Influences list, complete the fields for the contact.
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a Indicate the role of the contact by placing a check mark in each applicable field.

Fields include Economic Buyer, User Buyer, Technical Buyer, and Coach.

b Enter information in the Personal Win and Business Results fields for each contact.

c Select a Rating and Mode for each contact.

Examples of Rating are +2 Interested, and +4, Strongly Supportive. Examples of Mode are 
Growth, Trouble, and Overconfident.

d Enter your Evidence to Support Rating in the text field.

Adding Position Summary Information
The Position Summary view helps sales professionals identify Red Flags and Strengths to use in the 
opportunity. With this information, you can identify and track information needed to improve your 
competitive position.

To add position summary information

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Strategic Selling view tab.

4 In the lower link bar, click Position Summary.

5 In the Position Summary form, complete the Strengths and Red Flag fields.

Strengths and Red Flags help you determine your strengths and weaknesses for closing this 
opportunity.

6 In the form, create a new record and complete the necessary fields:

■ Identify what information is needed.

■ Designate a source for the information in the What and From Whom fields.

NOTE: Records in the Information Needed list also appear in the Activities list for the 
opportunity. The Activity Type is Information Needed.

Adding Possible Actions 
In the Possible Actions view, the sales team can brainstorm feasible actions for advancing an 
opportunity and then create an action plan based on Best Actions.

To add possible actions

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.
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3 Click the Strategic Selling view tab.

4 In the lower link bar, click Possible Actions.

5 In the list, create a new record.

6 Select the check box in the Best field to mark this action as best.

All actions flagged as Best appear in the Best Actions view.

7 In the What field, enter a description of the action.

8 Repeat Step 6 through Step 7 to enter all the best actions your sales team can accomplish.

Viewing and Adding Best Actions 
The Best Actions view presents the actions in the Possible Actions view that the sales team has 
selected as the best choices to advance the opportunities. This view helps keep the entire sales team 
on the same page by providing one location for action planning and logging status. You can assign 
best actions to people on your opportunity team and these actions appear in their activities list. It 
also helps teams monitor cumulative progress towards sales goals.

To add best actions

1 Navigate to the Opportunities screen > List view.

2 Drill down on an opportunity record.

3 Click the Strategic Selling view tab.

4 In the lower link bar, click Best Actions.

The possible actions you previously selected as best automatically appear in the Best Actions list.

5 In the list, create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

What Enter the description of the action in the text field. This description appears in the 
Activities list for the Opportunity. You can set the Display field to display the best 
action in your Calendar and Activities lists, your To-Do and Activities lists, or 
Activities Only.

Who The default is the user that created the Best Action. You can assign the action to 
another employee or person on your sales team.

Start Automatically populated. An action must have a start date to appear in the Calendar.

Due Click the Calendar control and choose the completion date for the action.
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Creating a Blue Sheet Report
The Blue Sheet uncovers and communicates key information at a glance. It helps to focus your 
team’s attention on essential business and contact information. You can print the Blue Sheet or email 
it to your manager and team in report format or as an HTML document.

To create a Blue Sheet report

1 Navigate to the Opportunities screen > List view.

2 Drill down on the opportunity.

3 Click the Strategic Selling view tab.

4 Click the Reports button and select Blue Sheet. 

For more information on creating reports, see Siebel Reports Administration Guide.

Status Indicate the status for an action by selecting it from the list of values.

Display Indicate where you want the action to appear by selecting from the list of values. 
Options are Calendar and Activities, To-Do and Activities, and Activities Only. The 
default is Calendar and Activities. 

Field Comments
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A System Preferences
Table 96 lists the system preferences provided throughout your Siebel applications. For information 
about how to change system preferences, see Chapter 4, “Ongoing Application Administration Tasks.”

Table 96. System Preferences

Preference Description

AAG Cobrand Id Obsolete.

AAG Cobrand Password Obsolete.

AAG Connection Obsolete.

AAG Lit Obsolete.

AAG Update Interval Obsolete.

AAG URL Obsolete.

Activity Hierarchy: Max Levels The maximum number of levels for the Activity Hierarchy.

ActivityStatusToCloseVisit A visit activity cannot be closed unless all of its required child 
activities have a status value that matches one of the values in 
this system preference. (By default, an activity cannot be 
closed unless all required child activities have been done or 
canceled.)

Default: 'Done','Cancelled'

Alarm Manager Load Frequency Number of minutes the system waits before rechecking for 
alarms.

Default: 60

AllowOverReceipts If set to TRUE, the received quantity can be greater than the 
shipped quantity. Also, for an internal order, when the Process 
Receipt command is invoked, the pick ticket can be closed only 
when the received quantity is equal to or greater than the 
shipped quantity. 

For more information about shipping and receiving, see Siebel 
Field Service Guide.

Always Show Message Bar Alerts Obsolete.

AMS AMI Char Conversion For AMS ACAPS integration: defines CharSetConversion for the 
EAI MQSeries AMI Transport business service, which 
communicates between the Siebel application and the ACAPS.

AMS AMI Policy Name See Siebel Finance Guide.
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AMS AMI Receiver Service Name See Siebel Finance Guide.

AMS AMI Sender Service Name See Siebel Finance Guide.

AMS RefData DB ODBC 
DataSource

For AMS ACAPS integration: defines the ODBC data source 
name for the AMS reference database.

AMS RefData DB Password For AMS ACAPS integration: defines the password for the AMS 
reference database.

AMS RefData DB Table Owner For AMS ACAPS integration: defines the table owner for the 
AMS reference database.

AMS RefData DB User Name For AMS ACAPS integration: defines the user name for the AMS 
reference database.

Auto Mgr Calendar Access Allow employee’s manager access to the employee’s calendar, 
even if the employee does not explicitly give the manager 
access.

NOTE: If multiple employees share a position, only the 
calendar of the primary employee is accessible.

Default: True

Company Name See Siebel Pharma Handheld Guide.

CSM Logging Enables logging of merge transactions. Merge transactions are 
created when connected users combine or merge two or more 
business components such as accounts or opportunities into 
one.

Information from this log can be used to relink orphaned 
records created when the merge process is crossed with an 
update process during a synchronization. 

This is only applicable if the installation uses Siebel Remote or 
Replication Manager.

Default: False

DB2: Default Opt Level Default optimization level which defines the optimizing 
algorithm that DB2 will use to execute SQL statements.

DBX: Vis Rules per Statement 1 Number of visibility or routing rules checked per SQL statement 
processed by the Database Extract component for the first SQL 
statement with header information.

DBX: Vis Rules per Statement N Number of visibility or routing rules checked per SQL statement 
processed by the Database Extract component for other SQL 
statements.

Table 96. System Preferences

Preference Description
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Default Campaign Source Code Default campaign for Web offers used in Siebel eMarketing. All 
offers that are a part of the default campaign will appear in the 
Featured Offers applet in Siebel eMarketing.

Default EC Procedure Obsolete. 

Default MVG Exists Query Siebel Industry Applications only: adds an EXISTS statement 
to every MVG field query. For more information, see Siebel 
Developer’s Reference.

Default: TRUE

Default Offer Code Code to track the click path of a customer on the eMarketing 
Web site who does not select a specific offer.

Default Pricing Procedure Obsolete. 

Default Time Zone Default time zone for all users of that database.

When a user logs in, the Time Zone field of the User business 
component is checked. If it is empty, the Default Time Zone 
system preference is checked.

Default: UTC

Docking:Transaction Logging Enables docking transaction logging.

For more information, see Siebel Remote and Replication 
Manager Administration Guide.

eAuc:AllowTimeStampAdvantage Give an advantage to a bid based on when the bid was made. 

Default: True

eAuc:AsyncNoticeCalls Invoke notice workflows through asynchronous request 
manager. Default: False

eAuc:AuctionURLRoot The URL placed in email messages for auction events. 

Default: http://www.<yourDomain>.com

eAuc:AutoApproveBidder Automatically approve a user’s request to become a bidder.

Default: True

eAuc:AutoApproveLister Automatically approve a user’s request to become a lister.

Default: True

eAuc:AutobidToReservePrice When a bid is placed, if it does not meet an auction’s reserve 
price and the bid has an AutoBid amount, then automatically 
adjust the bid to come as close to or match the reserve price.

Default: False

Table 96. System Preferences

Preference Description
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eAuc:BidIncrementMultiple A floating point number that determines the minimum 
monetary unit increment (or decrement) for bids.

Default: 0.01

eAuc:BidIncrMultipleTolerance A floating point number between 0 and 0.005 which specifies 
the allowed deviation from an exact multiple of the 
eAuc:BidIncrementMultiple property. This provides 
accommodation for math rounding errors that could result if 
the BidIncrementMultiple is set to certain problematic number 
values (such as 0.17).

Default: 0.005

eAuc:BidTimeTieBreakOption Preference specified as either 1, 2, or 3:

■ If 1, then users who have prior winning bids have their 
follow-up bids timestamped to the time of the prior winning 
bid.

■ If 2, then users who have placed any prior bid have their 
follow-up bids timestamped to the time of the prior bid.

■ If 3, new and replacement bids and AutoBids are 
timestamped when placed

Default: 1

eAuc:DynamicCloseEnabled Allow extending an auction past its posted end time according 
to its dynamic close properties.

eAuc:DynamicCloseMaxDelay The maximum number of minutes an auction’s end time can be 
delayed because of dynamic close extensions. (Works in 
conjunction with eAuc:DynamicCloseEnabled set to True.)

Default: 60

eAuc:EnforceExactBidIncrement Enforce bids to be exact multiples of an auction’s bid increment 
(or decrement).

Default: True

eAuc:MaxMoneyValueAccepted The maximum monetary value accepted for an auction’s 
starting price, an auction’s bid increment (or decrement), a 
bid, or a lister fee.

Default: 1000000000

eAuc:MaxRatingsPerSale The number of times a user is allowed to rate another user per 
auction. This property applies to both bidders and listers.

Default:2

Table 96. System Preferences

Preference Description
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eAuc:MaxThirdPartyListingDays The maximum number of days between a third-party auction’s 
start and end times.

Default:14

eAuc:Notice Wf-Auction Alert Name of workflow process used to notify user that an Auction 
Alert has triggered. 

Default: eAuction Alert Notice

eAuc:Notice Wf-Autobid Name of workflow process used to notify user that they have 
successfully registered to participate in auctions. 

Default: eAuction Autobid Notice

eAuc:Notice Wf-Bid Name of workflow process used to notify Bidder that they have 
placed an acceptable bid. 

Default: eAuction Bid Notice

eAuc:Notice Wf-ListerBidAccept Name of workflow process used to notify Lister that a Bid has 
been placed on one of their Items.

Default: eAuction Bid Accepted Notice

eAuc:Notice Wf-ListerClose Name of workflow process used to notify Lister that their 
Auction has closed. 

Default: eAuction Lister Close Notice

eAuc:Notice Wf-ListerInvoiced Name of workflow process used to notify Lister that their 
Auction has been invoiced.

Default: eAuction Lister Invoiced Notice

eAuc:Notice Wf-Outbid Name of workflow process used to notify Bidder that they have 
been outbid. 

Default: eAuction Outbid Notice

eAuc:Notice Wf-PartialOutbid Name of workflow process used to notify Bidder that they have 
been outbid on some number of items. 

Default: eAuction Partially Outbid Notice

eAuc:Notice Wf-UserStatus Name of workflow process used to notify User of their status. 

Default: eAuction User Status Notice

eAuc:Notice Wf-UserWelcome Name of workflow process used to notify User that they have 
been accepted into an auction.

Default: eAuction User Welcome Notice

Table 96. System Preferences

Preference Description
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eAuc:Notice Wf-Winner Name of workflow process used to notify Bidder that they have 
won.

Default: eAuction Win Notice

Email Personalization Format Specifies the default email personalization format for sending 
offers in email marketing.

Example: /shared/Marketing/Example List Formats/Email 
Personalization - Contacts - Transaction database only example

Entitlement: Pricing Dates If False or NULL, date verification is skipped when entitlement 
pricing terms are checked in the Verify Entitlement process. 
(Similar to the Entitlement: Verify Dates system preference 
except that one applies to entitlement pricing terms and the 
other to entitlement service terms.)

Entitlement: Verify Consumer See Siebel Field Service Guide.

Entitlement: Verify Dates See Siebel Field Service Guide.

Entitlement: Verify Product See Siebel Field Service Guide.

ETL Alignment Version See Siebel Data Warehouse Installation and Administration 
Guide.

ETL Analysis End

ETL Analysis Start

ETL Date Format

ETL Date format indicates the way dates need to be 
interpreted. The other two parameters mention the date range 
for which the Exchange Rates will be adjusted. This does not 
indicate that only the data created within this range will be 
extracted. Select the earliest date for the Analysis Start Date—
that is, when the transactions may have begun. In addition to 
considering the created and modified dates, consider other 
relevant dates such as order date. Setting this to an early value 
such as 19700101 (January 1, 1970) does not affect the 
processing time. A similar logic applies for choosing Analysis 
End Date. Note that the values need to be entered in the format 
defined by ETL Date Format.

Default Analysis End: 20101231

Default Analysis Start: 19940101

Default Date Format: YYYYMMDD

ETL Base Exchange Currency Currency in which all the financial data will be converted. While 
the OLTP supports transactions in many different currencies, 
the data in the OLAP is converted to a single currency for 
analysis purposes. The Exchange rates are derived from the 
Exchange Rates table in the OLTP. 

Default: USD

Table 96. System Preferences

Preference Description
Applications Administration Guide Version 7.7, Rev. B572 ■



System Preferences ■
ETL Default Continent Value for any address that does not have Continent defined. 
Set this to a value, which will be used if the value of Continent 
is not defined in the OLTP. 

Default: North America

ETL Default Country Value for any address that does not have the Country defined. 
Set this to a value, which will be used if the value of Country is 
not defined in the OLTP. 

Default: USA

ETL Default Currency Value for currency code that will be used if the currency code 
for a specific financial transaction is not set. 

Default: USA

ETL Default Language Language code used when language translation occurs when 
looking up the List of Values table. 

Default: ENU

ETL LOV Maximum Value

ETL LOV Minimum Value

In some fields, bucketing of values happens. Instead of saying 
the number of employees at an account is 45, 96, the values 
can be bucketed to 0-50, 50-100 and so on. In the List of 
Values, if the minimum and maximum values are not specified, 
the values of these parameters will be used.

Defaults: 9999999999 and 0

ETL Unknown Exchange Rate Value used when an exchange rate for a currency to the 
Datamart Default Currency is undefined in the OLTP. 

Default: 1

FINSeBanking Bill Pay Campaign A user property for these applets:

■ FINS eBanking Bill Pay Home Campaign Applet

■ FINS eBanking Announcements Applet (Bill Pay)

■ FINS eBanking Special Offers Applet (Bill Pay)

When this system preference is set to a campaign name, these 
applets only display offers for that campaign.

FINSeBanking Campaign A user property for these applets: 

■ FINS eBanking Announcements Applet

■ FINS eBanking Home Campaign Applet

When this system preference is set to a campaign name, these 
applets only display offers for that campaign.

Table 96. System Preferences

Preference Description
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FINSeEnrollment Campaign A user property for the FINS eEnrollment Announcement List 
Applet. When this system preference is set to a campaign 
name, the applet only displays Web-Announcements offers for 
that campaign.

FINSeSales Campaign A user property for these applets: 

■ FINS Let Us Help You Applet (eSales)

■ FINS Whats New In Your Life Applet (eSales)

■ FINS eAdvisor Special Offers Applet

When this system preference is set to a campaign name, these 
applets only display offers for that campaign.

Forecast: Auto-Forecast Creates subordinates’ forecasts to be used in a rollup forecast, 
if the subordinates have not created forecasts themselves.

Forecast: Use Server Task Send forecast processing requests to the Siebel Server for 
batch processing. If the value is False, requests are processed 
locally.

FSAssetSwap SubComponents If set to TRUE, the subcomponent assets of the source asset 
are shifted to the target asset when an activity part tracker 
transaction is committed.

FSDB:Override Service Region Maximum monetary value accepted in Auction Item, Bid, and 
Fee currency fields.

INSeService Campaign A user property for the FINS FSW Announcements Applet. 
When this system preference is set to a campaign name, the 
applet only displays Web-Announcements offers for that 
campaign.

INSeService Discount Campaign A user property for the FINS FSW Health Discount 
Announcements Applet. When this system preference is set to 
a campaign name, the applet only displays Web-
Announcements offers for that campaign.

Internal DUNS Number Your company’s DUNS number.

LOGMGR:Vis Rules per 
Statement

Set to 50 by default. For implementations that use any 
database other than Oracle, you should change this value to 
20.

Lots For Disperse Only See Siebel Life Sciences Guide.

MRG:Docking Timestamp Source See Siebel Remote and Replication Manager Administration 
Guide.

MRG:Inter Table Conflict Res See Siebel Remote and Replication Manager Administration 
Guide.

Table 96. System Preferences
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MRG:Inter Table Merge Rule See Siebel Remote and Replication Manager Administration 
Guide.

MRG:System Conflict Resolution See Siebel Remote and Replication Manager Administration 
Guide.

MRG:Txns per Commit See Siebel Remote and Replication Manager Administration 
Guide.

MRG:User Friendly Notification See Siebel Remote and Replication Manager Administration 
Guide.

Quick Print Application A user property to determine the application used by quick 
print. Allowed values are: HTML and EXCEL. This system 
preference can be overridden by the Quick Print Application 
user preference.

Quick Print Output Format Set to HTML, CSV, or Tab, as appropriate for the quick print 
application that you are using.

ReadOnlyOrderStatus If the status of an order matches one of the values in this 
system preference, then the order becomes read-only when 
invoiced.

Default: 'Booked','Billed'

SalesHierarchy:UseServerTask If set to TRUE, the Sales Hierarchy operation runs as a server 
task.

Samples Lots Enabled See Siebel Life Sciences Guide.

Satmetrix Key Value A string provided by Satmetrix to customers of Siebel 
Satmetrix Surveys. Required for generating encrypted tokens 
that are part of URLs for displaying survey reports.

Sch:Break Time Id Specifies the Row ID of the work type to be used when 
calculating the schedule cost where activities contain breaks. 
The default value is -1. 

To find the Row ID, navigate to the Application Administration
screen > Work Type Administration view, select the record, 
choose About Record from the Help menu, and note the Row # 
value. 

Sch:Default Constraint Set Specifies the Row ID of the constraint set to be used where no 
constraint set is associated with the service region loaded. The 
default value is -1. 

To find the Row ID, navigate to the Scheduling Administration
screen > Constraint Sets view, select the record, select About 
Record from the Help menu and note the Row # value.

Table 96. System Preferences
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Sch:Default Cost Function Specifies the Row ID of the cost function to be used where no 
cost function is associated with the service region loaded. The 
default value is -1. 

To find the Row ID, navigate to the Scheduling Administration 
screen > Cost Functions view, select the record, select About 
Record from the Help menu and note the Row # value.

Sch:Default Parameter Set Specifies the Row ID of the parameter set to be used where no 
cost function is associated with the service region loaded. The 
default value is -1. 

To find the Row ID, navigate to the Scheduling Administration
screen > Parameter Sets view, select the record, select About 
Record from the Help menu and note the Row # value.

Sch:Default Time Window Specifies the Row ID of the time window to be used where no 
cost function is associated with the service region loaded. The 
default value is -1. 

To find the Row ID, navigate to the Scheduling Administration 
screen > Time Window view, select the record, select About 
Record from the Help menu and note the Row # value.

SecThickClientExtAuthent See Security Guide for Siebel eBusiness Applications.

SM WebIntelligence Server The URL that points to the Web Intelligence server that serves 
up reports for Siebel Analytics.

SqlStyle Indicate which SQL statements are to be used with this 
implementation—Oracle, Microsoft SQL Server, Informix, or 
Sybase. Case-sensitive.

SSASqlErrRsltsDiscarded This message is displayed to the user when there are more 
rows than can be returned. For more information, see 
Implementing Siebel eBusiness Applications on DB2 UDB for z/
OS and OS/390.

SubSqlStyle An SQLStyle that falls within a family of similar database 
products.

Syndicated Data Set to Y to allow syndexp.exe to generate the syndicated data 
files on the Siebel Server.

Syndicated data is only used in the Life Sciences application.

Target Lists Obsolete.

Table 96. System Preferences
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Technical Support (Alt. 1) Specifies the telephone numbers to display in the Siebel 
Technical Support dialog box. Update this number to match 
your internal help desk number. The alternate numbers (Alt. 1 
and Alt. 2) provide expansion for pager numbers and email 
addresses. 

Set a value to None to leave it blank in the dialog box.

Technical Support (Alt. 2) Specifies the telephone numbers to display in the Siebel 
Technical Support dialog box. Update this number to match 
your internal help desk number. The alternate numbers (Alt. 1 
and Alt. 2) provide expansion for pager numbers and email 
addresses.

Set a value to None to leave it blank in the dialog box.

Technical Support (FAX) Specifies the fax number to display in the Siebel Technical 
Support dialog box. Update this number to match your internal 
help desk fax number.

Set a value to None to leave it blank in the dialog box.

Technical Support (URL) Specifies the support URL to display in the Siebel Technical 
Support dialog box. Update this URL to match your internal 
help desk Web address.

Set a value to None to leave it blank in the dialog box.

Technical Support (Voice) Specifies the voice number to display in the Siebel Technical 
Support dialog box. Update this number to match your internal 
help desk number.

Set a value to None to leave it blank in the dialog box.

Training: EAI HTTP Password Specifies the password for the user name given in the Training: 
EAI HTTP User Name system preference.

Training: EAI HTTP Server Specifies the server that AICC/SCORM-compatible content 
uses for eAI communication.

If set to:

■ default, then the URL of the current Siebel Server is used 
(For example, if the Siebel URL is http://siebelserver/
erm_enu, the EAI URL is http://siebelserver/eai_enu.)

■ defaultsecure, then the URL of the secure Siebel Server 
is used

■ An explicit URL, this URL must be a complete beginning 
of a URL, for example, http://theeaiserver/eai_enu

Table 96. System Preferences
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Training: EAI HTTP User Name Specifies the Siebel login ID for eAI requests by the AICC/
SCORM-compatible content. 

CAUTION: Because the AICC and SCORM standards require 
this user name and the accompanying password to be used in 
a non-secure manner, choose a user name and a password that 
do not have access to any other part of the Siebel application. 

Training: Lesson Adapter URL Specifies the path to the lesson adapter HTML file, which is 
used by SCORM-compatible content.

This default value is typically satisfactory. This is a relative URL 
and is relative to the current URL of the Siebel application.

For example, if this system preference is set to lms/
LmsLessonAdapter.html and the current Siebel URL is http://
siebel/erm_enu, the URL launched for the lesson adapter is 
http://siebel/erm_enu/lms/LmsLessonAdapter.html. 

Default: LMS/LmsLessonAdapter.html

Training: Lesson Security Allowed values: PIN (the default) and blank

Specifies the method of lesson security used to validate eAI 
requests from AICC/SCORM-compatible lesson content.

If set to PIN, the launched AICC lesson is supplied a PIN 
number that it must use to interact with the Siebel application. 

Universal Time Coordinated Turns on global time zone support for the entire system. Set 
this preference to TRUE to enable global time zone support. 
The default setting is TRUE.

NOTE: This is a one-time setting. Once you have turned on 
global time zone support in a production environment, you 
should not turn it off.

If you intend to operate your deployment with the Global Time 
Zone feature enabled, you must also set the operating system 
of your database servers to UTC time, or its equivalent. Failure 
to set the OS to UTC when the UTC parameter is set to TRUE 
will result in asynchronous server request errors.

For more information on enabling Global Time Zone, see Global 
Deployment Guide. Although enabling this feature is optional, 
it is strongly recommended that you operate your production 
environment with Global Time Zone enabled.

UsageTracking Enabled See “Setting System Preferences for Usage Collection” on 
page 243.

Table 96. System Preferences

Preference Description
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UsageTracking Log Time Period See “Setting System Preferences for Usage Collection” on 
page 243.

UsageTracking LogFile Dir See “Setting System Preferences for Usage Collection” on 
page 243.

UsageTracking LogFile Encoding See “Setting System Preferences for Usage Collection” on 
page 243.

UsageTracking LogFile Format See “Setting System Preferences for Usage Collection” on 
page 243.

UsageTracking Sess Cache Size See “Setting System Preferences for Usage Collection” on 
page 243.

User Group The User Group grantee for database access privileges. It is 
used in the DDL Sync step in Siebel Tools where the schema for 
the application is defined. 

Table 96. System Preferences

Preference Description
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B Content Center Reference
This appendix provides detailed information on two subjects: 

■ Prebuilt Content Objects for Content Center on page 581

■ Content Project Business Service on page 593

Prebuilt Content Objects for Content 
Center
Each Content Object is based on a business object that was derived from an existing business object 
by removing unnecessary fields. You can modify these content objects according to your business 
needs. 

Table 97 lists each content object, the primary business object on which it is based, and its primary 
business component.

Table 97. Prebuilt Content Objects 

Content Object Business Object Primary Business Component

Catalog Content Object Product Catalog

(Content Management)

Product Catalog

Catalog Category Content 
Object

Catalog Category 

(Content Management)

Catalog Category Admin

ContentBase Content Asset 
Content Object

ContentBase Asset EAI ContentBase Asset (Content 
Management)

ContentBase Content Set 
Content Object

ContentBase Content Set EAI ContentBase Content Set 
(Content Management)

ContentBase Content Type 
Content Object

ContentBase Content Type EAI ContentBase Content Type 
(Content Management)

ERM Group News Item Content 
Object

ERM Group News Item EAI ERM Group News Item EAI

Literature Content Object Admin Sales Tool 

(Content Management)

Admin Sales Tool

Microsite Management Page 
Content Object

ePortal MM Page EAI ePortal MM Page EAI
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The tables below describe the data that is transferred for each business component that is included 
in the content object.

Catalog Content Object
Catalog is a prebuilt content object based on the business object Product Catalog (Content 
Management). Table 98 lists the business components for the prebuilt content object Catalog.

Microsite Management Page 
Item Content Object

ePortal MM Page Item EAI ePortal MM Page Item EAI

Price List Content Object Price List (Content 
Management)

Price List

Product Content Object Product Admin Definition 

(Content Management)

Internal Product

Product Class Content Object XA Authoring Object XA Class

Product Feature Content Object Product Feature

(Content Management)

Product Feature

Product Line Content Object Admin Product Line

(Content Management)

Admin Product Line

Resolution Item Content Object Resolution Item SR Resolution Item

Solution Content Object Solution Solution

Volume Discount Content 
Object

Volume Discount 

(Content Management)

Volume Discount

Table 98. Prebuilt Content Object: Catalog

Business Components Transferred Data Links

Product Catalog Catalog Information Primary

Product Catalog 
Translation

Language Translations of Catalog 
Information

Product Catalog/Product 
Catalog Translation

Table 97. Prebuilt Content Objects 

Content Object Business Object Primary Business Component
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Catalog Category Content Object
Catalog Category is a prebuilt content object based on the business object Catalog Category. Table 99 
lists the business components for the prebuilt content object Catalog Category.

ContentBase Content Asset Content Object
ContentBase Content Asset is a prebuilt content object based on the business object ContentBase 
Asset EAI. Table 100 lists the business components for the prebuilt content object Content Asset.

Table 99. Prebuilt Content Object: Catalog Category 

Business 
Components Transferred Data Links

Catalog Category Catalog Category Primary

Catalog Subcategory Association relationships Catalog Category/Catalog Subcategory

Internal Product Association relationships Catalog Category/Internal Product

Table 100. Prebuilt Content Object: ContentBase Content Asset

Business Components Transferred Data Links

ContentBase Asset 
(Content Management)

ContentBase Asset identity Primary

ContentBase Asset 
(Content 
Management)_Access 
Group

ContentBase Access Group 
relationship

ContentBase Asset 
(Content 
Management)_Current 
Version

ContentBase Asset current 
version identification

ContentBase Version 
(Content Management)

Asset revision information ContentBase Asset (Content 
Management)/ContentBase Version 
(Content Management)

ContentBase Data 
(Content Management)

Content stored in database 
repository

ContentBase Version (Content 
Management)/ContentBase Data 
(Content Management)

ContentBase Namespace 
Aliases (Content 
Management)

XML namespace 
information

ContentBase Version (Content 
Management)/ContentBase Namespace 
Aliases (Content Management)
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ContentBase Content Set Content Object
ContentBase Content Set is a prebuilt content object based on the business object ContentBase 
Content Set EAI. Table 101 lists the business components for the prebuilt content object ContentBase 
Content Set.

ContentBase Version File 
Attachment (Content 
Management)

Content stored in file 
system

ContentBase Version (Content 
Management)/ContentBase Version File 
Attachment (Content Management)

ContentBase Version for 
Version Children

Asset version interrelations ContentBase Asset (Content 
Management)/ContentBase Version for 
Version Children

ContentBase Ref (Content 
Management)

Links to other assets ContentBase Version for Version 
Children/ContentBase Ref (Content 
Management)

Table 101. Prebuilt Content Object: ContentBase Content Set

Business Components Transferred Data Links

ContentBase Content Set 
(Content Management)

Set identity Primary

ContentBase Content Set 
(Content 
Management)_Pr. Asset

Home page 
identification

ContentBase Asset 
(Content Management)

Asset identity ContentBase Content Set (Content 
Management)/ContentBase Asset (Content 
Management)

ContentBase Asset 
(Content 
Management)_Access 
Group

ContentBase Access 
Group relationship

ContentBase Asset 
(Content 
Management)_Current 
Version

ContentBase Asset 
current version 
identification

ContentBase Version 
(Content Management)

Asset revision 
information

ContentBase Asset (Content Management)/
ContentBase Version (Content 
Management)

Table 100. Prebuilt Content Object: ContentBase Content Asset

Business Components Transferred Data Links
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ContentBase Content Type Content Object
ContentBase Content Type is a prebuilt content object based on the business object ContentBase 
Content Type EAI. Table 102 lists the business components for the prebuilt content object 
ContentBase Content Type.

ContentBase Data 
(Content Management)

Content stored in 
database repository

ContentBase Version (Content 
Management)/ContentBase Data (Content 
Management)

ContentBase Namespace 
Aliases (Content 
Management)

XML namespace 
information

ContentBase Version (Content 
Management)/ContentBase Namespace 
Aliases (Content Management)

ContentBase Version File 
Attachment (Content 
Management)

Content stored in file 
system

ContentBase Version (Content 
Management)/ContentBase Version File 
Attachment (Content Management)

ContentBase Version for 
Version Children

Asset version 
interrelations

ContentBase Content Set (Content 
Management)/ContentBase Version for 
Version Children

ContentBase Ref (Content 
Management)

Links to other assets ContentBase Version for Version Children/
ContentBase Ref (Content Management)

Table 102. Prebuilt Content Object: ContentBase Content Type

Business Components Transferred Data Links

ContentBase Content 
Type (Content 
Management)

ContentBase Asset data 
type

Primary

ContentBase DocType 
(Content Management)

SGML document type ContentBase Content Type (Content 
Management)/ContentBase DocType 
(Content Management)

ContentBase Namespace 
(Content Management)

XML namespace information ContentBase Content Type (Content 
Management)/ContentBase Namespace 
(Content Management)

ContentBase NS Node 
Type (Content 
Management)

Namespace node 
information

ContentBase Namespace (Content 
Management)/ContentBase NS Node 
Type (Content Management)

Table 101. Prebuilt Content Object: ContentBase Content Set

Business Components Transferred Data Links
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ERM Group News Item Content Object
ERM Group News Item is a prebuilt content object based on the business object ERM Group News 
Item EAI. Table 103 lists the business components for the prebuilt content object ERM Group News 
Item.

Table 103. Prebuilt Content Object: ERM Group News Item

Business Components Transferred Data Links

ERM Group News Item 
EAI

News Item identity, content 
references

Primary

ERM Group News Content 
Path EAI

Publication stages for news 
item

ERM Group News Item EAI/ERM Group 
News Content Path EAI

ERM Group News Content 
Path Stages EAI

Publication stage details ERM Group News Content Path EAI/ERM 
Group News Content Path Stages EAI

ERM Group News Position 
EAI

Publication approvers for 
news item

ERM Group News Content Path EAI/ERM 
Group News Position EAI

Access Group Contentbase Asset access 
groups

ContentBase Asset (Content 
Management)/Access Group

ERM Group News Access 
Group Member EAI

Group News access group 
information

Access Group/ERM Group News Access 
Group Member EAI

ContentBase Content Set 
(Content Management)

Set identity ERM Group News Item EAI/ContentBase 
Content Set (Content Management)

ContentBase Content Set 
(Content 
Management)_Pr. Asset

Home page identification

ContentBase Asset 
(Content Management)

Asset identity ContentBase Content Set (Content 
Management)/ContentBase Asset 
(Content Management)

ContentBase Asset 
(Content 
Management)_Access 
Group

ContentBase Access Group 
relationship

ContentBase Asset 
(Content 
Management)_Current 
Version

ContentBase Asset current 
version identification

ContentBase Version 
(Content Management)

Asset revision information ContentBase Asset (Content 
Management)/ContentBase Version 
(Content Management)
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Literature Content Object
Literature is a prebuilt content object based on the business object Admin Sales Tool. Table 104 lists 
the business components for the prebuilt content object Literature.

Microsite Management Page Content Object
Microsite Management Page is a prebuilt content object based on the business object ePortal MM 
Page EAI. Table 105 lists the business components for the prebuilt content object Microsite 
Management Page.

Views associated with this content object are:

■ Add/Edit - ePortal MM Page Administration

ContentBase Data 
(Content Management)

Content stored in database 
repository

ContentBase Version (Content 
Management)/ContentBase Data 
(Content Management)

ContentBase Namespace 
Aliases (Content 
Management)

XML namespace information ContentBase Version (Content 
Management)/ContentBase Namespace 
Aliases (Content Management)

ContentBase Version File 
Attachment (Content 
Management)

Content stored in file 
system

ContentBase Version (Content 
Management)/ContentBase Version File 
Attachment (Content Management)

ContentBase Version for 
Version Children

Asset version interrelations ContentBase Content Set (Content 
Management)/ContentBase Version for 
Version Children

ContentBase Ref 
(Content Management)

Links to other assets ContentBase Version for Version 
Children/ContentBase Ref (Content 
Management)

Table 104. Prebuilt Content Object: Literature

Business Components Transferred Data Links

Admin Sales Tool Literature record and 
associated files

Primary

Literature Item Detailed relationships Admin Sales Tool/Literature Item

Literature Component 
Item

Association relationships Literature Item/Literature Component 
Item - Admin

Table 103. Prebuilt Content Object: ERM Group News Item

Business Components Transferred Data Links
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■ Preview - ePortal MM Page Designer View

Table 105. Prebuilt Content Object: Microsite Management Page

Business Components Transferred Data Links

EPortal MM Page EAI Page identity Primary

ePortal MM Page Section 
EAI

Page layout information ePortal MM Page EAI/ePortal MM Page 
Section EAI

ePortal MM Page Item EAI Page Item display 
information

ePortal MM Page Section EAI/ePortal MM 
Page Item EAI

ContentBase Content Set 
(Content Management)

Set identity ePortal MM Page EAI/ContentBase 
Content Set (Content Management)

ContentBase Content Set 
(Content 
Management)_Pr. Asset

Home page identification

ContentBase Asset 
(Content Management)

Asset identity ContentBase Content Set (Content 
Management)/ContentBase Asset 
(Content Management)

ContentBase Asset 
(Content 
Management)_Access 
Group

ContentBase Access Group 
relationship

ContentBase Asset 
(Content 
Management)_Current 
Version

ContentBase Asset current 
version identification

ContentBase Version 
(Content Management)

Asset revision information ContentBase Asset (Content 
Management)/ContentBase Version 
(Content Management)

ContentBase Data 
(Content Management)

Content stored in database 
repository

ContentBase Version (Content 
Management)/ContentBase Data 
(Content Management)

ContentBase Namespace 
Aliases (Content 
Management)

XML namespace information ContentBase Version (Content 
Management)/ContentBase Namespace 
Aliases (Content Management)

ContentBase Version File 
Attachment (Content 
Management)

Content stored in file 
system

ContentBase Version (Content 
Management)/ContentBase Version File 
Attachment (Content Management)
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Microsite Management Page Item Content Object
Microsite Management Page Item is a prebuilt content object based on the business object ePortal 
MM Page Item EAI. Table 106 lists the business components for the prebuilt content object Microsite 
Management Page Item.

Views associated with this content object are:

■ Add/Edit - ePortal MM Page Administration

■ Preview - ePortal MM Page Designer View

ContentBase Version for 
Version Children

Asset version interrelations ContentBase Content Set (Content 
Management)/ContentBase Version for 
Version Children

ContentBase Ref 
(Content Management)

Links to other assets ContentBase Version for Version 
Children/ContentBase Ref (Content 
Management)

Table 106. Prebuilt Content Object: Microsite Management Page Item

Business Components Transferred Data Links

ePortal MM Page Item EAI Page Item display 
information and asset link

Primary

ContentBase Asset 
(Content Management)

Asset identity ePortal MM Page Item EAI/ContentBase 
Asset (Content Management)

ContentBase Asset 
(Content 
Management)_Access 
Group

ContentBase Access Group 
relationship

ContentBase Asset 
(Content 
Management)_Current 
Version

ContentBase Asset current 
version identification

ContentBase Version 
(Content Management)

Asset revision information ContentBase Asset (Content 
Management)/ContentBase Version 
(Content Management)

ContentBase Data 
(Content Management)

Content stored in database 
repository

ContentBase Version (Content 
Management)/ContentBase Data 
(Content Management)

Table 105. Prebuilt Content Object: Microsite Management Page

Business Components Transferred Data Links
Applications Administration Guide Version 7.7, Rev. B ■ 589



Content Center Reference ■ Prebuilt Content Objects for Content Center
Price List Content Object
Price List is a prebuilt content object based on the business object Price List. Table 107 lists the 
business components for the prebuilt content object Price List.

Product Content Object
Product is a prebuilt content object based on the business object Product Admin Definition. Table 108 
lists the business components for the prebuilt content object Product.

ContentBase Namespace 
Aliases (Content 
Management)

XML namespace information ContentBase Version (Content 
Management)/ContentBase Namespace 
Aliases (Content Management)

ContentBase Version File 
Attachment (Content 
Management)

Content stored in file 
system

ContentBase Version (Content 
Management)/ContentBase Version File 
Attachment (Content Management)

ContentBase Version for 
Version Children

Asset version interrelations ContentBase Asset (Content 
Management)/ContentBase Version for 
Version Children

ContentBase Ref 
(Content Management)

Links to other assets ContentBase Version for Version 
Children/ContentBase Ref (Content 
Management)

Table 107. Prebuilt Content Object: Price List

Business Components Transferred Data Links

Price List Price List

Association relationships to 
Organizations

Primary

Table 108. Prebuilt Content Object: Product

Business Components Transferred Data Links

Internal Product Internal Product Primary

Admin Product Definition 
(Content Management)

Association relationships

Defined in the intersection 
table: Rank column; Value 
column

Internal Product/Admin Product 
Comparison - Admin (Content 
Management)

Table 106. Prebuilt Content Object: Microsite Management Page Item

Business Components Transferred Data Links
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Product Class Content Object
Product Class is a prebuilt content object based on the business object XA Authoring Object. 
Table 109 lists the business components for the prebuilt content object Product Class.

Component Product Association relationships

Defined in the intersection 
table: Relation Type

Internal Product/Component Product - 
Admin

FS Inventory Options Association relationships Internal Product/FS Inventory Options

FS Product Measurement 
Characteristics

Association relationships Internal Product/FS Product 
Measurement Characteristics

Internal Product Sales 
Tool

Association relationships Internal Product/Internal Product Sales 
Tool - Admin

Key Feature Association relationships Internal Product/Key Feature - Admin

Price List Association relationships

Defined in the intersection 
table: some columns

Internal Product/Price List - Admin

Table 109. Prebuilt Content Object: Product Class

Business Components Transferred Data Links

XA Class Product Class Primary

XA Class Translation Product Class Language 
Translations

XA Class/XA Class Translation

XA Attribute Product Class Child 
Attributes

XA Class/XA Attribute

XA Attribute Translation Product Class Child 
Attribute Language 
Translations

XA Attribute/XA Attribute Translation

Table 108. Prebuilt Content Object: Product

Business Components Transferred Data Links
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Product Feature Content Object
Product Feature is a prebuilt content object based on the business object Product Feature (Content 
Management). Table 110 lists the business components for the prebuilt content object Product 
Feature.

Product Line Content Object
Product Line is a prebuilt content object based on the business object Admin Product Line (Content 
Management). Table 111 lists the business components for the prebuilt content object Product Line.

Resolution Item Content Object
Resolution Item is a prebuilt content object based on the business object Resolution Item. Table 112 
lists the business components for the prebuilt content object Resolution Item.

Table 110. Prebuilt Content Object: Product Feature

Business Components Transferred Data Links

Product Feature Product Feature Primary

Product Feature_Product Line Association of Features to Product 
Line

N/A

Table 111. Prebuilt Content Object: Product Line

Business Components Transferred Data Links

Admin Product Line Product Line Primary

Admin Product Line_Position Association to Position N/A

Table 112. Prebuilt Content Object: Resolution Item

Business Components Transferred Data Links

SR Resolution Item Resolution Item Primary

Solution Association relationships SR Resolution Item/Solution
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Solution Content Object
Solution is a prebuilt content object based on the business object Solution. Table 113 lists the 
business components for the prebuilt content object Solution.

Volume Discount Content Object
Volume Discount is a prebuilt content object based on the business object Volume Discount. 
Table 114 lists the business components for the prebuilt content object Volume Discount.

Content Project Business Service
The Content Project business service allows clients to perform various operations on Siebel Content 
Projects. Business service scripts, workflow-driven services, and business components can call the 
Content Project business service methods to manipulate Content Projects. It can be used to start and 
publish a content project and to add, delete, and update a content project or a content item. 

Table 113. Prebuilt Content Object: Solution

Business Components Transferred Data Links

Solution Solution Primary

Related Solution Association relationships Solution/Related Solution

SR Resolution Item Association relationships Solution/SR Resolution Item

Table 114. Prebuilt Content Object: Volume Discount

Business Components Transferred Data Links

Volume Discount Volume Discount Primary

Volume Discount Item Detailed relationships Volume Discount/Volume Discount Item 
- Admin

(This link has no restriction on insert/
update.)

Price List Association relationships

Defined in the intersection 
table: some columns

Internal Product/Price List - Admin
Applications Administration Guide Version 7.7, Rev. B ■ 593



Content Center Reference ■ Content Project Business Service
AddContentItem Method
This method adds a content item to the specified project. First it searches the project in the Content 
Project business component, and then it searches content type name, pick applet, picklist name, and 
source field name in the Content Type business component.

Table 115 lists the arguments for the AddContentItem method.

AddProject Method
This method creates a new content project.

Table 116 lists the arguments for the AddProject method.

Table 115. Arguments for the AddContentItem Method

Argument Type Description Required

ProjectId Input The project ID to add a content item X

ItemName Input The item name to add X

ItemAction Input The action for item to perform X

ItemDescription Input The description for the item

ItemTypeId Input Type ID for the item X

ItemReference Input The reference for the item

ItemId Output The item ID for the added item

Table 116. Arguments for the AddProject Method

Argument Type Description Required

ProjName Input The project name to create X

ProjectDescription Input The description for the project

ProjectOwnerId Input The owner ID for the project

ProjectPlanPublicationDate Input The planning publication date for the 
project

ProjectPublicationWorkflowI
d

Input The publication workflow ID for the project

ProjectId Output The project ID for the created project
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Export Method
If Connect String is not empty, this method exports the project from the staging environment to the 
production environment. If Connect String is empty and Export Directory is not empty, the method 
exports the project to the export directory. The method fails if both Connect String and Export 
Directory are empty.

Table 117 lists the arguments for the Export method.

Import Method
This method imports a project which has been exported using Export method.

Table 118 lists the arguments for the Import method.

PublishProject Method
This method publishes the project by calling the methods RequestPublish and Publish of Content 
Project business component. If SynchronousIndicator=“N”, the method calls the RequestPublish 
method. Otherwise, it calls the Publish method.

Table 119 lists the arguments for the PublishProject method.

Table 117. Arguments for the Export Method

Argument Type Description Required

Content Project Id Input The project ID to export X

Connect String Input Connect string to export

Export Directory Input The directory to export

Table 118. Arguments for the Import Method

Argument Type Description Required

Content Project Id Input The project ID to import into X

Export Directory Input The directory containing the export project

Table 119. Arguments for the PublishProject Method

Argument Type Description Required

ProjectId Input The project ID to publish X

SynchronousIndicator Input Indicator for sync (Y or N; default is Y)
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RemoveContentItem Method
This method removes a content item. If ItemId is provided, ProjectId and ItemName are not 
necessary. Otherwise, ProjectId and ItemName are required.

Table 120 lists the arguments for the RemoveContentItem method.

RemoveProject Method
This method removes a content project.

Table 121 lists the arguments for the RemoveProject method.

StartProject Method
This method starts the project by calling the methods RequestStartProject and StartProject of the 
Content Project business component. If SynchronousIndicator = “N”, the method calls the 
RequestStartProject method. Otherwise, the method calls the StartProject method.

Table 122 lists the arguments for the StartProject method.

Table 120. Arguments for the RemoveContentItem Method

Argument Type Description

ProjectId Input The project ID from which the content item is 
removed

ItemName Input The item name to remove

ItemId Input The item ID to remove

Table 121. Arguments for the RemoveProject Method

Argument Type Description Required

ProjectId Input The project ID to remove X

Table 122. Arguments for the StartProject Method

Argument Type Description Required

ProjectId Input The project ID to start X

SynchronousIndicator Input Indicator for sync (Y or N; default is Y)
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UpdateContentItem Method
This method updates a content item. If ItemId is provided, ProjectId and ItemName are not 
necessary and the item name can be updated. Otherwise, ProjectId and ItemName are required. If 
ItemTypeId is provided, the method searches content type name, pick applet, picklist name, and 
source field name in Content Type business component.

Table 123 lists the arguments for the UpdateContentItem method.

UpdateProject Method
This method updates a content project.

Table 124 lists the arguments for the UpdateProject method.

Table 123. Arguments for the UpdateContentItem Method

Argument Type Description

ProjectId Input The project ID where update the content item

ItemName Input The item name to update

ItemId Input The item ID to update

ItemAction Input The action for item to update

ItemDescription Input The description to update

ItemTypeId Input Type ID to update

ItemReference Input The reference to update

ItemStatus Input The item status to update

Table 124. Arguments for the UpdateProject Method

Argument Type Description Required

ProjectId Input The project ID for updating X

ProjName Input The project name to update

ProjectDescription Input The description to update

ProjectOwnerId Input The owner ID to update

ProjectPlanPublicationDate Input The planning publication date to update

ProjectPublicationWorkflowI
d

Input The publication workflow ID to update
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activity template, deleting 262
process for administering and using 257
sales methodology, defining 257
sales methods, about 256
scenarios 256
TAS Customer Milestone template, creating in 

a localized application 261
activity templates

about and activity plans 255
activity assignment, about using to 

create 259
activity plans, using to create 263
creating without grandchild records 260
target lists, setting up for 406

ActivityStatusToCloseVisit system 
preference 567

Actuate connect string, specifying 296
Add Web Link tool

external page, creating a link to 226
using, about 225

AddContentItem method 593
AddProject method 594
addresses

note, displaying Households and Contacts 
screen 511

administration tasks
application-wide case insensitivity, 

enabling 68
browser, adding additional Web 

Browsers 72
case sensitivity, about and Siebel 

applications 67
Contact Us account, adding 66
currencies, setting up 52
currency conversions, setting up 53
date formats, about 63
email address and subjects, about 

adding 66
expense types, setting up 56
field-specific case insensitivity, 

enabling 70
global time zone support, administering 64
industry, adding 66
InsensitivityFactor parameter, 

modifying 68
language, adding 67
pager companies, setting up 63
payment terms, setting up 57
periods, setting up 58
predefined queries, about setting up 50
predefined queries, creating by saving a 

query 51
Predefined Query view, setting up predefined 

query in 51
quick fill template, editing 75
quick fill template, making public 74
screen home pages, setting up default view 

links 75
system preferences, setting 50
telephone formats, specifying 58
Web browser capabilities, adding 71
ZIP Codes, adding 64

Alarm Manager Load Frequency system 
preference 567

alarms
Alarm Manager Load Frequency, 

about 275
retroactive alarms, about and changing days 

displayed 275
alerts

about and example 123
creating and sending 124
email and screen alerts, about 173
recurring message alert, setting up 175
scenario, using alerts 123
single message alert, sending 175

AllowOverReceipts system 
preference 567

Always Show Message Bar Alerts system 
preference 567

AMS AMI Char Conversion system 
preference 567

AMS AMI Policy Name system 
preference 567

AMS AMI Receiver Service Name system 
preference 568

AMS AMI Sender Service Name system 
preference 568

AMS RefData DB ODBC DataSource system 
preference 568

AMS RefData DB Password system 
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preference 568
AMS RefData DB Table Owner system 

preference 568
AMS RefData DB User Name system 

preference 568
applets

list applets, enabling target lists on 408
list applets, saving of target lists in 409

application recycle period
configuring 297

approvers
and contributors, setting up 195
content item, adding or editing 197
content, approving 198

ASIs, integrating using
accounts, contacts, and household, using 

for 445
accounts, contacts, and households ASIs, 

setting up 446
Get Account ASI 448
Synchronize Account ASI 448
Synchronize Contact ASI 448
Synchronize Household ASI 448
Web service, setting up an inbound 

service 447
Web service, setting up an outbound 

service 446
workflow, activating 447

assessment templates
about 265
creating 266

assessments
assessment scores, about calculating 268
assessment templates, about 265
assessment templates, creating 266
opportunity, assessing 268
process of administering and using 266
scenario 265
Target Account Selling, assessing an 

opportunity for 269
TAS coach, using to perform 

assessment 270
Assignment Manager

using to assign activities 253
attachments

contact, associating with 452
decision issue, associating with 527
opportunities, adding to 501
reference attachments, viewing 518

audit scope, about 88
Audit Trail

about 87
application, configuring for 93
audit scope, about 88

Audit Trail Engine business service, about and 
exposed methods (table) 100

Audit Trail Engine business service, 
enabling 91

audit trail records and record details, 
viewing 97, 98

audit trail recovery in file auditing mode, 
about 91

business component and fields, configuring to 
be audited 93

business component, determining whether it 
can be audited 89

business component, disabling 94
business component, linking to 99
cache, clearing 92
caution, about purging records 98
content of 88
customer application, configuring for Audit 

Trail 91
disabling for application 92
file auditing and database auditing, 

about 90
importing items into Siebel database 98
modes 88
object interfaces, about using with 93
parent-child business components, 

configuring to be audited 94
position, restricting by 96
process flow (diagram) 91
querying audit trail information 98
records, verifying 97
responsibility, restricting by 96
restrictions, list of 89
Siebel Remote and Siebel Replication users, 

about using 90
user, restricting by (procedure) 96

Audit Trail Buscomp, fields in list 94
Audit Trail Engine business service

about and exposed methods (table) 100
enabling (procedure) 91

Auto Mgr Calendar Access system 
preference 568

B
batch printing

See also client-based batch printing; server-
based batch printing

about 381
server print menu items, adding on 

Correspondence and Fulfillment 
screens 382

setting up, about 382
bcp utility
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about loading D&B data on Microsoft SQL 
server 419

best actions view, adding 565
Blue Sheet report, creating 566
Broadcast Message business component 

fields 119
BU/SU offering summary, viewing 539
bulk copy process (bcp) utility 419
Business and Service Unit, adding 532
business components

audit trail, disabling for individual business 
component 94

audit trail, linking to 99
audited, configuring for 93
audited, determining whether it can be 

audited 89
child modifications, disabling for business 

components 290
child modifications, enabling for business 

components 290
foreign keys to child object, modifying 187
foreign keys, modifying 186
identical user key column names, example of 

handling 188
primary business components 581
state models, about configuring for 285
state models, enabling in Siebel Tools 285

business objects
prebuilt content objects, relation to 581
in presentations 318

business service
Audit Trail Engine, about 100
Audit Trail Engine, enabling 91
Content Project, about 193
Content Project, list of services 593
CreateInbox method 152
CreateInboxEx method 151
CreateInboxItem method 154
CreateInboxOwner method 155
DeactivateInboxItem method 163
DeactivateInboxOwner method 164
DeleteInboxItem method 166
GetInboxItemInfo method 157
GetInboxOwnerInfo method 160
GetInboxOwnerInfoEx method 159
GetInboxParamInfo method 158
Initialize method 166
IsInboxItemExisted method 157
RouteInboxItem method 167
SetInboxParamInfo method 161
Universal Inbox definitions 149
Universal Inbox, about 129
UpdateInboxItemInfo method 162
UpdateInboxOwnerInfo method 165

Web Engine User Agent 71
buying influence information 563

C
cache, clearing 79
caching

hierarchical menus, configuring colors and 
icons 238

message broadcast caching, 
configuring 120

microsite caching, configuring 236
mmlayout.txt File, adding new view 

layouts 237
calendar

Alarm Manager Load Frequency, about system 
preference 275

calendar access administration 
scenarios 271

calendar access, about 271
calendar activities, administering 

resources 273
calendar activity description 276
calendar activity display, starting and end 

times 278
calendar activity hyperlink user 

properties 277
calendar administration, process of setting 

up 272
Calendar Detail view, changing 

controls 281
calendar drilldown, about and 

configuring 278
calendars to which an employee has access, 

viewing 273
drag-and-drop, about and user 

properties 279
eCalendar Detail applet, about required 

fields 275
employee’s Calendar Owner drop-down list, 

removing all employees from 274
employee’s calendar, giving another 

employee access to 273
employees’ Calendar Access List views, 

removing an employee from 274
Life Sciences calendar, hiding side 

applet 281
reference activity, adding to 518
resource administration scenarios 271
resources, about 271
retroactive alarms, about and changing days 

displayed 275
To Do List, removing 276
ToolTip text user properties 277
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ToolTip text, about 276
Calendar Access List views

removing an employee from 274
Calendar Detail view

changing controls 281
Calendar Owner drop-down list

removing all employees from 274
canceling

page layout changes 231
case sensitivity

about and Siebel applications 67
case insensitivity, enabling application 

wide 68
case insensitivity, enabling application wide 

Siebel Dedicated Web Client 69
case insensitivity, enabling for Application 

Object Manager 69
case insensitivity, enabling Siebel Web 

Client 69
field-specific case insensitivity, 

enabling 70
InsensitivityFactor parameter, 

modifying 68
Catalog Administration screen

associating literature with a category 399
catalog category content object

about and business components 583
catalog content object

about and business components 582
categories

about 521
account category, adding 522
scenario 521
searching for a category 522

Category icon, configuring 147
charts

currency conversion, supporting 56
opportunity charts 502
sales pipeline analysis chart, viewing 503
sales pipeline phases analysis chart, 

viewing 504
child records

child modification, disabling for business 
components 290

child modification, enabling for business 
components 290

state models, changing behavior 289
child Web browser, adding 74
Clear Cache button

using to clear cache 80
client-based batch printing

See also printing
about 381

Company Name system preference 568

competitive analysis
company comparisons, viewing 524
competitive analysis information, 

adding 550
TAS coach, using for 550

competitors
competitor comparisons, viewing 524
opportunity, associating with 523
scenario 523

component group
enabling Document Server for 295

components
synchronizing 296

conditions
templates, about using in 359
templates, criteria examples 359
templates, entering criteria 359
using in templates 328

constrained list of values
See list of values, constrained

constrained pick lists
See list of values, constrained

Contact Us account, adding 66
contacts

account contact, updating an external system 
with 459

account, associating a contact with 452
accounts, adding to 469
adding a contact 450
attachments, associating with a 

contact 452
buying influence information, adding 563
contact information, updating in external 

systems 454
defined 449
existing account used in Siebel Sales, 

associating with 459
existing contact, associating with an 

opportunity 496
household address, specifying for a household 

contact 510
household contact, storing information related 

to 512
household, adding contacts to 510
new account used in Siebel Sales, associating 

with 459
new contact, associating with an 

opportunity 495
opportunity, associating a contact 

with 452
organization analysis. adding existing 

contacts to 498
organization analysis. creating new contacts 

for 499
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organization chart, deleting from 537
organization map, deleting contacts 

on 553
partners, adding 538
personal contact, promoting to a sales 

contact 453
profile, creating for a contact 453
reference, associating with 517
scenario 449
synchronization list, adding a contact 

to 453
synchronization list, removing a contact 

from 454
content

content item, adding or editing 197
content, approving 198
defined 181

content asset management
configuring 207
content asset properties, viewing and 

editing 204
Content Asset Types view, about 207
content asset, checking in and out 206
content assets defined 201
content sets, adding content assets to 203
content sets, defining to contain content 

assets 202
home page, setting for a content set 204
HTML content, editing 207
scenario 201

Content Asset Types view
about 207

content assets
Content Asset commands on menu 

button 206
content asset management, 

configuring 207
content asset properties, viewing and 

editing 204
Content Asset Types view, about 207
content asset, checking in and out 206
content sets, adding to 203
content sets, defining to contain content 

assets 202
content sets, setting home page 204
defined 181, 201
HTML content, editing 207
page, adding to 227
scenario 201
search indexes, about creating 235

Content Center
about and features 179
auto complete workflow 192
business components containing foreign keys 

to child object, modifying 187
business components containing foreign keys, 

modifying 186
business components, handling identical user 

key column names 188
content approval process (single approver) 

workflow 191
content assets, adding to Content 

Center 207
content item approval process, about setting 

up workflows 189
content item state model 190
content item, adding or editing 197
content objects, setting up 186
Content Project business service, about and 

arguments 193
content project status, reviewing 196
content projects approval workflow, 

starting 196
content projects, creating 195
content projects, publishing 198
content staging environment, setting 

up 184
Content Task Subprocess 191
content types, setting up 194
content, approving 198
contributors and approvers, setting up 195
integration objects, creating 188
integration objects, modifying 189
job roles and terms, table of 180
process flow example 184
process of setting up and using 183
publication workflows, setting up 192
scenario 182
staging and production environment, 

maintaining consistency 185
terminology table 181

content item approval process, setting up
about 189
auto complete workflow 192
content approval (single approver) 

workflow 191
Content Task Subprocess 191
state model 190

content item, defined 181
content objects

catalog category content object 583
catalog content object 582
content center, setting up for 186
ContentBase Asset content object 583
ContentBase Set content object 584
ContentBase Type content object 585
defined 181
ERM Group News Item content object 586
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integration objects, creating for content 
center 188

literature content object 587
microsite management page content 

object 587
microsite management page item content 

object 589
prebuilt content objects 581
price list content object 590
product class content object 591
product content object 590
Product Feature content object 592
product line content object 592
resolution item content object 592
solution content object 593
volume discount content object 593

Content Project business service 193
AddContentItem method 593
AddProject method 594
Export method 595
Import method 595
PublishProject method 595
RemoveContentItem method 596
RemoveProject method 596
StartProject method 596
UpdateContentItem method 597
UpdateProject method 597

content projects
approval workflow, starting 196
creating 195
project status, reviewing 196
publishing 198

content sets
content assets, adding to content set 203
defining to contain content assets 202
home page, setting for a content set 204

content staging environment, setting up
about and required components 184
staging and production environments, 

maintaining consistency 185
content types

defined 182
setting up 194

ContentBase Content Asset content object
about and business components 583

ContentBase Content Type
about and business components 585

ContentBase Set content object
about and business components 584

contributors
and approvers, setting up 195
content item, adding or editing 197
content, approving 198

CookiesAllowed

additional browser capabilities 71
correspondence

about 301
batch printing, about 381
batch printing, about setting up 382
correspondence template records, about 

creating 308
correspondence templates, about 302
correspondence templates, creating in Office 

XP 307
correspondence templates, creating in 

Word 306
correspondence templates, inserting files 

into 307
correspondence templates. configuring 

additional merge fields 312
enabling HTML generation 297
fulfillment center, sending correspondence 

to 379
fulfillment requests, monitoring status 

of 380
generating 309
multiple languages and locales, about 

correspondence with 302
process of setting up and using 304
recalling 380
scenario 303
server print menu items, adding on 

Correspondence and Fulfillment 
screens 382

server-based batch printing, 
configuring 383

SIEBEL.HTML file, about 304
SIEBEL.HTML file, initially creating or 

updating 305
template record, adding 309
terms defined 302

correspondence templates
configuring additional merge fields 312

Create Activities for List command
using 407

Create Content tool
adding HTML to a page 226

create menu tool
menu of links, creating 222
using, about 221

Create Rerouted Oppty Activity workflow
setting up 481

CreateInbox method 152
CreateInboxEx method 151
CreateInboxItem method 154
CreateInboxOwner method 155
CSM Logging system preference 568
currencies, setting up
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active, making 52
active, making currencies active 52
currencies, defining 52

currency conversion, setting up
Euro Triangulation method, about 55
exchange rates, setting up 53
Siebel applications, conversion occurs 

in 55
triangulation conversion, process of 55

custom hierarchy
about 471
creating 473
default hierarchy, creating based on 474
organization, assigning to 474
updating 474

customer milestones
about 555
adding a milestone 555
associated activities, adding to each 

milestone 556

D
D&B integration

account promotion and prospect list creation 
configuration 430

account promotion and prospect lists, field 
mappings for 437

aggregate data. viewing 439
company data and report, accessing 439
configuration guidelines 429
D&B account, promoting 440
D&B real-time search and update, setting up 

symbolic URL for 428
D&B real-time updates, field mapping 

for 435
D&B report ordering, setting up symbolic URL 

for 428
D&B report, viewing 441
data, about 413
DB2, loading D&B data on 418
D-U-N-S number, understanding 415
files and format, required 416
global integration, using to add new 

accounts 441
loading D&B data 416
loading or reloading data 417
Microsoft SQL Server, loading D&B data 

on 419
multiple D&B update manager 

processes 423
multiple D&B update manager processes, with 

first time data loading 423
multiple processes and D-U-N-S number 

processing 423
Oracle, loading D&B data on 418
process of integrating data 415
prospect list, creating from D&B data 440
sample scripts, caution before running 418
scenarios 414
server components, about updating 420
server components, multiple D&B update 

manager processes 422
server components, multiple task Siebel 

update 422
server components, single task Siebel 

update 421
server components, updating process 420
Siebel update server component, 

running 424
symbolic URL, setting up 428
update server process configuration 430

D&B Update Manager
account promotion and prospect lists, field 

mappings for 437
D&B real-time updates, field mapping 

for 435
D&B server component field mappings 433
D&B server component, running as multiple 

task process 426
D&B server component, running as single task 

process 425
D&B server component, running from a 

command line 427
D&B Siebel server component, running from a 

command line 427
D&B, running without updating or deleting 

data 431
Siebel server component field 

mappings 433
Siebel server component, running as multiple 

task process 426
Siebel server component, running as single 

task process 426
Siebel, running without updating account 

name or location 432
tip, about running 425

data
and timestamps, about 65
import, list of values, considerations 86
seed data, about 33

Data Universal Numbering System number
See D-U-N-S number

database auditing
about 90
Siebel Web Client, audit trail option 88

databases
sample database, about 33
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selecting 33
date formats, about 63
DB2, loading D&B data on 418
DB2: Default Opt Level system 

preference 568
DBX: Vis Rules per Statement 1 system 

preference 568
DBX: Vis Rules per Statement N system 

preference 568
DeactivateInboxItem method 163
DeactivateInboxOwner method 164
debugging, enabling additional 

logging 298
decision issues

attachments, associating with decision 
issue 527

decision issues details, adding 526
literature, associating with the decision 

issue 527
opportunity, associating with 526
opportunity, viewing for 495
related issues, adding 527
scenario 525

dedicated Web clients
application-wide case insensitivity, 

enabling 69
databases, selecting 33
error message, first time logging in 30
license key, entering 30
message broadcasting, enabling or 

disabling 116
Siebel application, starting from 28

Default Campaign Source Code system 
preference 569

Default EC Procedure system 
preference 569

default hierarchy
about 471
generating 473

Default MVG Exists Query system 
preference 569

Default Offer Code system preference 569
Default Pricing Procedure system 

preference 569
Default Time Zone system preference 569
Delete command 206
DeleteInboxItem method 166
deleting

activity template 262
contacts from organization chart 537
contacts on organization map 553
employee from all employee’s Calendar 

Access List views 274
employees from Calendar Owner drop-down 

list 274
Inbox items 132
languages, about and mobile Web client 

synchronization 67
lines of influence 500
lines of influence on the organization 

map 554
page items 230
pages and root-level pages 233
To Do List 276

demo user, logging on 33
Display Value field

about modifying and updating records 82
dnbinitial.sql file

using to load D&B data 423
Docking:Transaction Logging system 

preference 569
document field mappings

defining, about 360
mapping, creating 361
mapping, fields 362

Document Server
See Siebel Document Server

DocumentServerViewHTML parameter
about 297

DTR files, caution about deleting 207
D-U-N-S number

about 415
warning about multiple processes 423

dynamic pick lists
constraining, about 86
using, about 77

E
EAI objects

See integration objects
eAuc:AllowTimeStampAdvantage system 

preference 569
eAuc:AsyncNoticeCalls system 

preference 569
eAuc:AuctionURLRoot system 

preference 569
eAuc:AutoApproveBidder system 

preference 569
eAuc:AutoApproveLister system 

preference 569
eAuc:AutobidToReservePrice system 

preference 569
eAuc:BidIncrementMultiple system 

preference 570
eAuc:BidIncrMultipleTolerance system 

preference 570
eAuc:BidTimeTieBreakOption system 
Applications Administration Guide Version 7.7, Rev. B ■ 607



Index ■ E
preference 570
eAuc:DynamicCloseEnabled system 

preference 570
eAuc:DynamicCloseMaxDelay system 

preference 570
eAuc:EnforceExactBidIncrement system 

preference 570
eAuc:MaxMoneyValueAccepted system 

preference 570
eAuc:MaxRatingsPerSale system 

preference 570
eAuc:MaxThirdPartyListingDays system 

preference 571
eAuc:Notice Wf-Auction Alert system 

preference 571
eAuc:Notice Wf-Autobid system 

preference 571
eAuc:Notice Wf-Bid system 

preference 571
eAuc:Notice Wf-ListerBidAccept system 

preference 571
eAuc:Notice Wf-ListerClose system 

preference 571
eAuc:Notice Wf-ListerInvoiced system 

preference 571
eAuc:Notice Wf-Outbid system 

preference 571
eAuc:Notice Wf-PartialOutbid system 

preference 571
eAuc:Notice Wf-UserStatus system 

preference 571
eAuc:Notice Wf-UserWelcome system 

preference 571
eAuc:Notice Wf-Winner system 

preference 572
eCalendar Detail applet, about required 

fields 275
email

address, about adding 66
alerts, about 173
message, using to send 176
opportunity assigned notification 

process 479
Email Personalization Format system 

preference 572
Employee field

configuring for activities 254
employee setup

completing 40
information, additional 39

employees
about activity assignment methods 248

Enterprise Application Integration (EAI)
See integration objects

Enterprise Selling Process
account plan and account map reports, 

generating 541
account plan highlights, adding 540
BU/SU offering summary, viewing 539
Business and Service Unit, adding 532
contact, adding 538
manager approval, viewing 541
objectives, adding 539
offerings, adding to Business and Service 

Units 533
organization chart, printing 538
organization’s reporting structure, 

charting 536
organization’s reporting structure, deleting 

contacts 537
organization’s reporting structure, deleting 

line of influence 537
organization’s reporting structure, drawing 

lines of influence 537
organization’s reporting structure, 

representing 537
organizational analysis 535
overview 530
partners, adding 538
scenario 530

Entitlement: Pricing Dates system 
preference 572

Entitlement: Verify Consumer system 
preference 572

Entitlement: Verify Dates system 
preference 572

Entitlement: Verify Product system 
preference 572

ERM Group News Item
about and business components 586

ESP
 See Enterprise Selling Process

ETL Alignment Version system 
preference 572

ETL Analysis End system preference 572
ETL Analysis Start system preference 572
ETL Base Exchange Currency system 

preference 572
ETL Date Format system preference 572
ETL Default Continent system 

preference 573
ETL Default Country system 

preference 573
ETL Default Currency system 

preference 573
ETL Default Language system 

preference 573
ETL LOV Maximum Value system 
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preference 573
ETL LOV Minimum Value system 

preference 573
ETL Unknown Exchange Rate system 

preference 573
Euro Triangulation method

about 55
triangulation conversion, process of 55

exchange rates
multiple currencies, about setting up 

for 52
setting up 53

expense reports
about currency conversion 56

expense types, setting up
about and pretasks 56

Export method 595
exporting

iHelp item as HTML file 111
external pages

link, creating to 226
linking to, about 225

external system
sending household information to 513

F
features, new

version 7.7 25
version 7.7, Rev A 23, 24

field-specific case insensitivity
enabling 70

file
adding to a page 228

file auditing
about 90
audit trail recovery, about 91
Siebel Web Client, audit trail option 88

FINSeBanking Bill Pay Campaign system 
preference 573

FINSeBanking Campaign system 
preference 573

FINSeEnrollment Campaign system 
preference 574

FINSeSales Campaign system 
preference 574

Forecast: Auto-Forecast system 
preference 574

Forecast: Use Server Task system 
preference 574

forecasting
about currency conversion 55

foreign keys
foreign key to child object, modifying 187

modifying business components with 186
FrameSupport

additional browser capabilities 71
FSAssetSwap SubComponents system 

preference 574
FSDB:Override Service Region system 

preference 574
fulfillment centers

adding 378
correspondence, sending to 379
reasons for using 377
requests, monitoring status of 380
Siebel correspondence, giving access 

to 379

G
Get Account ASI 448
Get Manager Email process

setting up 482
GetInboxItemInfo method 157
GetInboxOwnerInfo method 160
GetInboxOwnerInfoEx method 159
GetInboxParamInfo method 158
global accounts

account hierarchies, types of 471
custom hierarchy, assigning to an 

organization 474
custom hierarchy, creating 473
custom hierarchy, creating based on default 

hierarchy 474
custom hierarchy, updating 474
default hierarchy, generating 473
global accounts, viewing 475
process flow for using and administering 

accounts 472
scenario 471

global deployment
about correspondence with multiple 

languages and locales 302
global integration

using to add D&B accounts 441
Global Target List Management

about 401
activity templates, setting up for target 

lists 406
create activities asychronously, 

configuring 407
example process workflow 403
information, for additional 402
list applets, enabling target lists on 408
lists, kinds of 402
scenario 402
target lists, applying 405
Applications Administration Guide Version 7.7, Rev. B ■ 609



Index ■ H
target lists, creating activities from 405
target lists, creating by combining 

lists 404
target lists, creating by querying 403
target lists, editing 404
target lists, saving for a list applet 409
workflows, about 407

H
hardware

obtaining for document server 291
help

See iHelp
hierarchical menus

configuring colors and icons 238
hierarchy

custom hierarchy, assigning to an 
organization 474

custom hierarchy, creating 473
custom hierarchy, creating based on the 

default hierarchy 474
custom hierarchy, updating 474
default hierarchy, generating 473

high interactivity mode
microsite pages, using in 212

[H] high message, severity level 116
HighInteract

additional browser capabilities 71
home page

setting content set for 204
Honor MaxTasks parameter

MaxTasks parameters, setting 295
setting, about 295

households
activity, adding to 511
adding a household 508
address, specifying for a household 

contact 510
contact, storing information related to 512
contacts, adding to a household 510
defined 507
external system, sending household 

information to 513
information, types that can be related to 

household 512
information, viewing additional information 

related to 513
note, displaying addresses in Households and 

Contacts screens 511
scenario 508

HTML
adding to a page 226
content assets, editing content 207

exporting iHelp item as 111
generation, enabling for 

correspondence 297
importing iHelp item as 111
presentations, displaying in HTML 

format 334
proposals, displaying in HTML format 365

I
iHelp

about 101
active iHelp item, revising 109
administering iHelp scenario 101
buttons, about activating, revising, and 

deactivating 108
designing iHelp 104
example process workflow 102
iHelp Designer, accessing 106
iHelp item records, creating 102
iHelp item, activating 109
iHelp item, deactivating 109
iHelp items, exporting as HTML file 111
iHelp items, importing as HTML file 111
iHelp items, translating 110
iHelp list cache, clearing 108
iHelp step, creating 106
steps, connecting with branches 108
terminology 101

image
adding to a page 228

Import method 595
ImportFileEnabled parameter 207
ImportFilePath parameter 207
importing

audit trail items into Siebel database 98
iHelp item as HTML file 111

Inbox
about 127
deleting Inbox items 132
destination view, changing for Inbox 

type 132
expiration dates and due dates, 

setting 132
feature objects, interaction with 128
Inbox item, approving or rejecting 134
Inbox items, reviewing all 131
previously approved items, reviewing 135
process of administering and using 130
remote database, changing downloading 

to 133
scenario for approving personnel action 

forms 130
scenario for service request 
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management 130
submitted items, reviewing 135
translations, adding 134
Universal Inbox business service, 

about 129
Inbox approval translations

setting up 145
Inbox type

about 139
action type 139
category 140
creating 140

Inbox views
action buttons for high interactivity, 

configuring 148
action buttons for standard interactivity, 

configuring 148
action buttons, configuring background 

colors 149
action buttons, configuring for 148
toggle applets, configuring 146
toggle applets, types supported 146

Inbox, configuring
action buttons for high interactivity, 

configuring 148
action buttons for standard interactivity, 

configuring 148
action buttons, configuring background 

colors 149
action buttons, configuring for Inbox 

views 148
actions, about 142
actions, setting up 143
Category icon, configuring 147
Inbox action type 139
Inbox approval translations, setting 

up 145
Inbox category 140
Inbox item, deactivating 142
Inbox items, configuring the application to 

create 138
Inbox log file, setting level for 

troubleshooting 149
Inbox trigger used in ESS 168
Inbox trigger used in Server Script 169
Inbox type, creating 140
Inbox types 139
planning an Inbox configuration 138
process of setting up and configuring 137
remote databases, configuring using 144
toggle applets, configuring for Inbox 

views 146
Universal Inbox business service 

methods 149

views and SmartScripts, setting up Inbox 
links 141

industries
adding an industry 66

Initial Plan report 558
Initialize method 166
InsensitivityFactor parameter

modifying 68
Insert Content tool

adding content assets 227
Insert File tool

using 228
Insert Image tool

using 228
Insert Template tool

using 220
insertion templates

inserting files into correspondence 
templates 307

INSeService Campaign system 
preference 574

INSeService Discount Campaign system 
preference 574

installing
Microsoft Office applications, installing on 

Document Server 294
Siebel Server for Document Server 292
software required, table 27

integration objects
creating 188
modifying 189

Internal DUNS Number system 
preference 574

international telephone formats
about entering and format logic 60

Internet Explorer 5.0
adding JumpTab capability 73

intervals
sorting messages by 176

IsInboxItemExisted method 157

J
JumpTab capability

adding for Internet Explorer 5.0 73

L
Language Independent Code

list of values, about changing 82
list-of-values type, about within the 79

language independent values (LIV)
about changing list of values 82

languages
adding 67
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multiple languages, about correspondence 
with 302

lead sources
setting up for opportunities 483

leads, rerouting 481
license keys

about 29
additional license key, entering using a Siebel 

application 31
additional license key, entering using Siebel 

Tools 31
caution, about entering option-module license 

key 30
correcting errors 30
fields, table of 32
first license key, entering 30
hiding access to 32
option module license key 30

lines of influence
organization chart, deleting lines of 

influence 537
organization chart, using to draw 537
organization map, deleting 554
organization map, drawing 553

Link App View tool
using 224

Link Existing Page tool
using 223

list applets
target list, saving in an applet 409
target lists, enabling on an applet 408

list of values (LOV)
about 77
cache, clearing 79
caution, modifying seed data 82
inactivating a value, about and 

procedure 83
items, modifying 82
Language Independent Code values 

(LIV) 82
list-of-values type, identifying for a display 

value 78
LOV data, viewing 77
LOV record, fields in (table) 80
modifying, about 82
new value, adding to an existing list 78

list of values, constrained
about 84
Parent LIC attribute, about changing parent 

Area 85
Parent LIC attribute, about making values 

hierarchically dependent 84
Siebel EIM considerations 86

literature

See Siebel Literature
Literature Administration screen

associating literature with a category 399
literature files

See Siebel Literature
literature item kits

creating 394
literature prebuilt content object

about and business components 587
literature records

creating 391
LIVs

list of values, about changing for 82
local database, about 33
locales

creating 42
editing current locale 45
multiple languages, about correspondence 

with 302
setting up, about 41
translation, creating for 45

Lock command 206
locking

presentation 342
proposal 373

log files
Inbox log file, setting level for 

troubleshooting 149
usage-tracking log files, reviewing 244

logging
demo user, on as 33
logging, enabling additional 298

LOGMGR:Vis Rules per Statement system 
preference 574

Lots For Disperse Only system 
preference 574

LOV
See list of values (LOV)

M
Management Responsibility Code

about 416
manager approval, viewing 541
mapping

template, associating with 363
Marketing Data file, about 416
marketing resources, balancing tool 532
MaxTasks parameters

setting 295
setting, about 295

message broadcasting
Broadcast Message business component 

fields, table of 119
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caching, configuring 120
message broadcast script, sample of 120
message text, about automatically 

updating 119
messages, creating and sending 117
mobile and dedicated Web clients, enabling or 

disabling 116
overview 113
process flow example 115
scenario 114
server level, enabling/disabling message 

broadcasting 115
severity levels 116

messages
email and screen alerts, about 173
email, using to send a message 176
messages created by you, viewing 175
new message, creating 173
recurring message alert, setting up 175
setting up and using, process of 172
setting up scenario 171
single interval, sorting messages by 176
single message alert, sending 175
using, about 172
workflows for Messages screen and views, 

setting up 172
your messages, viewing 175

microsite management
content assets, adding to a page 227
Content Center, about using with 214
create menu tool, about using 221
external pages, about linking to 225
external pages, creating a link to 226
features 210
hierarchical menus, configuring colors and 

icons 238
HTML, adding to a page 226
insert template tool, using 220
inserting files and graphics 228
menu of links, creating 222
microsite caching, configuring 236
microsite management page content 

object 587
microsite management page item content 

object 589
microsite management page, creating 

navigation links between 223
mmlayout.txt File, adding new view 

layouts 237
multiple pages, adding templates to 235
navigation bar style, changing 239
new page, creating using Page Designer 

view 218
Page Administration view, about 214

Page Designer and finished page, relationship 
to 211

Page Designer, about 217
page in the tree, finding and modifying its 

properties 215
page item, deleting 230
page item, editing 229
page items, about managing groups 231
page items, grouping 232
page layout, saving and canceling 

changes 231
page, deleting 233
page, previewing 232
page, publishing 233
process flow example 214
root-level page, creating 216
scenario 213
search indexes, about creating 235
Siebel application, creating a link from a page 

to a view 224
standard and high interactivity mode, using 

in 212
structured content, about 209
templates, about and creating 234
templates, creating 235
unstructured content, about 209

microsite management page
creating navigation links between 223

Microsoft
correspondence templates, creating in Office 

XP 307
correspondence templates, creating in 

Word 306
MaxTasks parameters, setting 295
Office applications, installing on the Document 

Server 294
processing one task, about setting 295
SIEBEL.HTML file, about interface with 

Word 304
Word, using to edit correspondence 

templates 302
Microsoft PowerPoint

bookmarks, creating a component 
with 319

components, creating 319
related table subsections, adding 326
template sections, adding components 

to 327
template sections, adding subsections 325
template sections, creating top-level 

sections 321
templates, creating a record for 320
templates, creating background slide 318
templates, creating slides 317
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templates, planning 318
templates, setting up styles for 318

Microsoft SQL Server
loading D&B data on 419

Microsoft Word
styles document, creating 347
template documents, creating in 346
template documents, planning 347

milestones
adding a milestone 555
associated activities, adding to each 

milestone 556
customer milestones, about 555

mmlayout.txt File
adding new view layouts 237

mobile users
about activating state models 288

mobile Web clients
Document Server functionality, about running 

on 291
message broadcasting, enabling or 

disabling 116
MRC file, about 416
MRG:Docking Timestamp Source system 

preference 574
MRG:Inter Table Conflict Res system 

preference 574
MRG:Inter Table Merge Rule system 

preference 575
MRG:System Conflict Resolution system 

preference 575
MRG:Txns per Commit system 

preference 575
MRG:User Friendly Notification system 

preference 575
MSWordLiveCount parameter, using 297
multiple currencies

about setting up exchange rates for 52
multiple pages

adding templates to 235
multiple processes

and D-U-N-S number processing 423
My To Do filter

using to view activity 250

N
navigation bar style

changing 239
new features

version 7.7 25
version 7.7, Rev A 23, 24

non-North American telephone formats
specifying 59

[N] normal message
severity level 116

North American telephone formats
default format for 59

notes
opportunity, adding private and public 

notes 502
reference, adding a note to 519
target account selling, adding a note 557

notification workflows
communications profile, setting up 478
delivery of emails, restricting conditions 

for 481
email notifications, stop sending 482
Get Manager Email process, setting up 482
opportunities lost notification process, 

about 480
opportunity assigned notification process, 

about 479
opportunity inactive notification 

process 480
opportunity won notification process 480
opportunity workflow email, modifying the 

language of 481
opportunity workflows, setting up 479
setup steps 478
time lapse between lead assignment and 

email delivery, modifying 480

O
objectives

adding Enterprise Selling Process 
objective 539

offerings
BU/SU offering summary, viewing 539
Business and Service Units, adding to 533

Office XP
creating correspondence templates 307

opportunities
about and predefined opportunities, list 

of 477
account, associating with 460
activities, associated with an 

opportunity 496
assessing 268
assessing an opportunity 494
assessment, beginning 548
attachments and notes, adding to 501
communications profile, setting up 478
competitors, associating with 523
contact, associating with 452
creating an opportunity 490
decision issue, associating with an 
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opportunity 526
decision issues, viewing for an 

opportunity 495
defined and examples 485
delivery of emails, restricting conditions 

for 481
depicting organization hierarchy, using drag 

and drop 499
email notifications, stop sending 482
existing contact. associating with an 

opportunities 496
Get Manager Email process, setting up 482
lead qualification, sales methods. and 

stages 489
lead response, about 488
lead sources, setting up for 

opportunities 483
lines of influence, deleting 500
lines of influence, drawing 500
new contact. associating with an 

opportunities 495
notes, adding private and public notes 502
notification workflows, setup steps 478
opportunities by category report, 

configuring 504
opportunities lead assignment, about 488
opportunity assigned notification process, 

about 479
Opportunity Audit Trail, enabling and tracking 

additional fields 482
opportunity charts 502
opportunity inactive notification process, 

about 480
opportunity lost notification process, 

about 480
opportunity reports, generating 504
opportunity reroute activity, setting 

up 481
opportunity revenues, updating 498
opportunity won notification process, 

about 480
opportunity workflow email, modifying the 

language of 481
opportunity workflows, setting up 479
organization analysis, adding existing 

contact 498
organization analysis, creating new 

contacts 499
organization analysis, viewing and 

printing 500
position summary information, adding 564
primary team member, changing 493
processes and procedures 487
products, associating to an 

opportunity 496
quote, creating from an opportunity 497
revenue class and revenue type, 

about 493
sales pipeline analysis chart, viewing 503
sales pipeline phases analysis chart, 

viewing 504
scenario 486
significant opportunity transactions, 

monitoring 494
single sales objectives, adding 561
strategy sessions, adding actions to 564
Target Account Selling, accessing an 

opportunity 547
Target Account Selling, assessing an 

opportunity for 269
TAS coach, using 549
TAS coach, using to perform 

assessment 270
time lapse between lead assignment and 

email delivery, modifying 480
opportunities by category report

configuring 504
Opportunity Plan report

running 375
Oracle

loading data D&B data 418
organization

custom hierarchy, assigning to 474
organization chart, printing 538
organization’s reporting structure, 

charting 536
organization’s reporting structure, deleting 

contacts 537
organization’s reporting structure, deleting 

lines of influence 537
organization’s reporting structure, drawing 

lines of influence 537
organization’s reporting structure, 

representing 537
organization analysis

contacts. adding existing to 498
contacts. creating new 499
depicting organization hierarchy, using drag 

and drop 499
lines of influence, deleting 500
lines of influence, drawing 500
printing and viewing 500

organization hierarchy
using drag and drop to depict 499

organization map
contacts, deleting 553
creating 553
lines of influence, deleting 554
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lines of influence, drawing 553
printing 554

organizational analysis
about 535
about conducting 551
beginning an analysis 552
creating 535

Owner field
configuring for activities 254

P
page

content assets, adding to a page 227
content assets, inserting files and 

graphics 228
create menu tool, about using 221
external pages, about linking to 225
external pages, creating a link to 226
HTML, adding to a page 226
insert template tool, using 220
menu of links, creating 222
microsite management page, creating 

navigation links between 223
multiple pages, adding templates to 235
new page, creating 218
page items, about managing 231
page items, deleting 230
page items, editing 229
page items, grouping 232
page layout, saving and canceling 

changes 231
page, deleting 233
page, previewing 232
page, publishing 233
Siebel application, creating a link from a page 

to a view 224
Page Designer

about 217
content assets, adding to a page 227
create menu tool, about using 221
external pages, about linking to 225
external pages, creating a link to 226
finished page, relationship to 211
HTML, adding to a page 226
insert template tool, using 220
inserting files and graphics 228
menu of links, creating 222
microsite management page, creating 

navigation links between 223
new page, creating 218
page item, deleting 230
page item, editing 229
page items, about managing 231

page items, grouping 232
page layout, saving and canceling 

changes 231
page, deleting 233
page, previewing 232
page, publishing 233
Siebel application, creating a link from a page 

to a view 224
page information

Page Administration view, about 214
page in the tree, finding and modifying its 

properties 215
page items

grouping 232
managing, about 231
page, deleting 233
page, previewing 232
page, publishing 233

page layout
saving and canceling page layout 

changes 231
pager company

setting up 63
Parent LIC attribute

list of values, about making values 
hierarchically dependent 84

parent Area, about changing 85
parent Web browser

adding 74
parent-child business associations for audit

specifying 94
partners, adding 538
password and default user ID 28
payment terms

setting up 57
periods

period units, associating with a period 58
setting up 58

personal contact
promoting to a sales contact 453

pick lists
See dynamic pick lists

position
audit trail, restricting by position 96
summary information, adding 564

prebuilt content objects
about and business components 581

predefined queries, setting up
about 50
creating by saving a query 51
Predefined Query view, setting up predefined 

query in 51
preferences, system (table of) 567
presentation draft, generating 336
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Presentation Library
components, adding to 333
content, recommending for a 

presentation 333
creating, about 331
presentation files, creating for the 

library 332
sections, adding to 332

presentation structure
components, adding from another 

location 340
components, adding to a presentation 339
content, adding to the presentation 337
modifying and adding content, about 336
presentation component, modifying 341
presentation table of contents, using 338
sections, changing order in a 

presentation 338
sections, removing in a presentation 338
Siebel Encyclopedia component, 

adding 340
viewing the structure 337

presentations
See Siebel Presentations

previewing a page 232
price lists

currency conversion 55
price list content object 590

pricing
volume discount content object 593

primary team member
changing 493

PRIME activities
adding 557
viewing 556

printing
batch printing correspondence 381
batch printing, about 381
batch printing, about setting up 382
DocServer machine, adding printer 

connection to 384
organization analysis 500
organization chart 538
organization map 554
presentation 341
proposal 372
server print menu items, adding on 

Correspondence and Fulfillment 
screens 382

server-based batch printer, changing default 
printer 384

Priority input argument, about 166
private notes

adding to the opportunity 502

Product Feature
about and business components 592

products
opportunity, associating to 496
product class content object 591
product content object 590
product line content object 592

profile
contact, creating for 453
profile information, adding to a 

reference 519
profiles charts, viewing 520
projects, currency conversion 55
proposal library

components, adding to 364
creating, about 363
document files, creating 364
proposal, recommended content for 364
sections, adding to 364

proposals
component, adding from another 

location 371
component, adding to a proposal 370
content, adding to the proposal 368
content, modifying and adding 368
creating 367
generating 366
HTML format, displaying proposals in 365
locking a proposal 373
printing the proposal 372
proposal component, modifying 372
proposal draft, generating 367
proposal sections, changing order 369
proposal sections, removing 370
proposal structure, viewing 368
proposal table of contents, using 369
proposal templates, using to generate a 

proposal 366
sample field mappings 373
sample templates 374
seed templates 375
Siebel Encyclopedia component, 

adding 371
prospects

creating list from D&B data 440
public notes

adding to the opportunity 502
publishing a page 233
PublishProject method 595

Q
queries

audit trail information 98
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telephone number, examples 62
telephone numbers, about using and 

example 62
quick fill template

editing 75
making public 74

Quick Print Application system 
preference 575

Quick Print Output Format system 
preference 575

quotes
currency code, about changing 55
opportunity revenues, updating 498
opportunity, creating from 497

R
rate lists

about currency conversion 55
ReadOnlyOrderStatus system 

preference 575
recurring message alert

setting up 175
reference assets

viewing 520
references

accounts, designating as reference 516
accounts, managing and references 516
activities, adding 516
attachments, viewing 518
calendar, adding reference activity to 518
contact, associating with 517
note, adding to 519
profile information, adding to a 

reference 519
reference assets and profiles charts, 

viewing 520
scenarios 515
searching for references 519

relationship strategy
developing 554

remote
See Siebel Remote

remote databases
configuring Inboxes for use with 144

RemoveContentItem method 596
RemoveProject method 596
Replace command 206
replication (Siebel Replication)

about using audit trail 90
reports

account plan and account map reports, 
generating 541

Blue Sheet report, creating 566

configuring report generation 296
currency conversion supported in 56
Initial Plan report 558
opportunities by category report, 

configuring 504
opportunity reports, generating 504
Satmetrix survey reports, setting up 45
TAS Opportunity Plan report 558

resolution item content object 592
resources

about 271
calendar activities, administering 

resources 273
calendars to which an employee has access, 

viewing 273
employee’s calendar, giving another 

employee access to 273
Resources list applet

tip, adding fields 273
responsibility

restricting audit trail by 96
retroactive alarms

about and changing days displayed 275
revenues

updating opportunity revenues 498
root-level page

about 214
creating 216
deleting 233

RouteInboxItem method 167
RTI configuration file

account locations, edit so not updated 432
caution if modified 424

Run-time Event
setting up to collect usage data for 

views 242

S
S_audit_item table

purging 98
SADMIN ID

about modifying responsibility 28
sales contact

promoting a personal contact to 453
sales methods

about 256
sales methodology, defining 257

sales pipeline analysis chart
viewing 503

sales pipeline phases analysis chart
viewing 504

sales proposals
Siebel Encyclopedia components, 
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adding 371
sales stages

selection criteria 461
SalesHierarchy:UseServerTask system 

preference 575
sample database

about and logging in 33
Samples Lots Enabled system 

preference 575
Satmetrix Key Value system 

preference 575
Satmetrix survey reports

setting up, about 45
symbolic URL, setting up for access 46
WI_ARG_TYPE, extending list of values 

for 46
Save to File command 206
saving

page layout changes 231
target lists, enabling for saving for a list 

applet 409
Sch:Break Time Id system preference 575
Sch:Default Constraint Set system 

preference 575
Sch:Default Cost Function system 

preference 576
Sch:Default Parameter Set system 

preference 576
Sch:Default Time Window system 

preference 576
screen alerts

about 173
screen home pages

setting up default view links 75
script

sample message broadcasting script 120
search indexes

about creating 235
searching

category, searching for 522
for references 519

SecThickClientExtAuthent system 
preference 576

seed data
about 33
list of values, modifying 82

seed templates 375
server database, about 33
server-based batch printing

See also printing
about 381
configuring printers for 383
default printer, changing 384
DocServer machine, adding a printer 

connection 384
service requests

viewing activities associated with 253
SetInboxParamInfo method 161
setup tasks

summary of application administration 
tasks 34

setup, initial
about 37
employee setup, additional information 39
employee setup, completing 40
locale name, creating translation for 45
locale, editing current locale 45
locales, about setting up 41
locales, creating 42
Satmetrix survey reports, setting up 45
skills, assigning 41
tasks, summary of 38
views, adding to the application 39

severity levels
about using for message broadcasting 116

SIC (Standard Industrial Classification code) 
file

about and D&B data 416
Siebel application

license keys, hiding access to 32
link, creating from a page to a view 224
Siebel Dedicated Web Client, starting 

from 28
Siebel Web Client, starting from 28

Siebel correspondence
See correspondence

Siebel Dedicated Web Client
See dedicated Web clients

Siebel Document Server
about running on Siebel Mobile Web 

Clients 291
additional logging, enabling 298
application recycle period, configuring 297
component group, enabling 295
components, synchronizing 296
HTML generation, enabling for 

correspondence 297
MaxTasks parameters, about setting 295
MaxTasks parameters, setting 295
Microsoft Office application, installing 

on 294
mobile Web Clients. about running Document 

Server functionality 291
process overview 292
report generation, configuring 296
requests, routing all requests to 298
required hardware, obtaining 291
Siebel Server, installing 292
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Siebel software used to generate 
documents 291

Siebel eBriefings
about ordering D&B reports 429

Siebel Encyclopedia
presentation, adding to 340
proposal, adding to 371

Siebel Enterprise Selling Process (ESP)
See Enterprise Selling Process

Siebel Industry Applications
See Global Target List Management

Siebel Literature
literature files, about setting up 390
literature files, creating 390
literature files, modifying 390
literature item kits, creating 394
literature kits, about 389
literature records, creating 391
literature, associating with the decision 

issue 527
literature, making visible to users 395
sharing literature through eBriefings 398
sharing literature through literature or 

Infocenter 399
sharing literature through the Competitors 

screen 396
sharing literature through the 

Correspondence screen 398
sharing literature through the Decision 

screen 397
sharing literature through the Products 

screen 396
software supported 390
translation records, associating with a 

literature record 393
Siebel Mobile Web Clients

about running Document Server functionality 
on 291

Siebel objects
association with activity objects 248

Siebel OLE Automation, about 119
Siebel Presentations

about 315
background slide, creating 318
bookmarks, creating a component 

with 319
components, adding from another 

location 340
components, adding to a presentation 339
components, adding to the library 333
components, creating 319
content, adding to the presentation 337
content, recommending for a 

presentation 333

HTML format, displaying presentations 
in 334

locking a presentation 342
presentation component, modifying 341
presentation draft, generating 336
presentation field mappings, about 

defining 329
presentation field mappings, creating a 

mapping 330
presentation field mappings, mapping 331
presentation files, creating for the 

library 332
Presentation Library, about creating 331
presentation structure, about modifying and 

adding content 336
presentation structure, viewing 337
presentation table of contents, using 338
presentation, creating 335
presentations, generating 335
printing a presentation 341
related table subsections, adding 326
sample templates 342
sections in a presentation, removing 338
sections, adding to the library 332
sections, changing order in a 

presentation 338
Siebel Encyclopedia component, 

adding 340
Siebel Remote Web Client system 

requirements 316
Siebel Web Client system 

requirements 316
template sections, adding components 

to 327
template sections, adding subsections 325
template sections, creating top-level 

sections 321
template slides, creating in 

PowerPoint 317
template, associating mapping with 331
template, planning 318
template, setting up styles for 318
templates, creating a record for 320
templates, fields in top-level section 323
templates, process of creating 316
templates, using conditions in 328
templates, using to create 

presentations 334
Siebel Proposals

bookmarks, creating in Word 2003 348
bookmarks, creating in Word versions other 

than 2003 350
component, adding from another 

location 371
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component, adding to a proposal 370
components, creating 348
document field mappings, defining 360
document server, about using Siebel Server in 

UNIX 344
HTML format, displaying proposals in 365
locking a proposal 373
printing a proposal 372
proposal component, modifying 372
proposal draft, generating 367
proposal library, creating 363
proposal sections, changing order 369
proposal templates, using and generating a 

proposal 366
proposal, adding content 368
proposal, creating 367
proposal, modifying and adding contents 

to 368
proposal, viewing structure 368
proposals, generating 366
sample field mappings 373
sample templates 374
seed templates 375
Siebel Encyclopedia component, 

adding 371
Siebel Remote Web Client system 

requirements 345
Siebel Web Client system 

requirements 344
styles document, creating 347
table subsections, adding related 357
template documents, creating in Word 346
template sections, defining 352
template sections. adding components 

to 358
template structure, about creating 352
template subsections, adding 356
template top-level sections, creating 352
template, associating mapping with 363
template, creating a record for 351
template, planning 347
templates, process of creating 345
templates, using conditions in 359

Siebel proposals
configuring report generation 296

Siebel Remote
audit trail, about using 90
Siebel Presentations, system 

requirements 316
Siebel Replication

about using audit trail 90
Siebel Server

installing Document Server for 292
Siebel Tools

Audit Trail Engine business service, 
enabling 91

audit trail, configuring customer application 
for 91

business component, enabling for state 
models 285

license keys, entering additional using 
Tools 31

license keys, hiding access to 32
Siebel Web Client

application-wide case insensitivity, 
enabling 69

different Application Object Managers, 
enabling insensitivity 69

Siebel application, starting from 28
Siebel Presentations, system 

requirements 316
Siebel XML-based publication service

setting up Content Center publication 
workflows 192

SIEBEL.HTML file
about 304
initially creating or updating 305

single sales objective, entering 561
skills, assigning 41
SM WebIntelligence Server system 

preference 576
SmartScripts

setting up Inbox links 141
software required, table 27
solution

prebuilt content object 593
SQL (dnbinitial.sql)

using to load D&B data 423
SqlStyle system preference 576
SSASqlErrRsltsDiscarded system 

preference 576
Standard Industrial Classification code

about and D&B data 416
standard mode

using microsite pages in 212
starting

Siebel application, starting from Siebel 
Dedicated Web Client 28

Siebel application, starting from Siebel Web 
Client 28

StartProject method 596
State Machine, defined 283
state models

activating procedure 288
activating state models, about 288
business component, about 

configuring 285
business component, enabling in Siebel 
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Tools 285
business component, is it already 

enabled? 285
child modification, disabling for business 

components 290
child modification, enabling for business 

components 290
child records, about changing 

behavior 289
enforcing state models, about 288
functionality 283
mobile users, about activating 288
new state model, creating 286
scenario 284
setting up state model, process of 284
state model objects, about reading 288

state transitions
defined 283
new state model, creating 286

static pick lists
about 77
constraining, about 84

Strategic Selling
best actions, adding 565
Blue Sheet report, creating 566
buying influence information, adding 563
position summary information, adding 564
possible actions, adding 564
process of strategic selling 561
scenario 560
selling process, support of 559
single sales objective, entering 561

structured content about 209
styles document

creating 347
SubSqlStyle system preference 576
Suppress Side Applets Calendar Types user 

property 281
synchronization list

adding a contact to 453
removing a contact from 454

Synchronize Account ASI 448
Synchronize Contact ASI 448
Synchronize Household ASI 448, 513
Syndicated Data system preference 576
system preferences

setting 50
table of 567
usage tracking, enabling and 

configuring 243

T
Target Account Selling

assessment, beginning 548
associated activities, adding to each 

milestone 556
competitive analysis information, 

adding 550
competitive analysis, using TAS coach 

for 550
customer milestones, about 555
customer milestones, adding a 

milestone 555
notes, adding 557
opportunities, using to manage 543
opportunity, assessing 269, 547
organization map, creating 553
organization map, deleting contacts 553
organization map, deleting lines of 

influence 554
organization map, drawing lines of 

influence 553
organization map, printing 554
organizational analysis, about 

conducting 551
organizational analysis, beginning 552
PRIME activities, adding 557
PRIME activities, viewing 556
relationship strategy, developing 554
reports 558
scenario 544
TAS coach, using 549
TAS coach, using to perform 

assessment 270
TAS overview, completing 546

Target Account Selling Module
running Opportunity Plan report 375

target lists
activities, creating asychronously 407
activities, creating from 405
activity templates, setting up 406
applying 405
creating by combining lists 404
creating by querying 403
editing 404
list applets, enabling on an applet 408
list applets, saving target lists in an 

applet 409
Target Lists system preference 576
target server

routing all requests to 298
TAS coach

using 549
TAS Customer Milestone template
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